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+RZ�WR�8VH� WKH�8VHU¶V�*XLGH�ZLWK
5HIHUHQFH�0DQXDO�

The Mathcad 2001 User’s Guide with Reference Manual is organized as follows:

t 7KH�%DVLFV
This section contains a quick introduction to Mathcad’s features and worksp
including resources available in the product and on the Internet for getting m
out of Mathcad. Be sure to read this section first if you are a new Mathcad u

t &UHDWLQJ�0DWKFDG�:RUNVKHHWV
This section describes in more detail how to create and edit Mathcad worksh
It leads you through editing and formatting equations, text, and graphics, as
as opening, editing, saving, and printing Mathcad worksheets and templates

t &RPSXWDWLRQDO�)HDWXUHV
This section describes how Mathcad interprets equations and explains Math
computational features: units of measurement, complex numbers, matrices, 
in functions, solving equations, programming, and so on. This section also 
describes how to do symbolic calculations and how to use Mathcad’s two- a
three-dimensional plotting features.

t 5HIHUHQFH�0DQXDO
This section lists and describes in detail all built-in functions, operators, and
symbolic keywords, emphasizing their mathematical and statistical aspects.

As much as possible, the topics in this guide are described independently of each 
This means that once you are familiar with the basic workings of Mathcad, you c
simply select a topic of interest and read about it.

2QOLQH�5HVRXUFHV
The Mathcad Resource Center (choose Resource Center from the Help menu in 
Mathcad) provides step by step tutorials, examples, and application files that you
use directly in your own Mathcad worksheets. Mathcad QuickSheets are templa
available in the Resource Center that provide live examples that you can manipu

The Author’s Reference (choose Author’s Reference from the Help menu in Mathcad) 
provides information about creating Electronic Books in Mathcad. An Electronic Book 
is a browsable set of hyperlinked Mathcad worksheets that has its own Table of Contents 
and index.

The Developer’s Reference (choose Developer’s Reference from the Help menu in 
Mathcad) provides information about developing customized Mathcad components, 
specialized OLE objects in a Mathcad worksheet that allow you to access functions 
from other applications and data from remote sources. 
1
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The Developer’s Reference also documents Mathcad’s Object Model, which allo
you to access Mathcad’s functionality from another application or an OLE contai
(see “Online Resources” on page 21 for more details).

1RWDWLRQV�DQG�&RQYHQWLRQV
This guide uses the following notations and conventions:

Italics represent scalar variable names, function names, and error messages.

Bold Courier represents keys you should type.

Bold represents a menu command. It is also used to denote vector and matrix v
variables.

An arrow such as that in “Graph⇒X-Y Plot” indicates a submenu command.

Function keys and other special keys are enclosed in brackets. For example, [↑], [↓], 
[←], and [→] are the arrow keys on the keyboard. [F1], [F2], etc., are function keys; 
[BkSp] is the Backspace key for backspacing over characters; [Del] is the Delete key 
for deleting characters to the right; [Ins] is the Insert key for inserting characters to
the left of the insertion point; [Tab] is the Tab key; and [Space] is the space bar.

[Ctrl], [Shift], and [Alt] are the Control, Shift, and Alt keys. When two keys a
shown together, for example, [Ctrl]V, press and hold down the first key, and then
press the second key.

The symbol [↵] and [Enter] refer to the same key.

Additionally, in the Reference Manual portion of this book, the following specific 
notation is used whenever possible:

• x and y represent real numbers.

• z and w represent either real or complex numbers.

• m, n, i, j, and k represent integers.

• S and any names beginning with S represent string expressions.

• u, v, and any names beginning with v represent vectors.

• A and B represent matrices or vectors.

• M and N represent square matrices.

• f represents a scalar-valued function.

• F represents a vector-valued function.

• file is a string variable that corresponds to a filename or path.

• X and Y represent variables or expressions of any type.

In this guide, when spaces are shown in an equation, you need not type the spa
Mathcad automatically spaces equations correctly.

This guide describes a few product features that are available only in add-on pac
for Mathcad. For example, some numerical solving features and functions are pro
only in the Solving and Optimization Extension Pack.
2    
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&KDSWHU��
:HOFRPH�WR�0DWKFDG

t :KDW�,V�0DWKFDG"

t +LJKOLJKWV�RI�WKH�0DWKFDG������5HOHDVH

t 6\VWHP�5HTXLUHPHQWV�

t ,QVWDOODWLRQ

t &RQWDFWLQJ�0DWK6RIW

:KDW�,V�0DWKFDG"

Mathcad is the industry standard technical calculation tool for professionals, educators, 
and college students worldwide. Mathcad is as versatile and powerful as a programming 
language, yet it’s as easy to learn as a spreadsheet. Plus, it is fully wired to take
advantage of the Internet and other applications you use every day.

Mathcad lets you type equations as you’re used to seeing them, expanded fully on
screen. In a programming language, equations look something like this:

x=(-B+SQRT(B**2-4*A*C))/(2*A)

In a spreadsheet, equations go into cells looking something like this:

+(B1+SQRT(B1*B1-4*A1*C1))/(2*A1)

And that’s assuming you can see them. Usually all you see is a number.

In Mathcad, the same equation looks the way you might see 
it on a blackboard or in a reference book. And there is no 
difficult syntax to learn; you simply point and click and your 
equations appear.

But Mathcad equations do much more than look good. You can use them to solv
about any math problem you can think of, symbolically or numerically. You can pl
text anywhere around them to document your work. You can show how they look 
Mathcad’s two- and three-dimensional plots. You can even illustrate your work w
graphics taken from another Windows application. Plus, Mathcad takes full advan
of Microsoft’s OLE 2 object linking and embedding standard to work with other 
applications, supporting drag and drop and in-place activation as both client and s

Mathcad comes with its own online reference system called the Resource Cente
gives you access to basic and advanced tutorials as well as many useful formul
“quicksheet” recipes for using Mathcad functions, example worksheets, and refer
materials at the click of a button.
What Is Mathcad? 3
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Mathcad simplifies and streamlines documentation, critical to communicating and to 
meeting business and quality assurance standards. By combining equations, text, and 
graphics in a single worksheet, Mathcad makes it easy to keep track of the most complex 
calculations. By printing the worksheet exactly as it appears on the screen, Mathcad 
lets you make a permanent and accurate record of your work.

+LJKOLJKWV�RI�WKH�0DWKFDG������5HOHDVH

)DVWHU�3HUIRUPDQFH�LQ�WKH�&RPSXWDWLRQDO�(QJLQH
Mathcad 2001 Professional contains an improved computational engine that delivers 
faster performance. Additionally, there are other document-specific options that let you 
further customize your mode of calculation, like strict matrix singularity checking and 
backward compatibility.

1HZ�&RPSRQHQWV�DQG�$GG�LQV
Several new components, add-ins, and functions help you interface with other applica-
tions, data sources, and file types within your Mathcad worksheet.

• ODBC Read component. Enable streamlined connectivity to your databases. T
ODBC Read component allows you read and filter data from any ODBC compl
database that supports SQL.

• Data Acquisition component. Get data from or send data to supported measu
ment devices. The Data Acquisition component allows you to acquire and se
single point and waveform analog data in “real time.”

• MathSoft Controls components. Create custom forms controls such as button
and text boxes. MathSoft Controls allow you to customize interactivity in you
worksheets.

• New component SDK. Build custom Mathcad components quickly and easily 
using the new Mathcad Component Wizard for Visual Studio, which generates
shell of a component, including documentation and sample source code.

• WAV file support. Read, write, and get format information from pulse code 
modulated (PCM) Microsoft WAV file using Mathcad’s new WAV funtions.

• Customization and redistribution of components. Customize and distribute 
Scriptable Object components built in Mathcad using the new Save as Compo
feature. Once you have customized a component to your liking, you can shar
reuse your component quickly and easily

• New Add-ins. Extend Mathcad’s feature set to other applications. Visit the
Dowload area of the Mathcad web site at http://www.mathcad.com/ to get 
a complete list of current Mathcad Add-ins and information about how to downl
them. Other new Add-ins will be posted from time to time.
4  Chapter 1  Welcome to Mathcad
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,PSURYHG�:HE�,QWHJUDWLRQ
With Mathcad 2001 Professional, you can save your Mathcad worksheets as HTML 
documents with embedded Mathematical Markup Language (MathML) and display 
them in the browser. Using IBM’s techexplorerTM Hypermedia Browser, a plug-in 
application that comes with Mathcad, you can display any Mathcad worksheet s
in HTML/MathML format. Then, you can read those documents back into Mathc
with no loss of computational information.

$XWKRULQJ�7RROV
Create Electronic Books faster and more easily with new and improved authoring t
These tools include:

• Region-to-region hyperlinking

• An automatic index creation mechanism that allows you to tag regions with 
keywords

• An HBK debugging tool that allows you to check your electronic book for erro

2WKHU�)HDWXUHV
Other new features include:

• New capabilities in embedded pictures. You can import images to your Mathcad
worksheet from a variety of new formats including JPEG, GIF, and PCX. Onc
your worksheet, these images can be manipulated using the new picture too
which includes tools for zooming, cropping, and changing orientation, brightn
contrast, and grayscale mapping of a picture.

• More new functions. There are several new ease-of-use functions including 
coordinate system transforms to convert between coordinate systems and lo
functions to streamline searching for values in large matrices.

6\VWHP�5HTXLUHPHQWV

In order to install and run Mathcad 2001 Professional, the following are recomme
or required:

• Pentium 133MHz or compatible CPU.

• CD-ROM drive.

• Windows 95 or higher or Windows NT 4.0 or higher.

• At least 32 megabytes of memory. 64 MB is recommended.

• For improved appearance and full functionality of online Help, installation of 
Internet Explorer 4.0, Service Pack 2, or higher is recommended. IE does not
to be your default browser.
System Requirements 5
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To install Mathcad:

1. Insert the CD into your CD-ROM drive. The first time you do this, the CD will 
automatically start the installation program. If the installation program does not 
start automatically, you can start it by choosing Run from the Start menu and typing 
D:\SETUP (where “D:” is your CD-ROM drive). Click “OK.”

2. Click the Mathcad icon on main installation page. 

3. When prompted, enter your product serial number, which is located on the ba
the CD envelope.

4. Follow the remaining on-screen instructions.

To install other items such as SmartSketch LE, VoloView, or online documentati
click the icon for the item you want to install on the install startup screen.

&RQWDFWLQJ�0DWK6RIW

7HFKQLFDO�6XSSRUW
MathSoft provides free technical support for individual users of Mathcad. Please 
the Support area of the Mathcad web site at http://www.mathcad.com/.

If you reside outside the U.S. and Canada, please refer to the technical support c
your Mathcad package to find details for your local support center. You may also
contact: 

• Automated solution center and fax-back system: +44 1276 475350

• Fax: +44 1276 451224 (Attn: Tech Support)

• Email: help@mathsoft.co.uk 

Contact MathSoft or your local distributor for information about technical support pl
for site licenses.
6  Chapter 1  Welcome to Mathcad
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For information on system requirements and how to install Mathcad on your computer, 
refer to Chapter 1, “Welcome to Mathcad.”

When you start Mathcad, you’ll see a window like that shown in Figure 2-1. By def
the worksheet area is white. To select a different color, choose Color⇒Background 
from the Format menu.

Figure 2-1: Mathcad with various toolbars displayed.
The Mathcad Workspace 7
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Each button in the Math toolbar, shown in Figure 2-1, opens another toolbar of 
operators or symbols. You can insert many operators, Greek letters, and plots by 
clicking the buttons found on these toolbars:

The Standard toolbar is the strip of buttons shown just below the main menus in
Figure 2-1: 

Many menu commands can be accessed more quickly by clicking a button on the 
Standard toolbar. 

The Formatting toolbar is shown immediately below the Standard toolbar in Figure 
2-1. This contains scrolling lists and buttons used to specify font characteristics in 
equations and text.

7LS To learn what a button on any toolbar does, let the mouse pointer rest on the button momentarily. 
You’ll see a tooltip beside the pointer giving a brief description.

To conserve screen space, you can show or hide each toolbar individually by choosing 
the appropriate command from the View menu. You can also detach and drag a toolbar 
around your window. To do so, place the mouse pointer anywhere other than on a button 
or a text box. Then press and hold down the mouse button and drag. You’ll find 
the toolbars rearrange themselves appropriately depending on where you drag t
And Mathcad remembers where you left your toolbars the next time you open 
the application.

%XWWRQ 2SHQV�PDWK�WRROEDU���

Calculator—Common arithmetic operators.

Graph—Various two- and three-dimensional plot types and graph to

Matrix—Matrix and vector operators.

Evaluation—Equal signs for evaluation and definition.

Calculus—Derivatives, integrals, limits, and iterated sums and produ

Boolean—Comparative and logical operators for Boolean expression

Programming—Programming constructs.

Greek—Greek letters.

Symbolic—Symbolic keywords.
8  Chapter 2  Getting Started with Mathcad
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7LS You can customize the Standard, Formatting, and Math toolbars. To add and remove buttons 
from one of these toolbars, right-click on the toolbar and choose Customize from the pop-up 
menu to bring up the Customize Toolbar dialog box. 

The worksheet ruler is shown towards the top of the screen in Figure 2-1. To hide or 
show the ruler, choose Ruler from the View menu. To change the measurement system 
used in the ruler, right-click on the ruler, and choose Inches, Centimeters, Points, or Picas 
from the pop-up menu. For more information on using the ruler to format your 
worksheet, refer to “Using the worksheet ruler” on page 86.

:RUNLQJ�ZLWK�:LQGRZV�
When you start Mathcad, you open up a window on a Mathcad worksheet. You can 
have as many worksheets open as your available system resources allow. This 
you to work on several worksheets at once by simply clicking the mouse in which
document window you want to work in. 

There are times when a Mathcad worksheet cannot be displayed in its entirety be
the window is too small. To bring unseen portions of a worksheet into view, you 

• Make the window larger as you do in other Windows applications.

• Choose Zoom from the View menu or click  on the Standard toolbar and
choose a number smaller than 100%.

You can also use the scroll bars, mouse, and keystrokes to move around the Ma
window, as you can in your other Windows applications. When you move the mo
pointer and click the mouse button, for example, the cursor jumps from wherever i
to wherever you clicked. 

7LS Mathcad supports the Microsoft IntelliMouse and compatible pointing devices. Turning the 
wheel scrolls the window one line vertically for each click of the wheel. When you press 
[Shift] and turn the wheel, the window scrolls horizontally.

See “Arrow and Movement Keys” on page 499 in the Appendices for keystrokes
move the cursor in the worksheet. If you are working with a longer worksheet, ch
Go to Page from the Edit menu and enter the page number you want to go to in th
dialog box. When you click “OK,” Mathcad places the top of the page you specif
the top of the window.

7LS Mathcad supports standard Windows keystrokes for operations such as file opening, [Ctrl]O, 
saving, [Ctrl]S, printing, [Ctrl]P, copying, [Ctrl]C, and pasting, [Ctrl]V. Choose 
Preferences from the View menu and check “Standard Windows shortcut keys” in the Keybo
Options section of the General tab to enable all Windows shortcuts. Remove the check to
shortcut keys supported in earlier versions of Mathcad.
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Mathcad lets you enter equations, text, and plots anywhere in the worksheet. Each 
equation, piece of text, or other element is a region. Mathcad creates an invisible 
rectangle to hold each region. A Mathcad worksheet is a collection of such regions. To 
start a new region in Mathcad: 

1. Click anywhere in a blank area of the worksheet. You see a small crosshair. 

Anything you type appears at the crosshair.

2. If the region you want to create is a math region, just start typing anywhere 
you put the crosshair. By default Mathcad understands what you type as 
mathematics. See “A Simple Calculation” on page 12 for an example.

3. To create a text region, first choose Text Region from the Insert menu and then 
start typing. See “Entering Text” on page 14 for an example.

In addition to equations and text, Mathcad supports a variety of plot regions. See
“Graphs” on page 18 for an example of inserting a two-dimensional plot. 

7LS Mathcad displays a box around any region you are currently working in. When you click outside 
the region, the surrounding box disappears. To put a permanent box around a region, click on it 
with the right mouse button and choose Properties from the pop-up menu. Click on the Display 
tab and click the box next to “Show Border.”

6HOHFWLQJ�5HJLRQV
To select a single region, simply click it. Mathcad shows a rectangle around the region.

To select multiple regions:

1. Press and hold down the left mouse button to anchor one corner of the selection 
rectangle.

2. Without letting go of the mouse button, move the mouse to enclose everything you 
want to select inside the selection rectangle.

3. Release the mouse button. Mathcad shows dashed rectangles around regions you 
have selected.

7LS You can also select multiple regions anywhere in the worksheet by holding down the [Ctrl] 
key while clicking. If you click one region and [Shift]-click another, you select both regions
and all regions in between.

0RYLQJ�DQG�&RS\LQJ�5HJLRQV�
Once the regions are selected, you can move or copy them.

0RYLQJ�UHJLRQV���

You can move regions by dragging with the mouse or by using Cut and Paste.
10  Chapter 2  Getting Started with Mathcad
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To drag regions with the mouse: 

1. Select the regions as described in the previous section.

2. Place the pointer on the border of any selected region. The pointer turns into a small 
hand.

3. Press and hold down the mouse button.

4. Without letting go of the button, move the mouse. The rectangular outlines of the 
selected regions follow the mouse pointer.

At this point, you can either drag the selected regions to another spot in the worksheet, 
or you can drag them to another worksheet. To move the selected regions into another 
worksheet, press and hold down the mouse button, drag the rectangular outlines into 
the destination worksheet, and release the mouse button.

To move the selected regions by using Cut and Paste:

1. Select the regions as described in the previous section.

2. Choose Cut from the Edit menu (keystroke: [Ctrl] X), or click  on the 
Standard toolbar. This deletes the selected regions and puts them on the Clipboard.

3. Click the mouse wherever you want the regions moved to. Make sure you’ve cli
in an empty space. You can click either someplace else in your worksheet or
different worksheet altogether. You should see the crosshair.

4. Choose Paste from the Edit menu (keystroke: [Ctrl] V), or click  on the 
Standard toolbar. 

1RWH You can move one region on top of another. To move a particular region to the top or bottom, 
right-click on it and choose Bring to Front or Send to Back from the pop-up menu.

&RS\LQJ�5HJLRQV

To copy regions by using the Copy and Paste commands:

1. Select the regions as described in “Selecting Regions” on page 10.

2. Choose Copy from the Edit menu (keystroke: [Ctrl] C), or click  on the 
Standard toolbar to copy the selected regions to the Clipboard.

3. Click the mouse wherever you want to place a copy of the regions. You can 
either in your worksheet or in a different worksheet altogether. Make sure you
clicked in an empty space and that you see the crosshair.

4. Choose Paste from the Edit menu (keystroke: [Ctrl] V), or click  on the 
Standard toolbar. 

7LS If the regions you want to copy are coming from a locked area (see “Safeguarding an Area
Worksheet” on page 91) or an Electronic Book, you can copy them simply by dragging th
with the mouse into your worksheet.
Regions 11
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'HOHWLQJ�5HJLRQV���
To delete one or more regions:

1. Select the regions.

2. Choose Cut from the Edit menu (keystroke: [Ctrl] X), or click  on the 
Standard toolbar.

Choosing Cut removes the selected regions from your worksheet and puts them on the 
Clipboard. If you don’t want to disturb the contents of your Clipboard, or if you do
want to save the selected regions, choose Delete from the Edit menu (Keystroke: 
[Ctrl] D) instead.

$�6LPSOH�&DOFXODWLRQ�

Although Mathcad can perform sophisticated mathematics, you can just as easil
it as a simple calculator. To try your first calculation, follow these steps:

1. Click anywhere in the worksheet. You see a small 
crosshair. Anything you type appears at the crosshair.

2. Type 15-8/104.5=. When you type the equal sign 

or click  on the Evaluation toolbar, Mathcad 
computes and shows the result.

This calculation demonstrates the way Mathcad works:

• Mathcad shows equations as you might see them in a book or on a blackboa
Mathcad sizes fraction bars, brackets, and other symbols to display equation
same way you would write them on paper.

• Mathcad understands which operation to perform first. In this example, Math
knew to perform the division before the subtraction and displayed the equatio
accordingly.

• As soon as you type the equal sign or click  on the Evaluation toolbar, Math
returns the result. Unless you specify otherwise, Mathcad processes each eq
as you enter it. See the section “Controlling Calculation” in Chapter 8 to learn 
to change this.

• As you type each operator (in this case, − and /), Mathcad shows a small rectangle
called a placeholder. Placeholders hold spaces open for numbers or expression
yet typed. As soon as you type a number, it replaces the placeholder in the 
expression. The placeholder that appears at the end of the expression is use
unit conversions. Its use is discussed in “Displaying Units of Results” on page
12  Chapter 2  Getting Started with Mathcad
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Once an equation is on the screen, you can edit it by clicking in the appropriate spot 
and typing new letters, numbers, or operators. You can type many operators and Greek 
letters by clicking in the Math toolbars introduced in “The Mathcad Workspace” o
page 7. Chapter 4, “Working with Math,” details how to edit Mathcad equations.

'HILQLWLRQV�DQG�9DULDEOHV

Mathcad’s power and versatility quickly become apparent once you begin using 
variables and functions. By defining variables and functions, you can link equation
together and use intermediate results in further calculations.

The following examples show how to define and use several variables.

'HILQLQJ�9DULDEOHV�
To define a variable t, follow these steps:

1. Type t followed by a colon : or click  on the 
Calculator toolbar. Mathcad shows the colon as the 
definition symbol :=. 

2. Type 10 in the empty placeholder to complete the 
definition for t.

If you make a mistake, click on the equation and press 
[Space] until the entire expression is between the two editing lines, just as you d
earlier. Then delete it by choosing Cut from the Edit menu (keystroke: [Ctrl] X). See 
Chapter 4, “Working with Math,” for other ways to correct or edit an expression.

These steps show the form for typing any definition: 

1. Type the variable name to be defined.

2. Type the colon key : or click  on the Calculator toolbar to insert the definitio
symbol. The examples that follow encourage you to use the colon key, since
is usually faster.

3. Type the value to be assigned to the variable. The value can be a single numb
in the example shown here, or a more complicated combination of numbers a
previously defined variables.

Mathcad worksheets read from top to bottom and left to right. Once you have de
a variable like t, you can compute with it anywhere below and to the right of the equation 
that defines it. 
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Now enter another definition.

1. Press [↵]. This moves the crosshair below the first 
equation.

2. To define acc as –9.8, type: acc:–9.8 . Then press 
[↵] again. Mathcad shows the crosshair cursor 
below the last equation you entered.

&DOFXODWLQJ�5HVXOWV����
Now that the variables acc and t are defined, you can use them in other expressions.

1. Click the mouse a few lines below the two 
definitions. 

2. Type acc/2 [Space ]*t^2 . The caret symbol (^ ) 
represents raising to a power, the asterisk (* ) is 
multiplication, and the slash (/ ) represents division.

3. Press the equal sign (=).

This equation calculates the distance traveled by a falling body in time t with 
acceleration acc. When you enter the equation and press the equal sign (=), or click 

 on the Evaluation toolbar, Mathcad returns the result.

Mathcad updates results as soon as you make changes. For example, if you click on the 
10 on your screen and change it to some other number, Mathcad changes the result as 
soon as you press [↵] or click outside of the equation.

(QWHULQJ�7H[W�

Mathcad handles text as easily as it does equations, so you can make notes about the 
calculations you are doing. 

Here’s how to enter some text:

1. Click in the blank space to the right of the 
equations you entered. You’ll see a small 
crosshair.

2. Choose Text Region from the Insert menu, or 
press " (the double-quote key), to tell Mathcad 
that you’re about to enter some text. Mathcad changes the crosshair into a ve
line called the insertion point. Characters you type appear behind this line. A
surrounds the insertion point, indicating you are now in a text region. This bo
called a text box. It grows as you enter text.
14  Chapter 2  Getting Started with Mathcad



, 

. If 

tions. 

. 
the 

oblem 
s for 
3. Type Equations of motion. Mathcad 
shows the text in the worksheet, next to the 
equations.

1RWH If Ruler under the View menu is checked when the cursor is inside a text region, the ruler resizes 
to indicate the size of your text region. For more information on using the ruler to set tab stops 
and indents in a text region, see “Changing Paragraph Properties” on page 61.

7LS If you click in blank space in the worksheet and start typing, which creates a math region
Mathcad automatically converts the math region to a text region when you press [Space].

To enter a second line of text, just press [↵] and continue typing:

1. Press [↵].
2. Then type for falling body under gravity.

3. Click in a different spot in the worksheet or press 
[Ctrl][Shift][↵] to move out of the text 
region. The text box disappears and the cursor 
appears as a small crosshair.

1RWH Use [Ctrl][Shift][↵] to move out of the text region to a blank space in your worksheet
you press [↵], Mathcad inserts a line break in the current text region instead.

You can set the width of a text region and change the font, size, and style of the text in 
it. For more information, see Chapter 5, “Working with Text.”

,WHUDWLYH�&DOFXODWLRQV�

Mathcad can do repeated or iterative calculations as easily as individual calcula
Mathcad uses a special variable called a range variable to perform iteration.

Range variables take on a range of values, such as all the integers from 0 to 10
Whenever a range variable appears in a Mathcad equation, Mathcad calculates 
equation not just once, but once for each value of the range variable. 

This section describes how to use range variables to do iterative calculations.

&UHDWLQJ�D�5DQJH�9DULDEOH
To compute equations for a range of values, first create a range variable. In the pr
shown in “Calculating Results” on page 14, for example, you can compute result
a range of values of t from 10 to 20 in steps of 1. 
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To do so, follow these steps:

1. First, change t into a range variable by editing its 
definition. Click on the 10 in the equation t:=10. The 
insertion point should be next to the 10 as shown on the 
right.

2. Type , 11. This tells Mathcad that the next number in 
the range will be 11.

3. Type ; for the range variable operator, or click  on 
the Calculator toolbar, and then type the last number, 20. 
This tells Mathcad that the last number in the range will be 20. Mathcad shows the 
range variable operator as a pair of dots.

4. Now click outside the equation for t. Mathcad begins to compute 
with t defined as a range variable. Since t now takes on eleven 
different values, there must also be eleven different answers. 
These are displayed in an output table as shown at right. You 
may have to resize your window or scroll down to see the whole 
table.

'HILQLQJ�D�)XQFWLRQ
You can gain additional flexibility by defining functions. Here’s 
how to add a function definition to your worksheet:

1. First delete the table. To do so, drag-select the entire region until 
you’ve enclosed everything between the two editing lines. Then 

choose Cut from the Edit menu (keystroke: [Ctrl] X) or click  on the Standard 
toolbar. 

2. Now define the function d(t) by typing d(t):

3. Complete the definition by typing this expression: 
1600+acc/2[Space]*t^2[↵]

The definition you just typed defines a function. The func-
tion name is d, and the argument of the function is t. You can use this function to evaluate
the above expression for different values of t. To do so, simply replace t with an 
appropriate number. For example:
16  Chapter 2  Getting Started with Mathcad
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1. To evaluate the function at a particular value, such as 3.5, 
type d(3.5)=. Mathcad returns the correct value as 
shown at right.

2. To evaluate the function once for each value of the range variable 
t you defined earlier, click below the other equations and type 
d(t)=. As before, Mathcad shows a table of values, as shown at 
right.

)RUPDWWLQJ�D�5HVXOW
You can set the display format for any number Mathcad calculates and 
displays. This means changing the number of decimal places shown, 
changing exponential notation to ordinary decimal notation, and so on.

For example, in the example above, the first two values,  and 

, are in exponential (powers of 10) notation. Here’s how to 
change the table produced above so that none of the numbers in it are displayed
exponential notation:

1. Click anywhere on the table with 
the mouse. 

2. Choose Result from the Format 
menu. You see the Result Format 
dialog box. This box contains 
settings that affect how results are 
displayed, including the number of 
decimal places, the use of 
exponential notation, the radix, 
and so on.

3. The default format scheme is General which has Exponential 
Threshold set to 3. This means that only numbers greater than or 

equal to  are displayed in exponential notation. Click the 
arrows to the right of the 3 to increase the Exponential Threshold 
to 6.

4. Click “OK.” The table changes to reflect the new result format.

For more information on formatting results, refer to “Formatting 
Results” on page 115.

1RWH When you format a result, only the display of the result is affected. Mathcad maintains full 
precision internally (up to 15 digits).

1.11 103⋅

1.007 103⋅

103
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Mathcad can show both two-dimensional Cartesian and polar graphs, contour plots, 
surface plots, and a variety of other three-dimensional graphs. These are all examples 
of graph regions.

This section describes how to create a simple two-dimensional graph showing the points 
calculated in the previous section.

&UHDWLQJ�D�*UDSK
To create an X-Y plot in Mathcad, click in blank space where you want the graph to 

appear and choose Graph⇒X-Y Plot from the Insert menu or click  on the Graph 
toolbar. An empty graph appears with placeholders on the x-axis and y-axis for the 
expressions to be graphed. X-Y and polar plots are ordinarily driven by range variables 
you define: Mathcad graphs one point for each value of the range variable used in the 
graph. In most cases you enter the range variable, or an expression depending on the 
range variable, on the x-axis of the plot. For example, here’s how to create a plot of 
function d(t) defined in the previous section:

1. Position the crosshair in a blank spot and type 
d(t). Make sure the editing lines remain 
displayed on the expression.

2. Now choose Graph⇒X-Y Plot from the 

Insert menu, or click  on the Graph 
toolbar. Mathcad displays the frame of the 
graph.

3. Type t in the bottom middle placeholder on 
the graph.

4. Click anywhere outside the graph. Mathcad 
calculates and graphs the points. A sample 
line appears under the “d(t).” This helps you 
identify the different curves when you plot 
more than one function. Unless you specify 
otherwise, Mathcad draws straight lines 
between the points and fills in the axis limits.

For detailed information on creating and formatting graphs, see Chapter 12, “2D P
In particular, refer to Chapter 12 for information about the QuickPlot feature in Mathcad 
which lets you plot expressions even when you don’t specify the range variable dir
in the plot.
18  Chapter 2  Getting Started with Mathcad
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To resize a plot, click in the plot to select it. Then move the cursor to a handle along 
the edge of the plot until the cursor changes to a double-headed arrow. Hold the mouse 
button down and drag the mouse in the direction that you want the plot’s dimens
to change. 

)RUPDWWLQJ�D�*UDSK
When you first create a graph it has default characteristics: numbered linear axes, n
grid lines, and points connected with solid lines. You can change these characte
by formatting the graph. To format the graph created previously:

5. Click on the graph and choose 
Graph⇒X-Y Plot from the Format 
menu, or double-click the graph to 
bring up the formatting dialog box. 
This box contains settings for all 
available plot format options. To learn 
more about these settings, see Chapter 
12, “2D Plots.”

6. Click the Traces tab. 

7. Click “trace 1” in the scrolling list 
under “Legend Label.” Mathcad 
places the current settings for trace 1 in 
the boxes under the corresponding 
columns of the scrolling list.

8. Click the arrow under the “Type” column to see a drop-down list of trace type
Select “bar” from this drop-down list.

9. Click “OK” to show the result of 
changing the setting. Mathcad shows 
the graph as a bar chart instead of 
connecting the points with lines. Note 
that the sample line under the d(t) now 
has a bar on top of it.

10. Click outside the graph to deselect it.
Graphs 19
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Once you’ve created a worksheet, you will probably want to save or print it.

6DYLQJ�D�:RUNVKHHW�
To save a worksheet:

1. Choose Save from the File menu (keystroke: [Ctrl] S) or click  on the 
Standard toolbar. If the file has never been saved before, the Save As dialog box 
appears. Otherwise, Mathcad saves the file with no further prompting. 

2. Type the name of the file in the text box provided. To save to another folder, lo
the folder using the Save As dialog box.

By default Mathcad saves the file in Mathcad (MCD) format, but you have the option
of saving in other formats, such as RTF and HTML, as a template for future Mathcad 
worksheets, or in a format compatible with earlier Mathcad versions. For more 
information, see Chapter 7, “Worksheet Management.”

3ULQWLQJ

To print, choose Print from the File menu or click  on the Standard toolbar. To

preview the printed page, choose Print Preview from the File menu or click    on 
the Standard toolbar.

For more information on printing, see Chapter 7, “Worksheet Management.”

([LWLQJ�0DWKFDG�
When you’re done using Mathcad, choose Exit from the File menu. Mathcad closes 
down all its windows and returns you to the Desktop. If you’ve made any change
your worksheets since the last time you saved, a dialog box appears asking if you
to discard or save your changes. If you have moved any toolbars, Mathcad reme
their locations for the next time you open the application.

1RWH To close a particular worksheet while keeping Mathcad open, choose Close from the 
File menu.
20  Chapter 2  Getting Started with Mathcad
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An electronic book is a hyperlinked collection of Mathcad worksheets. If you learn best 
from examples, want information you can put to work immediately in your Mathcad 
worksheets, or wish to access any page on the Web from within Mathcad, choose 

Resource Center from the Help menu or click  on the Standard toolbar. The 
Resource Center is a Mathcad Electronic Book that appears in a custom window with 
its own menus and toolbar, as shown in Figure 3-1. 

Figure 3-1: Resource Center in Mathcad 2001 Professional.
Resource Center and Electronic Books 21
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1RWH A number of Electronic Books are available on the MathSoft Web Library which you can access 
through the Resource Center. In addition, a variety of Mathcad Electronic Books are available 
from MathSoft or your local distributor or software reseller. To open an Electronic Book you 
have installed, choose Open Book from the Help menu and browse to find the location of the 
appropriate Electronic Book (HBK) file.

The Resource Center offers:

• A comprehensive Mathcad Electronic Book containing a collection of tutorials
QuickSheet templates, examples, reference tables, and samples of Mathcad a
products. Simply drag and drop information from the Resource Center into yo
own Mathcad worksheets.

• Immediate access to Mathcad worksheets and Electronic Books on MathSoft’s
site and other Internet sites.

• Access to the full Web-browsing functionality of Microsoft Internet Explorer fro
within the Mathcad environment.

• Access to the Collaboratory where you can exchange messages with other 
Mathcad users.

7LS To prevent the Resource Center from opening automatically every time you start Mathcad,  
choose Preferences from the View menu, and uncheck  “Open Resource Center at startup”
the general tab.

1RWH You can make your own Mathcad Electronic Book. See “Creating an Electronic Book” on p
97 for more information.

&RQWHQW�LQ�WKH�5HVRXUFH�&HQWHU
Here are brief descriptions of the topics available in the Resource Center.

• Overview and Tutorials. A description of Mathcad’s features, tutorials for gettin
started with Mathcad, and tutorials for getting  more out of Mathcad’s  data anal
graphing, and worksheet creation features.

• QuickSheets and Reference Tables. Over 300 QuickSheets – “recipes” take yo
through a wide variety of common mathematical tasks that you can modify for y
own use. Tables for looking up physical constants, chemical and physical data
mathematical formulas you can use in your Mathcad worksheets.

• Extending Mathcad. Samples showing the use of MathCad components and
Add-ins.

• Collaboratory. A connection to MathSoft’s free Internet forum lets you consu
with the world-wide community of Mathcad users.

• Web Library. A built-in connection to regularly updated content and resources
Mathcad users.
22  Chapter 3  Online Resources
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• Mathcad.com. MathSoft’s Web page with access to Mathcad and mathematic
resources and the latest information from MathSoft.

• Training/Support. Information on Mathcad training and support available from
MathSoft.

• Web Store. MathSoft’s Web store where you can get information on and purch
Mathcad add-on products and the latest educational and technical profession
software products from MathSoft and other choice vendors.

)LQGLQJ�,QIRUPDWLRQ�LQ�DQ�(OHFWURQLF�%RRN
The Resource Center is a Mathcad Electronic Book. As in other hypertext systems, you
move around a Mathcad Electronic Book simply by clicking on icons or underline
text. The mouse pointer automatically changes into the shape of a hand when it h
over a hypertext link, and a message in the status bar tells you what will happen 
you click the link. Depending on how the book is organized, the activated link 
automatically opens the appropriate section or displays information in a pop-up 
window.

You can also use the buttons on the toolbar at the top of the Electronic Book win
to navigate and use content within the Electronic Book:

���

 %XWWRQ )XQFWLRQ

Links to the Table of  Contents or home page, the page that appears
you first open the Electronic Book.

Opens a toolbar for entering a Web address.

Backtracks to whatever document was last viewed.

Reverses the last backtrack.

Goes backward one section in the Electronic Book.

Goes forward one section in the Electronic Book.

Displays a list of documents most recently viewed.

Searches the Electronic Book for a particular term.

Copies selected regions to the Clipboard.

Saves current section of the Electronic Book.

Prints current section of the Electronic Book.
Resource Center and Electronic Books 23
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Mathcad keeps a record of where you’ve been in the Electronic Book. When you 

, Mathcad backtracks through your navigation history in the Electronic Book
Backtracking is especially useful when you have left the main navigation sequen
a worksheet to look at a hyperlinked cross-reference. Use this button to return to a
worksheet.

If you don’t want to go back one section at a time, click . This opens a Histo
window from which you can jump to any section you viewed since you first open
the Electronic Book. 

)XOO�WH[W�VHDUFK

In addition to using hypertext links to find topics in the Electronic Book, you can sea
for topics or phrases. To do so:

1. Click  to open the Search dialog 
box.

2. Type a word or phrase in the “Search 
for” text box. Select a word or phrase 
and click “Search” to see a list of 
topics containing that entry and the 
number of times it occurs in each 
topic. 

3. Choose a topic and click “Go To.” 
Mathcad opens the Electronic Book 
section containing the entry you want 
to search for. Click “Next” or 
“Previous” to bring the next or previous occurrence of the entry into the windo

$QQRWDWLQJ�DQ�(OHFWURQLF�%RRN
A Mathcad Electronic Book is made up of fully interactive Mathcad worksheets. Y
can freely edit any math region in an Electronic Book to see the effects of chang
parameter or modifying an equation. You can also enter text, math, or graphics 
annotations in any section of your Electronic Book, using the menu commands on
Electronic Book window and the Mathcad toolbars. 

7LS By default any changes or annotations you make to the Electronic Book are displayed in an 
annotation highlight color. To change this color, choose Color⇒Annotation from the Format 
menu. To suppress the highlighting of Electronic Book annotations, remove the check from 
Highlight Changes on the Electronic Book’s Book menu.
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6DYLQJ�DQQRWDWLRQV

Changes you make to an Electronic Book are temporary by default: your edits disappear 
when you close the Electronic Book, and the Electronic Book is restored to its original 
appearance the next time you open it. You can choose to save annotations in an 
Electronic Book by checking Annotate Book on the Book menu or on the pop-up menu 
that appears when you right-click. Once you do so, you have the following annotation 
options:

• Choose Save Section from the Book menu to save annotations you made in the
current section of the Electronic Book, or choose Save All Changes to save all 
changes made since you last opened the Electronic Book. 

• Choose View Original Section to see the Electronic Book section in its original
form. Choose View Edited Section to see your annotations again.

• Choose Restore Section to revert to the original section, or choose Restore All to 
delete all annotations and edits you have made to the Electronic Book.

&RS\LQJ�,QIRUPDWLRQ�IURP�DQ�(OHFWURQLF�%RRN
There are two ways to copy information from an Electronic Book into your Mathc
worksheet:

• You can use the Clipboard. Select text or equations in the Electronic Book u

one of the methods described in “Selecting Regions” on page 10, click  on
Electronic Book toolbar or choose Copy from the Edit menu, click on the 
appropriate spot in your worksheet, and choose Paste from the Edit menu.

• You can drag regions from the Book window and drop them into your worksh
Select the regions as above, then click and hold down the mouse button ove
of the regions while you drag the selected regions into your worksheet. The reg
are copied into the worksheet when you release the mouse button.

:HE�%URZVLQJ�
If you have Internet access, the Web Library button in the Resource Center conn
you to a collection of Mathcad worksheets and Electronic Books on the Web. You
also use the Resource Center window to browse to any location on the Web and
standard Hypertext Markup Language (HTML) and other Web pages, in addition to 
Mathcad worksheets. You have the convenience of accessing all of the Internet’s
information resources right in the Mathcad environment.

1RWH When the Resource Center window is in Web-browsing mode, Mathcad is using a Web-
browsing OLE control provided by Microsoft Internet Explorer. Web browsing in Mathcad 
requires Microsoft Internet Explorer version 4.0 or higher to be installed on your system, but it 
does not need to be your default browser. Although Microsoft Internet Explorer is available for 
installation when you install Mathcad, refer to Microsoft Corporation’s Web site at http://
www.microsoft.com/ for licensing and support information about Microsoft Internet 
Explorer and to download the latest version.
Resource Center and Electronic Books 25



 that 

ource 
To browse to any Web page from within the Resource Center window:

1. Click  on the Resource Center toolbar. As shown below, an additional toolbar 
with an “Address” box appears below the Resource Center toolbar to indicate
you are now in a Web-browsing mode:

2. In the “Address” box type a Uniform Resource Locator (URL) for a document on 
the Web. To visit the MathSoft home page, for example, type
http://www.mathsoft.com/ and press [Enter]. If you have Internet 
access and the server is available, the requested page is loaded in your Res
Center window. If you do not have a supported version of Microsoft Internet 
Explorer installed, you must launch a Web browser.

The remaining buttons on the Web Toolbar have the following functions:

1RWH When you are in Web-browsing mode and right-click on the Resource Center window, Mathcad 
displays a pop-up menu with commands appropriate for viewing Web pages. Many of the 
buttons on the Resource Center toolbar remain active when you are in Web-browsing mode, so 
that you can copy, save, or print material you locate on the Web, or backtrack to pages you 

previously viewed. When you click , you return to the Table of Contents for the Resource 
Center and disconnect from the Web.

7LS You can use the Resource Center in Web-browsing mode to open Mathcad worksheets anywhere 
on the Web. Simply type the URL of a Mathcad worksheet in the “Address” box in the Web 
toolbar.

%XWWRQ )XQFWLRQ

Bookmarks current page.

Reloads the current page.

Interrupts the current file transfer.
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Mathcad provides several ways to get support on product features through an extensive 
online Help system. To see Mathcad’s online Help at any time, choose Mathcad Help 

from the Help menu, click  on the Standard toolbar, or press [F1]. Mathcad’s Help 
system is delivered in Microsoft’s HTML Help environment, as shown in Figure 3-2
You can browse the Explorer view in the Contents tab, look up terms or phrases o
Index tab, or search the entire Help system for a keyword or phrase on the Sear

1RWH To run the Help, you must have Internet Explorer 3.02 or higher installed, but not necessarily set 
as your default browser.

You can get context-sensitive help while using Mathcad. For Mathcad menu com
mands, click on the command and read the status bar at the bottom of your wind
For toolbar buttons, hold the pointer over the button momentarily to see a tool tip

1RWH The status bar in Mathcad is displayed by default. You can hide the status bar by removing the 
check from Status Bar on the View menu.

You can also get more detailed help on menu commands or on many operators 
error messages. To do so:

1. Click an error message, a built-in function or variable, or an operator.

2. Press [F1] to bring up the relevant Help screen.

Figure 3-2: Mathcad online Help is delivered in HTML Help.
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To get help on menu commands or on any of the toolbar buttons:

1. Press [Shift][F1]. Mathcad changes the pointer into a question mark.

2. Choose a command from the menu. Mathcad shows the relevant Help screen.

3. Click any toolbar button. Mathcad displays the operator’s name and a keybo
shortcut in the status bar.

To resume editing, press [Esc]. The pointer turns back into an arrow.

7LS Choose Tip of the Day from the Help menu for a series of helpful hints on using Mathcad. 
Mathcad automatically displays one of these tips whenever you launch the application if  “S
Tips at Startup” is checked.

6SHFLDO�UHIHUHQFH�DUHDV

There are two special reference areas accessible under the Help menu in Mathcad: 
Author’s Reference and Developer’s Reference.

• The Author’s Reference contains all the information needed to create a Mathcad 
Electronic Book. Electronic Books created with Mathcad’s authoring tools are
browsable through the Resource Center window and, therefore, take advanta
all its navigation tools.

• The Developer’s Reference provides information about all the properties and 
methods associated with each of the MathSoft custom Scriptable Object 
components, including MathSoft Control components and the Data Acquisition 
component. See Chapter 16, “Advanced Computational Features,” for details
also guides advanced Mathcad users through Mathcad’s Object Model, whic
explains the tools needed to access Mathcad’s feature set from within 
another application. Also included are instructions for using C or C++ to create your 
own functions in Mathcad in the form of DLLS.

,QWHUQHW�$FFHVV�LQ�0DWKFDG

Many of the online Mathcad resources described in this chapter are located not on
own computer or on a local network but on the Internet.

To access these resources on the Internet you need:

• Networking software to support a 32-bit Internet (TCP/IP) application. Such 
software is usually part of the networking services of your operating system; 
your operating system documentation for details.

• A direct or dial-up connection to the Internet, with appropriate hardware and 
communications software. Consult your system administrator or Internet acc
provider for more information about your Internet connection.
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Before accessing the Internet through Mathcad, you also need to know whether you 
use a proxy server to access the Internet. If you use a proxy, ask your system 
administrator for the proxy machine’s name or Internet Protocol (IP) address, as well 
as the port number (socket) you use to connect to it. You may specify separate p
servers for each of the three Internet protocols understood by Mathcad: HTTP, for the 
Web; FTP, a file transfer protocol; and GOPHER, an older protocol for access to 
information archives.

Once you have this information, choose Preferences from the View menu, and click 
the Internet tab. Then enter the information in the dialog box.

7KH�&ROODERUDWRU\

If you have a dial-up or direct Internet connection, you can access the MathSoft 
Collaboratory server from the Resource Center home page. The Collaboratory is
interactive Web service that puts you in contact with a community of Mathcad us
The Collaboratory consists of a group of forums that allow you to contribute Math
or other files, post messages, and download files and read messages contribute
other Mathcad users. You can also search the Collaboratory for messages conta
key word or phrase, be notified of new messages in forums that interest you, and
only the messages you haven’t read yet. You’ll find that the Collaboratory combi
some of the best features of a computer bulletin board or an online news group 
the convenience of sharing worksheets and other files created 
using Mathcad. 

/RJJLQJ�LQ
To open the Collaboratory, choose Resource Center from the Help menu and click on 
the Collaboratory icon. Alternatively, you can open an Internet browser and go to
Collaboratory home page:

http://collab.mathsoft.com/~mathcad2000/

You’ll see the Collaboratory login screen in a browser window:
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The first time you come to the login screen of the Collaboratory, click “New User
This brings you to a form that you can fill out with your name and other required 
optional information about yourself. 

1RWH MathSoft does not use this information for any purposes other than for your participation in the 
Collaboratory.

Click “Create” when you are finished filling out the form. In a short while, check yo
email box for an email message with your login name and password. Go back to
Collaboratory, enter your login name and password given in the email message 
click “Log In.” You see the main page of the Collaboratory:

A list of forums and messages appears on the left side of the screen. The toolbar
top of the window gives you access to features such as search and online Help.

7LS After logging in, you may want to change your password to one you will remember. To do so, 
click More Options on the toolbar at the top of the window, click Edit User Profile and enter a 
new password in the password fields. Then click “Save.”

1RWH MathSoft maintains the Collaboratory server as a free service, open to all in the Mathcad
community. Be sure to read the Agreement posted in the top level of the Collaboratory fo
important information and disclaimers.

Figure 3-3: Opening the Collaboratory from the Resource Center. Available 
forums change over time.
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5HDGLQJ�0HVVDJHV�
When you enter the Collaboratory, you will see how many messages are new and how 
many are addressed to your attention. Click these links to see these messages or examine 
the list of messages in the left part of the screen. To read any message in any forum of 
the Collaboratory:

1. Click on the  next to the forum name or click on the forum name.

2. Click on a message to read it. Click the  to the left of a message to see replies 
underneath it. 

3. The message shows in the right side of the window.

Messages that you have not yet read are shown in italics. You may also see a “n
icon next to the messages.

3RVWLQJ�0HVVDJHV
After you enter the Collaboratory, you can go to any forum and post a message 
reply to a message. To post a new message or a reply to an existing one:

1. Click on the forum name to show the messages under it. If you want to reply
message, click on the message.

2. Choose Post from the toolbar at the top of the Collaboratory window to post a n
message. Or, to reply to a message, click Reply at the top of the message in the 
right side of the window. You’ll see the post/reply page in the right side of the
window. For example, if you post a new topic message in the Biology forum,
you see:
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3. Enter the title of your message in the Topic field.

4. Click on any of the boxes below the title to specify whether you want to, for 
example, preview a message, spell check a message, or attach a file.

5. Type your text in the message field.

7LS You can include hyperlinks in your message by entering an entire URL such as
 http://www.myserver.com/main.html.

6. Click “Post” after you finish typing. Depending on the options you selected, th
Collaboratory either posts your message immediately or allows you to previe
It might also display possible misspellings in red with links to suggested spellin

7. If you preview the message and the text looks correct, click “Post.” 

8. If you are attaching a file, a new page appears. Specify the file type and file o
next page and click “Upload Now.”

1RWH For more information on reading, posting messages, and other features of the Collaboratory, 
click Help on the Collaboratory toolbar.

To delete a message that you posted, click on it to open it and click Delete in the 
toolbar just above the message on the right side of the window.

6HDUFKLQJ
To search the Collaboratory, click Search on the Collaboratory toolbar. You can searc
for messages containing specific words or phrases, messages within a certain d
range, or messages posted by specific Collaboratory users.

You can also search the Collaboratory user database for users who are in a par
country or have a particular email address, etc. To do so, click Search Users at th
of the Search page.

&KDQJLQJ�<RXU�8VHU�,QIRUPDWLRQ
When you first logged into the Collaboratory, you filled out a New User Informati
form with your name, address, etc. This information is stored as your user profile
change any of this information or to make changes to the Collaboratory defaults
need to edit your profile.
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To do so:

1. Click More Options on the toolbar at the top of the window.

2. Click Edit Your Profile.

3. Make changes to the information in the form and click “Save.”

You can change information such as your login name and password. You can als
your email address.

2WKHU�)HDWXUHV
The Collaboratory has other features which make it easy to find and provide inform
to the Mathcad community. To perform activities such as creating an address bo
marking messages as read, viewing certain messages, and requesting automati
announcements when specific forums have new messages, choose More Options from 
the Collaboratory toolbar.

The Collaboratory also supports participation via email or a news group. For mo
information on these and other features available in the Collaboratory, click 
Collaboratory Help on the toolbar.

2WKHU�5HVRXUFHV

2QOLQH�'RFXPHQWDWLRQ
The following piece of Mathcad documentation is available in PDF form on the 
Mathcad CD in the DOC folder:

• Mathcad User’s Guide with Reference Manual. This guide with the latest 
information, including updates since the printed edition was created.

You can read this PDF file by installing Adobe Acrobat Reader which is also available 
on the Mathcad CD in the DOC folder. See the readme file in the DOC folder for more 
information about the online documentation.

6DPSOHV�)ROGHU
The SAMPLES folder, located in your Mathcad folder, contains sample Mathcad and 
application files which demonstrate components such as the Axum, Excel, and Smart-
Sketch components. There are also sample Visual Basic applications designed to work 
with Mathcad files. Refer to Chapter 16, “Advanced Computational Features,” for m
information on components and other features demonstrated in the samples. 
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Release notes are located in the DOC folder located in your Mathcad folder. It contains 
the latest information on Mathcad, updates to the documentation, and troubleshooting 
instructions.
34  Chapter 3  Online Resources



hing 

 

.

 and 

o enter 
&KDSWHU��
:RUNLQJ�ZLWK�0DWK

t ,QVHUWLQJ�0DWK

t %XLOGLQJ�([SUHVVLRQV

t (GLWLQJ�([SUHVVLRQV

t 0DWK�6W\OHV

,QVHUWLQJ�0DWK

You can place math equations and expressions anywhere you want in a Mathcad 
worksheet. All you have to do is click in the worksheet and start typing.

1. Click anywhere in the worksheet. You see a small 
crosshair. Anything you type appears at the crosshair.

2. Type numbers, letters, and math operators, or insert them 
by clicking buttons on Mathcad’s math toolbars, to create 
a math region.

You’ll notice that unlike a word processor, Mathcad by default understands anyt
you type at the crosshair cursor as math. If you want to create a text region instead, 
follow the procedures described in Chapter 5, “Working with Text.”

You can also type math expressions in any math placeholder, which appears when you
insert certain operators. See Chapter 9, “Operators,” for more on Mathcad’s 
mathematical operators and the placeholders that appear when you insert them

The rest of this chapter introduces the elements of math expressions in Mathcad
describes the techniques you use to build and edit them.

1XPEHUV�DQG�&RPSOH[�1XPEHUV
This section describes the various types of numbers that Mathcad uses and how t
them into math expressions. A single number in Mathcad is called a scalar. For 
information on entering groups of numbers in arrays, see “Vectors and Matrices” on 
page 37.
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In math regions, Mathcad interprets anything beginning with one of the digits 0–
a number. A digit can be followed by:

• other digits

• a decimal point

• digits after the decimal point

• or appended as a suffix, one of the letters b, h, or o, for binary, hexadecimal, and
octal numbers, or i or j for imaginary numbers. These are discussed in more de
below. See “Suffixes for Numbers” on page 497 in the Appendices for additio
suffixes.

1RWH Mathcad uses the period (.) to signify the decimal point. The comma (,) is used to separate 
values in a range variable definition, as described in “Range Variables” on page 106. So 
you enter numbers greater than 999, do not use either a comma or a period to separate dig
groups of three. Simply type the digits one after another. For example, to enter ten thousan
“10000”. 

,PDJLQDU\�DQG�FRPSOH[�QXPEHUV

To enter an imaginary number, follow it with i or j, as in 1i or 2.5j. 

1RWH You cannot use i or j alone to represent the imaginary unit. You must always type 1i or 1j. If 
you don’t, Mathcad thinks you are referring to a variable named either i or j. When the cursor is 
outside an equation that contains 1i or 1j, however, Mathcad hides the (superfluous) 1.   

Although you can enter imaginary numbers followed by either i or j, Mathcad normally 
displays them followed by i. To have Mathcad display imaginary numbers with j, 
choose Result from the Format menu, click on the Display Options tab, and set 
“Imaginary value” to “ j(J).” See “Formatting Results” on page 115 for a full descriptio
of the result formatting options.

Mathcad accepts complex numbers of the form  (or ), where a and b are 
ordinary numbers.

%LQDU\�QXPEHUV

To enter a number in binary, follow it with the lowercase letter b. For example, 

11110000b represents 240 in decimal. Binary numbers must be less than . 

2FWDO�QXPEHUV

To enter a number in octal, follow it with the lowercase letter o. For example, 25636o 

represents 11166 in decimal. Octal numbers must be less than . 

a bi+ a bj+

231

231
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To enter a number in hexadecimal, follow it with the lowercase letter h. For example, 
2b9eh represents 11166 in decimal. To represent digits above 9, use the upper or 
lowercase letters A through F. To enter a hexadecimal number that begins with a letter, 
you must begin it with a leading zero. If you don’t, Mathcad will think it’s a variab
name. For example, use 0a3h (delete the implied multiplication symbol between 0 
and a) rather than a3h to represent the decimal number 163 in hexadecimal. 

Hexadecimal numbers must be less than .

([SRQHQWLDO�QRWDWLRQ�

To enter very large or very small numbers in exponential notation, just multiply a

number by a power of 10. For example, to represent the number , type 3*10^8.

9HFWRUV�DQG�0DWULFHV����
A column of numbers is a vector, and a rectangular array of numbers is called a matrix. 
The general term for a vector or matrix is an array. 

There are a number of ways to create an array in Mathcad. One of the simplest 
filling in an array of empty placeholders as discussed in this section. This techniq
useful for arrays that are not too large. See Chapter 11, “Vectors, Matrices, and 
Arrays,” for additional techniques for creating arrays of arbitrary size.

7LS You may wish to distinguish between the names of matrices, vectors, and scalars by font. For 
example, in many math and engineering books, names of vectors are set in bold while those of 
scalars are set in italic. See “Math Styles” on page 54 for a description of how to do this.

&UHDWLQJ�D�YHFWRU�RU�PDWUL[

To create a vector or matrix in Mathcad, follow these steps:

1. Choose Matrix from the Insert menu or click  
on the Matrix toolbar. The dialog box shown on the 
right appears.

2. Enter a number of rows and a number of columns in 
the appropriate boxes. In this example, there are two 
rows and three columns. Then click “OK.” Mathcad 
inserts a matrix of placeholders. 

3. Fill in the placeholders to complete the matrix. Press 
[Tab] to move from placeholder to placeholder. 

You can use this matrix in equations, just as you would 
a number.

231

3 108⋅
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7LS The Insert Matrix dialog box also allows you to insert or delete a specified number of rows or 
columns from an array you have already created. See“Changing the size of a vector or m
on page 204.

1RWH Throughout this User’s Guide, the term “vector” refers to a column vector. A column vector is 
simply a matrix with one column. You can also create a row vector by creating a matrix with one 
row and many columns.

6WULQJV
Although in most cases the math expressions or variables you work with in Mathcad 
are numbers or arrays, you can also work with strings (also called string literals or 
string variables). Strings can include any character you can type at the keyboard, 
including letters, numbers, punctuation, and spacing, as well as a variety of special 
symbols as listed in “ASCII codes” on page 501. Strings differ from variable name
numbers because Mathcad always displays them between double quotes. You c
assign a string to a variable name, use a string as an element of a vector or mat
use a string as the argument to a function.

To create a string:

1. Click on an empty math placeholder in a math 
expression, usually on the right-hand side of a 
variable definition.

2. Type the double-quote (") key. Mathcad displays a 
pair of quotes and an insertion line between them.

3. Type any combination of letters, numbers, 
punctuation, or spaces. Click outside the expression 
or press the right arrow key (→) twice when you are 
finished.

To enter a special character corresponding to one of the ASCII codes, do the following:

1. Click to position the insertion point in the string.

2. Hold down the [Alt] key, and type the number “0” followed immediately by th
number of the ASCII code using the numeric keypad at the right of the keyboard in 
number-entry mode. 

3. Release the [Alt] key to see the symbol in the string. 

For example, to enter the degree symbol (° ) in a string, press [Alt ] and type “0176” 
using the numeric keypad.

1RWH The double-quote key (") has a variety of meanings in Mathcad, depending on the exact location 
of the cursor in your worksheet. When you want to enter a string, you must always have a blank 
placeholder selected.
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Valid strings include expressions such as “The Rain in Spain Falls Mainly on the Pl
“Invalid input: try a number less than -5,” and “Meets stress requirements.” A strin
Mathcad, while not limited in size, always appears as a single line of text in your
worksheet. Note that a string such as “123,” created in the way described above
understood by Mathcad to be a string of characters rather than the number 123.

7LS Strings are especially useful for generating custom error messages in programs, as described in 
Chapter 15, “Programming.” Other string handling functions are listed in “String Functions
page 198. Use strings also to specify system paths for arguments to some Mathcad built-
functions; see “File Access Functions” on page 199. 

1DPHV�����
A name in Mathcad is simply a sequence of characters you type or insert in a math 
region. A name usually refers to a variable or function that you use in your 
computations. Mathcad distinguishes between two kinds of names:

• Built-in names, which are the names of variables and functions that are alwa
available in Mathcad and which you can use freely in building up math express

• User-defined names, which are the names of variables and functions you cre
your Mathcad worksheets.

%XLOW�LQ�QDPHV

Because Mathcad is an environment for numerical and symbolic computation, a 
number of names are built into the product for use in math expressions. These bu
names include built-in variables and built-in functions. 

• Mathcad includes several variables that, unlike ordinary variables, are alread
defined when you start Mathcad. These predefined or built-in variables either have 
a conventional value, like π (3.14159...) or e (2.71828...), or are used as system 
variables to control how Mathcad performs calculations. See “Built-in Variable
on page 102 for more information.

• In addition to these predefined variables, Mathcad treats the names of all bui
units as predefined variables. For example, Mathcad recognizes the name “A
the ampere, “m” as the meter, “s” as the second, and so on. Choose Unit from the 

Insert menu or click  on the Standard toolbar to insert one of Mathcad’s 
predefined units. See “Units and Dimensions” on page 112 for more on built-
units in Mathcad. 

• Mathcad includes a large number of built-in functions that handle a range of 
computational chores ranging from basic calculation to sophisticated curve fit
matrix manipulation, and statistics. To access one of these built-in functions,
can simply type its name in a math region. For example, Mathcad recognizes
name “mean” as the name of the built-in mean function, which calculates the 
arithmetic mean of the elements of an array, and the name “eigenvals” as the 
of the built-in eigenvals function, which returns a vector of eigenvalues for a matr
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Thus, 
You can also choose Function from the Insert menu or click  on the Standard 
toolbar to insert one of Mathcad’s built-in functions. See Chapter 10, “Built-in
Functions,” for a broad overview of Mathcad’s built-in functions.

8VHU�GHILQHG�YDULDEOH�DQG�IXQFWLRQ�QDPHV

Mathcad lets you use a wide variety of expressions as variable or function name

Names in Mathcad can contain any of the following characters:

• Uppercase and lowercase letters.

• The digits 0 through 9. 

• The underscore (_). 

• The prime symbol (’). Note that this is not the same as an apostrophe. You’ll fi
the prime symbol on the same key as the tilde (~) or press [Ctrl][F7] to insert it.

• The percent symbol (%).

• Greek letters. To insert a Greek letter, click a button on the Greek toolbar or 
the equivalent roman letter and press [Ctrl]G. The section “Greek letters” on page
41 gives more details.

• The infinity symbol ∞ that you insert by clicking  on the Calculus toolbar o
by typing [Ctrl][Shift]Z.

The following are examples of valid names:

alpha b

xyz700 A1_B2_C3_D4%%%

F1’ a%%

The following restrictions apply to variable names:

• A name cannot start with one of the digits 0 through 9. Mathcad interprets anyt
beginning with a digit as either an imaginary number (  or ), a binary, oct

or hexadecimal number (e.g., 5o, 7h), or as a number times a variable ( ).

• The infinity symbol ∞ can only appear as the first character in a name.

• Any characters you type after a period (.) appear as a subscript. This is discusse
in “Literal subscripts” on page 41.

• All characters in a name must be in the same font, have the same point size, a
in the same style (italic, bold, etc.). Greek letters can, however, appear in an
variable name. See “Math Styles” on page 54.

• Mathcad does not distinguish between variable names and function names. 
if you define f(x), and later on you define the variable f, you will find that you cannot 
use f(x) anywhere below the definition for f.

2i 3j

3 x⋅
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• Although you can redefine Mathcad’s names for built-in functions, constants, 
units, keep in mind that their built-in meanings will no longer exist after the 
definition. For example, if you define a variable mean, Mathcad’s built-in function 
mean(v) can no longer be used.

1RWH Mathcad distinguishes between uppercase and lowercase letters. For example, diam is a different 
variable from DIAM. Mathcad also distinguishes between names in different fonts, as discussed 
in “Math Styles” on page 54. Thus, Diam is also a different variable from Diam. 

7LS To type symbols such as $ in a name, press [Ctrl][Shift]K, type the symbol(s), and type 
[Ctrl][Shift]K again.

*UHHN�OHWWHUV

There are two ways to enter a Greek variable name in Mathcad:

• Click on the appropriate letter on the Greek toolbar. To see this toolbar, click 
on the Math toolbar or choose Toolbars⇒Greek from the View menu.

• Type the Roman equivalent of the Greek symbol and then press [Ctrl]G. For 
example, to enter φ, press f[Ctrl]G. See “Greek Letters” on page 498 in the 
Appendices for a table of Greek letters and their Roman equivalents.

1RWH Although many of the uppercase Greek letters look like ordinary capital letters, they are not the 
same. Mathcad distinguishes between Greek and Roman letters, even if they appear visually 
equivalent.

7LS Because it is used so frequently, the Greek letter π can also be typed by pressing 
[Ctrl][Shift]P.

/LWHUDO�VXEVFULSWV�

If you include a period in a variable name, Mathcad displays whatever follows th
period as a subscript. You can use these literal subscripts to create variables with names
like  and .

To create a literal subscript, follow these steps:

1. Type the portion of the name that appears before the subscript.

2. Type a period (.) followed by the portion of the name that is to 
become the subscript.

1RWH Do not confuse literal subscripts with array subscripts, which are generated with the left bracket 

key ([) or by clicking  on the Calculator toolbar. Although they appear similar—a litera
subscript appears below the line, like an array subscript, but with a slight space before th
subscript—they behave quite differently in computations. A literal subscript is simply a 
cosmetic part of a variable name. An array subscript represents a reference to an array e
See Chapter 11, “Vectors, Matrices, and Data Arrays,” for a description of how to use subs
with arrays.

velinit uair
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As described in the previous section, certain characters, like letters and digits, make up 
parts of names and numbers. Other characters, like * and +, represent “operators.” 

Operators are symbols like “+” and “−” that link variables and numbers together to 
form expressions. The variables and numbers linked together by operators are ca
operands. For example, in an expression like:

the operands for the “+” are x and y. The operands for the exponent operator are a and 
the expression . 

You type the common arithmetic operators using the standard keystrokes, like * and 
+, used in your spreadsheet and other applications. But all of Mathcad’s operator
be entered with keystrokes or by clicking buttons in the Math toolbars. For exam

you insert Mathcad’s derivative operator by typing ? or by clicking  on the Calculus 
toolbar. Mathcad’s operators are discussed in Chapter 9, “Operators.” See also 
“Operators” on page 447 in the Reference Manual section of this book for a com
list of operators.

%XLOGLQJ�([SUHVVLRQV�

You can create many mathematical expressions by simply typing in a stream of 
characters or by inserting appropriate operators from the Math toolbars. 

For example, if you type the characters

3/4+5^2=

you get the result shown at the right.

On the surface, Mathcad’s equation editor seems very much like a simple text e
but there’s more to it than this. Mathematical expressions have a well-defined stru
and Mathcad’s equation editor is designed specifically to work within that structure
Mathcad, mathematical expressions are not so much typed-in as they are built.

Mathcad automatically assembles the various parts that make up an expression
the rules of precedence and some additional rules that simplify entering denomin

exponents, and expressions in radicals. For example, when you type / or click  on 
the Calculator toolbar to create a fraction, Mathcad stays in the denominator unti
press [Space] to select the entire expression. 

ax y+

x y+
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When you type in names or numbers, Mathcad behaves very much like a standard word 
processor. As you type, you see the characters you type appear behind a vertical editing 
line. The left and right arrow keys move this vertical editing line to the left or to the 
right a character at a time, just as they would in a word processor. There are, however, 
two important differences:

• As it moves to the right, the vertical editing line leaves behind 
a trail. This trail is a “horizontal editing line.” Its importance 
becomes apparent when you begin working with operators.

• Unless the equation you’ve clicked in already has an operator in it, pressing 
[Space] turns the math region into a text region. It is not possible to turn a te
region back into a math region.

7\SLQJ�LQ�2SHUDWRUV
The key to working with operators is learning to specify what variable or expressio
to become an operand. There are two ways to do this: 

• You can type the operator first and fill in the placeholders with operands, or 

• You can use the editing lines to specify what variable or expression you wan
turn into an operand.

The first method feels more like you’re building a skeleton and filling in the detai
later. This method may be easier to use when you’re building very complicated 
expressions, or when you’re working with operators like summation that require m
operands but don’t have a natural typing order.

The second method feels more like straight typing and can be much faster when
expressions are simple. In practice, you may find yourself switching back and for
the need arises.

Here’s how to create the expression  using the first method:

1. Press ̂ to create the exponent operator, or click  on the 
Calculator toolbar. You see two placeholders. The editing lines 
“hold” the exponent placeholder.

2. Click in the lower placeholder and type a.

3. Click in the upper placeholder.

4. Type +.

5. Click in the remaining placeholders and type x and y.

ax y+
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To use the editing lines to create the expression  proceed as follows:

1. Type a. The editing lines hold the a indicating that a becomes the 
first operand of whatever operator you type next.

2. Press ̂  to create the exponent operator. As promised, a becomes the 
first operand of the exponent. The editing lines now hold another 
placeholder. 

3. Type x+y in this placeholder to complete the expression.

Note that in this example, you could type the expression the same way you’d say
loud. However, even this simple example already contains an ambiguity. When 

say “a to the x plus y” there’s no way to tell if you mean  or . For more 
complicated expressions, the number of ambiguities increases dramatically. 

Although you can always resolve ambiguities by using parentheses, doing so ca
quickly become cumbersome. A better way is to use the editing lines to specify t
operands of whatever operator you type. The following example illustrates this b

describing how to create the expression  instead of .

1. Enter a^x as you did in the previous example. Note how the editing 
lines hold the x between them. If you were to type + at this point, 
the x would become the first operand of the plus.

2. Press [Space]. The editing lines now hold the entire expression . 

3. Now type +. Whatever was held between the editing lines now 
becomes the first operand of the plus.

4. In the remaining placeholder, type y.

0XOWLSOLFDWLRQ
A common way to show multiplication between two variables on a piece of paper 
place them next to each other. For example, expressions like ax or  are easily 
understood to mean “a times x” and “a times the quantity x plus y,” respectively. 

This cannot be done with Mathcad variables for the simple reason that when you
ax, Mathcad has no way of knowing whether you mean “a times x” or “the variable 
named ax.” Similarly, when you type a(x+y), Mathcad cannot tell if you mean “a 
times the quantity x plus y” or whether you mean “the function a applied to the argument

.” 

ax y+

ax y+ ax y+

ax y+ ax y+

ax

a x y+( )

x y+
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To avoid ambiguity in your everyday work, we recommend that you always press * 
explicitly to indicate multiplication, as shown in the following example:

1. Type a followed by *. Mathcad inserts a small dot after the “a” to 
indicate multiplication.

2. In the placeholder, type the second factor, x.

1RWH In the special case when you type a numerical constant followed immediately by a variable 
name, such as 4x, Mathcad interprets the expression to mean the constant multiplied by the 

variable: . Mathcad displays a space between the constant and the variable to indicate that 
the multiplication is implied. In this way, you can produce math notation that closely 
approximates the notation you see in textbooks and reference books. However, Mathcad 
reserves certain letters, such as “i” for the imaginary unit and “o” for octal, as suffixes for 
numbers, and in these cases does not attempt to multiply the number by a variable name
rather treats the expression as a single number with a suffix.

7LS You can change the display of the multiplication operator to an X, a thin space, or a large
To do so, click on the multiplication operator with the right mouse button and choose View 
Multiplication As...  Or to change all the multiplication operators in a worksheet, choose 
Options from the Math menu, click on the Display tab, and choose from the selections nex
“Multiplication.” See “Changing the Display of an Operator” on page 130 for additional 
information.

$Q�$QQRWDWHG�([DPSOH�
When it comes to editing equations, knowing how to use the editing lines assumes an 
importance similar to knowing where to put the flashing vertical bar (insertion point) 
you see in most word processors. A word processor can use a simple vertical bar because 
text is inherently one-dimensional, like a line. New letters go either to the left or to the 
right of old ones. An equation, on the other hand, is really two-dimensional, with a 
structure more like a tree with branches than like a line of text. As a result, Mathcad 
has to use a two-dimensional version of that same vertical bar. That’s why there are
two editing lines: a vertical line and a horizontal line.

Suppose, for example, that you want to type the slightly more complicated expre

4 x⋅

x 3 a2⋅–

4– y 1+ π+ +
---------------------------------------
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Watch what happens to the editing lines in the following steps:

1. Type x-3*a^2. Since the editing lines contain just the “2,” 
only the “2” becomes the numerator when you press the /. 

Since we want the whole expression, , to be the 
numerator, we must make the editing lines hold that entire expression.

2. To do so, press [Space]. Each time you press [Space], the 
editing lines hold more of the expression. You need to press 
[Space] three times to enclose the entire expression.

3. Now press / to create a division bar. Note that the numerator 
is whatever was enclosed between the editing lines when you 
pressed /.

4. Now type -4+ and click  on the Calculator toolbar. Then 
type y+1 under the radical to complete the denominator. 

5. To add something outside the radical sign, press [Space] 
twice to make the editing lines hold the radical. For example, 
to add the number π to the denominator, press [Space] twice.

6. Press +. Since the editing lines are holding the entire radical, 
it is the entire radical that becomes the first operand when you 
press +.

7. Click  on the Calculator toolbar or press 
[Ctrl][Shift]P. This is one of Mathcad’s built-in variables.

(GLWLQJ�([SUHVVLRQV

This section describes how to make changes to an existing expression.

&KDQJLQJ�D�1DPH�RU�1XPEHU������
To edit a name or number:

1. Click on it with the mouse. This places the vertical editing line where you clic
the mouse. 

2. Move the vertical editing line if necessary by pressing the [→] and [←] keys.

3. If you type a character, it appears just to the left of the vertical editing line. Pres
[Bksp] removes the character to the left of the vertical editing line. Pressing 
[Delete] removes the character to the right of the vertical editing line.

If you need to change several occurrences of the same name or number, you ma
it useful to choose Replace from the Edit menu. To search for a sequence of characte
choose Find from the Edit menu. These commands are discussed further in “Text
Tools” on page 67.

x 3 a2⋅–
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The easiest place to insert an operator is between two characters in a name or two 
numbers in a constant. For example, here’s how to insert a plus sign between tw
characters:

1. Place the editing lines where you want the plus sign to be.

2. Press the + key, or click  on the Calculator toolbar.

1RWH You never need to insert a space when typing an equation. Mathcad inserts spaces automatically 
around operators wherever doing so is appropriate. If you do try to insert a space, Mathcad 
assumes you meant to type text rather than math and converts your math region into a text region 
accordingly.

Operators such as division and exponentiation result in more dramatic formatting
changes. For example, when you insert a divide sign, Mathcad moves everything
comes after the divide sign into the denominator. Here’s how you insert a divide 

1. Place the editing lines where you want the divide sign to be. 

2. Press the / key or click  on the Calculator toolbar. Mathcad 
reformats the expression to accommodate the division.

Some operators require only one operand. Examples are the square root, absolute
and complex conjugate operators. To insert one of these, place the editing lines on
side of the operand and press the appropriate keystroke. Many of these operato

available on the Calculator toolbar as well. For example, to turn x into  do the 
following:

1. Place the editing lines around the “x,” either preceding or following 
the character.

2. Press \ to insert the square root operator, or click  on the 
Calculator toolbar.

$SSO\LQJ�DQ�2SHUDWRU�WR�DQ�([SUHVVLRQ
The methods described in the previous section work most predictably when you 
to apply an operator to a variable or a number. If, however, you want to apply an ope
to an entire expression, there are two ways to proceed:

• Surround that expression in parentheses and proceed as described in the pr
section, or

• Use the editing lines to specify the expression to which you want to apply the
operator.

x
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Although the first method may be more intuitive, it is slower since you need to type a 
pair of parentheses. The more efficient, second method is the subject of this section. 
The sections “Inserting Parentheses” on page 51 and “Deleting Parentheses” on
52 describe ways to work with parentheses more efficiently. 

The editing lines consist of a horizontal line and a vertical line that moves left to r
along the horizontal line. To make an operator apply to an expression, select the
expression by placing it between the two editing lines. The following examples s
how typing *c results in completely different expressions depending on what 
was selected.

• Here, the two editing lines hold only the numerator. This means 
any operator you type will apply only to the numerator.

• Typing *c results in this expression. Note how the expression 
held between the editing lines became the first operand of the 
multiplication.

• Here, the editing lines hold the entire fraction. This means any 
operator you type will apply to the entire fraction.

• Typing *c results in this expression. Note how everything 
between the editing lines became the first operand of the 
multiplication. 

• Here, the editing lines hold the entire fraction as they did in the 
previous example. However, this time the vertical editing line 
is on the left side instead of on the right side. 

• Typing *c results in this expression. Note how the expression 
enclosed by the editing lines became the second rather than the 
first operand of the multiplication. This happened because the 
vertical editing line was on the left side rather than the right side. 

&RQWUROOLQJ�WKH�HGLWLQJ�OLQHV

You use the following techniques to control what’s between the editing lines:

• Click on an operator. Depending on where on the operator you click, you’ll fin
the vertical editing line either on the left or on the right of the operator, with th
horizontal line selecting an operand of the operator. If you want to move the ver
editing line from one side to the other of the currently selected expression, p
[Insert].

• Use the left and right arrow keys to move the vertical editing line one charact
a time. The horizontal editing line selects an operand of the nearest operator. If
expression contains built-up fractions, you can also use the up and down arrow
to move the editing lines.
48  Chapter 4  Working with Math



ting 
e 

rted.

 ever 

ssion 
 arrow 
p in 
s 
lves 
• Press [Space] to select progressively larger parts of the expression with the edi
lines. Each time you press [Space], the editing lines enclose more and more of th
expression, until eventually they enclose the entire expression. Pressing [Space] 
one more time brings the editing lines back to where they were when you sta

7LS You can also drag-select parts of an expression to hold it between the editing lines. When you 
do this, the selected expression is highlighted in reverse video. Note that whatever you type next 
overwrites the highlighted expression.

The following example walks you through a short cycle of using [Space]:

1. This is the starting position. The two editing lines hold just the 
single variable “d.”

2. Pressing [Space] makes the editing lines grow so that they now 
hold the entire denominator.

3. Pressing [Space] once makes the editing lines grow again so that 
they now hold the entire expression. 

4. At this point, the editing lines can’t become any longer. Pressing 
[Space] brings the editing lines back to the starting point of the 
cycle.

You’ll notice that in stepping through the previous cycle there was never an 
intermediate step in which the editing lines held just the numerator. Nor was there
a step in which the editing lines held just the a or just the b in the numerator. That’s 
because the sequence of steps the editing lines go through as you press [Space] 
depends on the starting point of the cycle.

To set the starting point of the cycle, either click on the appropriate part of the expre
as described earlier, or use the arrow keys to move around the expression. The
keys walk the editing lines through the expression in the indicated direction. Kee
mind, however, that the idea of “up” and “down” or “left” and “right” may not alway
be obvious, particularly when the expression becomes very complicated or if it invo
summations, integrals, and other advanced operators.

1RWH Editing of strings differs from editing of other math expressions because you must use the arrow 
keys or click outside the string to move out of a string. Pressing [Space], which can be used 
in other expressions to change the position of the editing lines, is interpreted as just another 
character in a string.
Editing Expressions 49
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To delete an operator connecting two variable names or constants:

1. Place the vertical editing line after the operator.

2. Press [BkSp].

Now you can easily insert a new operator to replace the one you deleted 
just by typing it in.

7LS You can also delete an operator by placing the editing lines before it and pressing [Delete]. 

In the above examples, it is easy to see what “before” and “after” mean because
expressions involved naturally flow from left to right, the same way we read. Fract
behave the same way. Since we naturally say “a over b,” putting the editing lines “after” 
the division bar means putting them just before the b. Similarly, putting the editing lines 
“before” the division bar means putting them immediately after the a. The following 
example illustrates this:

1. Place the vertical editing lines after the division bar. 

2. Press [BkSp].

To delete an operator having only one operand (for example, ,  or ):

1. Position the editing lines just after the operator. 

2. Press [BkSp].

For certain operators, it may not be clear where to put the editing lines. 
For example, it is not clear when looking at  or  what “before” and “after” mea
When this happens, Mathcad resolves the ambiguity by referring to the spoken f
of the expression. For example, since you read  as “x conjugate,” the bar is treated as
being after the x.

5HSODFLQJ�DQ�2SHUDWRU
To replace an operator after deleting it between two variables or constants or on a 
variable, as shown in the steps above, simply type the new operator after pressi
[BkSp].

To replace an operator between two expressions:

1. Position the editing lines just after the operator.

2. Press [BkSp]. An operator placeholder appears.

3. Type the new operator.

x x x!

x x

x
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The minus sign that means “negation” uses the same keystroke as the one that 
“subtract.” To determine which one to insert, Mathcad looks at where the vertica
editing line is. If it’s on the left, Mathcad inserts the “negation” minus sign. If it’s 
the right, Mathcad inserts the “subtract” minus sign. To move the vertical editing 
from one side to the other, use [Insert].

The following example shows how to insert a minus sign in front of “sin(a).”

1. Click on the sin(a). If necessary, press [Space] to select the entire 
expression.

2. If necessary, press [Insert] to move the vertical editing line all 
the way to the left.

3. Type -, or click  on the Calculator toolbar, to insert a minus 
sign.

If what you really want to do is turn  into , insert another operato
(say, “+”) as described in the section “Inserting an Operator” on page 47. Then re
the operator with a minus sign as described in the section “Deleting an Operator

page 50. Notice that in Mathcad the unary negation symbol in the expression 

appears smaller than the minus sign in expressions such as .

1RWH When you are replacing an operator and the operator placeholder is showing, select an 
expression, rather than a single variable, to the right of the operator placeholder and type - in 
order to put a subtraction minus sign in the placeholder. Otherwise Mathcad inserts a negation 
sign.

,QVHUWLQJ�3DUHQWKHVHV����
Mathcad places parentheses automatically as needed to maintain the precedenc
operations. There may be instances, however, when you want to place parenthe
clarify an expression or to change the overall structure of the expression. You can 
insert a matched pair of parentheses all at once or insert the parentheses one at
We recommend you insert a matched pair since this avoids the possibility of unma
parentheses.

To enclose an expression with a matched pair of parentheses:

1. Select the expression by placing it between the editing lines. Do 
this by clicking on the expression and pressing [Space] one or 
more times.

2. Type the single-quote key (‘ ), or click  on the Calculator 
toolbar. The selected expression is now enclosed by 
parentheses. 

a( )sin 1 a( )sin–

a( )sin–

1 a( )sin–
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It is sometimes necessary to insert parentheses one at a time using the ( and ) keys. 

For example, to change  to  do the following:

1. Move the editing lines just to the left of the b. Make sure the 
vertical editing line is on the left as shown. Press [Insert] if 
necessary to move it over.

2. Type ( and click to the right of the c. Make sure the vertical 
editing line is to the right as shown. Press [Insert] if 
necessary to move it over.

3. Type ).

'HOHWLQJ�3DUHQWKHVHV
You cannot delete one parenthesis at a time. Whenever you delete one parenthesis, 
Mathcad deletes the matched parenthesis as well. This prevents you from inadvertently 
creating an expression having unmatched parentheses.

To delete a matched pair of parentheses:

1. Move the editing lines to the right of the “(”.

2. Press [BkSp]. Note that you could also begin with the editing 
lines to the left of the “)”and press [Delete] instead.

$SSO\LQJ�D�)XQFWLRQ�WR�DQ�([SUHVVLRQ�
To turn an expression into the argument of a function, follow these steps:

1. Click in the expression and press [Space] until the entire 
expression, , is held between the editing lines. 

2. Type the single-quote key (‘ ), or click  on the Calculator 
toolbar. The selected expression is enclosed by parentheses.

3. Press [Space ]. The editing lines now hold the parentheses 
as well.

4. If necessary, press the [Insert ] key so that the vertical 
editing line switches to the left side. If the vertical editing line 
is already on the left side, skip this step.

5. Now type the name of the function. If the function you wish 
to use is a built-in function, you can also choose Function 

from the Insert menu or click  on the Standard toolbar 
and double-click the name of the function.

a b– c+ a b c+( )–

w t⋅ k z⋅–
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The menu commands Cut, Copy, and Paste from the Edit menu are useful for editing 
complicated expressions. They function as follows:

• Cut (  on the Standard toolbar or [Ctrl]X on the keyboard) deletes whateve
is between the editing lines and copies it to the Clipboard.

• Copy (  on the Standard toolbar or [Ctrl]C on the keyboard) takes whateve
is between the editing lines and copies it to the Clipboard.

• Paste (  on the Standard toolbar or [Ctrl]V on the keyboard) takes whateve
is on the Clipboard and places it into your worksheet, either into a placeholde
into the blank space between other regions.

The Copy and Paste commands use the Clipboard to move expressions from one p
to another. You can, however, bypass the Clipboard by using Mathcad’s equation drag 
and drop feature.

Suppose you want to build the expression

1. Drag-select the argument to the cosine 
function so that it is highlighted in reverse 
video.

2. Press and hold down [Ctrl] and the mouse 
button. The pointer changes to indicate that it 
carries the selected expression with it. It 
continues to carry the selected expression until you release the mouse butto

3. With the mouse button still held down, drag 
the pointer over the placeholder.

4. Release the mouse button. The pointer drops 
the expression into the placeholder. It then 
recovers its original form.

7LS You can drag and drop expressions, or even entire math regions, into placeholders in other 
expressions or into any blank space in your worksheet. Just be sure you don’t let go of the 
button before you’ve dragged the expression to wherever you want to drop it. If you’re tryin
drop the expression into a placeholder, be sure to position the pointer carefully over the 
placeholder.

'HOHWLQJ�3DUWV�RI�DQ�([SUHVVLRQ�
You can delete part of an expression by using either the [Delete] key or the [BkSp] 
key. If you use this method, whatever you delete is not placed on the Clipboard. This 
is useful when you intend to replace whatever you delete with whatever is currently on 
the Clipboard. 

wt x+( )cos wt x+( )sin+
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To delete part of an expression without placing it on the Clipboard:

1. Drag-select the part of the expression (in this case, the 
numerator) so that it is highlighted in reverse video.

2. Press [Delete] or [BkSp]. This removes the numerator and 
leaves behind a placeholder.

1RWH If you select an expression with the editing lines instead of drag-
selecting as shown above, you must press [Bksp] or [Delete] twice to remove it. In this case, 
[Bksp] removes the expression to the left of the editing lines, and [Delete] removes to the 
right.

0DWK�6W\OHV���

You may already have encountered styles in your other applications to determine the 
appearance of text or other elements. By making changes to text styles rather than to 
individual text elements in a word processing document, you can make sweeping and 
strikingly uniform changes in the way that documents looks. (See Chapter 5, “Wor
with Text,” for an explanation of Mathcad’s text styles) You can get this same kin
leverage by using math styles to assign particular fonts, font sizes, font styles and 
effects, and colors to the elements of your math expressions. 

Mathcad has predefined math styles that govern the default appearance of all the
in your worksheet, but you can define and apply additional styles to enhance the
appearance of your equations.

Mathcad’s predefined math styles are:

• Variables, which governs the default appearance of all variables.

• Constants, which governs the default appearance of all numbers you type in m
regions as well as all numbers that appear in results.

Whenever you type a variable name, Mathcad: 

• Assigns to it a math style named “Variables.”

• Displays the variable name using the characteristics associated with the style n
“Variables.”

Similarly, when you type a number or when a result is calculated, Mathcad:

• Assigns to it a math style named “Constants.”

• Displays the number using the characteristics associated with the style name
“Constants.”

(GLWLQJ�0DWK�6W\OHV
To change Mathcad’s default style for all variables and plots:

1. Click on a variable name in your worksheet.
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2. Choose Equation from the Format menu. 
The style name “Variables” is selected.

3. Click “Modify” to change the font associated 
with the “Variables” style. You’ll see a dialog 
box for changing fonts.

4. Make any changes using the dialog box and 
click “OK.” Mathcad changes the font of all 
variables in the worksheet.

If you change the Variables style, you may also 
want to change the style used for numbers so that the two look good together. To

1. Click on a number. 

2. Choose Equation from the Format menu to see the Equation Format dialog bo
The style name “Constants” is now selected.

3. Follow the procedure given above for modifying the Variables style. 

You can also use the Formatting toolbar to change the font, font size, or font sty
associated with a math style. For example, to use the Formatting toolbar to modify 
of the settings for the Variables math style, click on a variable, then click on the 
appropriate Formatting toolbar button to make variables bold, italic, or underline
to specify the font or point size in the drop-down lists.

1RWH Mathcad’s line-and-character grid does not respond automatically to changes in the font 
used in text and math. Changing font characteristics, particularly font sizes, may cause re
to overlap. You can separate these regions by choosing Separate Regions from the Format 
menu.

You may wish to have your equations display in a different color than your default text 
regions to avoid confusing the two. To change the default color of all equations in your 
worksheet,

1. Choose Equation from the Format menu. 

2. Select a color in the “Default Equation Color” drop-down list.

3. Click “OK.”

$SSO\LQJ�0DWK�6W\OHV
The “Variables” and “Constants” styles govern the default appearance of all mat
your worksheet. These two style names cannot be changed. You may, however, 
and apply additional math styles, named as you choose, in your worksheets and
templates.

To see what math style is currently assigned to a name or number, simply click i
name or number, and look at the style window on the Formatting toolbar.
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Alternatively, click the name or number and 
choose Equation from the Format menu. The 
math style associated with whatever you clicked 
on appears in the drop-down list in the Equation 
Format dialog box. 

If you click on the button to the right of 
“Variables” in either the Formatting toolbar or the 
Equation Format dialog box, you’ll see a drop-
down list of available math styles. If you now 
choose “User 1” and click “OK,” a new math style is applied to the selected elem
and its appearance changes accordingly. 

In this way you can apply any of a variety of math styles to:

• individual variable names in an expression, or

• individual numbers in a math expression (but not in computed results, which alw
display in the “Constants” style).

For example, many math books show vectors in a bold, underlined font. If you wa
use this convention, do the following:

1. Choose Equation from the Format menu.

2. Click the down arrow beside the name of the current math styles to see a drop-
list of available math styles.

3. Click on an unused math style name like “User 1” to select it. The name “Use
should now appear in the “New Style Name” text box. Click in this text box an
change the name to something like “Vectors.”

4. Click “Modify” to change this style to a bold, underlined font.

This creates a math style called “Vectors” with the desired appearance. When y
done defining the style, click “OK.”

Now rather than individually changing the font, font size, and font style for name
vectors, you can simply change their math styles. 

1RWH All names, whether function names or variable names, are font sensitive. This means that x and 
x refer to different variables, and f(x) and f(x) refer to different functions. In deciding whether 
two variable names are the same, Mathcad actually checks math styles rather than fonts. To 
avoid having distinct variables that look identical, don’t create a math style with exactly th
same font, size, and other characteristics as another math style.

6DYLQJ�0DWK�6W\OHV
Once you’ve completed a set of math styles that you like, you need not repeat the p
for other worksheets. You can save math style information by saving a workshee
template. Choose Save As from the File menu and select Mathcad Template (*.mct
as the file type in the Save As dialog box.

To apply math style information to another worksheet, open your template from 
File menu and copy the contents of the worksheet to the template. For more inform
about worksheet templates, see Chapter 7, “Worksheet Management.”
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This section describes how to create text regions in Mathcad. Text regions are useful 
for inserting any kind of text into your worksheets and templates: comments around 
the equations and plots in your worksheet, blocks of explanatory text, background 
information, instructions for the use of the worksheet, and so on. Mathcad ignores text 
when it performs calculations, but you can insert working math equations into text 
regions as described in “Equations in Text” on page 65. 

&UHDWLQJ�D�7H[W�5HJLRQ�
To create a text region, follow these steps. First, click in a blank space in your work
to position the crosshair where you want the text region to begin. Then:

1. Choose Text Region from the Insert menu, or press the 
double-quote (") key. Mathcad begins a text region. The 
crosshair changes into an insertion point and a text box 
appears.

2. Now begin typing some text. Mathcad displays the text and 
surrounds it with a text box. As you type, the insertion point 
moves and the text box grows.

3. When you finish typing the text, click outside the text region. 
The text box disappears.

1RWH You cannot leave a text region simply by pressing [↵]. You must leave the text region by 
clicking outside the region, by pressing [Ctrl][Shift][↵], or by repeatedly pressing one of 
the arrow keys until the cursor leaves the region.
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To insert text into an existing text region:

• Click anywhere in a text region. A text box now surrounds your text. Anything y
type gets inserted at the insertion point. 

To delete text from an existing text region, click in the text region and:

1. Press [BkSp] to delete the character to the left of the insertion point, or

2. Press [Delete] to delete the character to the right of the insertion point.

To overtype text:

1. Place the insertion point to the left of the first character you want to overtype

2. Press [Insert] to begin typing in overtype mode. To return to the default insert 
mode, press [Insert] again. 

You can also overtype text by first selecting it (see “Selecting Text” on page 59)
Whatever you type next replaces your selection.

7LS To break a line or start a new line in a text region, press [↵]. Mathcad inserts a hard return and 
moves the insertion point down to the next line. Press [Shift][↵] to start a new line in the same 
paragraph. When you rewrap the text by changing the width of the text region, Mathcad 
maintains line breaks at these spots in the text. 

0RYLQJ�WKH�,QVHUWLRQ�3RLQW
In general, you move the insertion point within text regions by clicking with the mo
wherever you want to put the insertion point. However, you can also use the arrow
to move the insertion point. 

The arrow keys move the insertion point character by character or line by line w
text. Pressing [Ctrl] and an arrow key moves the insertion point word by word or li
by line. These and other ways of moving the insertion point are summarized bel

.H\ $FWLRQ

[→] Move right one character.

[←] Move left one character.

[↑] Move up to the previous line.

[↓] Move down to the next line.

[Ctrl][→] Move to the end of the current word. If the insertion point is alread
there, move to the end of the next word.

[Ctrl][←] Move to the beginning of the current word. If the insertion point is
already there, move to the beginning of the previous word.

[Ctrl][↑] Move to the beginning of the current line. If the insertion point is 
already there, move to the beginning of the previous line.

[Ctrl][↓] Move to the end of the current line. If the insertion point is already
there, move to the end of the next line.

[Home] Move to the beginning of the current line.

[End] Move to the end of the current line.
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6HOHFWLQJ�7H[W�
One way to select text within a text region is:

1. Click in the text region so that the text box appears.

2. Drag across the text holding the mouse button down.

Mathcad highlights the selected text, including any full lines 
between the first and last characters you selected.

2Q�OLQH�+HOS You can also select text using arrow keys and multiple clicks of the mouse button, just as you 
can in most word processing applications. For more information, refer to the topic “Select
text” in the on-line Help.

Once text is selected, you can delete it, copy it, cut it, check the spelling, or change its 
font, size, style, or color. 

7LS Once you’ve cut or copied text to the Clipboard, you can paste it back into any text region o
an empty space to create a new text region.

To select and move an entire text region or group of regions, follow the same steps that 
you would use with math regions, described on “Moving and Copying Regions” on 
page 10. To perform other editing actions, select the regions, and then choose Cut, 
Delete, Paste, or Copy from the Edit menu, or click the corresponding buttons on th
Standard toolbar.

*UHHN�/HWWHUV�LQ�7H[W
To type a Greek letter in a text region, use one of these two methods:

• Click on the appropriate letter on the Greek toolbar. To see this toolbar, click 
on the Math toolbar, or choose Toolbars⇒Greek from the View menu, or

• Type the Roman equivalent of the Greek symbol and then press [Ctrl]G. For 
example, to enter φ, press f[Ctrl]G. See “Greek Letters” on page 498 in the 
Appendices for a table of Greek letters and their Roman equivalents.

7LS As discussed in the section “Inserting Math” in Chapter 4, typing [Ctrl]G after a letter in a math 
region also converts it to its Greek equivalent. In addition, [Ctrl]G converts a non alphabetic 
character to its Greek symbol equivalent. For example, typing [Shift]2[Ctrl]G in a text 
region produces the “≅” character.

To change a text selection into its Greek equivalent, select the text and then:

1. Choose Text from the Format menu.

2. From the Font list select the Symbol font.

You can also change the font of a text selection by using the Formatting toolbar.
Inserting Text 59



-
 you 

low 
&KDQJLQJ�WKH�:LGWK�RI�D�7H[W�5HJLRQ
When you start typing in a text region, the region grows as you type, wrapping only 
when you reach the right margin or page boundary. (The location of the right margin 
is determined by the settings in the Page Setup dialog box, which you can modify by 
choosing Page Setup from the File menu.) Press [↵] whenever you want to start a new 
line. To set a width for your whole text region and have lines wrap to stay within that 
width as you type. To do this:

1. Type normally until the first line reaches the width you want.

2. Type a space and press [Ctrl][↵]. 

All other lines break to stay within this width. When you add to or edit the text, Mathcad 
rewraps the text according to the width set by the line at the end of which you pressed 
[Ctrl][↵]. 

To change the width of an existing text region, do the following:

1. Click anywhere in the text region. A selection box encloses the text region.

2. Move the pointer to the middle of the right edge of the text region until it hovers 
over the “handle” on the selection rectangle. The pointer changes to a double
headed arrow. You can now change the size of the text region the same way
change the size of any window—by dragging the mouse.

7LS You can specify that a text region occupies the full page width by clicking on the region and 
choosing Properties from the Format menu. Click the Text tab and check “Occupy Page 
Width.” As you enter more lines of text into a full-width text region, any regions that are be
are automatically pushed down in the worksheet.

7H[W�DQG�3DUDJUDSK�3URSHUWLHV�

This section describes changing various font properties and changing the alignment 
and indenting of paragraphs within a text region.

&KDQJLQJ�7H[W�3URSHUWLHV�
To change the font, size, style, 
position, or color of a portion of 
the text within a text region, first 
select the text. (See “Selecting 
Text” on page 59.) Then choose 
Text from the Format menu to 
access the Text Format dialog box. 
The Text Format dialog box also 
appears when you click with the 
right mouse button on selected 
text and choose Font from the 
pop-up menu.
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Many of the options of the Text Format dialog box are also available via the buttons 
and drop-down lists on the Formatting toolbar:

When you first insert text, its properties are determined by the worksheet or template 
defaults for the style called “Normal.” See “Text Styles” on page 63 to find out ab
applying and modifying existing text styles and creating new ones for governing 
default appearance of entire text paragraphs or regions. Any properties that you c
for selected text as described here override the properties associated with the style fo
that text region.

7LS If you simply place the insertion point in text and then change the text properties through the 
Text Format dialog box or the Formatting toolbar, any text you now type at that insertion point 
will have the new properties you selected.

You can change the following properties of selected text:

• Font

• Font style

• Font size

• Effects such as subscripts and superscripts

• Color 

Font sizes are in points. Note that some fonts are available in many sizes and o
aren’t. Remember that if you choose a bigger font, the text region you’re in may g
and overlap nearby regions. Choose Separate Regions from the Format menu if 
necessary.

7LS You can specify that a text region automatically pushes following regions down as it grows by 
clicking on the region and choosing Properties from the Format menu. Click the “Text” tab and 
select “Push Regions Down As You Type.” 

7LS As a shortcut for creating subscripts and superscripts in text, use the Subscript and Superscript 
commands on the pop-up menu that appears when you click with the right mouse button 
selected text.

&KDQJLQJ�3DUDJUDSK�3URSHUWLHV
A paragraph in a text region is any stream of characters followed by a hard return, which 
is created when you type [↵]. You can assign distinct properties to each paragraph in 
a text region, including alignment, indenting for either the first or all lines in the 
paragraph, tab stops, and bullets or sequential numbering to begin the paragraph.
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When you first create a text region, its paragraph properties are determined by the 
worksheet or template defaults for the style called “Normal.” See “Text Styles” on p
63 to find out about text styles for governing the default appearance of entire text re
or paragraphs. Any paragraph properties that you change as described here override 
the paragraph properties associated with the style for that text region.

1RWH When you type [Shift][↵] Mathcad inserts a new line within the current paragraph; it does not 
create a new paragraph.

You can change the properties for a paragraph within a text region by doing the 
following: 

1. Select the paragraph by clicking in it 
to place the insertion point, by drag-
selecting it, or by triple-clicking it.

2. Choose Paragraph from the Format 
menu, or click with the right mouse 
button and choose Paragraph from 
the pop-up menu. Mathcad displays 
the Paragraph Format dialog box.

3. Change the appropriate properties in 
the dialog box and click “OK.” 

You can change the following paragraph properties:

,QGHQW

To indent every line in the paragraph the same amount, enter numbers in the “Left
“Right” text boxes. To indent the first line of the paragraph a different amount than th
rest of the lines, as for a conventional or hanging indent, select “First Line” or 
“Hanging” from the “Special” drop-down list and enter a value below.

You can also set indents using the text ruler. Click in a paragraph and choose Ruler 
from the View menu. Move the top or bottom arrow in the ruler to set a different ind
for the first line, or move both arrows to indent all the lines in the paragraph.

%XOOHWV�DQG�QXPEHUHG�OLVWV

To begin the paragraph with a bullet, select “Bullets” from the “Bullets” drop-dow
list. Select “Numbers” from the drop-down list to have Mathcad number success

paragraphs in the region automatically. Alternatively, click  or  on the 
Formatting toolbar.

$OLJQPHQW

To align the paragraph at either the left or right edge of the text region, or to cente
text within the text region, use the three alignment buttons in the dialog box. Alte

tively, click one of the three alignment buttons on the Formatting toolbar: , , 

or . 
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To specify tabs, click the “Tabs” button in the Paragraph Format dialog box to op
the Tabs dialog box. Enter numbers into the “Tab stop position” text box. Click “S
for each tab stop then click “OK.”

Alternatively, you can set tab stops using the text ruler. Click in a paragraph and ch
Ruler from the View menu. Click in the ruler where you want a tab stop to be. A t
stop symbol appears. To remove a tab stop, click on the tab stop symbol, hold the m
button down, and drag the cursor away from the ruler.

7LS To change the measurement system used in the Paragraph Format dialog box or in the text ruler, 
choose Ruler from the View menu to show the text ruler if it is not already showing, click on 
the ruler with the right mouse button, and choose Inches, Centimeters, Points, or Picas from 
the pop-up menu.

7H[W�6W\OHV

Mathcad uses text styles to assign default text and paragraph properties to text regio
Text styles give you an easy way to create a consistent appearance in your works
Rather than choosing particular text and paragraph properties for each individua
region, you can apply an available text style, setting a range of text and paragra
properties at once.

Every worksheet has a default “normal” text style with a particular choice of text 
paragraph properties. Depending on your worksheet and the template from whic
worksheet is derived, you may have other predefined text styles to which you can 
to existing or new text regions. You can also modify existing text styles, create n
ones of your own, and delete ones you no longer need. 

This section describes the procedures for applying, modifying, creating, and dele
text styles. See the previous section, “Text and Paragraph Properties,” for detail
the available text and paragraph properties. 

$SSO\LQJ�D�7H[W�6W\OH�WR�D�3DUDJUDSK�LQ�D�7H[W�5HJLRQ
When you create a text region in your worksheet, the region is tagged by default
the “Normal” style. You can, however, apply a different style to each paragraph—e
stream of characters followed by a hard return—within the text region:

1. Click in the text region on the paragraph where 
you want to change the style.

2. Choose Style from the Format menu, or click 
with the right mouse button and choose Style 
from the pop-up menu, to see a list of the avail-
able text styles. Available text styles depend on 
the worksheet template used.
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3. Select one of the available text styles and click “Apply.” The default text in yo
paragraph acquires the text and paragraph properties associated with that st

7LS As an alternative to choosing Style from the Format menu, you can apply a text style to a text 
paragraph simply by clicking in the paragraph and choosing a style from the left-most drop-
down list in the Formatting toolbar. To apply a text style to an entire text region, first select all 
the text in the region. For information on selecting text, refer to “Selecting Text” on page 5

0RGLI\LQJ�DQ�([LVWLQJ�7H[W�6W\OH
You can change the definition of a text style—its text and paragraph properties—a
time.

To modify a text style:

1. Choose Style from the Format menu. Mathcad brings up the Text Styles dialog
box showing the currently available text styles.

2. Select the name of the text style you want to modify and click “Modify.”

3. The Define Style dialog 
box displays the defini-
tions of that text style.

4. Click “Font” to modify 
text formats such as the 
font, font size, font styl-
ing, special effects, and 
color. Click “Paragraph” 
to modify the indenting 
and alignment and other properties for paragraphs. See “Text and Paragraph
Properties” on page 60 for details about the available text and paragraph forma
options. 

5. Click “OK” to save your changes. 

Any new text regions to which you apply the modified text style will reflect the ne
definition for that text style. In addition, any text regions previously created with t
text style will be modified accordingly.

&UHDWLQJ�DQG�'HOHWLQJ�7H[W�6W\OHV
You can modify the list of available text styles in your worksheet by creating new o
and deleting ones you no longer use; any text style changes are saved with you
worksheet. You can base a new text style on an existing text style, such that it inh
text or paragraph properties, or you can create an entirely new style. For example
may want to base a new “Subheading” style on an existing “Heading” style, but ch
a smaller font size, keeping other text and paragraph properties the same. 
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To create a new text style:

1. Choose Style from the Format menu. Mathcad brings up the Text Styles dialog 
box showing the currently available text styles.

2. Click “New” to bring up the Define Style dialog box.

3. Enter a name for the new style in the “Name” text box. If you want to base the
style on one of the existing styles in the current worksheet or template select a
from the “Based on” drop-down list.

4. Click the “Font” button to make your choices for text formats for the new style
Click the “Paragraph” button to choose paragraph formats for the new style.

5. Click “OK” when you have finished defining the new style.

Your new style now appears in the Text Styles dialog box and can be applied to
text region as described in “Applying a Text Style to a Paragraph in a Text Region
page 63. When you save the worksheet, the new text style is saved with it. If you 
to use the new text style in your future worksheets, save your worksheet as a tem
as described in Chapter 7, “Worksheet Management.” You may also copy the text
into another worksheet simply by copying and pasting a styled region into the ne
worksheet.

1RWH If you base a new text style on an existing text style, any changes you later make to the original 
text style will be reflected in the new text style as well.

'HOHWLQJ�D�WH[W�VW\OH

You may delete a text style at any time. To do so:

1. Choose Style from the Format menu. Mathcad brings up the Text Styles dialog
box showing the currently available text styles.

2. Select one of the available text styles from the list.

3. Click “Delete.”

The text style is removed from the list of available text styles. However, any text reg
in your worksheet whose text and paragraph properties were defined in terms of
text style will continue to display the properties of that style.

(TXDWLRQV�LQ�7H[W

This section describes how to insert equations into your text regions. Equations ins
into text have the same properties as those in the rest of your worksheet. You ca
them using the methods described in Chapter 4, “Working with Math.” 
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,QVHUWLQJ�DQ�(TXDWLRQ�LQWR�7H[W
Place an equation into text either by creating a new equation inside a text region or by 
pasting an existing equation into a text region.

To add a new equation into a text region or a paragraph, follow these steps:

1. Click in the text region or paragraph 
to place the insertion point where you 
want the equation to start.

2. Choose Math Region from the
Insert menu. A placeholder appears. 

3. Type in the equation just as you 
would in a math region.

4. When you’ve finished typing in the 
equation, click on any text to return 
to the text region. Mathcad adjusts 
the line spacing in the text region to 
accommodate the embedded math region.

To paste an existing equation into a text region, follow these steps:

1. Select the equation you want to paste into the text.

2. Choose Copy from the Edit menu, or click  on the Standard toolbar.

3. Click in the text region to place the insertion point where you want the equatio
start.

4. Choose Paste from the Edit menu, or click  on the Standard toolbar.

'LVDEOLQJ�(PEHGGHG�(TXDWLRQV
When you first insert an equation into text, it behaves just like an equation in a m
region; it affects calculations throughout the worksheet. If you want the equation t
purely cosmetic, you can disable it so that it no longer calculates. To do so:

1. Click on the equation you want to disable.

2. Choose Properties from the Format menu. Click on the Calculation tab.

3. Click the “Disable Evaluation” check box.

4. Click “OK.”

Once you have done so, the equation can neither affect nor be affected by other
equations in the worksheet. To turn it back on, remove the check next to “Disabl
Evaluation” in the Properties dialog box.

For a more general discussion of disabling and locking equations, see “Disabling
Equations” on page 124.
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Mathcad has tools for finding and replacing text as well as checking the spelling of text.

)LQG�DQG�5HSODFH
Mathcad’s Find and Replace commands on the Edit menu are capable of working in
both text and math regions. By default, however, Mathcad finds and replaces tex
text regions only.

6HDUFKLQJ�IRU�WH[W

To find a sequence of characters:

1. Choose Find from the Edit menu. 
Mathcad brings up the Find dialog 
box.

2. Enter the sequence of characters you 
want to find. 

3. Click “Find Next” to find the occur-
rence of the character sequence im-
mediately after the current insertion point location. Use the available options in
dialog box to search upward or downward in the worksheet, to match whole w
only, to match the case exactly of the characters you entered, and to specify wh
Mathcad should search in text or math regions or both.

2Q�OLQH�+HOS The Help topic “Characters You Can Find and Replace” details the characters you can fin
math and text regions, including Greek symbols. Many special characters, including punctu
and spaces, can be located only in text or math strings.

5HSODFLQJ�FKDUDFWHUV

To search and replace text:

1. Choose Replace from the Edit menu 
to bring up the Replace dialog box.

2. Enter the string you want to find (the 
target string) in the “Find what” box. 

3. Enter the string you want to replace it 
with in the “Replace with” box. Check 
the appropriate boxes to match whole 
words only, to match the case exactly 
of the characters you entered, and to 
specify whether Mathcad should search in text or math regions or both.

You now have the following options:

• Click “Find Next” to find and select the next instance of your target string.

• Click “Replace” to replace the currently selected instance of the string.

• Click “Replace All” to replace all instances of the string.
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After creating text,  Mathcad can search the text for misspelled words and suggest 
replacements. You can also add commonly used words to your personal dictionary. 

1RWH Mathcad spell-checks text regions only, not math or graphics regions.

To begin spell-checking, specify the portion of the worksheet to spell-check:

• Click at the beginning of wherever you want to spell-check. Mathcad spell-che
starting from this point and continues to the end of the worksheet. You can th
either continue the spell-check from the beginning of the worksheet or quit.

• Alternatively, select the text you want to spell-check.

Once you’ve defined a range over which to check spelling:

1. Choose Check Spelling from the Edit 

menu, or click  on the Standard 
toolbar. 

2. When Mathcad finds a misspelled 
word, it opens the Check Spelling di-
alog box. The misspelled word is 
shown along with a suggested replace-
ment or a list of possible replace-
ments. If Mathcad has no immediate 
suggestions, it shows only the misspelled word. 

7LS To determine whether a word is misspelled, Mathcad compares it with the words in two 
dictionaries: a general dictionary of common English words supplemented by mathematical 
terms and a personal dictionary. If Mathcad detects correctly spelled words throughout your 
worksheet you can add them to your personal dictionary. 

After the Check Spelling dialog box appears, you have several options:

• To change the word to the suggested replacement, or to another word you s
from the list of possible replacements, click “Change.”

• Click “Suggest” to see additional but less likely replacements. If Mathcad can o
no additional suggestions, “Suggest” is grayed.

• To change the word to one not listed, type the replacement into the “Change
box and click “Change.”

• To leave the word as is, click “Ignore” or “Add.” If you click “Ignore,” Mathcad
leaves the word alone, continues spell-checking, and ignores all future occurre
of the word. If you click “Add,” the word is added to your personal dictionary.

1RWH To choose a dialect associated with the English dictionary, choose Preferences from the View 
menu, click on the General tab, and choose an option below “Spell Check Dialect.” 
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t ,QVHUWLQJ�2EMHFWV

t ,QVHUWLQJ�*UDSKLFV�&RPSXWDWLRQDOO\�/LQNHG�WR�<RXU�:RUNVKHHW

2YHUYLHZ

To illustrate your Mathcad calculations visually, it is often useful to add graphs, 
pictures, or other objects. You can include the following in your Mathcad worksheet:

• 2D graphs, including X-Y and polar plots

• 3D graphs, including surface plots, contour plots, three-dimensional scatter p
and others

• Pictures based on values in a matrix, copied and pasted from another applic
or based on an image file

• Objects created by another application (.AVI files, .DOC files, .MDI files, etc.)

• Graphics computationally linked to your calculations

For information on creating two-dimensional graphs, see Chapter 12, “2D Plots.” R
to Chapter 13, “3D Plots,” for information on creating three-dimensional graphs.

The sections in this chapter describe how to insert pictures and objects into a Ma
worksheet and format them. The last section of this chapter introduces the proce
inserting a graphic that is computationally linked to your calculations. For a more
detailed discussion of computationally linked applications, see Chapter 16, “Adva
Computational Features.”

,QVHUWLQJ�3LFWXUHV

This section describes techniques for creating and formatting pictures—static graphic 
images—in your Mathcad worksheet.
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You can create a picture in a Mathcad worksheet in the following ways:

• By creating a picture region and supplying either the name of a Mathcad matrix (
matrices) or the name of an external image file.

• By importing an image from another application via the Clipboard.

&UHDWLQJ�SLFWXUHV�IURP�D�PDWULFHV

You can view as a grayscale picture in Mathcad any single matrix by creating a pi
region:

1. Click in a blank space in your Mathcad worksheet.

2. Choose Picture from the Insert menu or click  on the Matrix toolbar.

3. Type the name of a matrix in the placeholder at the bottom of the picture reg

Mathcad creates a 256-shade grayscale representation of the data in the matrix
each matrix element corresponding to a pixel in the picture.

1RWH Mathcad’s picture region assumes a 256-color model with the value 0 represented as bla
255 as white. Numbers outside the range 0–255 are reduced modulo 256, and any nonin
value is treated as if its decimal part has been removed.

To create a color picture in Mathcad, you must define three matrices of the same size 
that describe, respectively, either:

• The red, green, and blue (RGB) components,

• The hue, saturation, and value (Smith’s HSV color model) components, or

• The hue, lightness, and saturation (Otswald’s HLS color model) components
each pixel in the picture.

To view as a color picture in Mathcad any three same-size matrices:

1. Click in a blank space in your worksheet, and choose Picture from the Insert menu.

2. Type the names of the three matrices, separated by commas, in the placeho
the bottom of the picture region.

By default, Mathcad creates a 3-layer, 256-color, or RGB, representation of the d
the matrices. This setting can be changed, however, through the Properties dialo
and the Picture toolbar. See “Modifying a picture” on page 71 for details.

Since the matrices used in picture rendering are usually quite large, this techniq
creating a picture is most useful when you import graphics files into Mathcad as 
matrices as described in “File Access Functions” on page 199. For example, you
use the READBMP function to read an external graphics file into a matrix, and then
view it as a picture in Mathcad.
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Mathcad can create a picture directly from an external image file in any one of a number 
of image file formats, including BMP, JPEG, GIF, TGA, PCX, and more. To do so, 
click in a blank space in your worksheet and then:

1. Choose Picture from the Insert menu, 

or click  on the Matrix toolbar, to 
insert a picture. 

2. In the placeholder, type a string 
containing the name of an image file in 
the current directory, or type a full path 
to an image file. You create a string in 
the placeholder by first typing the 
double-quote (") key.

3. Click outside the picture region. The 
bitmap appears in your worksheet.

Each time you open the worksheet or 
calculate the worksheet, the image file is 
read into the picture region.

1RWH If you modify the source image file, you must recalculate your worksheet to see the modified 
image. If you move the source image file, Mathcad can no longer display the picture.

0RGLI\LQJ�D�SLFWXUH

You can modify the orientation, view (zoom and pan factors), 
brightness, contrast, and grayscale mapping of a picture in 
Mathcad using the Picture toolbar. To do so:

1. Click on the picture so you see hash marks around the 
picture’s border, as shown at the right.

2. The Picture toolbar will pop up. To find out what operation 
each tool performs, hover over it briefly to see its tooltip.

For example, to zoom in on the picture, click  on the Picture toolbar and then
repeatedly click the picture until you reach the desired resolution. To zoom out, z

to window, or reset the zoom factor, click the toolbar buttons  ,  , and 
respectively, to activate those commands.

1RWH If you have the Image Processing Extension Pack or the Communication System Design (CSD) 
Pack, then you already have an Image Viewer component that behaves in a manner similar to a 
picture region. Both the Image Viewer component and a picture region allow you to import 
image files and manipulate them with specialized toolbar options.
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You can change your color model or select an output option under the Properties dialog 
box. To do so:

1. Right-click on the picture and select Properties from the pop-up menu.

2. Under the Input and Output tab of the Properties dialog box, make your adjustments 
in the Input and Output panels, and then click “OK.”

For example, you can send the color map information for a selected rectangle o
picture to a variable in your Mathcad worksheet. You might do this if you want to cr
another picture that only captures part of the whole image. In the Properties dialog
check “Output Selected Rectangle” in the output pane and select a color map op
Once you click “OK,” you need to type a variable name in the placeholder at the
of the picture region.

&UHDWLQJ�D�SLFWXUH�E\�LPSRUWLQJ�IURP�WKH�&OLSERDUG

You can copy an image from another application to the Clipboard and paste it in
Mathcad in one of the formats put on the Clipboard at the time of copying. This se
describes using the Paste Special command on the Edit menu to paste a graphic image
into a Mathcad worksheet from the Clipboard in a noneditable format: as a metaf
bitmap. A metafile, which is strictly a Windows graphic format, can be resized in
Mathcad without undue loss of resolution, whereas a bitmap is usually viewed bes
at its original size. A device-independent bitmap, or DIB, is stored in a bitmap format 
that is portable to other operating systems.

1RWH If you use the Paste command on Mathcad’s Edit menu to paste in an image from the Clipboar
(or use drag-and-drop from another application), you typically paste a linked OLE object into 
your Mathcad worksheet, as discussed in “Inserting Objects” on page 74. When you doub
click a linked OLE object, you activate the application that created the object and are able t
the object in your Mathcad worksheet.

To paste a graphics image from another application into Mathcad, do the following:

1. Open the application and place the graphics image on the Clipboard, usually via a 
Copy command on the Edit menu. Many Windows applications have this feature.

2. Click the mouse wherever you want the image in your Mathcad worksheet.

3. Choose Paste Special from the Edit menu, and choose “Picture (metafile)” or 
“Device Independent Bitmap.” 

4. Click “OK.” Mathcad creates a picture region and puts into it the image stored
the clipboard.

1RWH The format choices in the Paste Special dialog box will vary, depending on the application from 
which you originally copied a picture. 
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Mathcad stores the color depth—the number of colors in the image—at the time
paste it into a worksheet. This means that you can safely resave any worksheets
contain color images on systems that have different color displays, either fewer or 
colors. The images continue to display at the proper color depth on the systems
created the worksheets.

1RWH When you import directly from the Clipboard, the picture information is stored as part of the 
Mathcad worksheet. This makes the file size larger. It also means that when you copy the 
worksheet, the picture information travels along with it. 

1RWH To avoid making your Mathcad file too large, paste bitmaps that have been saved in as few colors 
as possible such as 16 or 256 colors.

)RUPDWWLQJ�D�3LFWXUH
This section describes your options for formatting a picture once you’ve created

5HVL]LQJ�D�SLFWXUH

To resize a picture region, do the following:

1. Click the mouse inside the picture region to select it.

2. Move the mouse pointer to one of the handles along the edge of region. The p
changes to a double-headed arrow.

3. Press and hold down the left mouse button. With the button still held, drag the m
in the direction you want the picture region to be stretched.

7LS When you change the size of the picture region, the picture inside may be distorted. If you resize 
the picture by dragging diagonally on the handle in the lower right corner, you preserve the 
aspect ratio—the ratio of height to width—of the original picture. To restore a picture to its
original size, click on the picture and choose Properties from the Format menu. On the display 
tab of the Properties dialog box, check “Display at Original Size.”

)UDPLQJ�D�SLFWXUH

Mathcad allows you to place a border all the way around a picture region. To do so:

1. Double-click the picture itself, or choose Properties from the Format menu. This 
brings up the Properties dialog box.

2. Click “Show Border.”

3. Click “OK.” Mathcad draws a border around the picture region.

&RQWUROOLQJ�FRORU�SDOHWWHV

If you are using a 256-color display and have color bitmaps in your Mathcad 
worksheets, Mathcad by default uses a single 256-color palette to display all the bit
in your worksheets. This is the same default color palette Mathcad uses for displa
the rest of the Mathcad screen and is suitable for most pictures. 
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This default color palette, however, may not be the exact one that any color bitmaps in 
a worksheet were designed to use. To improve the appearance of bitmaps in your 
worksheet, you can tell Mathcad to optimize its default color palette so that it chooses 
the best possible 256 colors to display bitmaps in the worksheet. To do so:

1. Choose Color⇒Optimize Palette from the Format menu. Mathcad surveys the 
pictures in the worksheet and generates an optimal 256-color palette to use for all 
of them. 

2. Make sure that Color⇒Use Default Palette in the Format menu is checked. Then 
Mathcad uses the new default palette it generates. 

1RWH If your display driver supports more than 256 colors, the palette-setting options on the Format 
menu are grayed.

,QVHUWLQJ�2EMHFWV

This section describes techniques for inserting and editing objects created by other 
applications in your Mathcad worksheets. OLE (Object Linking and Embedding) 
technology in Microsoft Windows makes it possible not only to insert static pictures 
of such objects into your applications (or of Mathcad objects into other applications), 
but to insert the objects in such a way that they can be fully edited in their originating 
applications. 

An object can be either embedded in or linked to a Mathcad worksheet. An object that 
is linked must exist in an external saved file. An object that you embed may be created 
at the time of insertion. When you edit a linked object, any changes you make to the 
object also update the original file containing the object. When you edit an embedded 
object, any changes you make to the object affect it only in the context of the Mathcad 
worksheet. The original object in the source application, if there is one, is unchanged. 

7LS For information about using specialized objects called components to import and export data, as 
well as establish dynamic connections between Mathcad and other applications, see Chapter 11, 
“Vectors, Matrices, and Data Arrays,” and Chapter 16, “Advanced Computational Feature

,QVHUWLQJ�DQ�2EMHFW�LQWR�D�:RUNVKHHW
You insert an object into Mathcad, which is an OLE 2–compatible application, by using
the Object command from the Insert menu, by copying and pasting, or by dragging
and dropping. The method you choose depends on whether you want to create the
on the fly, whether the object has already been created, or whether you want the 
to be an entire file. You can edit objects in a Mathcad worksheet simply by doub
clicking them, causing in-place activation of the originating application in most case

7LS In general, you use the same methods to insert a Mathcad object into another application and edit 
it inside that application as you do to insert objects into a Mathcad worksheet. However, the 
details depend on the extent to which the application receiving a Mathcad object supports OLE 
2. Once you’ve inserted a Mathcad object into a compatible application, you can edit it by
double-clicking it. If the application supports in-place activation, as current releases of 
Microsoft Office applications do, the menus and toolbars will change to Mathcad’s.
74  Chapter 6  Working with Graphics and Other Objects
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When you use the Object command from the Insert menu, you can insert an object 
that you create at the time you are inserting it, or you can insert an entire file you
already created.

To insert an object or a saved file:

1. First click in your worksheet where you want to insert the object. Make sure 
see the crosshair.

2. Choose Object from the 
Insert menu to bring up 
the Insert Object dialog 
box. By default “Create 
New” is selected:

3. Check “Display As Icon” 
if you want an icon, rather 
than the actual object, to 
appear in your worksheet. 
The icon is typically the 
icon of the application that 
created the object.

To create a new object:

1. Select an application from the “Object Type” list. The available object types dep
on the applications you have installed on your system.

2. Click “OK.” 

The source application opens so that you can create the object. When you are fin
working to create the object, exit the source application. The object you created is
embedded in your Mathcad worksheet.

If you want to insert a 
previously created file:

1. Click “Create from File” 
in the Insert Object dialog 
box. The dialog box then 
changes appearance.

2. Type the path to the 
object file or click 
“Browse” to locate it.

3. Check “Link” to insert a 
linked object. Otherwise, 
the object is embedded.

4. Click “OK.”
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You can copy an object from a source application to the Clipboard and paste it directly 
into Mathcad. This method is particularly useful when you’ve already created the o
in another application and you don’t want to insert an entire file. 

To insert an embedded or linked object into a worksheet via the Clipboard:

1. Open the source application containing the object.

2. Copy the object from the source application to the Clipboard. You typically do
by choosing Copy from the Edit menu or by pressing [Ctrl]C.

3. Click in the Mathcad worksheet where you’d like to place the object. 

4. Choose Paste or Paste Special from Mathcad’s Edit menu. 

If you choose Paste, the object is pasted in your Mathcad worksheet in a format th
depends on what the source application has placed on the Clipboard. The beha
differs depending on whether you have selected a math placeholder or are pastin
a blank space in the worksheet. Mathcad creates one of the following:

• A matrix, if you are pasting numeric data from the clipboard into an empty ma
placeholder. 

• A text region, if you are pasting text that does not contain numeric data exclusiv

• A bitmap or picture (metafile), if the originating application generates graphics.

• An embedded object, if the originating application supports OLE. 

If you choose Paste Special, you have the option of pasting the object in one of the
available formats placed on the Clipboard. Typically you can choose to paste the o
as an embedded or linked OLE object (if the object was stored in a saved file in an OLE-
compatible source application), a picture (metafile), or a bitmap. See “Creating a pi
by importing from the Clipboard” on page 72 for more information on pasting metaf
and bitmaps. 

'UDJJLQJ�DQG�GURSSLQJ�DQ�REMHFW�LQWR�D�ZRUNVKHHW

A third way to insert an OLE object into a Mathcad worksheet is to drag it from the
source application and drop it into the worksheet. This is very similar to copying 
pasting, but does not allow you to create a link to an object. To do so, open both Ma
and the source application and arrange the two windows side by side on the scr
Then select the object in the source application and drag it with the mouse into y
Mathcad worksheet. The object appears when you release the mouse button.
76  Chapter 6  Working with Graphics and Other Objects
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To edit an embedded object in a Mathcad worksheet, double-click the object. Math
menus and toolbars change to those of the source application, and a hatched bo
surrounds the object so that you can edit it. This OLE editing mechanism is called in-
place activation. For example, you can use in-place activation to edit objects crea
by Microsoft Office applications such as Excel and Word inside Mathcad.

If the source application does not support in-place activation inside Mathcad or t
object is linked, the behavior is different. In the case of an embedded object, a co
the object is placed into a window from the other application. If the object is linke
the source application opens the file containing the object. 

(GLWLQJ�D�/LQN
If you’ve inserted a linked object into a Mathcad worksheet, you can update the 
eliminate it, or change the source file to which the object is linked. To do so, cho
Links from the Edit menu.

Choose the link you 
want to edit from the list 
of links. Then make 
changes using the 
available options.

2Q�OLQH�+HOS See the on-line Help topic 
“Links dialog box” for 
information on each option 
in the dialog box.

,QVHUWLQJ�*UDSKLFV�&RPSXWDWLRQDOO\�/LQNHG�WR�<RXU�:RUNVKHHW

If you want to insert a drawing or other kind of graphic that is computationally linked 
to your Mathcad worksheet, you can insert a component. A component is a specialized 
OLE object. Unlike other kinds of OLE objects you can insert into a worksheet, as 
described in “Inserting Objects” on page 74, a component can receive data from
Mathcad, return data to Mathcad, or both, linking the object dynamically to your 
Mathcad computations.
Inserting Graphics Computationally Linked to Your Worksheet 77



The SmartSketch component, for example, allows you to insert SmartSketch drawings 
whose dimensions are computationally linked to your Mathcad calculations. 

An example using the SmartSketch component is shown in Figure 6-1. In addition to 
the SmartSketch component, Mathcad includes several components for exchanging 
data with applications such as Excel, MATLAB, and ODBC databases. For more 
information on these and other components, refer to Chapter 16, “Advanced 
Computational Features.”

Figure 6-1: The SmartSketch component inserted into a Mathcad worksheet.
78  Chapter 6  Working with Graphics and Other Objects
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As you use Mathcad you typically create a worksheet that contains unique text, math, 
and graphic regions. Mathcad uses MCD as the file extension for worksheets.

When you create a new worksheet in Mathcad, you can start with Mathcad’s def
choices for formats and layout, or you can use a template that contains customized 
information for laying out and formatting the worksheet. When you create a works
based on a template, all of the formatting information and any text, math, and gra
regions from the template are copied to the new worksheet. Templates allow yo
maintain consistency across multiple worksheets.

Mathcad comes with a variety of predefined templates for you to use as you creat
worksheets. You can extend the collection of templates by saving any of your Mat
worksheets as a template. Mathcad uses MCT as the file extension for templates.

Other saving options are available in Mathcad. You can save a worksheet in Hype
Markup Language (HTML), so that the file can be viewed through a Web browser,
in rich-text format (RTF), so that it can be opened by most word processors. You 
also save a worksheet in a format that can be read by earlier versions of Mathca
Worksheets and Templates 79
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When you first open Mathcad or click  on the Standard toolbar, you see an empty 
worksheet based on a worksheet template (NORMAL.MCT). You can enter and format 
equations, graphs, text, and graphics in this space, as well as modify worksheet 
attributes such as the page margins, numerical format, headers and footers, and text and 
math styles. The normal template is only one of the built-in templates Mathcad 
provides. There is a template for Electronic Books, one for engineering reports, and 
one for specification forms. 

To create a new worksheet based on a template:

1. Choose New from the File menu. Mathcad 
displays a list of available worksheet 
templates. The exact templates available 
differ depending on the templates you have 
developed.

2. Choose a template other than “Blank 
Worksheet.” By default Mathcad displays 
worksheet templates saved in the 
TEMPLATE folder of the directory you used 
to install Mathcad. Click “Browse” to find a 
template in another directory or on another drive.

3. Click “OK.”

6DYLQJ�<RXU�:RUNVKHHW
When you want to save the worksheet, choose either Save or Save As... from the File 
menu and enter a file name with the extension MCD. After the first time you save the 

worksheet, simply choose Save from the File menu or click  on the Standard toolba
to update the saved copy of the worksheet.

7LS To work on a worksheet you saved before, choose Open from the File menu or click  on 
the Standard toolbar. Mathcad prompts you for a name by displaying the Open dialog box. You 
can locate and open a Mathcad worksheet from other directories or drives just as you would in 
any other Windows application. At the bottom of the File menu, Mathcad maintains a list of the 
most recently used worksheets, from which you can choose directly, if you wish.

6DYLQJ�\RXU�ZRUNVKHHW�LQ�+70/�IRUPDW����

There are two ways to save a Mathcad worksheet in HTML format. One way crea
standard HTML document in which Mathcad text regions are saved as HTML an
other regions are saved as JPEG files linked to the document.
80  Chapter 7  Worksheet Management
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New to Mathcad 2001 is the ability to save your Mathcad worksheet as HTML with 
embedded Mathematical Markup Language (MathML). In order to view an HTML file 
that contains MathML, you must install IBM’s techexplorerTM Hypermedia Browser, a 
MathML renderer that works as a plug-in for your browser application. Your Math
2001 package includes a specialized version of techexplorerTM or you can download a 
free viewer-only version of techexplorerTM from IBM’s web site.

When you save your Mathcad worksheets in  HTML/MathML format, you can re
them back into Mathcad with no loss of information. All regions are displayed an
calculate in Mathcad as they would if the document was saved in MCD format.

1RWH When you save a Mathcad worksheet in HTML or HTML/MathML format, an HTM file is 
created and a subdirectory with the name “(filename)_images” is also created to contain a
associated JPEG files. Another subdirectory with the name “(filename)_data” contains the
information needed to perserve the functionality of Mathcad regions that cannot be rende
HTML or MathML.

To save a worksheet in either HTML or HTML/MathML format:

1. Choose Save As... from the File menu.

2. In the Save As dialog box, choose “HTML File” or “HTML/MathML File” from 
the “Save as type” drop-down list. 

3. Enter a file name and then click “Save.” The document is saved with the HTM
extension.

Figure 7-1 shows a Mathcad worksheet viewed in a browser enabled with IBM’s
techexplorerTM Hypermedia Browser.
Worksheets and Templates 81
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Figure 7-1: Mathcad worksheet saved in HTML/MathML format, viewed in a 
browser enabled with IBM’s techexplorerTM Hypermedia Browser.

1RWH Not all regions in Mathcad that contain numerical expressions or calculations can be rendered in 
MathML. For example, there are no markup tags that allow you to display a 2D or 3D graph. 
You may find that your HTML/MathML document still has many JPEG files associated with it, 
which display those regions that have no MathML equivalents. In Figure 7-1, the equations, 
range variable, and results are rendered in MathML, while the graph is displayed through a JPEG 
file.

Using Microsoft’s Internet Explorer, you can activate Mathcad to edit worksheets 
have been saved in HTML/MathML format.

To edit your Mathcad worksheets through an Internet Explorer browser:

1. Load your Mathcad worksheet that has been saved in HTML/MathML format i
Internet Explorer.

2. Select Edit with Mathcad Application under the File menu.

Edit your file as usual and then save it using the Save button on Standard toolba
with the Save command from the File menu. In either case, the file will be saved in
HTML/MathML format.
82  Chapter 7  Worksheet Management



pe” 

d 
ment. 
ur 
 word 
dit 

athcad 
to 
e 74.

ou 
e 

er 
ed as 
7LS To publish your HTML files on the web, you can use Windows’ Web Folders or the Web 
Publishing Wizard. These utilities help you establish a direct connection to your web server in 
order to publish or update your web files.

6DYLQJ�\RXU�ZRUNVKHHW�LQ�57)�IRUPDW����

To save a worksheet so you can open it in a word processor capable of reading an RTF 
file with embedded graphics:

1. Scroll to the bottom of your worksheet to update all calculated results.

2. Choose Save As from the File menu.

3. In the Save As dialog box, choose “Rich Text Format File” from the “Save as ty
drop-down list. 

4. Enter a file name and then click “Save.”

When you open an RTF file with a word processor such as Microsoft Word, you’ll fin
all the Mathcad regions lined up one above the other at the left edge of the docu
You may have to move regions in the word processor to make them look like yo
original Mathcad worksheet. Once the Mathcad regions have been loaded into a
processor, you will be able to edit the text. However, you’ll no longer be able to e
math regions and graphs, which have become embedded graphics. To embed M
worksheets or regions in a word processing document in a form that allows you 
continue to edit the original Mathcad worksheets, see “Inserting Objects” on pag

7LS Mathcad’s text supports Microsoft’s “Rich Text Format” (RTF) specification. This means y
can easily export text from Mathcad text regions to most word processing programs via th
Clipboard. Simply select text in a Mathcad text regions, copy the text to the Clipboard by 

choosing Copy from the Edit menu or clicking  on the Standard toolbar, and choose Paste 
from the Edit menu in your word processing application. 

6DYLQJ�\RXU�ZRUNVKHHW�LQ�DQ�HDUOLHU�IRUPDW

In general, worksheets created in an earlier version of Mathcad open in the current 
version, but files created in the current version of Mathcad do not open in earlier 
versions. Mathcad 2001, however, allows you to save a worksheet as a Mathcad 2000, 
8, 7, or 6 worksheet.

1RWH Features in your worksheet available only in Mathcad 2001 will not be recognized in earli
versions of Mathcad. Regions or features that won’t work in an earlier version are render
bitmaps.
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To save a worksheet in a form that can be read by an earlier version of Mathcad:

1. Choose Save or Save As from the File menu.

2. In the “Save as type” drop-down list, select “Mathcad 2000 Worksheet,” or on
the earlier formats listed, and provide a file name.

3. Click “Save.” A message appears warning you that certain features available
in Mathcad 2001 will not work in earlier versions. 

&UHDWLQJ�D�1HZ�7HPSODWH
You can extend the collection of templates by creating your own. A template you c
can have equations, text, and graphics in places you determine, as well as custo
information in the headers and footers (see “Layout” on page 89). 

The template also specifies:

• Definitions of all math styles (Chapter 4).

• Definitions of all text styles (Chapter 5).

• Margins for printing (see “Layout” on page 89).

• Numerical result formats and values for Mathcad’s built-in variables (Chapter

• Names of Mathcad’s basic units and the default unit system (Chapter 8).

• The default calculation mode (Chapter 8).

• Ruler visibility and measurement system (see “Aligning Regions” on page 85

To create a new template, first create a new worksheet having the options listed a
set the way you want. The worksheet can also contain any equations, text, and gr
that you want in the template. The next step is to save this worksheet as a templa
do so:

1. Choose Save As from the File menu.

2. Double-click the TEMPLATE folder in the Save As dialog.

3. In the “Save as type” drop-down list, select “Mathcad Templates (*.mct).”

4. Type a name for the template in the “File name” box.

5. Click “Save.” 

Your template is now added to the list of templates available in the dialog box th
appears when you choose New from the File menu. To make a new worksheet base
on a template you’ve created, simply choose New from the File menu and select your 
template from the list. If you did not save your template to the TEMPLATE folder, you 
need to browse to find the template. 
84  Chapter 7  Worksheet Management



 the 

save 

late, 

eets. 
, and 

or 
uler.

king 
0RGLI\LQJ�D�7HPSODWH
To modify an existing worksheet template:

1. Choose Open from the File menu or click  on the Standard toolbar.

2. In the “Files of type” drop-down list, select “All Files.”

3. Type the name of the template in the “File name” box, or browse to locate it in
dialog box. Worksheet templates are saved by default in the TEMPLATE folder.

4. Click “Open.” The template opens in the Mathcad window.

You may now edit the template as you would modify any Mathcad worksheet. To 
your changes under the current template name, choose Save from the File menu or click 

 on the Standard toolbar. If you want to give a new name to the modified temp
choose Save As from the File menu and enter a new name for the template.

7LS To modify the default template for a blank worksheet, modify the template file NORMAL.MCT.

1RWH When you modify a template, your changes affect only new files created from the modified 
template. The changes do not affect any worksheets created with the template before the 
template was modified.

5HDUUDQJLQJ�<RXU�:RUNVKHHW�

This section describes how to rearrange math, graphics, and text in your worksh
See the section “Regions” on page 10 for the basics on selecting, copying, moving
deleting regions.

1RWH You can get an overall view of how your worksheet looks by choosing Zoom from the View 

menu or clicking  on the Standard toolbar and choosing a magnification. Choose a 
magnification less than 100% to zoom out of the worksheet, or use a magnification greater than 
100% to zoom in. Alternatively, use the Print Preview command as described under “Print 
Preview” on page 99.

$OLJQLQJ�5HJLRQV
Once you’ve inserted regions into your worksheet, you can align them vertically 
horizontally using menu commands or you can align them using the worksheet r

8VLQJ�FRPPDQGV

To align regions horizontally or vertically using commands:

1. Select regions as described on page 10.

2. Choose Align Regions⇒Across (to align horizontally) or Align Regions⇒Down 
(to align vertically) from the Format menu. Or choose these commands by clic

 and  on the Standard toolbar.
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When you choose Align Regions⇒Down from the pull-right menu or click  on 
the Standard toolbar, Mathcad does the following:

• Mathcad draws an invisible vertical line halfway between the right edge of the r
most selected region and the left edge of the left-most selected region.

• All selected regions to the right of this line are moved left until their left edges
aligned with this line.

• All selected regions to the left of this line are moved right until their left edges
aligned with this line.

Choosing Align Regions⇒Across or clicking  on the Standard toolbar works in
much the same way. Mathcad draws an invisible horizontal line halfway between
top edge of the uppermost region and the bottom edge of the lowest region. Sel
regions below and above this line are moved up and down respectively until the
midpoints of their left edges are on this line.

1RWH Aligning regions may inadvertently cause regions to overlap. Mathcad warns you when this will 
occur, but you can separate overlapping regions as described in “Separating Regions” be

8VLQJ�WKH�ZRUNVKHHW�UXOHU

When you choose Ruler from the View menu while the cursor is in a blank spot or in 
a math region, you see the worksheet ruler at the top of the window. You can use 
alignment guidelines on the ruler to align regions at particular measurements along the 
worksheet.

To set an alignment guideline on the ruler:

1. Click on the ruler wherever you want the alignment guideline to appear. A tab stop 
symbol appears on the ruler.

2. Click on the tab stop symbol with the right mouse button and choose Show 
Guideline from the pop-up menu. A check appears next to the command.

The alignment guideline appears as a green vertical line. Select and move regions to 
the guideline. Figure 7-2 shows how you can use an alignment guideline to align math 
regions.

1RWH The tab stops you insert on the ruler specify where the cursor should move when you pre
[TAB] key. To remove a tab stop, click on its symbol, hold the mouse button down, and dra
cursor away from the ruler.

To remove an alignment guideline, click on the ruler with the right mouse button where 
the guideline is located and choose Show Guideline from the menu to uncheck it.

7LS You can change the measurement system used in the ruler by clicking on the ruler with the
mouse button, and choosing Inches, Centimeters, Points, or Picas from the pop-up menu. To 
change the ruler measurement for all documents, make this change to NORMAL.MCT.
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You can easily insert one or more blank lines into your worksheet: 

1. Click on the blank line below which you want to insert one or more blank lines. 
Make sure the cursor looks like a crosshair.

2. Press [Enter] to insert a blank line and move the cursor to the left margin. Do this 
as many times as you want to insert lines.

To delete one or more blank lines from your worksheet:

1. Click above the blank lines you want to delete. Make sure the cursor looks like a 
crosshair and that there are no regions to the right or left of the cursor.

2. Press [Delete] as many times as there are lines you want to delete. Mathcad 
deletes blank lines below your cursor. Alternatively, press [BkSp] to remove blank 
lines above your cursor.

If you press either [Delete] or [BkSp] and nothing seems to be happening, check to 
make sure that the cursor is on a line all by itself. If any region in your worksheet extends 
into the line you are trying to delete, Mathcad won’t be able to delete that line.

7LS To quickly insert or delete a specific number of lines from your worksheet, right-click in a blank 
part of the worksheet, choose Insert Lines or Delete Lines from the pop-up menu, and enter the 
number of lines in the dialog box.

Figure 7-2: Using an alignment guideline to align regions vertically.
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As you move and edit the regions in a Mathcad worksheet, they may end up overlapping 
one another. Overlapping regions don’t interfere with each other’s calculations, b
they may make your worksheet hard to read.

A good way to determine whether regions 
overlap is to choose Regions from the View 
menu. As shown at right, Mathcad displays 
blank space in gray and leaves the regions 
in your default background color. To return 
to the default background color, choose 
Regions from the View menu again.

To separate all overlapping regions, choose 
Separate Regions from the Format menu. 
Wherever regions overlap, this command 
moves the regions in such a way as to avoid 
overlaps.

1RWH Be careful with the Separate Regions command since not only can it have far-reaching effects, 
it also cannot be undone. Regions are moved around and the order of calculation can change. 
You can also drag regions individually, add lines by pressing [Enter], or cut and paste the 
regions so they don’t overlap.

+LJKOLJKWLQJ�5HJLRQV
Mathcad allows you to highlight regions so that they stand out from the rest of the 
equations and text in your worksheet:

To apply a background highlight color to a region:

1. Click in the region you want to highlight.

2. Choose Properties from the Format menu.

3. Click the Display tab.

4. Check “Highlight Region.” Click “Choose Color” to choose a highlight color oth
than the default choice.

5. Click “OK.”

Mathcad fills a box around the equation with either the default background highl
color or the color you chose. This is a purely cosmetic change with no effect on 
equation other than making it more conspicuous.
88  Chapter 7  Worksheet Management



f 

 page 
riately. 
1RWH The appearance of a highlighted region on printing depends on the capabilities of your printer 
and the choice of highlight color. Some black and white printers render a color as black, 
obscuring the equation or text. Others render just the right gray to highlight the equation without 
obscuring it. Still other printers will disregard the background highlight color entirely.

To change the default background color of highlighted regions:

1. Choose Color from the Format menu.

2. Pull right and choose Highlight to bring up a dialog box containing a palette of 
colors. Click the appropriate color.

3. Click “OK.”

&KDQJLQJ�WKH�ZRUNVKHHW�EDFNJURXQG�FRORU
To change the color of the background of your worksheet:

1. Choose Color from the Format menu.

2. Pull right and choose Background to bring up a dialog box containing a palette o
colors. Click the appropriate color. 

3. Click “OK.”

/D\RXW

Before printing a worksheet, you may need to adjust the margins, paper options,
breaks, and headers and footers so that pages of the worksheet are printed approp

6HWWLQJ�0DUJLQV��3DSHU�6L]H��6RXUFH��DQG�2ULHQWDWLRQ�
Mathcad worksheets have user-
specifiable margins at the left, right, top, 
and bottom of the worksheet. To set 
these margins, choose Page Setup from 
the File menu.

Use the four text boxes in the lower right 
of the Page Setup to specify the distances 
from the margin to the corresponding 
edge of the actual sheet of paper on 
which you are printing. 

You can also use settings in the Page 
Setup dialog box to change the size, 
source, or orientation of the paper on 
which you print your worksheet. See 
“Printing and Mailing” on page 98 for 
more about printing your Mathcad 
worksheets.
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7LS If you want the margin and other page setup settings in the current worksheet to be used in other 
worksheets, save the worksheet as a template as described in “Creating a New Template
page 84.

3DJH�%UHDNV
Mathcad provides two kinds of page breaks:

• Soft page breaks: Mathcad uses your default printer settings and your top and
bottom margins to insert these page breaks automatically. These show up as 
horizontal lines, which you see as you scroll down in your worksheet. You can
add or remove soft page breaks.

• Hard page breaks: You can insert a hard page break by placing the cursor at 
place in your worksheet and choosing Page Break from the Insert menu. Hard 
pagebreaks display as solid horizontal lines in your worksheets.

When Mathcad prints your worksheet, it begins printing on a new page wheneve
encounters either a soft or a hard page break. 

To delete a hard page break:

1. Drag-select the hard page break as you would select any other region in you
Mathcad worksheet. A dashed selection box appears around the page break

2. Choose Delete from the Edit menu. 

7LS Because Mathcad is a WYSIWYG environment, any region that overlaps a soft or hard page 
break prints by default in pieces on successive pages. To separate a region from a hard page 
break, choose Separate Regions from the Format menu. However, this command does not 
separate regions from any overlapping soft page breaks. Choose Repaginate Now from the 
Format menu to force Mathcad to insert a soft page break above any region that otherwise 
would print in pieces on successive pages.

+HDGHUV�DQG�)RRWHUV
To add a header or a footer to every printed page, to create a different header or 
for the first page of a worksheet, or to modify an existing header or footer, choos
Headers/Footers from the Format menu. The Header/Footer dialog box appears:
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To add or edit a header or footer:

1. Click the Header or Footer tab to modify the header or footer for the worksheet. To 
create a different header or footer for the first page of your worksheet, check the 
“Different header and footer on first page” option and click the Header–Page 
Footer–Page 1 tab.

2. Type the header or footer information into one or more of the text boxes. What
you type into the Left, Center, and Right text boxes will appear in these posit
on the page. Click “Format” in the Tools group to change the header or footer 
font style, size, or alignment. Click “Use full width for each section” if you wa
text in any of the boxes to extend beyond the width of the text box.

3. Click one or more of the buttons in the Tools group to insert items such as th
name, page number, current date, or time automatically wherever the insertion
is. To insert an image, click “Image” in the Tools group and browse to locate 
bitmap (.BMP format) file.

7LS Mathcad by default begins numbering at page 1. You can set a different starting page number in 
the Options group in the Header/Footer dialog box.

6DIHJXDUGLQJ�DQ�$UHD�RI�WKH�:RUNVKHHW

The ease with which you can alter a Mathcad worksheet can present a problem. I
too easy to alter a worksheet and to change things which are not meant to be cha
For example, if you’ve developed and thoroughly tested a set of equations, you 
want to prevent readers of your worksheet from tampering with them. To avoid 
unintended edits to your worksheet, you can safeguard an area of your workshe
locking it such that you can still edit it even though nobody else can. 

To lock an area of your worksheet:

1. Create an area in your worksheet to contain the regions to be protected.

2. Place the regions that you want to safeguard into that area.

3. Lock the area. Optionally you can password protect and collapse the area.

Once a region is safely inside a locked area, nobody can edit it. Any math regions i
a locked area continue, however, to affect other equations in the document. For 
example, if you define a function inside a locked area, you can still use that func
anywhere below and to the right of its definition. You cannot, however, change t
function’s definition itself unless you unlock the area first.

,QVHUWLQJ�DQ�$UHD
To insert a lockable area into your worksheet:

1. Choose Area from the Insert menu. 
Mathcad inserts a pair of lines into the 
worksheet. These mark the boundaries of 
the lockable area.
Safeguarding an Area of the Worksheet 91
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2. Select either of these boundary lines just as you’d select any region: by drag
the mouse across the line or by clicking the line itself.

3. Once you’ve selected the boundary line, drag it just as you’d drag any other re
to move it. 

You should position the boundaries so that there’s enough space between them
whatever regions you want to lock. You can have any number of lockable areas in
worksheet. The only restriction is that you cannot have one lockable area inside an

7LS To name an area in your worksheet, click on an area boundary, choose Properties from the 
Format menu, and enter a name on the Area tab. The Area tab also lets you modify other display 
attributes of an area, such as whether a border or icon appears.

/RFNLQJ�DQG�&ROODSVLQJ�DQ�$UHD����
Once you’ve placed whatever regions you want inside an area, you can lock the
You can choose to lock an area with a password to prevent unauthorized editing 
regions in it. You can also collapse the area, either with or without locking it, so 
the regions are hidden from view. 

To lock an area:

1. Click in the area.

2. Choose Area⇒Lock from the Format 
menu.

3. In the Lock Area dialog box, enter a 
password if you want to lock the area with 
a password. Type any combination of 
letters, numbers, and other characters. 
You must re-enter the password to 
confirm it.

4. Check “Collapse when locked” to hide the locked regions from view. Check “Sh
lock timestamp” to display the date and time the area was last locked above 
below the boundary lines.

5. Click “OK.”

The area is now locked and by default shows padlocks 
on the boundaries and a timestamp.

1RWH If you choose to password protect an area, make sure you remember your password. If you forget 
it, you will find yourself permanently locked out of that area. Keep in mind also that the 
password is case sensitive.

To collapse an area without locking it first:

1. Click in the area.

2. Choose Area⇒Collapse from the Format menu.

A collapsed area appears by default as a single line in your worksheet.
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If you want to make changes to a region inside a locked area, you have to unlock it. If 
the area is collapsed, you must also expand it.

To unlock a locked area:

1. Click in the area you want to unlock. 

2. Choose Area⇒Unlock from the Format menu.

3. If a password is required, you are prompted for the password. 

To expand a collapsed area:

1. Click on the boundary line.

2. Choose Area⇒Expand from the Format menu.

Once an area is unlocked and expanded, you can make whatever changes you want to 
just as freely as you would elsewhere in your worksheet.

7LS When you lock an area without a password, anyone can unlock it by simply choosing 
Area⇒Unlock from the Format menu. 

'HOHWLQJ�DQ�$UHD
You can delete a lockable area just as you would any other region. To do so: 

1. Make sure the area is unlocked. You cannot delete a locked area.

2. Select either of the two lines indicating the extent of the locked area by dragging 
the mouse across it.

3. Choose Cut from the Edit menu or click  on the Standard toolbar.

:RUNVKHHW�5HIHUHQFHV

There may be times when you want to use formulas and calculations from one Mathcad 
worksheet inside another. You may also have calculations and definitions that you re-
use frequently in your work. You can, of course, simply use Copy and Paste from the 
Edit menu to move whatever you need to move, or drag regions from one worksheet 
and drop them in another. However, when entire worksheets are involved, this method 
can be cumbersome or may obscure the main computations of your worksheet. 

Mathcad therefore allows you to reference one worksheet from another—that is, to 
access the computations in the other worksheet without opening it or typing its 
equations or definitions directly in the current worksheet. When you insert a refer
to a worksheet, you won’t see the formulas of the referenced worksheet, but the cu
worksheet behaves as if you could. 

7LS An alternative described in “Safeguarding an Area of the Worksheet” on page 91 is to cre
collapsible area to hide calculations in your worksheet. This method, while it does not let y
re-use calculations in the same way as a worksheet reference, does give you the option o
password protecting or locking an area of calculations.
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To insert a reference to a worksheet:

1. Click the mouse wherever you want to insert the reference. Make sure you click in 
empty space and not in an existing region. The cursor should look like a crosshair.

2. Choose Reference 
from the Insert 
menu. 

3. Click “Browse” to 
locate and select a 
worksheet. Alterna-
tively, enter the path 
to a worksheet. You 
can also enter an In-
ternet address (URL) to insert a reference to a Mathcad file that is located on th
World Wide Web. 

4. Click “OK” to insert the reference into your worksheet.

To indicate that a reference has been in-
serted, Mathcad pastes a small icon wher-
ever you had the crosshair. The path to the referenced worksheet is to the right 
icon. All definitions in the referenced worksheet are available below or to the righ
this icon. If you double-click this icon, Mathcad opens the referenced worksheet i
own window for editing. You can move or delete this icon just as you would any o
Mathcad region.

1RWH By default, the location of the referenced file is stored in the worksheet as an absolute system 
path (or URL). This means that if you move the main worksheet and the referenced worksheet 
to a different file system with a different directory structure, Mathcad cannot locate the 
referenced file. If you want the location of the referenced file on a drive to be stored relative to 
the Mathcad worksheet containing the reference, click “Use relative path for reference” in
Insert Reference dialog box. The reference is then valid even if you move the referenced fi
the main worksheet to a different drive but keep the relative directory structure intact. To use a
relative path, you must first save the file containing the reference.

If you edit the contents of a referenced file so that any calculations change, you must 
re-open any worksheets that contain references to that file for calculations to update. 
The calculations in those worksheets do not update automatically.
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Mathcad allows you to create hyperlinks in your Mathcad worksheets that, when 
double-clicked, open Mathcad worksheets, jump to other regions of a Mathcad 
worksheet, or link to other files.

&UHDWLQJ�+\SHUOLQNV�%HWZHHQ�:RUNVKHHWV
You can create a hyperlink from any Mathcad region, such as a text region or a graphic 
element, to any other Mathcad region, either within the same worksheet or in another 
worksheet. When you double-click the hyperlink, Mathcad opens the worksheet 
designated by the hyperlink, and if a region is specified it jumps to that region. In this 
way you can connect groups of related worksheets in a form similar to Mathcad’
Electronic Books, or simply cross-reference related areas of a worksheet or works

&UHDWLQJ�K\SHUOLQNV�IURP�ZRUNVKHHW�WR�ZRUNVKHHW

When you create a hyperlink from one worksheet to another you have two option
the appearance of the target worksheet:

• The target worksheet can open in a full-sized Mathcad worksheet window tha
overlays the current worksheet window and allows you to edit its contents.

• The target worksheet can open in a small pop-up window that displays the contents
of the worksheet, but does not allow you to edit its contents.

Mathcad can follow a hyperlink to any worksheet, whether it is stored on a local d
a network file system, or the World Wide Web. 

To create a hyperlink from one worksheet to another, first specify the hyperlink b

1. Selecting a piece of text, or 

2. Clicking anywhere in an equation or graphics region, or

3. Placing the insertion point anywhere within an entire text region.

7LS There are two ways to link text to a target file or destination. You can select a word or phrase, 
or you can click an entire text region. When you use selected text, Mathcad underlines the word 
or phrase and the mouse pointer changes to a hand cursor when you hover over it. In general, 
either selected text or an embedded graphic works best as a hyperlink to another worksheet. 

The next step is to specify the target worksheet. To do so:

1. Choose Hyperlink 
from the Insert menu. 
Mathcad opens the 
Insert Hyperlink 
dialog box.

2. Click “Browse” to 
locate and select the 
target worksheet. 
Alternatively, enter 
the complete path to a 
worksheet in the empty text box at the top of the dialog box, or enter an Inter
Hyperlinks 95
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address (URL) to create a hyperlink to a file on the World Wide Web.

3. Check “Use relative path for hyperlink” to store the location of the target worksh
relative to the Mathcad worksheet containing the hyperlink. This allows the 
hyperlink to be valid even if you move the target file and the worksheet contain
the hyperlink, but keep the relative directory structure between the two the sa

1RWH In order for “Use relative path for hyperlink” to be available, you must first save the worksh
in which you are inserting the hyperlink. 

4. Check “Display as pop-up document” if you want the target worksheet to ope
a small pop-up window.

5. If you want a message to appear on the status line at the bottom of the window
the mouse hovers over the hyperlink, type the message in the text box at the b
of the dialog box.

6. Click “OK.” 

To change any aspects of a hyperlink—for example, if you move the target works
and still want the hyperlink to work—click the hyperlink and choose Hyperlink from 
the Insert menu. Make any changes you wish in the Edit Hyperlink dialog box.

To remove a hyperlink, click the hyperlink and choose Hyperlink from the Insert 
menu. Click “Remove Link” in the dialog box. Mathcad removes all traces of the l

&UHDWLQJ�K\SHUOLQNV�IURP�UHJLRQ�WR�UHJLRQ

Before you can link to a specific region in a worksheet, you must mark it with a tag. A 
tag uniquely identifies a region in a worksheet, allowing you to jump directly to th
region. A tag can be any collection of words, numbers, or spaces, but no symbo

To create a region tag:

1. Right-click on any region in your worksheet for which you would like to create
region tag.

2. Select Properties from the pop-up menu.

3. In the Properties dialog box, under the Display tab, type a tag in the text box
provided and click “OK.”

Now, you will be able to link to that region from within the worksheet or from any
other worksheet.

To create a hyperlink to a region that has been tagged:

1. Click a region in your worksheet, and choose Hyperlink from the Insert menu.

2. Click “Browse” to locate and select the target worksheet, or type the complete
to a worksheet, or enter an Internet address (URL). You must enter the name of the
target worksheet even if you are creating a hyperlink to a region within the sa
worksheet.

3. At the end of the worksheet path type “#” followed by the region tag. The comp
path for your target region will look something like this: C:\filename#region tag
96  Chapter 7  Worksheet Management
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4. Make further desired specifications in the Hyperlink dialog box and click “OK

1RWH When you link from region to region within or between Mathcad worksheets, you cannot use the 
pop-up window option.

&UHDWLQJ�+\SHUOLQNV�WR�2WKHU�)LOHV
You can use the methods described in the previous section to create a hyperlink
only from one Mathcad worksheet to another, but also from a Mathcad workshee
any other file type, either on a local or network file system or on the Web. Use th
feature to create Electronic Books, as described in “Creating an Electronic Book
compound documents that contain not only Mathcad worksheets but word proce
files, animation files, web pages—any file type that you want. 

1RWH When you double-click a hyperlink to a file other than a Mathcad worksheet, you launch either 
the application that created the file or an application associated with a file of that type in the 
Windows Registry. You cannot display such hyperlinked files within a pop-up window.

&UHDWLQJ�DQ�(OHFWURQLF�%RRN

As described in Chapter 3, “Online Resources,” an Electronic Book is a hyperlin
collection of Mathcad worksheets. When you open an Electronic Book in Mathca
opens in its own window. The Electronic Book has a table of contents and an ind
well as other browsing features which you can access using the buttons on the to
in the window. The worksheets in an Electronic Book are live so a reader can exper
directly within the book.

If you have several Mathcad worksheets that you want to collect together, you c
create your own Electronic Book. There are several steps to creating an Electron
Book, and they include:

1. Creating individual Mathcad files

2. Preparing a Table of Contents

3. Adding hyperlinks between appropriate files

4. Creating an HBK file to specify the order of the files in the book

5. Developing an index (optional)

6. Checking the index, HBK file, and worksheets for errors

For more details about each step of this process, see the Author’s Reference under the 
Help menu in Mathcad. There you will find tips and techniques for creating Electronic 
Books, as well as other details associated with turning a collection of worksheets into 
a navigable handbook of information.

It is recommended that you read all steps of the process before you undertake the project 
of creating an Electronic Book. After you have created an Electronic Book, you or 
others can open it in Mathcad and navigate through it using the toolbar buttons of the 
Electronic Book window. For more information on Electronic Books and the navigation 
tools, refer to Chapter 3, “Online Resources.”
Creating an Electronic Book 97
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To print a Mathcad worksheet, 
choose Print from the File 
menu. The Print dialog box lets 
you control whether to print the 
entire worksheet, selected 
pages, or selected regions; what 
printer to print on; and the 
number of copies to print. The 
particular dialog box you see 
depends on the printer you’ve 
selected. A typical dialog box is 
shown at right.

3ULQWLQJ�:LGH�:RUNVKHHWV
Mathcad worksheets can be wider than a sheet of paper, since you can scroll as
the right as you like in a Mathcad worksheet and place equations, text, and grap
wherever you like. As you scroll horizontally, however, you see dashed vertical l
appearing to indicate the right margins of successive “pages” corresponding to t
settings for your printer. The sections of the worksheet separated by the dashed v
lines print on separate sheets of paper, yet the page number at the bottom of the M
window does not change as you scroll to the right.

You can think of the 
worksheet as being 
divided into vertical 
strips. Mathcad 
begins printing at the 
top of each strip and 
continues until it 
reaches the last region 
in this strip. It prints 
successive strips left 
to right. Note that 
certain layouts will 
produce one or more 
blank pages. 

7LS You can control whether a wide worksheet is printed in its entirety or in a single page width. To 
do so, choose Page Setup from the File menu to open the Page Setup dialog box. Then, to 
suppress printing of anything to the right of the right margin, check “Print single page wid
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You can ask Mathcad to print a range of pages in the worksheet by using the Print dialog 
box. The page numbers in the dialog box refer only to horizontal divisions. For example, 
if your worksheet looks like that shown above, and you ask Mathcad to print page 2, 
you will see two sheets of paper corresponding to the lower-left and lower-right 
quadrants.

7LS Mathcad allows you to change the display of some operators including the :=, the bold equals, 
the derivative operator, and the multiplication operator. Before you print, you can choose 
Options from the Math menu and click on the Display tab to change the appearance of these 
operators. This can make your printout clearer to someone unfamiliar with Mathcad notation. 

3ULQW�3UHYLHZ
To check your worksheet’s layout before printing, choose Print Preview from the File 

menu or click  on the Standard toolbar. The Mathcad window shows the cur
section of your worksheet in miniature, as it will appear when printed, with a strip
buttons across the top of the window: 

To print your worksheet from this screen, click “Print.” Click “Close” to go back to t
main worksheet screen. The remaining buttons give you more control over the pre

7LS Although you can use the “Zoom In” and “Zoom Out” buttons to magnify the worksheet, y
can also magnify the worksheet by moving the cursor onto the previewed page so that the 
changes to a magnifying glass. Then click the mouse. Click again to magnify your worksh
even more. Once you’re at the maximum magnification, clicking on the page de-magnifie

1RWH You cannot edit the current page or change its format in the Print Preview screen. To edi
page or change its format, return to the normal worksheet view by clicking “Close.” 

0DLOLQJ
If you’re connected to a mail system that’s compatible with Microsoft’s Mail API 
(MAPI), you can use Mathcad to direct that system to send an electronic mail mes
and your current Mathcad worksheet. When you use Mathcad to send a workshe
electronic mail, the recipient receives the worksheet as a file attached to an ordin
mail message, provided that the recipient’s mail system uses the same encoding
technique as yours.

7LS The settings in your mail system determine how Mathcad worksheets are attached to or encoded 
in the mail message. We recommend that you use a compression or encoding method such as 
ZIP, MIME, or UUENCODE, if available, to attach Mathcad worksheets to mail messages.
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To send a Mathcad worksheet by electronic mail:

1. Open the worksheet you want to send.

2. Choose Send from the File menu.

Once you do so, your mail system launches and creates a new message with your 
worksheet as an attachment. You should then enter the text of your mail message, the 
address of the recipient, and any other information allowed by your mail system.
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'HILQLQJ�DQG�(YDOXDWLQJ�9DULDEOHV�

When you type an expression into a worksheet, you are usually doing one of two things:

• You could be typing a variable or function name and assigning some value to

• You could be typing an equation and asking Mathcad to give you the answer

We introduce these topics in this and the following section. See “Evaluating Exp
sions Numerically” on page 103 for details on numerical evaluation.

'HILQLQJ�D�9DULDEOH�
A variable definition defines the value of a variable everywhere below and to the r
of the definition. To define a variable, follow these three steps:

1. Type the variable name to be defined. Chapter 4, “Working with 
Math,” contains a description of valid variable names.

2. Press the colon (:) key, or click  on the Calculator toolbar. 
The definition symbol (:=) appears with a blank placeholder to 
the right. 

3. Type an expression to complete the definition. This expression 
can include numbers and any previously defined variables and 
functions.
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The left-hand side of a “:=” can contain any of the following:

• A simple variable name like x.

• A subscripted variable name like .

• A matrix whose elements are either of the above. For example, . This techn

allows you to define several variables at once: each element on the right-hand
is assigned simultaneously to the corresponding element on the left-hand sid

• A function name with an argument list of simple variable names. For example
. This is described further in the next section.

• A superscripted variable name like .

%XLOW�LQ�9DULDEOHV���
Mathcad includes predefined or built-in variables. Predefined variables can have a 
conventional value, like π and e, or be used as system variables to control how Mathc
works. See “Predefined Variables” on page 496 in the Appendices for a list of bu
variables in Mathcad.

1RWH In addition to the built-in variables described here, Mathcad treats the names of all built-in units 
as predefined variables. See “Units and Dimensions” on page 112.

Although Mathcad’s predefined variables already have values when you start Mat
you can still redefine them. For example, if you want to use a variable called e with a 

value other than the one Mathcad provides, enter a new definition, like . The 

variable e takes on the new value everywhere in the worksheet below and to the 
of the new definition. Alternatively, create a global definition for the variable as 
described in “Global Definitions” on page 104.

1RWH Mathcad’s predefined variables are defined for all fonts, sizes, and styles. This means that
redefine e as described above, you can still use e, for example, as the base for natural logarithm
Note, however, that Greek letters are not included. 

vi

x

y1

f x y z, ,( )

M
1〈 〉

e 2:=
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You can modify many of Mathcad’s 
built-in variables without having to ex-
plicitly define them in your worksheet. 
To do so, choose Options from the 
Math menu, and click the Built-In 
Variables tab on the Math Options dia-
log box.

To set new starting values for any of 
these variables, enter a new value in the 
appropriate text box and click “OK.” 
Then choose Calculate Worksheet 
from the Math menu to ensure that all 
existing equations take the new values 
into account. 

The numbers in brackets to the right of the variable names represent the default v
for those variables. To restore these default values for the built-in variables liste
the dialog box, click “Restore Defaults” and then click “OK.”

(YDOXDWLQJ�([SUHVVLRQV�1XPHULFDOO\�
To evaluate an expression numerically, follow these steps:

1. Type an expression containing any valid combination of 
numbers, variables, and functions. Any variables or func-
tions in this expression should be defined earlier in the 
worksheet.

2. Press the “=” key, or click  on the Calculator toolbar. 
Mathcad computes the value of the expression and shows 
it after the equal sign. 

7LS Whenever you evaluate an expression, Mathcad shows a final placeholder at the end of the 
equation. You can use this placeholder for unit conversions, as explained in “Working wit
Results” on page 115. As soon as you click outside the region, Mathcad hides the placeh

Figure 8-1 shows some results calculated from preceding variable definitions.

+RZ�0DWKFDG�6FDQV�D�:RUNVKHHW�
Mathcad scans a worksheet the same way you read it: left to right and top to bottom. 
This means that a variable or function definition involving a “:=” affects everything 
below and to the right of it.

To see the placement of regions more clearly in your worksheet, choose Regions from 
the View menu. Mathcad displays blank space in gray and leaves regions in you
background color.
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Figure 8-2 shows examples of how placement of equations in a worksheet affects the 
evaluation of results. In the first evaluation, both x and y are highlighted (Mathcad 
shows them in red on screen) to indicate that they are undefined. This is because the 
definitions for x and y lie below where they are used. Because Mathcad scans from top 
to bottom, when it gets to the first equation, it doesn’t know the values of x and y.

The second evaluation, on the other hand, is below the definitions of x and y. By the 
time Mathcad gets to this equation, it has already assigned values to both x and y. 

1RWH You can define a variable more than once in the same worksheet. Mathcad simply uses the first 
definition for all expressions below the first definition and above the second. For expressions 
below the second definition and above the third, Mathcad uses the second definition, and so on.

*OREDO�'HILQLWLRQV�
Global definitions are exactly like local definitions except that they are evaluated be
any local definitions. If you define a variable or function with a global definition, th
variable or function is available to all local definitions in your worksheet, regardle
of whether the local definition appears above or below the global definition.

Figure 8-1: Calculations based on simple variable definitions.

Figure 8-2: Mathcad evaluates equations from top to bottom in a worksheet. 
Undefined variables are highlighted.
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To type a global definition, follow these steps:

1. Type a variable name or function to be defined.

2. Press the tilde (~) key, or click  on the Evaluation toolbar. 
The global definition symbol appears.

3. Type an expression. The expression can involve numbers or other 
globally defined variables and functions.

You can use global definitions for functions, subscripted variables, and anything else 
that normally uses the definition symbol “:=”. 

This is the algorithm that Mathcad uses to evaluate all definitions, global and other

• First, Mathcad takes one pass through the entire worksheet from top to botto
During this first pass, Mathcad evaluates global definitions only.

• Mathcad then makes a second pass through the worksheet from top to bottom
time, Mathcad evaluates all definitions made with “:=” as well as all equations 
containing “=” and “≡”. Note that during this pass, global definitions do not use
any local definitions.

1RWH A global definition of a variable can be overridden by a local definition of the same variable 
name with the definition symbol “:=”.

Figure 8-3 shows the results of a global definition for the variable R which appears at 
the bottom of the figure. 

Figure 8-3: Using the global definition symbol.
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Although global definitions are evaluated before any local definitions, Mathcad eval-
uates global definitions the same way it evaluates local definitions: top to bottom and 
left to right. This means that whenever you use a variable to the right of a “≡”:

• that variable must also have been defined with a “≡,” and

• the variable must have been defined above the place where you are trying to use 

Otherwise, the variable is marked in red to indicate that it is undefined.

7LS It is good practice to allow only one definition for each global variable. Although you can do 
things like define a variable with two different global definitions or with one global and one local 
definition, this may make your worksheet difficult for others to understand.

5DQJH�9DULDEOHV�
Iterative processes in Mathcad worksheets depend on range variables. Except for the 
way it is defined, a range variable looks just like a conventional variable. The differ
is that a conventional variable takes on only one value. A range variable, on the 
hand, takes on a range of values separated by uniform steps. For example, you
define a range variable to go from –4 through 4 in steps of 2. If you now use this r
variable in an expression, Mathcad evaluates that expression five times, once for
value taken by the range variable.

Range variables are crucial to exploiting Mathcad’s capabilities to their fullest. T
section shows how to define and use range variables to perform iteration. For a 
description of more advanced iterative operations made possible by the program
operators in Mathcad Professional, turn to Chapter 15, “Programming.”

'HILQLQJ�DQG�XVLQJ�UDQJH�YDULDEOHV�

To define a range variable, type the variable name followed by a colon and a ran
values. For example, here’s how to define the variable j ranging from 0 to 15 in steps 
of 1:

1. Type j and then press the colon key (:), or click  on the 
Calculator toolbar. The empty placeholder indicates that Mathcad 
expects a definition for j. At this point, Mathcad does not know whether j is to be 
a conventional variable or a range variable. 

2. Type 0. Then press the semicolon key (;), or click  on the 
Calculator toolbar. This tells Mathcad that you are defining a range 
variable. Mathcad displays the semicolon as two periods “..” to indicate a ran
Complete the range variable definition by typing 15 in the remaining placeholder.

This definition indicates that j now takes on the values . To define a rang
variable that changes in steps other than 1, see the section “Types of ranges” on
108. 

0 1 2…15, ,
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Once you define a range variable, it takes on its complete range of values every time 
you use it. If you use a range variable in an equation, for example, Mathcad evaluates 
that equation once for each value of the range variable.

You must define a range variable exactly as shown above. There must be:

• a variable name on the left,

• either a “:=” or a “≡” in the middle, and

• a valid range on the right.

1RWH You cannot define a variable in terms of a range variable. For example, if after having defined j 

as shown you now define , Mathcad assumes you are trying to set a scalar variable 

equal to a range variable and marks the equation with an appropriate error message.

One application of range variables is to fill up the elements of a vector or matrix. 
can define vector elements by using a range variable as a subscript. For examp

define  for each value of j:

• Type x[j:j^2[Space]+1.

Figure 8-4 shows the vector of values computed by this equation. Since j is a range 
variable, the entire equation is evaluated once for each value of j. This defines  for 

each value of j from 0 to 15. 

Figure 8-4: Using a range variable to define the values of a vector.

i j 1+:=

xj

xj
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To understand how Mathcad computes with range variables, keep in mind this funda-
mental principle: 

If you use a range variable in an expression, Mathcad evaluates the expression once 
for each value of the range variable.    

If you use two or more range variables in an equation, Mathcad evaluates the equation 
once for each value of each range variable. 

7LS Mathcad takes longer to compute equations with ranged expressions since there may be many 
computations for each equation. While Mathcad is computing, the mouse pointer changes its 
appearance. To learn how to interrupt a calculation in progress, see “Interrupting Calculat
on page 124.

7\SHV�RI�UDQJHV�

The definition of j in the previous section, ranging from 0 to 15, is an example of the 
simplest type of range definition. But Mathcad permits range variables with values 
ranging from any value to any other value, using any constant increment or decrement.

To define a range variable with a step size other than 1, type an equation of this form:

k:1,1.1;2

This appears in your worksheet window as:

In this range definition: 

• The variable k is the name of the range variable itself. 

• The number 1 is the first value taken by the range variable k.

• The number 1.1 is the second value in the range. Note that this is not the step size. 
The step size in this example is 0.1, the difference between 1.1 and 1. If you
the comma and the 1.1, Mathcad assumes a step size of one in whatever dir
(up or down) is appropriate.

• The number 2 is the last value in the range. In this example, the range value

constantly increasing. If instead you had defined , then k would count 

down from 10 to 1. If the third number in the range definition is not an even num
of increments from the starting value, the range will not go beyond it. For exam
if you define  then k takes values 10, 20, 30, . . ., 60.

1RWH You can use arbitrary scalar expressions in range definitions. However, these values must 
always be real numbers. Also note that if you use a fractional increment for a range variable, you 
will not be able to use that range variable as a subscript because subscripts must be integers.

k 1 1.1 2..,:=

k 10 1..:=

k 10 20 65..,:=
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As described in Chapter 10, “Built-in Functions,” Mathcad has an extensive built
function set. You can augment Mathcad’s built-in function set by defining your ow
functions.

You define a function in much the same way you define a variable. The name go
the left, a definition symbol goes in the middle, and an expression goes on the ri
The main difference is that the name includes an argument list. The example below 
shows how to define a function called dist(x, y) that returns the distance between th
point (x, y) and the origin.

To type such a function definition:

1. Type the function name. 

2. Type a left parenthesis followed by one or more names separated by 
commas. Complete this argument list by typing a right parenthesis. 

1RWH It makes no difference whether or not the names in the argument list have been defined or used 
elsewhere in the worksheet. What is important is that these arguments must be names. They 
cannot be more complicated expressions. 

• Press the colon (:) key, or click  on the Calculator 
toolbar. You see the definition symbol (:=).

• Type an expression to define the function. In this 
example, the expression involves only the names in 
the argument list. In general though, the expression 
can contain any previously defined functions and variables as well.

Once you have defined a function, you can use it anywhere below and to the rig
the definition, just as you would use a variable.

When you evaluate an expression containing a function, as shown in Figure 8-5
Mathcad:

1. evaluates the arguments you place between the parentheses,

2. replaces the dummy arguments in the function definition with the actual argum
you place between the parentheses, 

3. performs whatever arithmetic is specified by the function definition,

4. returns the result as the value of the function.

1RWH As shown in Figure 8-5, if you type only the name of a function without its arguments, Mathcad 
returns the word “function.”
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The arguments of a user-defined function can represent scalars, vectors, or matrices. 

For example, you could define the distance function as . This is 

an example of a function that accepts a vector as an argument and returns a scalar result. 
See Chapter 11, “Vectors, Matrices, and Data Arrays,” for more information. 

1RWH User-defined function names are font and case sensitive. The function f(x) is different from the 
function f(x) and SIN(x) is different from sin(x). Mathcad’s built-in functions, however, are 
defined for all fonts (except the Symbol font), sizes, and styles. This means that sin(x), sin(x), 
and sin(x) all refer to the same function. 

9DULDEOHV�LQ�8VHU�'HILQHG�)XQFWLRQV�
When you define a function, you don’t have to define any of the names in the argu
list since you are telling Mathcad what to do with the arguments, not what they are. 
When you define a function, Mathcad doesn’t even have to know the types of th
arguments—whether the arguments are scalars, vectors, matrices, and so on. It 
when Mathcad evaluates a function that it needs to know the argument types.

However, if in defining a function you use a variable name that is not in the argument 
list, you must define that variable name above the function definition. The value of
variable at the time you make the function definition then becomes a permanent
of the function. This is illustrated in Figure 8-6.

If you want a function to depend on the value of a variable, you must include tha
variable as an argument. If not, Mathcad just uses that variable’s fixed value at the
in the worksheet where the function is defined.

Figure 8-5: A user-defined function to compute the distance to the origin.

dist v( ) v0
2 v1

2+:=
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Mathcad supports recursive function definitions—you may define the value of a 
function in terms of a previous value of the function. As shown in Figure 8-7, recur
functions are useful for defining arbitrary periodic functions, as well as elegantly 
implementing numerical functions like the factorial function

Note that a recursive function definition should always have at least two parts:

• An initial condition that prevents the recursion from going forever.

• A definition of the function in terms of some previous value(s) of the function.

Figure 8-6: The value of a user function depends on its arguments.

Figure 8-7: Mathcad allows recursive function definitions.
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1RWH If you do not specify an initial condition that stops the recursion, Mathcad generates a “st
overflow” error message when you try to evaluate the function.

The programming operators in Mathcad Professional also support recursion. See the 
section “Programs Within Programs” in Chapter 15 for examples.

8QLWV�DQG�'LPHQVLRQV

When you first start Mathcad, a complete set of units is available for your calculati
You can treat these units just like built-in variables. To assign units to a number 
expression, just multiply it by the name of the unit. 

Mathcad recognizes most units by their common abbreviations. Lists of all of Ma
cad’s built-in units in several systems of units are in the Appendices. By default 
Mathcad uses units from the SI unit system (also known as the International System
Units) in the results of any calculations, but you may use any supported units you w
in creating your expressions. See “Displaying Units of Results” on page 118 for m
information about selecting a unit system for results.

For example, type expressions like the following:

mass:75*kg

acc:100*m/s^2

acc_g:9.8*m/s^2

F:mass*(acc + acc_g)

Figure 8-8 shows how these equations appear in a worksheet.

7LS If you define a variable which consists of a number followed immediately by a unit name, you 
can omit the multiplication symbol; Mathcad inserts a very small space and treats the 
multiplication as implied. See the definition of mass at the bottom of Figure 8-8. 

Figure 8-8: Equations using units.
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You can also use the Insert Unit dialog box to insert one of Mathcad’s built-in un
into any placeholder. 

To use the Insert Unit dialog box:

1. Click in the empty placeholder and choose Unit from the Insert menu, or click  
on the Standard toolbar. Mathcad opens the Insert Unit dialog box.

2. The list at the bottom shows built-in 
units, along with their Mathcad names, 
corresponding to whatever physical 
quantity is selected in the top scrolling 
list. When “Dimensionless” is selected 
at the top, a list of all available built-in 
units shows on the bottom.

3. If necessary, use the top scrolling list 
to display only those units correspond-
ing to a particular physical quantity. 
This makes it easier to find a particular 
unit or to see what choices are appro-
priate.

4. In the bottom list, double-click the unit you want to insert, or click the unit you
want and then click “Insert.” Mathcad inserts that unit into the empty placeho

1RWH Mathcad performs some dimensional analysis by trying to match the dimensions of your selected 
result with one of the common physical quantities in the top scrolling list. If it finds a match, 
you’ll see all the built-in units corresponding to the highlighted physical quantity in the bott
scrolling list. If nothing matches, Mathcad simply lists all available built-in units on the bott

'LPHQVLRQDO�&KHFNLQJ
Whenever you enter an expression involving units, Mathcad checks it for dimensional 
consistency. If you add or subtract values with incompatible units, or violate other 
principles of dimensional analysis, Mathcad displays an appropriate error message. 

For example, suppose you had defined acc 

as  instead of  as 
shown at right. Since acc is in units of 
velocity and acc_g is in units of accelera-
tion, it is inappropriate to add them togeth-
er. When you attempt to do so, Mathcad 
displays an error message. 

100 m s⁄⋅ 100 m s2⁄⋅
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Other unit errors are usually caused by one of the following:   

• An incorrect unit conversion.

• A variable with the wrong units.

• Units in exponents or subscripts (for example  or ). 

• Units as arguments to inappropriate functions (for example, ).

7LS If you want to temporarily remove units from an argument, x, divide x by UnitsOf(x). For 

example, if p is defined as 2 ft then  gives an error but .

'HILQLQJ�<RXU�2ZQ�8QLWV
Although Mathcad recognizes many common units, you may need to define your
unit if that unit isn’t one of Mathcad’s built-in units or if you prefer to use your ow
abbreviation instead of Mathcad’s abbreviation.

1RWH Although absolute temperature units are built into Mathcad, the Fahrenheit and Celsius 
temperature units are not. See the QuickSheet “Temperature Conversions” in the on-line
Resource Center for samples of defining these temperature scales and converting betwee

You define your own units in terms of existing units in exactly the same way you would 
define a variable in terms of an existing variable. Figure 8-9 shows how to define new 
units as well as how to redefine existing units.

1RWH Since units behave just like variables, you may run into unexpected conflicts. For exampl
you define the variable m in your worksheet, you won’t be able to use the built-in unit m for 
meters anywhere below that definition. However, Mathcad automatically displays the unitm in 
any results involving meters, as described in “Displaying Units of Results” on page 118.

Figure 8-9: Defining your own units.

v3 acre⋅ 23 f t⋅

0 henry⋅( )sin

p( )sin
p

UnitsOf p( )
----------------------------- 

 sin 0.573=
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The way that Mathcad displays numbers (the number of decimal places, whether to use 
i or j for imaginary numbers, and so on) is called the result format. You can set the 
result format for a single calculated result or for an entire worksheet.

6HWWLQJ�WKH�IRUPDW�RI�D�VLQJOH�UHVXOW

When you evaluate expressions numerically in Mathcad, results are formatted in the 
worksheet according to the worksheet default result format. You can modify the format 
for a single result as follows:

1. Click anywhere in the equation whose result you 
want to format. 

2. Choose Result from the Format 
menu. Alternatively, double-click 
the equation itself. The Result For-
mat dialog box appears. 

3. Change the desired settings. See be-
low to learn about the various set-
tings in the dialog box. To display a 
result with six decimal places, you 
would increase “Number of decimal 
places” from 3 to 6. 

4. Click “OK.” Mathcad redisplays 
the result using the new format.

To redisplay a result using the worksheet default result 
format settings, click on the result to enclose the result between the editing lines, d
the equal sign, and press = to replace the equal sign. The result is now restored to 
default worksheet settings.

1RWH When the format of a result is changed, only the appearance of the result changes in the 
worksheet. Mathcad continues to maintain full precision internally for that result. To see a 
number as it is stored internally, click on the result, press [Ctrl][Shift]N, and look at the 
message line at the bottom of the Mathcad window. If you copy a result, however, Mathcad 
copies the number only to the precision displayed.

6HWWLQJ�ZRUNVKHHW�GHIDXOW�IRUPDW�

To change the default display of numerical results in your worksheet:

1. Click in a blank part of your worksheet.

2. Choose Result from the Format menu. 
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3. Change the desired settings in the Result Format dialog box.

4. Click “OK.” 

Mathcad changes the display of all results whose formats have not been explicit
specified. 

Alternatively, you can change the worksheet default by clicking on a particular re
choosing Result from the Format menu, changing the settings in the Result Form
dialog box, and clicking “Set as Default.”

7LS Changing the worksheet default result format affects only the worksheet you are working in 
when you make the change. Any other worksheets open at the time retain their own default result 
formats. If you want to re-use your default result formats in other Mathcad worksheets, save your 
worksheet as a template as described in Chapter 7, “Worksheet Management.”

7KH�5HVXOW�)RUPDW�GLDORJ�ER[

The tabs in the Result Format dialog box lead to pages containing options for formatting 
various aspects of a result.

The Number Format page lets you control the number of decimal places, trailing zeros, 
and other options. Depending on the format scheme you choose under the Format 
section, you see different options.

• Choosing General lets you control the number of digits to the right of the decim
point, trailing zeros, and exponential threshold. A result is displayed in expone
notation or engineering format when the exponential threshold is exceeded. Y
can display trailing zeros to the right of the decimal until you exceed 15 digits t

• Choosing Decimal lets you control the number of digits to the right of the decim
point and never display the results in exponential notation. You can display tra
zeros to the right of the decimal point beyond 15 digits total, but only the first
digits are accurate.

• Choosing Scientific or Engineering lets you control the number of digits to the 
right of the decimal point and always display results in exponential notation. 
Engineering, the exponents are displayed in multiples of three. You can use 
notation for the exponents by choosing “Show exponents as ± E 000.” You c
display trailing zeros to the right of the decimal point beyond 15 digits total, b
only the first 15 digits are accurate.

• Choosing Fractional lets you display results as fractions or mixed numbers. U
the level of accuracy setting to control the number of decimal places of accur
of the fraction displayed. You can display a fraction that is accurate to up to 1
decimal places.

1RWH Settings that are grayed can only be changed for the entire worksheet, as described in “S
worksheet default format” on page 115.
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The Display Options page lets you control whether arrays are displayed as tables or 
matrices, whether nested arrays are expanded, and whether i or j is used to indicated 
imaginary. You can also specify another radix such as Binary or Octal.           

The Unit Display page gives you options to format units (as fractions) or simplify the 
units to derived units.

The Tolerance page allows you to specify when to hide a real or imaginary part of a 
result and how small a number has to be for it to display as zero.   

2Q�OLQH�+HOS For more details and examples of the options available on a particular page in the Result Format 
dialog box, click the Help button at the bottom of the dialog box.

Figure 8-10 shows some examples of formatting options.

&RPSOH[�5HVXOWV
Complex numbers can arise in results if you enter an expression that contains a complex 
number. Even a Mathcad expression that involves only real numbers can have a 

complex value. For example, if you evaluate , Mathcad returns i. See Figure 8-11 
for examples.

1RWH When complex numbers are available, many functions and operators we think of as returning 
unique results become multivalued. In general, when a function or operator is multivalued, 
Mathcad returns the principal value: the value making the smallest positive angle relative to the 

positive real axis in the complex plane. For example, when it evaluates , Mathcad 

returns  despite the fact that we commonly think of the cube root of –1 as being
This is because the number  makes an angle of only 60 degrees from the positiv
axis. The number –1, on the other hand, is 180 degrees from the positive real axis. Mathc
nth root operator returns –1 in this case, however.

Figure 8-10: Several ways to format the same number.
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Mathcad by default displays results in terms of the fundamental units of the unit system 
you’re working with. Mathcad offers the following unit system choices: SI, CGS, MKS, 
U.S. customary units, or no unit system (see below).

7LS Check “Simplify units when possible” in the Result Format dialog box (see page 115) to s
units in a result expressed in terms of derived units rather than in base units. Check “Form
units” to see units in a result displayed as a built-up fraction containing terms with positive
exponents only rather than as a product of units with positive and negative exponents.

You can have Mathcad redisplay a particular result in terms of any of Mathcad’s b
in units. To do so:

1. Click in the result. You’ll see an empty placeholder to its right. This is the units 
placeholder.

2. Click the units placeholder and choose Unit from the Insert menu, or click  
on the Standard toolbar. Mathcad opens the Insert Unit dialog box. This is desc
in “Units and Dimensions” on page 112.

3. Double-click the unit in which you want to display the result. Mathcad inserts 
unit in the units placeholder.

1RWH For some engineering units—such as hp, cal, BTU, and Hz—Mathcad adopts one common 
definition for the unit name but allows you to insert one of several alternative unit names,
corresponding to alternative definitions of that unit, in your results. In the case of horsepo
for example, Mathcad uses the U.K. definition of the unit hp but gives you several variants, such
as water horsepower, metric horsepower, boiler horsepower, and electric horsepower. 

Another way to insert a unit is to type its name directly into the units placeholder. This 
method is more general since it works not only for built-in units but also for units you
defined yourself and for combinations of units.

Figure 8-11: Examples of complex results.
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When you start Mathcad, the SI system of units is loaded by default. This means that 
when you use the equal sign to display a result having units, Mathcad automatically 
displays the units in the result in terms of base or derived SI units.

You can have Mathcad display results in terms of the units of any of the other built-in 
unit systems in Mathcad: CGS, US customary, MKS, or no unit system at all. To do so, 
choose Options from the Math menu and click the Unit System tab. 

Select the default unit system in which 
you want to display results. The SI unit 
system, widely used by scientists and 
engineers in many countries, provides 
two additional base units over the other 
systems, one for luminosity (candela) 
and one for substance (mole), and the 
base SI electrical unit (ampere) differs 
from the base electrical unit in the oth-
er systems (coulomb).

The following table summarizes the 
base units available in Mathcad’s unit 
systems:

8QLW�6\VWHP %DVH�8QLWV

SI m, kg, s, A, K, cd, and mole

MKS m, kg, sec, coul, and K

CGS cm, gm, sec, coul, and K

U.S. ft, lb, sec, coul, and K

None Displays results in terms of fundamental dimensions of length, mass,
time, charge, and absolute temperature. All built-in units are disabled.

The standard SI unit names—such as A for ampere, L for liter, s for second, and S for 
siemens—are generally available only in the SI unit system. Many other unit names ar
available in all the available systems of units. For a listing of which units are avail
in each system, see the Appendices. Mathcad includes most units common to sci
and engineering practice. Where conventional unit prefixes such as m- for milli-, n- for 
nano-, etc. are not understood by Mathcad, you can easily define custom units su

 as described in “Defining Your Own Units” on page 114. 

7LS For examples of units with prefixes not already built into Mathcad, see the QuickSheets in the 
on-line Resource Center.

µm
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If you click “None” in the Unit System tab of the Math Options dialog box, Mathc
doesn’t understand any built-in units and displays answers in terms of the fundam
dimensions of length, mass, time, charge, and temperature. However, even if you are 
working in one of Mathcad’s built-in unit systems, you can always choose to see re
in your worksheet displayed in terms of fundamental dimension names rather tha
base units of the unit system. To do so:

1. Choose Options from the Math menu. 

2. Click the Dimensions tab.

3. Check “Display dimensions.”

4. Click “OK.”

8QLW�FRQYHUVLRQV

There are two ways to convert from one set of units to another:

• By using the Insert Unit dialog box, or

• By typing the new units in the units placeholder itself.

To convert units using the Insert Unit dialog box:

1. Click the unit you want to replace.

2. Choose Unit from the Insert menu, or click  on the Standard toolbar.

3. In the scrolling list of units, double-click the unit in which you want to display t
result. 

As a quick shortcut, or if you want to display the result in terms of a unit not availa
through the Insert Unit dialog box—for example, a unit you defined yourself or a
algebraic combination of units—you can edit the units placeholder directly.

Figure 8-12 shows F displayed both in terms of fundamental SI units and in terms of 
several combinations of units.

When you enter an inappropriate unit in the units placeholder, Mathcad inserts a
combination of base units that generate the correct units for the displayed result
example, in the last equation in Figure 8-12,  is not a unit of force. Mathca

therefore inserts  to cancel the extra length dimension.

Whenever you enter units in the units placeholder, Mathcad divides the value to
displayed by whatever you enter in the units placeholder. This ensures that the com
displayed result—the number times the expression you entered for the placeholder
is a correct value for the equation.

1RWH Conversions involving an offset in addition to a multiplication, for example gauge pressure to 
absolute pressure, or degrees Fahrenheit to Celsius, cannot be performed directly with 
Mathcad’s unit conversion mechanism. You can, however, perform conversions of this typ
defining suitable functions. See the QuickSheet “Temperature Conversions” in the on-line
Resource Center for examples of temperature conversion functions.

kW s⋅

m 1–
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You can enter any variable, constant, or expression in a units placeholder. Mathcad 
then redisplays the result in terms of the value contained in the units placeholder. For 
example, you can use the units placeholder to display a result as a multiple of π or in 

engineering notation (as a multiple of , , etc.). 

7LS You can also use the units placeholder for dimensionless units like degrees and radians. Mathcad 
treats the unit rad as a constant equal to 1, so if you have a number or an expression in radians, 
you can type deg into the units placeholder to convert the result from radians to degrees. 

&RS\LQJ�DQG�3DVWLQJ�1XPHULFDO�5HVXOWV
You can copy a numerical result and paste it either elsewhere in your worksheet or into 
a new application. 

To copy a single number appearing to the right of an equal sign:

4. Click on the result to the right of the equal sign. This puts the result between the 
editing lines.

5. Choose Copy from the Edit menu, or click  on the Standard toolbar to place 
the result on the Clipboard.

6. Click wherever you want to paste the result. If you’re pasting into another app
tion, choose Paste from that application’s Edit menu. If you’re pasting into a 

Mathcad worksheet, choose Paste from Mathcad’s Edit menu or click  on the 
Standard toolbar.

Figure 8-12: A calculated result displayed with different units

103 106
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When you paste a numerical result into a Mathcad worksheet, it appears as:

• A math region consisting of a number if you paste it into empty space.

• A number if you paste it into a placeholder in a math region.

• A number if you paste it directly into text or into a placeholder in text created us
the Math Region command on the Insert menu.

To copy more than one number, follow the steps for copying from an array. See 
“Displaying Arrays” on page 210 for information on copying and pasting arrays.

1RWH The Copy command copies the numerical result only to the precision displayed. To copy the 
result in greater precision, double-click it and increase “Displayed Precision” on the Resu
Format dialog box. Copy does not copy units and dimensions from a numerical result.

&RQWUROOLQJ�&DOFXODWLRQ�

When you start Mathcad, you are in automatic mode. This means that Mathcad updates 
results in the worksheet window automatically. You can tell you’re in automatic m
because the word “Auto” appears in the message line at the bottom of the windo

If you don’t want to wait for Mathcad to make computations as you edit, you can dis
automatic mode by choosing Automatic Calculation from the Math menu. The word 
“Auto” disappears from the message line and the check beside Automatic Calculation 
disappears to indicate that automatic mode is now off. You are now in manual mode.

7LS The calculation mode—either manual or automatic—is a property saved in your Mathcad
worksheet. As described in Chapter 7, “Worksheet Management,” the calculation mode is
a property saved in Mathcad template (MCT) files. 

&DOFXODWLQJ�LQ�$XWRPDWLF�0RGH
Here is how Mathcad works in automatic mode:

• As soon as you press the equal sign, Mathcad displays a result.

• As soon as you click outside of an equation having a “:=” or a “≡,” Mathcad 
performs all calculations necessary to make the assignment statement.

When you process a definition in automatic mode by clicking outside the equatio
region, this is what happens:

• Mathcad evaluates the expression on the right side of the definition and assig
to the name on the left.

• Mathcad then takes note of all other equations in the worksheet that are in any
affected by the definition you just made.

• Finally, Mathcad updates any of the affected equations that are currently visib
the worksheet window. 
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1RWH Although the equation you altered may affect equations throughout your worksheet, Mathcad 
performs only those calculations necessary to guarantee that whatever you can see in the window 
is up-to-date. This optimization ensures you don’t have to wait for Mathcad to evaluate 
expressions that are not visible. If you print or move to the end of the worksheet, howeve
Mathcad automatically updates the whole worksheet.

Whenever Mathcad needs time to complete computations, the mouse pointer changes 
its appearance and the word “WAIT” appears on the message line. This can occur wh
you enter or calculate an equation, when you scroll, during printing, or when you
enlarge a window to reveal additional equations. In all these cases, Mathcad eva
pending calculations from earlier changes.

As Mathcad evaluates an expression, it surrounds it with a green rectangle. This m
it easy to follow the progress of a calculation.

To force Mathcad to recalculate all equations throughout the worksheet, choose
Calculate Worksheet from the Math menu.

&DOFXODWLQJ�LQ�0DQXDO�0RGH
In manual mode, Mathcad does not compute equations or display results until yo
specifically request it to recalculate. This means that you don’t have to wait for Mat
to calculate as you enter equations or scroll around a worksheet.

Mathcad keeps track of pending computations while you’re in manual mode. As s
as you make a change that requires computation, the word “Calc” appears on th
message line. This is to remind you that the results you see in the window are n
to-date and that you must recalculate them before you can be sure they are upd

You can update the screen by choosing Calculate from the Math menu or clicking  
on the Standard toolbar. Mathcad performs whatever computations are necessa
update all results visible in the worksheet window. When you move down to see m
of the worksheet, the word “Calc” reappears on the message line to indicate tha
must recalculate to see up-to-date results.

To process the whole worksheet, including those portions not visible in the works
window, choose Calculate Worksheet from the Math menu.

1RWH When you print a worksheet in manual calculation mode, the results on the printout are not 
necessarily up-to-date. In this case, make sure to choose Calculate Worksheet from the Math 
menu before you print.
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,QWHUUXSWLQJ�&DOFXODWLRQV�
To interrupt a computation in progress:

1. Press [Esc]. The dialog box shown at right appears.

2. Click “OK” to stop the calculations or “Cancel” to resume 
calculations.

If you click “OK,” the equation that was being processed when 
you pressed [Esc] is marked with an error message (see “Error 
Messages” on page 126) indicating that calculation has been interrupted. To resu
interrupted calculation, first click in the equation having the error message, then ch

Calculate from the Math menu or click  on the Standard toolbar.

7LS If you find yourself frequently interrupting calculations to avoid having to wait for Mathcad to 
recalculate as you edit your worksheet, you can switch to manual mode as described above. 

'LVDEOLQJ�(TXDWLRQV�
You can disable a single equation so that it no longer calculates along with other reg
in your worksheet. Disabling an equation does not affect Mathcad’s equation edi
formatting, and display capabilities.

To disable calculation for a single equation in your worksheet, follow these steps

1. Click on the equation you want to disable.

2. Choose Properties from the Format menu, and click the Calculation tab.

3. Under “Calculation Options” check “Disable Evaluation.” 

4. Mathcad shows a small rectangle after the equation to indi-
cate that it is disabled. An example is shown at right.

7LS An easy shortcut for disabling evaluation is to click with the right 
mouse button on an equation and select Disable Evaluation from the pop-up menu.

To re-enable calculation for a disabled equation:

1. Click on the equation to select it.

2. Choose Properties from the Format menu, and click the Calculation tab.

3. Remove the check from “Disable Evaluation.” 

Mathcad removes the small rectangle beside the equation, and calculation is re-en

$QLPDWLRQ

This section describes how to use Mathcad to create and play short animation cl
using the built-in variable FRAME. Anything that can be made to depend on this variab
can be animated. This includes not only plots but numerical results as well. You
play back the animation clips at different speeds or save them for use by other 
applications.
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Mathcad comes with a predefined constant called FRAME whose sole purpose is to 
drive animations. The steps in creating any animation are as follows:

1. Create an expression or plot, or a group of expressions, whose appearance ultimate-
ly depends on the value of FRAME. This expression need not be a graph. It can be 
anything at all. 

2. Choose Animate from the View 
menu to bring up the Animate dialog 
box.

3. Drag-select the portion of your work-
sheet you want to animate as shown 
in Figure 8-13. Draw a rectangle 
around as many regions as you want 
to appear in the animation.

4. Set the upper and lower limits for 
FRAME in the dialog box. When you 
record the animation, the FRAME variable increments by one as it proceeds from 
the lower limit to the upper limit.

5. Enter the playback speed in the Frames/Sec. box. 

6. Click “Animate.” You’ll see a miniature rendition of your selection inside the dial
box. Mathcad redraws this once for each value of FRAME. This won’t necessarily 
match the playback speed since at this point you’re just creating the animation.

7. To save your animation clip as a Windows AVI file, suitable for viewing in other 
Windows applications, click “Save As” in the dialog box. 

7LS Since animation clips can take considerable disk space, Mathcad saves them in compressed 
format. Before creating the animation, you can choose what compression method to use or 
whether to compress at all. To do so, click “Options” in the Animate dialog box. 

Figure 8-13: Selecting an area of a worksheet for animation.
Animation 125



. 

n.
3OD\LQJ�DQ�$QLPDWLRQ�&OLS
As soon as you’ve created an animation clip as described in 
the previous section, Mathcad opens a Playback window:

The first frame of the animation clip you just created is 
already in the window. To play back the animation clip, click 
the arrow at the lower left corner of the window. You can 
also play back the animation clip on a frame by frame basis, 
either forward or backward. To do so, drag the slider below 
the animated picture to the left or right.

7LS You can control the playback speed by clicking the button to the 
right of the play button, which then opens a pop-up menu. Choose Speed from the menu and 
adjust the slider control. 

3OD\LQJ�D�3UHYLRXVO\�6DYHG�$QLPDWLRQ
If you have an existing Windows AVI file on your disk, you can play it within Mathcad
To do so:

1. Choose Playback from the View menu to 
bring up the Playback dialog box. The win-
dow is collapsed since no animation clip has 
been opened. 

2. Click on the button to the right of the play button and choose Open from the menu. 
Use the Open File dialog box to locate and open the AVI file you want to play.

Once you’ve loaded a Windows AVI file, proceed as described in the previous sectio

7LS To launch an animation directly from your worksheet, you can insert a hyperlink to an AVI file 
by choosing Hyperlink from the Insert menu. You can also embed a shortcut to the AVI file in 
your worksheet by dragging the icon for the AVI file from the Windows Explorer and dropping 
it into your worksheet. Finally, you can embed or link an OLE animation object in your 
worksheet (see “Inserting Objects” on page 74).

(UURU�0HVVDJHV�

If Mathcad encounters an error when evaluating an expression, it marks the expression 
with an error message and highlights the offending name or operator in red.

An error message is visible only when you click on the 
associated expression, as shown to the right. 
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Mathcad cannot process an expression containing an error. If the expression is a 
definition, the variable or function it is supposed to define remains undefined. This can 
cause any expressions that reference that variable to be undefined as well.

7LS You can get on-line help about some error messages by clicking on them and pressing [F1]. 

)LQGLQJ�WKH�6RXUFH�RI�DQ�(UURU
When a Mathcad worksheet contains an expression that is dependent on one or more 
definitions made earlier in the worksheet, an error on that expression may originate in 
an earlier definition.

For example, in the figure above, the error appears on the third region, f(0). However, 
f(x) is based on the definition of g(x). When x is zero, g(x) is the first region that exhibits 
the error. 

You can try to find the source of an error yourself simply by examining your worksheet 
to see where the error began, or you can use Mathcad to trace the error back through 
your worksheet. To find the source of an error using Mathcad:

1. Click on the region showing the error with the right mouse button and choose Trace 
Error from the pop-up menu. The Trace Error dialog box appears:

2. Use the buttons in the dialog box to navigate among the regions associated with the 
region showing the error.

For example, click Back to step back to 
the previous dependent region.

Or click First to jump to the first region 
causing the error.

7LS If you anticipate time-consuming calculations, switch to manual mode as described in 
“Controlling Calculation” on page 122. When you are ready to recalculate, choose Calculate 

from the Math menu or click  on the Standard toolbar turn. Alternatively, turn on automa
mode again.
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Once you have determined which expression caused the error, edit that expression to 
fix the error or change the variable definitions that led to the error. When you click in 
the expression and begin editing, Mathcad removes the error message. When you click 
outside the equation (or in manual calculation mode, when you recalculate), Mathcad 
recomputes the expression. Once you have fixed the error, Mathcad then recomputes 
the other expressions affected by the expression you changed.

1RWH When you define a function, Mathcad does not try to evaluate it until you subsequently use it in 
the worksheet. If there is an error, the use of the function is marked in error, even though the real 
problem may lie in the definition of the function itself, possibly much earlier in the worksheet. 
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You insert the common arithmetic operators into math expressions in Mathcad using 
the standard keystrokes, like * and +, that you use in spreadsheet and other applications. 
Additionally, all of Mathcad’s operators can be inserted into math expressions by
clicking buttons in the math toolbars. For example, you insert Mathcad’s derivati

operator by clicking  on the Calculus toolbar, or by typing ?. Choose Toolbars 
from the View menu to see any of the math toolbars. See “Operators” on page 44
a complete list of operators, their keystrokes, and descriptions.

1RWH In general, you only insert operators into blank space in your worksheet or when you have 
already clicked in a math region. To use operators in text, first click in the text and choose Math 
Region from the Insert menu. This creates a math placeholder in the text into which you can 
insert operators.

7LS You can find the keyboard shortcut for inserting an operator by hovering the mouse pointer over 
an operator button in one of the Math toolbars and reading the tooltip that appears.

As introduced in Chapter 4, “Working with Math,” when you insert a Mathcad opera
into a blank space in your worksheet, a mathematical symbol with empty placeholders 
appears in the worksheet. The placeholders are for you to enter expressions that 
operands of the operator. The number of empty placeholders varies with the opera
some operators like the factorial operator have only a single placeholder, while o
such as the definite integral have several. You must enter a valid math expressi
each placeholder of an operator in order to calculate a result.
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Here is a very simple example involving Mathcad’s addition operator:

1. Click in a blank space in your worksheet and click  on the 
Calculator toolbar, or simply type +. The addition operator with 
two placeholders appears.

2. Enter 2 in the first placeholder.

3. Click in the second placeholder, or press [Tab] to move the 
cursor, and enter 6.

4. Press =, or click  on the Evaluation toolbar, to see the 
numerical result.

7LS See Chapter 4, “Working with Math,” for a discussion of how to build and edit more comp
math expressions, including how to use the editing lines to specify what becomes the operand o
the next operator you insert or delete.

$GGLWLRQDO�2SHUDWRUV
This chapter focuses on those Mathcad operators you can use to calculate numerical 
answers. Additional operators in Mathcad include: 

• Symbolic operators, which can only be used to generate other math expression
exact numerical answers. As described in Chapter 14, “Symbolic Calculation
Mathcad’s symbolic processor understands virtually any Mathcad expression
expressions that include the following operators on the Calculus toolbar can only 

be evaluated symbolically: indefinite integral , two-sided limit , limit from

above , and limit from below . To evaluate an expression symbolicall

click  on the Evaluation toolbar.

• Programming operators, which you use to link multiple Mathcad expressions v
conditional branching, looping constructs, local scoping of variables, and oth
attributes of traditional programming languages. These operators, available on

Mathcad Professional (click  on the Math toolbar), are introduced in Chap
15, “Programming.”

&KDQJLQJ�WKH�'LVSOD\�RI�DQ�2SHUDWRU
When you insert an operator into a worksheet, it has a certain default appearanc

example, when you type a colon: or click  on the Calculator toolbar, Mathcad 
shows the colon as the definition symbol :=. This is a special symbol used by Mathca
to indicate a variable or function definition. 
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There may be times when you want to control the appearance of a special symbol such 
as the definition symbol. For example you may want the definition symbol to look like 
an ordinary equal sign, but you still want to use it to define variables and functions in 
your worksheet. Mathcad therefore allows you to change the appearance of some 
operators, such as the definition symbol, so that they appear different but behave the 
same way.

To change the way an operator is displayed throughout a worksheet:

1. Choose Options from the Math 
menu.

2. Click the Display tab.

3. Use the drop-down options next to 
each operator to select a display 
option.

4. Click “OK.”

For information on the options avail-
able for each operator, click the Help 
button at the bottom of the Display tab 
in the Math Options dialog box.

To change the appearance of an opera-
tor in one or more individual expressions, click 
with the right mouse button and use the pop-up 
menu. For example, to change the multiplica-
tion in an expression from a dot to an X:

1. Click on the multiplication with the right 
mouse button.

2. Choose View Multiplication As…  ⇒ X 
from the pop-up menu.

$ULWKPHWLF�DQG�%RROHDQ�2SHUDWRUV

$ULWKPHWLF�2SHUDWRUV
You can freely combine all types of numbers with arithmetic operators you access on 
the Calculator toolbar. Figure 9-1 shows examples.

%RROHDQ�2SHUDWRUV
Mathcad includes logical or Boolean operators on the Boolean toolbar. Unlike other 
operators, the Boolean operators can return only a zero or a one. Despite this, they can 
be very useful to perform tests on your expressions.    
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The following table lists the Boolean operators available on the Boolean toolbar and 
their meaning. Note that the “Equal to” operator (bold equal sign) is different from
evaluation equal sign you insert by typing =.

1RWH The Boolean operators return 1 if the expression is true, 0 otherwise. The four operators 

 cannot take complex numbers because the concepts of greater than and less than 
lose their meaning in the complex plane.

Figure 9-1: Combining different types of numbers with arithmetic operators.

$SSHDUDQFH %XWWRQ 'HVFULSWLRQ .H\VWURNH

Equal to; displays as bold equal
sign. 

[Ctrl] =

Less than <

Greater than >

Less than or equal to [Ctrl] 9

Greater than or equal to [Ctrl] 0

Not equal to [Ctrl] 3

Not [Ctrl] [Shift] 1

And [Ctrl] [Shift] 7

Or [Ctrl] [Shift] 6

Xor (Exclusive Or) [Ctrl] [Shift] 5

w z=

x y<

x y>

x y≤

x y≥

w z≠

z¬

w z∧

w z∨

w z⊕

>, <, , and ≥≤
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7LS The comparative boolean operators such as < and > can also be used to compare strings. 
Mathcad compares two strings character by character by determining the ASCII codes of the 
characters. For example, the string “Euler” precedes the string “Mach” in ASCII order and
the expression (“Euler”<“Mach”) evaluates to 1. To determine the character ordering Mat
uses in comparing strings, see “ASCII codes” on page 501 in the Appendices. 

&RPSOH[�2SHUDWRUV�������

Mathcad has the following arithmetic operators for working with complex numbers:

Figure 9-3 shows some examples of how to use complex numbers in Mathcad.

9HFWRU�DQG�0DWUL[�2SHUDWRUV�

Most of the operators on the Calculator toolbar also have meaning for vectors and 
matrices. For example, when you use the addition operator to add two arrays of the 
same size, Mathcad performs the standard element-by-element addition. Mathcad also 
uses the conventional arithmetic operators for matrix subtraction, matrix multiplication, 
integer powers, and determinants, among others.

Some of Mathcad’s operators have special meanings for vectors and matrices, and

of these are grouped on the Matrix toolbar (click  on the Math toolbar). For 
example, the multiplication symbol means multiplication when applied to two numb
but it means dot product when applied to vectors, and matrix multiplication when
applied to matrices. 

Figure 9-2: Using boolean operators.

$SSHDUDQFH %XWWRQ 'HVFULSWLRQ

Complex conjugate of z. To apply the conjugate 
operator to an expression, select the expressio
then press the double-quote key ("). The conjugate
of the complex number  is . 

The magnitude of the number z. 

z

a b i⋅+ a b i⋅–

z
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The table below describes Mathcad’s vector and matrix operations. Operators not
in this table do not work for vectors and matrices. You can, however, use the vect

operator (click  on the Matrix toolbar) to perform any scalar operation or funct
element by element on a vector or matrix. See “Doing Calculations in Parallel” on p
213. Figure 9-4 shows some ways to use vector and matrix operators.

Figure 9-3: Complex numbers in Mathcad.

Figure 9-4: Vector and matrix operations.
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In the following table,

• A and B represent arrays, either vector or matrix

• u and v represent vectors

• M represents a square matrix

•  and  represent the individual elements of vectors u and v

• z represents a scalar

• m and n represent integers

$SSHDUDQFH %XWWRQ 'HVFULSWLRQ

Scalar multiplication. Multiplies each element of
A by the scalar z.

Dot product. Returns a scalar: . The 

vectors must have the same number of element

Matrix multiplication. Returns the matrix product
of A and B. The number of columns in A must 
match the number of rows in B. 

Vector/matrix multiplication. Returns the produc
of A and v. The number of columns in A must 
match the number of rows in v.

Scalar division. Divides each element of the arra
A by the scalar z.

Scalar division. Divides each element of the arra
A by the scalar z. Type [Ctrl] / to insert.

Vector and matrix addition. Adds corresponding
elements of A and B. The arrays A and B must 
have the same number of rows and columns.

Scalar addition. Adds z to each element of A.

Vector and matrix subtraction. Subtracts 
corresponding elements of A and B. The arrays A 
and B must have the same number of rows and 
columns.

Scalar subtraction. Subtracts z from each element 
of A.

Negative of vector or matrix. Returns an array 
whose elements are the negatives of the eleme
of A.

ui vi

A z⋅

u v⋅ Σ ui vi⋅〈 〉

A B⋅

A v⋅

A
z
----

A z÷

A B+

A z+

A B–

A z–

A–
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7LS Operators and functions that expect vectors always expect column vectors. They do not apply to 
row vectors. To change a row vector into a column vector, use the transpose operator by clicking 

 on the Matrix toolbar. 

6XPPDWLRQV�DQG�3URGXFWV�

The summation operator sums an expression over all values of an index. The iterated 
product operator works much the same way. It takes the product of an expression over 
all values of an index.

nth power of square matrix M (using matrix 
multiplication). n must be an integer.  
represents the inverse of M. Other negative 
powers are powers of the inverse. Returns a 
matrix.

Magnitude of vector. Returns  where  is 
the complex conjugate of v.

Determinant. M must be a square matrix.

Transpose. Interchanges row and columns of A.

Cross product. u and v must be three-element 
vectors; result is another three-element vector.

Complex conjugate. Takes complex conjugate of 
each element of A. Insert in math with the double-
quote key (").

Vector sum. Sum elements in v.

Vectorize. Treat all operations in A element by 
element. See “Doing Calculations in Parallel” on
page 213 for details. 

Array superscript. nth column of array A. Returns 
a vector.

Vector subscript. nth element of a vector.

Matrix subscript. m, nth element of a matrix.

Mn

M 1–

v v v⋅ v

M

AT

u v×

A

Σv

A

A n〈 〉

vn

Am n,
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To create a summation operator in your worksheet:

1. Click in a blank space. Then click  on the Calculus toolbar. A 
summation sign with four placeholders appears.

2. Type a variable name in the placeholder to the left of the equal sign. This 
variable is the index of summation. It is defined only within the 
summation operator and therefore has no effect on, and is not influenced 
by, variable definitions outside the summation operator.

3. Type integers, or any expressions that evaluate to integers, in the 
placeholders to the right of the equal sign and above the sigma. 

4. Type the expression you want to sum in the remaining placeholder. 
Usually, this expression involves the index of summation. If this 
expression has several terms, first type an apostrophe (’) to create 
parentheses around the placeholder.

Iterated products are similar to summations. Just click  on the Calculus toolbar and 
fill in the placeholders as described earlier.

7LS Use the keyboard shortcut [Ctrl][Shift]4 to enter the iterated sum and the shortcut 
[Ctrl][Shift]3 to enter the iterated product operator.

Figure 9-5 shows some examples of how to use the summation and product operators. 

To evaluate multiple summations, place another summation in the final placeholder of 
the first summation. An example appears at the bottom of Figure 9-5.

Figure 9-5: Summations and products.
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When you use the summation operator shown in Figure 9-5, the summation must be 
carried out over subsequent integers and in steps of one. Mathcad provides more general 
versions of these operators that can use any range variable you define as an index of 
summation. To use these operators:

1. Define a range variable. For example, type i:1,2;10. 

2. Click in a blank space. Then click  on the Calculus toolbar. 
A summation sign with two placeholders appears.

3. Click on the bottom placeholder and type the name of a range 
variable.

4. Click on the placeholder to the right of the summation sign and 
type an expression involving the range variable. If this 
expression has several terms, first type an apostrophe (’) to 
create parentheses around the placeholder.

5. Press =, or click  on the Evaluation toolbar, to get a result.

7LS To enter the expression in the example above using fewer keystrokes and mouse clicks, type 
i$i^2. 

A generalized version of the iterated product also exists. To use it, click  on the 
Calculus toolbar. Then fill in the two placeholders.

7LS The operation of summing the elements of a vector is so common that Mathcad provides a 

special operator for it. The vector sum operator (click  on the Matrix toolbar) sums the 
elements of a vector without needing a range variable.

9DULDEOH�8SSHU�/LPLW�RI�6XPPDWLRQ
Mathcad’s range summation operator runs through each value of the range variab
place in the bottom placeholder. It is possible, by judicious use of Boolean express
to sum only up to a particular value. In Figure 9-6, the term  returns the valu
whenever it is true and 0 whenever it is false. Although the summation operator 
sums over each value of the index of summation, those terms for which  are
multiplied by 0 and hence do not contribute to the summation.

i x≤

i x>
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You can also use the four-placeholder summation and product operators to compute 
sums and products with a variable upper limit, but note that the upper limit in these 
operators must be an integer.

Figure 9-6: A variable upper limit of summation.

'HULYDWLYHV�

You can use Mathcad’s derivative operators to evaluate the first or higher order 
derivatives of a function at a particular point. 

As an example, here’s how to evaluate the first derivative of  with respect to x at the 

point :

1. First define the point at which you want to evaluate the 
derivative. As a shortcut, type x:2 .

2. Click below the definition of x. Then click  on the Calculus 
toolbar. A derivative operator appears with two placeholders.

3. Type x in the bottom placeholder. You are differentiating with 
respect to this variable. In the placeholder to the right of the

 , enter x^3. This is the expression to be differentiated.

4. Press =, or click  on the Evaluation toolbar, to get the result.

x3

x 2=

xd
d
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Figure 9-7 shows examples of differentiation in Mathcad.

Figure 9-7: Examples of Mathcad differentiation.

With Mathcad’s derivative algorithm, you can expect the first derivative to be accu
within 7 or 8 significant digits, provided that the value at which you evaluate the 
derivative is not too close to a singularity of the function. The accuracy of this algor
tends to decrease by one significant digit for each increase in the order of the deriv
(see “Derivatives of Higher Order” on page 141).

1RWH Keep in mind that the result of numerical differentiation is not a function, but a single number: 
the computed derivative at the indicated value of the differentiation variable. In the previous 

example, the derivative of  is not the expression  but  evaluated at . To 
evaluate derivatives symbolically, see Chapter 14, “Symbolic Calculation.”

Although differentiation returns just one number, you can still define one function as 
the derivative of another. For example:

Evaluating f(x) returns the numerically computed derivative of g(x) at x.

You can use this technique to evaluate the derivative of a function at many points. An 
example of this is shown in Figure 9-8.

There are some important things to remember about differentiation in Mathcad:

• The expression to be differentiated can be either real or complex.

x3 3x2 3x2 x 2=

f x( )
xd

d g x( ):=
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• The differentiation variable must be a single variable name. If you want to eval
the derivative at several different values stored in a vector, you must evaluat
derivative at each individual vector element (see Figure 9-8). 

7LS You can change the display of the derivative operator to partial derivative symbols. For example 

you can make  look like  . To change the display of a derivative operator to partial 

derivative symbols, click on it with the mouse button and choose View Derivative As... ⇒ 
Partial. Or to change the display of all the derivative operators in a worksheet, choose Options 
from the Math menu, click on the Display tab, and select “Partial Derivative” next to Derivati
See “Changing the Display of an Operator” on page 130 for additional information.

'HULYDWLYHV�RI�+LJKHU�2UGHU
To evaluate a higher order derivative, insert the nth derivative operator using steps 
similar to those for inserting the derivative operator described above. 

As an example, here’s how to evaluate the third derivative of  with respect to x at 
the point : After defining x as 2:

1. Click below the definition of x. Then click  on the 
Calculus toolbar. A derivative operator appears with four 
placeholders.

2. Click on the bottom-most placeholder and type x.   

3. Click on the expression above and to the right of the 
previous placeholder and type 3. This must be an integer 

Figure 9-8: Evaluating the derivative of a function at several points.

xd
d

x∂
∂

x9

x 2=
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between 0 and 5 inclusive. Note that the placeholder in the numerator automatically 
mirrors whatever you’ve typed.

4. Click on the placeholder to the right of the  and type 

x^9. This is the expression to be differentiated.

5. Press =, or click  on the Evaluation toolbar, to see the 
result.

1RWH For , the nth derivative operator gives the same answer as the first-derivative operator 
discussed on page 139. 

,QWHJUDOV�

You can use Mathcad’s integral operator to numerically evaluate the definite inte
of a function over some interval.

As an example, here’s how to evaluate the definite integral of  from 0 to 

(In Mathcad you enter  as .) Follow these steps:

1. Click in a blank space and click  on the Calculus 
toolbar. An integral symbol appears, with placeholders for 
the integrand, limits of integration, and variable of 
integration.

2. Click on the bottom placeholder and type 0. Click on the 
top placeholder and type p[Ctrl]G/4. These are the 
upper and lower limits of integration.

3. Click on the placeholder between the integral sign and the 
“d.” Then type sin(x)^2. This is the expression to be 
integrated. 

4. Click on the remaining placeholder and type x. This is the 

variable of integration. Then press =, or click  on the 
Evaluation toolbar, to see the result. 

1RWH Some points to keep in mind when you evaluate integrals in Mathcad: 1) The limits of integration 
must be real. The expression to be integrated can, however, be either real or complex. 2) Except 
for the integrating variable, all variables in the integrand must have been defined previously in 
the worksheet. 3) The integrating variable must be a single variable name. 4) If the integrating 
variable involves units, the upper and lower limits of integration must have the same units.

,QWHJUDWLRQ�$OJRULWKPV�DQG�$XWR6HOHFW
Mathcad has a number of numerical integration methods at its disposal to calcula
numerical approximation of an integral. When you evaluate an integral, by defau

x
3

d

d

n 1=

sin2 x( ) π 4⁄

sin2 x( ) sin x( )2
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Mathcad uses an AutoSelect procedure to choose the most accurate integration method. 
You can override AutoSelect and choose from among the available integration algo-
rithms yourself.

Here are the methods from which Mathcad chooses when you evaluate an integral 
numerically:

5RPEHUJ

Applies a Romberg integration method that divides the interval of integration into 
equally spaced subintervals.

$GDSWLYH

Applies an adaptive quadrature algorithm in cases where the integrand varies consid-
erably in magnitude over the interval of integration.

,QILQLWH�/LPLW

Applies an algorithm designed for improper integral evaluation in cases where either 
limit of integration is ∞ or −∞. 

6LQJXODU�(QGSRLQW

Applies a routine that avoids use of the interval endpoints in cases where the integrand 
is undefined at either limit of integration.

1RWH Although designed to handle a wide range of problems, Mathcad’s integration algorithms—
all numerical methods—can have difficulty with ill-behaved integrands. For example, if th
expression to be integrated has singularities or discontinuities the solution may still be 
inaccurate. 

You can override Mathcad’s integration AutoSelect as follows:

1. Evaluate the value of the integral as described on page 142, 
allowing Mathcad to AutoSelect an integration algorithm.

2. Click with the right mouse button on the integral. 

3. Click one of the listed integration methods on the pop-up menu. 
Mathcad recalculates the integral using the method you selected.

7LS In some cases, you may be able to find an exact numerical value for your integral by using 
Mathcad’s symbolic integration capability. You can also use this capability to evaluate indefinite 
integrals. See Chapter 14, “Symbolic Calculation.” 
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9DULDEOH�/LPLWV�RI�,QWHJUDWLRQ
Although the result of an integration is a single number, you can always use an integral 
with a range variable to obtain results for many numbers at once. You might do this, 
for example, when you set up a variable limit of integration. Figure 9-9 shows how to 
do this. 

Keep in mind that calculations such as those shown in Figure 9-9 require repeatedly 
evaluating an integral. This may take considerable time depending on the complexity 
of the integrals, the length of the interval, and the value of the tolerance parameter TOL 
(see below).

7ROHUDQFH�IRU�,QWHJUDOV�
Mathcad’s numerical integration algorithms make successive estimates of the va
the integral and return a value when the two most recent estimates differ by less
the value of the built-in variable TOL. 

As described in “Built-in Variables” on page 102, you can change the value of th
tolerance by including definitions for TOL directly in your worksheet. You can also 
change the tolerance by using the Built-In Variables tab when you choose Options 
from the Math menu. To see the effect of changing the tolerance, choose Calculate 
Document from the Math menu to recalculate all the equations in the worksheet.

If Mathcad’s approximation to an integral fails to converge to an answer, Mathca
marks the integral with an error message. Failure to converge can occur when th
function has singularities or “spikes” in the interval or when the interval is extrem
long. 

1RWH When you change the tolerance, keep in mind the trade-off between accuracy and computation 
time. If you decrease (tighten) the tolerance, Mathcad computes integrals more accurately, but 
takes longer to return a result. Conversely, if you increase (loosen) the tolerance, Mathcad 
computes more quickly, but the answers are less accurate.

Figure 9-9: Variable limits of integration. 
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&RQWRXU�,QWHJUDOV�
You can use Mathcad to evaluate complex contour integrals. To do so, first parametrize 
the contour and then integrate over the parameter. If the parameter is something other 
than arc length, you must also include the derivative of the parametrization as a 
correction factor (see Figure 9-10). Note that the imaginary unit i used in specifying 
the path must be typed as 1i. 

0XOWLSOH�LQWHJUDOV
You can also use Mathcad to evaluate double or multiple integrals. To set up a double 

integral, for example, click  on the Calculus toolbar twice. Fill in the integrand, 
the limits, and the integrating variable for each integral. Figure 9-11 shows an example.

Figure 9-10: A complex contour integral in Mathcad.

Figure 9-11: Double integrals.
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1RWH Multiple integrals generally take much longer to converge to an answer than single integrals. 
Wherever possible, use an equivalent single integral in place of a multiple integral.

&XVWRPL]LQJ�2SHUDWRUV�

This section describes how to define and use your own customized operators.

You can think of operators and functions as being fundamentally very similar. A 
function takes “arguments” and returns a result. An operator, likewise, takes “opera
and returns a result. The differences are largely notational: 

• Functions usually have names you can spell, like tan or spline; operators are 
generally math symbols like “+” or “×.”

• Arguments to a function are enclosed by parentheses, they come after the func
name, and they’re separated by commas. Operands, on the other hand, can 

elsewhere. For example, you’ll often see  but you’ll rarely see . 

Similarly, you’ll often find “ ” but you rarely find “ .”

'HILQLQJ�D�&XVWRP�2SHUDWRU
You define a custom operator just as if you were defining a function that happen
have an unusual looking name:

1. Type the operator name followed by a pair of parentheses. Enter the operand
at the most) between the parentheses.

2. Enter the definition symbol :=. 

3. Type an expression describing what you want the operator to do with its oper
on the other side of the definition symbol. 

7LS Mathcad provides a collection of math symbols to define custom operators. To access these 
symbols, open the QuickSheets from the Resource Center (choose Resource Center on the 
Help menu) and then click on “Extra Math Symbols.” You can drag any of these symbols to 
worksheet for use in creating a new operator name.

For example, suppose you want to define a new union operator using the symbol 

1. Drag the symbol into your worksheet from the “Extra Math 
Symbols” QuickSheet.

2. Type a left parenthesis followed by two names separated by a 
comma. Complete this argument list by typing a right parenthesis.

3. Press the colon (:) key, or click  on the Calculator toolbar. 
You see the definition symbol followed by a placeholder.

4. Type the function definition in the placeholder.

f x y,( ) x f y

x y+ + x y,( )
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At this point, you’ve defined a function which behaves in every way like the user
defined functions described in Chapter 8, “Calculating in Mathcad.” You could, if y

wanted to, type “ ” in your worksheet and see the result, a vector with t
elements 1 and 2, on the other side of the equal sign. 

7LS Once you’ve defined the new operator, click on “Personal QuickSheets” in the QuickShee
the Mathcad Resource Center. Then choose Annotate Book from the Book menu and drag or 
type the definition into the QuickSheet. Then choose Save Section from the Book menu. When 
you need to use this operator again, just open your Personal QuickSheet and drag it into
worksheet.

8VLQJ�D�&XVWRP�2SHUDWRU�
Once you’ve defined a new operator, you can use it in your calculations just as y
would use any of Mathcad’s built-in operators. The procedure for using a custom
operator depends on whether the operator has one operand (like “ ” or “5!”) or

(like “ ”).

To use an operator having two operands:

1. Define any variables you want to use as arguments.

2. Click  on the Evaluation toolbar. You’ll see three empty 
placeholders.

3. In the middle placeholder, insert the name of the operator. 
Alternatively, copy the name from the operator definition and paste it 
into the placeholder.

4. In the remaining two placeholders, enter the two operands.

5. Press =, or click  on the Evaluation toolbar, to get the 
result.

7LS An alternative way to display an operator having two operands is to click  on the Evaluation 
toolbar. If you follow the preceding steps using this operator, you’ll see a tree-shaped dis

 ∪ 1 2,( ) =

1–

1 2÷
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To insert an operator having only one operand, decide first whether you want the 

operator to appear before the operand, as in “ ,” or after the operand as in “5!.”
former is called a prefix operator; the latter is a postfix operator. The example below 
shows how to use a postfix operator. The steps for creating a prefix operator are a
identical.

The following example shows how to define and use a new logical Not 
operator. First define an operator “ ′(x)” . To do so, follow the steps for 
defining ∪(x, y) in the previous section, substituting the symbol “ ′ ” for 
“∪” and using only one argument instead of two. 

Then, to evaluate with the new operator:

1. Click  on the Evaluation toolbar to make a postfix operator. 

Otherwise, click . In either case, you see two empty placeholders.

2. If you clicked , put the operator name in the second placeholder. 
Otherwise put it in the first placeholder. In either case, you may find 
it more convenient to copy the name from the operator definition and paste it
the placeholder.

3. In the remaining placeholder, place the operand.

4. Press =, or click  on the Evaluation toolbar, to see the result.

7LS Just as Mathcad can display a custom operator as if it were a function, you can conversely 
display a function as if it were an operator. For example, many publishers prefer to omit 
parentheses around the arguments to certain functions such as trigonometric functions, i.e., sin 

x rather than . To create this notation, you can treat the sin function as an operator with 
one operand. 

1–

x( )sin
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&KDSWHU���
%XLOW�LQ�)XQFWLRQV

t ,QVHUWLQJ�%XLOW�LQ�)XQFWLRQV

t &RUH�0DWKHPDWLFDO�)XQFWLRQV

t 'LVFUHWH�7UDQVIRUP�)XQFWLRQV

t 9HFWRU�DQG�0DWUL[�)XQFWLRQV

t 6ROYLQJ�DQG�2SWLPL]DWLRQ�)XQFWLRQV

t 6WDWLVWLFV��3UREDELOLW\��DQG�'DWD�$QDO\VLV�)XQFWLRQV

t )LQDQFH�)XQFWLRQV

t 'LIIHUHQWLDO�(TXDWLRQ�)XQFWLRQV

t 0LVFHOODQHRXV�)XQFWLRQV

,QVHUWLQJ�%XLOW�LQ�)XQFWLRQV

Mathcad’s set of built-in functions can change depending on whether you’ve insta
additional Extension Packs or whether you’ve written your own built-in functions
These functions can come from the following sources:

%XLOW�LQ�0DWKFDG�IXQFWLRQV

This is the core set of functions that come with Mathcad. These functions are introd
in this chapter.

0DWKFDG�([WHQVLRQ�3DFNV

An Extension Pack consists of a collection of advanced functions geared to a part
area of application. Documentation for these functions comes with an Electronic B
accompanying the Extension Pack itself. The list of available Extension Packs curr
includes collections for signal processing, image processing, steam tables, num
analysis, solving and optimization, and wavelets. To find out more about these a
other Extension Packs, contact MathSoft or your local distributor, or visit MathSo
Web site at:

http://www.mathsoft.com/

After you purchase and install an Extension Pack, the additional functions appea
the Insert Function dialog box.
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%XLOW�LQ�IXQFWLRQV�\RX�ZULWH�\RXUVHOI�LQ�&�

If you have a supported 32-bit C/C++ compiler, you can write your own built-in 
functions for Mathcad. For details see the Adobe Acrobat file CREATING A USER 
DLL.PDF included on your installation CD.

,QVHUW�)XQFWLRQ�)HDWXUH
To see a list of built-in functions available with your copy of Mathcad, arranged 
alphabetically or by category, or to insert a function together with placeholders for its 
arguments, use the Insert Function dialog box:

1. Click in a blank area of your worksheet or on a placeholder. 

2. Choose Function from the 

Insert menu or click  on the 
Standard toolbar. Mathcad opens 
the Insert Function dialog box.

3. Click a Function Category or 
click “All” to see all available 
functions sorted alphabetically.

4. Double-click the name of the 
function you want to insert from the right-hand scrolling list, or click 
“Insert.” The function and placeholders for its arguments are inserted 
into the worksheet. 

5. Fill in the placeholders.

To apply a function to an expression you have already entered, place the expres
between the two editing lines and follow the steps given above. See Chapter 4, 
“Working with Math,” for information about using the editing lines. 

You can also simply type the name of a built-in function directly into a math placeho
or in a math region.

7LS Although built-in function names are not font sensitive, they are case sensitive. If you do not use 
the Insert Function dialog box to insert a function name, you must enter the name of a built-in 
function in a math region exactly as it appears in the tables throughout this chapter: uppercase, 
lowercase, or mixed, as indicated.

1RWH Throughout this chapter and in the Insert Function dialog box, brackets, [  ], around an argument 
indicate that the argument is optional.
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Mathcad includes several sources of assistance for using built-in functions:

• The Reference section of this Manual provides details on the syntax, arguments
algorithms, and behavior of all of Mathcad’s built-in functions, operators, and
keywords.

• The Insert Function dialog box gives you a convenient way to look up a funct
by category, to see the arguments required, and to see a brief function synop
When you click “Help” in the Insert Function dialog box, you immediately ope
the Help topic associated with the currently selected function.

• The online Help system (choose Mathcad Help from the Help menu, or click  
on the Standard toolbar) provides both overview and detailed help topics on 
functions and function categories.

• The Resource Center (choose Resource Center from the Help menu, or click  
on the Standard toolbar) includes a range of Mathcad files to help you use bu
functions to solve problems including Tutorials and QuickSheet examples.

&RUH�0DWKHPDWLFDO�)XQFWLRQV

7ULJRQRPHWULF�)XQFWLRQV

angle(x, y) Returns the angle (in radians) from the positive x-axis to point (x, y) in the 
x-y plane. The result is between 0 and 2π.

cos(z) Returns the cosine of z. In a right triangle, this is the ratio of the length o
the side adjacent to the angle over the length of the hypotenuse.

cot(z) Returns , the cotangent of z. z should not be a multiple of .

csc(z) Returns , the cosecant of z. z should not be a multiple of .

sec(z) Returns , the secant of z. z should not be an odd multiple of 

sin(z) Returns the sine of z. In a right triangle, this is the ratio of the length of th
side opposite the angle over the length of the hypotenuse.

tan(z) Returns , the tangent of z. In a right triangle, this is the ratio
of the length of the side opposite the angle over the length of the side 
adjacent to the angle. z should not be an odd multiple of .

1 z( )tan⁄ π

1 z( )sin⁄ π

1 z( )cos⁄ π 2⁄

z( )sin z( )cos⁄

π 2⁄
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Mathcad’s trig functions and their inverses accept any scalar argument: real, com
or imaginary. They also return complex numbers wherever appropriate. 

1RWH Trigonometric functions expect their arguments in radians. To pass an argument in degrees, use 
the built-in unit deg. For example, to evaluate the sine of 45 degrees, type sin(45*deg). 

7LS In Mathcad you enter powers of trig functions such  as . Alternatively, you can 
use the prefix operator described in “Customizing Operators” on page 146. For example, to

. Click  on the Evaluation toolbar, enter sin2 in the left-hand placeholder, enter

(x) in the right-hand placeholder.

,QYHUVH�7ULJRQRPHWULF�)XQFWLRQV

With the exception of atan2 and acot, the inverse trigonometric functions can take 
either a real or complex argument and return an angle in radians between  and 

, or the principal value in the case of a complex argument. atan2 takes only real 
arguments and returns a result between  and , acot returns an angle in radians 
between 0 and  for a real argument or the principal value in the case of a complex 
argument.

To convert a result into degrees, either divide the result by the built-in unit deg or type 
deg in the units placeholder as described in “Displaying Units of Results” on page

acos(z) Returns the angle (in radians) whose cosine is z.

acot(z) Returns the angle (in radians) whose cotangent is z.

acsc(z) Returns the angle (in radians) whose cosecant is z.

asec(z) Returns the angle (in radians) whose secant is z.

asin(z) Returns the angle (in radians) whose sine is z.

atan(z) Returns the angle (in radians) whose tangent is z.

atan2(x, y) Returns the angle (in radians) from the positive x-axis to point (x, y) in 
the x-y plane.

sin2 x( ) sin x( )2

sin2 x( )

π 2⁄–
π 2⁄

π– π
π
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Mathcad’s exponential and logarithmic functions can accept and return complex
arguments. ln returns the principal branch of the natural log function.

%HVVHO�)XQFWLRQV�

acosh(z) Returns the number whose hyperbolic cosine is z.

acoth(z) Returns the number whose hyperbolic cotangent is z.

acsch(z) Returns the number whose hyperbolic cosecant is z.

asech(z) Returns the number whose hyperbolic secant is z.

asinh(z) Returns the number whose hyperbolic sine is z.

atanh(z) Returns the number whose hyperbolic tangent is z.

cosh(z) Returns the hyperbolic cosine of z.

coth(z) Returns , the hyperbolic cotangent of z.

csch(z) Returns , the hyperbolic cosecant of z.

sech(z) Returns , the hyperbolic secant of z.

sinh(z) Returns the hyperbolic sine of z.

tanh(z) Returns , the hyperbolic tangent of z.

exp(z) Returns e raised to the power z.

ln(z) Returns the natural log of z. ( ).

log(z, b) Returns the base b logarithm of z. ( , ). If b is omitted, returns 
the base 10 logarithm.

Returns the value of the Airy function of the first kind. x must be real.

Returns the value of the imaginary Bessel Kelvin function of order n.

Returns the value of the real Bessel Kelvin function of order n.

Returns the value of the Airy function of the second kind. x must be real.

Returns the value of the zeroth order modified Bessel function of the 
kind. x must be real.

Returns the value of the first order modified Bessel function of the fi
kind. x must be real.

1 z( )tanh⁄

1 z( )sinh⁄

1 z( )cosh⁄

z( )sinh z( )cosh⁄

z 0≠

z 0≠ b 0≠

Ai x( )

bei n x,( )

ber n x,( )

Bi x( )

I0 x( )

I1 x( )
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Returns the value of the mth order modified Bessel function of the first 
kind. x must be real, m is an integer,  .

Returns the value of the zeroth order Bessel function of the first kind. x 
must be real.

Returns the value of the first order Bessel function of the first kind. x 
must be real.

Returns the value of the mth order Bessel function of the first kind. x real, 
.

Returns the value of the spherical Bessel function of the first kind, of 
integer order n. , .

Returns the value of the zeroth order modified Bessel function of the 
second kind. x real, .

Returns the value of the first order modified Bessel function of the 
second kind. x real, .

Returns the value of the mth order modified Bessel function of the 
second kind. , m is an integer, .

Returns the value of the zeroth order Bessel function of the second kind. 
x real, .

Returns the value of the first order Bessel function of the second kind. x 
real, .

Returns the value of the mth order Bessel function of the second kind. 
, m is an integer, .

Returns the value of the spherical Bessel function of the second kind, of 
integer order n. x must be real.  , .

arg(z) Returns the angle in complex plane from real axis to z. The result is 
between −π and π radians.

csgn(z) Returns 0 if , 1 if  or (  and ), 
−1 otherwise.

Im(z) Returns the imaginary part of a number z. 

Re(z) Returns the real part of a number z. 

signum(z) Returns 1 if ,  otherwise.

In m x,( )
0 m 100≤ ≤

J0 x( )

J1 x( )

Jn m x,( )
0 m 100≤ ≤

js n x,( )
x 0> n 200–≥

K0 x( )
x 0>

K1 x( )
x 0>

Kn m x,( )
x 0> 0 m 100≤ ≤

Y0 x( )
x 0>

Y1 x( )
x 0>

Yn m x,( )
x 0> 0 m 100≤ ≤

ys n x,( )
x 0> n 200–≥

z 0= Re z( ) 0> Re z( ) 0= Im z( ) 0>

z 0= z z⁄
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1RWH The if function is useful for branching in calculation: choosing one of two values based on a 
condition. Although the first argument of the if function, cond, can be any expression at all, it is 
usually a Boolean expression that relates two math expressions with a Boolean operator. See 
“Arithmetic and Boolean Operators” on page 131.   

1XPEHU�7KHRU\�&RPELQDWRULFV

if(cond, tvl, fvl) Returns tvl if cond is nonzero (true), fvl if cond is zero (false). cond 
is usually a Boolean expression.

δ(m, n) Kronecker’s delta function. Returns 1 if , 0 otherwise. Bot
arguments must be integers.

ε(i, j, k) Completely antisymmetric tensor of rank 3. i, j, and k must be 
integers between 0 and 2 inclusive (or between ORIGIN and
ORIGIN + 2 inclusive if ORIGIN≠0). Result is 0 if any two are the 
same, 1 for even permutations,  for odd permutations.

Φ(x) Heaviside step function. Returns 1 if , 0 otherwise. x must be 
real.

sign(x) Returns 0 if , 1 if , and  otherwise. x must be real.

combin(n, k) Returns the number of combinations: the number of subsets of 
k that can be formed from n objects. n and k integers, .

gcd(A, B, C, ...) Returns the greatest common divisor: the largest integer that ev
divides all the elements in arrays or scalars A, B, C, ... The elements 
of A, B, C, ... must be non-negative integers.

lcm(A, B, C, ...) Returns the least common multiple: the smallest positive integer 
is a multiple of all the elements in the arrays or scalars A, B, C, ... 
The elements of A, B, C, ... must be non-negative integers.

mod(x, y) Remainder on dividing real number x by y ( ). Result has same 
sign as x.

permut(n, k) Returns the number of permutations: the number of ways of orde
n distinct objects taken k at a time. n and k integers, .

m n=

1–

x 0≥

x 0= x 0> 1–

0 k n≤ ≤

y 0≠

0 k n≤ ≤
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6SHFLDO�)XQFWLRQV

ceil(x) Least integer ≥ x (x real).

floor(x) Greatest integer ≤ x (x real). 

round(x, n) Rounds real number x to n decimal places. If , x is rounded to 
the left of the decimal point. If n is omitted, returns x rounded to the 
nearest integer.

trunc(x) Returns the integer part of a real number x by removing the fractional 
part.

erf(x) Returns the value of the error function at x. x must be real.

erfc(x) Returns the value of the complementary error function at x: 
. x real.

fhyper(a, b, c, x) Returns the value of the Gauss hypergeometric function at the point 
x given parameters a, b, c. .

Γ(z) Returns the value of the classical Euler gamma function at z, a real 
or complex number. Undefined for 

Γ(x, y) Returns the value of the extended Euler gamma function for real 
numbers , .

Her(n, x) Returns the value of the Hermite polynomial of degree n at x.

ibeta(a, x, y) Returns the value of the incomplete beta function of x and y with 
parameter a. 

Jac(n, a, b, x) Returns the value of the Jacobi polynomial of degree n at x with 
parameters a and b.

Lag(n, x) Returns the value of the Laguerre polynomial of degree n at x.

Leg(n, x) Returns the value of the Legendre polynomial of degree n at x.

mhyper(a, b, x) Returns the value of the confluent hypergeometric function at the 
point x given parameters a and b.

Tcheb(n, x) Returns the value of the Chebyshev polynomial of degree n, of the 
first kind, at x.

Ucheb(n, x) Returns the value of the Chebyshev polynomial of degree n, of the 
second kind, at x.

n 0<

1 erf x( )–

1– x 1< <

z 0 1– 2– …, , ,=

x 0> y 0≥

0 a 1≤ ≤
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Mathcad contains a variety of functions for performing discrete transforms. All of these 
functions require vectors as arguments. 

1RWH When you define a vector v for use with Fourier or wavelet transforms, Mathcad indexes the 
vector beginning at 0, by default, unless you have set the value of the built-in variable ORIGIN 
to a value other than 0 (see page 102). If you do not define , Mathcad automatically sets it to 
zero. This can distort the results of the transform functions.

)RXULHU�7UDQVIRUPV�RQ�5HDO�DQG�&RPSOH[�'DWD

cfft(A) Returns the fast Fourier transform of a vector or matrix of complex data 
representing equally spaced measurements in the time domain. The array 
returned is the same size as its argument.

icfft(A) Returns the inverse Fourier transform of a vector or matrix of data 
corresponding to cfft. Returns an array of the same size as its argument.

fft(v) Returns the fast discrete Fourier transform of a  element vector of real 
data representing measurements at regular intervals in the time domain. 

.

ifft(v) Returns the inverse Fourier transform of a vector of data corresponding to 

fft. Takes a vector of size , and returns a real vector of size . 

.

CFFT(A) Returns a transform identical to cfft, except using a different normalizing 
factor and sign convention.

ICFFT(A) Returns the inverse Fourier transform of a vector or matrix of data 
corresponding to CFFT. Returns an array of the same size as its argument.

FFT(v) Returns a transform identical to fft, except using a different normalizing 
factor and sign convention.

IFFT(v) Returns the inverse Fourier transform of a vector of data corresponding to 
FFT. Takes a vector of size , and returns a real vector of size .

v0

2m

m 2>

1 2n 1–+ 2n

n 2>

1 2n 1–+ 2n
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Mathcad comes with two types of Fourier transform pairs: fft / ifft (or the alternative 
FFT / IFFT) and cfft / icfft (or the alternative CFFT / ICFFT). These functions are discrete: 
they apply to and return vectors and matrices only. You cannot use them with other 
functions. 

Use the fft and ifft (or FFT / IFFT) functions if:

• the data values in the time domain are real, and

• the data vector has  elements.

Use the cfft and icfft (or CFFT / ICFFT) functions in all other cases.

Be sure to use these functions in pairs. For example, if you used CFFT to go from the 
time domain to the frequency domain, you must use ICFFT to transform back to the 
time domain. See Figure 10-1 for an example.

1RWH Different sources use different conventions concerning the initial factor of the Fourier transform 
and whether to conjugate the results of either the transform or the inverse transform. The 
functions fft, ifft, cfft, and icfft use  as a normalizing factor and a positive exponent in 
going from the time to the frequency domain. The functions FFT, IFFT, CFFT, and ICFFT 
use  as a normalizing factor and a negative exponent in going from the time to the 
frequency domain. 

Figure 10-1: Use of fast Fourier transforms in Mathcad. Since the random 
number generator gives different numbers every time, you may not be able to 
recreate this example exactly as you see it.

2m

1 N⁄

1 N⁄
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Note that functions that expect vectors always expect column vectors rather than row 
vectors. To change a row vector into a column vector, use the transpose operator (click 

 on the Matrix toolbar).

6L]H�DQG�6FRSH�RI�DQ�$UUD\

6SHFLDO�7\SHV�RI�0DWULFHV

wave(v) Returns the discrete wavelet transform of v, a  element vector 
containing real data, using the Daubechies four-coefficient wavelet filter. 
The vector returned is the same size as v.

iwave(v) Returns the inverse discrete wavelet transform of v, a  element vector 
containing real data. The vector returned is the same size as v.

cols(A) Returns the number of columns in array A. If A is a scalar, returns 0.

last(v) Returns the index of the last element in vector v. 

length(v) Returns the number of elements in vector v. 

max(A, B, C, ...) Returns the largest of the strings, arrays, or scalars A, B, C, ... If any 
value is complex, returns the largest real part plus i times the largest 
imaginary part.

min(A, B, C, ...) Returns the smallest of the strings, arrays, or scalars A, B, C, ... If 
any value is complex, returns the smallest real part plus i times the 
smallest imaginary part.

rows(A) Returns the number of rows in array A. If A is a scalar, returns 0.

diag(v) Returns a diagonal matrix containing on its diagonal the elements
of v. 

geninv(A) Returns the left inverse matrix L of A, such that , where 
I is the identity matrix having the same number of columns as A. 
Matrix A is an  real-valued matrix, where .

identity(n) Returns an  matrix of 0’s with 1’s on the diagonal.

rref(A) Returns the reduced-row echelon form of A. 

2m

2m

L A⋅ I=

m n× m n≥

n n×
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Figure 10-2: Functions for transforming arrays.

cond1(M) Returns the condition number of the matrix M based on the  norm.

cond2(M) Returns the condition number of the matrix M based on the  norm.

conde(M) Returns the condition number of the matrix M based on the Euclidean 
norm.

condi(M) Returns the condition number of the matrix M based on the infinity 
norm.

norm1(M) Returns the  norm of the matrix M.

norm2(M) Returns the  norm of the matrix M.

norme(M) Returns the Euclidean norm of the matrix M.

normi(M) Returns the infinity norm of the matrix M.

rank(A) Returns the rank of the real-valued matrix A.

tr(M) Returns the sum of the diagonal elements, known as the trace, of M. 

L1

L2

L1

L2
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1RWH For the functions CreateMesh and CreateSpace, instead of using a vector-valued function, F, 
you can use three functions, f1, f2, and f3, representing the x-, y-, and z-coordinates of the 
parametric surface or space curve. Your call to one of these functions might look something like 

this: .
Alternatively, for CreateMesh, you can use a single function of two variables such as 

.

augment(A, B, C, ...) Returns an array formed by placing A, B, C, ... left 
to right. A, B, C, ... are arrays having the same 
number of rows or they are scalars and single-row 
arrays.

CreateMesh(F, [[s0], 
[s1], [t0], [t1], [sgrid], 
[tgrid], [fmap]])

Returns a nested array of three matrices 
representing the x-, y-, and z-coordinates of a 
parametric surface defined by the function, F. F is 
a three-element vector-valued function of two 
variables. s0, s1, t0, and t1 are the variable limits, 
and sgrid and tgrid are the number of gridpoints. 
All must be real scalars. fmap is a three-element 
vector-valued mapping function. All arguments 
but the function argument are optional.

CreateSpace(F,[[t0], [t1], 
[tgrid], [fmap]])

Returns a nested array of three vectors 
representing the x-, y-, and z-coordinates of a space 
curve defined by the function, F. F is a three-
element vector-valued function of one variable. t0 
and t1 are the variable limits, and tgrid is the 
number of gridpoints. All must be real scalars. 
fmap is a three-element vector-valued mapping 
function. All arguments but the function argument 
are optional.

matrix(m, n, f) Creates a matrix in which the i,jth element 
contains  where  and 

. Function f must have been 
defined previously in the worksheet.

stack(A, B, C, ...) Returns an array formed by placing A, B, C, ... top 
to bottom. A, B, C, ... are arrays having the same 
number of columns or they are scalars and vectors.

submatrix(A, ir, jr, ic, jc) Returns a submatrix of A consisting of all 
elements contained in rows ir through jr and 
columns ic through jc. Make sure  and 

 or the order of rows or columns will be 
reversed.

f i j,( ) i 0 1 … m 1–, , ,=

j 0 1 … n 1–, , ,=

ir jr≤
ic jc≤

CreateMesh f1 f2 f3, ,( )

F x y,( ) x( )sin y( )cos+
2

--------------------------------------=
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Figure 10-3 shows examples of using stack and augment.

0DSSLQJ�)XQFWLRQV

7LS Use any of the 3D mapping functions as the fmap argument for the CreateSpace and CreateMesh 
functions.

Figure 10-3: Joining matrices with the augment and stack functions.

cyl2xyz(r, θ, z) Converts the cylindrical coordinates of a point in 3D space, 
represented by r, θ, and z, to rectangular coordinates. r, θ, and z 
must be real numbers.

pol2xy(r, θ) Converts the polar coordinates of a point in 2D space, 
represented by r and θ, to rectangular coordinates. r and θ must 
be real numbers.

sph2xyz(r, θ, φ) Converts the spherical coordinates of a point in 3D space, 
represented by r, θ, and φ, to rectangular coordinates. r, θ, and φ 
must be real numbers.

xy2pol(x, y) Converts the rectangular coordinates of a point in 2D space, 
represented by x and y, to polar coordinates. x and y must be real 
numbers.

xyz2cyl(x, y, z) Converts the rectangular coordinates of a point in 3D space, 
represented by x, y, and z, to cylindrical coordinates. x, y, and z 
must be real numbers.

xyz2sph(x, y, z) Converts the rectangular coordinates of a point in 3D space, 
represented by x, y, and z, to spherical coordinates. x, y, and z 
must be real numbers.
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lookup(z, A, B) Looks in a vector or matrix, A, for a given value, z, and returns the 
value(s) in the same position(s) (i.e. with the same row and column 
numbers) in another matrix, B. z may be a real or complex number 
or a string. A and B must have the same dimensions and contain 
real, complex, or string values.

hlookup(z, A, r) Looks in the first row of a given matrix, A, for a given value, z, and 
returns the value(s) in the same column(s) in the row specified, r. 
z may be a real or complex number or a string. A must contain real, 
complex, or string values. r must be an integer.

vlookup(z, A, r) Looks in the first column of a given matrix, A, for a given value, 
z, and returns the value(s) in the same row(s) in the column 
specified, r. z may be a real or complex number or a string. A must 
contain real, complex, or string values. r must be an integer.

match(z, A) Looks in a vector or matrix, A, for a given value, z, and returns the 
index (indices) of its positions in A. z may be a real or complex 
number or a string. A must contain real, complex, or string values.

eigenvals(M) Returns a vector containing the eigenvalues of the square matrix M.

eigenvec(M, z) Returns a vector containing the normalized eigenvector 
corresponding to the eigenvalue z of the square matrix M.

eigenvecs(M) Returns a matrix containing normalized eigenvectors corresponding 
to the eigenvalues of the square matrix M. The nth column of the 
matrix returned is an eigenvector corresponding to the nth 
eigenvalue returned by eigenvals.

genvals(M, N) Returns a vector v of computed eigenvalues each of which satisfies 
the generalized eigenvalue problem . Vector x is 
the corresponding eigenvector. M and N are real square matrices 
having the same number of columns. 

genvecs(M, N) Returns a matrix containing the normalized eigenvectors 
corresponding to the eigenvalues in v, the vector returned by 
genvals. The nth column of this matrix is the eigenvector x 
satisfying the generalized eigenvalue problem . 

Matrices M and N are real-valued square matrices having the same 
number of columns. 

M x⋅ vi N x⋅ ⋅=

M x⋅ vn N x⋅ ⋅=
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 Figure 10-4 shows how some of these functions are used.

6ROYLQJ�D�/LQHDU�6\VWHP�RI�(TXDWLRQV

Use the lsolve function to solve a linear system of equations whose coefficients are 
arranged in a matrix M.

1RWH The argument M for lsolve must be a matrix that is neither singular nor nearly singular. An 
alternative to lsolve is to solve a linear system by using matrix inversion. See “Solving and 
Optimization Functions” on page 166 for additional solving functions.

Figure 10-4: Eigenvalues and eigenvectors in Mathcad.

lsolve(M, v) Returns a solution vector x such that . v is a vector having the 
same number of rows as the matrix M.

M x⋅ v=
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7LS Unless you change the value of ORIGIN, matrices are numbered by default starting with row 
zero and column zero. To sort on the first column of a matrix, for example, use csort(A, 0). 

cholesky(M) Returns a lower triangular matrix L such that . This uses 
only the upper triangular part of M. The upper triangular of M, when 
reflected about the diagonal, must form a positive definite matrix.

lu(M) Returns a single matrix containing the three square matrices P, L, and 
U, all having the same size as M and joined together side by side, in 
that order. These three matrices satisfy the equation , 
where L and U are lower and upper triangular respectively.

qr(A) Returns a matrix whose first n columns contain the square, 
orthonormal matrix Q, and whose remaining columns contain the 
upper triangular matrix, R. Matrices Q and R satisfy the equation 

, where A is a real-valued array.

svd(A) Returns a single matrix containing two stacked matrices U and V, 
where U is the upper  submatrix and V is the lower  
submatrix. Matrices U and V satisfy the equation 

, where s is a vector returned by svds(A). 

A is an  array of real values, where .

svds(A) Returns a vector containing the singular values of the  real-

valued array A, where .

csort(A, n) Returns an array formed by rearranging rows of the matrix A such that 
the elements in column n are in ascending order. The result has the 
same size as A.

reverse(A) Returns an array in which the elements of a vector, or the rows of a 
matrix, are in reverse order.

rsort(A, n) Returns an array formed by rearranging the columns of the matrix A 
such that the elements in row n are in ascending order. The result has 
the same size as A.

sort(v) Returns the elements of the vector v sorted in ascending order.

L LT⋅ M=

P M⋅ L U⋅=

A Q R⋅=

m n× n n×

A U diag s( ) VT⋅ ⋅=

m n× m n≥

m n×
m n≥
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This section describes how to solve equations ranging from a single equation in one 
unknown to large systems with multiple unknowns. The techniques described here 
generate numeric solutions. Chapter 14, “Symbolic Calculation,” describes a var
of techniques for solving equations symbolically.

)LQGLQJ�5RRWV�

1RWH When you specify the arguments a and b for the root function, Mathcad will only find a root for 
the function f if f(a) is positive and f(b) is negative or vice versa.

The root function solves a single equation in a single unknown. This function take
arbitrary expression or function and one of the variables from the expression. root can 
also take a range in which the solution lies. It then varies that variable until the 
expression is equal to zero and lies in the specified range. Once this is done, the fu
returns the value that makes the expression equal zero and lies in the specified 

7LS root makes successive estimates of the value of the root and returns a value when the two most 
recent estimates differ by less than the value of the tolerance parameter, TOL. As described in 
“Built-in Variables” on page 102, you can change the value of the tolerance, and hence th
accuracy of the solution, by including definitions for TOL directly in your worksheet. You c
also change the tolerance by using the Built-in Variables tab when you choose Options from the 
Math menu. 

To find the roots of a polynomial or an expression having the form:

you can use polyroots rather than root. polyroots does not require a guess value, and 
polyroots returns all roots at once, whether real or complex. Figure 10-5 shows 
examples.

polyroots(v) Returns the roots of an nth degree polynomial whose coefficients 
are in v, a vector of length . Returns a vector of length n.

root( f(z), z) Returns the value of z which the expression f(z) is equal to 0. The 
arguments are a real- or complex-valued expression f(z) and a real 
or complex scalar, z. Must be preceded in the worksheet by a guess 
value for z. Returns a scalar.

root( f(z), z, a, b) Returns the value of z lying between a and b at which the expression 
f(z) is equal to 0. The arguments to this function are a real-valued 
expression f(z), a real scalar, z, and real endpoints a<b. No guess 
value for z is required. Returns a scalar.

n 1+

vnxn … v2x2 v1x v0+ + + +
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r to 
Figure 10-5: Finding roots with root and polyroots.

By default, polyroots uses a LaGuerre method of finding roots. If you want to use the 
companion matrix method instead, click on the polyroots function with the right mouse 
button and choose Companion Matrix from the pop-up menu.

1RWH root and polyroots can solve only one equation in one unknown, and they always return 
numerical answers. To solve several equations simultaneously, use the techniques described in 
“Linear/Nonlinear System Solving and Optimization.” To solve an equation symbolically, o
find an exact numerical answer in terms of elementary functions, choose Solve for Variable 
from the Symbolic menu or use the solve keyword. See Chapter 14, “Symbolic Calculation.”

/LQHDU�1RQOLQHDU�6\VWHP�6ROYLQJ�DQG�2SWLPL]DWLRQ����
Mathcad includes numerical solving functions that solve problems such as:

• Linear systems of equations with constraints (equalities or inequalities).

• Nonlinear systems of equations with constraints.

• Optimization (maximization or minimization) of an objective function.

• Optimization (maximization or minimization) of an objective function with
constraints.
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• Linear programming, in which all constraints are either equalities or inequalit
that compare linear functions to constants and the objective function is of the f

• Quadratic programming, in which all constraints are linear but the objective 
function contains linear terms and quadratic terms. Quadratic programming fea
are available in the Solving and Optimization Extension Pack (Expert Solver), 
available for separate sale from MathSoft or your local distributor or reseller.

1RWH Mathcad solves nonlinear systems of up to 200 variables and linear systems of up to 500 
variables. With the Solving and Optimization Extension Pack (Expert Solver), you can solve 
nonlinear systems of up to 250 variables, linear systems of up to 1000 variables, and quadratic 
systems of up to 1000 variables.

6ROYH�%ORFNV

The general form for using system solving functions in Mathcad is within the bod
a solve block. There are four general steps to creating a solve block. These are:

1. Provide an initial guess (definition) for each of the unknowns you intend to so
for. Mathcad solves equations by making iterative calculations that ultimately
converge on a valid solution. The initial guesses you provide give Mathcad a p
to start searching for solutions. Guess values are usually required for all syst

2. Type the word Given in a separate math region below the guess definitions. Th
tells Mathcad that what follows is a system of constraint equations. Be sure y
don’t type “Given” in a text region. 

3. Now enter the constraints (equalities and inequalities) in any order below the 

Given. Make sure you use the bold equal symbol (click  on the Boolean toolbar 
or press [Ctrl]=) for any equality. You can separate the left and right sides of
inequality with any of the symbols <, >, ≤, and ≥.  

4. Enter any equation that involves one of the functions Find, Maximize, Minimize, or 
Minerr below the constraints.

1RWH Solve blocks cannot be nested inside each other—each solve block can have only one Given and 
one Find (or Maximize, Minimize, or Minerr). You can, however, define a function like 

 at the end of one solve block and refer to this function in another solve blo

c0x0 c1x1 … cnxn+ + +

f x( ) Find x( ):=
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7LS Unlike most Mathcad functions, the solving functions Find, Maximize, Minerr, and Minimize 
can be entered in math regions with either an initial lowercase or an initial capital letter.

Figure 10-6 shows a solve block with several kinds of constraints and ending with a 
call to the Find function. There are two unknowns. As a result, the Find function here 
takes two arguments, x and y, and returns a vector with two elements.

&RQVWUDLQWV

The table below lists the kinds of constraints that can appear in a solve block between 
the keyword Given and one of the functions Find, Maximize, Minerr, and Minimize. In 
the table, x and y represent real-valued expressions, and z and w represent arbitrary 
expressions. The Boolean constraints are inserted using buttons on the Boolean toolbar. 
Constraints are often scalar expressions but can also be vector or array expressions.     

Find(z0, z1, . . .) Returns values of z0, z1, . . . that satisfy the constraints in a 
solve block. z0, z1, . . . are real or complex scalars, vectors, 
arrays, or individual elements of vectors equal in number to the 
number of unknowns in the system. Returns a scalar for a 
single unknown; otherwise returns a vector of solutions.  

Maximize(f, z0, z1,  . . .) Returns values of z0, z1, . . . that make the function f take on 
its largest value. z0, z1, . . . are real or complex scalars, vectors, 
arrays, or individual elements of vectors equal in number to the 
number of unknowns in the system. Returns a scalar for a 
single unknown; otherwise returns a vector of solutions. Solve 
block constraints are optional.

Minerr(z0, z1,  . ..) Returns values of z0, z1, . . . that come closest to satisfying the 
constraints in a solve block. z0, z1, . . . are real or complex 
scalars, vectors, arrays, or individual elements of vectors equal 
in number to the number of unknowns in the system. Returns a 
scalar for a single unknown; otherwise returns a vector of 
solutions.

Minimize(f, z0, z1,  . . .) Returns values of z0, z1, . . . that make the function f take on 
its smallest value. z0, z1, . . . are real or complex scalars, 
vectors, arrays, or individual elements of vectors equal in 
number to the number of unknowns in the system. Returns a 
scalar for a single unknown; otherwise returns a vector of 
solutions. Solve block constraints are optional.
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Mathcad does not allow the following inside a solve block:

• Constraints with “≠.” 
• Assignment statements (statements like x:=1).

You can, however, include compound statements such as .

1RWH Mathcad returns only one solution for a solve block. There may, however, be multiple solutions 
to a set of equations. To find a different solution, try different guess values or enter an additional 
inequality constraint that the current solution does not satisfy.   

Figure 10-6: A solve block with both equalities and inequalities.

Constrained to be equal.

Greater than. 

Less than.

Greater than or equal to. 

Less than or equal to. 

And

Or

Xor (Exclusive Or)

Not

w z=

x y>

x y<

x y≥

x y≤

x y∧

x y∨

x y⊗

x¬

1 x 3≤ ≤
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Mathcad’s numerical solvers make use of two tolerance parameters in calculatin
solutions in solve blocks:

• Convergence tolerance. The solvers calculate successive estimates of the val
of the solutions and return values when the two most recent estimates differ by
than the value of the built-in variable TOL. A smaller value of TOL often results in 
a more accurate solution, but the solution may take longer to calculate.

• Constraint tolerance. This parameter, determined by the value of the built-in 
variable CTOL, controls how closely a constraint must be met for a solution to
acceptable. For example, if the constraint tolerance were 0.0001, a constraint
as  would be considered satisfied if, in fact, the value of x satisfied .

Procedures for modifying the values of these tolerances are described in “Built-i
Variables” on page 102.

7LS If you use Minerr in a solve block, you should always include additional checks on the 
reasonableness of the results. The built-in variable ERR returns the size of the error vector for 
the approximate solution returned by Minerr. There is no built-in variable for determining the 
size of the error for individual solutions to the unknowns. 

6ROYLQJ�DOJRULWKPV�DQG�$XWR6HOHFW

When you solve an equation, by default Mathcad uses an AutoSelect procedure to 
choose an appropriate solving algorithm. You can override Mathcad’s choice of 
algorithm and select another available algorithm yourself.

Here are the available solving methods:

/LQHDU

Applies a linear programming algorithm to the problem. Guess values for the unkno
are not required.

1RQOLQHDU

Applies either a conjugate gradient, Levenberg-Marquardt, or quasi-Newton solv
routine to the problem. Guess values for all unknowns must precede the solve b
Choose Nonlinear⇒Advanced Options from the pop-up menu to control settings fo
the conjugate gradient and quasi-Newton solvers.

1RWH The Levenberg-Marquardt method is not available for the Maximize and Minimize functions.

x 2< x 2.0001<
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Applies a quadratic programming algorithm to the problem. This option is available 
only if the Solving and Optimization Extension Pack (Expert Solver) is installed. Guess 
values for the unknowns are not required.

You can override Mathcad’s default choice of solving algorithm as follows:

1. Create and evaluate a solve block, allowing 
Mathcad to AutoSelect an algorithm.

2. Click with the right mouse button on the 
name of the function that terminates the 
solve block, and remove the check from 
AutoSelect on the pop-up menu. 

3. Check one of the available solving methods 
on the pop-up menu. Mathcad recalculates 
the solution using the method you selected.

5HSRUWV

If you have the Solving and Optimization Extension Pack (Expert Solver) installed, you 
can generate reports for a linear optimization problems. To generate a report, cli
a solving function with the right mouse button and choose Report from the pop-up 
menu. For more information on reports, refer to the online Help.

0L[HG�LQWHJHU�SURJUDPPLQJ�

If you have Solving and Optimization Extension Pack (Expert Solver) installed, you 
can perform mixed integer programming. Using mixed integer programming you
force the solution for an unknown variable to be a binary number (1 or 0) or an inte
For more information mixed integer programming, refer to the online Help.
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6WDWLVWLFV�

7LS If you are interested in graphing the result of a frequency analysis in a 2D bar plot showing the 
distribution of data across the bins, use the function histogram rather than hist, and plot the first 
column of the result against the second column of the result.

corr(A, B) Returns the Pearson’s r correlation coefficient for the  
arrays A and B.

cvar(A, B) Returns the covariance of the elements in  arrays A and B.

gmean(A, B, C, ...) Returns the geometric mean of the elements of the arrays or
scalars A, B, C, ... All elements must be real and greater than 0

hist(int, A) Returns a vector representing the frequencies with which valu
in A fall in the intervals represented by int. When int is a vector 
of intervals in ascending order, the ith element of the returned 
vector is the number of points in data falling between the ith and 
(i+1)th element of int. When int is an integer, it represents the 
number of subintervals of equal length. Both int and A must be 
real.

histogram(int, A) Returns a matrix with two columns. When int is an integer, the 
first column contains the midpoints of int subintervals of the 
range  of equal length and the second

column is identical to hist(int, A). When int is a vector of 
intervals in ascending order, the first column contains midpoin
of the intervals represented by the int vector. Both int and A must 
be real.

hmean(A, B, C, ...) Returns the harmonic mean of the elements of the arrays or 
scalars A, B, C, ... All elements must be nonzero

kurt(A, B, C, ...) Returns the kurtosis of the elements of the arrays or scalars A, B, 
C, ...

mean(A, B, C, ...) Returns the arithmetic mean of the elements of the arrays or 
scalars A, B, C, ...

median(A, B, C, ...) Returns the median of the elements of the arrays or scalars A, B, 
C, ... the value above and below which there are an equal num
of values. If there are an even number of elements, this is the
arithmetic mean of the two central values.

mode(A, B, C, ...) Returns the element from the arrays or scalars A, B, C, ... that 
occurs most often.

m n×

m n×

min A( ) value max A( )≤ ≤
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Mathcad includes functions for working with several common probability densities. 
These functions fall into four classes:

• Probability densities. These functions, beginning with the letter “d,” give the 
likelihood that a random variable will take on a particular value. 

• Cumulative probability distributions. These functions, beginning with the lette
“p,” give the probability that a random variable will take on a value less than or 
equal to a specified value. These are obtained by simply integrating (or summ
when appropriate) the corresponding probability density from  to a specifi
value. 

• Inverse cumulative probability distributions. These functions, beginning with 
the letter “q,” take a probability p between 0 and 1 as an argument and return a
value such that the probability that a random variable will be less than or equal to 
that value is p.

• Random number generators. These functions, beginning with the letter “r,” retur
a vector of m elements drawn from the corresponding probability distribution. Ea
time you recalculate an equation containing one of these functions, Mathcad
generates new random numbers. 

7LS Mathcad’s random number generators have a “seed value” associated with them. A given
value always generates the same sequence of random numbers, and choosing Calculate from the 
Math menu advances Mathcad along this random number sequence. Changing the seed
however, advances Mathcad along a different random number sequence. To change the
value, choose Options from the Math menu and enter a value on the Built-in Variables tab. 

1RWH See comments above about the nomenclature, arguments, and returned values for the pro
distribution functions in the following table.

skew(A, B, C, ...) Returns the skewness of the elements of the arrays or scalars A, 
B, C, ...

stdev(A, B, C, ...) Returns the population standard deviation (square root of the 
variance) of the elements of the arrays or scalars A, B, C, ... 

Stdev(A, B, C, ...) Returns the sample standard deviation (square root of the sample 
variance) of the elements of the arrays or scalars A, B, C, ... 

var(A, B, C, ...) Returns the population variance of the elements of the arrays or 
scalars A, B, C, ... 

Var(A, B, C, ...) Returns the sample variance of the elements of the arrays or 
scalars A, B, C, ...

∞–
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qbeta(p, )

Probability distribution functions for the beta distribution in 
which  are the shape parameters. . 

.

dbinom(k, n, p)
pbinom(k, n, p)
qbinom(p, n, r)
rbinom(m, n, p)

Probability distribution functions for the binomial 
distribution in which n and k are integers satisfying 

. . r is the probability of success on a 
single trial.

dcauchy(x, l, s)
pcauchy(x, l, s)
qcauchy(p, l, s)
rcauchy(m, l, s)

Probability distribution functions for the Cauchy 
distribution in which l is a location parameter and  is a 

scale parameter. .

dchisq(x, d)
pchisq(x, d)
qchisq(p, d)
rchisq(m, d)

Probability distribution functions for the chi-squared 
distribution in which  are the degrees of freedom and 

. .

dexp(x, r)
pexp(x, r)
qexp(p, r)
exp(m, r)

Probability distribution functions for the exponential 
distribution in which  is the rate and . .

dF( )
pF( )
qF( )
rF( )

Probability distribution functions for the F distribution in 
which  are the degrees of freedom and 

. .

dgamma(x, s)
pgamma(x, s)
qgamma(p, s)
rgamma(m, s)

Probability distribution functions for the gamma 
distribution in which  is the shape parameter and 

. .

dgeom(k, p)
pgeom(k, p)
qgeom(p, r)
rgeom(m, p)

Probability distribution functions for the geometric 
distribution in which  is the probability of success 
and k is a nonnegative integer. r is the probability of success 
on a single trial.

dhypergeom(M, a, b, n)
phypergeom(M, a, b, n)
qhypergeom(p, a, b, n)
rhypergeom(M, a, b, n)

Probability distribution functions for the hypergeometric 
distribution in which M, a, b, and n are integers with 

, , and . . 

dlnorm( )
plnorm( )
qlnorm( )
rlnorm(m, µ, σ)

Probability distribution functions for the lognormal 
distribution in which µ is the logmean and  is the 

logdeviation. . .

dbeta x s1 s2, ,( )
pbeta x s1 s2, ,( )

s1 s2,
rbeta m s1 s2, ,( )

s1 s2, 0>( ) 0 x 1< <

0 p 1≤ ≤

0 k n≤ ≤ 0 p 1≤ ≤

s 0>
0 p 1< <

d 0>
x 0≥ 0 p≤ 1<

r 0> x 0≥ 0 p≤ 1<

x d1 d2, ,
x d1 d2, ,
p d1 d2, ,
m d1 d2, ,

d1 d2, 0>( )

x 0≥ 0 p≤ 1<

s 0>
x 0≥ 0 p≤ 1<

0 p 1≤<

0 M a≤ ≤ 0 n M– b≤ ≤ 0 n a b+≤ ≤ 0 p≤ 1<

x µ σ, ,
x µ σ, ,
p µ σ, ,

σ 0>
x 0≥ 0 p≤ 1<
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7LS Two additional functions that are useful for common probability calculations are rnd(x), which 
is equivalent to runif(1, 0, x), and cnorm(x), which is equivalent to pnorm(x, 0, 1).

dlogis(x, l, s)
plogis(x, l, s)
qlogis(p, l, s)
rlogis(m, l, s)

Probability distribution functions for the logistic 
distribution in which l is the location parameter and  is 

the scale parameter. .

dnbinom(k, n, p)
pnbinom(k, n, p)
qnbinom(p, n, r)
rnbinom(m, n, p)

Probability distribution functions for the negative binomial 
distribution in which  and n and k are integers, 

 and .

dnorm( )
pnorm( )
qnorm( )
rnorm(m, µ, σ)

Probability distribution functions for the normal 
distribution in which µ and σ are the mean and standard 
deviation. .

dpois(k, λ)
ppois(k, λ)
qpois(p, λ)
rpois(m, λ)

Probability distribution functions for the Poisson 
distribution in which  and k is a nonnegative integer. 

.

dt(x, d)
pt(x, d)
qt(p, d)
t(m, d)

Probability distribution functions for Student’s t 
distribution in which  are the degrees of 

freedom. .

dunif(x, a, b)
punif(x, a, b)
qunif(p, a, b)
runif(m, a, b)

Probability distribution functions for the uniform 
distribution in which b and a are the endpoints of the 
interval with . .

dweibull(x, s)
pweibull(x, s)
qweibull(p, s)
rweibull(m, s)

Probability distribution functions for the Weibull 
distribution in which  is the shape parameter and 

. .

s 0>
0 p 1< <

0 p< 1≤
n 0> k 0≥

x µ σ, ,
x µ σ, ,
p µ σ, , σ 0>

λ 0>
0 p 1≤ ≤

d 0>
0 p 1< <

a x b≤ ≤ 0 p 1≤ ≤

s 0>
x 0≥ 0 p 1< <
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1RWH Whenever you use arrays in any of the functions described in this section, be sure that every 
element in the array contains a data value. Mathcad assigns 0 to any elements you have not 
explicitly assigned.

bspline(vx, vy, u, n) Returns a vector of coefficients of a B-spline of degree n, which 
is used in the interp function. The knot locations of the spline are 
specified in vector u. vx and vy must be real vectors of the same 
length. The values in vx must be in ascending order. 

cspline(vx, vy) Returns a vector of coefficients of a cubic spline with cubic 
endpoints, which is used in the interp function. vx and vy must be 
real vectors of the same length. The values in vx must be in 
ascending order.

interp(vs, vx, vy, x) Returns the interpolated y value corresponding to the argument x. 
The vector vs is a vector of intermediate results obtained by 
evaluating bspline, cspline, lspline, or pspline or the regression 
routine regress or loess using the data vectors vx and vy. vx and 
vy must be real vectors of the same length. The vector vx must be 
in ascending order.

linterp(vx, vy, x) Uses the data vectors vx and vy to return a linearly interpolated y 
value corresponding to the argument x. vx and vy must be real 
vectors of the same length. The vector vx must be in ascending 
order. 

lspline(vx, vy) Returns a vector of coefficients of a cubic spline with linear 
endpoints, which is used in the interp function. vx and vy must be 
real vectors of the same length. The values in vx must be in 
ascending order.

predict(v, m, n) Returns n predicted values based on m consecutive values from 
the data vector v. Elements in v should represent samples taken at 
equal intervals. m and n are integers

pspline(vx, vy) Returns a vector of coefficients of a cubic spline with parabolic 
endpoints, which is used in the interp function. vx and vy must be 
real vectors of the same length. The values in vx must be in 
ascending order.
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Interpolation involves using existing data points to predict values between these data 
points. Mathcad allows you to connect the data points either with straight lines (linear 
interpolation) or with sections of a cubic polynomial (cubic spline interpolation). 
Unlike the regression functions discussed in the next section, these interpolation 
functions return a curve which must pass through the points you specify. If your data 
is noisy, you should consider using regression functions instead (see page 179). 

Cubic spline interpolation passes a curve through a set of points in such a way that the 
first and second derivatives of the curve are continuous across each point. This curve 
is assembled by taking three adjacent points and constructing a cubic polynomial 
passing through those points. These cubic polynomials are then strung together to form 
the completed curve. In the case of “traditional” cubic splines, the data points to 
interpolated define the “knots” where the polynomials are joined, but B-splines 
(implemented in the function bspline)  join the polynomials at arbitrary points. 

Linear prediction involves using existing data values to predict values beyond the
existing ones. 

The coefficients returned by the spline interpolation functions bspline, cspline, lspline, 
and pspline and the regression functions regress and loess described in the next section
are designed to be passed to Mathcad’s interp function. interp returns a single 
interpolated y value for a given x value, but as a practical matter you’ll probably be 
evaluating interp for many different points, as shown in Figure 10-7. Store the 
coefficients returned by the spline or regression functions in a vector (such as vs in 
Figure 10-7) that can be passed to interp for evaluation, plotting, or further calculation

Figure 10-7: Spline curve for the points stored in vx and vy. Since the random 
number generator gives different numbers every time, you may not be able to 
recreate this example exactly as you see it.
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7LS For best results with spline interpolation, do not use the interp function on values of x far from 
the fitted points. Splines are intended for interpolation, not extrapolation.

1RWH Mathcad handles two-dimensional cubic spline interpolation in much the same way as the one-
dimensional case illustrated: in this case the spline function takes two matrix arguments, Mxy 
and Mz. The first is an  matrix specifying the points along the diagonal of a rectangular 
grid, and the second is an  matrix of z-values representing the surface to be interpolated. 
Mathcad passes a surface through the grid of points. This surface corresponds to a cubic 
polynomial in x and y in which the first and second partial derivatives are continuous in the 
corresponding direction across each grid point. For an example see the “Data Analysis” 
QuickSheets and in the Resource Center (choose Resource Center from the Help menu).

5HJUHVVLRQ�DQG�6PRRWKLQJ�)XQFWLRQV�
Mathcad includes a number of functions for performing regression. Typically, these 
functions generate a curve or surface of a specified type in some sense minimizes the 
error between itself and the data you supply. The functions differ primarily in the type 
of curve or surface they use to fit the data. Unlike interpolation functions, these 
functions do not require that the fitted curve or surface pass through points you supply, 
and they are therefore less sensitive to spurious data.

Smoothing involves taking a set of y (and possibly x) values and returning a new set of 
y values that is smoother than the original set. Unlike the regression and interpolation 
functions, smoothing results in a new set of y values, not a function that can be evaluated 
between the data points you specify. Thus, if you are interested in y values between the 
y values you specify, you should use a regression or interpolation function.

/LQHDU�UHJUHVVLRQ

intercept(vx, vy) Returns a scalar: the y-intercept of the least-squares regression line 
for the data points in vx and vy. 

slope(vx, vy) Returns a scalar: the slope of the least-squares regression line for the 
data points in vx and vy.

stderr(vx, vy) Returns the standard error associated with linear regression of the 
elements of vy on the elements of vx. 

line(vx, vy) Returns the y-intercept and slope of the line that best approximates 
the data in vx and vy.

medfit(vx, vy) Returns the y-intercept and slope of the line that best approximates 
the data in vx and vy using median-median regression.

n 2×
n n×
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These functions are useful when you have a set of measured y values corresponding to 
x values (or possibly multiple x values) and you want to fit a polynomial through those 
y values.   

Use regress when you want to use a single polynomial to fit all your data values. The 
regress function lets you fit a polynomial of any order. However as a practical matter, 
you rarely should go beyond .

The loess function performs a more localized regression. Instead of generating a single 
polynomial the way regress does, loess generates a different second order polynomial 
depending on where you are on the curve. It does this by examining the data in a small 
neighborhood of a point you’re interested in. 

As in the case of Mathcad’s spline interpolation functions, the coefficients returne
regress and loess are designed to be passed to Mathcad’s interp function. interp returns 
a single interpolated y value for a given x value, but as a practical matter you’ll probabl
be evaluating interp for many different points.

1RWH Mathcad also allows multivariate polynomial regression with regress or loess to fit y values 
corresponding to two or more independent variables. In this case, the regression function
two arguments are Mx and vy: the first is an  matrix specifying the m values of n predictor 
variables, and the second is a vector of response data corresponding to the factors in Mx. For an 
example see the “Data Analysis” QuickSheets in the Resource Center (choose Resource Center 
from the Help menu). You can add independent variables by simply adding columns to theMx 
array and a corresponding number of rows to the vector you pass to the interp function.

6SHFLDOL]HG�UHJUHVVLRQ

regress(vx, vy, n) Returns a vector of coefficients for the nth degree least-squares 
polynomial fit for the data points specified in vectors vx and vy. 
This vector becomes the first argument of the interp function.

loess(vx, vy, span) Returns a vector specifying a set of second order polynomials that 
best fit particular neighborhoods of data points specified in vectors 
vx and vy. This vector becomes the first argument of the interp 
function. The argument span, , specifies how large a 
neighborhood loess considers in performing this local regression. 

expfit(vx, vy, vg) Returns the parameter values for the exponential curve

that best approximates the data in vx and vy. Vector vg 
specifies guess values for the three unknown parameters a, b, and c. 
See Figure 10-8 for an example. 

lgsfit(vx, vy, vg) Returns the parameter values for the logistic curve

that best approximates the data in vx and vy. 
Vector vg specifies guess values for the three unknown parameters 
a, b, and c.

span 0>

n 4=

n m×

a e
b x⋅( )

c+⋅

a 1 b e
c– x⋅( )⋅+( )⁄
180  Chapter 10  Built-in Functions



Use these functions when you have a set of measured y values corresponding to x values 
and you want to fit a special type of curve through those y values. Although you can 
use the genfit function described on page 182 to perform a curve fit on any function, 
the functions outlined above are designed for ease of use. Use them if they address the 
particular function curve to which you are fitting your data.

lnfit(vx, vy) Returns the parameter values for the logarithmic curve
that best approximates the data in vx and vy. A vector 

of guess values is not required.

logfit(vx, vy, vg) Returns the parameter values for the logarithmic curve
that best approximates the data in vx and vy. 

Vector vg specifies guess values for the three unknown parameters 
a, b, and c.

pwrfit(vx, vy, vg) Returns the parameter values for the power curve

that best approximates the data in vx and vy. Vector vg 
specifies guess values for the three unknown parameters a, b, and c.

sinfit(vx, vy, vg) Returns the parameter values for the sine curve
that best approximates the data in vx and vy. 

Vector vg specifies guess values for the four unknown parameters a, 
b, and c.

Figure 10-8: Using the specialized regression function expfit.

a x( )ln⋅ b+

a x b+( )ln⋅ c+

a x
b⋅ c+

a x b+( )sin⋅ c+
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linfit is designed to model your data by a linear combination of arbitrary functions:

genfit is designed to model your data by some arbitrary (possibly nonlinear) function 
whose parameters must be chosen. For example, if your data is to be modeled by the sum

and you wish to solve for the unknown parameters  and , you would use genfit. 
An example of using genfit is given in Figure 10-9.

linfit(vx, vy, F) Returns a vector containing the coefficients used to create a linear 
combination of the functions in F that best approximates the data 
points in vectors vx and vy. F is a function which returns a vector 
consisting of the functions to be linearly combined. Elements of 
vx should be in ascending order.

genfit(vx, vy, vg, F) Returns the parameters for the best fit by the (possibly nonlinear) 
function defined by f to the data points in the vectors vx and vy. 
F is a function that returns an  element vector containing f 
and its partial derivatives with respect to each of its n parameters. 
vg is an n-element vector of guess values for the n parameters.

Figure 10-9: Using genfit for finding the parameters of a function so that it 
best fits the data.

n 1+

y a0 f0 x( )⋅ a1 f1 x( )⋅ … an fn x( )⋅+ + +=

f x( ) 2 a1x( )sin⋅ 3 a2x( )tanh⋅+=

a1 a2
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Anything you can do with linfit you can also do, albeit less conveniently, with genfit. 
The difference between these two functions is the difference between solving a system 
of linear equations and solving a system of nonlinear equations. The latter generally 
must be solved by iteration, which explains why genfit needs a vector of guess values 
as an argument and linfit does not. 

6PRRWKLQJ�IXQFWLRQV

medsmooth is the most robust of the three smoothing functions since it is least likely 
to be affected by spurious data points. This function uses a running median smoother, 
computes the residuals, smooths the residuals the same way, and adds these two 
smoothed vectors together. Note that medsmooth leaves the first and last  
points unchanged. In practice, the length of the smoothing window, n, should be small 
compared to the length of the data set.

ksmooth uses a Gaussian kernel to compute local weighted averages of the input vector 
vy. This smoother is most useful when your data lies along a band of relatively constant 
width. If your data lies scattered along a band whose width fluctuates considerably, you 
should use an adaptive smoother like supsmooth. supsmooth uses a symmetric k nearest 
neighbor linear least-squares fitting procedure to make a series of line segments through 
your data. Unlike ksmooth which uses a fixed bandwidth for all your data, supsmooth 
adaptively chooses different bandwidths for different portions of your data. 

)LQDQFH�)XQFWLRQV

These personal finance functions perform a variety of calculations for making credit 
and investment decisions. All finance functions take only real values. Payments you 
make, such as deposits in a savings account or payments toward a loan, must be entered 
as negative numbers. Cash you receive, such as dividend checks, must be entered as 
positive numbers. If you want to specify the timing of a payment, use the optional timing 
variable, type, which can be equal to 0 for the end of the period and 1 for the beginning. 
If omitted, type is 0.

medsmooth(vy, n) Returns an m-element vector created by smoothing vy with running 
medians. vy is an m-element vector of real numbers. n is the width 
of the window over which smoothing occurs. n must be an odd 
number less than the number of elements in vy.

ksmooth(vx,vy, b) Returns an n-element vector created by using a Gaussian kernel to 
return weighted averages of vy. vy and vx are n-element vectors of 
real numbers. The bandwidth b controls the smoothing window and 
should be set to a few times the spacing between your x data points. 
Elements in vx must be in ascending order.

supsmooth(vx,vy) Returns an n-element vector created by the piece wise use of a 
symmetric k-nearest neighbor linear least-squares fitting procedure 
in which k is adaptively chosen. vy and vx are n-element vectors of 
real numbers. The elements of vx must be in increasing order.

n 1–( ) 2⁄
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5DWH�DQG�SHULRG

7LS If rate does not converge to within  after 20 iterations, rate returns an error. In such a 
case, try different values for guess. In most cases, rate converges if guess is between 0 and 1.

&XPXODWLYH�LQWHUHVW�DQG�SULQFLSDO

cnper(rate, pv, fv) Returns the number of compounding periods required for 
an investment to yield a future value, fv, given a present 
value, pv, and an interest rate period, rate. rate > -1. pv > 
0. fv > 0.

crate(nper, pv, fv) Returns the fixed interest rate required for an investment at 
present value, pv, to yield a future value, fv, over a given 
number of compounding periods, nper. nper is a positive 
integer. pv > 0. fv > 0.

nper(rate, pmt, pv, [[fv],
[type]])

Returns the number of compounding periods for an 
investment or loan based on periodic, constant payments, 
pmt, using a fixed interest rate, rate, and a present value, 
pv. If omitted, fv = 0 and type = 0. If pmt > 0, rate and pv 
must be opposite signs.

rate(nper, pmt, pv, [[fv],
[type], [guess]])

Returns the interest rate per period of an investment or 
loan over a number of compounding periods, nper, given a 
periodic, constant payment, pmt, and a present value, pv. 
nper is a positive integer. If omitted, fv = 0, type = 0, and 
guess = 0.1 (10%).

cumint(rate, nper, pv, start, 
end, [type])

Returns the cumulative interest paid on a loan between 
a starting period, start, and an ending period, end, 
given a fixed interest rate, rate, the total number of 
compounding periods, nper, and the present value of 
the loan, pv. rate ≥ 0. nper, start, and end are positive 
integers. If omitted, type = 0.

cumprn(rate, nper, pv, start, 
end, [type])

Returns the cumulative principal paid on a loan 
between a starting period, start, and an ending period, 
end, given a fixed interest rate, rate, the total number 
of compounding periods, nper, and the present value 
of the loan, pv. rate ≥ 0. nper, start, and end are 
positive integers. If omitted, type = 0.

1
7–×10
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,QWHUHVW�UDWH

)XWXUH�YDOXH

1RWH When using functions that require information about rates and periods, use the same unit of time 
for each. For example, if you make monthly payments on a four-year loan at an annual interest 
rate of 12%, use 1% as the interest rate per period (one month) and 48 months as the number of 
periods.

Figure 10-10: Using the cumint function.

eff(rate, nper) Returns the effective annual interest rate (APR) given the nominal 
interest rate, rate, and the number of compounding periods per 
year, nper. nper is positive.

nom(rate, nper) Returns the nominal interest rate given the effective annual interest 
rate (APR), rate, and the number of compounding periods per year, 
nper. rate > -1. nper is positive.

fv(rate, nper, pmt, [[pv],
 [type]]) 

Returns the future value of an investment or loan over 
a number of compounding periods, nper, given a 
periodic, constant payment, pmt, and a fixed interest 
rate, rate. nper is a positive integer. If omitted, present 
value pv = 0 and type = 0. 

fvadj(prin, v) Returns the future value of an initial principal, prin, 
after applying a series of compound interest rates 
stored in v. v is a vector.

fvc(rate, v) Returns the future value of a list of cash flows 
occurring at regular intervals, v, earning an interest 
rate, rate. v is a vector.
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,QWHUQDO�UDWH�RI�UHWXUQ�

pmt(rate, nper, pv, [[fv], 
[type]]) 

Returns the payment for an investment or loan based 
on periodic constant payments over a given number of 
compounding periods, nper, using a fixed interest rate, 
rate, and a present value, pv. nper is a positive integer. 
If omitted, future value fv = 0 and type = 0.

ipmt(rate, per, nper, pv, [[fv], 
[type]]) 

Returns the interest payment of an investment or loan 
for a given period, per, based on periodic constant 
payments over a given number of compounding 
periods, nper, using a fixed interest rate, rate, and a 
present value, pv. per and nper are positive integers, 
per ≤ nper. If omitted, future value fv = 0 and type = 0.

ppmt(rate, per, nper, pv, [[fv], 
[type]]) 

Returns the payment on the principal, of a investment 
or loan, for a given period, per, based on periodic 
constant payments over a given number of 
compounding periods, nper, using a fixed interest rate, 
rate, and a present value, pv. per and nper are positive 
integers, per ≤ nper. If omitted, future value fv = 0 and 
type = 0.

Figure 10-11: Using the pmt, ipmt, and ppmt functions.

irr(v, [guess]) Returns the internal rate of return for a series of cash 
flows, v, occurring at regular intervals. v is a vector 
that must contain at least one positive value and one 
negative value. If omitted, guess = 0.1 (10%).

mirr(v, fin_rate, rein_rate) Returns the modified internal rate of return for a series 
of cash flows occurring at regular intervals, v, given a 
finance rate payable on the cash flows you borrow, 
fin_rate, and a reinvestment rate earned on the cash 
flows as you reinvest them, rein_rate. v is a vector that 
must contain at least one positive value and one 
negative value.
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1RWH If irr does not converge to within  of a percentage after 20 iterations, irr returns an error.  
In such a case, try different values for guess. In most cases, irr converges if guess is between 0 
and 1.

3UHVHQW�YDOXH

1RWH irr and npv are related functions. The internal rate of return (irr) is the rate for which the net 
present value (npv) is zero.

'LIIHUHQWLDO�(TXDWLRQ�)XQFWLRQV

In a differential equation, you solve for an unknown function rather than just a variable. 
For ordinary differential equations, the unknown function is a function of one variable. 
Partial differential equations are differential equations in which the unknown is a 
function of two or more variables.

The easiest way to solve a single differential equation of any order is to use a solve 
block and the function Odesolve. To solve systems of equations or to have more control 
over the solving process, you can use the general-purpose differential equation solver 
rkfixed. Alternatively you can choose from additional, more specialized functions for 
solving differential equations. 

6ROYLQJ�D�'LIIHUHQWLDO�(TXDWLRQ�8VLQJ�D�6ROYH�%ORFN

To solve a single differential equation of any order, use a solve block and the function 
Odesolve. A solve block for solving a differential equation is similar to a solve block 
for solving a system of equations as described on page 168. There are three steps to 
creating a differential equation solve block:

1. Type the word Given. You can type Given or given in any style, but be sure not to 
type it in a text region.

pv(rate, nper, pmt, [[fv]
 [type]])

Returns the present value of an investment or loan 
based on periodic constant payments over a given 
number of compounding periods, nper, using a fixed 
interest rate, rate, and a payment, pmt. nper is a 
positive integer. If omitted, fv = 0 and type = 0.

npv(rate, v) Returns the net present value of an investment given a 
discount rate, rate, and a series of cash flows occurring 
at regular intervals, v. v is a vector.

Odesolve(x, b, [step]) Returns a function of x which is the solution to a single ordinary 
differential equation. b is the terminal point of the integration 
interval. step (optional) is the number of steps. 

1
5–×10
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2. Type the differential equation and constraints in any order below the word Given. 

Use the bold equal sign (click  on the Boolean toolbar or press [Ctrl]=) for 
an equality. The independent variable x must be explicitly indicated throughout. A 
typical initial value constraint might be y(a)=c or y‘(a)=d; Mathcad does not allow 
more complicated constraints like y(a)+y‘(a)=e. The differential equation can be 

written using the derivative operators d/dx, d2/dx2, d3/dx3 , ... (press ? or [Ctrl]? 
to insert the derivative or nth derivative operators), or using prime notation y‘(x), 
y‘‘(x) , y‘‘‘(x) , .... (Press [Ctrl] [F7] for the prime symbol.)

3. Finally, type the Odesolve function. The terminal point b must be larger than the 
initial point a.

7LS Prime notation is only allowed inside a solve block. If you use it outside of a solve block, you 
see an error.

The output of Odesolve is a function of x, interpolated from a table of values computed 
using the fixed step method employed by the function rkfixed, described below.  If you 
prefer to use an adaptive step method employed by the function Rkadapt:

1. Click on Odesolve with the right mouse button.

2. Choose Adaptive from the pop-up menu.

1RWH Mathcad is very specific about the types of expressions that can appear between Given and 
Odesolve. The lower derivative terms can appear nonlinearly in the differential equation (e.g., 
they can be multiplied together or raised to powers), but the highest derivative term must appear 
linearly. Inequality constraints are not allowed. There must be n independent equality constraints 
for an nth order differential equation. For an initial value problem, the values for y(x) and its first 
n−1 derivatives at a single initial point a are required. For a boundary value problem, the n 
equality constraints should prescribe values for y(x) and certain derivatives at exactly two points 
a and b.

Figure 10-12: Solving a single differential equation.
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*HQHUDO�3XUSRVH�'LIIHUHQWLDO�(TXDWLRQ�6ROYHU��UNIL[HG
To solve systems of equations or to specify a starting point for the interval and the 
number of points at which to approximate a solution, you can use the differential 
equation solver rkfixed. Alternatively you can choose from additional, more specialized 
functions for solving differential equations, described in the following section 
“Specialized Differential Equation Solvers.”

)LUVW�RUGHU�GLIIHUHQWLDO�HTXDWLRQV

A first order differential equation is one in which the highest order derivative of th
unknown function is the first derivative. To solve a first order differential equation
Mathcad, you can use Odesolve as described in “Solving a Differential Equation Usin
a Solve Block” or you can use rkfixed. rkfixed uses the fourth order Runge-Kutta metho
to solve a first order differential equation and return a two-column matrix in whic

• The left-hand column contains the points at which the solution to the differen
equation is evaluated.

• The right-hand column contains the corresponding values of the solution. 

rkfixed(y, x1, x2, npoints, D)

y = A vector of n initial values where n is the order of the differential 
equation or the size of the system of equations you’re solving. For a 
order differential equation, the vector degenerates to one point, 

. 

x1, x2 = The endpoints of the interval on which the solution to the differentia
equations will be evaluated. The initial values in y are the values at x1.

npoints = The number of points beyond the initial point at which the solution is
be approximated. This controls the number of rows ( ) in t
matrix returned by rkfixed.

D(x, y) = An n-element vector-valued function containing the first n derivatives of 
the unknown functions.

y 0( ) y x1( )=

1 npoints+
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Figure 10-13 shows how to solve the differential equation subject to 
the initial condition .

1RWH The most difficult part of solving a differential equation using rkfixed, particularly with 
nonlinear differential equations, is solving for the first derivative so you can define the function 
D(x, y). In such cases, you can sometimes solve for  symbolically and paste it into the 
definition for D(x, y). To do so, use the symbolic solving techniques discussed in the section 
“Examples of Symbolic Calculation” in Chapter 14.

6HFRQG�DQG�KLJKHU�RUGHU�GLIIHUHQWLDO�HTXDWLRQV

You can use Odesolve and a solve block, as described on page 187, or you can use 
rkfixed to solve higher order differential equations. Using rkfixed to solve a second 
order differential equation is similar to solving a first order differential equation. The 
key differences are:

• The vector of initial values y now has two elements: the value of the function an
its first derivative at the starting value, x1.

• The function D(t, y) is now a vector with two elements:

• The solution matrix contains three columns: the left-hand one for the t values; the 
middle one for ; and the right-hand one for .

Figure 10-13: Solving a first order differential equation.

xd
dy

3 y⋅+ 0=
y 0( ) 4=

y′ x( )

D t y,( ) y′ t( )
y″ t( )

=

y t( ) y′ t( )
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See Figure 10-14 for an example using rkfixed. See Figure 10-12 for an example using 
Odesolve.

7LS The procedure for solving higher order differential equations is an extension of that used for 
second order differential equations. The main differences are that the vector of initial values y 
now has n elements for specifying initial conditions of y, , the function D is 
now a vector with n elements corresponding to the first n derivatives of the unknown functions, 
and the solution matrix contains n columns: the left-hand one for the t values and the remaining 
columns for values of y(t), .

6\VWHPV�RI�GLIIHUHQWLDO�HTXDWLRQV

Solving a system of differential equations is similar to solving a higher order differential 
equation using rkfixed. To solve a system of first order differential equations:

1. Define a vector containing the initial values of each unknown function.

2. Define a vector-valued function containing the first derivatives of each of the 
unknown functions.

3. Decide at which points you want to evaluate the solutions.

4. Pass all this information into rkfixed.

Figure 10-14: Solving a second order differential equation.

y′ y″ … y n 1–( ), , ,

y′ t( ) y″ t( ) … y n 1–( ) t( ), , ,
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rkfixed returns a matrix whose first column contains the points at which the solutions 
are evaluated and whose remaining columns contain the solution functions evaluated 
at the corresponding point. Figure 10-15 shows an example solving the equations:

with initial conditions  and .

Solving a system of nth order differential equations is similar to solving a system of 
first order differential equations. The main differences are:

• The vector of initial conditions must contain initial values for the  derivativ
of each unknown function in addition to initial values for the functions themsel

• The vector-valued function must contain expressions for the  derivatives
each unknown function in addition to the nth derivative.

rkfixed returns a matrix in which the first column contains the values at which the
solutions and their derivatives are to be evaluated, and the remaining columns co
the solutions and their derivatives evaluated at the corresponding point in the firs
column. The order in which the solution and its derivatives appear matches the o
in which you put them into the vector of initial conditions.

Figure 10-15: A system of first order linear equations.

x′0 t( ) µ x0 t( )⋅ x1 t( )– x0 t( )2 x1 t( )2+( ) x0 t( )⋅–=

x′1 t( ) µ x1 t( )⋅ x0 t( ) x0 t( )2 x1 t( )2+( ) x1 t( )⋅–+=

x0 0( ) 0= x1 0( ) 1=

n 1–

n 1–
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6SHFLDOL]HG�'LIIHUHQWLDO�(TXDWLRQ�6ROYHUV
Mathcad includes several, specialized functions for solving differential equations, and 
there are cases in which you may want to use these rather than the general-purpose 
rkfixed. These cases fall into the three categories given below. Each of these functions 
solves differential equations numerically: you always get back a matrix containing the 
values of the function evaluated over a set of points.

7LS When solving a differential equation it is a good idea to try more than one differential equation 
solver because one method might suit your differential equation better than another method.

6PRRWK�V\VWHPV

When you know the solution is smooth, use Bulstoer, which uses the Bulirsch-Stoer 
method rather than the Runge-Kutta method used by rkfixed. 

Bulstoer(y, x1, x2, npoints, D) 

The argument list and the matrix returned by Bulstoer are identical to that for rkfixed.

6ORZO\�YDU\LQJ�VROXWLRQV

Given a fixed number of points, you can approximate a function more accurately if you 
evaluate it frequently wherever it’s changing fast and infrequently wherever it’s 
changing more slowly. 

Rkadapt(y, x1, x2, npoints, D) 

The argument list and the matrix returned by Rkadapt are identical in form to that for 
rkfixed.

If you know that the solution has this property, you may be better off using Rkadapt. 
Unlike rkfixed, Rkadapt examines how fast the solution is changing and adapts its s
size accordingly.

1RWH Although Rkadapt uses nonuniform step sizes internally when it solves the differential equation, 
it nevertheless returns the solution at equally spaced points.

6WLII�V\VWHPV

A system of differential equations expressed in the form  is a stiff system if 
the matrix A is nearly singular. Under these conditions, the solution returned by rkfixed 
may oscillate or be unstable. When solving a stiff system, you should use one of
two differential equation solvers specifically designed for stiff systems, Stiffb and Stiffr, 
which use the Bulirsch-Stoer method and the Rosenbrock method, respectively. 
take the same arguments as rkfixed as well as one additional argument.

y A x⋅=
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Stiffb(y, x1, x2, npoints, D, J) 
Stiffr(y, x1, x2, npoints, D, J) 

(YDOXDWLQJ�2QO\�WKH�)LQDO�9DOXH
If you care about only the value of the solution at the endpoint, y(x2), rather than over 
a number of uniformly spaced x values in the integration interval bounded by x1 and 
x2, use the functions listed below. Each function corresponds to the capitalized versions 
already discussed. The properties of each of these functions are identical to those of 
the corresponding function in the previous sections, except for the arguments below:

bulstoer(y, x1, x2, acc, D, kmax, save)
rkadapt(y, x1, x2, acc, D, kmax, save) 
stiffb(y, x1, x2, acc, D, J, kmax, save) 
stiffr(y, x1, x2, acc, D, J, kmax, save) 

J(x, y) = A function you define that returns the  matrix whose first 

column contains the derivatives  and whose remaining rows 

and columns form the Jacobian matrix ( ) for the system of 

differential equations. For example, if:

See rkfixed for a description of other parameters.

acc = Controls the accuracy of the solution. A small value of acc forces 
the algorithm to take smaller steps along the trajectory, thereby 
increasing the accuracy of the solution. Values of acc around 0.001 
generally yield accurate solutions.

kmax = The maximum number of intermediate points at which the solution 
will be approximated. The value of kmax places an upper bound on 
the number of rows of the matrix returned by these functions. 

save = The smallest allowable spacing between the values at which the 
solutions are to be approximated. This places a lower bound on the 
difference between any two numbers in the first column of the 
matrix returned by the function.

n n 1+( )×
D∂ x∂⁄

D∂ yk∂⁄

D x y,( )
x y1⋅

2– y1 y0⋅ ⋅
    then   = J x y,( )

y1 0 x

0 2– y1⋅ 2– y0⋅
=
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The specialized differential equation solvers discussed above are useful for solving 
initial value problems. In some cases, however, you may know the value taken by the 
solution at the endpoints of the interval of integration, which is a boundary value 
problem. 

To solve boundary value problems in Mathcad, use Odesolve, described in “Solving a 
Differential Equation Using a Solve Block”, or sbval or bvalfit as described here.

7ZR�SRLQW�ERXQGDU\�YDOXH�SUREOHPV

Two-point boundary value problems are one-dimensional systems of differential
equations in which the solution is a function of a single variable and the value of
solution is known at two points. You can use sbval in the following case:

• You have an nth order differential equation.

• You know some, but not all, of the values of the solution and its first  
derivatives at the beginning of the interval of integration, x1, and at the end of the 
interval of integration, x2.

• Between what you know about the solution at x1 and at x2, you have n known values.

sbval returns a vector containing those initial values left unspecified at the first endp
of the interval. Once you know the missing initial values at x1, you have an initial value 
problem that can be solved using any of the functions discussed earlier in this se

sbval(v, x1, x2, D, load, score) 

v= Vector of guesses for initial values left unspecified at x1.

x1, x2 = The endpoints of the interval on which the solution to the 
differential equations will be evaluated.

D(x, y) = An n-element vector-valued function containing the first derivativ
of the unknown functions.

load(x1, v) = A vector-valued function whose n elements correspond to the value
of the n unknown functions at x1. Some of these values will be 
constants specified by your initial conditions. Others will be 
unknown at the outset but will be found by sbval. If a value is 
unknown, you should use the corresponding guess value from v.

score(x2, y) = A vector-valued function having the same number of elements av. 
Each element is the difference between an initial condition at x2, as 
originally specified, and the corresponding estimate from the 
solution. The score vector measures how closely the proposed 
solution matches the initial conditions at x2. A value of 0 for any 
element indicates a perfect match between the corresponding in
condition and that returned by sbval.

n 1–
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1RWH As shown in Figure 10-16, sbval does not actually return a solution to a differential equation. It 
merely computes the initial values the solution must have in order for the solution to match the 
final values you specify. You must then take the initial values returned by sbval and solve the 
resulting initial value problem using a function such as rkfixed.

It’s also possible that you don’t have all the information you need to use sbval but you 
do know something about the solution and its first  derivatives at some 
intermediate value, xf. bvalfit solves a two-point boundary value problem of this typ
by shooting from the endpoints and matching the trajectories of the solution and
derivatives at the intermediate point. This method becomes especially useful whe
derivative has a discontinuity somewhere in the integration interval.

bvalfit(v1, v2, x1, x2, xf, D, load1, load2, score)

Figure 10-16: Using sbval to obtain initial values corresponding to given final 
values of a solution to a differential equation.

v1, v2 = Vector v1 contains guesses for initial values left unspecified at x1. 
Vector v2 contains guesses for initial values left unspecified at x2.

x1, x2 = The endpoints of the interval on which the solution to the 
differential equations will be evaluated.

xf = A point between x1 and x2 at which the trajectories of the solution
beginning at x1 and those beginning at x2 are constrained to be 
equal.

D(x, y) = An n-element vector-valued function containing the first 
derivatives of the unknown functions.

n 1–
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A second type of boundary value problem arises when you are solving a partial 
differential equation. Rather than being fixed at two points, the solution is fixed at a 
whole continuum of points representing some boundary.

Two partial differential equations that arise often in the analysis of physical systems 
are Poisson’s equation:

and its homogeneous form, Laplace’s equation.

7LS To type a partial differential equation symbol such as , insert the derivative operator  by 

typing ?, click on the derivative operator with the right mouse button, and choose View 
Derivative As ⇒ Partial Derivative from the pop-up menu.

Mathcad has two functions for solving these equations over a square boundary.

should use relax if you know the value taken by the unknown function  on a
four sides of a square region.

If u(x, y) is zero on all four sides of the square, you can use multigrid, which often 
solves the problem faster than relax. Note that if the boundary condition is the same o
all four sides, you can simply transform the equation to an equivalent one in whic
value is zero on all four sides.

relax returns a square matrix in which:

• An element’s location in the matrix corresponds to its location within the squa
region, and 

• Its value approximates the value of the solution at that point. 

This function uses the relaxation method to converge to the solution. Poisson’s equ
on a square domain is represented by:

load1(x1, v1) = A vector-valued function whose n elements correspond to the 
values of the n unknown functions at x1. Some of these values will
be constants specified by your initial conditions. If a value is 
unknown, you should use the corresponding guess value fromv1.

load2(x2, v2) = Analogous to load1 but for values taken by the n unknown 
functions at x2.

score(xf, y) = An n element vector valued function that specifies how the 
solutions match at xf. You’ll usually want to define score(xf, y) := 
y to make the solutions to all unknown functions match up at xf.

x2
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∂
∂ u

y2

2

∂
∂ u

+ ρ x y,( )=

x∂
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relax(a, b, c, d, e, f, u, rjac)

multigrid(M, ncycle)

0LVFHOODQHRXV�)XQFWLRQV

([SUHVVLRQ�7\SH

6WULQJ�)XQFWLRQV

a . . . e = Square matrices all of the same size containing coefficients of the above 
equation.

f = Square matrix containing the source term at each point in the region in 
which the solution is sought.

u = Square matrix containing boundary values along the edges of the region 
and initial guesses for the solution inside the region.

rjac = Spectral radius of the Jacobi iteration. This number between 0 and 1 
controls the convergence of the relaxation algorithm. Its optimal value 
depends on the details of your problem.

M =  row square matrix whose elements correspond to the 
source term at the corresponding point in the square domain.

ncycle = The number of cycles at each level of the multigrid iteration. A 
value of 2 generally gives a good approximation of the solution.

IsArray(x) Returns 1 if x is a matrix or vector, 0 otherwise.

IsScalar(x) Returns 1 if x is a real or complex number, 0 otherwise.

IsString(x) Returns 1 if x is a string, 0 otherwise.

UnitsOf(x) Returns the units of x, 1 otherwise.

concat(S1, S2, S3, ...) Returns a string formed by appending string S2 to the end of 
string S1, S3 to the end of S2, and so on.

error(S) Returns the string S as an error tip. When Mathcad evaluates 
the error function, the expression is highlighted in red and 
further numerical evaluation is suspended. When you click on 
the expression, the string appears in an error tip.

num2str(z) Returns a string formed by converting the real or complex 
number z into a decimal-valued string.

search(S, S1, m) Returns the starting position of the substring S1 in string S 
beginning from position m, or  if no substring is found. m 
must be a nonnegative integer.

1 2n+( )

1–
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The strings used and returned by most of these functions are typed in a math placeholder 
by pressing the double-quote key (") and entering any combination of letters, numbers, 
or other ASCII characters. Mathcad automatically places double quotes around the 
string expression and displays quotes around a string returned as a result. 

1RWH When evaluating the functions search and substr, Mathcad assumes that the first character in a 
string is at position 0.

)LOH�$FFHVV�)XQFWLRQV
The file argument you supply to a Mathcad file access function is a string—or a variable 
to which a string is assigned—that corresponds either to:

• The name of a data or image file in the folder of the Mathcad worksheet you’
currently working on.

• The name of a colormap file (see page 202) in the CMAP subfolder of your Mathcad 
installation folder.

• A full or relative path to a data, image, or colormap file located elsewhere on a l
or network file system.

str2num(S) Returns a constant formed by converting the characters in
string S to a number. S must contain only characters which 
constitute an integer, a floating-point or complex number, o
an e-format number such as 4.51e-3 (for ). Spac
are ignored.

str2vec(S) Returns a vector of ASCII codes corresponding to the 
characters in string S. 

strlen(S) Returns the number of characters in string S.

substr(S, m, n) Returns a substring of S beginning with the character in the 
mth position and having at most n characters. m and n must be 
nonnegative integers.

vec2str(v) Returns a string formed by converting a vector v of ASCII 
codes to characters. The elements of v must be integers 
between 0 and 255. 

4.51 10 3–⋅
Miscellaneous Functions 199



5HDGLQJ�DQG�ZULWLQJ�$6&,,�GDWD�ILOHV�

Files in plain ASCII format consist only of numbers separated by commas, spaces, or 
carriage returns. The numbers in the data files can be integers like 3 or –1, floating-

point numbers like 2.54, or E-format numbers like 4.51E- 4 (for ).

7LS These ASCII data file access functions are provided mainly for compatibility with worksheets 
created in earlier versions of Mathcad. The Input Table and File Read/Write component provide 
more general methods of importing and exporting data in a variety of formats. See Chapter 11, 
“Vectors, Matrices, and Data Arrays.”

5HDGLQJ�DQG�ZULWLQJ�LPDJH�ILOHV

READPRN( file) Reads a structured data file. Returns a matrix. Each line in the data 
file becomes a row in the matrix. The number of elements in each 
row must be the same. Usually used as follows: 
A := READPRN( file)

WRITEPRN(file) Writes a matrix into a data file. Each row becomes a line in the file. 
Must be used in a definition of the form WRITEPRN( file) :=  A 

APPENDPRN(file) Appends a matrix to an existing file. Each row in the matrix 
becomes a new line in the data file. Must be used in a definition of 
the form APPENDPRN(file) :=  A. Existing data must have as many 
columns as A.

READBMP( file) Creates a matrix containing a grayscale representation of the 
image in BMP format file. Each element in the matrix 
corresponds to a pixel. The value of a matrix element 
determines the shade of gray associated with the 
corresponding pixel. Each element is an integer between 0 
(black) and 255 (white).

READRGB(file) Creates a matrix in which the color information in BMP 
format file is represented by the appropriate values of red, 
green, and blue. This matrix consists of three submatrices, 
each with the same number of columns and rows. Three 
matrix elements, rather than one, correspond to each pixel. 
Each element is an integer between 0 and 255. The three 
corresponding elements, when taken together, establish the 
color of the pixel.

WRITEBMP( file) Creates a grayscale BMP file from the matrix. Must be used 
in a definition of the form WRITEBMP( file) :=  A.

WRITERGB( file) Creates a color BMP file from a matrix in which the image is 
stored in RGB format. Must be used in a definition of the 
form WRITERGB( file) :=  A.

READ_IMAGE( file) Creates a matrix containing a grayscale representation of the 
image in BMP, GIF, JPG, PCX, or TGA format file. 

4.51 10 4–⋅
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Use these functions to read, write, and get format information from pulse code 
modulated (PCM) Microsoft WAV files.

READ_HLS( file)
READ_HSV(file)

Creates a matrix in which the color information in BMP, GIF, 
JPG, PCX, or TGA format file is represented by the 
appropriate values of hue, lightness, and saturation (HLS) or 
hue, saturation, and value (HSV).

READ_RED( file)
READ_GREEN(file)
READ_BLUE(file)

Extracts only the red, green, or blue component from a color 
image in BMP, GIF, JPG, PCX, or TGA format file. The result 
has one-third the number of columns that the matrix returned 
by READRGB would have had.

READ_HLS_HUE( file)
READ_HLS_LIGHT(file)
READ_HLS_SAT(file)

Extracts only the hue, lightness, or saturation component 
from a color image in BMP, GIF, JPG, PCX, or TGA format 
file. The result has one-third the number of columns that the 
matrix returned by READ_HLS would have had.

READ_HSV_HUE(file)
READ_HSV_SAT(file)
READ_HSV_VALUE(file)

Extracts only the hue, saturation, or value component from 
a color image in BMP, GIF, JPG, PCX, or TGA format file. 
The result has one-third the number of columns that the 
matrix returned by READ_HSV would have had.

WRITE_HLS( file) Creates a color BMP file out of a matrix in which the image 
is stored in HLS format. Must be used in a definition of the 
form WRITE_HLS( file) :=  A.

WRITE_HSV( file) Creates a color BMP file out of a matrix in which the image 
is stored in HSV format. Must be used in a definition of the 
form WRITE_HSV( file) :=  A.

READWAV(file) Creates an n-column matrix containing data values 
corresponding to n channels of a WAV file, file.

WRITEWAV(file, r, b) Creates a WAV file, file, from a matrix, with a specified 
sample rate, r, and number of bits per sample, or bit 
resolution, b. Both r and b must be integers. Must be used in 
a definition of the form WRITEWAV(file, r, b) :=  A.

GETWAVINFO(file) Returns a vector containing, in order, the number of 
channels, the sample rate, the bit resolution, and the average 
bytes per second of a WAV file, file.
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/RDGLQJ�DQG�VDYLQJ�FRORUPDSV

A colormap is a .CMP file containing three columns of values that represent levels of 
red, green, and blue. You can apply a colormap to a 3D plot as described in “Fill C
on page 248. Each value in a colormap should be an integer between 0 and 255
inclusive. By default Mathcad saves and loads colormaps from the CMAPS subfolder 
of the location where you installed Mathcad.

*UDSKLQJ��'�SRO\KHGUD

The uniform polyhedra are regular polyhedra whose 
vertices are congruent. Each has a name, a number, a 
dual (the name of another polyhedron), and a Wythoff 
symbol associated with it. To look up the name, 
Wythoff symbol, and dual name of a polyhedron, use 
PolyLookup.

To graph a uniform polyhedron:

1. Click in a blank spot of your worksheet. Choose 
Graph⇒Surface Plot from the Insert menu.

2. In the placeholder, enter the Polyhedron function 
with an appropriate string argument.

3. Click outside the plot or press [Enter].

LoadColormap(file) Returns an array containing the values in the colormap file.

SaveColormap(file, M) Creates a colormap file containing the values in the three-
column array M. Returns the number of rows written to file.

PolyLookup(n) Returns a vector containing the name, the dual name, and the 
Wythoff symbol for the uniform polyhedron whose number code
n. n is a positive integer less than 81, a name typed as a string, 
Wythoff symbol typed as a string.

Polyhedron(S) Generates the uniform polyhedron whose name, number code
Wythoff symbol is string S.
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&UHDWLQJ�$UUD\V����

As introduced in “Inserting Math” on page 35, one technique of creating an array 
use the Matrix command on the Insert menu to create an array of empty placeholde
and then to enter expressions directly into the placeholders. This technique can o
used for small arrays, but it can be used to create arrays of any kind of Mathcad
expression, not just numbers. This section describes this technique and other 
approaches for creating arrays of arbitrary size:

• Using range variables to fill in the elements. This technique is useful when yo
have some explicit formula for the array elements in terms of their indices. 

• Using the File Read/Write component to import data from external files in a var
of formats.

• Entering numbers manually in a spreadsheet-like input table.

Unlike the Insert Matrix command, however, these procedures can be used only for 
creating arrays of numbers, as opposed to arbitrary math expressions.

1RWH The effective array size limit depends on the memory available on your system—usually a
1 million elements. In no system is it higher than 8 million elements. 

,QVHUW�0DWUL[�&RPPDQG�
To insert a vector or matrix in Mathcad, follow these steps:

1. Click in either a blank space or on a math 
placeholder.

2. Choose Matrix from the Insert menu, or click  
on the Matrix toolbar. A dialog box appears, as 
shown at right. 
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3. Enter the appropriate number of elements in the text boxes for 
“Rows” and “Columns.” For example, to create a three-element 
vector, enter 3 and 1.

4. An array with blank placeholders appears in your worksheet.

Next, fill in the array elements. You can enter any Mathcad expression 
into the placeholders of an array created in this way. Simply click in a placeholde
type a number or Mathcad expression. Use the [Tab] key to move from placeholder to
placeholder.

1RWH Arrays created using the Matrix command on the Insert menu are limited to 100 elements. 

&KDQJLQJ�WKH�VL]H�RI�D�YHFWRU�RU�PDWUL[�

You can change the size of a matrix by inserting and deleting rows and columns

1. Click on one of the matrix elements to place it between the 
editing lines. Mathcad begins inserting or deleting with this 
element.

2. Choose Matrix from the Insert menu. Type the number of 
rows and/or columns you want to insert or delete. Then press 
either “Insert” or “Delete.” For example, to delete the 
column that holds the selected element, type 1 in the box 
next to “Columns,” 0 in the box next to “Rows,” and press “Delete.”

1RWH If you insert rows or columns, Mathcad inserts rows below the selected element and inserts 
columns to the right of the selected element. If you delete rows or columns, Mathcad begins with 
the row or column occupied by the selected element and deletes rows from that element 
downward and columns from that element rightward. To insert a row above the top row or a 
column to the left of the first column, first place the entire matrix between the editing lines.

&UHDWLQJ�$UUD\V�ZLWK�5DQJH�9DULDEOHV�
As introduced in “Range Variables” on page 106, you can use one or more rang
variables to fill up the elements of an array. If you use two range variables in an equ
for example, Mathcad runs through each value of each range variable. This is us
for defining matrices. For example, to define a  matrix whose i,jth element is 

, enter the equations shown in Figure 11-1. 

Recall that you enter the range variable operator by pressing the semicolon key ;) or 

clicking  on the Calculator toolbar. You enter the subscript operator by clicki

 on the Matrix toolbar.

5 5×
i j+
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The  equation is evaluated for each value of each range variable, for a total of 25 

evaluations. The result is the matrix shown at the bottom of Figure 11-1, with 5 rows 
and 5 columns. The element in the ith row and jth column of this matrix is .

1RWH To be used to define an array element, a range variable can take on only whole-number values.

7LS You can also define individual array elements using the subscript operator, as described in 
“Accessing Array Elements” on page 208.

5HDGLQJ�D�'DWD�)LOH
Mathcad provides the File Read/Write component to read a data file and store the data 
in a Mathcad array variable.

1RWH A component is a specialized OLE object that you insert into a Mathcad worksheet to cre
link between the worksheet and either a data source or another application containing da
more information on components, including specialized components for linking other 
computational applications dynamically to arrays in a Mathcad worksheet, see Chapter 1
“Advanced Computational Features.”

You can read data from files in a variety of formats, including:

• Excel (*.XLS)

• MATLAB (*.MAT)

• Lotus 1-2-3 (*.WK*) 

• ASCII editors (*.DAT, *.CSV, *.PRN, *.TXT)

7LS Mathcad also provides a number of built-in functions for importing ASCII data files and image 
files. See “File Access Functions” on page 199.

Figure 11-1: Defining a matrix using range variables.

xi j,

i j+
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To read in data using the File Read/Write component:

1. Click in a blank spot of your worksheet.

2. Choose Component from the Insert menu.

3. Choose File Read or Write from the list and click “Next.” This launches the F
Read or Write Wizard. 

4. Choose “Read from a file” and press “Next” to continue through the Wizard.

5. Specify the type of data file you want to read. Enter the path to the data file o
the “Browse” button to locate it.

6. Press “Finish.” You’ll see the File Read/Write 
component icon and the path to the data file. For 
example, if you specify a data file called data.txt in the 
C:\WINDOWS folder, you’ll see the component at 
right.

In the placeholder that appears, enter the name of the Mathcad variable to whic
data from the file will be assigned. When you click outside the component, the dat
is read in and the data is assigned to the Mathcad array variable you entered int
placeholder.

Each time you calculate the worksheet, Mathcad re-reads the data from the file 
have specified. Figure 11-2 shows an example of reading in data using the File 
Write component. If you want to import data from a file just once into Mathcad, re
to“Importing Once from a Data File” on page 208.

 

Figure 11-2: Reading in data from a data file. Whenever you calculate the 
worksheet, the data file is read in.
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To read in a different data file or a different type of data file:

1. Click with the right mouse button on the component and select Choose File from 
the component pop-up menu.

2. In the “Files of type” text box, choose the type of file you’d like to import. Use t
dialog box to browse to the data file, select the data file, and click “Open.”

7LS By default, Mathcad reads in the entire data file and creates an array with the variable name you 
provide. To read in only certain rows or columns of a data file, click once on the component to 
select it, then click with the right mouse button on the component and choose Properties from 
the pop-up menu. Use the Properties dialog box to specify the row and columns at which to start 
and stop reading.

(QWHULQJ�'DWD�LQWR�D�7DEOH
To get the convenience of a spreadsheet-like interface for entering data, you can 
an array using the Input Table component:

1. Click in a blank spot in your worksheet and choose Component from the Insert 
menu.

2. Select Input Table from the list and click “Next.” The Input Table component i
inserted into your worksheet. 

3. Enter the name of the Mathcad variable to which the data will be assigned in
placeholder that appears.

4. Click in the component and enter data into the cells. Each row must have the 
number of data values. If you do not enter a number into a cell, Mathcad inse
into the cell.

Figure 11-3 shows two input tables. Notice that when you create an input table, y
actually assigning elements to an array that has the name of the variable you en
into the placeholder. 

Figure 11-3: Using input tables to create arrays of data.
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When you click the table, you can edit the values in it. The scroll bars let you scroll 
through the table. To resize the table, move the cursor to one of these handles along the 
sides of the region so that it changes to a double-headed arrow. Then press and hold 
down the mouse button and drag the cursor to change the table’s dimensions.

7LS You can copy data from an input table as follows: first select some data, then click with the right 
mouse button on the component and choose Copy from the pop-up menu. You can paste a single 
number from the Clipboard into the table by selecting a cell and choosing Paste from the pop-
up menu. Choosing Paste Table from the pop-up menu overwrites the entire table with values 
in the Clipboard.

,PSRUWLQJ�2QFH�IURP�D�'DWD�)LOH
You can use an input table to import data a single time from a data file. To do so

1. Insert an input table by following the instructions given above.

2. In the placeholder that appears to the left, enter the name of the Mathcad va
to which this data will be assigned.

3. Click on the table to select it. Then click on it with the right mouse button on 
input table so that you see the pop-up menu.

4. Choose Import.

5. The Read from File dialog box appears. In the “Files of type” text box, choose
type of file you’d like to import. Use the dialog box to browse to the data file a
click “Open.”

The data from the data file appears in your worksheet in the input table.

1RWH Unlike the File Read/Write component, the Import feature of an input table reads the data only 
when you choose Import, not each time you calculate the worksheet. If you want the data to be 
imported each time you calculate, use the File Read/Write component as described in “Re
a Data File” on page 205.

$FFHVVLQJ�$UUD\�(OHPHQWV

You can access all the elements of an array simply by using its variable name, or you 
can access the elements individually or in groups. 

6XEVFULSWV�
You access individual elements of a vector or matrix by using the subscript operator 
described in “Vector and Matrix Operators” on page 133. Insert the subscript ope

by clicking  on the Matrix toolbar or by typing [. To access an element of a vecto
enter one number in the subscript. To access a matrix element, enter two numbe
separated by a comma. To refer to the ith element of a vector, type v[i. In general, to 
refer to the element in the ith row, jth column of matrix M, type M[i,j. 

Figure 11-4 shows examples of how to define individual matrix elements and ho
view them.
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1RWH When you define vector or matrix elements, you may leave gaps in the vector or matrix. For 

example, if v is undefined and you define  as 10, then , , and  are all undefined. 

Mathcad fills these gaps with zeros until you enter specific values for them, as shown in Figure 
11-4. Be careful of inadvertently creating very large vectors and matrices by doing this. Also 
note that vector and matrix elements by default are numbered starting with row zero and column 
zero unless the built-in variable ORIGIN has a value other than zero (see page 209).

You can use this kind of subscript notation in Mathcad to perform parallel calculations 
on the elements of an array. See “Doing Calculations in Parallel” on page 213.

7LS If you want to define or access a group of array elements at once, you can use a range variable 
in a subscript.

$FFHVVLQJ�5RZV�DQG�&ROXPQV
Although you can use a range variable to access all the elements in a row or colu
an array, Mathcad provides a column operator for quickly accessing all the elem

in a column. Click  on the Matrix toolbar for the column operator. Figure 11-5
shows how to extract the third column of the matrix M. 

To extract a single row from a matrix, transpose the matrix using the transpose op

(click  on the Matrix toolbar) and then extract a column using the column opera
This is shown on the right-hand side of Figure 11-5.

&KDQJLQJ�WKH�$UUD\�2ULJLQ
When you use subscripts to refer to array elements, Mathcad assumes the array 
at the current value of the built-in variable ORIGIN. By default, ORIGIN is 0, but you 
can change its value. See “Built-in Variables” on page 102 for details.

Figure 11-6 shows a worksheet with the ORIGIN set to 1. If you try to refer to the zeroth
element of an array in this case, Mathcad displays an error message.

Figure 11-4: Defining and viewing matrix elements.

v3 v0 v1 v2
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As described in “Formatting Results” on page 115, Mathcad automatically displa
matrices and vectors having more than nine rows or columns as output tables ra
than as matrices or vectors. Smaller arrays are displayed by default in traditional m
notation. Figure 11-7 shows an example.

1RWH An output table displays a portion of an array. To the left of each row and at the top of each 
column, there is a number indicating the index of the row or column. Click with the right mouse 
button on the output table and select Properties from the pop-up menu to control whether row 
and column numbers appear and the font used for values in the table. If your results extend 
beyond the table, a scroll bar appears along the appropriate edge of the table. You can scroll 
through the table using these scroll bars just as you would scroll through any window. 

Figure 11-5: Extracting a column from a matrix.

Figure 11-6: Arrays beginning at element one instead of at element zero.
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To resize an output table:

1. Click the output table. You’ll see handles along the sides of the table.

2. Move the cursor to one of these handles so that it changes to a double-headed

3. Press and hold down the mouse button and drag the cursor in the direction you
the table’s dimensions to change.

7LS You can change the alignment of the table with respect to the expression on the left-hand side of 
the equal sign. Click with the right mouse button on the table, then choose one of the Alignment 
options from the pop-up menu.

&KDQJLQJ�WKH�'LVSOD\�RI�$UUD\V�²�7DEOH�YHUVXV�0DWUL[
Although matrices and vectors having more than nine rows or columns are autom
cally displayed as scrolling output tables, you can have Mathcad display them a
matrices. You can also change matrices to output tables. To do so:

1. Click on the scrolling output table.

2. Choose Result from the Format menu.

3. Click on the Display Options tab.

4. Choose Matrix or Table in the “Matrix display style” drop-down box.

5. Click “OK.”

To display all the results in your worksheet as matrices or as tables regardless o
size, click “Set as Default” in the Result Format dialog box rather than “OK.”

1RWH Mathcad cannot display extremely large arrays in matrix form. You should display a large array 
as a scrolling output table. 

&KDQJLQJ�WKH�)RUPDW�RI�'LVSOD\HG�(OHPHQWV
You format the numbers in the array the same way you format other numerical re
as described in “Formatting Results” on page 115. Just click on the displayed arra
choose Result from the Format menu, and modify the settings there. When you clic
“OK,”  Mathcad applies the selected format to all the numbers in the table, vecto
matrix. It is not possible to format the numbers individually.   

Figure 11-7: Display results as a matrix or in an output table.
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You can copy an array of numbers directly from a spreadsheet or database into Mathcad 
where you can take advantage of its free-form interface and its advanced mathematical 
tools. Once you’ve performed the necessary computations, you can paste the res
array of numbers back to its source or even into another application.

To copy just one number from a result array, simply click the number and choose Copy 

from the Edit menu, or click  on the Standard toolbar. Copying multiple numbe
from a vector or matrix result differs depending on whether the array is displayed
matrix or as an output table. See “Formatting Results” on page 115 for more inform
on how vector and matrix results are displayed.

To copy a result array displayed as a matrix:

1. Drag-select the array to the right of the equal sign to place the entire array bet
the editing lines.

2. Choose Copy from the Edit menu. This places the entire array on the Clipboar

3. Click wherever you want to paste the result. If you’re pasting into another 
application, choose Paste from that application’s Edit menu. If you’re pasting into 

a Mathcad worksheet, choose Paste from Mathcad’s Edit menu, or click  on 
the Standard toolbar.

1RWH You may only paste an array into a math placeholder or into a blank space in a Mathcad 
worksheet. 

When you display array results as a table, you can copy some or all of the numb
from the table and use them elsewhere:

1. Click on the first number you want to copy.

2. Drag the mouse in the direction of the other values you want to copy while hol
the mouse button down.

3. Click on the selected values with the right mouse button and choose Copy Selection 
from the pop-up menu.

To copy all the values in a row or column, click on the column or row number sho
to the left of the row or at the top of the column. All the values in the row or colum
are selected. Then choose Copy from the Edit menu.

After you have copied one or more numbers from an output table, you can paste
into another part of your worksheet or into another application. Figure 11-8 show
example of a new matrix created by copying and pasting numbers from an output 
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Once you create an array, you can use it in calculations. There are many operators and 
functions designed for use with vectors and matrices. See “Vector and Matrix 
Operators” on page 133 and “Vector and Matrix Functions” on page 159 for an 
overview. This section highlights the vectorize operator, which permits efficient 
parallel calculations on the elements of arrays. You can also display the values 
array graphically or export them to a data file or another application.

'RLQJ�&DOFXODWLRQV�LQ�3DUDOOHO�
Any calculation Mathcad can perform with single values, it can also perform with
vectors or matrices of values. There are two ways to do this:

• Iterate over each element using range variables. See for example “Creating A
with Range Variables” on page 204.

• Use the vectorize operator, which allows Mathcad to perform the same operatio
efficiently on each element of a vector or matrix.

Mathematical notation often shows repeated operations with subscripts. For exa
to define a matrix P by multiplying corresponding elements of the matrices M and N, 
you would write:

Note that this is not matrix multiplication, but multiplication element by element. Iis 
possible to perform this operation in Mathcad using subscripts, but it is much fast
perform exactly the same operation with a vectorized equation.

Figure 11-8: Copying and pasting results from an output table.

Pi j, Mi j, Ni j,⋅=
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Here’s how to apply the vectorize operator to an expression like :

1. Select the whole expression by clicking inside it and pressing 
[Space] until the right-hand side is surrounded by the editing 
lines. 

2. Click  on the Matrix toolbar to apply the vectorize operator. 
Mathcad puts an arrow over the top of the selected expression.

3URSHUWLHV�RI�WKH�YHFWRUL]H�RSHUDWRU�

• The vectorize operator changes the meaning of the other operators and functions 
to which it applies. The vectorize operator tells Mathcad to apply the operators
functions with their scalar meanings, element by element. It does not change
meaning of the actual names and numbers. If you apply the vectorize operato
single name, it simply draws an arrow over the name. You can use this arrow
cosmetic purposes only if you like.

• Since operations between two arrays are performed element by element, all a
under a vectorize operator must be the same size. Operations between an arr
a scalar are performed by applying the scalar to each element of the array. 

• You can use any of the following matrix operations under a vectorize operator
product, matrix multiplication, matrix powers, matrix inverse, determinant, or 
magnitude of a vector. The vectorize operator transforms these operations in
element-by-element scalar multiplication, exponentiation, or absolute value, 
appropriate.

7LS A number of Mathcad’s built-in functions and operators ordinarily take scalar arguments b
implicitly vectorize arguments that are vectors (one-column arrays): they automatically com
a result element by element, whether you apply the vectorize operator or not. Functions t
implicitly vectorize vector arguments include the trigonometric, logarithmic, Bessel, and 
probability distribution functions. Operators that implicitly vectorize vector arguments incl
the factorial, square and nth root, and relational operators. You must continue to use the 
vectorize operator on arrays of other sizes with these functions and operators.

For example, suppose you want to apply the quadratic formula to three vectors 
containing coefficients a, b, and c. Figure 11-9 shows how to do this with the vectorize 
operator. 

The vectorize operator, appearing as an arrow above the quadratic formula in Figure 
11-9, is essential in this calculation. Without it, Mathcad would interpret  as a 
vector dot product and also flag the square root of a vector as illegal. But with the 
vectorize operator, both  and the square root are performed element by element.

M N⋅

a c⋅

a c⋅
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In addition to looking at the actual numbers making up an array, you can also see a 
graphical representation of those same numbers. There are several ways to do this:

• For an arbitrary array, you can use the various three-dimensional plot types 
discussed in Chapter 13, “3D Plots.”

• For an array of integers between 0 and 255, you can look at a grayscale ima
choosing Picture from the Insert menu and entering the array’s name in the 
placeholder. 

• For three arrays of integers between 0 and 255 representing the red, green, an
components of an image, choose Picture from the Insert menu and enter the arrays
names, separated by commas, in the placeholder.

See Chapter 6, “Working with Graphics and Other Objects,” for more on viewing
matrix (or three matrices, in the case of a color image) in the picture operator.

:ULWLQJ�WR�D�'DWD�)LOH
The File Read/Write component allows you to write the values stored in a Mathc
variable to a data file in a variety of formats, including the following:

• Excel (*.XLS)

• MATLAB (*.MAT)

• Lotus 1-2-3 (*.WK*) 

• ASCII editors (*.DAT, *.CSV, *.PRN, *.TXT)

7LS Mathcad also provides a number of built-in functions to export arrays as ASCII data files or 
image files. See “File Access Functions” on page 199.

Figure 11-9: Quadratic formula with vectors and the vectorize operator.
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To export data using the File Read/Write component:

1. Click in a blank spot in your worksheet.

2. Choose Component from the Insert menu.

3. Select File Read or Write from the list and click “Next.” This launches the File
Read or Write Wizard. 

4. Choose “Write to a file” and press “Next” to continue through the Wizard.

5. Specify the type of data file you want to create. Also enter the path to the dat
you want to write or click the “Browse” button to locate it. 

6. Press “Finish.” You’ll see the File Read/Write component icon 
and the path to the data file. For example, if you specify a data 
file called data.txt, you’ll see the component at right.

In the placeholder, enter the name of the Mathcad variable containing the data t
written to the data file. When you click outside the component, all the values in t
array are written to the file you specified. Each time you calculate the worksheet
data file is rewritten. See Figure 11-10 for an example.

To change the name of the data file or the file type being created:

1. Click once on the component to select it.

2. Click with the right mouse button on the component and select Choose File from 
the pop-up menu to open the Write to File dialog box.

3. Choose the type of file you’d like to create in the “Files of type” text box. Use 
dialog box to browse to the folder in which the data file will be created and cl
“Open.”

Figure 11-10: Exporting data with the File Read/Write component
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7LS When you display an array as an output table, as described in “Displaying Arrays” on page
you can export data directly from the table. Click with the right mouse button on the output t
choose Export from the pop-up menu, and enter the name of the file that will receive the d
Unlike the File Read/Write component, the output table writes the data only when you cho
Export, not each time you calculate the worksheet.

1HVWHG�$UUD\V

An array element need not be a scalar. It’s possible to make an array element its
another array. This allows you to create arrays within arrays.

These arrays behave very much like arrays whose elements are all scalars. How
there are some distinctions, as described below.

1RWH Most of Mathcad’s operators and functions do not work with nested arrays, since there is
universally accepted definition of what constitutes correct behavior in this context. Certain
operators and functions are nevertheless useful and appropriate for nested arrays. Functio
enumerate rows or columns, or that partition, augment, and stack matrices, can be applie
nested arrays. The transpose, subscript, and column array operators and the Boolean eq
likewise support nested arrays.

'HILQLQJ�D�1HVWHG�$UUD\
You define a nested array in much the same way you would define any array. The only 
difference is that you cannot use the Matrix command from the Insert menu when 
you’ve selected a placeholder within an existing array. You can, however, click o
placeholder in an array and type the name of another array. Figure 11-11 shows sever
ways to define a nested array. Additional methods include using a file access fun
such as READPRN in the array of placeholders created using the Insert Matrix 
command, and using the programming operators in Mathcad Professional to bui
an array whose elements are themselves arrays.

1RWH The display of a nested array is controlled by Display Styles settings in the Result Format dialog 
box (see page 115). You can expand a nested array when the array is displayed in matrix form; 
otherwise, whenever an array element is itself an array, you see bracket notation showing the 
number of rows and columns rather than the array itself. If the nested array is displayed as an 
output table, you can see the underlying array temporarily. Click on the array element, then click 
with the right mouse button and choose Down One Level from the pop-up menu. Choose Up 
One Level from the pop-up menu to restore the array element to non-expanded form.
Nested Arrays 217



Figure 11-11: Defining nested arrays.
218  Chapter 11  Vectors, Matrices, and Data Arrays



&KDSWHU���
�'�3ORWV

t 2YHUYLHZ�RI��'�3ORWWLQJ

t *UDSKLQJ�)XQFWLRQV�DQG�([SUHVVLRQV

t 3ORWWLQJ�9HFWRUV�RI�'DWD

t )RUPDWWLQJ�D��'�3ORW

t 0RGLI\LQJ�<RXU��'�3ORW¶V�3HUVSHFWLYH�

2YHUYLHZ�RI��'�3ORWWLQJ

To visually represent a function or expression of a single variable or X-Y data in 
Mathcad, you can create a 2D plot. You can create either a Cartesian X-Y plot or a 
polar plot. A typical X-Y plot shows horizontal x-values versus vertical y-values, while 
a typical polar plot shows angular values, θ, versus radial values, r. Figure 12-1 shows 
several examples of 2D plots.

Figure 12-1: Examples of 2D plots.
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In general, to create an X-Y plot:

1. Click in your worksheet where you want the graph to appear. 

2. Choose Graph⇒X-Y Plot from the Insert menu 

or click  on the Graph toolbar. Alternatively, 
type [Shift] 2 or @. Mathcad inserts a blank X-
Y plot.

3. Fill in both the x-axis placeholder (bottom center) 
and the y-axis placeholder (left center) with a 
function, expression, or variable.

4. Click outside the plot or press [Enter].

Mathcad automatically chooses axis limits for you. If you want to specify the axis limits 
yourself, click in the plot and type over the numbers in the placeholders at the ends of 
the axes.

Mathcad creates the plot over a default range using default limits. See “Formatti
2D Plot” on page 229 for information on modifying these defaults.

1RWH If a point is complex, Mathcad does not graph it. To graph the real or imaginary part of a point 
or expression, use the Re and Im functions to extract the real and imaginary parts, respectively.

To resize a plot, click in the plot to select it. Then move the cursor to a handle a
the right or bottom edge of the plot until the cursor changes to a double-headed a
Hold the mouse button down and drag the mouse in the direction that you want 
plot’s dimension to change.

1RWH If some points in a function or expression are valid and others are not, Mathcad plots only the 
valid ones. If the points are not contiguous, Mathcad does not connect them with a line. You may 
therefore see a blank plot if none of the points are contiguous. To see the points, format the trace 
to have symbols. See “Formatting a 2D Plot” on page 229 for information on formatting tr

&UHDWLQJ�D�SRODU�SORW
In general, to create a polar plot:

1. Click in your worksheet where you want the graph to 
appear.

2. Choose Graph⇒Polar Plot from the Insert menu or 

click  on the Graph toolbar.

3. Fill in both the angular-axis placeholder (bottom 
center) and the radial-axis placeholder (left center) 
with a function, expression, or variable.

4. Click outside the plot or press [Enter].
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Mathcad creates the plot over a default range using default limits. See “Formatti
2D Plot” on page 229 for information on modifying these defaults.

The remaining sections in this chapter focus on plotting functions, expressions, 
data. Although the instructions and figures typically show X-Y plots, the instructio
apply to polar plots as well.

*UDSKLQJ�)XQFWLRQV�DQG�([SUHVVLRQV

�'�4XLFN3ORWV
A 2D QuickPlot is a plot created from an expression or function which represents
y-coordinates of the plot. With a QuickPlot, there is no need to define the independe
or x-axis variable.

To create an X-Y plot of a single expression or function:

1. Click in your worksheet where you want the graph to appear.

2. Enter the expression or function of a single variable you want 
to plot. Make sure the editing lines remain in the expression. 

3. Choose Graph⇒X-Y Plot from the Insert 

menu or click  on the Graph toolbar.

4. Click outside the graph or press [Enter].

Mathcad automatically produces a plot over a 
default domain for the independent variable, 
from –10 to 10.

To change the default domain for the
independent variable in a 2D QuickPlot, change the axis limits on the plot:

1. Click on the plot, and then click on one of the four axis limit placeholders loca
at the ends of the axes.

2. Type the value of the axis limit you want. There is no restriction on the values
can enter in these placeholders.

3. Click outside the graph or press [Enter] to see the updated graph.

'HILQLQJ�DQ�LQGHSHQGHQW�YDULDEOH
If you don’t want Mathcad to use a default range for the independent variable, you
define the independent variable as a range variable before creating the plot. For
example:

1. Define a range variable, such as x, that takes on the values you 
want to graph. The range variable need not be called x; you can 
use any valid name. See “Range Variables” on page 106.

2. Enter an expression or function you want to plot using that 
variable. Make sure the editing lines remain in the expression. 
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3. Choose Graph⇒X-Y Plot from the Insert menu or click  on the Graph toolbar.

4. Type the name of the variable into the x-axis placeholder.

5. Click outside the graph or press [Enter]. 

Mathcad graphs one point for every value of the 
range variable, and, unless you specify 
otherwise, connects each pair of points with a 
straight line.

7LS To override Mathcad’s choices for the axis limits on a plot, click in the plot and type over 
limits in the placeholders at the ends of the axes (see “Setting Axis Limits” on page 229).

�3ORWWLQJ�0XOWLSOH��'�&XUYHV�
You can graph several traces on the same X-Y or polar plot. A graph can show several 
y-axis (or radial) expressions against the same x-axis (or angular) expression. See Figure 
12-3. Or it can match up several y-axis (or radial) expressions with the corresponding 
number of x-axis (or angular) expressions. See Figure 12-2.

To create a QuickPlot containing more than one trace:

1. Enter the expressions or functions of a single variable 
you want to plot, separated by commas. Make sure the 
editing lines remain in the expression.

2. Choose Graph⇒X-Y Plot from the Insert 

menu or click  on the Graph toolbar.

3. Click outside the graph or press [Enter].

Mathcad produces a single graph containing 
plots of all the expressions or functions, over a 
default range for the independent variable(s), 
from –10 to 10. You can change the axis range 
by editing the upper and lower limits on the x-
axis as described in “Setting Axis Limits” on 
page 229.

1RWH In a QuickPlot with multiple traces, you need not use the same independent variable in every y-
axis (or radial-axis) expression. Mathcad will provide the appropriate corresponding variable in 
the x-axis (or angular-axis) placeholder.
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In general, to create a graph containing several independent curves:

1. Choose Graph⇒X-Y Plot from the Insert menu or click  on the Graph toolbar.

2. Enter two or more expressions separated by commas in the y-axis placeholder.

3. Enter the same number of expressions separated by commas in the x-axis 
placeholder.

Mathcad matches up the expressions in pairs—the first x-axis expression with first y-
axis expression, the second with the second, and so on. It then draws a trace fo
pair. Figure 12-2 shows an example.

1RWH All traces on a graph share the same axis limits. For each axis, all expressions and limits on that 
axis must have compatible units.

Figure 12-2: Graph with multiple expressions on both axes.

Figure 12-3: Graph with multiple y-axis expressions.
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A parametric plot is one in which a function or expression is plotted against another 
function or expression that uses the same independent variable. You can create either 
an X-Y or polar parametric plot.

To create an X-Y parametric plot:

1. Click in your worksheet where you want the graph to appear. 

2. Choose Graph⇒X-Y Plot from the Insert menu or click  on the Graph toolbar. 
Mathcad inserts a blank X-Y plot with empty placeholders.

3. In both the x-axis and y-axis placeholders, enter a function or expression.

4. Click outside the plot or press [Enter].

Mathcad produces a QuickPlot over a default range for the independent variable. Figure 
12-1 shows an example of a parametric plot.

If you don’t want Mathcad to use a default range for the plot, define the indepen
variable as a range variable before creating the plot. Mathcad graphs one point fo
value of the independent variable and connects each pair of points with a straigh
Figure 12-4 shows two functions of θ plotted against each other. The range variableθ 
was previously defined. For more information, see “Range Variables” on page 1

Figure 12-4: Graphing one function against another.
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To graph a vector of data, you can create either an X-Y plot or a polar plot. When 
creating either type of plot, you need to use the vector subscript (see “Vector and M
Operators” on page 133) to specify which elements to plot. Additionally, you can
Axum LE (see “Using Axum to Plot Data” on page 227) to create a 2D plot of yo
vectors or data. Some graphs of data vectors are shown in Figure 12-5.

3ORWWLQJ�D�VLQJOH�YHFWRU�RI�GDWD
To create an X-Y plot of a single vector of data:

1. Define a range variable, such as i, that references the subscript of each element
the vector you want to plot. For example, for a vector with 10 elements, your 
subscript range variable would be i := 0 .. 9.

2. Click in your worksheet where you want the graph to appear.

3. Choose Graph⇒X-Y Plot from the Insert menu or click  on the Graph toolbar
Mathcad inserts a blank X-Y plot.

4. Enter i in the bottom placeholder and the vector name with the subscript (  f

example) in the placeholder on the left. Type [ as a shortcut to create the subscrip

5. Click outside the graph or press [Enter].

1RWH Subscripts must be integers greater than or equal to ORIGIN. Τhis means that the x-axis or 
angular variable used in the graphs in Figure 12-5 can run through whole-number values only. 
If you want to graph fractional or negative values on the x-axis, graph a function or graph one 
vector against another, as described in the next section.

7LS If you have a handful of data points, you can use an input table to create a vector as shown in the 
second graph in Figure 12-5 or in Figure 12-7. For more information, see “Entering Data i
Table” on page 207.

Figure 12-5: Graphing a vector.
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To graph all the elements of one data vector against all the elements in another, enter 
the names of the vectors in the axis placeholders of an X-Y plot or polar plot.

For example, to create an X-Y plot of two data vectors x and y:

1. Define the vectors x and y.

2. Click in your worksheet where you want the graph to appear.

3. Choose Graph⇒X-Y Plot from the Insert menu, or click  on the Graph 
toolbar.

4. Enter in the y-axis placeholder and in the x-axis placeholder.

5. Click outside the graph or press [Enter].

Mathcad plots the elements in the vector x against the elements in the vector y. 

1RWH If the vectors being plotted are not the same length, Mathcad plots the number of elements in the 
shorter vector.

If you want to plot only certain vector elements, define a range variable and use it as a 
subscript on the vector names. In the example above, to plot the fifth through tenth 
elements of x and y against each other:

1. Define a range variable, such as k, going from 4 to 9 in increments of 1. (Note that 
the first elements of the vectors x and y are  and  by default.) 

2. Enter  and  in the axis placeholders.

1RWH If you have a set of data values to graph, create a vector by reading in data from a data file, by 
pasting in the data from the Clipboard, or by typing data directly into an input table. See Chapter 
11, “Vectors, Matrices, and Data Arrays.” See Figure 12-7 for an example showing the us
an input table.

Figure 12-6: Graphing two vectors.
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Included on your Mathcad CD is the application Axum LE. Axum LE is a version of 
Axum that features numerous 2D plot types, complete control over graph formatting, 
and a full set of annotation tools. Axum LE gives you fine control over every aspect of 
your 2D plots, and you can integrate these plots into your Mathcad worksheets.

There are two basic methods for integrating plots from Axum into your Mathcad 
worksheet. You can create a graph in Axum and insert it into your Mathcad worksheet 
as an object. Or, you can define data in your Mathcad worksheet, send it to Axum, and 
create a dynamic Axum graph directly in your Mathcad worksheet. Here are brief 
instructions for each method.

,QVHUWLQJ�DQ�$[XP�JUDSK�REMHFW

To insert an Axum graph object:

1. Create and save a graph in Axum. For more information about using Axum, see 
Axum’s on line Help.

2. In Mathcad, choose Object from the Insert menu. In the Insert Object dialog box
click Create from File, and browse for your saved Axum graph sheet. Once y
have selected your graph sheet, click OK.

3. The Axum graph appears into your Mathcad worksheet. If you check Link in 
Insert Object dialog, you may activate the plot from within your Mathcad 
worksheet, by double-clicking, and make changes to the original Axum graph

For more information about inserting objects, refer to “Chapter 6: Working with 
Graphics and Other Objects.”

Figure 12-7: Plotting vectors from input table data.
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To insert an Axum graph linked to data in your Mathcad worksheet:

1. In Mathcad, define the vector(s) of data you wish to plot.

2. Click in a blank spot in your worksheet. Be sure to click below or to the right of 
your vector(s) of data.

3. Choose Component from the Insert menu. Select Axum Graph from the list and 
click Next. Choose a plot type and specify as many input variables as you have data 
vectors. Click Finish.

4. A blank Axum graph appears in your Mathcad worksheet. Enter the name(s) of 
your data vector(s) in the placeholders in the bottom left corner of the graph. Click 
outside the graph or press [Enter].

If you change the vectors of data upon which your Axum graph component is 
dependent, your graph updates automatically. For more information about using 
components, refer to “Chapter 16: Advanced Computational Features.” Figure 1
shows an Axum graph that has been customized with axes labels, a title, and te
graphic annotations.

1RWH If you want to create an Axum graph component with multiple independent traces, define x- and 
y-vectors for each plot. Then, choose the plot type “Scatter Plots of XY Pairs” from the Ax
Graph dialog, and specify as many input variables as you have vectors of data. Enter the 
names in the placeholders in xy-pairs, i.e., (x1  y1  x2  y2  etc.)

Figure 12-8: An Axum graph in a Mathcad worksheet.
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When you create an X-Y plot or a polar plot, Mathcad uses the default settings to format 
the axes and traces. You can, however, reformat the axes and traces. You can also add 
titles and labels and control the default settings of the graph. 

To format a 2D graph:

1. Double-click the graph. Alternatively, 
click once on the graph and choose 
Graph⇒X-Y Plot or Graph⇒Polar 
Plot from the Format menu. You’ll 
see the dialog box for formatting a 
selected graph.

2. Click the tab for the page you want to 
work with. Use the Axes tab to 
determine the appearance of the axes 
and grid lines. Use the Traces tab to set 
the color, type, and width of the traces. 
Use the Labels tab to insert labels on 
the axes. Use the Defaults tab to 
specify the default appearance of your 
graphs.

3. Make the appropriate changes in the dialog box. 

4. Click Apply to see the effect of your changes without closing the dialog box. 

5. Close the dialog by clicking OK. 

1RWH In the Axes page, make sure you turn options on and off in the appropriate axis column. In the 
Traces page, click on a trace’s name in the Legend Label column and change characteris
clicking on the arrow beside each of the drop-down options.

7LS If you double-click an axis on a graph, you’ll see a formatting dialog box for that axis alon

2Q�OLQH�+HOS Click Help in the dialog box for details on particular formatting options.

6HWWLQJ�$[LV�/LPLWV
When you create a 2D graph, the Autoscale option is turned on. Use the Axes page of 
the plot formatting dialog box to turn Autoscale on or off:

• With Autoscale on, Mathcad automatically sets each axis limit to the first maj
tick mark beyond the end of the data. This is a reasonably round number larg
enough to display every point being graphed. 

• With Autoscale off, Mathcad automatically sets the axis limits exactly at the 
data limits. 
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You can override Mathcad’s automatic limits by entering limits directly on the gra
To do so:

1. Click the graph to select it. Mathcad displays four additional numbers, one by 
axis limit. These numbers are enclosed within corner symbols, as illustrated in
selected plot in Figure 12-9. 

2. Click on one of these numbers and type a number to replace it. Do the same f
other numbers if you want to change more than one limit.

3. Click outside the graph. Mathcad redraws it using the new axis limits you speci
The corner symbols below the limits you changed disappear. Figure 12-9 sho
the effect of manually setting limits on a graph.

6HWWLQJ�'HIDXOW�)RUPDWV
Mathcad uses default settings to format the axes and traces of new graphs you 

&RS\LQJ�'HIDXOWV�IURP�DQ�([LVWLQJ�*UDSK

One way to create a new set of defaults is to use the format settings of an existing 
The advantage of this method is that you can actually see how the format settings
as you define them.

Figure 12-9: Data limits set automatically and manually. 
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To use the format of a particular graph as 
the default graph format:   

1. Double-click the graph, or click in 
the graph and choose Graph⇒X-Y 
Plot (or Graph⇒Polar Plot) from 
the Format menu. Mathcad displays 
the dialog box for formatting a 
selected graph. 

2. Click the Defaults tab to see the 
Defaults page. 

3. Check Use for Defaults. When you 
click OK, to close the dialog box, 
Mathcad saves these settings as your 
default settings.

6HWWLQJ�'HIDXOWV�:LWKRXW�8VLQJ�D�*UDSK

You can use the Setting Default Formats dialog box to change default plot settings. To 
set defaults this way:

1. Make sure that you don’t have any graphs selected.

2. Choose Graph⇒X-Y Plot (or Graph⇒Polar Plot) from the Format menu. You’ll 
see the Setting Default Formats dialog box. 

3. Change the appropriate settings on the Axes and Traces pages.

4. Click OK to accept your changes and close the dialog box.

$GGLQJ�&XVWRP�7LWOHV��/DEHOV��DQG�2WKHU�$QQRWDWLRQV
One way to add titles and labels to your 2D graph is to use the options on the La
tab of the 2D Plot Format dialog box. A second way to add titles and labels, as w
annotations, is to create text or some other object in your worksheet and then m
on top of the graph.

To create an annotation for your 2D graph:

1. Create a text region, or insert a graphic object in your worksheet by pasting it 
by choosing Object from the Insert menu.

2. Drag the text or object onto your 2D graph and position it appropriately.

Figure 12-10 shows a graph containing both a text region (“inflection pt”) and a gra
object (an arrow).

1RWH If you choose Separate Regions from the Format menu, all overlapping regions in your 
worksheet will separate. In the case of annotated graph, such as the one shown above, all 
annotations move below the graph when you separate regions.
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Mathcad provides the following options for manipulating your 2D graph:

• You can zoom in on a portion of the graph.

• You can get the x- and y-coordinates for any point that was plotted to construct 
individual plot.

• You can get the x- and y-coordinates for any location within the graph.

=RRPLQJ�LQ�RQ�D�3ORW�
Mathcad allows you to select a region of a graph and magnify it. To zoom in on a po
of a graph, follow these steps:

1. Click in the graph and choose Graph⇒Zoom from 

the Format menu, or click  on the Graph toolbar. 
The Zoom dialog box appears. The X-Y Zoom dialog 
box is shown to the right. 

2. If necessary, reposition the Zoom dialog box so that 
you can see the entire region of the graph you want 
to zoom.

3. Click the mouse at one corner of the region in the graph you want to magnify

4. Press and hold down the mouse button and drag the mouse. A dashed selec
outline emerges from the anchor point. The coordinates of the selected regio
listed in the Min and Max text boxes (or the Radius text box of the Polar Zoo
dialog box).

Figure 12-10: Mathcad graph with annotations.
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5. When the selection outline just encloses the region you want to magnify, let go of 
the mouse button. If necessary, click on the selection outline, hold the mouse button 
down, and move the outline to another part of the graph.

6. Click Zoom to redraw the graph. The axis limits are temporarily set to the 
coordinates specified in the Zoom dialog box. To make these axis limits permanent, 
click OK.

7LS If you’re working with a graph that has already been zoomed, you can restore the default
appearance of the graph. To do so, click Full View in the Zoom dialog box. 

 

*HWWLQJ�D�5HDGRXW�RI�3ORW�&RRUGLQDWHV�
To see a readout of coordinates of the specific points that make up a trace, follow these 
steps:

1. Click in the graph and choose Graph⇒Trace from 

the Format menu, or click  on the Graph 
toolbar. The X-Y Trace dialog box appears as in the 
example at right. Check Track Data Points if it isn’t 
already checked. If necessary, reposition the Trace 
dialog box so that you can see the entire graph.

Figure 12-11: A zoomed-in region of an X-Y plot.
Modifying Your 2D Plot’s Perspective 233



2. Click and drag the mouse along the trace whose coordinates you want to see. A 
dotted crosshair jumps from one point to the next as you move the pointer along 
the trace.

3. If you release the mouse button, you can use the left and right arrows to move to 
the previous and next data points. Use the up and down arrows to select other traces.

4. As the pointer reaches each point on the trace, Mathcad displays the values of that 
point in the X-Value and Y-Value boxes (or the Radius and Angle boxes in the 
Polar Trace dialog box).

5. The values of the last point selected are shown in the boxes. The crosshair remains 
until you click outside the plot.

7LS When Track Data Points is unchecked in the Trace dialog box, you can see a readout of 
coordinates for any location in a graph, not just the data points that created an individual plot.

Figure 12-12 shows an example of a plot whose coordinates are being read.

To copy and paste a coordinate using the Clipboard:

1. Click Copy X or Copy Y (or Copy Radius or Copy Angle in the case of a polar plot).

2. You can then paste that value into a math or text region in your Mathcad worksheet, 
into a spreadsheet, or into any other application that allows pasting from the 
Clipboard.

Figure 12-12: Reading coordinates from a graph.
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2YHUYLHZ�RI��'�3ORWWLQJ

To visually represent in three dimensions a function of one or two variables or to plot 
data in the form of x-, y-, and z-coordinates, you can create a surface plot, a contour 
plot, a 3D bar plot, a 3D scatter plot, or a vector field plot. Create these different plot 
types using commands from the Insert menu or the 3D Plot Wizard. You can also place 
more than one 3D plot on the same graph. Mathcad renders 3D plots with sophisticated, 
high performance OpenGL graphics.

,QVHUWLQJ�D��'�3ORW
In general, to create a three-dimensional plot:

1. Define a function of two variables or a matrix of data.

2. Click in the worksheet where you want the plot to appear. Then choose Graph from 
the Insert menu and select a 3D plot. Alternatively, click one of the 3D graph 
buttons on the Graph toolbar. Mathcad inserts a blank 3D plot with axes and an 
empty placeholder.

3. Enter the name of the function or matrix in the placeholder.

4. Click outside the plot or press [Enter]. Mathcad creates the plot according to the 
function or matrix of data.

For example, the surface plot shown below was created 
in Mathcad from the function:
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When you create a 3D plot from a function, it’s 
called a QuickPlot. A QuickPlot uses default ranges 
and grids for the independent variables. To change 
these settings, double-click on the graph and use the 
QuickPlot Data page of the 3D Plot Format dialog. 
For more information on modifying these and other 
plot characteristics, see “Formatting a 3D Plot” on 
page 246.

To learn how to create a plot from a matrix of values, 
see the shown in Figure 13-2 on page 241.

�'�3ORW�:L]DUG
The 3D Plot Wizard gives you more control over the format settings of the plot as y
insert it. To use the Wizard:

1. Click in your worksheet wherever you want the graph to appear.

2. Choose Graph⇒3D Plot Wizard from the Insert menu. The first page of the 3D
Plot Wizard appears.

3. Select the type of three-dimensional graph you want to see and click “Next.”

4. Make your selections for the appearance and coloring of the plot on subsequ
pages of the Wizard. Click “Finish” and a graph region with a blank placehold
appears.

5. Enter appropriate arguments (a function name, data vectors, etc.) for the 3D
into the placeholder.

6. Click outside the plot or press [Enter].

The plot is created using the settings you specified in the Wizard. For informatio
modifying the appearance of your plot, see “Formatting a 3D Plot” on page 246.

&UHDWLQJ��'�3ORWV�RI�)XQFWLRQV

This section describes how to create various 3D plots from functions in Mathcad,
known as QuickPlots. Although the instructions focus on using commands on the Insert 
menu and changing settings through the 3D Plot Format dialog box, you can als
the 3D Plot Wizard, as described on page 236.

7LS To see a variety of two- and three-dimensional functions and data sets visualized in plots, open 
the “Practical Curves and Surfaces” section of QuickSheets in the Mathcad Resource Ce
(choose Resource Center from the Help menu and click on “QuickSheets”). 
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You can visualize any function of two variables as a surface, bar, contour, or scatter 
plot in three dimensions.

6WHS����'HILQH�D�IXQFWLRQ�RU�VHW�RI�IXQFWLRQV

First, define the function in your worksheet in any one of the following forms:

F(x,y) is a function of two variables. In this type of function, the x- and y-coordinates 
of the plot vary, by default, from –5 to 5 with a step size of 0.5. Each z-coordinate is 
determined by the function using these x- and y-values.

G(u,v) is a vector-valued function of two variables. In this type of function, the 
independent variables u and v vary, by default, from –5 to 5 with a step size of 0.5. Th
x-, y-, and z-coordinates are plotted parametrically according to the definitions in 
three elements of the vector using these u- and v-values.

X(u,v), Y(u,v), and Z(u,v) are functions of two variables. In this type of function triple
the independent variables u and v vary, by default, from –5 to 5 with a step size of 0.5
The x-, y-, and z-coordinates are plotted parametrically according to the three func
definitions using these u- and v-values.

1RWH The function descriptions above assume that you are working in Cartesian coordinates. If your 
function represents spherical or cylindrical, rather than Cartesian, coordinates, you can 
automatically convert the function to Cartesian coordinates. Double-click on the plot, go to the 
QuickPlot Data page of the 3D Plot Format dialog box, and click “Spherical” or “Cylindrica
under Coordinate System.

6WHS����,QVHUW�D��'�SORW

After you define a function or set of functions to plot, choose Graph from the Insert 
menu and select a 3D plot type.

For example, to create a surface plot from the functions X, Y, and Z, defined above:

1. Choose Graph⇒Surface Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad inserts a blank 3D plot.

2. Enter the name of the functions in the placeholder. When you have 
more than one function definition for a single surface, separate the 
function names by commas and enclose the function names in paren-
theses. For this example, type:
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3. Press [Enter] or click outside the plot.

To change your plot to a different plot type:

1. Double-click on the graph to bring up the 3D Plot Format dialog box.

2. In the Display As section on the General tab, select Bar Plot, Contour Plot, or Data 
Points from the array of plot types.

3. Click “OK.”

Figure 13-1 shows a 3D scatter plot created from the function G, and a contour p
created from the function F, both defined above:

1RWH All 3D QuickPlots are parametric curves or surfaces. In other words, all QuickPlots are created 
from three vectors or matrices of data representing the x-, y-, and z-coordinates of the plot. In the 
case of a single function of two variables, Mathcad internally creates two matrices of x- and y-
data over the default range -5 to 5 with a step size of 0.5, and then generates z-data using these 
x- and y-coordinates.

Figure 13-1: A scatter plot and a contour plot created from functions of two 
variables.
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To change the default ranges and grids for the independent variables, double-click on 
the graph and use the QuickPlot Data page of the 3D Plot Format dialog. For more 
information on modifying these and other plot characteristics, see “Formatting a 
Plot” on page 246.

&UHDWLQJ�D�6SDFH�&XUYH
You can visualize any parametrically-defined function of one variable as a scatter
in three dimensions.

6WHS����'HILQH�D�IXQFWLRQ�RU�VHW�RI�IXQFWLRQV

First, define the function in your worksheet in one of the following forms:

H(u) is a vector-valued function of one variable. In this type of function, the indepen
variable u varies, by default, from –5 to 5 with a step size of 0.5. The x-, y-, and z-
coordinates of the plot are determined by the functions in each element of the ve
using these u-values.

R(u), S(u), and T(u) are functions of one variable. In this type of function triple, the
independent variable u varies, by default, from –5 to 5 with a step size of 0.5. The x-, 
y-, and z-coordinates are plotted according to the function definitions using theseu-
values.

1RWH A space curve often represents the path of a particle in motion through space where u is a time 
parameter.

6WHS����,QVHUW�D��'�VFDWWHU�SORW

To create a space curve from a single function or set of functions:

1. Choose Graph⇒3D Scatter Plot from the Insert menu or click   on the Graph
toolbar. Mathcad inserts a blank 3D plot.

2. Enter the name of function or functions in the placeholder. When you 
have more than one function definition, separate the function names 
by commas and enclose the function names in parentheses. To create 
a space curve from the functions R, S, and T, defined above, type:
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3. Press [Enter] or click outside the plot.

For general information on formatting 3D plots, refer to “Formatting a 3D Plot” on
page 246. For specific information on formatting a scatter plot, refer to the topic “Sc
Plots” in the on-line Help.

&UHDWLQJ��'�3ORWV�RI�'DWD

This section describes how to create various 3D plots from data in Mathcad. Altho
the instructions focus on using commands on the Insert menu and changing settings 
through the 3D Plot Format dialog, you can also use the 3D Plot Wizard, as desc
on page 236.

&UHDWLQJ�D�6XUIDFH��%DU��RU�6FDWWHU�3ORW
Surface, bar, and scatter plots are useful for visualizing two-dimensional data cont
in an array as either a connected surface, bars above and below the zero plane, o
in space.

For example, to create a surface plot from data:

1. Create or import a matrix of values to plot. The row and column numbers repre
the x- and y-coordinate values. The matrix elements themselves are the z-coordinate 
values plotted as heights above and below the xy-plane (at z = 0).

2. Choose Graph⇒Surface Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad inserts a blank 3D plot.

3. Enter the name of the matrix in the placeholder.

4. Press [Enter] or click outside the plot. Figure 13-2 shows a 3D bar plot creat
from a matrix, M:

In the default perspective, the first row of the matrix extends from the back left co
of the grid to the right, while the first column extends from the back left corner ou
toward the viewer. See “Formatting a 3D Plot” on page 246 to learn how to change
default view.
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A parametric surface plot is created by passing three matrices representing the x-, y-, 
and z- coordinates of your points in space to the surface plot.

To create a parametric surface plot:

1. Create or import three matrices having the same number of rows and columns.

2. Choose Graph⇒Surface Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad inserts a blank 3D plot.

3. Type the names of the three matrices separated by commas and enclosed in 
parentheses in the placeholder. For example:

(X, Y, Z)

4. Press [Enter] or click outside the plot.

Figure 13-3 shows a parametric surface plot created from the matrices, X, Y, and Z, 
defined above the plot.

1RWH The underlying parameter space is a rectangular sheet covered by a uniform mesh. In effect, the 
three matrices map this sheet into three-dimensional space. For example, the matrices X, Y, and 
Z defined in Figure 13-3 carry out a mapping that rolls the sheet into a tube and then joins the 
ends of the tube to form a torus.

For general information on formatting 3D plots, refer to “Formatting a 3D Plot” on
page 246. For specific information on formatting a parametric surface plot, refer to
topic “Surface Plots” in the on-line Help.

Figure 13-2: Defining a matrix of data and plotting it as a 3D bar plot.
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&UHDWLQJ�D�7KUHH�GLPHQVLRQDO�3DUDPHWULF�&XUYH
A three-dimensional parametric curve is created by passing three vectors representing 
the x-, y-, and z-coordinates of your points in space to the surface plot. 

To create a three-dimensional parametric curve:

1. Create or import three vectors having the same number of rows.

2. Choose Graph⇒Scatter Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad inserts a blank 3D plot.

3. Type the names of the three vectors separated by commas and enclosed in paren-
theses in the placeholder. For example:

(X, Y, Z)

4. Press [Enter] or click outside the plot.

Figure 13-4 shows a three-dimensional parametric curve created from the vectors, P, 
Q, and R, defined above the plot:

For general information on formatting 3D plots, refer to “Formatting a 3D Plot” on
page 246. For specific information on formatting a scatter plot, refer to the topic “Sc
Plots” in the on-line Help.

Figure 13-3: Defining data for a parametric surface plot.
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&UHDWLQJ�D�&RQWRXU�3ORW
To view three-dimensional data as a two-dimensional contour map, you can create a 
contour plot:

1. Define or import a matrix of values to plot. 

2. Choose Graph⇒Contour Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad shows a blank plot with a single placeholder.

3. Type the name of the matrix in the placeholder. 

4. Press [Enter] or click outside the plot.

Figure 13-5 shows a contour plot created from the matrix, C, defined above the plot:

The contour plot is a visual representation of the matrix’s level curves. Mathcad 
assumes that the rows and columns represent equally spaced intervals on the ax
then linearly interpolates the values of this matrix to form level curves or contour
Each level curve is formed such that no two cross. By default, the z-contours are shown 
on the x-y plane. Mathcad plots the matrix such that the element in row 0 and col
0 is in the lower left corner. Thus the rows of the matrix correspond to values on tx-
axis, increasing to the right, and the columns correspond to values along the y-axis, 
increasing toward the top. 

For general information on formatting 3D plots, refer to “Formatting a 3D Plot” on
page 246. For specific information on formatting a contour plot, refer to the topic
“Contour Plots” in the on-line Help.

1RWH If you create a contour plot of a function as described above, the positive x-axis of the plot 
extends to the right and the positive y-axis extends toward the top of the plot.

Figure 13-4: Defining data for a space curve.
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In a vector field plot, each point in the x-y plane is assigned a two-dimensional vector. 
There are two ways to set up the data needed for a vector field plot:

1. Create a matrix of complex numbers in which the following conditions exist:

• The row and column numbers represent the x- and y-coordinates

• The real part of each matrix element is the x-component of the vector associated
with that row and column

• The imaginary part of each element is the y-component of the vector associated 
with that row and column.

2. Create two matrices having the same number of rows and columns. The first m
should have the x-components of the vectors, the second the y-components.

Once you have defined your data, as described above, to create a vector field p

1. Choose Graph⇒Vector Field Plot from the Insert menu or click  on the 
Graph toolbar. 

2. Type the name(s) of the matrix or matrices in the placeholder. If you have m
than one matrix for a vector field plot, separate the matrix names by commas
enclose the matrix name set in parentheses. For example:

(X, Y)

3. Press [Enter] or click outside the plot.

Figure 13-5: Defining data for a contour plot.
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Figure 13-6 shows a vector field plot created from the matrix, Q, defined above 
the plot:

For general information on formatting 3D plots, refer to “Formatting a 3D Plot.” F
specific information on formatting a vector field plot, refer to the topic “Vector fie
plots” in the on-line Help.

*UDSKLQJ�0XOWLSOH��'�3ORWV
Just as you can plot more than one trace on a two-dimensional graph, you can p
more than one surface, curve, contour, bar, or scatter plot on a three-dimensional

For example, to create a 3D graph with a contour plot and a surface plot:

1. Define two functions of two variables or any combination of two acceptable 
argument sets for a 3D plot (two matrices, two sets of three vectors, etc.).

2. Choose Graph⇒Contour Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad inserts a blank 3D plot.

3. Enter the name of the function or matrix for the contour plot into the placehol
Then type , (a comma).

4. Enter the name of the function or matrix for the surface plot.

5. Press [Enter] or click outside the plot. You see two contour plots. 

6. Double-click the graph to bring up the 3D Plot Format dialog box. In the Disp
As section of the General tab, click the tab labeled Plot 2 and select Surface
the array of plot types. Click “OK.”

Figure 13-6: Defining data for a vector field plot.
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Both the contour plot and the surface plot, with default format settings, appear in a 
single graph.

7LS As a general rule, you will not want to create a 3D graph with more than two or three plots 
together since they may obscure each other and make the graph difficult to interpret.

)RUPDWWLQJ�D��'�3ORW

A three-dimensional plot’s default appearance depends on how you insert it. Whe
choose Graph⇒3D Plot Wizard from the Insert menu, you make selections in the 
pages of the Wizard that determine a plot’s appearance. When you insert a plot 
choosing a plot type from the Insert menu, however, the plot automatically acquire
default characteristics. 

You can change the appearance of any 3D plot after it is inserted. To do so, you
the many options available in the 3D Plot Format dialog box. For example, you ca
the options to change a plot’s color, format the axes, add backplanes, and forma
lines or points.

Figure 13-7:  Two plots, one contour and one surface, shown on the
same graph.
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To bring up the 3D Plot Format dialog box:

1. Click once on the plot to select 
it and choose Graph⇒3D Plot 
from the Format menu. Alter-
natively, double-click the plot 
itself. Mathcad brings up the 3D 
Plot Format dialog box. The 
General page is shown at right. 
The remaining tabs take you to 
additional pages.

2. Click the tab for the page you 
want to work with.

3. Make the appropriate changes 
in the dialog box.

4. Click Apply to see the effect of your changes without closing the dialog box. 

5. Close the dialog by clicking OK. 

7KH��'�3ORW�)RUPDW�'LDORJ�%R[
The tabs in the 3D Plot Format dialog box bring you to pages containing options for 
formatting various aspects of a three-dimensional plot. Some options available on 
certain pages in the dialog box depend on the kind of plot you are formatting. Options 
on other pages are available for any three-dimensional graph. 

• The General page gives you access to basic options that control the overall 
appearance of the graph. Use these options to control the position of a plot, s
axis style, draw a border or a box, or convert a plot to another type.

• The options on the Axes page allow you to control exactly how each axis looks
You can specify the weight of each axis and whether it has numbers or tick ma
You can also specify the axis limits. Use the tabs at the top of the page to for
the x-, y-, or z-axis. 

• The Backplanes page has options for specifying whether a backplane is filled w
a color, has a border, or has grid lines or tick marks. Use the tabs at the top o
page to format the xy-, yz-, or xz-backplane.

1RWH Both the Backplanes page and the Axes page have options for setting and formatting grid lines. 
When you set the grid lines for an axis on the Axes tab, you set them for the two backplanes 
shared by the axis. When you set the grid lines on the Backplanes tab, you set them for one 
backplane only.
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• Use the options on the Appearance page to format the surfaces, lines, and poin
that make up a plot. For example, you can apply color directly to a plot’s surf
its contours, or its lines and points. The following sections discuss how to con
the surfaces, lines, and points of a plot.

• The Lighting page options control both the overall lighting of the plot as well 
individual lights directed onto it. See “Lighting” on page 253 for more informati
on lighting.

• The Title page provides a text box for entering a title for the graph and options
specifying the location of the title on the graph.

• The Special page allows you to control options related to specific kinds of plot
For example, the Bar Plot Layout options let you specify the way the bars are
arranged in a 3D bar plot.

• The Advanced page has options used only when you need very fine control o
the appearance of a plot, such as the vertical scale.

• The QuickPlot Data page contains the range and grid settings for the independ
variables that control a 3D QuickPlot. Additionally, you can specify whether yo
function(s) are in Cartesian, spherical, or cylindrical coordinates.

2Q�OLQH�+HOS For details on the options available on a particular page in the 3D Plot Format dialog box, click 
the Help button at the bottom of the dialog box.

Some options in the 3D Plot Format dialog box work together to control the appear
of a plot. For example, the choices on the Appearance page, the Lighting page, a
Special and Advanced pages together control the color of a plot.

1RWH When you format a graph containing more than one plot (using Mathcad Professional), as 
described in “Graphing Multiple 3D Plots” on page 245, some options in the 3D Plot Form
dialog box apply to an entire graph while others apply to individual plots. For example, all
options on the Axes, Backplanes, and Lighting pages are for the graph as a whole: each 
the graph uses common axes, backplanes, and lighting. However, options on the Appeara
are specific to each plot on the graph. That is, each plot can be filled with its own color, ha
own lines drawn, etc. The tabs labeled Plot 1, Plot 2, etc. control the settings for individual 

)LOO�&RORU
The color of a plot is primarily determined by its fill color. This section describes the 
ways to apply color to a plot by filling its surfaces or contours. A plot’s color and 
shading are also affected by lighting, as described in more detail in page 253.

Mathcad allows you to apply either a solid color or a colormap to the surface or con
of a plot. A solid color is useful when you don’t want to overcomplicate a plot wit
many colors or when you want to use lighting to shade a plot. A colormap applie
array of color to a plot according to its coordinates. 
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1RWH Mathcad comes with a variety of colormaps for applying rainbow colors and shades of gray, red, 
green, and blue. You can also create and load custom colormaps in Mathcad Professional by 
using the SaveColormap and LoadColormap functions, described on page 202. By default, a 
colormap is applied in the direction of the z-values, or according to the height of the plot. You 
can apply the colormap in the direction of the x-values or y-values by clicking the Advanced tab 
and choosing a direction in the Colormap section. For more information, see on-line Help.

)LOOLQJ�WKH�6XUIDFH

The options on the Appearance page of the 3D Plot Format dialog box allow you to fill 
the plot’s surface with a solid color or a colormap. For example, to color the bars
3D bar plot according to a colormap:

1. Double-click the graph to bring 
up the 3D Plot Format dialog 
box.

2. Click the Appearance tab. 

3. Click both Fill Surface in Fill 
Options and Colormap in Color 
Options.

4. Click Apply to preview the 
plot. Click OK to close the dia-
log box.

Figure 13-8 shows an example.

Figure 13-8: Filling the surface or contours of a plot.
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The plot is shaded using the default colormap “Rainbow.” To choose a different 
colormap, click the Advanced tab of the 3D Plot Format dialog box and select a 
colormap from the Choose Colormap drop-down menu.

If you wanted to fill the bars of the plot with a solid color, choose Solid Color inste
of Colormap and click the color box next to Solid Color to select a color.

)LOOLQJ�&RQWRXUV

When you format a surface plot, you can choose Fill Contours instead of Fill Sur
in the Fill Options section of the Appearance page. If you fill the contours of a sur
plot, the plot is filled according to its contours rather than directly by its data. You 
fill according to the x-, y-, or z-contours or two at the same time. For a contour plot
you must choose Fill Contours instead of Fill Surface to fill the contours of the pl

For example, to fill a contour plot with color:

1. Double-click the graph to bring up the tabbed dialog box.

2. Click the Appearance tab. 

3. In the Fill Options section, click Fill Contours.

4. Click Apply to preview the plot. Click OK to close the dialog box.

The plot is shaded using the default colormap Rainbow. To choose a different color
click the Advanced tab of the 3D Plot Format dialog box and select a colormap f
the Choose Colormap drop-down menu.

1RWH If you have a contour plot projected on a plane other than the x-y plane, you can fill the contour 
using options on the Special page of the 3D Plot Format dialog box. To do so, click the Special 
tab, then choose a contour direction from the drop-down menu. Click Fill for each contour you 
want to color. For example, if you have Fill checked for the z-contours and x-contours, you will 
see contour color on both the x-y backplane and the y-z backplane. 

/LQHV
Mathcad provides many ways to control the appearance of the lines on a three-
dimensional plot. You can draw the lines so they form a wireframe, or you can d
only the contour lines. You can also control the weight and color of the lines on a

'UDZLQJ�D�:LUHIUDPH

To control whether lines form a wireframe on a plot, use the options on the Appear
page of the 3D Plot Format dialog box. For example, to remove the wireframe o
surface plot as shown in Figure 13-9:

1. Double-click the graph to bring up the tabbed dialog box.

2. Click the Appearance tab. 

3. In the Line Options section, click No Lines.

4. Click Apply to preview the plot. Click OK to close the dialog box.

To turn lines on again later, choose Wireframe on the Appearance page.
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When you format a surface plot, you can choose Contour instead of Wireframe in the 
Line Options section of the Appearance page. Contour lines are those drawn according 
to the contours of a surface. You can draw either the x-, y-, or z- contour lines, two of 
these contours lines, or all three.

1RWH For contour plots, Mathcad always chooses Contour instead of Wireframe to draw contour lines. 

For example, to draw lines showing the x-contours of a surface plot:

1. Double-click the graph to bring up the tabbed dialog box.

2. Click the Appearance tab. 

3. Click Contour in the Line Options section. 

4. Click the Special tab.

5. Verify that Z-Contours is selected in the drop-down menu at the bottom of the 
Contour Options section. Click Draw Lines to remove the check mark. This turns 
lines off for the z-contours. 

6. Choose Z-Contours from the drop-down menu on the Special page.

7. Check Draw Lines.

8. Click Apply to preview the plot. Click OK to close the dialog box.

The surface plot is drawn with contour lines perpendicular to the z-axis, as shown in 
Figure 13-9.

Figure 13-9: A wireframe vs. contour lines on a surface plot.
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1RWH When you format a contour plot on a multi-plot graph (see page 236), the options in the drop-
down menu on the Special tab determine on which backplane the contour lines are drawn. For 
example, if you have Draw Lines checked for the z-contours and x-contours, you will see contour 
lines on both the x-y backplane and the y-z backplane. 

/LQH�&RORU

You can control the color of the lines in a plot using the color options in the Line Options 
section of the Appearance page. Just as you can fill a plot’s surface with a colorm
a solid color, described on page 249, you can also apply a colormap or solid col
the lines in a plot.

For example, to make the lines of a contour plot orange:

1. Double-click the graph to bring up the tabbed dialog box.

2. Click the Appearance tab. 

3. In the Line Options section, click Contour to draw contour lines and Solid Co

4. Click the color box next to Solid Color, click the orange box, and click OK.

5. Click Apply to preview the plot. Click OK to close the dialog box.

3RLQWV
You can draw and format points on most three-dimensional plots, since all 3D p
are constructed from discrete data points. (The exceptions are vector field plots, co
plots, bar plots, and patch plots.) Points are most useful, however, on a 3D scatte
in which points are the main focus of the plot. Mathcad allows you to control the sym
used for the points in a plot as well as the color and size of the symbol.

To draw or remove points on a surface plot:

1. Double-click the graph to bring up the 3D Plot Format dialog box.

2. Click the Appearance tab.

3. In the Points Options section, check (or uncheck) Draw Points.

4. Click Apply to preview the plot. Click OK to close the dialog box.

To format the symbol, color, and size of the points on your 3D scatter plot using
Points Options section of the Appearance tab:

• Choose a Symbol from the drop-down list to change the symbol displayed.

• Use the arrows next to Size to increase or decrease the size of the symbol.

• Click the color box next to Solid Color and choose a hue from the color palette
click Colormap to change the coloring of the symbols.
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The color of a three-dimensional plot is a result of color you use to fill its surface, lines, 
and points as well as the color of any ambient light or directed lights shining on it. This 
behavior is identical to the effect of light on object color in the real world. Objects 
reflect and absorb light depending on their color. For example, a yellow ball reflects 
mostly yellow light and absorbs others, and it can look grayish under dim lighting, 
green under blue lighting, and bright yellow in bright lighting.

You can fill a plot’s surfaces, contours, lines, and points with either a solid color 
colormap using the options on the Appearance and Advanced pages of the 3D P
Format dialog box. 

Light is controlled using the options on the Lighting page of the 3D Plot Format dia
box. If you are content to fill a plot with a colormap, you may not need to use ligh
at all. However, if you want to shade the plot differently, or if you fill the plot with
solid color and want to shade it, you can enable lighting.

1RWH If your 3D graph contains multiple plots, lighting affects all the plots in a graph, but you can fill 
individual plots with color independently.

1RWH If you want lighting to be the sole determinant of the color of a plot, use the Appearance page 
options in the 3D Plot Format dialog box to fill the plot with solid white.

To enable lighting:

1. Double-click the plot to open the tabbed dialog box.

2. Click the Lighting tab.

3. Check Enable Lighting in the Lighting section.

Figure 13-10: A white surface plot with lighting enabled.
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4. Click the options on tabs labeled Light 1, Light 2, etc. to enable a directed light and 
set its color and location. Mathcad lets you set up to eight directed lights.

5. Click the Ambient Light Color box to set the ambient light color. Note that black 
corresponds to no ambient light.

6. Click Apply to preview the plot. Click OK to close the dialog box.

2Q�OLQH�+HOS For details on the options available on the Lighting page, click the Help button at the bottom of 
the dialog box. For additional information on lighting, see “Advanced Topics” under Overv
and Tutorial in the Mathcad Resource Center.

&KDQJLQJ�2QH��'�3ORW�WR�$QRWKHU
You can change almost any three-dimensional plot into another kind of three-
dimensional plot by using the Display As options on the General tab in the 3D Plot 
Format dialog box. Simply select another available 3D plot type and click Apply or 
OK to change the plot instantaneously to another type. Figure 13-11 shows the same 
matrix displayed as three different plot types.

1RWH Some three-dimensional plots cannot be converted to other forms. For example, you can
convert a vector field plot into any other kind of plot. If a plot cannot be converted to anot
kind of plot, that plot type is grayed in the 3D Plot Format dialog box.

$QQRWDWLRQV
In addition to adding a title to your three-dimensional plot by using options on the Title 
page of the 3D Plot Format dialog box, you can annotate a three-dimensional plot by 
placing text or bitmaps anywhere on it. This allows you to label or highlight any part 
of the plot that you wish.

To add a text annotation to a three-dimensional plot:

1. Create a text region in your worksheet using the methods described in Chapter 5, 
“Working with Text.” 

2. Drag the text region from its location in your worksheet and drop it directly on
the plot. See “Moving and Copying Regions” on page 10 for more on dragging
dropping regions.

You can select the text annotation on your plot to reposition it. To edit a text annot
on a plot, select the text and drag it off the plot to your worksheet. You can now 
the text region. Then drag the text region back onto the plot.

7LS You can drag a bitmap image from your Mathcad worksheet onto a three-dimensional plot just 
as you drag and drop text annotations. To place a bitmap you created in another application onto 
a three-dimensional plot, copy the bitmap from the other application to the Clipboard, click on 
the plot with the right mouse button, and choose Paste Special from the pop-up menu.
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When you create a 3D QuickPlot, as described on page 236, you can change the range 
and step size of each independent variable by using the settings on the QuickPlot Data 
page of the 3D Plot Format dialog box.

To change the range of either independent variable:

1. Set the start and end values of either range using the text boxes for each range.

2. Click Apply to keep the dialog box open. Click OK to close the dialog box.

Figure 13-11:  The same data displayed in several different 3D plots.
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To change the step size, the number of grids generated along each variable’s ax
between the start and end values:

1. Use the arrows next to # of Grids for each range to increase or decrease the
value. Alternatively, you can type in a value in the text box.

2. Click Apply to keep the dialog box open. Click OK to close the dialog box.

1RWH The ranges you set for the independent variables in the QuickPlot Data page do not necessarily 
control the axis limits of the plot, unless you are plotting a single function of two variables in 
Cartesian coordinates. In all other cases, the axis limits are determined by the x-, y-, and z-data 
generated for the QuickPlot by your function(s).

To perform automatic coordinate system conversions on your QuickPlot data:

1. Click the radio button under Coordinate System corresponding the coordinat
system of the function you are plotting.

2. Click Apply to keep the dialog box open. Click OK to close the dialog box.

5RWDWLQJ�DQG�=RRPLQJ�RQ��'�3ORWV

You can resize a three-dimensional plot using the same methods you use to resi
graph region in Mathcad. Click on it and use the handles that appear along the e
to drag out the edges. Mathcad provides several additional options for manipula
the presentation of your 3D plot:

• You can rotate the plot to see it from a different perspective.

• You can set the plot in motion about an axis of rotation so that it spins continuo

• You can zoom in or out on a portion of the plot.

1RWH When you rotate, spin, or zoom a three-dimensional plot, any visible axes move or resize 
themselves with the plot. Text or graphic annotations you add to the plot (see page 254) remain 
anchored at their original sizes and positions.

5RWDWLQJ�D�3ORW
You can rotate a plot interactively with the mouse or by specifying parameters in
3D Plot Format dialog box.

To rotate a three-dimensional plot interactively by using the mouse:

1. Click in the plot, and hold the mouse button down.

2. Drag the mouse in the direction you want the plot to turn.

3. Release the mouse button when the plot is in the desired position.
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To rotate a three-dimensional plot by using the 3D Plot Format dialog box:

1. Click once on the plot to select it and choose Graph⇒3D Plot from the Format 
menu. Alternatively, double-click the plot.

2. Click the General tab.

3. Edit the settings for Rotation, Tilt, and Twist in the View options.

4. Click Apply to preview the plot. Click OK to close the dialog box.

6SLQQLQJ�D�3ORW
You can set a plot in motion so that it spins continuously about an axis of rotation:

1. Click in the plot, and hold the [Shift] key and the mouse button down.

2. Drag the mouse in the direction you want the plot to spin.

3. Release the mouse button to set the plot in motion.

 The plot spins continuously until you click again inside the plot.

1RWH If you make changes to equations that affect a plot, the plot recomputes even when it is spinning!

7LS To create an AVI file of a spinning plot, see the techniques in “Animation” on page 124.

=RRPLQJ�D�3ORW
You can zoom in or out of a plot interactively or by specifying a zoom factor in the 3D 
Plot Format dialog box.

To zoom in on a three-dimensional plot by using the mouse:

1. Click in the plot, and hold the [Ctrl] key and the mouse button down.

2. Drag the mouse toward the top of the plot to zoom out, or drag the mouse toward 
the bottom to zoom in.

3. Release the mouse button when the plot is at the desired zoom factor.

7LS If you use an IntelliMouse-compatible mouse with a center wheel, you can rotate the whe
zoom in or out of a three-dimensional plot.
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To zoom in or out of a three-dimensional plot by using the 3D Plot Format dialog box:

1. Click once on the plot to select it and choose Graph⇒3D Plot from the Format 
menu. Alternatively, double-click the plot.

2. Click the General tab.

3. Edit the Zoom setting in the View options.

4. Click Apply to preview the plot. Click OK to close the dialog box.
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Elsewhere in this User’s Guide, you’ve seen Mathcad engaging in numeric calculations. 
This means that whenever you evaluate an expression, Mathcad returns one or 
numbers, as shown at the top of Figure 14-1. When Mathcad engages in symbolic 
mathematics, however, the result of evaluating an expression is generally anoth
expression, as shown in the bottom of Figure 14-1. 

Figure 14-1: A numeric and symbolic evaluation of the same expression.
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There are three ways to perform a symbolic transformation on an expression.

• You can use the symbolic equal sign as described in “Live Symbolic Evaluat
on page 260. This method feels very much as if you’re engaging in numeric m
If you need more control over the symbolic transformation, you can use keywords 
with the symbolic equal sign.

• You can use commands from the Symbolics menu. See “Using the Symbolics 
Menu” on page 269.

• You can make the numeric and symbolic processors work together, the latte
simplifying an expression behind the scenes so that the former can work with
more efficiently. This is discussed in “Symbolic Optimization” on page 280.

1RWH For a computer, symbolic operations are, in general, much more difficult than the corresponding 
numeric operations. In fact, many complicated functions and deceptively simple-looking 
functions have no closed-forms as integrals or roots.

/LYH�6\PEROLF�(YDOXDWLRQ�

The symbolic equal sign provides a way to extend Mathcad’s live document inter
beyond the numeric evaluation of expressions. You can think of it as being analo
to the equal sign “=.” Unlike the equal sign, which always gives a numeric result
the right-hand side, the symbolic equal sign is capable of returning expressions. You 
can use it to symbolically evaluate expressions, variables, functions, or program

To use the symbolic equal sign:

1. Make sure that Automatic Calculation on the Math menu has a check beside it.
If it doesn’t, choose it from the menu.

2. Enter the expression you want to evaluate.

3. Click  on the Symbolic toolbar or press [Ctrl]. 
(the Control key followed by a period). Mathcad 
displays a symbolic equal sign, “→.”

4. Click outside the expression. Mathcad displays a 
simplified version of the original expression. If an 
expression cannot be simplified further, Mathcad 
simply repeats it to the right of the symbolic equal sign.

The symbolic equal sign is a live operator just like any Mathcad operator. When
make a change anywhere above or to the left of it, Mathcad updates the result. T
symbolic equal sign “knows” about previously defined functions and variables and 
them wherever appropriate. You can force the symbolic equal sign to ignore prio
definitions of functions and variables by defining them recursively just before you
evaluate them, as shown in Figure 14-6 on page 269.
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Figure 14-2 shows some examples of how to use the symbolic equal sign, “→.” 

1RWH The symbolic equal sign, “→,” applies to an entire expression. You cannot use the symbolic
equal sign to transform only part of an expression. 

7LS Figure 14-2 also illustrates the fact that the symbolic processor treats numbers containing
decimal point differently from numbers without a decimal point. When you send numbers 
decimal points to the symbolic processor, any numeric results you get back are decimal 
approximations to the exact answer. Otherwise, any numeric results you get back are exp
without decimal points whenever possible. 

&XVWRPL]LQJ�WKH�6\PEROLF�(TXDO�6LJQ�8VLQJ�.H\ZRUGV���������������������������������������������
The “→” takes the left-hand side and places a simplified version of it on the right-h
side. Of course, exactly what “simplify” means is a matter of opinion. You can, to
limited extent, control how the “→” transforms the expression by using one of the 
symbolic keywords.

Figure 14-2: Using the symbolic equal sign.
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 To do so:

1. Enter the expression you want to evaluate.

2. Click  on the Symbolic toolbar or press [Ctrl] 
[Shift]. (Press the Control and Shift keys and type a 
period.) Mathcad displays a placeholder to the left of the symbolic equal sign, “→.”

3. Click on the placeholder to the left of the symbolic equal sign 
and type any of the keywords from the following table. If the 
keyword requires any additional arguments, separate the 
arguments from the keyword with commas.

4. Press [Enter] to see the result.

7LS Another way to use a keyword is to enter the expression you want to evaluate and click on a 
keyword button from the Symbolic toolbar. This inserts the keyword, placeholders for any 
additional arguments, and the symbolic equal sign, “→.” Just press [Enter] to see the result.

.H\ZRUG )XQFWLRQ

complex Carries out symbolic evaluation in the complex domain. Result 
is usually in the form .

float,m Displays a floating point value with m places of precision 
whenever possible. If the argument m, an integer, is omitted, the 
precision is 20. 

simplify Simplifies an expression by performing arithmetic, canceling 
common factors, and using basic trigonometric and inverse 
function identities.

expand,expr Expands all powers and products of sums in an expression except 
for the subexpression expr. The argument expr is optional. The 
entire expression is expanded if the argument expr is omitted. 

If the expression is a fraction, expands the numerator and writes 
the expression as a sum of fractions. Expands sines, cosines, and 
tangents of sums of variables or integer multiples of variables as 
far as possible into expressions involving only sines and cosines 
of single variables.

a i b⋅+

1 m 250≤ ≤
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factor,expr Factors an expression into a product, if the entire expression can 
be written as a product. Factors with respect to expr, a single 
radical or a list of radicals separated by commas. The argument 
expr is optional. 

Usually factors a single variable into powers of primes. 
Otherwise, attempts to convert the expression into a product of 
simpler functions. Combines a sum of fractions into a single 
fraction and often simplifies a complex fraction with more than 
one fraction bar.

solve,var Solves an equation for the variable var or solves a system of 
equations for the variables in a vector var. 

collect,
var1,...,varn

Collects like terms with respect to the variables or 
subexpressions var1 through varn. 

coeffs,var Finds coefficients of an expression when it is rewritten as a 
polynomial in the variable or subexpression var. 

substitute,
var1=var2

Replaces all occurrences of a variable var1 with an expression or 
variable var2. Press [Ctrl]= for the bold equal sign.

series,
var=z,m

Expands an expression in one or more variables, var, around the 
point z. The order of expansion is m. Arguments z and m are 
optional. By default, the expansion is taken around zero and is a 
polynomial of order six. By default, finds Taylor series (series in 
nonnegative powers of the variable) for functions that are 
analytic at 0 and Laurent series for functions that have a pole of 
finite order at 0. 

convert,
parfrac,var

Converts an expression to a partial fraction expansion in var, the 
variable in the denominator of the expression on which to 
convert. Usually factors the denominator of the expression into 
linear or quadratic factors having integer coefficients and 
expands the expression into a sum of fractions with these factors 
as denominators. 

fourier,var Evaluates the Fourier transform of an expression with respect to 
the variable var. Result is a function of ω given by:

where f(t) is the expression to be transformed.

invfourier,var Evaluates the inverse Fourier transform of an expression with 
respect to the variable var. Result is a function of t given by:

where F(ω) is the expression to be transformed. 

f t( )e i– ω t td
∞–

 ∞+

∫

1
2π
------ F ω( )eiωt ωd

∞–

 ∞+

∫

Live Symbolic Evaluation 263



Many of the keywords take at least one additional argument, typically the name of a 
variable with respect to which you are performing the symbolic operation. Some of the 
arguments are optional. See Figure 14-3 and Figure 14-4 for examples.

1RWH Keywords are case sensitive and must therefore be typed exactly as shown. Unlike variables, 
however, they are not font sensitive. 

laplace,var Evaluates the Laplace transform of an expression with respect to 
the variable var. Result is a function of s given by:

where f(t) is the expression to be transformed.

invlaplace,var Evaluates the inverse Laplace transform of an expression with 
respect to the variable var. Result is a function of t given by:

where F(s) is the expression to be transformed and all 
singularities of F(s) are to the left of the line .

ztrans,var Evaluates the z-transform of an expression with respect to the 
variable var. Result is a function of z given by:

where f(n) is the expression to be transformed.

invztrans,var Evaluates the inverse z-transform of an expression with respect 
to the variable var. Result is a function of n given by a contour 
integral around the origin:

where F(z) is the expression to be transformed and C is a contour 
enclosing all singularities of the integrand. 

assume
constraint

Imposes constraints on one or more variables according to the 
expression constraint.

f t( )e st– td
0

 ∞+
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Figure 14-3: Using keywords with a symbolic evaluation sign.

Figure 14-4: Evaluating expressions symbolically.
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Some keywords take additional modifiers that specify the kind of symbolic evaluation 
even further.

To use a modifier, separate it from its keyword with a comma. For example, to use the 
“assume=real” modifier with the simplify keyword on an expression:

1. Enter the expression to simplify.

2. Click  on the Symbolic toolbar or press [Ctrl] [Shift]. (hold down the 
Control and Shift keys and type a period). Mathcad displays a placeholder to
left of the symbolic equal sign, “→.”

3. Enter simplify,assume=real into the placeholder (press [Ctrl]= for the 
equal sign).

4. Press [Enter] to see the result.

0RGLILHUV�IRU�³DVVXPH´

0RGLILHUV�IRU�³VLPSOLI\´�

Figure 14-5 shows some examples using the simplify keyword with and without 
additional modifiers.

7LS Keyword modifiers can be typed or inserted from the buttons on the Modifier toolbar.

var=real Evaluates the expression on the assumption that the variablevar 
is real.

var=
RealRange(a,b)

Evaluates on the assumption that all the indeterminates are 
and are between a and b, where a and b are real numbers or 
infinity ([Ctrl][Shift]Z).

assume=real Simplifies on the assumption that all the indeterminates in th
expression are real.

assume=
RealRange(a,b)

Simplifies on the assumption that all the indeterminates are r
and are between a and b, where a and b are real numbers or 
infinity ([Ctrl][Shift]Z).

trig Simplifies a trigonometric expression by applying only the 
following identities:

It does not simplify the expression by simplifying logs, power
or radicals.

x( )sin
2

x( )cos
2

+ 1=

x( )cosh
2

x( )sinh
2

– 1=
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In some cases, you may want to perform two or more types of symbolic evaluation 
consecutively on an expression. Mathcad allows you to apply several symbolic key-
words to a single expression. There are two ways of applying multiple keywords. The 
method you choose depends on whether you want to see the results from each keyword 
or only the final result.

To apply several keywords and see the results from each:

1. Enter the expression you want to evaluate.

2. Press  on the Symbolic toolbar or type 
[Ctrl] [Shift]. (Hold down the Control 
and Shift keys and type a period.) Mathcad displays a placeholder to the left of the 
symbolic equal sign, “→.”

3. Enter the first keyword into the placeholder to 
the left of the symbolic equal sign, including 
any comma-delimited arguments the keyword 
takes.

4. Press [Enter] to see the result from the first 
keyword.

Figure 14-5: Modifiers such as “assume=real” allow you to control simpli-
fication.
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5. Click on the result and press [Ctrl] 
[Shift]. again. The first result disappears 
temporarily. Enter a second keyword and any 
modifiers into the placeholder. 

6. Press [Enter] to see 
the result from the 
second keyword.

Continue applying keywords to the intermediate results in this manner.

To apply several keywords and see only the final result:

1. Enter the expression you want to evaluate.

2. Click  on the Symbolic toolbar or press 
[Ctrl] [Shift]. so that Mathcad displays a 
placeholder to the left of the symbolic equal sign, “→.”

3. Enter the first keyword into the placeholder, 
including any comma-delimited arguments it 
takes.

4. Press [Ctrl] [Shift]. again and enter a 
second keyword into the placeholder. The 
second keyword is placed immediately below 
the first keyword.

5. Continue adding keywords by pressing [Ctrl] 
[Shift]. after each one. Press [Enter] to 
see the final result.

,JQRULQJ�3UHYLRXV�'HILQLWLRQV
When you use the symbolic equal sign to evaluate an expression, Mathcad chec
the variables and functions making up that expression to see if they’ve been def
earlier in the worksheet. If Mathcad does find a definition, it uses it. Any other varia
and functions are evaluated symbolically. 

There are two exceptions to this. In evaluating an expression made up of previo
defined variables and functions, Mathcad ignores prior definitions:

• When the variable has been defined recursively. 

• When the variable has been defined as a range variable. 

These exceptions are illustrated in Figure 14-6.

1RWH Although Mathcad does not evaluate range variables symbolically, it does symbolically evaluate 
any vectors or matrices that you define using range variables.
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One advantage to using the symbolic equal sign, sometimes together with keywords 
and modifiers as discussed in the last section, is that it is “live,” just like the num
processing in Mathcad. That is, Mathcad checks all the variables and functions m
up the expression being evaluated to see if they’ve been defined earlier in the work
If Mathcad does find a definition, it uses it. Any other variables and functions are
evaluated symbolically. Later on, whenever you make a change to the workshee
results automatically update. This is useful when the symbolic and numeric equa
in the worksheet are tied together.

There may be times, however, when a symbolic calculation is quite separate from
rest of your worksheet and does not need to be tied to any previous definitions. In
cases, you can use commands from the Symbolics menu. These commands are not live
you apply them on a case by case basis to selected expressions, they do not “kn
about previous definitions, and they do not automatically update. 

The commands on the Symbolics menu perform the same manipulations as many o
the keywords listed on page 261. For example, the Symbolics menu command 
Polynomial Coefficients evaluates an expression just as the keyword coeffs does. 
The only differences are that the menu command does not recognize previous 
definitions and does not automatically update.

The basic steps for using the Symbolics menu are the same for all the menu comman

1. Place whatever math expression you want to evaluate between the two editing lines. 
You can drag-select a part of the expression to place it between the editing l

2. Choose the appropriate command from the Symbolics menu. Mathcad then places
the evaluated expression into your document.

Figure 14-6: Defining a variable in terms of itself makes the symbolic 
processor ignore previous definitions of that variable.
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For example, to evaluate an expression symbolically using the Symbolics menu, follow 
these steps:

1. Enter the expression you want to evaluate.

2. Surround the expression with the editing lines.

3. Choose Evaluate⇒Symbolically from the Symbolics menu. 
Mathcad places the evaluated expression into your worksheet. The 
location of the result in relation to the original expression depends 
on the Evaluation Style you’ve selected (see “Displaying Symbolic Results” o
page 270). 

Some commands on the Symbolics menu require that you click on or select the variab
of interest rather than select the entire expression. If a menu command is unava
try selecting a single variable rather than an entire expression.

7LS Since the commands on the Symbolics menu operate only on the part of the expression currently 
selected by the editing lines, they are useful when you want to address parts of an expression. 
For example, if evaluating or simplifying the entire expression doesn’t give the answer yo
want, try selecting a subexpression and choose a command from the Symbolics menu. 

/RQJ�5HVXOWV�
Symbolic calculations can easily produce results so long that they don’t fit convenie
in your window. If you obtain a symbolic result consisting of several terms by us
commands on the Symbolics menu, you can reformat such a result by using Mathca
“Addition with line break” operator (see “Operators” on page 447).

Sometimes, a symbolic result is so long that you can’t conveniently display it in y
worksheet. When this happens, Mathcad asks if you want the result placed in th
Clipboard. If you click “OK,” Mathcad places a string representing the result on t
Clipboard. When you examine the contents of the clipboard, you’ll see a result wr
in a Fortran-like syntax. See the topic “Special functions and syntax used in Sym
results” in the on-line Help for more information on this syntax.

'LVSOD\LQJ�6\PEROLF�5HVXOWV�
If you’re using the symbolic equal sign, “→,” the result of a symbolic transformation
always goes to the right of the “→.” However, when you use the Symbolics menu, you 
can tell Mathcad to place the symbolic results in one of the following ways:

• The symbolic result can go below the original expression. 

• The symbolic result can go to the right of the original expression. 

• The symbolic result can simply replace the original expression. 
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In addition, you can choose whether you want Mathcad to generate text describing what 
had to be done to get from the original expression to the symbolic result. This text goes 
between the original expression and the symbolic result, creating a narrative for the 
symbolic evaluation. These text regions are referred to as “evaluation comments

To control both the placement of the symbolic result and the presence of narrative
choose Evaluation Style from the Symbolics menu to bring up the “Evaluation Style”
dialog box. 

([DPSOHV�RI�6\PEROLF�&DOFXODWLRQ

Just as you can carry out a variety of numeric calculations in Mathcad, you can 
out all kinds of symbolic calculations. As a general rule, any expression involving
variables, functions, and operators can be evaluated symbolically using either th
symbolic equal sign or the menu commands, as described earlier in this chapter

7LS When deciding whether to use the symbolic equal sign or menu commands from the Symbolics 
menu, remember that unlike the keyword-modified expressions, expressions modified by 
commands from the Symbolics menu do not update automatically, as described in the section 
“Using the Symbolics Menu” on page 269.

This section describes how to symbolically evaluate definite and indefinite integrals, 
derivatives, and limits. It also covers how to symbolically transpose, invert, and find 
the determinant of a matrix. Finally, this section describes how to perform symbolic 
transforms and solve equations symbolically. Keep in mind that these are just a few of 
the calculations you can perform symbolically.

1RWH Functions and variables you define yourself are recognized by the symbolic processor whe
use the symbolic equal sign. They are not, however, recognized when you use the Symbolics 
menu commands. Figure 14-7 shows the difference.

'HULYDWLYHV�
To evaluate a derivative symbolically, you can use Mathcad’s derivative operator
the live symbolic equal sign as shown in Figure 14-8:

1. Click    on the Calculus toolbar or type ? to insert the derivative operator. 

Alternatively, click  on the Calculus toolbar or type [Ctrl]? to insert the nth 
order derivative operator.

2. Enter the expression you want to differentiate and the variable with respect to w
you are differentiating in the placeholders. 

3. Click  on the Symbolic toolbar or press [Ctrl]. (the Control key followed by 
a period). Mathcad displays a symbolic equal sign, “→.”

4. Press [Enter] to see the result.
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Figure 14-9 shows you how to differentiate an expression without using the derivative 
operator. The Symbolics menu command Variable⇒Differentiate differentiates an 

expression with respect to a selected variable. For example, to differentiate  
with respect to x: 

Figure 14-7: The symbolic processor recognizes certain built-in functions. 
Functions and variables you define yourself are only recognized when you 
use the symbolic equal sign.

Figure 14-8: Evaluating integrals and derivatives symbolically.

2 x2⋅ y+
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1. Enter the expression.

2. Click on or select the x. 

3. Choose Variable⇒Differentiate from the Symbolics menu. Mathcad displays the 
derivative, . Note that y is treated as a constant.

If the expression in which you’ve selected a variable is one element of an array, Ma
differentiates only that array element. To differentiate an entire array, differentiate 
element individually: select a variable in that element and choose 
Variable⇒Differentiate from the Symbolics menu.

7LS Be sure to select a variable in an expression before choosing from the Symbolics menu. 
Otherwise, the Variable⇒Differentiate menu command is not available. 

,QWHJUDOV����
To symbolically evaluate a definite or indefinite integral:

1. Click  or  on the Calculus toolbar to insert the definite or indefinite integ
operator.

2. Fill in the placeholder for the integrand and, if applicable, the placeholders fo
limits of integration.

3. Place the integration variable in the placeholder next to the “d.” This can be any 
variable name.

Figure 14-9: Differentiating and integrating with menu commands.

4 x⋅
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4. Click  on the Symbolic toolbar or press [Ctrl]. (the Control key followed by 
a period). Mathcad displays a symbolic equal sign, “→.”

5. Press [Enter] to see the result.

See Figure 14-8 for examples of integrals evaluated symbolically.

When evaluating a definite integral, the symbolic processor attempts to find an 
indefinite integral of your integrand before substituting the limits you specified. If 
symbolic integration succeeds and the limits of integration are integers, fractions
exact constants like π, you get an exact value for your integral. If the symbolic proces
can’t find a closed form for the integral, you’ll see an appropriate error message

Another way to integrate an expression indefinitely is to enter the expression and
on the variable of integration. Then choose Variable⇒Integrate from the Symbolics 
menu. See Figure 14-9 for an example. Be sure to select a variable in an expres
before choosing from the Symbolics menu. Otherwise, the Variable⇒Integrate menu 
command is unavailable. 

7LS When you apply the Variable⇒Integrate command on the Symbolics menu, the expression 
you select should not usually include the integral operator. You should select only an expression 
to integrate. If you include the integral operator in the selected expression, you are taking a 
double integral.

/LPLWV
Mathcad provides three limit operators. These can only be evaluated symbolicall
use the limit operators:

1. Click    on the Calculus toolbar or press [Ctrl]L to insert the limit operator. 

To insert the operator for a limit from the left or right, click    or  on the 
Calculus toolbar or press [Ctrl][Shift]B or [Ctrl][Shift]A.

2. Enter the expression in the placeholder to the right of the “lim.”

3. Enter the limiting variable in the left-hand placeholder below the “lim.”

4. Enter the limiting value in the right-hand placeholder below the “lim.”

5. Click  on the Symbolic toolbar or press [Ctrl]. (the Control key followed by 
a period). Mathcad displays a symbolic equal sign, “→.”

6. Press [Enter] to see the result.

Mathcad returns a result for the limit. If the limit does not exist, Mathcad returns 
error message. Figure 14-10 shows some examples of evaluating limits.
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To solve an equation symbolically for a variable, use the keyword solve:

1. Type the equation. Make sure you click  on the Boolean toolbar or type 
[Ctrl]= to create the bold equal sign.

1RWH When solving for the root of an expression, there is no need to set the expression equal to zero. 
See Figure 14-11 for an example.

2. Click  on the Symbolic toolbar or type [Ctrl] [Shift]. (hold down the 
Control and Shift keys and type a period). Mathcad displays a placeholder to the 
left of the symbolic equal sign, “→.”

3. Type solve in the placeholder, followed by a comma and the variable for whi
to solve.

4. Press [Enter] to see the result.

Mathcad solves for the variable and inserts the result to the right of the “→.” Note that 
if the variable was squared in the original equation, you may get two results back when 
you solve. Mathcad displays these in a vector. Figure 14-11 shows an example.

7LS Another way to solve for a variable is to enter the equation, click on the variable you want to 
solve for in the equation, and choose Variable⇒Solve from the Symbolics menu.

Figure 14-10: Evaluating limits.
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One way to symbolically solve a system of equations is to use the same solve keyword 
used to solve one equation in one unknown. To solve a system of n equations for n 
unknowns:

1. Press  on the Matrix toolbar or type [Ctrl]M to insert a vector having n rows 
and 1 column.

2. Fill in each placeholder of the vector with one of the n equations making up the 

system. Make sure you click  on the Boolean toolbar or type [Ctrl]= to enter 
the bold equal sign.

3. Press  on the Symbolic toolbar or type [Ctrl] [Shift]. (hold down the 
Control and Shift keys and type a period). Mathcad displays a placeholder to the 
left of the symbolic equal sign, “→.”

4. Type solve followed by a comma in the placeholder.

5. Type [Ctrl]M or press  on the Matrix toolbar to create a vector having n rows 
and 1 column. Then enter the variables you are solving for.

6. Press [Enter] to see the result. 

Mathcad displays the n solutions to the system of equations to the right of the symbo
equal sign. Figure 14-12 shows an example.

Figure 14-11: Solving equations, solving inequalities, and finding roots.
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Another way to solve a system of equations symbolically is to use a solve block, similar 
to the numeric solve blocks described in “Solving and Optimization Functions” on p
166: 

1. Type the word Given. This tells Mathcad that what follows is a system of equatio
You can type Given in any combination of upper- and lowercase letters and in a
font. Just be sure you don’t type it while in a text region.

2. Now enter the equations in any order below the word Given. Make sure that for 

every equation you click  on the Boolean toolbar or type [Ctrl]= to insert the 
bold equal sign for each equation.

3. Enter the Find function with arguments appropriate for your system of equatio
This function is described in “Linear/Nonlinear System Solving and Optimizatio
on page 167.

4. Click  on the Symbolic toolbar or press [Ctrl]. (the Control key followed by 
a period). Mathcad displays the symbolic equal sign.

5. Click outside the Find function or press [Enter]. 

Mathcad displays the solutions to the system of equations to the right of the sym
equal sign. Figure 14-12 shows an example.

Most of the guidelines for solve blocks described in “Linear/Nonlinear System Solv
and Optimization” on page 167 apply to the symbolic solution of systems of equat
The main difference is that when you solve equations symbolically, you do not e
guess values for the solutions.

Figure 14-12: Two methods for solving a system of equations symbolically.
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You can use Mathcad to find the symbolic transpose, inverse, or determinant of a matrix 
using a built-in operator and the symbolic equal sign. To find the transpose of a matrix, 
for example:

1. Place the entire matrix between the two editing lines by clicking [Space] one or 
more times.

2. Click  on the Matrix toolbar or press [Ctrl] | to insert the matrix transpose 
operator.

3. Click  on the Symbolic toolbar or press [Ctrl]. (the Control key followed by 
a period). Mathcad displays the symbolic equal sign, “→.”

4. Press [Enter] to see the result.

Mathcad returns the result to the right of the “→.” Figure 14-13 shows some examples

Another way to find the transpose, inverse, or determinant of a matrix is to use t
Matrix commands on the Symbolics menu. For example, to find the transpose of a
matrix:

1. Place the entire matrix between the two editing lines by pressing [Space] one or 
more times.

2. Choose Matrix⇒Transpose from the Symbolics menu.

Unlike matrices evaluated with the symbolic equal sign, matrices modified by 
commands from the Symbolics menu do not update automatically, as described in t
section “Using the Symbolics Menu” on page 269.

Figure 14-13: Symbolic matrix operations.
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You can use symbolic keywords to evaluate the Fourier, Laplace, or z- transform of a 
expression and to evaluate the inverse transform. For example, to evaluate the Fourier 
transform of an expression:

1. Enter the expression you want to transform.

2. Click  on the Symbolic toolbar or type [Ctrl] [Shift]. (hold down the 
Control and Shift keys and type a period). Mathcad displays a placeholder to the 
left of the symbolic equal sign, “→.”

3. Type fourier in the placeholder, followed by a comma and the name of the
transform variable.

4. Press [Enter] to see the result. 

1RWH Mathcad returns a function in a variable commonly used for the transform you perform. If the 
expression you are transforming already contains this variable, Mathcad avoids ambiguity by 
returning a function of a double variable. For example, Mathcad returns a function in the variable 
ω when you perform a Fourier transform. If the expression you are transforming already contains 
an ω, Mathcad returns a function of the variable ωω instead. 

The Fourier transform result is a function of ω given by: 

Use the keyword invfourier to return the inverse Fourier transform as a functio
given by:

where f(t) and F(ω) are the expressions to be transformed. 

Use the keywords laplace, invlaplace, ztrans, and invztrans to perform 
a Laplace or z-transform or their inverses.

The Laplace transform result is a function of s given by:

Its inverse is given by:

where f(t) and F(s) are the expressions to be transformed. All singularities of F(s) are 
to the left of the line .
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The z-transform result is a function of z given by:

Its inverse is given by:

where f(n) and F(z) are the expressions to be transformed and C is a contour enclosing 
all singularities of the integrand.

7LS You can substitute a different variable for the one Mathcad returns from a transform or its 
inverse by using the substitute keyword. 

Another way to evaluate the Fourier, Laplace, or z- transform or their inverses on an 
expression is to use commands on the Symbolics menu. For example, to find the 
Laplace transform of an expression:

• Enter the expression.

• Click on the transform variable.

• Choose Transform⇒Laplace from the Symbolics menu.

Keep in mind that, unlike keyword-modified expressions, expressions modified b
commands from the Symbolics menu do not update automatically, as described in t
section “Using the Symbolics Menu” on page 269.

1RWH Results from symbolic transformations may contain functions that are recognized by Math
symbolic processor but not by its numeric processor. An example is the function Dirac shown 
in the middle of Figure 14-14. You’ll find numeric definitions for this and other such functio
in “Special Functions” on page 486 in the Appendices as well as in the Resource Center 
QuickSheet titled “Special Functions.”

6\PEROLF�2SWLPL]DWLRQ

In general, Mathcad’s symbolic and numeric processors don’t communicate with
another. You can, however, make the numeric processor ask the symbolic proce
for advice before starting what could be a needlessly complicated calculation. 

For example, if you were to evaluate an expression such as:

Mathcad would undertake the task of evaluating a numeric approximation of the t
integral even though one could arrive at an exact solution by first performing a fe
elementary calculus operations. 

This happens because by itself, Mathcad’s numeric processor does not simplify b
plunging ahead into the calculation. Although Mathcad’s symbolic processor kno
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all about simplifying complicated expressions, these two processors do not consult with 
each other, although for certain definitions, it would be helpful. To make these two 
processors talk to each other for a particular definition click on a definition with the 
right mouse button and choose Optimize from the pop-up menu.

Once you’ve done this, Mathcad’s live symbolic processor simplifies the expressio
the right of a “:=” before the numeric processor begins its calculations. This helps
Mathcad’s numeric processor evaluate the expression more quickly. It can also 
any computational issues inherent in the numeric calculation.

If Mathcad finds a simpler form for the expression, it responds by doing the follow

• It marks the region with a red asterisk. 

• It internally replaces what you’ve typed with a simplified form. 

• The equivalent expression is evaluated instead of the expression you specifie
see this equivalent expression, double-click the red asterisk beside the regio

If Mathcad is unable to find a simpler form for the expression, it places a blue asterisk 
next to it.

In the previous example, the symbolic processor would examine the triple integra
return the equivalent, but much simpler expression:

Figure 14-14: Performing symbolic transforms.

1
3
--- w3vu wv3u wvu3+ +( )
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Then it uses any definitions that exist in your worksheet and simplifies the expression 
further. To see this expression in a pop-up window, click the red asterisk with the right 
mouse button and choose Show Popup from the pop-up menu (see Figure 14-15). 

To enable optimization for an entire worksheet, choose Optimization from the Math 
menu. To disable optimization for an expression, right-click it and uncheck Optimize 
on the pop-up menu. Mathcad evaluates the expression exactly as you typed it. 

To disable optimization for all expressions, remove the check from Optimization on 
the Math menu. 

Figure 14-15: A pop-up window showing the equivalent expression that 
Mathcad actually evaluates.
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A Mathcad program is a special kind of expression you can 
create in Mathcad Professional. It’s an expression made up of a 
sequence of statements created using programming operators, 

available on the Programming toolbar. Click  on the Math 
toolbar, or choose Toolbars⇒Programming from the View 
menu, to open the Programming toolbar.

You can think of a program as a compound expression that 
involves potentially many programming operators. Like any expression, a progra
returns a value—a scalar, vector, array, nested array, or string—when followed b
equal sign or the symbolic equal sign. Just as you can define a variable or functi
terms of an expression, you can also define them in terms of a program.

The following example shows how to make a simple program to define the funct

Although the example chosen is simple enough not to require programming, it 
illustrates how to separate the statements that make up a program and how to u
local assignment operator, “←.” 

f x w,( ) x
w
---- 

 log=
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1. Type the left side of the function definition, followed by a 
“:=”. Make sure the placeholder is selected.

2. Click  on the Programming toolbar. Alternatively, press 
]. You’ll see a vertical bar with two placeholders, which will 
hold the statements that comprise your program.

3. Click in the top placeholder. Type z, then click  on the 
Programming toolbar. Alternatively, press { to insert a “←,” 
which is also known as the local definition symbol.

4. Type x/w in the placeholder to the right of the local definition 
symbol. Then press [Tab] to move to the bottom placeholder, 
or click on the bottom placeholder.

5. Enter the value to be returned by the program in the remaining 
placeholder. Type log(z).

You can now use this function just as you would any other function 
in your worksheet.

1RWH You cannot use Mathcad’s usual assignment operator, “:=,” inside a program. You must u
local assignment operator, represented by “←,” instead. Variables defined inside a program wit
the local assignment operator, such as z in the example above, are local to the program and a
undefined elsewhere in the worksheet. However, within a program, you can refer to Math
variables and functions defined previously in the worksheet.

Figure 15-1 shows a more complex example involving the quadratic formula. Although 
you can define the quadratic formula with a single statement as shown in the top half 
of the figure, you may find it easier to define it with a series of simple statements as 
shown in the bottom half. 

Figure 15-1: A more complex function defined in terms of both an expression 
and a program.
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7LS A program can have any number of statements. To add a statement, click  on the 
Programming toolbar or press [. Mathcad inserts a placeholder below whatever statement 
you’ve selected. To delete the placeholder, click on it and press [Bksp].

As with any expression, a Mathcad program must have a value. This value is simply 
the value of the last statement executed by the program. It can be a string expression, 
a single number, or an array of numbers. It can even be an array of arrays (see “N
Arrays” on page 217).

You can also write a Mathcad program to return a symbolic expression. When you 
evaluate a program using the symbolic equal sign, “→,” described in Chapter 14, 
“Symbolic Calculation,” Mathcad passes the expression to its symbolic processor
when possible, returns a simplified symbolic expression. You can use Mathcad’s a
to evaluate programs symbolically to generate complicated symbolic expression
polynomials, and matrices. Figure 15-2 shows a function that, when evaluated 
symbolically, generates symbolic polynomials. 

1RWH Programs that include the return and on error statements, described on page 290 and 
page 292, cannot be evaluated symbolically since the symbolic processor does not recognize 
these operators.

2Q�OLQH�+HOS For programming examples, see the “Programming” section in the Resource Center 
QuickSheets. The Resource Center also includes a special section, “The Treasury Guide
Programming,” which provides detailed examples and applications of Mathcad programs

Figure 15-2: Using a Mathcad program to generate a symbolic expression.
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In general, Mathcad evaluates each statement in your program from the top down. There 
may be times, however, when you want Mathcad to evaluate a statement only when a 
particular condition is met. You can do this by including an if statement.

For example, suppose you want to define a function that forms a semicircle around the 
origin but is otherwise constant. To do this:

1. Type the left side of the function definition, followed by 
a “:=”. Make sure the placeholder is selected.

2. Click  on the Programming toolbar. 
Alternatively, press ]. You’ll see a vertical bar with two 
placeholders. These placeholders will hold the 
statements making up your program.

3. Click  on the Programming toolbar in the top 
placeholder. Alternatively, press }. Do not type “if.”

4. Enter a Boolean expression in the right placeholder 
using one of the relational operators on the Boolean 
toolbar. In the left placeholder, type the value you want 
the program to return whenever the expression in the 
right placeholder is true. If necessary, add more placeholders by clicking 

5. Select the remaining placeholder and click  on 
the Programming toolbar or press [Ctrl] 3.

6. Type the value you want the program to return if the 
condition in the first statement is false. 

Figure 15-3 shows a plot of this function.

Figure 15-3: Using the if statement to define a piecewise continuous function.
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1RWH The if statement in a Mathcad program is not the same as the if function (see “Piecewise 
Continuous Functions” on page 155). Although it is not hard to define a simple program u
the if function, as shown in Figure 15-3, the if function can become unwieldy as the number o
branches exceeds two. 

/RRSLQJ

One of the greatest strengths of programmability is the ability to execute a sequence of 
statements repeatedly in a loop. Mathcad provides two loop structures. The choice of 
which loop to use depends on how you plan to tell the loop to stop executing.

• If you know exactly how many times you want a loop to execute, use a for loop. 

• If you want the loop to stop when a condition has been met, but you don’t kn
how many loops will be required, use a while loop.

7LS See “Controlling Program Execution” on page 289 for methods to interrupt calculation wit
the body of a loop.

³)RU´�/RRSV
A for loop terminates after a predetermined number of iterations. Iteration is controlled 
by an iteration variable defined at the top of the loop. The definition of the iteration 
variable is local to the program.

To create a for loop:

1. Click  on the Programming toolbar or press [Ctrl] “ . Do 
not type the word “for.” 

2. Type the name of the iteration variable in the placeholder to the 
left of the “∈.” 

3. Enter the range of values the iteration variable should take in the 
placeholder to the right of the “∈.” You usually specify this range 
the same way you would for a range variable (see page 106). 

4. Type the expression you want to evaluate in the remaining 
placeholder. This expression generally involves the iteration 
variable. If necessary, add placeholders by clicking  on the 
Programming toolbar.

The upper half of Figure 15-4 shows this for loop being used to add a sequence of integers. 
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1RWH Although the expression to the right of the “∈” is usually a range, it can also be a vector or a li
of scalars, ranges, and vectors separated by commas. The lower half of Figure 15-4 show
example in which the iteration variable is defined as the elements of two vectors. 

³:KLOH´�/RRSV
A while loop is driven by the truth of some condition. Because of this, you don’t n
to know in advance how many times the loop will execute. It is important, howeve
have a statement somewhere, either within the loop or elsewhere in the program
eventually makes the condition false. Otherwise, the loop executes indefinitely.

To create a while loop:

1. Click  on the Programming toolbar or press [Ctrl] ]. 
Do not type the word “while.”

2. Click in the top placeholder and type a condition. This is 
typically a Boolean expression like the one shown.

3. Type the expression you want evaluated in the remaining 
placeholder. If necessary, add placeholders by clicking 

 on the Programming toolbar.

Figure 15-5 shows a larger program incorporating the above loop. 
Upon encountering a while loop, Mathcad checks the condition. If the condition is
true, Mathcad executes the body of the loop and checks the condition again. If t
condition is false, Mathcad exits the loop.

Figure 15-4: Using a for loop with two different kinds of iteration variables.
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The Programming toolbar in Mathcad Professional includes three statements for 
controlling program execution:

• Use the break statement within a for or while loop to interrupt the loop when a 
condition occurs and move execution to the next statement outside the loop.

• Use the continue statement within a for or while loop to interrupt the current 
iteration and force program execution to continue with the next iteration of the l

• Use the return statement to stop a program and return a particular value from wi
the program rather than from the last statement evaluated. 

7KH�³%UHDN´�6WDWHPHQW
It is often useful to break out of a loop upon the occurrence of some condition. F
example, in Figure 15-6 a break statement is used to stop a loop when a negative
number is encountered in an input vector.

To insert a break statement, click on a placeholder inside a loop and click  
the Programming toolbar or press [Ctrl] {. Do not type the word “break.” You 
typically insert break into the left-hand placeholder of an if statement. The break is 
evaluated only when the right-hand side of the if is true.

7LS To create the program on the left in Figure 15-6, for example, you would click  first, 

then click .

Figure 15-5: Using a while loop to find the first occurrence of a particular 
number in a matrix. 
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To ignore an iteration of a loop, use continue. To insert the continue statement, click 
on a placeholder inside a loop and click  on the Programming toolbar or press 
[Ctrl] [. Do not type the word “continue.” As with break, you typically insert 
continue into the left-hand placeholder of an if statement. The continue statement 
is evaluated only when the right-hand side of the if is true.

For example, in Figure 15-6 a continue statement is used to ignore nonpositive 
numbers in an input vector.

7KH�³5HWXUQ´�6WDWHPHQW
A Mathcad program returns the value of the last expression evaluated in the prog
In simple programs, the last expression evaluated is in the last line of the program
you create more complicated programs, you may need more flexibility. The return 
statement allows you to interrupt the program and return particular values other 
the default value. 

A return statement can be used anywhere in a program, even within a deeply n
loop, to force program termination and the return of a scalar, vector, array, or str
As with break and continue, you typically use return on the left-hand side of an if 
statement, and the return statement is evaluated only when the right-hand side of 
if statement is true.

Figure 15-6: The break statement halts the loop. Program execution resumes 
on the next iteration when continue is used.
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The following program fragment shows how a return statement is used to return a 
string upon the occurrence of a particular condition:

1. Click  on the Programming toolbar.

2. Now click  on the Programming toolbar or 
press [Ctrl]|. Do not type “return.”

3. Create a string by typing the double-quote key (") 
on the placeholder to the right of return. Then type 
the string to be returned by the program. Mathcad 
displays the string between a pair of quotes.

4. Type a condition in the placeholder to the right of if. 
This is typically a Boolean expression like the one 
shown. (Type [Ctrl]= for the bold equal sign.)

In this example, the program returns the string “int” when the expression 
is true.

7LS You can add more lines to the expression to the right of return by clicking  on the 
Programming toolbar.

(UURU�+DQGOLQJ

Errors may occur during program execution that cause Mathcad to stop calculatin
program. For example, because of a particular input, a program may attempt to d
by 0 in an expression and therefore encounter a singularity error. In these cases M
treats the program as it does any math expression: it marks the offending expre
with an error message and highlights the offending name or operator in a different c
as described in Chapter 8, “Calculating in Mathcad.” 

Mathcad Professional gives you two features to improve error handling in progra

• The on error statement on the Programming toolbar allows you to trap a numer
error that would otherwise force Mathcad to stop calculating the program.

• The error string function gives you access to Mathcad’s error tip mechanism a
lets you customize error messages issued by your program.

floor x( ) x=
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In some cases you may be able to anticipate program inputs that lead to a numerical 
error (such as a singularity, an overflow, or a failure to converge) that would force 
Mathcad to stop calculating the program. In more complicated cases, especially when 
your programs rely heavily on Mathcad’s numerical operators or built-in function 
you may not be able to anticipate or enumerate all of the possible numerical error
can occur in a program. The on error statement is designed as a general-purpose er
trap to compute an alternative expression when a numerical error occurs that wo
otherwise force Mathcad to stop calculating the program. 

To use the on error statement, click  on the Programming toolbar or type 
[Ctrl] ‘ . Do not type “on error.” In the placeholder to the right of on error, create 
the program statement(s) you ordinarily expect to evaluate but in which you wish
trap any numerical errors. In the placeholder to the left of on error, create the program 
statement(s) you want to evaluate should the default expression on the right-han
fail. Figure 15-7 shows on error operating in a program to find a root of an expressio

Figure 15-7: The on error statement traps numerical errors in a program.
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Just as Mathcad automatically stops further evaluation and produces an appropriate 
“error tip” on an expression that generates an error (see the bottom of Figure 15
an example), you can cause evaluation to stop and make custom error tips appea
your programs or other expressions are used improperly or cannot return answe

Mathcad Professional’s error string function gives you this capability. This function
(see “String Functions” on page 198) suspends further numerical evaluation of a
expression and produces an error tip whose text is the string it takes as an argu

Typically you use the error string function in the placeholder on the left-hand side 
an if or on error programming statement so that an error and appropriate error tip
generated when a particular condition is encountered. Figure 15-8 shows how cu
errors can be used even in a small program.

1RWH Some error strings are automatically translated to a Mathcad error message that is similar to the 
error string. For example “must be real” is translated to “This value must be real. Its imag
part must be zero.”

Figure 15-8: Generating custom errors via the error string function.
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The examples in previous sections have been chosen more for illustrative purposes 
rather than their power. This section shows examples of more sophisticated programs. 

Much of the flexibility inherent in programming arises from the ability to embed 
programming structures inside one another. In Mathcad, you can do this in the following 
ways:

• You can make one of the statements in a program be another program, or yo
define a program elsewhere and call it from within another program as if it we
subroutine.

• You can define a function recursively.

6XEURXWLQHV
Figure 15-9 shows two examples of programs containing a statement which is its
program. In principle, there is no limit to how deeply you can nest a program. 

Figure 15-9: Programs in which statements are themselves programs.
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One way many programmers avoid overly complicated programs is to bury the 
complexity in subroutines. Figure 15-10 shows an example of this technique.

7LS Breaking up long programs with subroutines is good programming practice. Long programs and 
those containing deeply nested statements can become difficult for other users to understand at 
a glance. They are also more cumbersome to edit and debug. 

In Figure 15-10, the function adapt carries out an adaptive quadrature or integration 
routine by using intsimp to approximate the area in each subinterval. By defining 
intsimp elsewhere and using it within adapt, the program used to define adapt becomes 
considerably simpler.

5HFXUVLRQ
Recursion is a powerful programming technique that involves defining a function in 
terms of itself, as shown in Figure 15-11. See also the definition of adapt in Figure 15-
10. Recursive function definitions should always have at least two parts:

• A definition of the function in terms of a previous value of the function.

• An initial condition to prevent the recursion from continuing forever.

Figure 15-10: Using a subroutine to manage complexity.
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The idea is similar to mathematical induction: if you can determine  from , 

and you know , then you know all there is to know about f.

7LS Recursive function definitions, despite their elegance and conciseness, are not always 
computationally efficient. You may find that an equivalent definition using one of the iterative 
loops described earlier will evaluate more quickly.

Figure 15-11: Defining functions recursively.

f n 1+( ) f n( )
f 0( )
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2YHUYLHZ

In this chapter, you will learn how to extend Mathcad’s functionality by bringing t
feature sets of other applications into your Mathcad worksheet. Likewise, you ca
expand the usefulness of other programs by interfacing with Mathcad. In both ca
you take advantage of Mathcad’s OLE (Object Linking and Embedding) capabili

([FKDQJLQJ�'DWD�ZLWK�2WKHU�$SSOLFDWLRQV

Components are specialized OLE objects in your Mathcad worksheet. They allow yo
to exchange data with other applications or sources. Application components allow you 
to access functions and data from other computational applications such as Exc
SmartSketch, and MATLAB. Unlike other kinds of OLE objects you insert into a 
worksheet, as described in the section “Inserting Objects” in Chapter 6, a compo
can receive data from Mathcad, return data to Mathcad, or do both, dynamically lin
the object to your Mathcad computations.

7LS As described in Chapter 11, “Vectors, Matrices, and Data Arrays,” Mathcad also provides
File Read/Write component for you to import and export static data files in a variety of formats 
compatible with other computational programs. For linking dynamically to an object for wh
Mathcad does not have a dedicated component, see “Scripting Custom OLE Automation
Objects” on page 308.

Components that connect Mathcad to other applications include:

• Axum, for creating highly customizable Axum graphs

• Excel, for accessing cells and formulas in a Microsoft Excel spreadsheet

• MATLAB, for accessing the programming environment of MATLAB

• ODBC Read, for retrieving data from an ODBC-compliant database that supp
SQL
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• SmartSketch, for creating 2D drawings and designs

• S-PLUS Graph, for creating S-PLUS graphs

• S-PLUS Script, for accessing the programming environment of S-PLUS

1RWH To use an application component, you must have the application for that component installed, 
but not necessarily running, on your system.

Other built-in components that may be customized using scripting:

• Data Acquisition, for sending data to or getting data from a measurement de

• MathSoft Controls, for creating custom forms controls like buttons and text bo

These components are described in detail in the next section, “Scripting Custom OLE 
Automation Objects” on page 308.

7LS See the SAMPLES folder of your Mathcad installation for a variety of example files that u
components.

+RZ�WR�8VH�$SSOLFDWLRQ�&RPSRQHQWV
In general, components receive input from one or more Mathcad variables, perform 
operations on the data you specify, and return output to other Mathcad variables. An 
“input variable” is a scalar, vector, matrix, or, in some cases, a string, that you h
already defined in your Mathcad worksheet. It contains the data that is passed in
component. Output from a component (again, either a scalar, vector, matrix, or st
is then assigned to a Mathcad variable. This variable is referred to as an “output
variable.” 

The basic steps for using a component are as follows:

• Insert the component.

• Specify the input variable(s) and output variable(s).

• Configure the component to handle inputs from and return outputs to Mathca

Since some components only take input or only send output, these steps differ sl
for each component. The ideas presented in the steps that follow provide an ove
of the process.

6WHS����,QVHUWLQJ�D�FRPSRQHQW

To insert a component into a Mathcad worksheet:

1. Click in a blank area of your Mathcad worksheet where you want the compon
to appear. Click below or to the right of definitions for any variables that will 
become inputs to the component.

2. Choose Component from the Insert menu. This launches the Component Wizar
298  Chapter 16  Advanced Computational Features
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3. Choose a component from the list and click “Next” or “Finish,” depending on 
component you choose. You may see additional dialog boxes that let you sp
properties of the component before it is inserted. When you click “Finish,” the
component is inserted into your worksheet.

If you don’t see a Wizard when you choose one of the components from the Inse
Component dialog box, you’ll immediately see the component inserted into your
worksheet with some default properties. 

Each component has its own particular appearance, but all components have on
more placeholders to the left of the :=, if it returns data to Mathcad, and/or at the bo
of the component, if it receives data from Mathcad. For example, the Excel compo
(with one input and two outputs) looks like this when inserted into your workshee

The placeholder(s) at the bottom of the component are for the names of previou
defined input variables. The placeholder(s) you see to the left of the := are for the o
variables. 

After you fill in the placeholders for the input and output variables, you can hide 
variables by clicking with the right mouse button on the component and choosing Hide 
Arguments from the pop-up menu.

1RWH To add an input or output variable, click with the right mouse button on the component and 
choose Add Input Variable or Add Output Variable from the pop-up menu. To eliminate an 
input or output, choose Remove Input Variable or Remove Output Variable from the menu.

6WHS����&RQILJXULQJ�D�FRPSRQHQW

Once you’ve inserted a component into a worksheet, you can configure its prope
so that the component knows how to handle any inputs it receives from Mathcad
what to send as output. To configure the properties for a component:

1. Click on the component once to select it.

2. Click on the component with the right mouse button to see a pop-up menu.
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3. Choose Properties from the pop-up menu.

The settings in the Properties dialog box differ for each component. For example, the 
Properties dialog box for the Excel component lets you specify the starting cells in 
which the input values are stored and the cell range from which the output is sent.

7LS When you insert an application component, you see a small window on that application’s
environment embedded in your Mathcad worksheet. When you double-click the component, the 
component is in-place activated and Mathcad’s menus and toolbars change to those of the o
application. This gives you access to the features of that application without leaving the Ma
environment.

6WHS����([FKDQJLQJ�GDWD

Once you’ve configured the component, click outside it elsewhere in the worksh
At that point, the region recalculates and data exchange takes place: data passe
the input variable(s) into the component, the component processes the data, and
output variable(s) receive output from the component. This exchange happens w
ever:

• You click on the component and press [F9] to recalculate the region.

• The input variables change and Automatic Calculation is turned on.

• You choose Calculate Worksheet from the Math menu.

7LS Some components allow you to save the file with which the component exchanges data as a 
separate file. Click on a component with the right mouse button and choose Save As... from the 
pop-up menu.

([FHO�&RPSRQHQW
The Excel component allows you to exchange data with and access the function
Microsoft Excel (version 7 or higher), if it is installed on your system. 

7LS If you only need to import or export a static data file in Excel format, use the File Read/Write 
component as described in Chapter 11, “Vectors, Matrices, and Data Arrays.”

,QVHUWLQJ�DQ�([FHO�FRPSRQHQW

To insert an Excel component into a Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the component 
from a Mathcad variable defined in your worksheet, click below or to the right of 
the variable definition.

2. Choose Component from the Insert menu.
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3. Select Excel from the list and click “Next.” To create an object based on a file
you’ve already created, choose “Create from file,” and type the path name in
text box or use the Browse button to locate the file; then click “Open.” Otherw
choose “Create an empty Excel Worksheet.”

4. Click Display as Icon if you want to see an icon in your Mathcad worksheet ra
than a portion of the Excel spreadsheet object.

Successive pages of the Wizard allow you to specify:

• The number of input and output variables. Supply multiple input and output 
variables. The number of input and output variables you can pass between Ma
and Excel is only limited by the memory and speed of your computer. There i
set limit.

• Input ranges. The cells in which the values of each input variable from Mathc
will be stored. Enter the starting cell, which is the cell that will hold the elemen
the upper left corner of an input array. For example, for an input variable contai
a  matrix of values, you can specify A1 as the starting cell, and the values
be placed in cells A1 through C3.

• Output ranges. The cells whose values will define the output variables in Mathc
For example, enter C2:L11 to extract the values in cells C2 through L11 and c
a  matrix.

7LS You can specify a particular Excel worksheet and cell range using standard Excel notation such 
as Sheet2!B2:C2. You can also specify named cells and cell ranges.

When you finish using the Wizard, the Excel component appears in your worksh
with placeholders for the input and output variables. Enter the names of input vari
in the bottom placeholders. Enter the names of the output variables into the placeh
to the left of the :=. When you click outside the component, input variables are se
Excel from Mathcad and a range of cells are returned to Mathcad.

Figure 16-1 shows an example of an Excel component in a Mathcad worksheet.

1RWH By default, the Excel component displays only some of the rows and columns of the underlying 
spreadsheet object. To see more or fewer rows and columns, click the component so that you see 
handles along its sides. Resize the component by dragging a handle. To see different rows or 
columns than the ones shown in the view, double-click the component and use the scroll bars to 
find the rows or columns of interest.

3 3×

10 10×
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If you add input or output variables, you need to specify which cells in the component 
will store the new input and which will provide the new output. To do so:

1. Click on the component with the right mouse button and choose Properties from 
the pop-up menu.

2. Click on the Inputs tab and specify a starting cell for each input; click on the Outputs 
tab and specify a range of cells for each output.

You should also follow these steps if you want to change the cell ranges for inputs and 
outputs you initially specified in the Setup Wizard.

1RWH Strings can be passed as input to and outputs from an Excel component.

$FFHVVLQJ�([FHO

After inserting an Excel component into a Mathcad worksheet, you can use the 
component to perform calculations in Excel. To do so:

1. Double-click the Excel component in the Mathcad worksheet. The Excel compo-
nent opens and the menus and toolbars change to Excel’s menus and toolbar
is called in-place activation of the component application, i.e. Excel.

2. Edit the Excel component.

3. Click back in the Mathcad worksheet to have the component recalculate and
resume working in Mathcad.

Figure 16-1: An Excel spreadsheet object in a Mathcad worksheet.
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The MATLAB component allows you to exchange data with and access the program-
ming environment of The MathWorks’ MATLAB Professional 4.2c or higher, if it is 
installed on your system.

7LS If you only need to import or export a static data file in MATLAB format, use the File Read/
Write component as described in Chapter 11, “Vectors, Matrices, and Data Arrays.”

,QVHUWLQJ�D�0$7/$%�FRPSRQHQW

To insert a MATLAB  component into a Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the MATLAB  
component from a Mathcad variable, click below or to the right of the variable 
definition.

2. Choose Component from the Insert menu. Select MATLAB  from the list and click 
“Finish.” The MATLAB component is inserted into your worksheet.

3. In the placeholder that appears at the bottom, enter the name of the Mathcad
variable to pass into the MATLAB component. In the placeholder that appears t
the left of the component, enter the name of the Mathcad output variable to b
defined.

1RWH By default, the data in the Mathcad input variables are sent into MATLAB variables named 
in0, in1, in2, and so on. The MATLAB variables out0, out1, out2, and so on define 
the data to be passed to the Mathcad output variables. To change these names, choose Properties 
from the component’s pop-up menu and type in new names in the Inputs and Outputs tab

To use the MATLAB  component to perform calculations in MATLAB :

1. Right-click the MATLAB  component in your Mathcad worksheet and select Edit 
Script... from the pop-up menu. This action opens a text window for entering 
MATLAB  commands.

2. Edit the MATLAB  script to your liking. Be sure to use appropriate MATLAB  variable 
names to take input from Mathcad and provide output.

When you click outside the component, input variables from Mathcad are sent to 
MATLAB,  and arrays from MATLAB are assigned to output variables in Mathcad.

1RWH Some versions of MATLAB support multidimensional arrays and other complex data struct
While you may use these structures within the MATLAB component, you may pass only sca
vectors, and two-dimensional arrays from Mathcad to the MATLAB component and vice ve
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The ODBC (Open Database Connectivity) component allows you to retrieve informa-
tion from a database that supports SQL in its ODBC driver, like Microsoft Access or 
FoxPro. There are some programs that have SQL support within their application, but 
do not support SQL in their ODBC driver, like Microsoft Excel.

A link to your database must be established before you insert an ODBC component 
into your worksheet. In order to establish a link to a database on your system or network, 
in the Control Panel, go to Administrative Tools\Data Sources (ODBC), in Windows 
2000, or ODBC Data Sources, in Windows 95, 98, and NT. For more information about 
ODBC and SQL support, check the documentation that comes with your database 
application.

,QVHUWLQJ�DQ�2'%&�FRPSRQHQW

To insert an ODBC component into a Mathcad worksheet:

1. Click in a blank spot in your worksheet and choose Component from the Insert 
menu.

2. Select ODBC Read from the list and click “Next.”

3. Choose a database from which to collect data. Depending on the data sourc
also may need to enter a username and password. Click “Next.”

4. Select a table and specify the fields in the database that you would like to re
Click “Finish.”

5. In the placeholder that appears to the left of the component, enter the name 
Mathcad output variable to be defined.

Once a link to a particular database has been established, you may want to chan
data source, the table, or the columns of data to be imported to your Mathcad work

To change the data source in an ODBC component:

1. Right-click the component and select Properties from the pop-up menu.

2. In the Properties dialog box under the Data Source tab, select a database, tab
columns of data.

3. Click “OK” to close the dialog box and update your worksheet.

1RWH You can change the order in which the fields of your database are stored in the columns of the 
output matrix in Mathcad. To do so, right-click the ODBC component in your Mathcad 
worksheet and choose Properties from the pop-up menu. Navigate to the Advanced tab of the 
dialog box, and rearrange the order of the fields in the columns of the matrix using the “m
up” and “move down” buttons.
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To filter your data before bringing it into a Mathcad output variable, you can query 
your database directly through the ODBC component using a SQL “where” statement.

To filter your data through the ODBC component:

1. Right-click the component and select Properties from the pop-up menu.

2. Under the Advanced tab, check the “Use SQL” option and type a “where” state
in the text box.

3. Click “OK” to close the dialog box and update your worksheet.

Figure 16-2 shows the use of a SQL “where” statement.

Figure 16-2: Using a SQL “where” statement to filter data through the ODBC 
component.

7LS Checking the “Show all fields” option in the ODBC component Wizard or on the Data Sou
page of the Properties dialog box displays all data fields, even those not supported by Math
variables. For example, Mathcad does not support any time data types, but you can selec
display time indices from your database in a Mathcad output variable.
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6PDUW6NHWFK�&RPSRQHQW
SmartSketch is a 2D drawing and design tool developed by Intergraph. The Smart-
Sketch component allows you to create in a Mathcad worksheet SmartSketch drawings 
whose dimensions are computationally linked to your Mathcad calculations. For 
example, your Mathcad equations can drive the size of drawing objects. 

The SmartSketch component makes Mathcad the ideal platform for creating technical 
illustrations and specification-driven designs. You can use the SmartSketch component 
if you have installed SmartSketch LE for Mathcad (included on your Mathcad CD), 
SmartSketch 3 or higher, Imagination Engineer, or Imagineer Technical 2.

,QVHUWLQJ�D�6PDUW6NHWFK�GUDZLQJ

To insert a drawing that is computationally linked to your Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the drawing 
from a Mathcad variable defined in your worksheet, click below or to the right of 
the variable definition.

2. Choose Component from the Insert menu. Select SmartSketch and click “Next.
The first page of the SmartSketch component Wizard appears.

3. To insert a SmartSketch drawing you've already created, choose “From Exis
File,” and type the path name in the text box or use the Browse button to locat
file; then click “Open.” Otherwise, choose “New SmartSketch Document.” Th
next page of the Wizard appears.

4. Specify the number of inputs and outputs. If you are using an existing file, als
specify the names of the variables, dimensions, or symbols in the drawing to 
input to and retrieve output from. Use the drop-down list boxes next to each i
and output.

When you click “Finish,” the SmartSketch component appears in your worksheet 
placeholders for the input and output variables. Enter the names of Mathcad inp
variables in the bottom placeholders. Enter the output variables in the placeholde
the left of the :=. 

Figure 16-3 shows a SmartSketch drawing inserted into a Mathcad worksheet. T
values from the variables RadiusA, RadiusB, and Distance are sent to SmartSketch as
input and used to create the drawing. The variables WrapB, BLength, and Beta1 are 
output variables.
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1RWH  Input values that do not have units attached are passed in SI units. For example, if you send 2.0 
as input for a length, it is assumed to be 2.0 meters. SmartSketch, by default, converts this to the 
display units (inches by default) and creates the drawing. 

&UHDWLQJ�D�QHZ�GUDZLQJ

If you choose “New SmartSketch Document” when inserting the SmartSketch co
nent, you need to create a new SmartSketch drawing after the component appea
do so:

1. Double-click on the component and use SmartSketch's menus and toolbars to
a drawing. Use the Dimensions toolbar to add dimensions to your drawing. 

2. Choose Variables from the Tools menu to define variables or edit dimensions. 
Close the Variable Table before clicking back in the Mathcad worksheet.

Next you need to bind variables, dimensions, or symbols to the inputs or outputs
do so, right-click on the component in Mathcad and choose Properties from the pop-
up menu. Use the Properties dialog to specify:

• Input names. The dimension, symbol, or variable names used in the SmartSk
drawing that are controlled by the inputs to the SmartSketch component. Cho
dimension or variable name from the drop-down list.

• Output names. The dimension, symbol, or variable names used in the SmartSk
drawing that define the output variables in Mathcad. Choose a dimension or var
name from the drop-down list.

Figure 16-3: Integrating a SmartSketch drawing into a Mathcad worksheet.
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When you click outside the component, input values are sent to the SmartSketch 
drawing from Mathcad and values are returned to Mathcad as output.

7LS If the drawing is so large that it extends beyond the component window, click on the component 
with the right mouse button, choose Properties from the pop-up menu, and click the box next 
to Automatic Resizing.

1RWH In order for the dimensions in a drawing to resize relative to any changes to the dimensions, 
check the box next to Maintain Relationships under the Tools menu in SmartSketch. To verify 
this setting, double-click on the component and choose Tools from the menu bar.

For more information on SmartSketch, refer to the tutorials and documentation avail-
able from the Help menu in SmartSketch. Sample Mathcad files containing Smart-
Sketch components are located in the SAMPLES\CAD folder of your Mathcad 
installation.

1RWH To learn about other built-in application components in Mathcad, see Mathcad’s online H

6FULSWLQJ�&XVWRP�2/(�$XWRPDWLRQ�2EMHFWV

As described in the previous section, Mathcad has several specialized components for 
accessing the functionality of other technical computing environments within your 
Mathcad worksheet. However, you can dynamically exchange data between a Mathcad 
worksheet and any other application that supports OLE Automation, even if Mathcad 
does not have a specific component for that application. To do so, you must use the 
Scriptable Object component (SOC).

In addition to programming the SOC to interface with other OLE applications, you can 
build customized Controls that respond to user input in the worksheet, such as buttons 
and text boxes. Also, you can use the SOC to retrieve data from measurement devices 
attached to your system. Scripted objects to perform these tasks come pre-installed with 
Mathcad. Brief descriptions of their use appear later in this section, under “Custom
and Redistributing Components” on page 310 and “Data Acquisition Componen
(DAC)” on page 313. These components appear in the Insert Component list, bu
still need to be customized through modifications to their scripts.
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In general, you can create a custom scriptable object from any object you can insert 
into a Mathcad worksheet as well as any ActiveX controls installed on your computer.

To create a Scriptable Object component, you must:

1. Be proficient in a supported scripting language, such as Microsoft VBScript or 
JScript, that is installed on your system.

2. Know something about the Object Model of the other application. In other words, 
you must know how the application has implemented Automation.

3. Have the other application or control installed on your system, if you’re interfac
with another application.

6FULSWLQJ�/DQJXDJHV
To use a Scriptable Object component, you must have a supported scripting lang
installed on your system. Two scripting languages are supported by Mathcad: Micr
VBScript (Visual Basic Scripting Edition) and Microsoft JScript (an implementatio
of JavaScript). Both of these scripting languages are included with Microsoft Inte
Explorer, which can be installed from the Mathcad CD. These scripting language
also be downloaded at no charge from Microsoft, Inc. at: 

http://msdn.microsoft.com/scripting

For more information on scripting languages and syntax associated with their us
see the Developer’s Reference under the Help menu in Mathcad.

,QVHUWLQJ�D�6FULSWDEOH�2EMHFW
To insert a Scriptable Object component into a Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the object 
from a Mathcad variable, click below or to the right of the variable definition.

2. Choose Component from the Insert menu.

3. Select Scriptable Object from the list in the Wizard and click “Next.” 

This launches the Scripting Wizard. The Object to Script scrolling list shows the 
available server applications on your system. Choose an application that suppor
OLE 2 automation interface (consult documentation for the application for details

You must specify:

• Whether the component is a new file or whether you will insert an existing file

• Whether you will see the actual file or an icon in your Mathcad worksheet.
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In the remaining pages of the Wizard you specify: the type of object you want to script, 
the scripting language you are using, the name of the object, and the number of inputs 
and outputs the object will accept and provide.

A Scriptable Object component appears in your worksheet with placeholders for the 
input and output variables. Enter the input variables in the bottom placeholders. Enter 
the output variables into the placeholders to the left of the :=.

1RWH There are two Properties dialog boxes for any customized Scripted Object component, one for 
the object and one for the embedded control. Access the one for the object by right-clicking on 
the object and choosing Properties from the pop-up menu. This dialog box allows you to specify 
the number of inputs and outputs and the name of the object. Access the one for the control by 
right-clicking on the object and choosing Properties (Control Name) Object. This dialog box 
allows you to modify the setting for the embedded control. For example, in the Data Acquisition 
Control (see page 313), you use it to change the data collection mode from single point to 
waveform.

&XVWRPL]LQJ�DQG�5HGLVWULEXWLQJ�&RPSRQHQWV
Once you have scripted an object to your liking, you can save it as a customized Scripted 
Object component for future use. The scripted object will be saved as an MCM file and, 
once registered, it will be available every time you start Mathcad 2001. You can share 
any MCM file you have created with other Mathcad 2001 users.

6DYLQJ�6FULSWHG�2EMHFWV�DV�FXVWRPL]HG�FRPSRQHQWV

To save a Scripted Object as a customized component:

1. Create a Scripted Object component in your Mathcad worksheet.

2. Right-click on the component and choose Export as Component from the pop-up 
menu.

3. Specify the name of the component, as you would like it to appear on the Insert 
Component list, and provide a file name. Click “Next.”

4. Enter a password to prevent others from editing the script of the component 
verify the password. Click “Finish” to save the component. This step is option

Once you have exported your component, which saves the component informati
an MCM file, it automatically becomes available on your system. The component
appear in the Insert Component list.

To start using a component defined in an MCM file you have received:

1. Copy the MCM file to the MCM folder of your Mathcad installation.

2. Double-click the MCM file to register it with Mathcad.

3. Start Mathcad and the customized component defined in the MCM file will app
on your Insert Component list.
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The MathSoft Control components allow you to insert buttons, text boxes, list boxes, 
combo boxes, and sliders into your Mathcad worksheet. These components operate in 
a fashion similar to Microsoft Forms Controls.

1RWH For more information about the properties and methods associated with MathSoft Controls and 
other Scriptable Object components, see the Developer’s Reference under the Help menu in 
Mathcad.

,QVHUWLQJ�D�0DWK6RIW�&RQWURO�FRPSRQHQW

To insert a MathSoft Control component into a Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the component 
from a Mathcad variable, click below or to the right of the variable definition.

2. Choose Component from the Insert menu. Select MathSoft TextBox Control or 
one of the other MathSoft Controls from the list and click “Finish.”

3. In the placeholder that appears to the left of the component, enter the name 
Mathcad output variable to be defined.

To add input or output variables to your component, right-click the embedded co
(i.e. the button, list box, text box, etc.) and select Add Input Variable or Add Output 
Variable from the pop-up menu. If you add or remove input or output variables fr
the component, you must make changes to the script. To edit the script, right-clic
embedded control and select Edit Script... from the pop-up menu.

You are allowed a maximum of four inputs and four outputs for any MathSoft Con
component. For information on inputs, outputs, and scripting your control compo
see the Developer’s Reference under Help in Mathcad.

7LS For most MathSoft Control components, you will specify outputs only. For example, if you have 
a TextBox control you will get 0 inputs and 1 output, the output being based on the text entered 
in the text box.
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To change the appearance of a MathSoft Control component:

1. Right-click on the component and select Mathsoft (Control) Object ⇒ Properties 
from the pop-up menu.

2. In the Properties dialog box 
you will see various options 
that let you change the appear-
ance of the control. For exam-
ple, for a MathSoft Button 
Control, you can change the 
default check box to a push 
button within this dialog box. 
Make your selections.

3. Click “Apply” to keep the 
Properties dialog box open and 
preview the changes in your 
worksheet. Click “OK” to close the Properties dialog box and return to the 
worksheet.

7LS To customize a button quickly with a specific graphic image, create an image and copy it into 
your clipboard. Right-click on your MathSoft Control component and select MathSoft 
(Control) Object ⇒ Paste Bitmap from the pop-up menu. Alternatively, you can browse for a 
bitmap or icon file through the Pictures tab in the Properties dialog box.

To edit the script of a MathSoft Control component:

1. Right-click on the component and select MathSoft (Control) Object ⇒ Edit 
Script… from the pop-up menu.

2. Make your changes and close the Script Editor.

3. To update the component in your Mathcad worksheet, select Calculate Worksheet 
from the Math  menu or click on the component and press [F9].

1RWH You cannot send a string as input to any MathSoft Control component. The only types of input 
variables allowed are scalars, vectors, and matrices. However, you can define an output variable 
as a string in a MathSoft Control component. See CONTROLS.MCD in the SAMPLES 
directory of your Mathcad installation for examples of MathSoft Control components.
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The Data Acquisition component (DAC) allows you to read data directly from or send 
data directly to a measurement device installed in your system. The DAC eliminates 
the step of saving data to an external file before importing the data into Mathcad for 
display and analysis. To some degree, the DAC also allows for “real time” data log
and analysis. At this time, the DAC only supports National Instruments E-Series 
acquisition boards and PC cards. See the Developer’s Reference for a complete list of 
supported data acquisition boards.

1RWH The degree to which “real time” data logging and analysis is possible depends on the size
data being transferred, the complexity of the calculations being performed, and the speed o
computer. If at some point Mathcad is unable to keep up with the data transfer or calcula
real-time analysis is no longer possible.

,QVHUWLQJ�D�'DWD�$FTXLVLWLRQ�FRPSRQHQW

To insert a Data Acquisition component into a Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the component 
from a Mathcad variable, click below or to the right of the variable definition.

2. Choose Component from the Insert menu.

3. Select Data Acquisition Component (DAC) from the list and click “Finish.”

The DAC is inserted into the worksheet with default properties, namely, one outp
and single point analog data collection. These properties are easily modified, how
using either the object’s Properties dialog box, the Edit Script… window, or the user 
interface for the control, shown in Figure 16-4.

.

Figure 16-4: User Interface of the Data Acquisition copmonent (DAC).
Scripting Custom OLE Automation Objects 313



quisi-

king 

me” 

ry 

lly 
 data 

 
isit 

ad 
To modify DAC settings using the object’s Properties dialog box:

1. Right-click the DAC and select Properties MathcadDAQ.AnalogIO Object from 
the pop-up menu.

2. Use this properties dialog box to specify properties for the embedded data ac
tion control.

The number of inputs and outputs for the component can be specified by right-clic
on the component and selecting Add or Remove Input Variable or Output Variable 
from the pop-up menu or by selecting Properties… from the pop-up menu and using 
the Scripted Object Component Properties dialog box.

1RWH For more information about the properties and methods associated with the DAC and other 
Scriptable Object components, see the Developer’s Reference under the Help menu in 
Mathcad.

7LS If you are using the DAC component to bring analog waveform data into Mathcad for “real ti
analysis, be sure that Automatic Calculation, under the Math menu, is turned on.

Example worksheets are provided in the SAMPLES folder of your Mathcad installation 
showing usage of the component for single point and waveform analog input and output. 
Context sensitive help is available for all methods, properties, and events associated 
with the Mathcad Data Acquisition control. You can access context sensitive help by 
looking at the AnalogIO object in the Visual Basic object browser and clicking on the 
help button.

$FFHVVLQJ�0DWKFDG�IURP�:LWKLQ�$QRWKHU�$SSOLFDWLRQ

The previous section describes how to script a custom OLE object in Mathcad. 
Mathcad’s OLE automation interface provides a mechanism for the complementa
process of using Mathcad as an automation server from within another Windows 
application. Using Mathcad’s OLE automation interface, you can send data dynamica
to Mathcad from another application, use Mathcad to perform calculations or other
manipulations, and send results back to the original application.

0DWKFDG�$GG�LQV
There are several applications for which specialized Mathcad Add-ins have been
created. An Add-in allows you to insert a Mathcad object into another application. V
the Download area of the Mathcad web site at http://www.mathcad.com/ for a 
complete list of available Mathcad Add-ins and information about how to downlo
them for use.

1RWH The OLE automation interface is supported in Mathcad 7.02 and higher and supersedes the DDE 
interface supported in Mathcad 5 and 6. For information on the interface, see the Developer’s 
Reference under the Help menu in Mathcad. For specific examples, see TRAJECTORY.XLS 
in the \SAMPLES\EXCEL and DOUGHNUT.EXE in the \SAMPLES\VBASIC in your 
Mathcad installation.
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This chapter lists and describes Mathcad’s built-in mathematical and statistical 
functions. The functions are listed alphabetically. 

Certain features described here accompany the Solving and Optimization Extension 
Pack, which requires Mathcad and is available for sale separately.

Function names are case-sensitive, but not font-sensitive. Type them in any font, but 
use the same capitalization as shown in the syntax section. 

Many functions described here as accepting scalar arguments will, in fact, accept vector 
arguments. For example, while the input z for the DFRV function is specified as a “real 
or complex number,”  DFRV will in fact evaluate correctly at each of a vector input of
real or complex numbers.

Other functions may possess optional arguments, for example, FXPLQW�or IY. For such 
functions f and g, the notation f(x,[y]) means that y can be omitted, while the notation
g(x,[[y],[z]]) means that both x and y can be omitted (but not just x or just y).

Some functions don’t accept input arguments with units. For such a function f, an error 
message “must be dimensionless” will arise when evaluating f(x), if x has units.

)XQFWLRQ�&DWHJRULHV
Each function falls within one of the following categories:

• Bessel

• Complex numbers

• Differential equation solving

• Expression type

• File access

• Finance

• Fourier transform

• Hyperbolic

• Interpolation and prediction

• Log and exponential

• Number theory/combinatorics

• Piecewise continuous
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• Probability density

• Probability distribution

• Random number

• Regression and smoothing

• Solving

• Sorting

• Special

• Statistics

• String

• Trigonometric

• Truncation and round-off

• Vector and matrix

• Wavelet transform

The category name is indicated in the upper right corner of each entry. To see all the 
functions that belong to a given category, check the index of this book.

)LQGLQJ�0RUH�,QIRUPDWLRQ
You can also find information about functions using either of these methods:

• To quickly see a short description of each function from within Mathcad, choose 
Function from the Insert menu. Select a function in the Function field, then read 
the description in the Description field. Click on the Help button to see the Help 
topic on a selected function.

• Refer to the Resource Center QuickSheets for more detailed information abo
functions, categories, and related topics. Select Resource Center from the Help 
menu. Then click on the QuickSheets icon and select a specific topic.

$ERXW�WKH�5HIHUHQFHV
References are provided in the Appendices for you to learn more about the num
algorithm underlying a given Mathcad function or operator. References are not inte
to give a description of the actual underlying source code. Some references (suc
Numerical Recipes) do contain actual C code for the algorithms discussed therein, but 
the use of the reference does not necessarily imply that the code is what is implem
in Mathcad. The references are cited for background information only.
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DFRV 7ULJRQRPHWULF

6\QWD[ DFRV�z�

'HVFULSWLRQ Returns the inverse cosine of z (in radians). The result is between 0 and π if z is real. For complex 
z, the result is the principal value.

$UJXPHQWV
z real or complex number

DFRVK +\SHUEROLF

6\QWD[ DFRVK�z�

'HVFULSWLRQ Returns the inverse hyperbolic cosine of z. The result is the principal value for complex z.

$UJXPHQWV
z real or complex number

DFRW 7ULJRQRPHWULF

6\QWD[ DFRW�z�

'HVFULSWLRQ Returns the inverse cotangent of z (in radians). The result is between 0 and π if z is real. For 
complex z, the result is the principal value.

$UJXPHQWV
z real or complex number

DFRWK +\SHUEROLF

6\QWD[ DFRWK�z�

'HVFULSWLRQ Returns the inverse hyperbolic cotangent of z. The result is the principal value for complex z.

$UJXPHQWV
z real or complex number

DFVF 7ULJRQRPHWULF

6\QWD[ DFVF�z�

'HVFULSWLRQ Returns the inverse cosecant of z (in radians). The result is the principal value for complex z.

$UJXPHQWV
z real or complex number

DFVFK +\SHUEROLF

6\QWD[ DFVFK�z��

'HVFULSWLRQ Returns the inverse hyperbolic cosecant of z. The result is the principal value for complex z.

$UJXPHQWV
z real or complex number
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$L � %HVVHO

6\QWD[ $L�x�

'HVFULSWLRQ Returns the value of the Airy function of the first kind.

$UJXPHQWV
x real number

([DPSOH

&RPPHQWV� This function is a solution of the differential equation: .

$OJRULWKP Asymptotic expansion (Abramowitz and Stegun, 1972)

6HH�DOVR %L

DQJOH 7ULJRQRPHWULF

6\QWD[ DQJOH�x, y�

'HVFULSWLRQ Returns the angle (in radians) from positive x-axis to point (x, y) in x-y plane. The result is between 
0 and 2π.

$UJXPHQWV
x, y real numbers

6HH�DOVR DUJ,�DWDQ,�DWDQ�

$33(1'351 )LOH�$FFHVV

6\QWD[ $33(1'351�file� � �A�

'HVFULSWLRQ Appends a matrix A to an existing structured ASCII data file. Each row in the matrix becomes 
a new line in the data file. Existing data must have as many columns as A. The function must 
appear alone on the left side of a definition.

$UJXPHQWV
file string variable corresponding to structured ASCII data filename or path

6HH�DOVR :5,7(351 for more details

x2

2

d
d

y x y⋅– 0=
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DUJ &RPSOH[�1XPEHUV

6\QWD[ DUJ�z��

'HVFULSWLRQ Returns the angle (in radians) from the positive real axis to point z in the complex plane. The 
result is between −π and π. Returns the same value as that of θ when z is written as .

$UJXPHQWV
z real or complex number

6HH�DOVR DQJOH,�DWDQ,�DWDQ�

DVHF 7ULJRQRPHWULF

6\QWD[ DVHF�z��

'HVFULSWLRQ Returns the inverse secant of z (in radians). The result is the principal value for complex z.

$UJXPHQWV
z real or complex number

DVHFK +\SHUEROLF

6\QWD[ DVHFK�z��

'HVFULSWLRQ Returns the inverse hyperbolic secant of z. The result is the principal value for complex z.

$UJXPHQWV
z real or complex number

DVLQ 7ULJRQRPHWULF

6\QWD[ DVLQ�z��

'HVFULSWLRQ Returns the inverse sine of z (in radians). The result is between −π/2 and π/2 if z is real. For 
complex z, the result is the principal value.

$UJXPHQWV
z real or complex number

DVLQK +\SHUEROLF

6\QWD[ DVLQK�z��

'HVFULSWLRQ Returns the inverse hyperbolic sine of z. The result is the principal value for complex z.

$UJXPHQWV
z UHDO�RU�FRPSOH[�QXPEHU

DWDQ 7ULJRQRPHWULF

6\QWD[ DWDQ�z��

'HVFULSWLRQ Returns the inverse tangent of z (in radians). The result is between −π/2 and π/2 if z is real. For 
complex z, the result is the principal value.

$UJXPHQWV
z real or complex number

6HH�DOVR DQJOH,�DUJ,�DWDQ�

r ei θ⋅⋅
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DWDQ� 7ULJRQRPHWULF

6\QWD[ DWDQ��x, y��

'HVFULSWLRQ Returns the angle (in radians) from positive x-axis to point (x, y) in x-y plane. The result is between 
−π and π.

$UJXPHQWV
x, y real numbers

6HH�DOVR DQJOH,�DUJ,�DWDQ

DWDQK +\SHUEROLF

6\QWD[ DWDQK�z��

'HVFULSWLRQ Returns the inverse hyperbolic tangent of z. The result is the principal value for complex z.

$UJXPHQWV
z real or complex number

DXJPHQW 9HFWRU�DQG�0DWUL[

6\QWD[ DXJPHQW�A, B, C, ...�

'HVFULSWLRQ Returns a matrix formed by placing the matrices A, B, C, ... left to right. 

$UJXPHQWV
A, B, C, ... at least two matrices or vectors; A, B, C, ... must have the same number of rows

([DPSOH

6HH�DOVR VWDFN

EHL � %HVVHO

6\QWD[ EHL�n, x�

'HVFULSWLRQ Returns the value of the imaginary Bessel Kelvin function of order n.

$UJXPHQWV
n integer, n ≥ 0
x real number

&RPPHQWV The function  is a solution of the differential equation:

. 

$OJRULWKP Series expansion (Abramowitz and Stegun, 1972)

6HH�DOVR EHU

ber n x,( ) i bei n x,( )⋅+

x
2

x2

2

d
d

y x
d

dx
------y i( x

2
n

2 ) y⋅+⋅–⋅+ 0=
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EHU � %HVVHO

6\QWD[ EHU�n, x�

'HVFULSWLRQ Returns the value of the real Bessel Kelvin function of order n. 

$UJXPHQWV
n integer, n ≥ 0

x real number

&RPPHQWV The function  is a solution of the differential equation:

.

$OJRULWKP Series expansion (Abramowitz and Stegun, 1972)

6HH�DOVR EHL

%L � %HVVHO

6\QWD[ %L�x�

'HVFULSWLRQ Returns the value of the Airy function of the second kind. 

$UJXPHQWV
x real number

&RPPHQWV� This function is a solution of the differential equation:

.

$OJRULWKP Asymptotic expansion (Abramowitz and Stegun, 1972)

6HH�DOVR $L for example

EVSOLQH � ,QWHUSRODWLRQ�DQG�3UHGLFWLRQ

6\QWD[ EVSOLQH�vx, vy, u,�n�

'HVFULSWLRQ Returns the vector of coefficients of a B-spline of degree n, given the knot locations indicated 
by the values in u. The output vector becomes the first argument of the�LQWHUS�function.

$UJXPHQWV
vx, vy real vectors of the same size; elements of vx must be in ascending order

u real vector with  fewer elements than vx; elements of u must be in ascending order; first 
element of vx is  first element of u; last element of vx is  last element of u

n integer equal to 1, 2, or 3; represents the degree of the individual piecewise linear, quadratic, or 
cubic polynomial fits

&RPPHQWV The knots, those values where the pieces fit together, are contained in the input vector u. This is 
unlike traditional splines (OVSOLQH, FVSOLQH, and SVSOLQH) where the knots are forced to be the 
values contained in the vector vx. The fact that knots are chosen or modified by the user gives 
EVSOLQH more flexibility than the other splines.

6HH�DOVR OVSOLQH for more details

ber n x,( ) i bei n x,( )⋅+

x
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x2
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EXOVWRHU � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ EXOVWRHU�y,�x1, x2, acc, D,�kmax, save��

'HVFULSWLRQ Solves a differential equation using the smooth Bulirsch-Stoer method. Provides DE solution 
estimate at x2.

$UJXPHQWV Several arguments for this function are the same as described for UNIL[HG.

y real vector of initial values

x1, x2 real endpoints of the solution interval

acc real acc > 0 controls the accuracy of the solution; a small value of acc forces the algorithm to 
take smaller steps along the trajectory, thereby increasing the accuracy of the solution. Values 
of acc around 0.001 will generally yield accurate solutions.

D(x, y) real vector-valued function containing the derivatives of the unknown functions

kmax integer kmax > 0 specifies maximum number of intermediate points at which the solution is 
approximated; places an upper bound on the number of rows of the matrix returned by these 
functions 

save real save > 0 specifies the smallest allowable spacing between values at which the solutions are 
approximated; places a lower bound on the difference between any two numbers in the first 
column of the matrix returned by the function

&RPPHQWV The specialized DE solvers�%XOVWRHU,�5NDGDSW,�6WLIIE,�and�6WLIIU provide the solution y(x) over 
a number of uniformly spaced x-values in the integration interval bounded by x1 and x2. When 
you want the value of the solution at only the endpoint, y(x2), use EXOVWRHU,�UNDGDSW,�VWLIIE, and 
VWLIIU instead.

$OJRULWKP Adaptive step Bulirsch-Stoer method (Press et al., 1992)

6HH�DOVR UNIL[HG,�a more general differential equation solver, for information on output and arguments.

%XOVWRHU � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ %XOVWRHU�y, x1, x2, npts, D��

'HVFULSWLRQ Solves a differential equation using the smooth Bulirsch-Stoer method. Provides DE solution at 
equally spaced x-values by repeated calls to EXOVWRHU. 

$UJXPHQWV All arguments for this function are the same as described for UNIL[HG.

y real vector of initial values 

x1, x2 real endpoints of the solution interval 

npts integer npts > 0 specifies the number of points beyond initial point at which the solution is to be 
approximated; controls the number of rows in the matrix output

D(x,y) real vector-valued function containing the derivatives of the unknown functions 

&RPPHQWV When you know the solution is smooth, use the %XOVWRHU function instead of UNIL[HG. The 
%XOVWRHU function uses the Bulirsch-Stoer method which is slightly more accurate under these 
circumstances than the Runge-Kutta method used by UNIL[HG.

$OJRULWKP Fixed step Bulirsch-Stoer method with adaptive intermediate steps (Press et al., 1992)

6HH�DOVR UNIL[HG,�a more general differential equation solver, for information on output and arguments. 
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EYDOILW� � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ EYDOILW�v1, v2, x1, x2, xf, D, load1, load2, score�

'HVFULSWLRQ Converts a boundary value differential equation to initial/terminal value problems. Useful when 
derivatives have a single discontinuity at an intermediate point xf. 

$UJXPHQWV
v1 real vector containing guesses for initial values left unspecified at x1

v2 real vector containing guesses for initial values left unspecified at x2

x1, x2 real endpoints of the interval on which the solution to the DEs are evaluated

xf point between x1 and x2 at which the trajectories of the solutions beginning at x1 and those 
beginning at x2 are constrained to be equal

D(x, y) real n-element vector-valued function containing the derivatives of the unknown functions

load1(x1, v1) real vector-valued function whose n elements correspond to the values of the n unknown functions 
at x1. Some of these values are constants specified by your initial conditions. If a value is 
unknown, you should use the corresponding guess value from v1

load2(x2, v2) analogous to load1 but for values taken by the n unknown functions at x2

score(xf, y) real n-element vector-valued function used to specify how you want the solutions to match at xf
One usually defines score(xf, y) := y to make the solutions to all unknown functions match up at xf

([DPSOH

&RPPHQWV If you have information at the initial and terminal points, use VEYDO. If you know something about 
the solution and its first  derivatives at some intermediate value xf,  use EYDOILW.

EYDOILW�solves a two-point boundary value problem of this type by shooting from the endpoints 
and matching the trajectories of the solution and its derivatives at the intermediate point. EYDOILW 
is especially useful when a derivative has a discontinuity somewhere in the integration interval, 
as the above example illustrates. EYDOILW does not return a solution to a differential equation. It 
merely computes the initial values the solution must have in order for the solution to match the 
final values you specify. You must then take the initial values returned by�EYDOILW and solve the 
resulting initial value problem using UNIL[HG or any of the other more specialized DE solvers. 

n 1–
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$OJRULWKP Shooting method with 4th order Runge-Kutta method (Press et al., 1992)

6HH�DOVR UNIL[HG, for more information on output and arguments. 

FHLO 7UXQFDWLRQ�DQG�5RXQG�RII

6\QWD[ FHLO�x��

'HVFULSWLRQ Returns the least integer ≥ x. 

$UJXPHQWV
x real number

6HH�DOVR IORRU�for more details, URXQG, WUXQF

FIIW )RXULHU�7UDQVIRUP

6\QWD[ FIIW�A��

'HVFULSWLRQ Returns the fast discrete Fourier transform of complex data (representing measurements at regular 
intervals in the time domain). Returns an array of the same size as its argument. 

$UJXPHQWV
A real or complex matrix or vector

([DPSOH

&RPPHQWV There are two reasons why you may not be able to use the�IIW�LIIW�Fourier�transform pair:

• The data may be complex-valued, hence Mathcad can no longer exploit the symmetry p
in the real-valued case.
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• The data vector might not have exactly  data points in it, hence Mathcad cannot ta
advantage of the efficient FFT algorithm used by the�IIW�LIIW pair.

Although the FIIW�LFIIW�pair works on arrays of any size, the functions work significantly fas
when the number of rows and columns contains many smaller factors. Vectors with lengt
fall into this category, as do vectors having lengths like 100 or 120. Conversely, a vector w
length is a large prime number slows down the Fourier transform algorithm. 

$OJRULWKP Singleton method (Singleton, 1986)

6HH�DOVR IIW for more details

&))7 )RXULHU�7UDQVIRUP

6\QWD[ &))7�A��

'HVFULSWLRQ Returns the fast discrete Fourier transform of complex data (representing measurements at
intervals in the time domain). Returns an array of the same size as its argument. 
Identical to FIIW(A), except uses a different normalizing factor and sign convention (see exam

$UJXPHQWV
A real or complex matrix or vector

([DPSOH

$OJRULWKP Singleton method (Singleton, 1986)

6HH�DOVR IIW for more details

2n

2n
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FKROHVN\� � 9HFWRU�DQG�0DWUL[

6\QWD[ FKROHVN\�M�

'HVFULSWLRQ Returns a lower triangular matrix L satisfying the equation .

$UJXPHQWV
M real, symmetric, positive definite, square matrix

&RPPHQWV FKROHVN\ takes M to be symmetric, in the sense that it uses only the upper triangular part of M 
and assumes it to match the lower triangular part. 

FQRUP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ FQRUP�x�

'HVFULSWLRQ Returns the cumulative standard normal distribution. Same as SQRUP(x, 0, 1).

$UJXPHQWV
x real number

&RPPHQWV FQRUP is provided mainly for compatibility with documents created in earlier versions of 
Mathcad.

FQSHU )LQDQFH

6\QWD[ FQSHU�rate, pv, fv��

'HVFULSWLRQ Returns the number of compounding periods required for an investment to yield a specified future 
value, fv, given a present value, pv, and an interest rate period, rate.

$UJXPHQWV
rate real rate, rate > -1

pv real present value, pv > 0

fv real future value, fv > 0

&RPPHQWV If you know the annual interest rate for the investment, ann_rate, you must calculate the interest 
rate per period as rate = ann_rate/nper.

6HH�DOVR FUDWH,�QSHU

FROV 9HFWRU�DQG�0DWUL[

6\QWD[ FROV�A�

'HVFULSWLRQ Returns the number of columns in array A. 

$UJXPHQWV
A matrix or vector

([DPSOH

6HH�DOVR URZV

L LT⋅ M=
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FRPELQ 1XPEHU�7KHRU\�&RPELQDWRULFV

6\QWD[ FRPELQ�n, k�

'HVFULSWLRQ Returns the number of subsets each of size k that can be formed from n objects.

$UJXPHQWV
n, k integers, 

&RPPHQWV Each such subset is known as a combination. The number of combinations is C . 

6HH�DOVR SHUPXW

FRQFDW � 6WULQJ

6\QWD[ FRQFDW�S1, S2, S3, ...�

'HVFULSWLRQ Appends string S2 to the end of string S1, string S3 to the end of string S2, and so on.

$UJXPHQWV
S1, S2, S3, ... string expressions

FRQG� � 9HFWRU�DQG�0DWUL[

6\QWD[ FRQG��M�

'HVFULSWLRQ Returns the condition number of the matrix M based on the  norm.

$UJXPHQWV
M real or complex square matrix 

FRQG� � 9HFWRU�DQG�0DWUL[

6\QWD[ FRQG��M�

'HVFULSWLRQ Returns the condition number of the matrix M based on the  norm.

$UJXPHQWV
M real or complex square matrix

$OJRULWKP Singular value computation (Wilkinson and Reinsch, 1971)

FRQGH � 9HFWRU�DQG�0DWUL[

6\QWD[ FRQGH�M�

'HVFULSWLRQ Returns the condition number of the matrix M based on the Euclidean norm.

$UJXPHQWV
M real or complex square matrix

FRQGL � 9HFWRU�DQG�0DWUL[

6\QWD[ FRQGL�M�

'HVFULSWLRQ Returns the condition number of the matrix M based on the infinity norm.

$UJXPHQWV
M real or complex square matrix

0 k n≤ ≤
n

k
n!

k! n k–( )!⋅
---------------------------=

L1

L2
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FRUU 6WDWLVWLFV

6\QWD[ FRUU�A, B�

'HVFULSWLRQ Returns the Pearson correlation coefficient for the elements in two  arrays A and B:

$UJXPHQWV
A, B real or complex  matrices or vectors of the same size

6HH�DOVR FYDU

FRV 7ULJRQRPHWULF

6\QWD[ FRV(z), for z in radians;
FRV(z·deg), for z in degrees

'HVFULSWLRQ Returns the cosine of z. 

$UJXPHQWV
z real or complex number

FRVK +\SHUEROLF

6\QWD[ FRVK�z�

'HVFULSWLRQ Returns the hyperbolic cosine of z.

$UJXPHQWV
z real or complex number

FRW 7ULJRQRPHWULF

6\QWD[ FRW(z), for z in radians;
FRW(z·deg), for z in degrees

'HVFULSWLRQ Returns the cotangent of z. 

$UJXPHQWV
z real or complex number; z is not a multiple of π

FRWK +\SHUEROLF

6\QWD[ FRWK�z�

'HVFULSWLRQ Returns the hyperbolic cotangent of z.

$UJXPHQWV
z real or complex number

FUDWH )LQDQFH

6\QWD[ FUDWH�nper, pv, fv��

'HVFULSWLRQ Returns the fixed interest rate required for an investment at present value, pv, to yield a specified 
future value, fv, over a given number of compounding periods, nper.

$UJXPHQWV
nper integer number of compounding periods, nper ≥ 1

pv real present value, pv > 0

fv real future value, fv > 0

6HH�DOVR FQSHU,�UDWH

m n×

corr A B,( ) cvar A B,( )
stdev A( ) stdev B( )⋅
------------------------------------------------------=

m n×
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&UHDWH0HVK 9HFWRU�DQG�0DWUL[

6\QWD[ &UHDWH0HVK�F, s0, s1, t0, t1, sgrid, tgrid,�fmap�

'HVFULSWLRQ Returns a nested array containing points on the parametric surface in 3D space defined by F.

$UJXPHQWV
F real three-dimensional vector-valued function of two variables s and t; defines a parametric 

surface in (u,v,w)-space

s0, s1 (optional) real endpoints for the domain for s, s0 < s1

t0, t1 (optional) real endpoints for the domain for t, t0 < t1

sgrid (optional) integer number of gridpoints in s, sgrid > 0

tgrid (optional) integer number of gridpoints in t, tgrid > 0

fmap (optional) real three-dimensional vector-valued function of three variables u, v and w; defines 
Cartesian coordinates (x,y,z) in terms of (u,v,w)

&RPPHQWV &UHDWH0HVK is used internally by Mathcad when making�3D QuickPlots of surfaces. The default 
value for s0 and t0 is -5, for s1 and t1 it is 5, for sgrid and tgrid it is 20, and for fmap it is the 
identity mapping. If s0 and s1 are explicitly specified, then t0 and t1 must also be specified. The 
number of cells in the grid determined by sgrid and tgrid is (sgrid−1)(tgrid−1). 

There is flexibility in specifying the function F. Calls to &UHDWH0HVK might look like 
&UHDWH0HVK�G�,�where�G�is a real scalar-valued function of u and v (and w=G(u,v)); or 
&UHDWH0HVK(h1,h2,h3),�where�h1, h2, and h3�are real scalar-valued functions of s and t (and 
u=h1(s,t), v=h2(s,t), w=h3(s,t)).

Also, the mapping fmap may be defined to be VSK�[\], a Mathcad built-in function which
converts spherical coordinates (r,θ,φ) to Cartesian coordinates (x,y,z): 

x = u sin(w) cos(v) = r sin(φ) cos(θ)

y = u sin(w) sin(v) = r sin(φ) sin(θ)

z = u cos(w) = r cos(φ)

or F\O�[\], which converts cylindrical coordinates (r,θ,z) to (x,y,z) : 

x = u cos(v) = r cos(θ)

y = u sin(v) = r sin(θ)

z = w = z.

&UHDWH6SDFH 9HFWRU�DQG�0DWUL[

6\QWD[ &UHDWH6SDFH�F,�t0, t1, tgrid, fmap�

'HVFULSWLRQ Returns a nested array containing points on the parametric curve in 3D space defined by F.

$UJXPHQWV
F real three-dimensional vector-valued function of one variable t; defines a parametric curve in 

(u,v,w)-space

t0, t1 (optional) real endpoints for the domain for t, t0 < t1

tgrid (optional) integer number of gridpoints in t, tgrid > 0

fmap (optional) real three-dimensional vector-valued function of three variables u, v and w; defines 
Cartesian coordinates (x,y,z) in terms of (u,v,w)
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&RPPHQWV &UHDWH6SDFH is used internally by Mathcad when making�3D QuickPlots of curves. The default 
value for t0 is -5, for t1 it is 5, for tgrid it is 20, and for fmap it is the identity mapping. The 
number of cells in the grid determined by tgrid is tgrid−1. 

There is flexibility in specifying the function F. Calls to &UHDWH6SDFH might look like 
&UHDWH6SDFH(g1,g2,g3),�where�g1, g2, and g3�are real scalar-valued functions of t and u=g1(t), 
v=g2(t), w=g3(t).

6HH�DOVR &UHDWH0HVK�for information about the mapping fmap.

FVF 7ULJRQRPHWULF

6\QWD[ FVF(z), for z in radians;
FVF(z·deg), for z in degrees

'HVFULSWLRQ Returns the cosecant of z. 

$UJXPHQWV
z real or complex number; z is not a multiple of π

FVFK +\SHUEROLF

6\QWD[ FVFK�z�

'HVFULSWLRQ Returns the hyperbolic cosecant of z.

$UJXPHQWV
z real or complex number

FVJQ &RPSOH[�1XPEHUV

6\QWD[ FVJQ�z�

'HVFULSWLRQ Returns 0 if z=0, 1 if Re(z)>0 or (Re(z)=0 and Im(z)>0), −1 otherwise.

$UJXPHQWV
z real or complex number

6HH�DOVR VLJQ, VLJQXP

FVRUW 6RUWLQJ

6\QWD[ FVRUW�A,�j�

'HVFULSWLRQ Sorts the rows of the matrix A by placing the elements in column j in ascending order. The result
is the same size as A. 

$UJXPHQWV
A  matrix or vector

j integer, 

$OJRULWKP Heap sort (Press et al., 1992)

6HH�DOVR VRUW for more details,�UVRUW

FVSOLQH ,QWHUSRODWLRQ�DQG�3UHGLFWLRQ

2QH�GLPHQVLRQDO�&DVH

6\QWD[ FVSOLQH�vx, vy�

'HVFULSWLRQ Returns the vector of coefficients of a cubic spline with cubic ends. This vector becomes th
argument of the�LQWHUS�function. 

$UJXPHQWV
vx, vy real vectors of the same size; elements of vx must be in ascending order 

m n×
0 j n 1–≤ ≤
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7ZR�GLPHQVLRQDO�&DVH

6\QWD[ FVSOLQH�Mxy, Mz�

'HVFULSWLRQ Returns the vector of coefficients of a two-dimensional cubic spline, constrained to be cubic at 
region boundaries spanned by Mxy. This vector becomes the first argument of�LQWHUS.

$UJXPHQWV
Mxy  matrix whose elements,  and , specify the x- and y-coordinates along the 

diagonal of a rectangular grid. This matrix plays exactly the same role as vx in the one-
dimensional case described above. Since these points describe a diagonal, the elements in each 
column of Mxy must be in ascending order (  whenever ).

Mz  matrix whose ijth element is the z-coordinate corresponding to the point  and 
. Mz plays exactly the same role as vy does in the one-dimensional case above.

$OJRULWKP Tridiagonal system solving (Press et al., 1992; Lorczak)

6HH�DOVR OVSOLQH for more details

FXPLQW )LQDQFH

6\QWD[ FXPLQW�rate, nper, pv, start, end, [type]��

'HVFULSWLRQ Returns the cumulative interest paid on a loan between a starting period, start, and an ending 
period, end, given a fixed interest rate, rate, the total number of compounding periods, nper, and 
the present value of the loan, pv.

$UJXPHQWV
rate real rate, rate ≥ 0
nper integer number of compounding periods, nper ≥ 1

pv real present value

start integer starting period of the accumulation, start ≥ 1
end integer ending period of the accumulation, end ≥ 1, start ≤ end, end ≤ nper

type (optional) indicator payment timing, 0 for payment made at the end of the period, 1 for payment 
made at the beginning, default is type = 0

&RPPHQWV If you know the annual interest rate for the loan, ann_rate, you must calculate the interest rate 
per period as rate = ann_rate/nper.

6HH�DOVR FXPSUQ��LSPW��SPW

FXPSUQ )LQDQFH

6\QWD[ FXPSUQ�rate, nper, pv, start, end, [type]��

'HVFULSWLRQ Returns the cumulative principal paid on a loan between a starting period, start, and an ending 
period, end, given a fixed interest rate, rate, the total number of compounding periods, nper, and 
the present value of the loan, pv.

$UJXPHQWV
rate real rate, rate ≥ 0
nper integer number of compounding periods, nper ≥ 1

pv real present value

start integer starting period of the accumulation, start ≥ 1
end integer ending period of the accumulation, end ≥ 1, start ≤ end, end ≤ nper

type (optional) indicator payment timing, 0 for payment made at the end of the period, 1 for payment 
made at the beginning, default is type = 0

n 2× Mxyi 0, Mxyi 1,

Mxyi k, Mxyj k,< i j<
n n× x Mxyi 0,=
y Mxyj 1,=
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&RPPHQWV If you know the annual interest rate for the loan, ann_rate, you must calculate the interest rate 
per period as rate = ann_rate/nper.

6HH�DOVR FXPLQW��SPW��SSPW

FYDU 6WDWLVWLFV

6\QWD[ FYDU�A, B�

'HVFULSWLRQ Returns the covariance of the elements in two  arrays A and B:

, where the bar indicates

complex conjugation. 

$UJXPHQWV
A, B real or complex  matrices or vectors

6HH�DOVR FRUU

F\O�[\] 9HFWRU�DQG�0DWUL[

6\QWD[ F\O�[\]�r, θ, z�

'HVFULSWLRQ Converts the cylindrical coordinates of a point in 3D space to rectangular coordinates.

$UJXPHQWV
r, θ, z real numbers

&RPPHQWV x = r cos(θ), y = r sin(θ), z = z

6HH�DOVR [\]�F\O

GEHWD 3UREDELOLW\�'HQVLW\

6\QWD[ GEHWD�x, s1, s2�

'HVFULSWLRQ Returns the probability density for a beta distribution: .

$UJXPHQWV
x real number, 

s1, s2 real shape parameters, 

GELQRP 3UREDELOLW\�'HQVLW\

6\QWD[ GELQRP�k, n, p�

'HVFULSWLRQ Returns Pr(X = k) when the random variable X has the binomial distribution: 

.

$UJXPHQWV
k, n integers, 

p real number, 

GFDXFK\ 3UREDELOLW\�'HQVLW\

6\QWD[ GFDXFK\�x, l, s�

'HVFULSWLRQ Returns the probability density for the Cauchy distribution: .

m n×

cvar A B,( ) 1
mn
------- Ai j, mean A( )–[ ] Bi j, mean B( )–[ ]

j 0=

n 1–

∑
i 0=

m 1–

∑=

m n×

Γ s1 s2+( )
Γ s1( ) Γ s2( )⋅
------------------------------- x

s1 1–
1 x–( )s2 1–⋅ ⋅

0 x 1< <
s1 0> s2, 0>

n!
k! n k–( )!
-----------------------pk 1 p–( )n k–

0 k n≤ ≤
0 p 1≤ ≤

πs 1 x l–( ) s⁄( )2+( )( ) 1–
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$UJXPHQWV
x real number

l real location parameter

s real scale parameter, 

GFKLVT 3UREDELOLW\�'HQVLW\

6\QWD[ GFKLVT�x, d�

'HVFULSWLRQ Returns the probability density for the chi-squared distribution: .

$UJXPHQWV
x real number,  

d integer degrees of freedom, 

GH[S 3UREDELOLW\�'HQVLW\

6\QWD[ GH[S�x, r�

'HVFULSWLRQ Returns the probability density for the exponential distribution: .

$UJXPHQWV
x real number,  

r real rate, 

G) 3UREDELOLW\�'HQVLW\

6\QWD[ G)�x, d1, d2�

'HVFULSWLRQ Returns the probability density for the F distribution:

.

$UJXPHQWV
x real number,  

d1, d2 integer degrees of freedom, 

GJDPPD 3UREDELOLW\�'HQVLW\

6\QWD[ GJDPPD�x, s�

'HVFULSWLRQ Returns the probability density for the gamma distribution: .

$UJXPHQWV
x real number,  

s real shape parameter, 

GJHRP 3UREDELOLW\�'HQVLW\

6\QWD[ GJHRP�k, p�

'HVFULSWLRQ Returns Pr(X = k) when the random variable X has the geometric distribution: .

$UJXPHQWV
k integer, 
p real number,  

s 0>

e x 2⁄–

2Γ d 2⁄( )
---------------------- x

2
--- 

  d 2⁄ 1–( )

x 0≥
d 0>

re rx–

x 0≥
r 0>

d1
d1 2⁄

d2
d2 2⁄ Γ d1 d2+( ) 2⁄( )

Γ d1 2⁄( )Γ d2 2⁄( )
----------------------------------------------------------------- x

d1 2–( ) 2⁄

d2 d1x+( ) d1 d2+( ) 2⁄
------------------------------------------------⋅

x 0≥
d1 0> d2, 0>

xs 1– e x–

Γ s( )
-------------------

x 0≥
s 0>

p 1 p–( )k

k 0≥
0 p 1≤<
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GK\SHUJHRP 3UREDELOLW\�'HQVLW\

6\QWD[ GK\SHUJHRP�m, a, b, n�

'HVFULSWLRQ Returns Pr(X = m) when the random variable X has the hypergeometric distribution: 

 where ; 0 for m elsewhere.

$UJXPHQWV
m, a, b, n integers, , , 

GLDJ � 9HFWRU�DQG�0DWUL[

6\QWD[ GLDJ�v�

'HVFULSWLRQ Returns a diagonal matrix containing, on its diagonal, the elements of v.

$UJXPHQWV
v real or complex vector

GOQRUP 3UREDELOLW\�'HQVLW\

6\QWD[ GOQRUP�x,�µ,�σ)

'HVFULSWLRQ Returns the probability density for the lognormal distribution: .

$UJXPHQWV
x real number, 
µ real logmean
σ real logdeviation, 

GORJLV 3UREDELOLW\�'HQVLW\

6\QWD[ GORJLV�x, l, s)

'HVFULSWLRQ Returns the probability density for the logistic distribution: .

$UJXPHQWV
x real number
l real location parameter
s real scale parameter,  

GQELQRP 3UREDELOLW\�'HQVLW\

6\QWD[ GQELQRP�k, n, p)

'HVFULSWLRQ Returns Pr(X = k) when the random variable X has the negative binomial distribution:

$UJXPHQWV
k, n integers,  and 

p real number, 

a
m 

  b
n m– 

  a b+
n 

 ⁄⋅ max 0 n b–,{ } m min n a,{ }≤ ≤

0 m a≤ ≤ 0 n m b≤–≤ 0 n a b+≤ ≤

1

2πσx
----------------- 1

2σ2
---------– x( )ln µ–( )2

 
 exp

x 0≥

σ 0>

x l–( ) s⁄–( )exp
s 1 x l–( ) s⁄–( )exp+( )2
----------------------------------------------------------

s 0>

n k 1–+

k 
  pn 1 p–( )k

n 0> k 0≥
0 p 1≤<
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GQRUP 3UREDELOLW\�'HQVLW\

6\QWD[ GQRUP�x,�µ,�σ)

'HVFULSWLRQ Returns the probability density for the normal distribution: .

$UJXPHQWV
x real number

µ real mean

σ real standard deviation, 

([DPSOH
 

GSRLV 3UREDELOLW\�'HQVLW\

6\QWD[ GSRLV�k,�λ)

'HVFULSWLRQ Returns Pr(X = k) when the random variable X has the Poisson distribution: .

$UJXPHQWV
k integer, 

λ real mean, . 

GW�IXQFWLRQ 3UREDELOLW\�'HQVLW\

6\QWD[ GW�x, d�

'HVFULSWLRQ Returns the probability density for Student’s t distribution: .

$UJXPHQWV
x real number

d integer degrees of freedom, . 

GXQLI 3UREDELOLW\�'HQVLW\

6\QWD[ GXQLI�x, a, b�

'HVFULSWLRQ Returns the probability density for the uniform distribution: .

$UJXPHQWV
x real number, 

a, b real numbers,  

1

2πσ
-------------- 1

2σ2
---------– x µ–( )2

 
 exp

σ 0>

λk

k!
-----e λ–

k 0≥
λ 0>

Γ d 1+( ) 2⁄( )
Γ d 2⁄( ) πd
--------------------------------- 1

x2

d
-----+ 

  d 1+( ) 2⁄–

d 0>

1
b a–
------------

a x≤ b≤
a b<
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GZHLEXOO 3UREDELOLW\�'HQVLW\

6\QWD[ GZHLEXOO�x, s�

'HVFULSWLRQ Returns the probability density for the Weibull distribution: .

$UJXPHQWV
x real number, 

s real shape parameter, 

HII )LQDQFH

6\QWD[ HII�rate, nper�

'HVFULSWLRQ Returns the effective annual interest rate given the nominal interest rate, rate, and the number of 
compounding periods per year, nper.

$UJXPHQWV
rate real rate

nper real number of compounding periods, nper ≥ 1

&RPPHQWV Effective annual interest rate is also known as annual percentage rate (APR).

6HH�DOVR QRP

HLJHQYDOV 9HFWRU�DQG�0DWUL[

6\QWD[ HLJHQYDOV�M�

'HVFULSWLRQ Returns a vector of eigenvalues for the matrix M.

$UJXPHQWV
M real or complex square matrix

([DPSOH

$OJRULWKP Reduction to Hessenberg form coupled with QR decomposition (Press et al., 1992)

6HH�DOVR HLJHQYHF, HLJHQYHFV

HLJHQYHF 9HFWRU�DQG�0DWUL[

6\QWD[ HLJHQYHF�M,�z�

'HVFULSWLRQ Returns a vector containing the normalized eigenvector corresponding to the eigenvalue z of the 
square matrix M. 

$UJXPHQWV
M real or complex square matrix

z real or complex number

$OJRULWKP Inverse iteration (Press et al., 1992; Lorczak)

6HH�DOVR HLJHQYDOV,�HLJHQYHFV

sxs 1– x– s( )exp

x 0≥
s 0>
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HLJHQYHFV � 9HFWRU�DQG�0DWUL[

6\QWD[ HLJHQYHFV�M�

'HVFULSWLRQ Returns a matrix containing the normalized eigenvectors corresponding to the eigenvalues of the 
matrix M. The nth column of the matrix is the eigenvector corresponding to the nth eigenvalue 
returned by HLJHQYDOV. 

$UJXPHQWV
M real or complex square matrix

$OJRULWKP Reduction to Hessenberg form coupled with QR decomposition (Press et al., 1992)

6HH�DOVR HLJHQYDOV,�HLJHQYHF

([DPSOH

HUI 6SHFLDO

6\QWD[ HUI�x�

'HVFULSWLRQ Returns the error function .

$UJXPHQWV
x real number

$OJRULWKP Continued fraction expansion (Abramowitz and Stegun, 1972; Lorczak)

6HH�DOVR HUIF

HUIF 6SHFLDO

6\QWD[ HUIF�x�

'HVFULSWLRQ Returns the complementary error function .

$UJXPHQWV
x real number

$OJRULWKP Continued fraction expansion (Abramowitz and Stegun, 1972; Lorczak)

6HH�DOVR HUI

erf x( ) 2

π
-------e t2– td

0

x

∫=

erfc x( ) 1 erf x( )–:=
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HUURU � 6WULQJ

6\QWD[ HUURU�S�

'HVFULSWLRQ Returns the string S as an error message.

$UJXPHQWV
S string

([DPSOH

&RPPHQWV Mathcad’s built-in error messages appear as “error tips” when a built-in function is used 
incorrectly or could not return a result.

Use the string function HUURU to define specialized error messages that will appear when yo
user-defined functions are used improperly or cannot return answers.This function is espe
useful for trapping erroneous inputs to Mathcad programs you write. 

When Mathcad encounters the HUURU function in an expression, it highlights the expression in
red. When you click on the expression, the error message appears in a tool tip that hover
the expression. The text of the message is the string argument you supply to the HUURU function.

H[S /RJ�DQG�([SRQHQWLDO

6\QWD[ H[S�z�

'HVFULSWLRQ Returns the value of the exponential function .

$UJXPHQWV
z real or complex number

H[SILW 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ H[SILW�vx, vy, vg�

'HVFULSWLRQ Returns a vector containing the parameters (a, b, c) that make the function  best 
approximate the data in vx and vy.

$UJXPHQWV
vx, vy real vectors of the same size

vg real vector of guess values for (a, b, c)

&RPPHQWV This is a special case of the JHQILW�function. A vector of guess values is needed for initializatio
By decreasing the value of the built-in TOL variable, higher accuracy in H[SILW might be achieved. 

6HH�$OVR OLQH,�OLQILW,�JHQILW,�ORJILW,�OQILW, SZUILW,�OJVILW,�VLQILW,�PHGILW

ez

a e⋅ b x⋅ c+
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IIW )RXULHU�7UDQVIRUP

6\QWD[ IIW�v�

'HVFULSWLRQ Returns the fast discrete Fourier transform of real data. Returns a vector of size . 

$UJXPHQWV
v real vector with  elements (representing measurements at regular intervals in the time domain), 

where n is an integer, n > 0.

([DPSOH

&RPPHQWV When you define a vector v for use with Fourier or wavelet transforms, be sure to start with  
(or change the value of ORIGIN). If you do not define , Mathcad automatically sets it to zero. 
This can distort the results of the transform functions.

Mathcad comes with two types of Fourier transform pairs: IIW�LIIW�DQG�FIIW�LFIIW. These functions 
can be applied only to discrete data (i.e., the inputs and outputs are vectors and matrices only). 
You cannot apply them to continuous data. 

2n 1– 1+

2n

v0
v0
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Use the�IIW�and�LIIW�functions if:

• the data values in the time domain are real, and
• the data vector has  elements.
Use the FIIW and�LFIIW�functions in all other cases.

The first condition is required because the IIW�LIIW�pair takes advantage of the fact that, for rea
data, the second half of the transform is just the conjugate of the first. Mathcad discards t
second half of the result vector to save time and memory. The FIIW�LFIIW pair does not assume 
symmetry in the transform; therefore you must use this pair for complex valued data. Becaus
the real numbers are just a subset of the complex numbers, you can use the FIIW�LFIIW�pair for real 
numbers as well.

The second condition is required because the�IIW�LIIW�transform pair uses a highly efficient fast
Fourier transform algorithm. In order to do so, the vector you use with IIW must have  elements. 
The FIIW�LFIIW Fourier transform pair uses an algorithm that permits vectors as well as matr
of arbitrary size. When you use this transform pair with a matrix, you get back a two-dimens
Fourier transform.

If you used�IIW�to get to the frequency domain, you must use�LIIW to get back to the time domain.
Similarly, if you used�FIIW�to get to the frequency domain, you must use�LFIIW�to get back to the 
time domain.

Different sources use different conventions concerning the initial factor of the Fourier trans
and whether to conjugate the results of either the transform or the inverse transform. The fun
IIW,�LIIW, FIIW, and�LFIIW�use  as a normalizing factor and a positive exponent in going from the t
to the frequency domain. The functions ))7,�,))7, &))7, and�,&))7�use  as a normalizing 
factor and a negative exponent in going from the time to the frequency domain. Be sure t
these functions in pairs. For example, if you used &))7 to go from the time domain to the 
frequency domain, you must use ,&))7 to transform back to the time domain.

The elements of the vector returned by IIW satisfy the following equation:

In this formula, n is the number of elements in v and i is the imaginary unit. 

The elements in the vector returned by the IIW function correspond to different frequencies. To
recover the actual frequency, you must know the sampling frequency of the original signav 
is an n-element vector passed to the IIW function, and the sampling frequency is , the frequen
corresponding to  is 

Therefore, it is impossible to detect frequencies above the sampling frequency. This is a limi
not of Mathcad, but of the underlying mathematics itself. In order to correctly recover a si
from the Fourier transform of its samples, you must sample the signal with a frequency of a
twice its bandwidth. A thorough discussion of this phenomenon is outside the scope of th
manual but within that of any textbook on digital signal processing.

$OJRULWKP Cooley-Tukey (Press et al., 1992)

2n

2n

1 n⁄

cj
1

n
------- vke2π i j n⁄( )k

k 0=

n 1–

∑=

fs
ck

fk
k
n
--- fs⋅=
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))7 )RXULHU�7UDQVIRUP

6\QWD[ ))7�v�

'HVFULSWLRQ Identical to�IIW(v), except uses a different normalizing factor and sign convention. Returns a 
vector of size . 

$UJXPHQWV
v real vector with  elements (representing measurements at regular intervals in the time domain), 

where n is an integer, n > 0.

&RPPHQWV The definitions for the Fourier transform discussed in the�IIW�entry are not the only ones used. 
For example, the following definitions for the discrete Fourier transform and its inverse appear 
in Ronald Bracewell’s The Fourier Transform and Its Applications (McGraw-Hill, 1986):

 

These definitions are very common in engineering literature. To use these definitions rathe
those presented in the last section, use the functions ))7,�,))7, &))7, and�,&))7. These differ 
from those discussed in the last section as follows:

• Instead of a factor of 1/  in front of both forms, there is a factor of 1/n in front of the 
transform and no factor in front of the inverse.

• The minus sign appears in the exponent of the transform instead of in its inverse.
The functions ))7,�,))7, &))7, and�,&))7 are used in exactly the same way as the functions IIW,�
LIIW, FIIW, and�LFIIW.

$OJRULWKP Cooley-Tukey (Press et al., 1992)

6HH�DOVR IIW for more details

IK\SHU � 6SHFLDO

6\QWD[ IK\SHU�a, b, c, x�

'HVFULSWLRQ Returns the value of the Gauss hypergeometric function .

$UJXPHQWV
a, b, c, x real numbers, 

&RPPHQWV The hypergeometric function is a solution of the differential equation

.

Many functions are special cases of the hypergeometric function, e.g., elementary ones l

,

and more complicated ones like Legendre functions.

$OJRULWKP Series expansion (Abramowitz and Stegun, 1972)

2n 1– 1+

2n

F υ( ) 1
n
--- f τ( )e 2π i υ n⁄( )τ–

τ 1=

n

∑= f τ( ) F υ( )e2π i τ n⁄( )υ

υ 1=

n
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n

F2 1 a b c x );;,(

1– x 1< <

x 1 x–( )
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2
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d

y⋅ ⋅ c a b 1+ +( )– x⋅( ) d
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------y⋅ a b y⋅ ⋅–+ 0=
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2
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2
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)LQG 6ROYLQJ

6\QWD[ )LQG�var1, var2, ...�

'HVFULSWLRQ Returns values of var1, var2, ... which solve a prescribed system of equations, subject to 
prescribed inequalities. The number of arguments matches the number of unknowns. Output is 
a scalar if only one argument; otherwise it is a vector of answers. 

$UJXPHQWV
var1, var2, ... real or complex variables; var1, var2,.. must be assigned guess values before using )LQG.

([DPSOHV

Figure 17-1: Example 1: A solve block with one equation in one unknown.

Figure 17-2: Example 2: A solve block with both equations and inequalities.
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Figure 17-3: Example 3: Solving an equation repeatedly (by defining the 
Reynolds number R to be a range variable).

Figure 17-4: Example 4: A solve block for computing the square root of a 
matrix.
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Figure 17-5: Example 5: A solve block for computing the solution of a matrix 
equation.

&RPPHQWV Mathcad lets you numerically solve a system of up to 200 simultaneous equations in 200 
unknowns. If you aren’t sure that a given system possesses a solution but need an appro
answer which minimizes error, use 0LQHUU instead. To solve an equation symbolically, that is
to find an exact answer in terms of elementary functions, choose Solve for Variable from the 
Symbolic menu or use the VROYH keyword.

There are four steps to solving a system of simultaneous equations:

1. Provide initial guesses for all the unknowns you intend to solve for. These give Mathc
place to start searching for solutions. Use complex guess values if you anticipate com
solutions; use real guess values if you anticipate real solutions.

2. Type the word *LYHQ. This tells Mathcad that what follows is a system of equality or 
inequality constraints. You can type *LYHQ or JLYHQ in any style. Just don't type it while in
a text region. 

3. Type the equations and inequalities in any order below the word *LYHQ. Use [Ctrl]= to 
type “=.” 

4. Finally, type the )LQG function with your list of unknowns. You can’t put numerical value
in the list of unknowns: for example, )LQG(2) in Example 1 isn’t permitted. Like JLYHQ, you 
can type )LQG or�ILQG in any style.

The word *LYHQ, the equations and inequalities that follow, and the )LQG function form a solve 
block. 

Example 1 shows a worksheet that contains a solve block for one equation in one unknow
one equation in one unknown, you can also use the URRW or SRO\URRWV functions.

Mathcad is very specific about the types of expressions that can appear between *LYHQ and )LQG. 
See Example 2. The types of allowable constraints are z=w, x>y, x<y, x≥y and x≤y. Mathcad 
does not allow the following inside a solve block:

• Constraints with “≠”

• Range variables or expressions involving range variables of any kind

• Any kind of assignment statement (statements like x:=1)
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If you want to include the outcome of a solve block in an iterative calculation, see Example 3.

Solve blocks cannot be nested inside each other. Each solve block can have only one *LYHQ and 
one )LQG. You can however, define a function like  at the end of one solve block 
and use this same function in another solve block.

If the solver cannot make any further improvements to the solution but the constraints are not all 
satisfied, then the solver stops and marks )LQG with an error message. This happens whenever 
the difference between successive approximations to the solution is greater than TOL and:

• The solver reaches a point where it cannot reduce the error any further.

• The solver reaches a point from which there is no preferred direction. Becau
this, the solver has no basis on which to make further iterations.

• The solver reaches the limit of its accuracy. Round-off errors make it unlikely 
further computation would increase accuracy of the solution. This often happe

you set 72/ to a value below .

The following problems may cause this sort of failure:
• There may actually be no solution. 

• You may have given real guesses for an equation with no real solution. If the
solution for a variable is complex, the solver will not find it unless the starting va
for that variable is also complex.

• The solver may have become trapped in a local minimum for the error values
find the actual solution, try using different starting values or add an inequality
keep Mathcad from being trapped in the local minimum.

• The solver may have become trapped on a point that is not a local minimum,
from which it cannot determine where to go next. Again, try changing the init
guesses or adding an inequality to avoid the undesirable stopping point.

• It may not be possible to solve the constraints to within the desired tolerance
defining 72/ with a larger value somewhere above the solve block. Increasing
tolerance changes what Mathcad considers close enough to call a solution.

The pop-up menu (right mouse click) associated with )LQG contains the following options:

• AutoSelect − chooses an appropriate algorithm 

• Linear option − indicates that the problem is linear (and thus applies linear 
programming methods to the problem); guess values for var1, var2,... are immate-
rial (can all be zero) 

• Nonlinear option − indicates that the problem is nonlinear (and thus applies th
general methods to the problem: the conjugate gradient solver; if that fails to
converge, the Levenberg-Marquardt solver; if that too fails, the quasi-Newton
solver); guess values for var1, var2,... greatly affect the solution

f x( ) Find x( ):=

10 15–
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• Quadratic option (appears only if the Solving and Optimization Extension Pac
Expert Solver product is installed) − indicates that the problem is quadratic (and
thus applies quadratic programming methods to the problem); guess values for var1, 
var2,... are immaterial (can all be zero)

• Advanced options − applies only to the nonlinear conjugate gradient and the qu
Newton solvers 

These options provide you more control in trying different algorithms for testing and comparison. 
You may also adjust the values of the built-in variables &72/ and 72/. The constraint tolerance 
&72/ controls how closely a constraint must be met for a solution to be acceptable; if &72/ were 
0.001, then a constraint such as x < 2 would be considered satisfied if the value of x satisfied x 
< 2.001. This can be defined or changed in the same way as the convergence tolerance 72/. The 
default value for &72/ is 10-3.

Other Solving and Optimization Extension Pack features include mixed integer programming 
and constraint sensitivity report generation. See on-line Help for details.

$OJRULWKP For the non-linear case: Levenberg-Marquardt, Quasi-Newton, Conjugate Gradient. For the 
linear case: simplex method with branch/bound techniques (Press et al., 1992; Polak, 1997; 
Winston, 1994)

6HH�DOVR 0LQHUU,�0D[LPL]H,�0LQLPL]H

IORRU 7UXQFDWLRQ�DQG�5RXQG�RII

6\QWD[ IORRU�x�

'HVFULSWLRQ Returns the greatest integer ≤ x.

$UJXPHQWV
x real number

([DPSOH

&RPPHQWV Can be used to define the positive fractional part of a number: PDQWLVVD(x) := x - IORRU(x).

6HH�DOVR FHLO��URXQG��WUXQF

IY )LQDQFH

6\QWD[ IY�rate, nper, pmt,�>>pv@,�>type@@��

'HVFULSWLRQ Returns the future value of an investment or loan over a specified number of compounding 
periods, nper, given a periodic, constant payment, pmt, and a fixed interest rate, rate.

$UJXPHQWV
rate real rate

nper integer number of compounding periods, nper ≥ 1

pmt real payment

pv (optional) real present value, default is pv = 0

type (optional) indicator payment timing, 0 for payment made at the end of the period, 1 for payment 
made at the beginning, default is type = 0
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&RPPHQWV If you know the annual interest rate, ann_rate, you must calculate the interest rate per period as 
rate = ann_rate/nper.

Payments you make, such as deposits into a savings account or payments toward a loan, must be 
entered as negative numbers. Cash you receive, such as dividend checks, must be entered as 
positive numbers.

6HH�DOVR IYDGM,�IYF,�QSHU,�SPW,�SY,�UDWH

IYDGM )LQDQFH

6\QWD[ IYDGM�prin,�v��

'HVFULSWLRQ Returns the future value of an initial principal, prin, after applying a series of compound interest 
rates stored in a vector, v.

$UJXPHQWV
prin real principal

v real vector of interest rates

&RPPHQWV Use IYDGM to calculate the future value of an investment with a variable or adjustable interest rate.

6HH�DOVR IY,�IYF

IYF )LQDQFH

6\QWD[ IYF�rate,�v��

'HVFULSWLRQ Returns the future value of a list of cash flows occurring at regular intervals, v, earning a specified 
interest rate, rate.

$UJXPHQWV
rate real rate

v real vector of cash flows

&RPPHQWV In v, payments must be entered as negative numbers and income must be entered as positive 
numbers.

IYF assumes that the payment is made at the end of the period.

6HH�DOVR IY,�IYDGM

JFG 1XPEHU�7KHRU\�&RPELQDWRULFV

6\QWD[ JFG�A�

'HVFULSWLRQ Returns the largest positive integer that is a divisor of all the values in the array A. This integer 
is known as the greatest common divisor of the elements in A.

$UJXPHQWV
A integer matrix or vector; all elements of A are greater than zero

&RPPHQWV JFG(A, B, C, ...) is also permissible and returns the greatest common divisor of the elements of 
A, B, C, ....

$OJRULWKP Euclid’s algorithm (Niven and Zuckerman, 1972)

6HH�DOVR OFP
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JHQILW 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ JHQILW�vx, vy, vg, F�

'HVFULSWLRQ Returns a vector containing the parameters that make a function f of x and n parameters 
 best approximate the data in vx and vy.

$UJXPHQWV
vx, vy real vectors of the same size

vg real vector of guess values for the n parameters

F a function that returns an n+1 element vector containing f and its partial derivatives with respect 
to its n parameters

([DPSOH

&RPPHQWV The functions OLQILW and JHQILW are closely related. Anything you can do with OLQILW you can also 
do, albeit less conveniently, with JHQILW. The difference between these two functions is analogous 
to the difference between solving a system of linear equations and solving a system of nonlinear 
equations. The former is easily done using the methods of linear algebra. The latter is far more 
difficult and generally must be solved by iteration. This explains why JHQILW needs a vector of 
guess values as an argument and OLQILW does not.

The example above uses JHQILW to find the exponent that best fits a set of data. By decreasing the 
value of the built-in TOL variable, higher accuracy in�JHQILW�might be achieved.

$OJRULWKP Levenberg-Marquardt (Press et al., 1992)

6HH�DOVR OLQH��OLQILW��H[SILW��ORJILW��OQILW, SZUILW��OJVILW��VLQILW��PHGILW

JHQLQY � 9HFWRU�DQG�0DWUL[

6\QWD[ JHQLQY�A�

'HVFULSWLRQ Returns the left inverse of a matrix A.

$UJXPHQWV
A real  matrix, where .

&RPPHQWV If L denotes the left inverse, then  where I is the identity matrix with FROV(I)=FROV(A).

$OJRULWKP SVD-based construction (Nash, 1979)

u0 u1 … un 1–, , ,

m n× m n≥

L A⋅ I=
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JHQYDOV � 9HFWRU�DQG�0DWUL[

6\QWD[ JHQYDOV�M, N�

'HVFULSWLRQ Returns a vector v of eigenvalues each of which satisfies the generalized eigenvalue equation 
 for nonzero eigenvectors x.

$UJXPHQWV
M, N real square matrices of the same size

([DPSOH

&RPPHQWV To compute the eigenvectors, use JHQYHFV. 

$OJRULWKP Stable QZ method (Golub and Van Loan, 1989)

JHQYHFV � 9HFWRU�DQG�0DWUL[

6\QWD[ JHQYHFV�M, N�

'HVFULSWLRQ Returns a matrix of normalized eigenvectors corresponding to the eigenvalues in v, the vector 
returned by JHQYDOV. The jth column of this matrix is the eigenvector x satisfying the generalized 
eigenvalue problem . 

$UJXPHQWV
M, N real square matrices of the same size

$OJRULWKP Stable QZ method (Golub and Van Loan, 1989)

6HH�DOVR JHQYDOV for example

M x⋅ vj N x⋅ ⋅=

M x⋅ vj N x⋅ ⋅=
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*(7:$9,1)2 )LOH�$FFHVV

6\QWD[ *(7:$9,1)2�file�

'HVFULSWLRQ Creates a vector with four elements containing information about file. The elements corresponds 
to the number of channels, the sample rate, the number of bits per sample (resolution), and average 
number of bytes per second, respectively.

$UJXPHQWV
file string variable corresponding to pulse code modulated (PCM) Microsoft WAV filename or path

&RPPHQWV Data from a WAV file is not scaled. 

6HH�DOVR 5($':$9�and :5,7(:$9

JPHDQ 6WDWLVWLFV

6\QWD[ JPHDQ�A�

'HVFULSWLRQ Returns the geometric mean of the elements of A: . 

$UJXPHQWV
A real  matrix or vector with all elements greater than zero

&RPPHQWV JPHDQ(A, B, C, ...) is also permissible and returns the geometric mean of the elements of A, B, 
C, ....

6HH�DOVR KPHDQ��PHDQ��PHGLDQ��PRGH

+HU � 6SHFLDO

6\QWD[ +HU�n, x�

'HVFULSWLRQ Returns the value of the Hermite polynomial of degree n at x. 

$UJXPHQWV
n integer, n ≥ 0

x real number

&RPPHQWV The nth degree Hermite polynomial is a solution of the differential equation:

.

$OJRULWKP Recurrence relation (Abramowitz and Stegun, 1972)

KLVW 6WDWLVWLFV

8QLIRUP�%LQ�&DVH

6\QWD[ KLVW�n, A�

'HVFULSWLRQ Returns a vector containing the frequencies with which values in A fall in n subintervals of the 
range  of equal length. The resulting histogram vector has n 
elements. 

$UJXPHQWV
n integer, n > 0
A real matrix

gmean A( ) Ai j,
j 0=

n 1–

∏
i 0=

m 1–

∏
 
 
 
  1 mn( )⁄

=

m n×

x
x2

2

d
d

y⋅ 2 x⋅–
d

dx
------y 2 n y⋅ ⋅+⋅ 0=

min A( ) value max A( )≤ ≤
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&RPPHQWV This is identical to KLVW(intervals, A) with  
and  (see below).

1RQ�XQLIRUP�%LQ�&DVH

6\QWD[ KLVW(intervals, A)

'HVFULSWLRQ Returns a vector containing the frequencies with which values in A fall in the intervals represented 
by the intervals vector. The resulting histogram vector is one element shorter than intervals. 

$UJXPHQWV
intervals real vector with elements in ascending order

A real matrix

([DPSOH

&RPPHQWV The intervals vector contains the endpoints of subintervals constituting a partition of the data. 
The result of the KLVW function is a vector f, in which  is the number of values in A satisfying 
the condition .

Mathcad ignores data points less than the first value in intervals or greater than the last value in 
intervals.

6HH�DOVR KLVWRJUDP

KLVWRJUDP 6WDWLVWLFV

8QLIRUP�%LQ�&DVH

6\QWD[ KLVWRJUDP�n, A�

'HVFULSWLRQ Returns a matrix with two columns. The first column contains midpoints of the n subintervals of 
the range  of equal length. The second column is identical to 
KLVW�n, A�, and hence the resulting matrix has n rows. 

$UJXPHQWV
n integer, n > 0
A real matrix

intervalsi min A( ) max A( ) min A( )–
n

---------------------------------------------- i⋅+=
0 i n≤ ≤

fi
intervalsi value intervalsi 1+<≤

min A( ) value max A( )≤ ≤
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&RPPHQWV Using KLVWRJUDP rather than KLVW�saves you the additional step of defining horizontal axis data 
when plotting.

1RQ�XQLIRUP�%LQ�&DVH

6\QWD[ KLVWRJUDP(intervals, A)

'HVFULSWLRQ Returns a matrix with two columns. The first column contains midpoints of the intervals 
represented by the intervals vector. The second column is identical to KLVW(intervals, A), 
and hence the resulting matrix has one less row than intervals. 

$UJXPHQWV
intervals real vector with elements in ascending order

A real matrix

6HH�DOVR KLVW

KORRNXS� � 9HFWRU�DQG�0DWUL[

6\QWD[ KORRNXS�z,�A, r�

'HVFULSWLRQ Looks in the first row of a matrix, A, for a given value, z, and returns the value(s) in 
the same column(s) in the row specified, r. When multiple values are returned, they appear 
in a vector.

$UJXPHQWV
z real or complex number, or string

A real, complex or string  matrix

r integer,

&RPPHQWV The degree of precision to which the comparison adheres is determined by the TOL setting of 
the worksheet.

6HH�$OVR ORRNXS,�YORRNXS,�PDWFK

KPHDQ 6WDWLVWLFV

6\QWD[ KPHDQ�A�

'HVFULSWLRQ Returns the harmonic mean of the elements of A: .

$UJXPHQWV
A real  matrix or vector with all elements greater than zero

&RPPHQWV KPHDQ(A, B, C, ...) is also permissible and returns the harmonic mean of the elements of A, B, 
C, ....

6HH�DOVR JPHDQ��PHDQ��PHGLDQ��PRGH

,� %HVVHO

6\QWD[ ,��x�

'HVFULSWLRQ Returns the value of the modified Bessel function  of the first kind. Same as ,Q(0, x).

$UJXPHQWV
x real number

$OJRULWKP Small order approximation (Abramowitz and Stegun, 1972)

m n×
ORIGIN r ORIGIN m 1–+≤ ≤

hmean A( ) 1
mn
------- 1

Ai j,
---------

j 0=

n 1–

∑
i 0=

m 1–

∑
 
 
 
  1–

=

m n×

I0 x( )
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,� %HVVHO

6\QWD[ ,��x�

'HVFULSWLRQ Returns the value of the modified Bessel function  of the first kind. Same as ,Q(1, x).

$UJXPHQWV
x real number

$OJRULWKP Small order approximation (Abramowitz and Stegun, 1972)

LEHWD � 6SHFLDO

6\QWD[ LEHWD�a, x, y�

'HVFULSWLRQ Returns the value of the incomplete beta function with parameter a, at (x, y).

$UJXPHQWV�
a real number, 

x, y real numbers, x > 0, y > 0

&RPPHQWV The incomplete beta function often arises in probabilistic applications. It is defined by the 
following formula: 

.

$OJRULWKP Continued fraction expansion (Abramowitz and Stegun, 1972)

LFIIW )RXULHU�7UDQVIRUP

6\QWD[ LFIIW�A�

'HVFULSWLRQ Returns the inverse Fourier transform corresponding to FIIW. Returns an array of the same size 
as its argument. 

$UJXPHQWV
A real or complex matrix or vector

&RPPHQWV The�FIIW�and�LFIIW functions are exact inverses; .

$OJRULWKP Singleton method (Singleton, 1986)

6HH�DOVR IIW for more details and FIIW for example

,&))7 )RXULHU�7UDQVIRUP

6\QWD[ ,&))7�A�

'HVFULSWLRQ Returns the inverse Fourier transform corresponding to &))7. Returns an array of the same size 
as its argument. 

$UJXPHQWV
A real or complex matrix or vector

&RPPHQWV The�&))7�and�,&))7 functions are exact inverses; .

$OJRULWKP Singleton method (Singleton, 1986)

6HH�DOVR fft for more details and &))7 for example

I1 x( )

0 a 1≤ ≤

ibeta a x y, ,( ) Γ x y+( )
Γ x( ) Γ y( )⋅
--------------------------- tx 1– 1 t–( )y 1–⋅ td

0

a

∫⋅=

icfft cfft A( )( ) A=

ICFFT CFFT A( )( ) A=
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LGHQWLW\ 9HFWRU�DQG�0DWUL[

6\QWD[ LGHQWLW\�n�

'HVFULSWLRQ Returns the  identity matrix. 

$UJXPHQWV
n integer, n > 0

LI 3LHFHZLVH�&RQWLQXRXV

6\QWD[ LI�cond, x, y�

'HVFULSWLRQ Returns x or y depending on the value of cond. 
If cond is true (non-zero), returns x. If cond is false (zero), returns y. 

$UJXPHQWV
cond arbitrary expression (usually a Boolean expression)

x, y arbitrary real or complex numbers, arrays, or strings

([DPSOH

&RPPHQWV Use�LI�to define a function that behaves one way below a certain number and a different way 
above that number. That point of discontinuity is specified by its first argument, cond. The 
remaining two arguments let you specify the behavior of the function on either side of that 
discontinuity. The argument cond is usually a Boolean expression (made up using the Boolean 
operators  , >, <,  ≥,  ≤, ≠, ∧, ∨, ⊕, or ¬). 

To save time, Mathcad evaluates only the necessary arguments. For example, if cond is false, 
there is no need to evaluate x because it will not be returned anyway. Therefore, errors in the 
unevaluated argument can escape detection. For example, Mathcad will never detect the fact that 
ln(0) is undefined in the expression if(|z| < 0, ln(0), ln(z)).

You can combine Boolean operators to create more complicated conditions. For example, the 
condition (x < 1) ∧ (x > 0) acts like an “and” gate, returning 1 if and only if x is between 
0 and 1. Similarly, the expression (x < 1) ∨ (x > 0) acts like an “or” gate, returning a 1 if and 
only if  or . 

n n×

x 1> x 0<
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LIIW )RXULHU�7UDQVIRUP

6\QWD[ LIIW�v�

'HVFULSWLRQ Returns the inverse Fourier transform corresponding to�IIW. Returns a real vector of size . 

$UJXPHQWV
v real or complex vector of size , where n is an integer.

&RPPHQWV The argument v is a vector similar to those generated by the IIW�function. To compute the result, 
Mathcad first creates a new vector w by taking the conjugates of the elements of v and appending 
them to the vector v. Then Mathcad computes a vector d whose elements satisfy this formula:

.

This is the same formula as the�IIW formula, except for the minus sign in the exponent. The IIW 
and LIIW functions are exact inverses. For all real v, .

$OJRULWKP Cooley-Tukey (Press et al., 1992)

6HH�DOVR IIW for more details

,))7 )RXULHU�7UDQVIRUP

6\QWD[ ,))7�v�

'HVFULSWLRQ Returns the inverse transform corresponding to ))7. Returns a real vector of size . 

$UJXPHQWV
v real or complex vector of size , where n is an integer.

$OJRULWKP Cooley-Tukey (Press et al., 1992)

6HH�DOVR IIW for more details

,P &RPSOH[�1XPEHUV

6\QWD[ ,P�z�

'HVFULSWLRQ Returns the imaginary part of z.

$UJXPHQWV
z real or complex number

6HH�DOVR 5H

,Q %HVVHO

6\QWD[ ,Q�m, x�

'HVFULSWLRQ Returns the value of the modified Bessel function  of the first kind.

$UJXPHQWV
m integer, 

x real number

&RPPHQWV Solution of the differential equation . 

$OJRULWKP Small order approximation, upward recurrence relation (Abramowitz and Stegun, 1972; Press et 
al., 1992)

6HH�DOVR .Q

2n

1 2n 1–+

dj
1

n
------- wke 2π i j n⁄( )k–

k 0=

n 1–

∑=

ifft fft v( )( ) v=

2n

1 2n 1–+

Im x( )

0 m 100≤ ≤

x2

x2

2

d
d

y⋅ x
d

dx
------y⋅ x2 m2+( ) y⋅–+ 0=
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LQWHUFHSW 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ LQWHUFHSW�vx, vy�

'HVFULSWLRQ Returns the y-intercept of the least-squares regression line.

$UJXPHQWV
vx, vy real vectors of the same size

6HH�DOVR VORSH for more details, OLQH,�VWGHUU,�PHGILW

LQWHUS ,QWHUSRODWLRQ�DQG�3UHGLFWLRQ

2QH�GLPHQVLRQDO�&DVH

6\QWD[ LQWHUS�vs, vx, vy,�x�

'HVFULSWLRQ Interpolates the value from spline coefficients or regression coefficients. Takes three vector 
arguments vx, vy (of the same size) and vs. Returns the interpolated y value corresponding to the 
point x. 

$UJXPHQWV
vs real vector output from interpolation routine EVSOLQH, FVSOLQH, OVSOLQH, or SVSOLQH or regression 

routine UHJUHVV or�ORHVV

vx, vy real vectors of the same size

x real number

&RPPHQWV Let us first discuss�LQWHUS on the output of cubic spline routines. To find the interpolated value 
for a particular x, Mathcad finds the two points which x falls between. It then returns the y value 
on the cubic section enclosed by these two points. For x values less than the smallest point in vx, 
Mathcad extrapolates the cubic section connecting the smallest two points of vx. Similarly, for 
x values greater than the largest point in vx, Mathcad extrapolates the cubic section connecting 
the largest two points of vx.

For best results, do not use the�LQWHUS function on values of x far from the fitted points. Splines 
are intended for interpolation, not extrapolation. Consequently, computed values for such x values 
are unlikely to be useful. See SUHGLFW�for an alternative.

In the UHJUHVV case, LQWHUS simply computes the value of the regression polynomial; for�ORHVV, 
LQWHUS uses the local least-squares polynomial on the interval.

7ZR�GLPHQVLRQDO�&DVH

6\QWD[ LQWHUS�vs, Mxy, Mz, v�

'HVFULSWLRQ Interpolates the value from spline coefficients or regression coefficients. Takes two matrix 
arguments Mxy and Mz (with the same number of rows) and one vector argument vs. Returns 
the interpolated z value corresponding to the point  and . 

$UJXPHQWV
vs real vector output from interpolation routine EVSOLQH,�FVSOLQH, OVSOLQH, or SVSOLQH or regression 

routine UHJUHVV or�ORHVV

Mxy, Mz real matrices (with the same number of rows)

v real two-dimensional vector

&RPPHQWV For best results, do not use the LQWHUS function on values of x and y far from the grid points. 
Splines are intended for interpolation, not extrapolation. Consequently, computed values for such 
x and y values are unlikely to be useful. See SUHGLFW�for an alternative.

6HH�DOVR OVSOLQH�for example,�EVSOLQH, FVSOLQH, SVSOLQH,�UHJUHVV, ORHVV

x v0= y v1=
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LSPW )LQDQFH

6\QWD[ LSPW�rate, per, nper, pv,�>>fv@,�>type@@��

'HVFULSWLRQ Returns the interest payment of an investment or loan for a given period, per, based on periodic 
constant payments over a given number of compounding periods, nper, using a fixed interest 
rate, rate, and a specified present value, pv.

$UJXPHQWV
rate real rate

per integer period number, per ≥ 1

nper integer number of compounding periods, 1≤ per ≤ nper

pv real present value

fv (optional) real future value, default is fv = 0

type (optional) indicator payment timing, 0 for payment made at the end of the period, 1 for payment 
made at the beginning, default is type = 0

&RPPHQWV If you know the annual interest rate, ann_rate, you must calculate the interest rate per period as 
rate = ann_rate/nper.

Payments you make, such as deposits into a savings account or payments toward a loan, must be 
entered as negative numbers. Cash you receive, such as dividend checks, must be entered as 
positive numbers.

6HH�DOVR FXPLQW��SPW,�SSPW

LUU )LQDQFH

6\QWD[ LUU�v,�>guess]��

'HVFULSWLRQ Returns the internal rate of return for a series of cash flows, v, occurring at regular intervals.

$UJXPHQWV
v real vector of cash flows

guess (optional) real guess value, default is guess = 0.1 (10%)

&RPPHQWV In v, payments must be entered as negative numbers and income must be entered as positive 
numbers. There must be at least one negative value and one positive value in v.

If LUU�cannot find a result that is accurate to within  percent after 20 iterations, it returns 
an error. In such a case, a different guess value should be tried, although it will not guarantee a 
solution.

6HH�DOVR PLUU��QSY

,V$UUD\ � ([SUHVVLRQ�7\SH

6\QWD[ ,V$UUD\�x�

'HVFULSWLRQ Returns 1 if x is a matrix or vector; 0 otherwise.

$UJXPHQWV
x arbitrary real or complex number, array, or string

1 10 5–⋅
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,V6FDODU � ([SUHVVLRQ�7\SH

6\QWD[ ,V6FDODU�x�

'HVFULSWLRQ Returns 1 if x is a real or complex number; 0 otherwise.

$UJXPHQWV
x arbitrary real or complex number, array, or string

,V6WULQJ � ([SUHVVLRQ�7\SH

6\QWD[ ,V6WULQJ�x�

'HVFULSWLRQ Returns 1 if x is a string; 0 otherwise.

$UJXPHQWV
x arbitrary real or complex number, array, or string

LZDYH � :DYHOHW�7UDQVIRUP

6\QWD[ LZDYH�v�

'HVFULSWLRQ Returns the inverse wavelet transform corresponding to ZDYH.

$UJXPHQWV
v real vector of  elements, where n is an integer, n > 0.

$OJRULWKP Pyramidal Daubechies 4-coefficient wavelet filter (Press et al., 1992)

6HH�DOVR ZDYH for example

-� %HVVHO

6\QWD[ -��x�

'HVFULSWLRQ Returns the value of the Bessel function  of the first kind. Same as -Q(0, x).

$UJXPHQWV
x real number

$OJRULWKP Steed’s method (Press et al., 1992)

-� %HVVHO

6\QWD[ -��x�

'HVFULSWLRQ Returns the value of the Bessel function  of the first kind. Same as�-Q(1, x).

$UJXPHQWV
x real number

$OJRULWKP Steed’s method (Press et al., 1992)

-DF � 6SHFLDO

6\QWD[ -DF�n, a, b, x�

'HVFULSWLRQ Returns the value of the Jacobi polynomial of degree n with parameters a and b, at x. 

$UJXPHQWV
n integer, 

a, b real numbers, a > −1, b > −1

x real number

2n

J0 x( )

J1 x( )

n 0≥
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ess 
&RPPHQWV The Jacobi polynomials are solutions of the differential equation:

 

and include the Chebyshev and Legendre polynomials as special cases.

$OJRULWKP Recurrence relation (Abramowitz and Stegun, 1972)

-Q %HVVHO

6\QWD[ -Q�m, x�

'HVFULSWLRQ Returns the value of the Bessel function  of the first kind.

$UJXPHQWV
m integer, .

x real number

&RPPHQWV Solution of the differential equation .

$OJRULWKP Steed’s method (Press et al., 1992)

6HH�DOVR <Q

MV � %HVVHO

6\QWD[ MV�n, x�

'HVFULSWLRQ Returns the value of the spherical Bessel function of the first kind, of order n, at x. 

$UJXPHQWV
n integer, 

x real number, x > 0; x = 0 is permitted for MV if 

&RPPHQWV Solution of the differential equation: .

$OJRULWKP Small order approximation, upward recurrence relation (Abramowitz and Stegun, 1972; Pret 
al., 1992)

6HH�DOVR \V

.� %HVVHO

6\QWD[ .��x�

'HVFULSWLRQ Returns the value of the modified Bessel function  of the second kind. Same as .Q(0, x).

$UJXPHQWV
x real number, x > 0

$OJRULWKP Small order approximation (Abramowitz and Stegun, 1972)

.� %HVVHO

6\QWD[ .��x�

'HVFULSWLRQ Returns the value of the modified Bessel function  of the second kind. Same as .Q(1, x).

$UJXPHQWV
x real number, x > 0

$OJRULWKP Small order approximation (Abramowitz and Stegun, 1972)

1 x
2
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x2

2
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d
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x2
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y 2x
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n n 1+( )⋅–( )y+⋅+⋅ 0=

K0 x( )

K1 x( )
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.Q %HVVHO

6\QWD[ .Q�m, x�

'HVFULSWLRQ Returns the value of the modified Bessel function  of the second kind. 

$UJXPHQWV
m integer, .

x real number, x > 0

&RPPHQWV Solution of the differential equation .

6HH�DOVR ,Q

$OJRULWKP Small order approximation, upward recurrence relation (Abramowitz and Stegun, 1972; Press et 
al., 1992)

NVPRRWK � 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ NVPRRWK�vx, vy, b�

'HVFULSWLRQ Creates a new vector, of the same size as vy, by using a Gaussian kernel to return weighted 
averages of vy.

$UJXPHQWV
vx, vy real vectors of the same size; elements of vx must be in ascending order 

b real bandwidth b > 0; controls the smoothing window and should be set to a few times the spacing 
between your data points on the x-axis, depending on how big of a window you want to use when 
smoothing

&RPPHQWV The NVPRRWK function uses a Gaussian kernel to compute local weighted averages of the input 
vector vy. This smoother is most useful when your data lies along a band of relatively constant 
width. If your data lies scattered along a band whose width fluctuates considerably, you should 
use an adaptive smoother like VXSVPRRWK.

For each  in the n-element vector vy, the NVPRRWK function returns a new  given by:

 where: 

and b is a bandwidth which you supply to the NVPRRWK function. The bandwidth is usually set 
to a few times the spacing between data points on the x axis, depending on how big a window 
you want to use when smoothing.

$OJRULWKP Moving window Gaussian kernel smoothing (Lorczak)

6HH�DOVR ³PHGVPRRWK´�RQ�SDJH���� for more details, ³VXSVPRRWK´�on page 437

Km x( )

0 m 100≤ ≤

x2

x2

2

d
d

y⋅ x
d

dx
------y⋅ x2 m2+( ) y⋅–+ 0=
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NXUW 6WDWLVWLFV

6\QWD[ NXUW�A�

'HVFULSWLRQ Returns the kurtosis of the elements of A:

$UJXPHQWV
A real or complex  matrix or vector; 

&RPPHQWV NXUW(A, B, C, ...) is also permissible and returns the kurtosis of the elements of A, B, C, ....

/DJ � 6SHFLDO

6\QWD[ /DJ�n, x�

'HVFULSWLRQ Returns the value of the Laguerre polynomial of degree n at x. 

$UJXPHQWV
n integer, 

x real number

&RPPHQWV The Laguerre polynomials are solutions of the differential equation 

.

$OJRULWKP Recurrence relation (Abramowitz and Stegun, 1972)

ODVW 9HFWRU�DQG�0DWUL[

6\QWD[ ODVW�v�

'HVFULSWLRQ Returns the index of the last element in vector v. 

$UJXPHQWV
v vector

&RPPHQWV ODVW(v) = OHQJWK(v) − 1 + ORIGIN

6HH�DOVR URZV

OFP 1XPEHU�7KHRU\�&RPELQDWRULFV

6\QWD[ OFP�A�

'HVFULSWLRQ Returns the smallest positive integer that is a multiple of all the values in the array A. This integer 
is known as the least common multiple of the elements in A. 

$UJXPHQWV
A integer matrix or vector; all elements of A are greater than zero

&RPPHQWV OFP(A, B, C, ...) is also permissible and returns the least common multiple of the elements of A, 
B, C, ....

$OJRULWKP Euclid’s algorithm (Niven and Zuckerman, 1972)

6HH�DOVR JFG

kurt A( ) mn mn 1+( )
mn 1–( ) mn 2–( ) mn 3–( )
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---------------------------------------- 

 
4

j 0=

n 1–

∑
i 0=

m 1–

∑
 
 
 
 

3 mn 1–( )2

mn 2–( ) mn 3–( )
-------------------------------------------–=

m n× m n 4≥⋅

n 0≥

x
x2

2

d
d

y⋅ 1 x–( )+
d

dx
------y n y⋅+⋅ 0=
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/HJ � 6SHFLDO

6\QWD[ /HJ�n, x�

'HVFULSWLRQ Returns the value of the Legendre polynomial of degree n at x.

$UJXPHQWV
n integer, 

x real number

&RPPHQWV The Legendre polynomials are solution of the differential equation

.

$OJRULWKP Recurrence relation (Abramowitz and Stegun, 1972)

OHQJWK 9HFWRU�DQG�0DWUL[

6\QWD[ OHQJWK�v�

'HVFULSWLRQ Returns the number of elements in vector v. 

$UJXPHQWV
v vector

&RPPHQWV Same as URZV(v)

OJVILW 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ OJVILW�vx, vy, vg�

'HVFULSWLRQ Returns a vector containing the parameters (a, b, c) that make the function  
best approximate the data in vx and vy.

$UJXPHQWV
vx, vy real vectors of the same size

vg real vector of guess values for (a, b, c)

&RPPHQWV This is a special case of the JHQILW�function. A vector of guess values is needed for initialization. 
By decreasing the value of the built-in TOL variable, higher accuracy in OJVILW might be achieved.

6HH�$OVR OLQH,�OLQILW,�JHQILW,�H[SILW,�ORJILW,�OQILW, SZUILW,�VLQILW,�PHGILW

OLQH 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ OLQH�vx, vy�

'HVFULSWLRQ Returns a vector containing the y-intercept and the slope of the least-squares regression line. 

$UJXPHQWV
vx, vy real vectors of the same size

6HH�$OVR VORSH for more details, LQWHUFHSW, VWGHUU, PHGILW

n 0≥

1 x
2

–( )
x2

2

d
d

y 2 x
d
dx
------y⋅ ⋅ n n 1+( ) y⋅ ⋅+–⋅ 0=

a 1 b cx–( )exp+( ) 1–⋅
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OLQILW� 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ OLQILW�vx, vy, F�

'HVFULSWLRQ Returns a vector containing the coefficients used to create a linear combination of the functions 
in F which best approximates the data in vx and vy. See genfit�for a more general technique. 

$UJXPHQWV
vx, vy real vectors of the same size; elements of vx should be in ascending order

F a function of a single variable that returns a vector of functions

([DPSOH

&RPPHQWV Not all data sets can be modeled by lines or polynomials. There are times when you need to model 
your data with a linear combination of arbitrary functions, none of which represent terms of a 
polynomial. For example, in a Fourier series you try to approximate data using a linear 
combination of complex exponentials. Or you may believe your data can be modeled by a 
weighted combination of Legendre polynomials, but you just don’t know what weights to assign.

The OLQILW function is designed to solve these kinds of problems. If you believe your data could 
be modeled by a linear combination of arbitrary functions: 

, you should use OLQILW to evaluate the . The 
example above shows a linear combination of three functions x, , and  to model 
some data.

There are times however when the flexibility of OLQILW is still not enough. Your data may have to 
be modeled not by a linear combination of data but by some function whose parameters must be 
chosen. For example, if your data can be modeled by the sum: 

 and all you need to do is solve for the unknown weights 
 and , then the OLQILW function is sufficient. By contrast, if instead your data is to be modeled 

by the sum:  and you now have to solve for the unknown 
parameters  and , you should use the JHQILW�function. 

$OJRULWKP SVD-based least squares minimization (Press et al., 1992)

6HH�DOVR OLQH��JHQILW

y a0 f0 x( )⋅ a1 f1 x( )⋅ … an fn x( )⋅+ + += ai
x2 x 1+( ) 1–

f x( ) a1 2x( )sin⋅ a2 3x( )tanh⋅+=
a1 a2

f x( ) 2 a1x( )sin⋅ 3 a2x( )tanh⋅+=
a1 a2
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OLQWHUS ,QWHUSRODWLRQ�DQG�3UHGLFWLRQ

6\QWD[ OLQWHUS�vx, vy,�x�

'HVFULSWLRQ Returns a linearly interpolated value at x. 

$UJXPHQWV
vx, vy real vectors of the same size; elements of vx should be in ascending order

x real number at which to interpolate

([DPSOH

&RPPHQWV Interpolation involves using existing data points to predict values between these data points. 
Mathcad allows you to either connect the data points with straight lines (linear interpolation, as 
with�OLQWHUS) or to connect them with sections of a cubic polynomial (cubic spline interpolation, 
as with OVSOLQH,�SVSOLQH, FVSOLQH, EVSOLQH�and�LQWHUS).

Unlike the regression functions discussed elsewhere, these interpolation functions return a curve 
which must pass through the points you specify. Therefore, the resulting function is very sensitive 
to spurious data points. If your data is noisy, you should consider using the regression functions 
instead.

Be sure that every element in the vx and vy arrays contains a data value. Because every element 
in an array must have a value, Mathcad assigns 0 to any elements you have not explicitly assigned.

To find the interpolated value for a particular x, OLQWHUS finds the two points between which the 
value falls and returns the corresponding y value on the straight line between the two points. 

For x values before the first point in vx, OLQWHUS extrapolates the straight line between the first 
two data points. For x values beyond the last point in vx, OLQWHUS extrapolates the straight line 
between the last two data points. 

For best results, the value of x should be between the largest and smallest values in the vector 
vx. The OLQWHUS function is intended for interpolation, not extrapolation. Consequently, computed 
values for x outside this range are unlikely to be useful. See SUHGLFW�for an alternative.
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OQ /RJ�DQG�([SRQHQWLDO

6\QWD[ OQ�z�

'HVFULSWLRQ Returns the natural logarithm of nonzero z (to base e). It is the principal value (imaginary part 
between π and −π) for complex z. 

$UJXPHQWV
z real or complex nonzero number

([DPSOH

&RPPHQWV In general, a complex argument to the natural log function returns:

Mathcad’s OQ function returns the value corresponding to , namely: 
 (principal branch of the natural log function).

6HH�DOVR ORJ

OQILW 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ OQILW�vx, vy�

'HVFULSWLRQ Returns a vector containing the parameters (a, b) that make the function  best 
approximate the data in vx and vy.

$UJXPHQWV
vx, vy real vectors of the same size

&RPPHQWV This is a two-parameter alternative to the three-parameter ORJILW�function. It uses linear regression 
to perform the curve fit (by taking the logarithm of y-values), hence there is no need for a guess 
values vector.

6HH�$OVR OLQH,�OLQILW,�JHQILW,�H[SILW,�SZUILW, ORJILW, OJVILW,�VLQILW,�PHGILW

/RDG&RORUPDS � )LOH�$FFHVV

6\QWD[ /RDG&RORUPDS�file�

'HVFULSWLRQ Returns an array containing the values in the colormap file.

$UJXPHQWV
file string variable corresponding to CMP filename

&RPPHQWV The file file is the name of a colormap located in the CMAPS subdirectory of your Mathcad 
directory. The function /RDG&RORUPDS is useful when you want to edit a colormap or use it to 
create a new colormap. See on-line Help for more information.

6HH�DOVR 6DYH&RORUPDS

x i y⋅+( )ln x i y⋅+ln y x⁄( ) i⋅atan 2 n π i⋅ ⋅ ⋅+ +=

n 0=
x i y⋅+( )ln x i y⋅+ln y x⁄( ) i⋅atan+=

a x( )ln⋅ b+
Functions 367



ORHVV � 5HJUHVVLRQ�DQG�6PRRWKLQJ

2QH�GLPHQVLRQDO�&DVH

6\QWD[ ORHVV�vx, vy, span�

'HVFULSWLRQ Returns the vector required by the�LQWHUS function to find the set of second order polynomials 
that best fit particular neighborhoods of data points specified in arrays vx and vy. 

$UJXPHQWV
vx, vy real vectors of the same size

span real  specifies how large a neighborhood�ORHVV will consider in performing this local 
regression 

([DPSOH

&RPPHQWV Instead of generating a single polynomial the way�UHJUHVV does, ORHVV generates a different 
second order polynomial depending on where you are on the curve. It does this by examining 
the data in a small neighborhood of the point you’re interested in. The argument span controls 
the size of this neighborhood. As span gets larger, ORHVV becomes equivalent to UHJUHVV with 

. A good default value is . 

The example above shows how span affects the fit generated by the�ORHVV�function. A smaller 
value of span makes the fitted curve track fluctuations in data more effectively. A larger value 
of span tends to smear out fluctuations in data and thereby generates a smoother fit.

span 0>

n 2= span 0.75=
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7ZR�GLPHQVLRQDO�&DVH

6\QWD[ ORHVV�Mxy, vz, span�

'HVFULSWLRQ Returns the vector required by the�LQWHUS function to find the set of second order polynomials 
that best fit particular neighborhoods of data points specified in arrays Mxy and vz. 

$UJXPHQWV
Mxy real  matrix containing x-y coordinates of the m data points

vz real m-element vector containing the z coordinates corresponding to the points specified in Mxy 

span real  specifies how large a neighborhood�ORHVV will consider in performing this local 
regression 

&RPPHQWV Can be extended naturally to the three- and four-dimensional cases (that is, up to four independent 
variables).

$OJRULWKP Local polynomial estimation (Cleveland and Devlin, 1988)

6HH�DOVR ³UHJUHVV´�on page 409 for more details

ORJ /RJ�DQG�([SRQHQWLDO

&ODVVLFDO�'HILQLWLRQ

6\QWD[ ORJ�z�

'HVFULSWLRQ Returns the common logarithm of nonzero z to base 10. The result is the principal value 
(imaginary part between π and −π) for complex z. 

$UJXPHQWV
z real or complex nonzero number

([WHQGHG�'HILQLWLRQ

6\QWD[ ORJ�z, b�

'HVFULSWLRQ Returns the logarithm of nonzero z to base b. The result is the principal value (imaginary part 
between π and −π) for complex z. 

$UJXPHQWV
z real or complex nonzero number

b real number, b > 0, b ≠ 1

6HH�DOVR OQ

ORJILW 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ ORJILW�vx, vy, vg�

'HVFULSWLRQ Returns a vector containing the parameters (a, b, c) that make the function  best 
approximate the data in vx and vy.

$UJXPHQWV
vx, vy real vectors of the same size

vg real vector of guess values for (a, b, c)

&RPPHQWV This is a special case of the JHQILW�function. A vector of guess values is needed for initialization. 
By decreasing the value of the built-in TOL variable, higher accuracy in ORJILW might be achieved.

6HH�$OVR OLQH,�OLQILW,�JHQILW,�H[SILW,�SZUILW,�OQILW, OJVILW,�VLQILW,�PHGILW

m 2×

span 0>

a x b+( )ln⋅ c+
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ORRNXS� � 9HFWRU�DQG�0DWUL[

6\QWD[ ORRNXS�z,�A, B�

'HVFULSWLRQ Looks in a vector or matrix, A, for a given value, z, and returns the value(s) in the same 
position(s) (i.e., with the same row and column numbers) in another matrix, B. When 
multiple values are returned, they appear in a vector in row-wise order, starting with the top left 
corner of B and sweeping to the right.

$UJXPHQWV
z real or complex number, or string

A, B real, complex or string  matrices or vectors

&RPPHQWV The degree of precision to which the comparison adheres is determined by the TOL setting of 
the worksheet.

6HH�$OVR KORRNXS,�YORRNXS,�PDWFK

OVROYH � 9HFWRU�DQG�0DWUL[

6\QWD[ OVROYH�M, v�

'HVFULSWLRQ Returns a solution vector x such that . 

$UJXPHQWV
M real or complex square matrix that is neither singular nor nearly singular

v real or complex vector

([DPSOH

&RPPHQWV A matrix is singular if its determinant is zero; it is nearly singular if it has a high condition number. 
Alternatively, you can solve a system of linear equations by using matrix inversion, via numeric 
or symbolic solve blocks.

$OJRULWKP LU decomposition and forward/backward substitution (Press et al., 1992)

m n×

M x⋅ v=
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OVSOLQH ,QWHUSRODWLRQ�DQG�3UHGLFWLRQ

2QH�GLPHQVLRQDO�&DVH

6\QWD[ OVSOLQH�vx, vy�

'HVFULSWLRQ Returns the vector of coefficients of a cubic spline with linear ends. This vector becomes the first 
argument of the�LQWHUS�function.

$UJXPHQWV
vx, vy real vectors of the same size; elements of vx must be in ascending order

([DPSOH

&RPPHQWV Cubic spline interpolation lets you pass a curve through a set of points so that the first and second 
derivatives of the curve are continuous across each point. This curve is assembled by taking three 
adjacent points and constructing a cubic polynomial passing through those points. These cubic 
polynomials are then strung together to form the completed curve.

To fit a cubic spline curve through a set of points: 

1. Create the vectors vx and vy containing the x and y coordinates through which you want the 
cubic spline to pass. The elements of vx should be in ascending order. (Although we use the 
names vx, vy, and vs, there is nothing special about these variable names; you can use 
whatever names you prefer.)

2. Generate the vector . The vector vs is a vector of intermediate results 
designed to be used with LQWHUS��,W�contains, among other things, the second derivatives for 
the spline curve used to fit the points in vx and vy.

3. To evaluate the cubic spline at an arbitrary point, say x0, evaluate  
here vs, vx, and vy are the vectors described earlier. You could have accomplished the same 
task by evaluating: . As a practical matter, though, 
you’ll probably be evaluating LQWHUS for many different points.

vs lspline vx vy,( ):=

interp vs vx vy x0, , ,( )

interp lspline vx vy,( ) vx vy x0, , ,( )
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The call to OVSOLQH can be time-consuming and the result won’t change from one point to the next, 
so it makes sense to do it just once and store the outcome in the vs array.

Be sure that every element in the input arrays contains a data value. Because every element in a 
array must have a value, Mathcad assigns 0 to any elements you have not explicitly assigned.

In addition to OVSOLQH, Mathcad comes with three other cubic spline functions: SVSOLQH, FVSOLQH, 
and�EVSOLQH. The SVSOLQH function generates a spline curve that approaches a parabola at the 
endpoints, while the FVSOLQH function generates a spline curve that can be fully cubic at the 
endpoints. EVSOLQH, on the other hand, allows the interpolation knots to be chosen by the user.

For OVSOLQH, the first three components of the output vector vs are vs0=0 (a code telling�LQWHUS 
that vs is the output of a spline function as opposed to a regression function), vs1=3 (the index 
within vs where the second derivative coefficients begin) and vs2=0 (a code denoting OVSOLQH). 
The first three components for SVSOLQH and FVSOLQH are identical except vs2=1 (the code denoting 
SVSOLQH) and vs2=2 (the code denoting FVSOLQH), respectively.

7ZR�GLPHQVLRQDO�&DVH

6\QWD[ OVSOLQH�Mxy, Mz�

'HVFULSWLRQ Returns the vector of coefficients of a two-dimensional cubic spline, constrained to be linear at 
region boundaries spanned by Mxy. This vector becomes the first argument of the�LQWHUS 
function.

$UJXPHQWV
Mxy  matrix whose elements,  and , specify the x- and y-coordinates along the 

diagonal of a rectangular grid. This matrix plays exactly the same role as vx in the one-
dimensional case described earlier. Since these points describe a diagonal, the elements in each 
column of Mxy must be in ascending order (  whenever ).

Mz  matrix whose ijth element is the z-coordinate corresponding to the point  and 
. Mz plays exactly the same role as vy does in the one-dimensional case above.

&RPPHQWV Mathcad handles two-dimensional cubic spline interpolation in much the same way as the one-
dimensional case. Instead of passing a curve through a set of points so that the first and second 
derivatives of the curve are continuous across each point, Mathcad passes a surface through a 
grid of points. This surface corresponds to a cubic polynomial in x and y in which the first and 
second partial derivatives are continuous in the corresponding direction across each grid point.

The first step in two-dimensional spline interpolation is exactly the same as that in the one-
dimensional case: specify the points through which the surface is to pass. The procedure, 
however, is more complicated because you now have to specify a grid of points. 

To perform two-dimensional spline interpolation, follow these steps:

1. Create Mxy.

2. Create Mz. 

n 2× Mxyi 0, Mxyi 1,

Mxyi k, Mxyj k,< i j<
n n× x Mxyi 0,=
y Mxyj 1,=
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3. Generate the vector . The vector vs is a vector of intermediate 
results designed to be used with LQWHUS. 
To evaluate the cubic spline at an arbitrary point, say , evaluate

, where vs, Mxy, and Mz are as described earlier. 

The result is the value of the interpolating surface corresponding to the arbitrary point 
. You could have accomplished exactly the same task by evaluating:

.

As a practical matter though, you’ll probably be evaluating LQWHUS for many different points. The 
call to OVSOLQH can be time-consuming, and the result won’t change from one point to the next, so 
do it just once and store the outcome in the vs array.

In addition to OVSOLQH, Mathcad comes with two other cubic spline functions for the two-
dimensional case: SVSOLQH and FVSOLQH. The SVSOLQH function generates a spline curve that 
approaches a second degree polynomial in x and y along the edges. The FVSOLQH function generates 
a spline curve that approaches a third degree polynomial in x and y along the edges.

$OJRULWKP Tridiagonal system solving (Press et al., 1992; Lorczak)

OX � 9HFWRU�DQG�0DWUL[

6\QWD[ OX�M�

'HVFULSWLRQ Returns an  matrix whose first n columns contain an  permutation matrix P, 
whose next n columns contain an  lower triangular matrix L, and whose remaining n 
columns contain an  upper triangular matrix U. These matrices satisfy the equation 

.

$UJXPHQWV
M real or complex  matrix 

&RPPHQWV This is known as the LU decomposition (or factorization) of the matrix M, permuted by P.

$OJRULWKP Crout’s method with partial pivoting (Press et al., 1992; Golub and Van Loan, 1989)

vs lspline Mxy Mz,( ):=

x0 y0,( )

interp vs Mxy Mz x0
y0

, , ,
 
 
 

x0 y0,( )

interp lspline Mxy Mz,( ) Mxy Mz x0
y0

, , ,
 
 
 

n 3 n⋅( )× n n×
n n×

n n×
P M⋅ L U⋅=

n n×
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��� �&KDSWHU����)XQFWLRQV

PDWFK� 9HFWRU�DQG�0DWUL[

6\QWD[ PDWFK�z,�A�

'HVFULSWLRQ Looks in a vector or matrix, A, for a given value, z, and returns the index (indices) of 
its positions in A. When multiple values are returned, they appear in a nested array in row-wise 
order, starting with the top left corner of A and sweeping to the right.

$UJXPHQWV
z real or complex number, or string

A real, complex or string  matrix or vector

&RPPHQWV The degree of precision to which the comparison adheres is determined by the TOL setting of 
the worksheet.

6HH�$OVR ORRNXS,�KORRNXS,�YORRNXS

PDWUL[ 9HFWRU�DQG�0DWUL[

6\QWD[ PDWUL[�m, n, f�

'HVFULSWLRQ Creates a matrix in which the ijth element is the value f(i, j), where  and 
.

$UJXPHQWV
m, n integers

f scalar-valued function

PD[ 9HFWRU�DQG�0DWUL[

6\QWD[ PD[�A�

'HVFULSWLRQ Returns the largest element in A. If A is complex, returns max(Re(A)) + i max(Im(A)).

$UJXPHQWV
A real or complex  matrix or vector, or string

&RPPHQWV PD[(A, B, C, ...) is also permissible and returns the largest element in A, B, C, ....

6HH�DOVR PLQ

0D[LPL]H 6ROYLQJ

6\QWD[ 0D[LPL]H�f, var1, var2,...�

'HVFULSWLRQ Returns values of var1, var2,... which solve a prescribed system of equations, subject to 
prescribed inequalities, and which make the function f take on its largest value. The number of 
arguments matches the number of unknowns, plus one. Output is a scalar if only one unknown; 
otherwise it is a vector of answers.

$UJXPHQWV
f real-valued objective function

var1, var2, ... real or complex variables; var1, var2, ... must be assigned guess values before using 0D[LPL]H

m n×

i 0 1 … m 1–, , ,=
j 0 1 … n 1–, , ,=

m n×
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��� �&KDSWHU����)XQFWLRQV

&RPPHQWV There are five steps to solving a maximization problem:

1. Define the objective function f.

2. Provide an initial guess for all the unknowns you intend to solve for. This gives Mathcad a 
place to start searching for solutions.

3. Type the word JLYHQ. This tells Mathcad that what follows is a system of equality or 
inequality constraints. You can type JLYHQ or *LYHQ in any style. Just be sure you don’t type 
it while in a text region. 

4. Now type the equations and inequalities in any order below the word JLYHQ. Use [Ctrl]= 
to type “=.” 

5. Finally, type the 0D[LPL]H�function with f and your list of unknowns. You can’t put 
numerical values in the list of unknowns; for example, 0D[LPL]H(f, 2) isn’t permitted. Like 
JLYHQ, you can type PD[LPL]H or�0D[LPL]H in any style.

The 0D[LPL]H function returns values as follows:

• If there is one unknown, 0D[LPL]H�returns a scalar value that optimizes f.
• If there is more than one unknown, 0D[LPL]H�returns a vector of answers; for example, 

0D[LPL]H(f, var1, var2) returns a vector containing values of var1 and var2 that satisfy the 
constraints and optimize f.

The word *LYHQ, the equations and inequalities that follow, and the 0D[LPL]H�function form a 
solve block. 

By default, Mathcad examines your objective function and the constraints, and solves usi
appropriate method. If you want to try different algorithms for testing and comparison, you
choose options from the pop-up menu associated with 0D[LPL]H�(available via right mouse 
click),�which include:

• AutoSelect − chooses an appropriate algorithm for you
• Linear option − indicates that the problem is linear (and thus applies linear programmin

methods to the problem) − guess values for var1, var2,... are immaterial (can all be zero)
• Nonlinear option − indicates that the problem is nonlinear (and thus applies these gene

methods to the problem: the conjugate gradient solver; if that fails to converge, the qu
Newton solver) − guess values for var1, var2,... greatly affect the solution

• Quadratic option (appears only if the Solving and Optimization Extension Pack or Exp
Solver product is installed) − indicates that the problem is quadratic (and thus applies 
quadratic programming methods to the problem) − guess values for var1, var2,... are 
immaterial (can all be zero)

• Advanced options − applies only to the nonlinear conjugate gradient and the quasi-New
solvers

These options provide more control for you to try different algorithms for testing and compar
You may also adjust the values of the built-in variables CTOL and TOL. The constraint tolerance 
CTOL controls how closely a constraint must be met for a solution to be acceptable, e.g., if C
were 0.001, then a constraint such as x < 2 would be considered satisfied if the value of x satisfie
x < 2.001. This can be defined or changed in the same way as the convergence tolerance TOL, 
which is discussed further in connection with the )LQG function. Since 0D[LPL]H can be used 
without constraints, the value of CTOL will sometimes be irrelevant. Its default value is 10-3.

Other Solving and Optimization Extension Pack features include mixed integer programm
and constraint sensitivity report generation. See on-line Help for details.

For an unconstrained maximization problem, the word *LYHQ and constraints are unnecessary



)XQFWLRQV ���

$OJRULWKP For the non-linear case: quasi-Newton, conjugate gradient
For the linear case: simplex method with branch/bound techniques (Press et al., 1992; Polak, 
1997; Winston, 1994)

6HH�DOVR )LQG�for more details about solve blocks��0LQHUU,�0LQLPL]H

PHDQ 6WDWLVWLFV

6\QWD[ PHDQ�A�

'HVFULSWLRQ Returns the arithmetic mean of the elements of A: . 

$UJXPHQWV
A real or complex  matrix or vector

&RPPHQWV PHDQ(A, B, C, ...) is also permissible and returns the arithmetic mean of the elements of
A, B, C, ....

6HH�DOVR JPHDQ,�KPHDQ,�PHGLDQ,�PRGH

PHGILW 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ PHGILW�vx, vy�

'HVFULSWLRQ Returns a vector containing the y-intercept and the slope of the median-median regression line.

$UJXPHQWV
vx, vy real vectors of the same size

&RPPHQWV PHGILW provides a linear fit which is more robust (less sensitive to data outliers) than�OLQH. The 
data is divided into three sets, the median of the first and last subsets are calculated, and the 
intercept and slope of the line connecting those two medians comprises the fit. 

6HH�$OVR OLQH,�OLQILW,�JHQILW,�H[SILW,�ORJILW, OQILW, SZUILW,�OJVILW,�VLQILW

PHGLDQ 6WDWLVWLFV

6\QWD[ PHGLDQ�A�

'HVFULSWLRQ Returns the median of the elements of A. The median is the value above and below which there 
are an equal number of values. If A has an even number of elements, PHGLDQ is the arithmetic 
mean of the two central values.

$UJXPHQWV
A real  matrix or vector

&RPPHQWV PHGLDQ(A, B, C, ...) is also permissible and returns the median of the elements of A, B, C, ....

6HH�DOVR JPHDQ,�PHDQ,�PHGLDQ,�PRGH

PHGVPRRWK 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ PHGVPRRWK�vy,�n�

'HVFULSWLRQ Creates a new vector, of the same size as vy, by smoothing vy with running medians. 

$UJXPHQWV
vy real vector

n odd integer, n > 0, the size of smoothing window

mean A( ) 1
mn
------- Ai j,

j 0=

n 1–

∑
i 0=

m 1–

∑=

m n×

m n×
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&RPPHQWV Smoothing involves taking a set of y (and possibly x) values and returning a new set of y values 
that is smoother than the original set. Unlike the interpolation functions OVSOLQH,�SVSOLQH,�FVSOLQH�
or EVSOLQH�or regression functions UHJUHVV or�ORHVV, smoothing results in a new set of y values, 
not a function that can be evaluated between the data points you specify. If you are interested in 
y values between the y values you specify, use an interpolation or regression function.

Whenever you use vectors in any of the functions described in this section, be sure that every 
element in the vector contains a data value. Because every element in a vector must have a value, 
Mathcad assigns 0 to any elements you have not explicitly assigned.

The PHGVPRRWK function is the most robust of Mathcad’s three smoothing functions beca
it is least likely to be affected by spurious data points. This function uses a running media
smoother, computes the residuals, smooths the residuals the same way, and adds these
smoothed vectors together.

PHGVPRRWK performs these steps:

1. Finds the running medians of the input vector vy. We'll call this . The ith element is 
given by: .

2. Evaluates the residuals: .

3. Smooths the residual vector, vr, using the same procedure described in step 1, to create
smoothed residual vector, .

4. Returns the sum of these two smoothed vectors: .

PHGVPRRWK will leave the first and last  points unchanged. In practice, the length
the smoothing window, n, should be small compared to the length of the data set.

vy′
vy′i medianvyi n 1 2⁄–( )– … vyi … vyi n 1 2⁄–( )+, , , ,( )=

vr vy vy′–=

vr′
medsmoothvy n,( ) vy′ vr′+=

n 1–( ) 2⁄
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$OJRULWKP Moving window median method (Lorczak)

6HH�DOVR NVPRRWK and VXSVPRRWK

PK\SHU � 6SHFLDO

6\QWD[ PK\SHU�a, b, x�

'HVFULSWLRQ Returns the value of the confluent hypergeometric function,  or .

$UJXPHQWV
a, b, x real numbers

&RPPHQWV The confluent hypergeometric function is a solution of the differential equation: 

 and is also known as the Kummer function. 

Many functions are special cases of this, e.g., elementary ones like

 

and more complicated ones like Hermite functions.

$OJRULWKP Series expansion, asymptotic approximations (Abramowitz and Stegun, 1972)

PLQ 9HFWRU�DQG�0DWUL[

6\QWD[ PLQ�A�

'HVFULSWLRQ Returns the smallest element in A. If A is complex, returns min(Re(A)) + i min(Im(A)). 

$UJXPHQWV
A real or complex  matrix or vector, or string

&RPPHQWV PLQ(A, B, C, ...) is also permissible and returns the smallest element in A, B, C, ....

6HH�DOVR PD[

0LQHUU 6ROYLQJ

6\QWD[ 0LQHUU�var1, var2,...�

'HVFULSWLRQ Returns values of var1, var2, ... which come closest to solving a prescribed system of equations, 
subject to prescribed inequalities. The number of arguments matches the number of unknowns. 
Output is a scalar if only one argument; otherwise it is a vector of answers. 

$UJXPHQWV
var1, var2, ... real or complex variables; var1, var2, ... must be assigned guess values before using 0LQHUU 

F1 1 a b x );;( M a b; x;( )

x
x2

2

d
d

y b x–( )+
d
dx
------y a y⋅ 0=–⋅ ⋅

x( )exp mhyper 1 1 x, ,( )= x( )exp h x( )sin⋅ x mhyper 1 2 2 x⋅, ,( )⋅=

m n×
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&RPPHQWV The 0LQHUU�function is very similar to )LQG and uses exactly the same algorithm. The difference 
is that even if a system has no solutions, 0LQHUU will attempt to find values which come closest 
to solving the system. The )LQG�function, on the other hand, will return an error message 
indicating that it could not find a solution. You use 0LQHUU exactly the way you use )LQG. 

Like�)LQG, type the 0LQHUU function with your list of unknowns. You can’t put numerical value
in the list of unknowns; e.g., in the example above, 0LQHUU(0.8, 1) isn’t permitted. Like )LQG, 
you can type 0LQHUU or�PLQHUU in any style.

0LQHUU usually returns an answer that minimizes the errors in the constraints. However, 0LQHUU 
cannot verify that its answers represent an absolute minimum for the errors in the constra

If you use 0LQHUU in a solve block, you should always include additional checks on the 
reasonableness of the results. The built-in variable ERR gives the size of the error vector 
approximate solution. There is no built-in variable for determining the size of the error for
individual solutions to the unknowns.

0LQHUU is particularly useful for solving certain nonlinear least-squares problems. In the exam
0LQHUU is used to obtain the unknown parameters in a Weibull distribution. The function JHQILW 
is also useful for solving nonlinear least-squares problems.

The pop-up menu (available via right mouse click) associated with 0LQHUU contains the following 
options:

• AutoSelect − chooses an appropriate algorithm for you
• Linear option − not available for 0LQHUU (since the objective function is quadratic, hence th

problem can never be linear)
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• Nonlinear option − indicates that the problem is nonlinear (and thus applies these gene
methods to the problem: the conjugate gradient solver; if that fails to converge, the 
Levenberg-Marquardt solver; if that too fails, the quasi-Newton solver) − guess values for 
var1, var2,... greatly affect the solution

• Quadratic option (appears only if the Solving and Optimization Extension Pack or Exp
Solver product is installed) − indicates that the problem is quadratic (and thus applies 
quadratic programming methods to the problem) − guess values for var1, var2,... are 
immaterial (can all be zero)

• Advanced options − applies only to the nonlinear conjugate gradient and the quasi-New
solvers

These options provide more control for you to try different algorithms for testing and compar
You may also adjust the values of the built-in variables CTOL and TOL. The constraint tolerance 
CTOL controls how closely a constraint must be met for a solution to be acceptable, e.g., if C
were 0.001, then a constraint such as x < 2 would be considered satisfied if the value of x satisfied 
x < 2.001. This can be defined or changed in the same way as the convergence tolerance TOL. 
The default value for CTOL is 10-3.

Other Solving and Optimization Extension Pack features include mixed integer programm
and constraint sensitivity report generation. See on-line Help for details.

$OJRULWKP For the non-linear case: Levenberg-Marquardt, quasi-Newton, conjugate gradient
For the linear case: simplex method with branch/bound techniques 
(Press et al., 1992; Polak, 1997; Winston, 1994)

6HH�DOVR Find for more details about solve blocks; 0D[LPL]H, 0LQLPL]H 

0LQLPL]H 6ROYLQJ

6\QWD[ 0LQLPL]H�f, var1, var2,...�

'HVFULSWLRQ Returns values of var1, var2,... which solve a prescribed system of equations, subject to 
prescribed inequalities, and which make the function f take on its smallest value. The number 
of arguments matches the number of unknowns, plus one. Output is a scalar if only one unk
otherwise it is a vector of answers.

$UJXPHQWV
f real-valued function

var1, var2, ... real or complex variables; var1, var2, ... must be assigned guess values before using 0LQLPL]H.
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&RPPHQWV There are five steps to solving a minimization problem:

1. Define the objective function f.

2. Provide an initial guess for all the unknowns you intend to solve for. This gives Mathcad a 
place to start searching for solutions.

3. Type the word JLYHQ. This tells Mathcad that what follows is a system of equality or 
inequality constraints. You can type JLYHQ or *LYHQ in any style. Just be sure you don’t type 
it while in a text region. 

4. Now type the equations and inequalities in any order below the word JLYHQ. Use [Ctrl]= 
to type “=.” 

5. Finally, type the 0LQLPL]H�function with f and your list of unknowns. You can’t put 
numerical values in the list of unknowns; for example, 0LQLPL]H(f, 2) isn’t permitted. Like 
JLYHQ, you can type PLQLPL]H or�0LQLPL]H in any style.

The 0LQLPL]H function returns values as follows:

• If there is one unknown, 0LQLPL]H�returns a scalar value that optimizes f.
• If there is more than one unknown, 0LQLPL]H�returns a vector of answers; for example, 

0LQLPL]H(f, var1, var2) returns a vector containing values of var1 and var2 that satisfy the 
constraints and optimize f.

The word *LYHQ, the equations and inequalities that follow, and the 0LQLPL]H�function form a 
solve block.

By default, Mathcad examines your objective function and the constraints, and solves usi
appropriate method. If you want to try different algorithms for testing and comparison, you
choose options from the pop-up menu associated with 0LQLPL]H�(available via right mouse click), 
which include:

• AutoSelect − chooses an appropriate algorithm for you
• Linear option − indicates that the problem is linear (and thus applies linear programmin

methods to the problem) − guess values for var1, var2,... are immaterial (can all be zero)
• Nonlinear option − indicates that the problem is nonlinear (and thus applies these gene

methods to the problem: the conjugate gradient solver; if that fails to converge, the qu
Newton solver) − guess values for var1, var2,... greatly affect the solution

• Quadratic option (appears only if the Solving and Optimization Extension Pack or Exp
Solver product is installed) − indicates that the problem is quadratic (and thus applies 
quadratic programming methods to the problem) − guess values for var1, var2,... are 
immaterial (can all be zero)

• Advanced options − applies only to the nonlinear conjugate gradient and the quasi-New
solvers

These options provide more control for you to try different algorithms for testing and compar
You may also adjust the values of the built-in variables CTOL and TOL. The constraint tolerance 
CTOL controls how closely a constraint must be met for a solution to be acceptable, e.g., if C
were 0.001, then a constraint such as x < 2 would be considered satisfied if the value of x satisfie
x < 2.001. This can be defined or changed in the same way as the convergence tolerance TOL, 
which is discussed further in connection with the )LQG function. Since 0LQLPL]H can be used 
without constraints, the value of CTOL will sometimes be irrelevant. Its default value is 10-3.

Other Solving and Optimization Extension Pack features include mixed integer programm
and constraint sensitivity report generation. See on-line Help for details.

For an unconstrained minimization problem, the word *LYHQ and constraints are unnecessary
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$OJRULWKP For the non-linear case: quasi-Newton, conjugate gradient
For the linear case: simplex method with branch/bound techniques 
(Press et al., 1992; Polak, 1997; Winston, 1994)

6HH�DOVR Find for more details about solve blocks; 0D[LPL]H, 0LQHUU

PLUU )LQDQFH

6\QWD[ PLUU�v,�fin_rate, rein_rate��

'HVFULSWLRQ Returns the modified internal rate of return for a series of cash flows occurring at regular intervals, 
v, given a finance rate payable on the cash flows you borrow, fin_rate, and a reinvestment rate 
earned on the cash flows as you reinvest them, rein_rate.

$UJXPHQWV
v real vector of cash flows

fin_rate real finance rate

rein_rate real reinvestment rate

&RPPHQWV In v, payments must be entered as negative numbers and income must be entered as positive 
numbers. There must be at least one positive value and one negative value in v.

6HH�DOVR LUU

PRG 1XPEHU�7KHRU\�&RPELQDWRULFV

6\QWD[ PRG�n, k�

'HVFULSWLRQ Returns the remainder of n when divided by k. The result has the same sign as n. 

$UJXPHQWV
n, k integers,  

PRGH 6WDWLVWLFV

6\QWD[ PRGH�A�

'HVFULSWLRQ Returns the value in A that occurs most often.

$UJXPHQWV
A real or complex  matrix or vector

&RPPHQWV PRGH(A, B, C, ...) is also permissible and returns the value in A, B, C, ... that occurs most often.

6HH�DOVR JPHDQ,�KPHDQ,�PHDQ,�PHGLDQ

PXOWLJULG � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ PXOWLJULG�M, ncycle�

'HVFULSWLRQ Solves the Poisson partial differential equation over a planar square region. The  matrix M 
gives source function values, where  is a power of 2 and zero boundary conditions on all 
four edges are assumed. PXOWLJULG�uses a�different algorithm and is faster than UHOD[, which is 
more general. 

$UJXPHQWV
M   real square matrix containing the source term at each point in the region in 

which the solution is sought (for example, the right-hand side of equation below)

ncycle positive integer specifying number of cycles at each level of the PXOWLJULG iteration; a value of 
2 generally gives a good approximation of the solution

k 0≠

m n×

n n×
n 1–

1 2k+( ) 1 2k+( )×
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&RPPHQWV Two partial differential equations that arise often in the analysis of physical systems are Poisson’s 
equation:

 and its homogeneous form, Laplace’s equation.

Mathcad has two functions for solving these equations over a square region, assuming the
taken by the unknown function u(x, y) on all four sides of the boundary are known. The mos
general solver is the UHOD[ function. In the special case where u(x, y) is known to be zero on all 
four sides of the boundary, you can use the PXOWLJULG function instead. This function often solves
the problem faster than UHOD[. If the boundary condition is the same on all four sides, you ca
simply transform the equation to an equivalent one in which the value is zero on all four s

The PXOWLJULG function returns a square matrix in which:

• an element's location in the matrix corresponds to its location within the square region
• its value approximates the value of the solution at that point. 

$OJRULWKP Full multigrid algorithm (Press et al., 1992)

6HH�DOVR UHOD[

QRP )LQDQFH

6\QWD[ QRP�rate, nper�

'HVFULSWLRQ Returns the nominal interest rate given the effective annual interest rate, rate, and the number of 
compounding periods per year, nper.

$UJXPHQWV
rate real rate, rate > −1

nper real number of compounding periods, nper ≥ 1

&RPPHQWV Effective annual interest rate is also known as annual percentage rate (APR).

6HH�DOVR HII

x2

2

∂
∂ u

y2

2

∂
∂ u

+ ρ x y,( )=
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QRUP� � 9HFWRU�DQG�0DWUL[

6\QWD[ QRUP��M�

'HVFULSWLRQ Returns the  norm of the matrix M. 

$UJXPHQWV
M real or complex square matrix

QRUP� � 9HFWRU�DQG�0DWUL[

6\QWD[ QRUP��M�

'HVFULSWLRQ Returns the  norm of the matrix M. 

$UJXPHQWV
M real or complex square matrix

$OJRULWKP Singular value computation (Wilkinson and Reinsch, 1971)

QRUPH � 9HFWRU�DQG�0DWUL[

6\QWD[ QRUPH�M�

'HVFULSWLRQ Returns the Euclidean norm of the matrix M. 

$UJXPHQWV
M real or complex square matrix

QRUPL �� 9HFWRU�DQG�0DWUL[

6\QWD[ QRUPL�M�

'HVFULSWLRQ Returns the infinity norm of the matrix M. 

$UJXPHQWV
M real or complex square matrix

QSHU )LQDQFH

6\QWD[ QSHU�rate, pmt, pv, [[fv], [type]]�

'HVFULSWLRQ Returns the number of compounding periods for an investment or loan based on periodic, constant 
payments, pmt, using a fixed interest rate, rate, and a specified present value, pv.

$UJXPHQWV
rate real rate

pmt real payment

pv real present value

fv (optional) real future value, default is fv = 0

type (optional) indicator payment timing, 0 for payment made at the end of the period, 1 for payment 
made at the beginning, default is type = 0

&RPPHQWV If you know the annual interest rate, ann_rate, you must calculate the interest rate per period as 
rate = ann_rate/nper.

Payments you make, such as deposits into a savings account or payments toward a loan, must be 
entered as negative numbers. Cash you receive, such as dividend checks, must be entered as 
positive numbers. Specific to nper, if pmt > 0, rate and pv must be opposite signs.

6HH�DOVR FQSHU,�IY,�SPW,�SY,�UDWH

L1

L2



)XQFWLRQV ���

QSY )LQDQFH

6\QWD[ QSY�rate,�v�

'HVFULSWLRQ Returns the net present value of an investment given a discount rate, rate, and a series of cash 
flows occurring at regular intervals, v.

$UJXPHQWV
rate real rate

v real vector of cash flows

&RPPHQWV npv assumes that the payment is made as the end of the period.

In v, payments must be entered as negative numbers and income must be entered as positive 
numbers.

The npv investment begins one period before the date of the first cash flow and ends with the 
last cash flow in the vector. If your first cash flow occurs at the beginning of the first period, the 
first value must be added to the npv result, not included in the vector of cash flows.

6HH�DOVR LUU,�SY

QXP�VWU � 6WULQJ

6\QWD[ QXP�VWU�z�

'HVFULSWLRQ Returns the string whose characters correspond to the decimal value of z. 

$UJXPHQWV
z real or complex number

6HH�DOVR VWU�QXP

2GHVROYH � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ 2GHVROYH�x, b, [nstep]�

'HVFULSWLRQ Solves a single ordinary differential equation, subject to either initial value or boundary value 
constraints. The DE must be linear in the highest order derivative term. The output is a function 
of x, interpolated from a table of values computed via either fixed step or adaptive DE solvers.

$UJXPHQWV

x variable of integration, real

b terminal point of integration interval, real

nstep (optional) integer number of steps, nstep 0>
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&RPPHQWV There are three steps to solving a DE using 2GHVROYH:

1. Type the word *LYHQ. This tells Mathcad that what follows is a DE, along with initial value 
or boundary value constraints. You can type *LYHQ or JLYHQ in any style. Just don’t type it 
while in a text region.

2. Type the DE and constraints in any order below the word *LYHQ. Use [Ctrl]= to type “=” 
and [Ctrl]F7 to type a prime ‘ . The DE can be written using the derivative operators d/dx, 
d2/dx2, d3/dx3, ... or using prime notation y‘(x), y‘‘(x), y‘‘‘(x) , .... Note that the independent 
variable x must be explicitly indicated throughout. A typical initial value constraint might 
be y(a)=c or y‘(a)=d; Mathcad does not allow more complicated constraints like 
y(a)+y‘(a)=e.

3. Finally, type the 2GHVROYH function. You can’t put a numerical value in place of x: for 
example, 2GHVROYH(2, 150) in the Example isn’t permitted. Like JLYHQ, you can type 
2GHVROYH or�RGHVROYH in any style.

The word *LYHQ, the equations that follow, and the 2GHVROYH function form a solve block. This 
is similar to the solve block described with the )LQG function, except here no guess values are
needed.



 

y 
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Mathcad is very specific about the types of expressions that can appear between *LYHQ and 
2GHVROYH. The lower derivative terms can appear nonlinearly in the DE (e.g., they can be 
multiplied together or raised to powers), but the highest derivative term must appear linearly. 
Inequality constraints are not allowed. There must be n independent equality constraints for an 
nth order DE. For an initial value problem, the values for y(x) and its first n−1 derivatives at a 
single initial point a are required. For a boundary value problem, the n equality constraints should 
prescribe values for y(x) and certain derivatives at exactly two points a and b. Mathcad will check 
for the correct type and number of conditions.

For initial value problems, the default routine employed by 2GHVROYH�is UNIL[HG��If you prefer 
5NDGDSW, right-mouse click on the word 2GHVROYH and select “Adaptive”. For boundary value
problems, the routine employed is VEYDO�followed by UNIL[HG or 5NDGDSW. Internally, the output 
of each of these DE solvers is a table of values, which Mathcad interpolates using OVSOLQH followed 
by LQWHUS��Note in the Example that, although y and f are defined to be output of 2GHVROYH (no 
independent variable is indicated), y(x) and f(t) are functions which can be plotted, etc., like an
other function. 

The default value for nsteps is ten times the length of the interval [a, b] (truncated to an integer).

6HH�DOVR UNIL[HG,�5NDGDSW,�VEYDO,�OVSOLQH,�LQWHUS

SEHWD 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SEHWD�x, s1, s2�

'HVFULSWLRQ Returns the cumulative beta distribution with shape parameters s1 and s2.

$UJXPHQWV
x real number, 

s1, s2 real shape parameters, s1 > 0, s2 > 0

$OJRULWKP Continued fraction expansion (Abramowitz and Stegun, 1972)

SELQRP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SELQRP�k, n, p�

'HVFULSWLRQ Returns Pr( ) when the random variable X has the binomial distribution with parameters n 
and p.

$UJXPHQWV
k, n integers, 

p real numbers, 

$OJRULWKP Continued fraction expansion (Abramowitz and Stegun, 1972)

SFDXFK\ 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SFDXFK\�x, l, s�

'HVFULSWLRQ Returns the cumulative Cauchy distribution.

$UJXPHQWV

x real number

l real location parameter

s real scale parameter,  

0 x 1< <

X k≤

0 k n≤ ≤
0 p 1≤≤

s 0>
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SFKLVT 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SFKLVT�x, d�

'HVFULSWLRQ Returns the cumulative chi-squared distribution.

$UJXPHQWV

x real number,  

d integer degrees of freedom, 

$OJRULWKP Continued fraction and asymptotic expansions (Abramowitz and Stegun, 1972)

SHUPXW 1XPEHU�7KHRU\�&RPELQDWRULFV

6\QWD[ SHUPXW�n, k�

'HVFULSWLRQ Returns the number of ways of ordering n distinct objects taken k at a time. 

$UJXPHQWV
n, k integers, 

&RPPHQWV Each such ordered arrangement is known as a permutation. The number of permutations is 

P

6HH�DOVR FRPELQ

SH[S 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SH[S�x, r�

'HVFULSWLRQ Returns the cumulative exponential distribution.

$UJXPHQWV
x real number,  

r real rate,  

S) 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ S)�x, d1, d2�

'HVFULSWLRQ Returns the cumulative F distribution.

$UJXPHQWV
x real number, 

d1, d2 integer degrees of freedom, 

$OJRULWKP Continued fraction expansion (Abramowitz and Stegun, 1972)

SJDPPD 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SJDPPD�x, s�

'HVFULSWLRQ Returns the cumulative gamma distribution.

$UJXPHQWV
x real number, 
s real shape parameter,  

$OJRULWKP Continued fraction and asymptotic expansion (Abramowitz and Stegun, 1972)

x 0≥
d 0>

0 k n≤ ≤

n

k
n!

n k–( )!
------------------=

x 0≥
r 0>

x 0≥
d1 0> d2, 0>

x 0≥
s 0>
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SJHRP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SJHRP�k, p�

'HVFULSWLRQ Returns Pr( ) when the random variable X has the geometric distribution with parameter p.

$UJXPHQWV
k integer, 

p real number,  

SK\SHUJHRP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SK\SHUJHRP�m, a, b, n�

'HVFULSWLRQ Returns Pr( ) when the random variable X has the hypergeometric distribution with 
parameters a, b and n.

$UJXPHQWV
m, a, b, n integers, , ,  

SOQRUP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SOQRUP�x, µ, σ�
'HVFULSWLRQ Returns the cumulative lognormal distribution.

$UJXPHQWV

x real number, 

µ real logmean

σ real logdeviation,  

SORJLV 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SORJLV�x, l, s�

'HVFULSWLRQ Returns the cumulative logistic distribution.

$UJXPHQWV
x real number

l real location parameter 

s real scale parameter,  

SPW )LQDQFH

6\QWD[ SPW�rate, nper, pv, [[fv], [type]]��

'HVFULSWLRQ Returns the payment for an investment or loan based on periodic, constant payments over a given 
number of compounding periods, nper, using a fixed interest rate, rate, and a specified present 
value, pv.

$UJXPHQWV
rate real rate

nper integer number of compounding periods, nper ≥ 1

pv real present value

fv (optional) real future value, default is fv = 0

type (optional) indicator payment timing, 0 for payment made at the end of the period, 1 for payment 
made at the beginning, default is type = 0

X k≤

k 0≥
0 p 1≤<

X m≤

0 m a≤ ≤ 0 n m b≤–≤ 0 n a b+≤ ≤

x 0≥

σ 0>

s 0>
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&RPPHQWV If you know the annual interest rate, ann_rate, you must calculate the interest rate per period as 
rate = ann_rate/nper.

Payments you make, such as deposits into a savings account or payments toward a loan, must be 
entered as negative numbers. Cash you receive, such as dividend checks, must be entered as 
positive numbers.

6HH�DOVR FXPLQW��FXPSUQ��IY��LSPW,�QSHU��SSPW��SY��UDWH

SQELQRP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SQELQRP�k, n, p�

'HVFULSWLRQ Returns the cumulative negative binomial distribution with parameters n and p.

$UJXPHQWV
k, n integers,  and 

p real number, 

$OJRULWKP Continued fraction expansion (Abramowitz and Stegun, 1972)

SQRUP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SQRUP�x,�µ, σ�
'HVFULSWLRQ Returns the cumulative normal distribution.

$UJXPHQWV
x real number

µ real mean 

σ real standard deviation,  

3RO\KHGURQ � 9HFWRU�DQG�0DWUL[

6\QWD[ 3RO\KHGURQ�S�

'HVFULSWLRQ Generates the uniform polyhedron whose name, number code, or Wytoff symbol is S. 

$UJXPHQWV
S string expression containing the name of a polyhedron, its number code, or its Wytoff symbol

([DPSOH

n 0> k 0≥
0 p 1≤<

σ 0>
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&RPPHQWV A uniform polyhedron has faces which are regular polygons and every vertex is in the same 
relationship to the solid. The faces, however, need not be identical. There are 75 such polyhedra, 
as well as two infinite families of prisms and antiprisms. The 3RO\KHGURQ function can construct 
80 examples of these, and is used with the 3D surface plot tool as illustrated. Its argument is 
either a name (“cube”), the # symbol followed by a number (“#6”), or a Wytoff symbol (“3|2 4

3RO\/RRNXS � 9HFWRU�DQG�0DWUL[

6\QWD[ 3RO\/RRNXS�n�

'HVFULSWLRQ Returns a vector containing the name, the dual name, and the Wytoff symbol for the polyh
indicated by n. 

$UJXPHQWV
n integer, is the code for a polyhedron; alternatively, a string expression containing the 

polyhedron’s number code, name, or Wytoff symbol

6HH�DOVR 3RO\KHGURQ for example

SRO\URRWV 6ROYLQJ

6\QWD[ SRO\URRWV�v�

'HVFULSWLRQ Returns the roots of an nth degree polynomial whose coefficients are in v. Output is a vector of 
length n. 

$UJXPHQWV
v real or complex vector of length 

([DPSOH

&RPPHQWV To find the roots of an expression having the form: 

you can use the SRO\URRWV function rather than the URRW function. Unlike URRW, SRO\URRWV does 
not require a guess value. Moreover, SRO\URRWV returns all roots at once, whether real or comple

The SRO\URRWV function can solve only one polynomial equation in one unknown. See URRW for 
a more general equation solver. To solve several equations simultaneously, use solve blo
()LQG or 0LQHUU). To solve an equation symbolically − that is, to find an exact numerical answe
in terms of elementary functions − choose Solve for Variable from the Symbolics menu or use 
the VROYH keyword.

n 1+

vnxn … v2x2 v1x v0+ + + +
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$OJRULWKP Laguerre with deflation and polishing (Lorczak) is the default method; a companion matrix-based 
method (using Mathcad’s HLJHQYDOV function) is available if you right-click on the word 
SRO\URRWV and change the selection on a pop-up menu.

6HH�DOVR See FRHII keyword for a way to create the coefficient vector v immediately, given a polynomial.

SRO�[\ 9HFWRU�DQG�0DWUL[

6\QWD[ SRO�[\�r, θ�

'HVFULSWLRQ Converts the polar coordinates of a point in 2D space to rectangular coordinates.

$UJXPHQWV
r, θ real numbers

&RPPHQWV x = r cos(θ), y = r sin(θ)

6HH�DOVR [\�SRO

SSPW )LQDQFH

6\QWD[ SSPW�rate, per, nper, pv,�>>fv@,�>type@@��

'HVFULSWLRQ Returns the payment on the principal, of an investment or loan, for a given period, per, based on 
periodic, constant payments over a given number of compounding periods, nper, using a fixed 
interest rate, rate, and a specified present value, pv.

$UJXPHQWV
rate real rate

per integer period number, per ≥ 1

nper integer number of compounding periods, 1 ≤ per ≤ nper

pv real present value

fv (optional) real future value, default is fv = 0

type (optional) indicator payment timing, 0 for payment made at the end of the period, 1 for paym
made at the beginning, default is type = 0

&RPPHQWV If you know the annual interest rate, ann_rate, you must calculate the interest rate per period 
rate = ann_rate/nper.

Payments you make, such as deposits into a savings account or payments toward a loan, 
entered as negative numbers. Cash you receive, such as dividend checks, must be enter
positive numbers.

6HH�DOVR FXPSUQ��LSPW,�SPW

SSRLV 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SSRLV�k,�λ)
'HVFULSWLRQ Returns the cumulative Poisson distribution.

$UJXPHQWV

k integer, 

λ real mean, 

$OJRULWKP Continued fraction and asymptotic expansions (Abramowitz and Stegun, 1972)

k 0≥
λ 0>
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SUHGLFW � ,QWHUSRODWLRQ�DQG�3UHGLFWLRQ

6\QWD[ SUHGLFW�v, m, n�

'HVFULSWLRQ Returns n predicted values based on m consecutive values from the data vector v. Elements in v 
should represent samples taken at equal intervals.

$UJXPHQWV
v real vector

m, n integers, m > 0, n > 0

([DPSOH

&RPPHQWV Interpolation functions such as FVSOLQH,�OVSOLQH, or SVSOLQH, coupled with LQWHUS, allow you to 
find data points lying between existing data points. However, you may need to find data points 
that lie beyond your existing ones. Mathcad provides the function SUHGLFW which uses some of 
your existing data to predict data points lying beyond existing ones. This function uses a linear 
prediction algorithm which is useful when your data is smooth and oscillatory, although not 
necessarily periodic. This algorithm can be seen as a kind of extrapolation method but should 
not be confused with linear or polynomial extrapolation.

The�SUHGLFW function uses the last m of the original data values to compute prediction coefficients. 
After it has these coefficients, it uses the last m points to predict the coordinates of the (m+1)st 
point, in effect creating a moving window that is m points wide.

$OJRULWKP Burg’s method (Press et al., 1992)

SVSOLQH ,QWHUSRODWLRQ�DQG�3UHGLFWLRQ

2QH�GLPHQVLRQDO�&DVH

6\QWD[ SVSOLQH�vx, vy�

'HVFULSWLRQ Returns the vector of coefficients of a cubic spline with parabolic ends. This vector become
first argument of the�LQWHUS�function. 

$UJXPHQWV
vx, vy real vectors of the same size; elements of vx must be in ascending order
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7ZR�GLPHQVLRQDO�&DVH

6\QWD[ SVSOLQH�Mxy, Mz�

'HVFULSWLRQ Returns the vector of coefficients of a two-dimensional cubic spline, constrained to be parabolic 
at region boundaries spanned by Mxy. This vector becomes the first argument of the�LQWHUS�
function. 

$UJXPHQWV
Mxy  matrix whose elements,  and , specify the x- and y-coordinates along the 

diagonal of a rectangular grid. This matrix plays exactly the same role as vx in the one-
dimensional case described earlier. Since these points describe a diagonal, the elements in each 
column of Mxy must be in ascending order (  whenever ).

Mz  matrix whose ijth element is the z-coordinate corresponding to the point  
and . Mz plays exactly the same role as vy in the one-dimensional case above.

$OJRULWKP Tridiagonal system solving (Press et al., 1992; Lorczak)

6HH�DOVR OVSOLQH for more details

SW 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SW�x, d�

'HVFULSWLRQ Returns the cumulative Student’s t distribution. 

$UJXPHQWV
x real number, 

d integer degrees of freedom,  

$OJRULWKP Continued fraction expansion (Abramowitz and Stegun, 1972).

SXQLI 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SXQLI�x, a, b�

'HVFULSWLRQ Returns the cumulative uniform distribution.

$UJXPHQWV

x real number

a, b real numbers,  

SY )LQDQFH

6\QWD[ SY�rate, nper, pmt,�>>fv@,�>type@@��

'HVFULSWLRQ Returns the present value of an investment or loan based on periodic, constant payments over a 
given number of compounding periods, nper, using a fixed interest rate, rate, and a specified 
payment, pmt.

n 2× Mxyi 0, Mxyi 1,

Mxyi k, Mxyj k,< i j<
n n× x Mxyi 0,=

y Mxyj 1,=

x 0≥
d 0>

a b<
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$UJXPHQWV
rate real rate

nper integer number of compounding periods, nper ≥ 1

pmt real payment

fv (optional) real future value, default is fv = 0

type (optional) indicator payment timing, 0 for payment made at the end of the period, 1 for payment 
made at the beginning, default is type = 0

&RPPHQWV If you know the annual interest rate, ann_rate, you must calculate the interest rate per period as 
rate = ann_rate/nper.

Payments you make, such as deposits into a savings account or payments toward a loan, must be 
entered as negative numbers. Cash you receive, such as dividend checks, must be entered as 
positive numbers.

6HH�DOVR IY,�QSHU,�SPW,�UDWH

SZHLEXOO 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ SZHLEXOO�x, s�

'HVFULSWLRQ Returns the cumulative Weibull distribution. 

$UJXPHQWV

x real number, 

s real shape parameter,  

SZUILW 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ SZUILW�vx, vy, vg�

'HVFULSWLRQ Returns a vector containing the parameters (a, b, c) that make the function  best 
approximate the data in vx and vy.

$UJXPHQWV
vx, vy real vectors of the same size

vg real vector of guess values for (a, b, c)

&RPPHQWV This is a special case of the JHQILW�function. A vector of guess values is needed for initialization. 
By decreasing the value of the built-in TOL variable, higher accuracy in SZUILW might be achieved.

6HH�$OVR OLQH,�OLQILW,�JHQILW,�H[SILW,�ORJILW, OQILW, OJVILW,�VLQILW,�PHGILW

x 0≥
s 0>

a xb⋅ c+
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TEHWD 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TEHWD�p, s1, s2�

'HVFULSWLRQ Returns the inverse beta distribution with shape parameters s1 and s2. 

$UJXPHQWV
p real number, 

s1, s2 real shape parameters, 

$OJRULWKP Root finding (bisection and secant methods) (Press et al., 1992)

TELQRP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TELQRP�p, n, q�

'HVFULSWLRQ Returns the inverse binomial distribution function, that is, the smallest integer k so that 
SELQRP(k, n, q) ≥ p.

$UJXPHQWV
n integer, n > 0

p, q real numbers, , 

&RPPHQWV k is approximately the integer for which Pr( ) = p, when the random variable X has the 
binomial distribution with parameters n and q. This is the meaning of “inverse” binomial 
distribution function.

$OJRULWKP Discrete bisection method (Press et al., 1992)

TFDXFK\ 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TFDXFK\�p, l, s�

'HVFULSWLRQ Returns the inverse Cauchy distribution function.

$UJXPHQWV

p real number, 

l real location parameter

s real scale parameter,  

TFKLVT 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TFKLVT�p, d�

'HVFULSWLRQ Returns the inverse chi-squared distribution.

$UJXPHQWV
p real number, 

d integer degrees of freedom,  

$OJRULWKP Root finding (bisection and secant methods) (Press et al., 1992)
Rational function approximations (Abramowitz and Stegun, 1972)

0 p≤ 1≤
s1 0> s2, 0>

0 p 1≤≤ 0 q 1≤≤

X k≤

0 p 1< <

s 0>

0 p 1<≤
d 0>
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TH[S 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TH[S�p, r�

'HVFULSWLRQ Returns the inverse exponential distribution.

$UJXPHQWV
p real number, 

r real rate,  

T) 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ T)�p, d1, d2)

'HVFULSWLRQ Returns the inverse F distribution.

$UJXPHQWV
p real number, 

d1, d2 integer degrees of freedom, d1 > 0, d2 > 0 

$OJRULWKP Root finding (bisection and secant methods) (Press et al., 1992)

TJDPPD 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TJDPPD�p, s�

'HVFULSWLRQ Returns the inverse gamma distribution.

$UJXPHQWV
p real number, 

s real shape parameter,  

$OJRULWKP Root finding (bisection and secant methods) (Press et al., 1992)
Rational function approximations (Abramowitz and Stegun, 1972)

TJHRP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TJHRP�p, q�

'HVFULSWLRQ Returns the inverse geometric distribution, that is, the smallest integer k so that SJHRP(k, q) ≥ p.

$UJXPHQWV
p, q real numbers, , 

&RPPHQWV k is approximately the integer for which Pr( ) = p, when the random variable X has the 
geometric distribution with parameter q. This is the meaning of “inverse” geometric distribution
function.

0 p 1<≤
r 0>

0 p 1<≤

0 p 1<≤
s 0>

0 p 1< < 0 q 1< <

X k≤



 

��� �&KDSWHU����)XQFWLRQV

TK\SHUJHRP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TK\SHUJHRP�p, a, b, n�

'HVFULSWLRQ Returns the inverse hypergeometric distribution, that is, the smallest integer k so that 
SK\SHUJHRP(k, a, b, n) ≥ p.

$UJXPHQWV
p real number, 

a, b, n integers, , , 

&RPPHQWV k is approximately the integer for which Pr( ) = p, when the random variable X has the 
hypergeometric distribution with parameters a, b and n. This is the meaning of “inverse” 
hypergeometric distribution function.

$OJRULWKP Discrete bisection method (Press et al., 1992)

TOQRUP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TOQRUP�p,�µ, σ�
'HVFULSWLRQ Returns the inverse log normal distribution.

$UJXPHQWV
p real number; 

µ logmean 

σ logdeviation; 

$OJRULWKP Root finding (bisection and secant methods) (Press et al., 1992)

TORJLV 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TORJLV�p, l, s�

'HVFULSWLRQ Returns the inverse logistic distribution.

$UJXPHQWV
p real number, 

l real location parameter 

s real scale parameter,  

TQELQRP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TQELQRP�p, n, q�

'HVFULSWLRQ Returns the inverse negative binomial distribution function, that is, the smallest integer k so that 
SQELQRP(k, n, q) ≥ p.

$UJXPHQWV
n integer, n > 0

p, q real numbers, , 

&RPPHQWV k is approximately the integer for which Pr( ) = p, when the random variable X has the 
negative binomial distribution with parameters n and q. This is the meaning of “inverse” negative
binomial distribution function.

$OJRULWKP Discrete bisection method (Press et al., 1992)

0 p 1≤ ≤
0 a≤ 0 b≤ 0 n a b+≤ ≤

X k≤

0 p 1<≤

σ 0>

0 p 1<<

s 0>

0 p 1<< 0 q 1<<

X k≤
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TQRUP 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TQRUP�p,�µ, σ�
'HVFULSWLRQ Returns the inverse normal distribution.

$UJXPHQWV
p real number, 

m real mean 

s standard deviation, 

$OJRULWKP Root finding (bisection and secant methods) (Press et al., 1992)

TSRLV 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TSRLV�p,�λ)
'HVFULSWLRQ Returns the inverse Poisson distribution, that is, the smallest integer k so that SSRLV(k, λ) ≥ p.

$UJXPHQWV

p real number, 

λ real mean, 

&RPPHQWV k is approximately the integer for which Pr( ) = p, when the random variable X has the 
Poisson distribution with parameter λ. This is the meaning of “inverse” Poisson distribution 
function.

$OJRULWKP Discrete bisection method (Press et al., 1992)

TU� � 9HFWRU�DQG�0DWUL[

6\QWD[ TU�A�

'HVFULSWLRQ Returns an  matrix whose first m columns contain the  orthonormal matrix
Q, and whose remaining n columns contain the  upper triangular matrix R. These satisfy 
the matrix equation .

$UJXPHQWV
A real  matrix

([DPSOH

0 p 1< <

σ 0>

λ 0>
X k≤

m m n+( )× m m×
m n×

A Q R⋅=

m n×
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TW 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TW�p, d�

'HVFULSWLRQ Returns the inverse Student’s t distribution.

$UJXPHQWV
p real number, 

d integer degrees of freedom,  

$OJRULWKP Root finding (bisection and secant methods) (Press et al., 1992). 

TXQLI 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TXQLI�p, a, b�

'HVFULSWLRQ Returns the inverse uniform distribution.

$UJXPHQWV
p real number, 

a, b real numbers,  

TZHLEXOO 3UREDELOLW\�'LVWULEXWLRQ

6\QWD[ TZHLEXOO�p, s�

'HVFULSWLRQ Returns the inverse Weibull distribution. 

$UJXPHQWV
p real number, 

s real shape parameter,  

0 p 1< <
d 0>

0 p 1≤≤
a b<

s 0>
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UDQN 9HFWRU�DQG�0DWUL[

6\QWD[ UDQN�A�

'HVFULSWLRQ Returns the rank of a matrix A, i.e., the maximum number of linearly independent columns in A.

$UJXPHQWV
A real  matrix

$OJRULWKP Singular value computation (Wilkinson and Reinsch, 1971)

UDWH )LQDQFH

6\QWD[ UDWH�nper, pmt, pv, >>fv@��>type@��>guess@@��

'HVFULSWLRQ Returns the interest rate per period of an investment or loan over a specified number of 
compounding periods, nper, given a periodic, constant payment, pmt, and a specified present 
value, pv.

$UJXPHQWV
nper integer number of compounding periods, nper ≥ 1

pmt real payment

pv real present value

fv (optional) real future value, default is fv = 0

type (optional) indicator payment timing, 0 for payment made at the end of the period, 1 for payment 
made at the beginning, default is type = 0

guess (optional) real guess, default is guess = 0.1 (10%)

&RPPHQWV Payments you make, such as deposits into a savings account or payments toward a loan, must be 
entered as negative numbers. Cash you receive, such as dividend checks, must be entered as 
positive numbers.

If UDWH cannot find a result that is accurate to within  percent after 20 iterations, it returns 
an error. In such a case, a different guess value should be tried, but it will not guarantee a solution.

6HH�DOVR FUDWH��IY��QSHU��SPW��SY

UEHWD 5DQGRP�1XPEHUV

6\QWD[ UEHWD�m, s1, s2�

'HVFULSWLRQ Returns a vector of m random numbers having the beta distribution.

$UJXPHQWV
m integer, m > 0

s1, s2 real shape parameters, s1 > 0, s2 > 0

$OJRULWKP Best’s XG algorithm, Johnk’s generator (Devroye, 1986)

6HH�DOVR UQG

m n×

1 10 7–⋅



��� �&KDSWHU����)XQFWLRQV

UELQRP 5DQGRP�1XPEHUV

6\QWD[ UELQRP�m, n, p�

'HVFULSWLRQ Returns a vector of m random numbers having the binomial distribution.

$UJXPHQWV
m, n integers, m > 0, n > 0

p real number, 

$OJRULWKP Waiting time and rejection algorithms (Devroye, 1986)

6HH�DOVR UQG

UFDXFK\ 5DQGRP�1XPEHUV

6\QWD[ UFDXFK\�m, l, s)

'HVFULSWLRQ Returns a vector of m random numbers having the Cauchy distribution.

$UJXPHQWV

m integer, m > 0
l real location parameter

s real scale parameter, 

$OJRULWKP Inverse cumulative density method (Press et al., 1992)

6HH�DOVR UQG

UFKLVT 5DQGRP�1XPEHUV

6\QWD[ UFKLVT�m, d�

'HVFULSWLRQ Returns a vector of m random numbers having the chi-squared distribution.

$UJXPHQWV
m integer, m > 0
d integer degrees of freedom,  

$OJRULWKP Best’s XG algorithm, Johnk’s generator (Devroye, 1986)

6HH�DOVR UQG

5H &RPSOH[�1XPEHUV

6\QWD[ 5H�z�

'HVFULSWLRQ Returns the real part of z.

$UJXPHQWV
z real or complex number

6HH�DOVR ,P

0 p 1≤≤

s 0>

d 0>
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5($'B%/8(� )LOH�$FFHVV

6\QWD[ 5($'B%/8(�file�

'HVFULSWLRQ Extracts only the blue component from file of a color image in BMP, JPG, GIF, TGA, and PCX 
format. The result is a matrix with one-third as many columns as the matrix returned by 
5($'5*%.

$UJXPHQWV
file string variable corresponding to color image filename or path

5($'%03 )LOH�$FFHVV

6\QWD[ 5($'%03�file�

'HVFULSWLRQ Creates a matrix containing a grayscale representation of the bitmap image in file. Each element 
in the matrix corresponds to a pixel. The value of a matrix element determines the shade of gray 
associated with the corresponding pixel. Each element is an integer between 0 (black) and 255 
(white). 

$UJXPHQWV
file string variable corresponding to grayscale image BMP filename or path

&RPPHQWV Picture viewer will display the matrix.

The function 5($'B,0$*( which reads not only BMP files but also JPG, GIF, TGA and PCX 
files. 

6HH�DOVR For color images, see 5($'5*%.

5($'B*5((1� )LOH�$FFHVV

6\QWD[ 5($'B*5((1�file�

'HVFULSWLRQ Extracts only the green component from file of a color image in BMP, JPG, GIF, TGA, and PCX 
format. The result is a matrix with one-third as many columns as the matrix returned by 
5($'5*%.

$UJXPHQWV
file string variable corresponding to color image filename or path

5($'B+/6 � )LOH�$FFHVV

6\QWD[ 5($'B+/6�file�

'HVFULSWLRQ Creates a matrix in which the color information in file is represented by the appropriate values 
of hue, lightness, and saturation. file is in BMP, JPG, GIF, TGA, or PCX format.

$UJXPHQWV
file string variable corresponding to color image filename or path

6HH�DOVR See 5($'5*% for an overview.
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5($'B+/6B+8(� )LOH�$FFHVV

6\QWD[ 5($'B+/6B+8(�file�

'HVFULSWLRQ Extracts only the hue component from file of a color image in BMP, JPG, GIF, TGA, or PCX 
format. The result is a matrix with one-third as many columns as the matrix returned by 
5($'B+/6.

$UJXPHQWV
file string variable corresponding to color image filename or path

5($'B+/6B/,*+7� )LOH�$FFHVV

6\QWD[ 5($'B+/6B/,*+7�file�

'HVFULSWLRQ Extracts only the lightness component from file of a color image in BMP, JPG, GIF, TGA, or 
PCX format. The result is a matrix with one-third as many columns as the matrix returned by 
5($'B+/6.

$UJXPHQWV
file string variable corresponding to color image filename or path

5($'B+/6B6$7� )LOH�$FFHVV

6\QWD[ 5($'B+/6B6$7�file�

'HVFULSWLRQ Extracts only the saturation component from file of a color image in BMP, JPG, GIF, TGA, or 
PCX format. The result is a matrix with one-third as many columns as the matrix returned by 
5($'B+/6.

$UJXPHQWV
file string variable corresponding to color image filename or path

5($'B+69 � )LOH�$FFHVV

6\QWD[ 5($'B+69�file�

'HVFULSWLRQ Creates a matrix in which the color information in file is represented by the appropriate values 
of hue, saturation and value. file is in BMP, JPG, GIF, TGA, or PCX format.

$UJXPHQWV
file string variable corresponding to color image filename or path

6HH�DOVR See 5($'5*% for an overview of reading color data files.

5($'B+69B+8(� )LOH�$FFHVV

6\QWD[ 5($'B+69B+8(�file�

'HVFULSWLRQ Extracts only the hue component from file of a color image in BMP, JPG, GIF, TGA, or PCX 
format. The result is a matrix with one-third as many columns as the matrix returned by 
5($'B+69.

$UJXPHQWV
file string variable corresponding to color image filename or path
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5($'B+69B6$7� )LOH�$FFHVV

6\QWD[ 5($'B+69B6$7�file�

'HVFULSWLRQ Extracts only the saturation component from file of a color image in BMP, JPG, GIF, TGA, or 
PCX format. The result is a matrix with one-third as many columns as the matrix returned by 
5($'B+69.

$UJXPHQWV
file string variable corresponding to color image filename or path

5($'B+69B9$/8(� )LOH�$FFHVV

6\QWD[ 5($'B+69B9$/8(�file�

'HVFULSWLRQ Extracts only the value component from file of a color image in BMP, JPG, GIF, TGA, or PCX 
format. The result is a matrix with one-third as many columns as the matrix returned by 
5($'B+69.

$UJXPHQWV
file string variable corresponding to color image filename or path

5($'B,0$*(� )LOH�$FFHVV

6\QWD[ 5($'B,0$*(�file�

'HVFULSWLRQ Creates a matrix containing a grayscale representation of the image in file. Each element in the 
matrix corresponds to a pixel. The value of a matrix element determines the shade of gray 
associated with the corresponding pixel. Each element is an integer between 0 (black) and 255 
(white). file is in BMP, JPG, GIF, TGA, or PCX format.

$UJXPHQWV
file string variable corresponding to grayscale image filename or path

6HH�DOVR For color images, see 5($'5*%.

5($'351 )LOH�$FFHVV

6\QWD[ 5($'351�file�

'HVFULSWLRQ Reads a structured ASCII data file and returns a matrix. Each line in the data file becomes a row 
in the matrix. The number of elements in each row must be the same. Used as follows:
A := 5($'351(file).

$UJXPHQWV
file string variable corresponding to structured ASCII data filename or path

&RPPHQWV The�5($'351 function reads an entire data file, determines the number of rows and columns, 
and creates a matrix out of the data.
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When Mathcad reads data with the 5($'351 function:

• Each instance of the 5($'351 function reads an entire data file.
• All lines in the data file must have the same number of values. (Mathcad ignores lines

no values.) If the lines in the file have differing numbers of values, Mathcad marks the
5($'351 equation with an error message. Use a text editor to replace the missing va
with zeros before you use 5($'351.

• The 5($'351�function ignores text in the data file.
• The result of reading the data file is an m-by-n matrix A, where m is the number of lines 

containing data in the file and n is the number of values per line.
:5,7(351 and 5($'351 allow you to write out and read in nested arrays created in Mathcad.

5($'B5(' �� )LOH�$FFHVV

6\QWD[ 5($'B5('�file�

'HVFULSWLRQ Extracts only the red component from file of a color image in BMP, JPG, GIF, TGA, or PCX 
format.The result is a matrix with one-third as many columns as the matrix returned by 
5($'5*%.

$UJXPHQWV
file string variable corresponding to color image filename or path

5($'5*% )LOH�$FFHVV

6\QWD[ 5($'5*%�file�

'HVFULSWLRQ Creates a matrix in which the color information in the BMP file file is represented by the 
appropriate values of red, green, and blue. This matrix consists of three submatrices, eac
the same number of columns and rows. Three matrix elements, rather than one, correspo
each pixel. Each element is an integer between 0 and 255. The three corresponding elem
when taken together, establish the color of the pixel.

$UJXPHQWV
file string variable corresponding to color image filename or path

([DPSOH

&RPPHQWV To partition the matrix for a color image into its red, green, and blue components, use the
VXEPDWUL[ function formulas shown in the example above. In this example, the color bitmap
monalisa.bmp is read into a grayscale matrix gray, as well as the packed RGB matrix 
packed, and then converted into three submatrices called red, green, and blue.

Picture viewer will display the matrix.

Mathcad includes several specialized functions for reading color images or image compo
including functions for reading images in GIF, JPG, TGA and PCX formats. 
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Consult the following table to decide which function to use:

1RWH 5($'B+/6 and 5($'B+69 work in exactly the same way as 5($'5*%��All the others work 
in exactly the same way as 5($'%03�

6HH�DOVR For grayscale images, see 5($'%03.

5($':$9 )LOH�$FFHVV

6\QWD[ 5($':$9�file�

'HVFULSWLRQ Creates a matrix containing signal amplitudes in file. Each column represents a separate channel 
of data. Each row corresponds to a moment in time.

$UJXPHQWV
file string variable corresponding to pulse code modulated (PCM) Microsoft WAV filename or path

&RPPHQWV Data from a WAV file is not scaled. 

6HH�DOVR :5,7(:$9�and *(7:$9,1)2

UHJUHVV 5HJUHVVLRQ�DQG�6PRRWKLQJ

2QH�GLPHQVLRQDO�&DVH

6\QWD[ UHJUHVV�vx, vy,�n�

'HVFULSWLRQ Returns the vector required by the�LQWHUS function to find the nth order polynomial that best fits 
data arrays vx and vy.

$UJXPHQWV
vx, vy real vectors of the same size

n integer, n > 0

7R�VHSDUDWH�D�ILOH�LQWR�WKHVH�

FRPSRQHQWV� 8VH�WKHVH�IXQFWLRQV�

UHG��JUHHQ��DQG�EOXH��5*%� 5($'B5('��5($'B*5((1��5($'B%/8(

KXH��OLJKWQHVV��DQG�VDWXUDWLRQ�

�+/6�

5($'B+/6��5($'B+/6B+8(��

5($'B+/6B/,*+7��5($'B+/6B6$7��

KXH��VDWXUDWLRQ��DQG�YDOXH��+69� 5($'B+69��5($'B+69B+8(��

5($'B+69B6$7��5($'B+69B9$/
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([DPSOH

&RPPHQWV The regression functions UHJUHVV and ORHVV are useful when you have a set of measured y values 
corresponding to x values and you want to fit a polynomial of degree n through those y values. 
(For a simple linear fit, that is, n=1, you may as well use the OLQH�function.)

Use UHJUHVV when you want to use a single polynomial to fit all your data values. The UHJUHVV 
function lets you fit a polynomial of any order. However as a practical matter, you would rarely 
need to go beyond .

Since UHJUHVV tries to accommodate all your data points using a single polynomial, it will not 
work well when your data does not behave like a single polynomial. For example, suppose you 
expect your  to be linear from  to  and to behave like a cubic equation from  to . 
If you use UHJUHVV with  (a cubic), you may get a good fit for the second half but a poor 
fit for the first half.

The ORHVV function alleviates these kinds of problems by performing a more localized regression.

For UHJUHVV, the first three components of the output vector  are vr0=3 
(a code telling�LQWHUS that vr is the output of UHJUHVV as opposed to a spline function or ORHVV), 
vr1=3 (the index within vr where the polynomial coefficients begin), and vr2=n (the order of the 
fit). The remaining n + 1 components are the coefficients of the fitting polynomial from the lowest 
degree term to the highest degree term.

n 6=

yi x1 x10 x11 x20
n 3=

vr regress vx vy n, ,( ):=
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7ZR�GLPHQVLRQDO�&DVH

6\QWD[ UHJUHVV(Mxy, vz, n)

'HVFULSWLRQ Returns the vector required by the�LQWHUS function to find the nth order polynomial that best fits 
data arrays Mxy and vz. Mxy is an  matrix containing x-y coordinates. vz is an m-element 
vector containing the z coordinates corresponding to the m points specified in Mxy.

$UJXPHQWV
Mxy real  matrix containing x-y coordinates of the m data points

vz real m-element vector containing the z coordinates corresponding to the points specified in Mxy

n integer, n > 0

&RPPHQWV Assume, for example, that you have a set of measured z values corresponding to x and y values 
and you want to fit a polynomial surface through those z values. The meanings of the input 
arguments are more general than in the one-dimensional case:

• The argument vx, which was an m-element vector of x values, becomes an  matrix, 
Mxy. Each row of Mxy contains an x in the first column and a corresponding y value in the 
second column.

• The argument x for the LQWHUS function becomes a 2-element vector v whose elements are 
the x and y values at which you want to evaluate the polynomial surface representing the
fit to the data points in Mxy and vz.

This discussion can be extended naturally to higher dimensional cases. You can add indep
variables by simply adding columns to the Mxy array. You would then add a corresponding 
number of rows to the vector v that you pass to the LQWHUS function. The UHJUHVV�function can 
have as many independent variables as you want. However, UHJUHVV will calculate more slowly 
and require more memory when the number of independent variables and the degree are 
than four. The ORHVV function is restricted to at most four independent variables.

Keep in mind that for UHJUHVV, the number of data values, m must satisfy , 

where k is the number of independent variables (hence the number of columns in Mxy), n is the 
degree of the desired polynomial, and m is the number of data values (hence the number of ro
in vz). For example, if you have five explanatory variables and a fourth degree polynomial,
will need more than 126 observations. 

The ORHVV function works better than UHJUHVV when your data does not behave like a single 
polynomial.

$OJRULWKP Normal equation solution through Gauss-Jordan elimination (Press et al., 1992)

UHOD[ � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ UHOD[�A, B, C, D, E, F, U, rjac�

'HVFULSWLRQ Returns a matrix of solution values for a Poisson partial differential equation over a planar s
region. More general than PXOWLJULG, which is faster.

m 2×

m 2×

m 2×

m n k 1–+
n 

  n k+
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------------⋅>
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$UJXPHQWV
A, B, C, D, E real square matrices all of the same size containing coefficients of the discretized Laplacian (for 

example, the left-hand side of equations below).

F real square matrix containing the source term at each point in the region in which the solution is 
sought (for example, the right-hand side of equations below).

U real square matrix containing boundary values along the edges of the region and initial guesses 
for the solution inside the region.

rjac spectral radius of the Jacobi iteration, , which controls the convergence of the 
relaxation algorithm. Its optimal value depends on the details of your problem.

([DPSOH

&RPPHQWV Two partial differential equations that arise often in the analysis of physical systems are Poisson’s 
equation:

 and its homogeneous form, Laplace’s equation.

Mathcad has two functions for solving these equations over a square region, assuming the values 
taken by the unknown function  on all four sides of the boundary are known. The most 
general solver is the UHOD[ function. In the special case when u(x, y) is known to be zero on all 
four sides of the boundary, you can use the PXOWLJULG function instead. This function will often 
solve the problem faster than UHOD[. If the boundary condition is the same on all four sides, you 
can simply transform the equation to an equivalent one in which the value is zero on all four sides.

The UHOD[ function returns a square matrix in which:

• an element's location in the matrix corresponds to its location within the square region
• its value approximates the value of the solution at that point. 
This function uses the relaxation method to converge to the solution. Poisson's equation 
square domain is represented by:

.

$OJRULWKP Gauss-Seidel with successive overrelaxation (Press et al., 1992)

6HH�DOVR PXOWLJULG

0 rjac 1<<

x2

2

∂
∂ u

y2

2

∂
∂ u

+ ρ x y,( )=

u x y,( )

aj k, uj 1+ k, bj k, uj 1– k, cj k, uj k 1+, dj k, uj k 1–, ej k, uj k,+ + + + fj k,=
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UHYHUVH 6RUWLQJ

2QH�GLPHQVLRQDO�&DVH

6\QWD[ UHYHUVH�v�

'HVFULSWLRQ Reverses the order of the elements of vector v. 

$UJXPHQWV
v vector 

7ZR�GLPHQVLRQDO�&DVH

6\QWD[ UHYHUVH�A�

'HVFULSWLRQ Reverses the order of the rows of matrix A. 

$UJXPHQWV
A matrix

6HH�DOVR See VRUW�for sample application.

UH[S 5DQGRP�1XPEHUV

6\QWD[ UH[S�m, r�

'HVFULSWLRQ Returns a vector of m random numbers having the exponential distribution.

$UJXPHQWV
m integer, m > 0
r real rate,  

6HH�DOVR UQG

$OJRULWKP Inverse cumulative density method (Press et al., 1992)

U) 5DQGRP�1XPEHUV

6\QWD[ U)�m, d1, d2�

'HVFULSWLRQ Returns a vector of m random numbers having the F distribution.

$UJXPHQWV
m integer, m > 0

d1, d2 integer degrees of freedom, d1 > 0, d2 > 0

$OJRULWKP Best’s XG algorithm, Johnk’s generator (Devroye, 1986)

6HH�DOVR UQG

UJDPPD 5DQGRP�1XPEHUV

6\QWD[ UJDPPD�m, s�

'HVFULSWLRQ Returns a vector of m random numbers having the gamma distribution.

$UJXPHQWV
m integer, m > 0
s real shape parameter, s > 0

$OJRULWKP Best’s XG algorithm, Johnk’s generator (Devroye, 1986)

6HH�DOVR UQG

r 0>
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UJHRP 5DQGRP�1XPEHUV

6\QWD[ UJHRP�m, p�

'HVFULSWLRQ Returns a vector of m random numbers having the geometric distribution.

$UJXPHQWV
m integer, m > 0
p real number, 

$OJRULWKP Inverse cumulative density method (Press et al., 1992)

6HH�DOVR UQG

UK\SHUJHRP 5DQGRP�1XPEHUV

6\QWD[ UK\SHUJHRP�m, a, b, n�

'HVFULSWLRQ Returns a vector of m random numbers having the hypergeometric distribution.

$UJXPHQWV
m integer, m > 0

a, b, n integers, , , 

$OJRULWKP Uniform sampling methods (Devroye, 1986)

6HH�DOVR UQG

UNDGDSW� � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ UNDGDSW�y, x1, x2, acc, D, kmax, save�

'HVFULSWLRQ Solves a differential equation using a slowly varying Runge-Kutta method. Provides DE solution 
estimate at x2.

$UJXPHQWV Several arguments for this function are the same as described for UNIL[HG.

y real vector of initial values

x1, x2 real endpoints of the solution interval

acc real acc > 0 controls the accuracy of the solution; a small value of acc forces the algorithm to 
take smaller steps along the trajectory, thereby increasing the accuracy of the solution. Values 
of acc around 0.001 will generally yield accurate solutions.

D(x, y) real vector-valued function containing the derivatives of the unknown functions

kmax integer kmax > 0 specifies the maximum number of intermediate points at which the solution 
will be approximated. The value of kmax places an upper bound on the number of rows of the 
matrix returned by these functions. 

save real save > 0 specifies the smallest allowable spacing between the values at which the solutions 
are to be approximated. save places a lower bound on the difference between any two numbers 
in the first column of the matrix returned by the function.

&RPPHQWV The specialized DE solvers�%XOVWRHU��5NDGDSW��6WLIIE��and�6WLIIU provide the solution y(x) over 
a number of uniformly spaced x-values in the integration interval bounded by x1 and x2. When 
you want the value of the solution at only the endpoint, y(x2), use EXOVWRHU��UNDGDSW��VWLIIE� 
and VWLIIU instead.

$OJRULWKP Adaptive step 5th order Runge-Kutta method (Press et al., 1992)

6HH�DOVR UNIL[HG, a more general differential equation solver, for information on output and arguments; 
5NDGDSW�
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5NDGDSW� � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ 5NDGDSW�y, x1, x2, npts, D�

'HVFULSWLRQ Solves a differential equation using a slowly varying Runge-Kutta method; provides DE solution 
at equally spaced x values by repeated calls to UNDGDSW.

$UJXPHQWV All arguments for this function are the same as described for UNIL[HG.

y real vector of initial values

x1, x2 real endpoints of the solution interval

npts integer npts > 0 specifies the number of points beyond initial point at which the solution is to be 
approximated; controls the number of rows in the matrix output

D(x, y) real vector-valued function containing the derivatives of the unknown functions

&RPPHQWV Given a fixed number of points, you can approximate a function more accurately if you evaluate 
it frequently wherever it’s changing fast, and infrequently wherever it’s changing more slowly. 
If you know that the solution has this property, you may be better off using 5NDGDSW. Unlike 
UNIL[HG which evaluates a solution at equally spaced intervals, 5NDGDSW examines how fast the 
solution is changing and adapts its step size accordingly. This “adaptive step size control” e
5NDGDSW to focus on those parts of the integration domain where the function is rapidly chan
rather than wasting time on the parts where change is minimal.

Although 5NDGDSW will use nonuniform step sizes internally when it solves the differential 
equation, it will nevertheless return the solution at equally spaced points.

5NDGDSW takes the same arguments as UNIL[HG, and the matrix returned by 5NDGDSW is identical 
in form to that returned by UNIL[HG.

$OJRULWKP Fixed step Runge-Kutta method with adaptive intermediate steps (5th order) (Press et al., 1992)

6HH�DOVR UNIL[HG��a more general differential equation solver, for information on output and argume
also 2GHVROYH, for a solve block approach.

UNIL[HG 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ UNIL[HG�y, x1, x2, npts, D�

'HVFULSWLRQ Solves a differential equation using a standard Runge-Kutta method. Provides DE solutio
equally spaced x values. 

$UJXPHQWV
y real vector of initial values (whose length depends on the order of the DE or the size of the s

of DEs). For a first order DE like that in Example 1 or Example 2 below, the vector degene
to one point, . For a second order DE like that in Example 3, the vector has
elements: the value of the function and its first derivative at x1. For higher order DEs like that 
in Example 4, the vector has n elements for specifying initial conditions of y, . 
For a first order system like that in Example 5, the vector contains initial values for each unk
function. For higher order systems like that in Example 6, the vector contains initial value
the  derivatives of each unknown function in addition to initial values for the function
themselves.

y 0( ) y x1( )=

y′ y″ … y n 1–( ), , ,

n 1–
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x1, x2 real endpoints of the interval on which the solution to the DEs will be evaluated; initial values 
in y are the values at x1

npts integer npts > 0 specifies the number of points beyond the initial point at which the solution is 
to be approximated; controls the number of rows in the matrix output

D(x, y) real vector-valued function containing derivatives of the unknown functions. For a first order DE 
like that in Example 1 or Example 2, the vector degenerates to a scalar function. For a second 
order DE like that in Example 3, the vector has two elements:

For higher order DEs like that in Example 4, the vector has n elements: .

For a first order system like that in Example 5, the vector contains the first derivatives of each 
unknown function. For higher order systems like that in Example 6, the vector contains 
expressions for the  derivatives of each unknown function in addition to nth derivatives.

([DPSOHV�

Example 1: Solving a first order differential equation. 

D t y,( ) y′ t( )
y″ t( )

=

D t y,( )

y′ t( )
y″ t( )

.

.

.

y n( ) t( )

=

n 1–
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Example 2: Solving a nonlinear differential equation. 

Example 3: Solving a second order differential equation.
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.

Example 4: Solving a higher order differential equation.

Example 5: Solving a system of first order linear equations.
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Example 6: Solving a system of second order linear differential equations. 

&RPPHQWV For a first order DE like that in Example 1 or Example 2, the output of UNIL[HG is a two-column 
matrix in which:

• The left-hand column contains the points at which the solution to the DE is evaluated.
• The right-hand column contains the corresponding values of the solution.
For a second order DE like that in Example 3, the output matrix contains three columns: th
hand column contains the t values; the middle column contains ; and the right-hand colum
contains . 
For higher order DEs like that in Example 4, the output matrix contains n columns: the left-hand 
one for the t values and the remaining columns for values of y(t), . 

For a first order system like that in Example 5, the first column of the output matrix contain
points at which the solutions are evaluated and the remaining columns contain correspon
values of the solutions. For higher order systems like that in Example 6: 

• The first column contains the values at which the solutions and their derivatives are eval
• The remaining columns contain corresponding values of the solutions and their deriva

The order in which the solutions and their derivatives appear matches the order in whic
put them into the vector of initial conditions.

The most difficult part of solving a DE is defining the function D(x, y). In Example 1 and Example 
2, for example, it was easy to solve for . In some more difficult cases, you can solve

 symbolically and paste it into the definition for D(x, y). To do so, use the�VROYH keyword 
or the Solve for Variable command from the Symbolics menu.

The function UNIL[HG�uses a fourth order Runge-Kutta method, which is a good general-purp
DE solver. Although it is not always the fastest method, the Runge-Kutta method nearly al
succeeds. There are certain cases in which you may want to use one of Mathcad's more spe
DE solvers. These cases fall into three broad categories:

y t( )
y′ t( )

y′ t( ) y″ t( ) … y n 1–( ) t( ), , ,

y′ x( )
y′ x( )
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• Your system of DEs may have certain properties which are best exploited by functions 
than UNIL[HG. The system may be stiff (6WLIIE��6WLIIU); the functions could be smooth 
(%XOVWRHU) or slowly varying (5NDGDSW).

• You may have a boundary value rather than an initial value problem (VEYDO and�EYDOILW).
• You may be interested in evaluating the solution only at one point (EXOVWRHU��UNDGDSW��VWLIIE 

and VWLIIU).
You may also want to try several methods on the same DE to see which one works the b
Sometimes there are subtle differences between DEs that make one method better than 

$OJRULWKP Fixed step 4th order Runge-Kutta method (Press et al., 1992)

6HH�DOVR Mathcad Resource Center QuickSheets and Differential Equations tutorial; also 2GHVROYH, for 
a solve block approach.

UOQRUP 5DQGRP�1XPEHUV

6\QWD[ UOQRUP�m��µ, σ�
'HVFULSWLRQ Returns a vector of m random numbers having the lognormal distribution.

$UJXPHQWV
m integer, m > 0
µ real logmean

σ real logdeviation, 

$OJRULWKP Ratio-of-uniforms method (Devroye, 1986)

6HH�DOVR UQG

UORJLV 5DQGRP�1XPEHUV

6\QWD[ UORJLV�m, l, s�

'HVFULSWLRQ Returns a vector of m random numbers having the logistic distribution.

$UJXPHQWV
m integer, m > 0
l real location parameter 

s real scale parameter, 

$OJRULWKP Inverse cumulative density method (Press et al., 1992)

6HH�DOVR UQG

UQELQRP 5DQGRP�1XPEHUV

6\QWD[ UQELQRP�m, n, p�

'HVFULSWLRQ Returns a vector of m random numbers having the negative binomial distribution. 

$UJXPHQWV
m, n integers, m > 0, n> 0

p real number, 

$OJRULWKP Based on USRLV and UJDPPD (Devroye, 1986)

6HH�DOVR UQG

σ 0>

s 0>
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UQG 5DQGRP�1XPEHUV

6\QWD[ UQG�x�

'HVFULSWLRQ Returns a random number between 0 and x. Identical to UXQLI(1, 0, x) if . 

$UJXPHQWV
x real number

([DPSOH

Note: You won’t be able to recreate this example exactly because the random 
number generator gives different numbers every time.

&RPPHQWV Each time you recalculate an equation containing UQG or some other random variate built-in 
function, Mathcad generates new random numbers. Recalculation is performed by clicking on 
the equation and choosing Calculate from the Math menu.

These functions have a “seed value” associated with them. Each time you reset the seed, M
generates new random numbers based on that seed. A given seed value will always gene
same sequence of random numbers. Choosing Calculate from the Math menu advances Mathcad
along this random number sequence. Changing the seed value, however, advances Mathca
an altogether different random number sequence.

To change the seed value, choose Options from the Math menu and change the value of “seed
on the Built-In Variables tab. Be sure to supply an integer.

To reset Mathcad's random number generator without changing the seed value, choose Options 
from the Math menu, click on the Built-In Variables tab, and click “OK” to accept the curre
seed. Then click on the equation containing the random number generating function and c
Calculate from the Math menu. Since the randomizer has been reset, Mathcad generates
same random numbers it would generate if you restarted Mathcad.

There are many other random variate generators in Mathcad. 

$OJRULWKP Linear congruence method (Knuth, 1997)

x 0>
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UQRUP 5DQGRP�1XPEHUV

6\QWD[ UQRUP�m��µ, σ�
'HVFULSWLRQ Returns a vector of m random numbers having the normal distribution.

$UJXPHQWV
m integer, m > 0
µ real mean 

σ real standard deviation, 

([DPSOH

Note: You won’t be able to recreate this example exactly because the random 
number generator gives different numbers every time.

$OJRULWKP Ratio-of-uniforms method (Devroye, 1986)

6HH�DOVR UQG

URRW 6ROYLQJ

8QEUDFNHWHG�9HUVLRQ

6\QWD[ URRW(f(var)��var�

'HVFULSWLRQ Returns a value of var at which the expression f(var) or function f is equal to 0. 

$UJXPHQWV
var real or complex scalar; var must be assigned a guess value before using this version of URRW�

f real or complex-valued function.

σ 0>
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&RPPHQWV For expressions with several roots, your guess value determines which root Mathcad returns. The 
example shows a situation in which the URRW function returns several different values, each of 
which depends on the initial guess value.

You can’t put numerical values in the list of unknowns; for example, URRW(f(x), -2) or 
URRW(14, −2) is not permitted in the example above. 

Mathcad solves for complex roots as well as real roots. To find a complex root, you must
with a complex value for the initial guess.

Solving an equation of the form  is equivalent to using the URRW function as follows:

The URRW function can solve only one equation in one unknown. To solve several equation
simultaneously, use )LQG or 0LQHUU. To solve an equation symbolically, that is, to find an exa
numerical answer in terms of elementary functions, choose Solve for Variable from the 
Symbolics menu or use the VROYH keyword.

See also SRO\URRWV for an efficient means to compute all roots of a polynomial at once.

Mathcad evaluates the unbracketed version of the URRW function using the secant method. If that 
method fails to find a root, then the Mueller method is used. The guess value you supply for x 
becomes the starting point for successive approximations to the root value. When the mag
of f(x) evaluated at the proposed root is less than the value of the predefined variable TO
URRW function returns a result.

If after many approximations Mathcad still cannot find an acceptable answer, it marks theURRW 
function with an error message indicating its inability to converge to a result. This error ca
caused by any of the following:

• The expression has no roots.
• The roots of the expression are far from the initial guess.
• The expression has local maxima or minima between the initial guess and the roots.
• The expression has discontinuities between the initial guess and the roots.
• The expression has a complex root but the initial guess was real (or vice versa).
To find the cause of the error, try plotting the expression. This will help determine whethe
not the expression crosses the x-axis and if so, approximately where. In general, the closer yo
initial guess is to where the expression crosses the x-axis, the more quickly the URRW function will 
converge on an acceptable result.

f x( ) g x( )=

root f x( ) g x( )– x,( )
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Here are some hints for getting the most out of the URRW function:

• To change the accuracy of the URRW function, change the value of the built-in variable TOL
If you increase TOL, the URRW function will converge more quickly, but the answer will be
less accurate. If you decrease TOL, the URRW function will converge more slowly, but the 
answer will be more accurate. To change TOL at a specified point in the worksheet, inc
a definition like . To change TOL for the whole worksheet, choose Options 
from the Math menu, click on the Built-In Variables tab, and replace the number in the 
box beside “TOL.” After you click “OK,” choose Calculate Worksheet from the Math 
menu to update the entire worksheet using the new value of TOL.

• If an expression has multiple roots, try different guess values to find them. Plotting the
function is a good way to determine how many roots there are, where they are, and w
initial guesses are likely to find them. Refer to the previous example. If two roots are c
together, you may have to reduce TOL to distinguish between them.

• If f(x) has a small slope near its root, then  may converge to a value r that is 

relatively far from the actual root. In such cases, even though , r may be far 

from the point where . To find a more accurate root, decrease the value of TO

Or, try finding URRW(g(x),x), where .

• For an expression f(x) with a known root r, solving for additional roots of f(x) is equivalent 

to solving for roots of . Dividing out known roots like this is usefu
for resolving two roots that may be close together. It's often easier to solve for roots ofh(x) 
as defined here than it is to try to find other roots for f(x) with different guesses.

$OJRULWKP Secant and Mueller methods (Press et al., 1992; Lorczak)

%UDFNHWHG�9HUVLRQ

6\QWD[ URRW(f(var)��var, a, b�

'HVFULSWLRQ Returns a value of var lying between a and b at which the expression f(var) or function f is equal 
to 0. 

$UJXPHQWV
var real scalar

f real-valued function

a, b real numbers, a < b

&RPPHQWV For expressions with several roots, your choice of interval endpoints a and b determines which 
root Mathcad returns. f(a) and f(b) must be of opposite signs. Observe that an initial guess f
var is not required for the bracketed version of URRW to work.

If the optional arguments a and b are not included, then the unbracketed version of root is us
Note the restriction to real expressions and real variables in the bracketed case.

Mathcad evaluates the bracketed version of the root function using the Ridder method. If that 
method fails to find a root, then the Brent method is used.

The above comments concerning convergence and accuracy for the unbracketed version URRW 
also apply to the bracketed version.

$OJRULWKP Ridder and Brent methods (Press et al., 1992; Lorczak)

TOL 0.01:=

root f x( ) x,( )
f r( ) TOL<

f r( ) 0=

g x( ) f x( )
d

dx
------f x( )
----------------=

h x( ) f x( )( ) x r–( )⁄=
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URXQG 7UXQFDWLRQ�DQG�5RXQG�RII

2QH�DUJXPHQW�9HUVLRQ

6\QWD[ URXQG�x�

'HVFULSWLRQ Rounds the real number x to the nearest integer. Same as URXQG(x, 0).

$UJXPHQWV
x real number

7ZR�DUJXPHQW�9HUVLRQ

6\QWD[ URXQG�x, n�

'HVFULSWLRQ Rounds the real number x to n decimal places. If n < 0, x is rounded to the left of the decimal point.

$UJXPHQWV
x real number

n integer

6HH�DOVR FHLO��IORRU��WUXQF

URZV 9HFWRU�DQG�0DWUL[

6\QWD[ URZV(A�

'HVFULSWLRQ Returns the number of rows in array A. 

$UJXPHQWV
A matrix or vector

6HH�DOVR FROV for example

USRLV 5DQGRP�1XPEHUV

6\QWD[ USRLV�m��λ)

'HVFULSWLRQ Returns a vector of m random numbers having the Poisson distribution.

$UJXPHQWV

m integer, m > 0
λ real mean, 

$OJRULWKP Devroye, 1986

6HH�DOVR UQG

UUHI 9HFWRU�DQG�0DWUL[

6\QWD[ UUHI�A)

'HVFULSWLRQ Returns a matrix representing the row-reduced echelon form of A.

$UJXPHQWV

A real  matrix

$OJRULWKP Elementary row reduction (Anton)

λ 0>

m n×
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UVRUW 6RUWLQJ

6\QWD[ UVRUW�A��i)

'HVFULSWLRQ Sorts the columns of the matrix A by placing the elements in row i in ascending order. The result 
is the same size as A. 

$UJXPHQWV

A  matrix or vector

i integer, 

$OJRULWKP Heap sort (Press et al., 1992)

6HH�DOVR VRUW for more details, FVRUW

UW 5DQGRP�1XPEHUV

6\QWD[ UW�m��d)

'HVFULSWLRQ Returns a vector of m random numbers having Student’s t distribution.

$UJXPHQWV

m integer, m > 0
d integer degrees of freedom, 

$OJRULWKP Best’s XG algorithm, Johnk’s generator (Devroye, 1986)

6HH�DOVR UQG

UXQLI 5DQGRP�1XPEHUV

6\QWD[ UXQLI�m��a��b)

'HVFULSWLRQ Returns a vector of m random numbers having the uniform distribution

$UJXPHQWV

m integer, m > 0
a, b real numbers, 

$OJRULWKP Linear congruence method (Knuth, 1997)

6HH�DOVR UQG

UZHLEXOO 5DQGRP�1XPEHUV

6\QWD[ UZHLEXOO�m��s�

'HVFULSWLRQ Returns a vector of m random numbers having the Weibull distribution.

$UJXPHQWV

m integer, m > 0
s real shape parameter, 

$OJRULWKP Inverse cumulative density method (Press et al., 1992)

6HH�DOVR UQG 

m n×
0 i m 1–≤ ≤

d 0>

a b<

s 0>
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6DYH&RORUPDS � )LOH�$FFHVV

6\QWD[ 6DYH&RORUPDS�file, M�

'HVFULSWLRQ Creates a colormap file containing the values in the matrix M. Returns the number of rows written 
to file.

$UJXPHQWV
file string variable corresponding to CMP filename

M integer matrix with three columns and whose elements Mi, j all satisfy .

&RPPHQWV The file file is the name of a colormap located in the CMAPS subdirectory of your Mathcad 
directory. After you use 6DYH&RORUPDS, the colormap is available on the Advanced tab in the 
3D Plot Format dialog box. See on-line Help for more information.

6HH�DOVR /RDG&RORUPDS

VEYDO � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ VEYDO�v, x1, x2, D, load, score�

'HVFULSWLRQ Converts a boundary value differential equation to an initial value problem. Useful when 
derivatives are continuous throughout. 

$UJXPHQWV
v real vector containing guesses for missing initial values

x1, x2 real endpoints of the interval on which the solution to the DEs will be evaluated

D(x, y) real n-element vector-valued function containing the derivatives of the unknown functions

load(x1, v) real vector-valued function whose n elements correspond to the values of the n unknown functions 
at x1. Some of these values will be constants specified by your initial conditions. If a value is 
unknown, you should use the corresponding guess value from v.

score(x2, y) real n-element vector-valued function which measures solution discrepancy at x2

([DPSOH
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&RPPHQWV Initial value DE solvers like UNIL[HG assume that you know the value of the solution and its first 
 derivatives at the beginning of the interval of integration. Two-point boundary value DE 

solvers, like VEYDO�and�EYDOILW, may be used if you lack this information about the solution at 
the beginning of the interval of integration, but you do know something about the solution 
elsewhere in the interval. In particular:

• You have an nth order differential equation.
• You know some but not all of the values of the solution and its first  derivatives at

beginning of the interval of integration, x1.
• You know some but not all of the values of the solution and its first  derivatives at

end of the interval of integration, x2.
• Between what you know about the solution at x1 and what you know about it at x2, you have 

n known values.
If there is a discontinuity at a point intermediate to x1 and x2, you should use EYDOILW��If continuity 
holds throughout, then use VEYDO to evaluate those initial values left unspecified at x1. VEYDO does 
not actually return a solution to a differential equation; it merely computes the initial values
solution must have in order for the solution to match the final values you specify. You must
take the initial values returned by�VEYDO and solve the resulting initial value problem using 
UNIL[HG or any of the other more specialized DE solvers.

$OJRULWKP Shooting method with 4th order Runge-Kutta method (Press et al., 1992)

6HH�DOVR UNIL[HG�for more details; also 2GHVROYH, for a solve block approach.

VHDUFK � 6WULQJ

6\QWD[ VHDUFK�S, SubS, m�

'HVFULSWLRQ Returns the starting position of the substring SubS in S beginning from position m. Returns –1 if 
the substring is not found.

$UJXPHQWV
S string expression; Mathcad assumes that the first character in S is at position 0

SubS substring expression

m integer,  

VHF 7ULJRQRPHWULF

6\QWD[ VHF(z), for z in radians;
VHF(z·deg), for z in degrees

'HVFULSWLRQ Returns the secant of z.

$UJXPHQWV
z real or complex number; z is not an odd multiple of π/2

VHFK +\SHUEROLF

6\QWD[ VHFK�z�

'HVFULSWLRQ Returns the hyperbolic secant of z.

$UJXPHQWV
z real or complex number

n 1–

n 1–

n 1–

m 0≥
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VLJQ 3LHFHZLVH�&RQWLQXRXV

6\QWD[ VLJQ�x�

'HVFULSWLRQ Returns 0 if x=0, 1 if x > 0, and −1 otherwise.

$UJXPHQWV
x real number

6HH�DOVR FVJQ��VLJQXP

VLJQXP &RPSOH[�1XPEHUV

6\QWD[ VLJQXP�z)

'HVFULSWLRQ Returns 1 if z=0 and  otherwise.

$UJXPHQWV
z real or complex number

6HH�DOVR FVJQ��VLJQ

VLQ 7ULJRQRPHWULF

6\QWD[ VLQ(z), for z in radians;
VLQ(z·deg), for z in degrees

'HVFULSWLRQ Returns the sine of z. 

$UJXPHQWV
z real or complex number

VLQILW 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ VLQILW�vx, vy, vg�

'HVFULSWLRQ Returns a vector containing the parameters (a, b, c) that make the function  
best approximate the data in vx and vy.

$UJXPHQWV
vx, vy real vectors of the same size

vg real vector of guess values for (a, b, c)

&RPPHQWV This is a special case of the JHQILW�function. A vector of guess values is needed for initializatio
By decreasing the value of the built-in TOL variable, higher accuracy in VLQILW might be achieved. 

6HH�$OVR OLQH,�OLQILW,�JHQILW,�H[SILW��ORJILW,�OQILW, SZUILW��OJVILW��PHGILW

VLQK +\SHUEROLF

6\QWD[ VLQK�z�

'HVFULSWLRQ Returns the hyperbolic sine of z.

$UJXPHQWV
z real or complex number

z z⁄

a x b+( )sin⋅ c+
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VNHZ 6WDWLVWLFV

6\QWD[ VNHZ�A�

'HVFULSWLRQ Returns the skewness of the elements of A: 

$UJXPHQWV
A real or complex  matrix or vector, 

&RPPHQWV VNHZ(A, B, C, ...) is also permissible and returns the skewness of the elements of A, B, C, ....

VORSH 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ VORSH�vx, vy)

'HVFULSWLRQ Returns the slope of the least-squares regression line. 

$UJXPHQWV
vx, vy real vector arguments of the same size

([DPSOH

&RPPHQWV The functions LQWHUFHSW and VORSH return the intercept and slope of the line which best fits the 
data in a least-squares sense: . Alternatively, you 
may use the OLQH function which returns both parameter estimates via one function call.

Be sure that every element in the vx and vy arrays contains a data value. Since every element in 
an array must have a value, Mathcad assigns 0 to any elements not explicitly assigned.

These functions are useful not only when the data is inherently linear, but also when it is 
exponential. If x and y are related by , you can apply these functions to the logarithm 
of the data values and make use of the fact that , hence 

.

The resulting fit weighs the errors differently from a least-squares exponential fit (which the 
function H[SILW provides) but is usually a good approximation.

6HH�DOVR LQWHUFHSW,�OLQH��VWGHUU��PHGILW

skew A( ) mn
mn 1–( ) mn 2–( )

-------------------------------------------
Ai j, mean A( )–

Stdev A( )
---------------------------------------- 

 
3

j 0=

n 1–

∑
i 0=

m 1–

∑=

m n× m n 3≥⋅

y intercept vx vy,( ) slope vx vy,( ) x⋅+=

y Aekx=
y( )ln A( )ln kx+=

A intercept vx vy( )ln,( )( )  and  exp= k slope vx vy( )ln,( )=
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VRUW 6RUWLQJ

6\QWD[ VRUW�v�

'HVFULSWLRQ Returns the elements of vector v sorted in ascending order. 

$UJXPHQWV
v vector

([DPSOH

&RPPHQWV All of Mathcad’s sorting functions accept matrices and vectors with complex elements. How
in sorting them, Mathcad ignores the imaginary part.

To sort a vector or matrix in descending order, first sort in ascending order, then use�UHYHUVH. 
For example, UHYHUVH(VRUW(v)) returns the elements of v sorted in descending order.

Unless you change the value of ORIGIN, matrices are numbered starting with row zero a
column zero. If you forget this, it’s easy to make the error of sorting a matrix on the wrong
or column by specifying an incorrect n argument for UVRUW and FVRUW. To sort on the first column 
of a matrix, for example, you must use FVRUW(A, 0). 

$OJRULWKP Heap sort (Press et al., 1992)

VSK�[\] 9HFWRU�DQG�0DWUL[

6\QWD[ VSK�[\]�r, θ, φ�

'HVFULSWLRQ Converts the spherical coordinates of a point in 3D space to rectangular coordinates.

$UJXPHQWV
r, θ, φ real numbers

&RPPHQWV x = r sin(φ) cos(θ), y = r sin(φ) sin(θ), z = r cos(φ)

6HH�DOVR [\]�VSK
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VWDFN 9HFWRU�DQG�0DWUL[

6\QWD[ VWDFN�A, B, C, ...�

'HVFULSWLRQ Returns a matrix formed by placing the matrices A, B, C, ... top to bottom.

$UJXPHQWV
A, B, C, ... at least two matrices or vectors; A, B, C, ... must have the same number of columns

6HH�DOVR DXJPHQW for example

VWGHUU 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ VWGHUU�vx, vy�

'HVFULSWLRQ Returns the standard error associated with simple linear regression, measuring how closely data 
points are spread about the regression line.

. 

$UJXPHQWV
vx, vy real vector arguments of the same size

6HH�DOVR VORSH��LQWHUFHSW

VWGHY 6WDWLVWLFV

6\QWD[ VWGHY�A�

'HVFULSWLRQ Returns the standard deviation of the elements of A, where mn (the sample size) is used in the 
denominator: .

$UJXPHQWV
A real or complex  matrix or vector

&RPPHQWV VWGHY(A, B, C, ...) is also permissible and returns the standard deviation of the elements of A, 
B, C, ....

6HH�DOVR 6WGHY,�YDU,�9DU

6WGHY 6WDWLVWLFV

6\QWD[ 6WGHY�A�

'HVFULSWLRQ Returns the standard deviation of the elements of A, where mn − 1 (the sample size less one) is 
used in the denominator: .

$UJXPHQWV
A real or complex  matrix or vector

&RPPHQWV 6WGHY(A, B, C, ...) is also permissible and returns the standard deviation of the elements of A, 
B, C, ....

6HH�DOVR VWGHY��YDU��9DU

stderr vx vy,( ) 1
n 2–
------------ vyi intercept vx vy,( ) slope vx vy,( ) vxi⋅+( )–( )2

i 0=

n 1–

∑=

stdev A( ) var A( )=

m n×

Stdev A( ) Var A( )=

m n×
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VWLIIE � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ VWLIIE�y, x1, x2, acc, D, J, kmax, save�

'HVFULSWLRQ Solves a differential equation using the stiff Bulirsch-Stoer method. Provides DE solution 
estimate at x2.

$UJXPHQWV Several arguments for this function are the same as described for UNIL[HG.

y real vector of initial values. 

x1, x2 real endpoints of the solution interval.

D(x, y) real vector-valued function containing the derivatives of the unknown functions. 

acc real acc > 0 controls the accuracy of the solution; a small value of acc forces the algorithm to 
take smaller steps along the trajectory, thereby increasing the accuracy of the solution. Values 
of acc around 0.001 will generally yield accurate solutions.

J(x, y) real vector-valued function which returns the  matrix whose first column contains 
the derivatives  and whose remaining columns form the Jacobian matrix ( ) for 
the system of DEs. 

kmax integer kmax > 0 specifies maximum number of intermediate points at which the solution will 
be approximated; places an upper bound on the number of rows of the matrix returned by these 
functions. 

save real save > 0 specifies the smallest allowable spacing between values at which the solutions are 
to be approximated; places a lower bound on the difference between any two numbers in the first 
column of the matrix returned by the function.

&RPPHQWV The specialized DE solvers�%XOVWRHU��5NDGDSW��6WLIIE��and�6WLIIU provide the solution y(x) over 
a number of uniformly spaced x-values in the integration interval bounded by x1 and x2. When 
you want the value of the solution at only the endpoint, y(x2), use EXOVWRHU��UNDGDSW��VWLIIE� 
and VWLIIU instead.

$OJRULWKP Bulirsch-Stoer method with adaptive step size for stiff systems (Press et al., 1992)

6HH�DOVR UNIL[HG,�a more general differential equation solver, for information on output and arguments; 
6WLIIE.

6WLIIE � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ 6WLIIE�y, x1, x2, npts, D, J�

'HVFULSWLRQ Solves a differential equation using the stiff Bulirsch-Stoer method. Provides DE solution at 
equally spaced x values by repeated calls to VWLIIE.

$UJXPHQWV Several arguments for this function are the same as described for UNIL[HG.

y real vector of initial values. 

x1, x2 real endpoints of the solution interval.

D(x, y) real vector-valued function containing the derivatives of the unknown functions. 

npts integer npts > 0 specifies the number of points beyond initial point at which the solution is to be 
approximated; controls the number of rows in the matrix output.

J(x, y) real vector-valued function which returns the  matrix whose first column contains 
the derivatives  and whose remaining columns form the Jacobian matrix ( ) for 
the system of DEs. For example, if:

n n 1+( )×
D∂ x∂⁄ D∂ yk∂⁄

n n 1+( )×
D∂ x∂⁄ D∂ yk∂⁄

D x y,( )
x y1⋅

2– y1 y0⋅ ⋅
    then   = J x y,( )

y1 0 x

0 2– y1⋅ 2– y0⋅
=
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&RPPHQWV A system of DEs expressed in the form  is a stiff system if the matrix A is nearly 
singular. Under these conditions, the solution returned by UNIL[HG may oscillate or be unstable. 
When solving a stiff system, you should use one of the two DE solvers specifically designed for 
stiff systems: 6WLIIE and 6WLIIU. These use the Bulirsch-Stoer method and the Rosenbrock method, 
respectively, for stiff systems.

The form of the matrix returned by these functions is identical to that returned by UNIL[HG. 
However, 6WLIIE and 6WLIIU require an extra argument J(x, y). 

$OJRULWKP Fixed-step Bulirsch-Stoer method with adaptive intermediate step size for stiff systems
(Press et al., 1992)

6HH�DOVR UNIL[HG,�a more general differential equation solver, for information on output and arguments. 

VWLIIU � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ VWLIIU�y, x1, x2, acc, D, J, kmax, save�

'HVFULSWLRQ Solves a differential equation using the stiff Rosenbrock method. Provides DE solution estimate 
at x2.

$UJXPHQWV Several arguments for this function the same as described for UNIL[HG�

y real vector of initial values. 

x1, x2 real endpoints of the solution interval.

D(x, y) real vector-valued function containing the derivatives of the unknown functions. 

acc real acc > 0 controls the accuracy of the solution; a small value of acc forces the algorithm to 
take smaller steps along the trajectory, thereby increasing the accuracy of the solution. Values 
of acc around 0.001 will generally yield accurate solutions.

J(x, y) real vector-valued function that returns the  matrix whose first column contains the 
the derivatives  and whose remaining columns form the Jacobian matrix ( ) for 
the system of DEs.

kmax integer kmax > 0 specifies maximum number of intermediate points at which the solution will 
be approximated; places an upper bound on the number of rows of the matrix returned by these 
functions. 

save real save > 0 specifies the smallest allowable spacing between values at which the solutions are 
to be approximated; places a lower bound on the difference between any two numbers in the first 
column of the matrix returned by the function.

&RPPHQWV The specialized DE solvers�%XOVWRHU��5NDGDSW��6WLIIE��and�6WLIIU provide the solution y(x) over 
a number of uniformly spaced x-values in the integration interval bounded by x1 and x2. When 
you want the value of the solution at only the endpoint, y(x2), use EXOVWRHU��UNDGDSW��VWLIIE� 
and VWLIIU instead.

$OJRULWKP 4th order Rosenbrock method with adaptive intermediate step size for stiff systems 
(Press et al., 1992)

6HH�DOVR UNIL[HG,�a more general differential equation solver for information on output and arguments, 
and 6WLIIU

y A x⋅=

n n 1+( )×
D∂ x∂⁄ D∂ yk∂⁄
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6WLIIU � 'LIIHUHQWLDO�(TXDWLRQ�6ROYLQJ

6\QWD[ 6WLIIE�y, x1, x2, npts, D, J�

'HVFULSWLRQ Solves a differential equation using the stiff Rosenbrock method. Provides DE solution at equally 
spaced x values by repeated calls to VWLIIU.

$UJXPHQWV Several arguments for this function are the same as described for UNIL[HG�

y real vector of initial values. 

x1, x2 real endpoints of the solution interval.

D(x, y) real vector-valued function containing the derivatives of the unknown functions. 

npts integer npts > 0 specifies the number of points beyond initial point at which the solution is to be 
approximated; controls the number of rows in the matrix output.

J(x, y) real vector-valued function which returns the  matrix whose first column contains 
the derivatives  and whose remaining columns form the Jacobian matrix ( ) for 
the system of DEs. For example, if: 

&RPPHQWV A system of DEs expressed in the form  is a stiff system if the matrix A is nearly 
singular. Under these conditions, the solution returned by UNIL[HG may oscillate or be unstable. 
When solving a stiff system, you should use one of the two DE solvers specifically designed for 
stiff systems: 6WLIIE and 6WLIIU. These use the Bulirsch-Stoer method and the Rosenbrock method, 
respectively, for stiff systems.

The form of the matrix returned by these functions is identical to that returned by UNIL[HG. 
However, 6WLIIE and 6WLIIU require an extra argument J(x, y). 

$OJRULWKP Fixed-step 4th order Rosenbrock method with adaptive intermediate step size for stiff systems 
(Press et al., 1992)

6HH�DOVR UNIL[HG,�a more general differential equation solver, for information on output and arguments.

VWU�QXP � 6WULQJ

6\QWD[ VWU�QXP�S�

'HVFULSWLRQ Returns the constant formed by converting the characters in S into a number. Characters in S 
must constitute an integer such as 17, a real floating-point number such as −16.5, a complex 
floating-point number such as 2.1+6i or 3.241 − 9.234j, or an e-format number such as 4.51e-3 
(for ). Mathcad ignores any spaces in the string.

$UJXPHQWV
S string expression

6HH�DOVR QXP�VWU

n n 1+( )×
D∂ x∂⁄ D∂ yk∂⁄

D x y,( )
x y1⋅

2– y1 y0⋅ ⋅
    then   = J x y,( )

y1 0 x

0 2– y1⋅ 2– y0⋅
=

y A x⋅=

4.51 10 3–⋅
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VWU�YHF � 6WULQJ

6\QWD[ VWU�YHF�S�

'HVFULSWLRQ Returns the vector of ASCII codes corresponding to the characters in string S. For a list of ASCII 
codes, see the Appendix. For example, the ASCII code for letter “a” is 97, that for letter “b” is 
98, and that for letter “c” is 99.

$UJXPHQWV
S string expression

6HH�DOVR YHF�VWU

VWUOHQ � 6WULQJ

6\QWD[ VWUOHQ�S�

'HVFULSWLRQ Returns the number of characters in S.

$UJXPHQWV
S string expression

VXEPDWUL[ 9HFWRU�DQG�0DWUL[

6\QWD[ VXEPDWUL[�A, ir, jr, ic, jc�

'HVFULSWLRQ Returns a submatrix of A consisting of all elements common to rows ir through jr and columns 
ic through jc. Make certain that  and , otherwise the order of rows and/or colum
will be reversed. 

$UJXPHQWV
A  matrix or vector

ir, jr integers, 

ic, jc integers, 

([DPSOH

ir jr≤ ic jc≤

m n×
0 ir jr m≤ ≤ ≤
0 ic jc n≤ ≤ ≤



)XQFWLRQV ���

VXEVWU � 6WULQJ

6\QWD[ VXEVWU�S, m, n�

'HVFULSWLRQ Returns a substring of S beginning with the character in the mth position and having at most n 
characters. 

$UJXPHQWV
S string expression. Mathcad assumes that the first character in S is at position 0.

m, n integers, 

VXSVPRRWK � 5HJUHVVLRQ�DQG�6PRRWKLQJ

6\QWD[ VXSVPRRWK�vx, vy�

'HVFULSWLRQ Creates a new vector, of the same size as vy, by piecewise use of a symmetric k-nearest neighbor 
linear least square fitting procedure in which k is adaptively chosen. 

$UJXPHQWV
vx, vy real vectors of the same size; elements of vx must be in ascending order

([DPSOH

&RPPHQWV The VXSVPRRWK function uses a symmetric k nearest neighbor linear least-squares fitting 
procedure to make a series of line segments through the data. Unlike NVPRRWK which uses a fixed 
bandwidth for all the data, VXSVPRRWK will adaptively choose different bandwidths for different 
portions of the data.

$OJRULWKP Variable span super-smoothing method (Friedman)

6HH�DOVR PHGVPRRWK�DQG�NVPRRWK

VYG � 9HFWRU�DQG�0DWUL[

6\QWD[ VYG�A�

'HVFULSWLRQ Returns an  matrix whose first m rows contain the  orthonormal matrix U, and 
whose remaining n rows contain the  orthonormal matrix V. Matrices U and V satisfy the 
equation , where s is the vector returned by VYGV(A).

$UJXPHQWV
A  real matrix, where 

m 0≥ n 0≥,

m n+( ) n× m n×
n n×

A U diag s( ) VT⋅ ⋅=

m n× m n≥
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([DPSOH

$OJRULWKP Householder reduction with QR transformation (Wilkinson and Reinsch, 1971)

6HH�DOVR VYGV

VYGV � 9HFWRU�DQG�0DWUL[

6\QWD[ VYGV�A�

'HVFULSWLRQ Returns a vector containing the singular values of A.

$UJXPHQWV
A  real matrix, where 

$OJRULWKP Householder reduction with QR transformation (Wilkinson and Reinsch, 1971)

6HH�DOVR VYG

WDQ 7ULJRQRPHWULF
6\QWD[ WDQ(z) for z in radians;

WDQ(z·deg), for z in degrees

'HVFULSWLRQ Returns the tangent of z.

$UJXPHQWV
z real or complex number

WDQK +\SHUEROLF

6\QWD[ WDQK�z�

'HVFULSWLRQ Returns the hyperbolic tangent of z.

$UJXPHQWV
z UHDO�RU�FRPSOH[�QXPEHU

m n× m n≥
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7FKHE � 6SHFLDO

6\QWD[ 7FKHE�n, x�

'HVFULSWLRQ Returns the value of the Chebyshev polynomial of degree n of the first kind.

$UJXPHQWV
n integer, 

x real number

&RPPHQWV Solution of the differential equation .

$OJRULWKP Recurrence relation (Abramowitz and Stegun, 1972)
6HH�DOVR 8FKHE

WU 9HFWRU�DQG�0DWUL[

6\QWD[ WU�M�

'HVFULSWLRQ Returns the trace of M, the sum of diagonal elements.

$UJXPHQWV
M real or complex square matrix

WUXQF 7UXQFDWLRQ�DQG�5RXQG�RII

6\QWD[ WUXQF�x�

'HVFULSWLRQ Returns the integer part of x. Same as floor(x) for x > 0 and ceil(x) for x < 0.

$UJXPHQWV
x real number

6HH�DOVR FHLO,�IORRU,�URXQG

8FKHE � 6SHFLDO

6\QWD[ 8FKHE�n, x�

'HVFULSWLRQ Returns the value of the Chebyshev polynomial of degree n of the second kind.

$UJXPHQWV
n integer, 

x real number

&RPPHQWV Solution of the differential equation .

$OJRULWKP Recurrence relation (Abramowitz and Stegun, 1972)

6HH�DOVR 7FKHE

8QLWV2I ([SUHVVLRQ�7\SH

6\QWD[ 8QLWV2I�x�

'HVFULSWLRQ Returns the units of x. Returns 1 if x has no units.

$UJXPHQWV
x arbitrary real or complex number, array, or string

&RPPHQWV You can divide a value by the 8QLWV2I function to make it unitless. For example, some built-in 
functions, such as OQ, require their arguments to be unitless. If an argument to OQ�has units, you 
can divide the argument by 8QLWV2I to remove them.

n 0≥

1 x2–( )
x2

2

d
d

y⋅ x
d

dx
------y⋅– n2 y⋅+ 0=

n 0≥

1 x2–( )
x2

2

d
d

y⋅ 3 x
d
dx
------y⋅ ⋅– n n 2+( ) y⋅ ⋅+ 0=



��� �&KDSWHU����)XQFWLRQV

YDU 6WDWLVWLFV

6\QWD[ YDU�A�

'HVFULSWLRQ Returns the variance of the elements of A: .

This expression is normalized by the sample size mn.

$UJXPHQWV
A real or complex  matrix or array

&RPPHQWV YDU(A, B, C, ...) is also permissible and returns the variance of the elements of A, B, C, ....

6HH�DOVR VWGHY��6WGHY��9DU

9DU 6WDWLVWLFV

6\QWD[ 9DU�A�

'HVFULSWLRQ Returns the variance of the elements of A: .

This expression is normalized by the sample size less one, mn − 1.

$UJXPHQWV
A real or complex  matrix or array

&RPPHQWV 9DU(A, B, C, ...) is also permissible and returns the variance of the elements of A, B, C, ....

6HH�DOVR VWGHY��6WGHY��YDU

YHF�VWU � 6WULQJ

6\QWD[ YHF�VWU�v�

'HVFULSWLRQ Returns the string formed by converting a vector v of ASCII codes to characters. The elements 
of v must be integers between 0 and 255. 

$UJXPHQWV
v vector of ASCII codes

6HH�DOVR VWU�YHF

YORRNXS� � 9HFWRU�DQG�0DWUL[

6\QWD[ YORRNXS�z,�A, c�

'HVFULSWLRQ Looks in the first column of a matrix, A, for a given value, z, and returns the value(s) 
in the same row(s) in the column specified, c. When multiple values are returned, they appear 
in a vector.

$UJXPHQWV
z real or complex number, or string

A real, complex or string  matrix

c integer,

&RPPHQWV The degree of precision to which the comparison adheres is determined by the TOL setting of 
the worksheet.

6HH�$OVR ORRNXS,�KORRNXS,�PDWFK

var A( ) 1
mn
------- Ai j, mean A( )– 2

j 0=

n 1–

∑
i 0=

m 1–

∑=

m n×

var A( ) 1
mn 1–
---------------- Ai j, mean A( )– 2

j 0=

n 1–

∑
i 0=

m 1–

∑=

m n×

m n×
ORIGIN c ORIGIN n 1–+≤ ≤
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ZDYH � :DYHOHW�7UDQVIRUP

6\QWD[ ZDYH�v�

'HVFULSWLRQ Returns the discrete wavelet transform of real data using Daubechies four-coefficient wavelet 
filter. 

$UJXPHQWV
v real vector of  elements, where n > 0 is an integer

([DPSOH

&RPPHQWV When you define a vector v for use with Fourier or wavelet transforms, be sure to start with  
(or change the value of ORIGIN). If you do not define , Mathcad automatically sets it to zero. 
This can distort the results of the transform functions.

$OJRULWKP Pyramidal Daubechies 4-coefficient wavelet filter (Press et al., 1992)

6HH�DOVR LZDYH

:5,7(%03 )LOH�$FFHVV

6\QWD[ :5,7(%03�file�

'HVFULSWLRQ Creates a grayscale BMP image file file out of a matrix. 
Used as follows: :5,7(%03( file) := M. The function must appear alone on the left side of a 
definition.

$UJXPHQWV
file string variable corresponding to BMP filename or path

M integer matrix, each element satisfying 

2n

v0
v0

0 Mi j, 255≤ ≤



d 
 
n.

first. 
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:5,7(B+/6 � )LOH�$FFHVV

6\QWD[ :5,7(B+/6�file�

'HVFULSWLRQ Creates a color BMP image file file out of a matrix formed by juxtaposing the three matrices 
giving the hue, lightness, and saturation components of an image. 

$UJXPHQWV
file string variable corresponding to BMP filename or path

M integer matrix, each element satisfying 

6HH�DOVR See :5,7(5*% for an overview of creating color data files.

:5,7(B+69 � )LOH�$FFHVV

6\QWD[ :5,7(B+69�file�

'HVFULSWLRQ Creates a color BMP image file file out of a matrix formed by juxtaposing the three matrices 
giving the hue, saturation, and value components of an image. 

$UJXPHQWV
file string variable corresponding to BMP filename or path

M integer matrix, each element satisfying 

6HH�DOVR See :5,7(5*% for overview.

:5,7(351 )LOH�$FFHVV

6\QWD[ :5,7(351(file) :=  A

'HVFULSWLRQ Writes a matrix A into a structured ASCII data file file. Each row becomes a line in the file. The 
function must appear alone on the left side of a definition.

$UJXPHQWV
file string variable corresponding to structured ASCII data filename or path

A matrix or vector

&RPPHQWV The :5,7(351 and $33(1'351�functions write out data values neatly lined up in rows and 
columns. When you use these functions:

• Equations using :5,7(351�or $33(1'351�must be in a specified form. On the left shoul
be :5,7(351(file) or $33(1'351(file). This is followed by a definition symbol (:=) and
a matrix expression. Do not use range variables or subscripts on the matrix expressio

• Each new equation involving :5,7(351�writes a new file; if two equations write to the 
same file, the data written by the second equation will overwrite the data written by the 
Use $33(1'351 if you want to append values to a file rather than overwrite the file.

• The built-in variables PRNCOLWIDTH and PRNPRECISION determine the format of the 
data file that Mathcad creates. The value of PRNCOLWIDTH specifies the width of the 
columns (in characters). The value of PRNPRECISION specifies the number of significant
digits used. By default, PRNCOLWIDTH=8 and PRNPRECISION=4. To change these 
values, choose Options from the Math menu and edit the numbers on the Built-In Variable
tab, or enter definitions for these variables in your Mathcad document above the :5,7(351�

function.
:5,7(351 and 5($'351 allow you to write out and read in nested arrays created in Mathcad.

0 Mi j, 255≤ ≤

0 Mi j, 255≤ ≤
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If the array you are writing is either a nested array (an array whose elements are themselves 
arrays) or a complex array (an array whose elements are complex), then :5,7(351 will not 
create a simple ASCII file. Instead, :5,7(351 creates a file using a special format unlikely to 
be readable by other applications. This file can, however, be read by Mathcad’s 5($'351 
function.

By using the�DXJPHQW�function, you can concatenate several variables and write them all using 
:5,7(351�to a data file.

6HH�DOVR $33(1'351

:5,7(5*% )LOH�$FFHVV

6\QWD[ :5,7(5*%�file�

'HVFULSWLRQ Creates a color BMP image file file out of a single matrix formed by juxtaposing the three matrices 
giving the red, green, and blue values of an image. Used as follows: :5,7(5*%( file) := M. The 
function must appear alone on the left side of a definition.

$UJXPHQWV
file string variable corresponding to BMP filename or path

M integer matrix, each element satisfying 

&RPPHQWV The function DXJPHQW�is helpful for combining submatrices prior to using :5,7(5*%.

Mathcad has functions for creating color BMP files out of matrices in which the image is stored 
in HLS or HSV format. These work in exactly the same way as :5,7(5*%. 

6HH�DOVR :5,7(B+/6 and :5,7(B+69

:5,7(:$9 )LOH�$FFHVV

6\QWD[ :5,7(:$9�file, s, b�

'HVFULSWLRQ Creates a WAVsignal file file out of a matrix. 
Used as follows: :5,7(:$9( file, s, b) := M. The function must appear alone on the left side 
of a definition.

$UJXPHQWV
file string variable corresponding to pulse code modulated (PCM) Microsoft WAV filename or path

s integer sample rate

b bit resolution

M integer matrix

&RPPHQWV If the specified bit resolution is 1−8, the data is written to file as unsigned byte data. The limits 
on unsigned byte data are 0 to 256. If the bit resolution is 9−16, word data (two bytes) is written 
to file. The limits on word data are -32768 to 32767. 

6HH�DOVR *(7:$9,1)2�and 5($':$9

[\]�F\O 9HFWRU�DQG�0DWUL[

6\QWD[ [\]�F\O�x, y, z�

'HVFULSWLRQ Converts the rectangular coordinates of a point in 3D space to cylindrical coordinates.

$UJXPHQWV
x, y, z real numbers

&RPPHQWV x = r cos(θ), y = r sin(θ), z = z

6HH�DOVR F\O�[\]

0 Mi j, 255≤ ≤
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[\�SRO 9HFWRU�DQG�0DWUL[

6\QWD[ [\�SRO�x, y�

'HVFULSWLRQ Converts the rectangular coordinates of a point in 2D space to polar coordinates.

$UJXPHQWV
x, y real numbers

&RPPHQWV x = r cos(θ), y = r sin(θ)

6HH�DOVR SRO�[\

[\]�VSK 9HFWRU�DQG�0DWUL[

6\QWD[ [\]�VSK�x, y, z�

'HVFULSWLRQ Converts the rectangular coordinates of a point in 3D space to spherical coordinates.

$UJXPHQWV
x, y, z real numbers

&RPPHQWV x = r sin(φ) cos(θ), y = r sin(φ) sin(θ), z = r cos(φ)

6HH�DOVR VSK�[\]

<� %HVVHO

6\QWD[ <��x�

'HVFULSWLRQ Returns the value of the Bessel function  of the second kind. Same as <Q(0, x).

$UJXPHQWV
x real number, x > 0

$OJRULWKP Steed’s method (Press et al., 1992)

<� %HVVHO

6\QWD[ <��x�

'HVFULSWLRQ Returns the value of the Bessel function  of the second kind. Same as <Q(1, x).

$UJXPHQWV
x real number, x > 0

$OJRULWKP Steed’s method (Press et al., 1992)

<Q %HVVHO

6\QWD[ <Q�m, x�

'HVFULSWLRQ Returns the value of the Bessel function  of the second kind.

$UJXPHQWV
m integer, 

x real number, x > 0

&RPPHQWV Solution of the differential equation .

$OJRULWKP Steed’s method (Press et al., 1992)

6HH�DOVR -Q

Y0 x( )

Y1 x( )

Ym x( )

0 m 100≤ ≤

x2

x2

2

d
d

y⋅ x
d

dx
------y⋅ x2 m2–( ) y⋅+ + 0=
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\V � %HVVHO

6\QWD[ \V�n, x�

'HVFULSWLRQ Returns the value of the spherical Bessel function of the second kind, of order n, at x. 

$UJXPHQWV
x real number, x > 0

n integer, 

&RPPHQWV Solution of the differential equation: .

$OJRULWKP Recurrence relation (Abramowitz and Stegun, 1972)

6HH�DOVR MV

δ 3LHFHZLVH�&RQWLQXRXV

6\QWD[ δ�m��n��

'HVFULSWLRQ Returns the value of the Kronecker delta function. Output is 1 if m=n and 0 otherwise.
(To type δ, press d[Ctrl]G).

$UJXPHQWV
m, n integers

$OJRULWKP Continued fraction expansion (Abramowitz and Stegun, 1972; Lorczak)

ε 3LHFHZLVH�&RQWLQXRXV

6\QWD[ ε�i, j, k��
'HVFULSWLRQ Returns the value of a completely antisymmetric tensor of rank three. Output is 0 if any two 

arguments are the same, 1 if the three arguments are an even permutation of (0 1 2), and
the arguments are an odd permutation of (0 1 2). (To type ε, press e[Ctrl]g).

$UJXPHQWV
i, j, k integers between 0 and 2 inclusive (or between ORIGIN and ORIGIN+2 inclusive if ORIGIN≠0)

Γ 6SHFLDO

&ODVVLFDO�'HILQLWLRQ

6\QWD[ Γ�z��
'HVFULSWLRQ Returns the value of the classical Euler gamma function. (To type Γ, press G[Ctrl]g).

$UJXPHQWV
z real or complex number; undefined for  

'HVFULSWLRQ For Re(z) > 0, . 

For Re(z) < 0, function values analytically continue the above formula. Because , 
the gamma function extends the factorial function (traditionally defined only for positive 
integers).

200– n≤

x
2

x2

2

d
d

y 2 x
d

dx
------y x

2
n n 1+( )⋅–( )y 0=+⋅ ⋅+⋅

z 0 1– 2– …, , ,=

Γ z( ) tz 1– e t– td
0

∞

∫=

Γ z 1+( ) z!=
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([WHQGHG�'HILQLWLRQ

6\QWD[ Γ(x, y)

'HVFULSWLRQ Returns the value of the extended Euler gamma function. (To type Γ, press G[Ctrl]g).

$UJXPHQWV
x, y real numbers, 

'HVFULSWLRQ Although restricted to real arguments, the function  

extends the classical gamma function in the sense that the lower limit of integration y is free to 
vary. In the special case when y=0, the classical formulation applies and the first argument may 
assume complex values.

Φ 3LHFHZLVH�&RQWLQXRXV

6\QWD[ Φ�x��
'HVFULSWLRQ Returns the value of the Heaviside step function. Output is 1 if x ≥ 0 and 0 otherwise. 

(To type Φ, press F[Ctrl]g).

$UJXPHQWV
x real number

([DPSOH

x 0> y 0≥,

Γ x y,( ) tx 1– e t– td
y

∞

∫=
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This chapter lists and describes Mathcad’s built-in operators. The operators are 
according to the toolbar (Calculator, Matrix, Calculus, Evaluation, Boolean, or Pr
gramming) on which they appear. 

$FFHVVLQJ�2SHUDWRUV
You can access operators in two ways:

• Simply type in the keystroke shown for that operator, or

• Select the operator from a toolbar.

1. First, select View ⇒ Toolbars ⇒ Math. 
The Math toolbar appears showing the various operator toolbar buttons.

2. Click a button for a specific toolbar. The corresponding toolbar appears.

You can alternatively go directly to an operator toolbar from the View me
by selecting View ⇒ Toolbars, and then selecting one of the operator toolba
listed; for example Matrix:
Accessing Operators 447



 more 
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 but 
ented 
The Matrix operator toolbar appears, showing the various matrix operator 
buttons:

3. Click the button of the operator that you want to use.

)LQGLQJ�0RUH�,QIRUPDWLRQ
Refer to the Resource Center QuickSheets for examples involving operators. Select 
Resource Center from the Help menu. Then click on the QuickSheets icon and select 
a specific topic.

To change the appearance of certain operators (e.g., multiplication or derivatives), 
choose Options from the Math menu, click the Display tab and use drop-down options 
to make the selection. See “Changing the Display of an Operator” on page 130 for
information.

$ERXW�WKH�5HIHUHQFHV
References are provided in the Appendices for you to learn more about the num
algorithm underlying a given Mathcad function or operator. References are not inte
to give a description of the actual underlying source code. Some references (suc
Numerical Recipes) do contain actual C code for the algorithms discussed therein,
the use of the reference does not necessarily imply that the code is what is implem
in Mathcad. The references are cited for their textbook nature only.

$ULWKPHWLF�2SHUDWRUV
To access an arithmetic operator:

• type its keystroke, or 

• choose the operator from the Calculator toolbar (if it has a button):
448  Chapter 18  Operators



Refer to “Accessing Operators” on page 447 for more information on how to 
access a toolbar.

3DUHQWKHVHV

.H\VWURNH ’

'HVFULSWLRQ Groups parts of an expression.

$GGLWLRQ  

.H\VWURNH +

'HVFULSWLRQ If X and Y are real or complex numbers, adds X and Y. 
If X and Y are real or complex vectors or matrices of the same size, adds elements of X to 
corresponding elements of Y. 
If X is a real or complex array and Y is a real or complex number, adds Y to each element of X.

$GGLWLRQ�ZLWK�OLQH�EUHDN  

.H\VWURNH [Ctrl][↵]

'HVFULSWLRQ Adds in the same manner as $GGLWLRQ, but inserts a line break for cosmetic formatting reasons.

&RPPHQWV This formatting feature cannot be used for multiplication or division. It can be used with 
subtraction if X − Y is written instead as X + (− Y).

 X ( )

X Y+

X…
Y+
Arithmetic Operators 449



6XEWUDFWLRQ�DQG�1HJDWLRQ , 

.H\VWURNH -  

6XEWUDFWLRQ

'HVFULSWLRQ If X and Y are real or complex numbers, subtracts Y from X. 
If X and Y are real or complex vectors or matrices of the same size, subtracts elements of Y from 
corresponding elements of X. 
If X is an real or complex array and Y is a real or complex number, subtracts Y from each element 
of X.

1HJDWLRQ

'HVFULSWLRQ If X is a real or complex number, reverses the sign of X.
If X is an real or complex array, reverses the sign of each element of X.

0XOWLSOLFDWLRQ  

.H\VWURNH *

'HVFULSWLRQ If X and Y are real or complex numbers, multiplies Y by X. 
If Y is a real or complex array and X is a real or complex number, multiplies each element 
of Y by X. 
If X and Y are real or complex vectors of the same size, returns the dot product (inner product). 
If X and Y are real or complex conformable matrices, performs matrix multiplication.

To change the appearance of multiplication from a dot to a cross, choose Options from the Math 
menu, click the Display tab and use drop-down options to make the selection.

'LYLVLRQ

.H\VWURNH /

'HVFULSWLRQ If X and z are real or complex numbers and z is nonzero, divides X by z. 
If X is an real or complex array and z is a nonzero real or complex number, divides each element 
of X by z.

,QOLQH�'LYLVLRQ  

.H\VWURNH [Ctrl]/

'HVFULSWLRQ If X and z are real or complex numbers and z is nonzero, divides X by z. 
If X is an real or complex array and z is a nonzero real or complex number, divides each element 
of X by z.

)DFWRULDO

.H\VWURNH !

'HVFULSWLRQ Returns  if n is an integer and ; 1 if n = 0.

X Y– X–

X Y⋅

X
z
---

X z÷

n!

n n 1–( ) n 2–( )…2 1⋅⋅ ⋅ n 1≥
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&RPSOH[�FRQMXJDWH  

.H\VWURNH ”

'HVFULSWLRQ If X is a complex number, reverses the sign of the imaginary part of X.

$EVROXWH�YDOXH  

.H\VWURNH |

'HVFULSWLRQ If z is a real or complex number, |z| returns the absolute value (or modulus or magnitude)

 of z.

If v is real or complex vector, |v| returns the magnitude (or Euclidean norm or length)  of 
v. If all elements in v are real, this definition is equivalent to .

If M is a real or complex square matrix, |M| returns the determinant of M.

6TXDUH�URRW  

.H\VWURNH \

'HVFULSWLRQ Returns the positive square root for positive z; principal value for negative or complex z.

QWK�URRW  

.H\VWURNH [Ctrl]\

'HVFULSWLRQ Returns the positive nth root for positive z; negative nth root for negative z and odd n; principal 
value otherwise. n must be an integer, . 

6HH�DOVR ([SRQHQWLDWLRQ��6TXDUH�URRW

&RPPHQWV This operator gives the same values as the ([SRQHQWLDWLRQ operator except when z < 0 and n is 
an odd integer and  (by special convention).

5HFLSURFDO

.H\VWURNH / 1

6FDODU�&DVH

'HVFULSWLRQ Returns the reciprocal (multiplicative inverse) of z, where z is a real or complex number.

0DWUL[�&DVH

'HVFULSWLRQ If M is a real or complex square matrix, the reciprocal of M is the same as the inverse matrix 
 (assuming that M is nonsingular).

6HH�DOVR ([SRQHQWLDWLRQ

$OJRULWKP LU decomposition used for matrix inversion (Press et al., 1992)

X

x

Re z( )2 Im z( )2+

v v⋅
v v⋅

z

zn

n 1≥

n 3≥

1
z
---

M 1–
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([SRQHQWLDWLRQ

.H\VWURNH ^

6FDODU�&DVH

'HVFULSWLRQ Returns the principal value of z raised to the power w, where z and w are real or complex numbers. 

6HH�DOVR QWK�URRW

&RPPHQWV The principal value is given by the formula . In the special case z < 0 and 
w = 1/n, where n is an odd integer and , the principal value has a nonzero imaginary part. 
Hence, in this special case, ([SRQHQWLDWLRQ does not give the same value as the nWK�URRW operator 
(by convention).

0DWUL[�&DVH

'HVFULSWLRQ If M is a real or complex square matrix and is an integer, returns the nth power of 
M (using iterated matrix multiplication). Under the same conditions,  is the inverse of  
(assuming additionally that M is nonsingular).

$OJRULWKP LU decomposition used for matrix inversion (Press et al., 1992)

(TXDOV c =  

.H\VWURNH =

'HVFULSWLRQ Returns numerical value of c if c is: a variable previously defined in the worksheet; a built-in 
variable; a globally-defined variable; or a function of several such variables. Appears as an 
ordinary = on the screen. Not used for symbolic evaluation.

'HILQLWLRQ z : = c ,   f(x,y,z,...) : = expr  

.H\VWURNH :

'HVFULSWLRQ Gives z the numerical value c from that point onward throughout the worksheet. Gives a function 
f(x,y,z,...) the meaning prescribed by the expression expr from that point onward throughout the 
worksheet. expr need not involve x, y, z, ... but it usually does; it may involve other built-in or 
user-defined functions. 

6HH�DOVR 'HILQLWLRQ (under Evaluation Operators) for example.

0L[HG�QXPEHU  

.H\VWURNH [Ctrl][Shift]+

'HVFULSWLRQ If k, m and n are integers, returns the value of k + m/n.

&RPPHQWV To display a numerical result as a mixed number, double-click on the result to bring up the Result 
Format dialog box. Choose Fraction for the result format on the Number Format tab. Click the 
box next to "Use mixed numbers" so that it is checked.

zw

z w π i w⋅ ⋅( )exp⋅
n 3≥

n 0≥ Mn

M n– Mn

k
m
n
----
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0DWUL[�2SHUDWRUV
To access a matrix operator:

• type its keystroke, or 

• choose the operator from the Matrix toolbar:

Refer to “Accessing Operators” on page 447 for more information on how to acce
toolbar.

,QVHUW�PDWUL[

.H\VWURNH [Ctrl]M

'HVFULSWLRQ Creates a vector or matrix of specified dimensions. 

9HFWRU�DQG�PDWUL[�VXEVFULSW , 

.H\VWURNH [

'HVFULSWLRQ If v is a vector, vn returns the nth element of v. 
If M is a matrix, Mi, j returns the element in row i and column j of M.

5DQJH�YDULDEOH

.H\VWURNH ;

'HVFULSWLRQ Specifies that a variable assume a range of values (for the sake of repeated or iterative 
calculations).

'RW�SURGXFW�

.H\VWURNH *

'HVFULSWLRQ Returns the dot product (scalar or inner product) of two n-dimensional real or complex vectors 
u and v.

&URVV�SURGXFW�

.H\VWURNH [Ctrl]8

'HVFULSWLRQ Returns the cross product (vector product) of two 3-dimensional real or complex vectors u and v.

vn
Mi j,

u v⋅

u v×
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9HFWRU�VXP  

.H\VWURNH [Ctrl]4

'HVFULSWLRQ Returns the sum (a scalar) of all elements of a real or complex vector v. (No range variable or 
vector subscripts are needed.)

0DWUL[�,QYHUVH  

.H\VWURNH ^-1

'HVFULSWLRQ Returns the multiplicative inverse of a real or complex nonsingular square matrix M.

$OJRULWKP LU decomposition used for matrix inversion (Press et al., 1992)

0DJQLWXGH�DQG�'HWHUPLQDQW
   

.H\VWURNH |

'HVFULSWLRQ If z is a real or complex number, |z| returns the absolute value (or modulus or magnitude)
 of z.

If v is real or complex vector, returns the magnitude (or Euclidean norm or length)  of v. 
If all elements in v are real, this definition is equivalent to .

If M is a real or complex square matrix, returns the determinant of M.

$OJRULWKP LU decomposition (Press et al., 1992)

0DWUL[�VXSHUVFULSW   

.H\VWURNH [Ctrl]6

'HVFULSWLRQ Extracts column n (a vector) from matrix M.

0DWUL[�WUDQVSRVH�

.H\VWURNH [Ctrl]1

'HVFULSWLRQ If M is a vector or matrix, returns a matrix whose rows are the columns of M and whose columns 
are the rows of M.

9HFWRUL]H  

.H\VWURNH [Ctrl]-

'HVFULSWLRQ Forces operations in expression X to take place element by element. All vectors or matrices in X 
must be the same size.

Σv

x

Re z( )2 Im z( )2+

v v⋅
v v⋅

M n〈 〉

MT

X
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&RPPHQWV Mathcad’s�YHFWRUL]H operator allows parallel operations to be performed efficiently on eac
element of a vector or matrix. For example, to define a matrix P by multiplying corresponding 
elements of the matrices M and N, you could write  where i and j are range 
variables. (This is not matrix multiplication, but rather multiplication element by element.) 
faster, however, to define P using YHFWRUL]H:

• Select the whole expression by clicking 
inside and pressing [Space] until the 
right-hand side is held between the editing 
lines. 

• Press [Ctrl]– to apply the vectorize op-
erator. Mathcad puts an arrow over the top 
of the selected expression.

Extending ordinary scalar multiplication to matrices in this fashion, element by ele-
ment, is referred to as “vectorizing” an expression. 

Here are some properties of the YHFWRUL]H operator: 

• The vectorize operator changes the meaning of functions and operators but 
constants or variables.

• Operations between an array and a scalar are performed by applying the sca
each element of the array. For example, if v is a vector and n is a scalar, applying 

the vectorize operator to  returns a vector whose elements are the nth powers of 
the elements of v.

• You cannot use any of the following matrix operations under a vectorize opera
dot product, matrix multiplication, matrix powers, matrix inverse, determinant,
magnitude of a vector. The vectorize operator will transform these operations
element-by-element scalar multiplication, exponentiation, or absolute value, 
appropriate.

• The vectorize operator has no effect on operators and functions that require vectors 
or matrices: transpose, cross product, sum of vector elements, and functions�

PHDQ. These operators and functions have no scalar meaning.

3LFWXUH

.H\VWURNH [Ctrl]T

'HVFULSWLRQ Displays a matrix, M, or an image file, S, as a grayscale image, by default. Each element of M 
corresponds to a pixel. The value of an element determines the shade of gray associated with the 
corresponding pixel. Each element of M is an integer between 0 (black) and 255 (white). When 
the argument is a string that indicates the path to an image file, the picture is also displayed as a 
grayscale image. See “Inserting Pictures” on page 69 for more details.

Pi j, Mi j, Ni j,⋅=

vn
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&DOFXOXV�2SHUDWRUV
To access a calculus operator:

• type its keystroke, or 

• choose the operator from the Calculus toolbar:

Refer to “Accessing Operators” on page 447 for more information on how to acce
toolbar. 

6XPPDWLRQ  

.H\VWURNH [Ctrl][Shift]4 

'HVFULSWLRQ Performs iterated addition of X over . X can be any expression; it need not 
involve i but it usually does. m and n must be integers. If   or , the evaluation 
must be performed symbolically. 

([DPSOH

6HH�DOVR 5DQJH�VXP

&RPPHQWV To evaluate multiple summations, place another summation in the final placeholder of the first 
summation, as illustrated in the example.

X
i m=

n

∑

i m m 1 … n, ,+,=
m ∞–= n ∞=
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3URGXFW  

.H\VWURNH [Ctrl][Shift]3 

'HVFULSWLRQ Performs iterated multiplication of X over . X can be any expression; it need 
not involve i but it usually does. If  or , the evaluation must be performed 
symbolically. Works similar to 6XPPDWLRQ��

6HH�DOVR Range product. See Summation for an example.

5DQJH�VXP

.H\VWURNH $

'HVFULSWLRQ Performs iterated addition of X over the range variable i. X can be any expression; it need not 
involve i but it usually does. 

([DPSOH

6HH�DOVR 6XPPDWLRQ

&RPPHQWV When you use the 6XPPDWLRQ operator described earlier, the summation must be carried out 
over integers and in steps of one. Mathcad provides a more general version of this operator that 
can use any range variable you define as an index of summation. 

The 5DQJH�VXP operator, unlike the 6XPPDWLRQ operator, cannot stand alone. It requires 
the existence of a range variable. However, a single range variable can be used with 
any number of these operators. 

To evaluate multiple summations, place another summation in the final placeholder of 
the first summation and use two range variables, as illustrated in the example.

X
i m=

n

∏

i m m 1 … n, ,+,=
m ∞–= n ∞=

X
i

∑
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5DQJH�SURGXFW  

.H\VWURNH #

'HVFULSWLRQ Performs iterated multiplication of X over the range variable i. X can be any expression; it need 
not involve i but it usually does. Works similar to 5DQJH�VXP� 

6HH�DOVR 3URGXFW��See 5DQJH�VXP�for an example.

'HILQLWH�LQWHJUDO  

.H\VWURNH &

'HVFULSWLRQ Returns the definite integral of f(t) over the interval . a and b must be real scalars. All 
variables in the expression f(t), except the variable of integration t, must be defined. The 
integrand, f(t), cannot return an array. , , or both are permitted.  

([DPSOHV

Figure 18-1: Example 1.

Figure 18-2: Example 2.

X
i

∏

f t( ) td
a

b
∫

a b,[ ]

a ∞–= b ∞=
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&RPPHQWV There are some important things to remember about integration in Mathcad:

• The limits of integration must be real, but the expression to be integrated can
either real or complex.

• Except for the integrating variable, all variables in the integrand must have b
defined elsewhere in the worksheet.

• The integrating variable must be a single variable name. 

• If the integrating variable involves units, the upper and lower limits of integrat
must have the same units.

Like all numerical methods, Mathcad’s integration algorithm can have difficulty with ill-behaved 
integrands. If the expression to be integrated has singularities, discontinuities, or large and rapid 
fluctuations, Mathcad’s solution may be inaccurate. 

In some cases, you may be able to find an exact expression for your definite integral or even the 
indefinite integral (antiderivative) by using Mathcad’s symbolics.

Although the result of an integration is a single number, you can always use an integral w
range variable to obtain results for many numbers at once (as illustrated in Example 1). S
repeated evaluations may take considerable time depending on the complexity of the inte
the length of the interval, and the value of TOL.

Mathcad's numerical integration algorithm makes successive estimates of the value of the in
and returns a value when the two most recent estimates differ by less than the value of th
in variable TOL. Figure 18-2 above shows how changing TOL affects the accuracy of inte
calculations (not to be confused with the mere formatting issue of how many digits to disp

You can change the value of the tolerance by including definitions for TOL directly in you
worksheet as shown. You can also change the tolerance by using the Built-In Variables tab
you choose Options from the Math menu. To see the effect of changing the tolerance, choo
Calculate Document from the Math menu to recalculate all the equations in the worksheet

If Mathcad's approximations to an integral fail to converge to an answer, Mathcad marks 
integral with an appropriate error message.

When you change the tolerance, keep in mind the trade-off between accuracy and compu
time. If you decrease (tighten) the tolerance, Mathcad will compute integrals more accura
However, because this requires more work, Mathcad will take longer to return a result. 
Conversely, if you increase (loosen) the tolerance, Mathcad will compute more quickly, bu
answers will be less accurate.

You can also use Mathcad to evaluate double or multiple integrals. To set up a double int
press the ampersand key, [&], twice. Fill in the integrand, the limits, and the integrating variab
for each integral. Keep in mind that double integrals take much longer to converge to an a
than single integrals. Wherever possible, use an equivalent single integral in place of a d
integral.
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Because certain numerical integration methods work best on certain kinds of integrals, Mathcad 
has an AutoSelect feature for integration. Depending on the kind of integral you are evaluating, 
Mathcad automatically chooses the most appropriate integration method to use. Using 
AutoSelect, Mathcad examines the integral and evaluates it using one of the following methods:

• Romberg (Romberg trapezoidal approximation with Richard extrapolation − equal intervals)

• Adaptive (if the values of f(x) vary significantly over the interval − unequal intervals) 

• Infinite Limit (if ,  or both) 

• Singular Endpoint (if f(a) and/or f(b) is undefined)

If you want to evaluate an integral using a method other than the one chosen during the 
AutoSelect process, turn off AutoSelect and choose another method. To do so:

1. Type the integral and allow AutoSelect to return a result.

2. Right-click on the integral.

3. Click on the method you want to use.

The integral is automatically re-evaluated using the method you clicked and is re-evaluate
way from then on, unless you specify another method or AutoSelect later.

$OJRULWKP Romberg, Kahan transform, QAGS, Clenshaw-Curtis, Gauss-Kronrod formulas (Piessens
Lorczak)

,QGHILQLWH�LQWHJUDO

.H\VWURNH [Ctrl]i

'HVFULSWLRQ Returns the indefinite integral (that is, an antiderivative) of f(t). Must be performed symbolically. 
The integrand, f(t), cannot return an array.

'HULYDWLYH  

.H\VWURNH ?

'HVFULSWLRQ Returns the derivative of f(t) evaluated at t. All variables in the expression f(t) must be defined. 
The variable t must be a scalar value. The function f(t) must return a scalar.

a ∞–= b ∞=

f t( ) td∫

td
d f t( )
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&RPPHQWV With Mathcad’s derivative algorithm, you can expect the first derivative to be accurate to within 
7 or 8 significant digits, provided that the value at which you evaluate the derivative is not too 
close to a singularity of the function. The accuracy of this algorithm tends to decrease by one 
significant digit for each increase in the order of the derivative (see QWK�GHULYDWLYH�operator).

The result of differentiating is not a function, but a single number: the computed derivative at 

the indicated value of the differentiation variable. In the previous example, the derivative of  

is not the expression  but  evaluated at . If you want the expression , you 
will need to use either live or menu symbolics. 

Although differentiation returns just one number, you can still define one function as the 
derivative of another. For example: . Evaluating f(x) will return the numerically 
computed derivative of g(x) at x. You can use this technique to evaluate the derivative of a 
function at many points via range variables.

To change the appearance of the derivative symbol to a partial derivative symbol, choose Options 
from the Math menu, click the Display tab and use drop-down options to make the selection.

$OJRULWKP Modified Ridder’s method (Press et al., 1992; Lorczak)

QWK�GHULYDWLYH

.H\VWURNH [Ctrl]?

'HVFULSWLRQ Returns the nth derivative of f(t) evaluated at t. All variables in f(t) must be defined. The variable
t must be a scalar value. The function f(t) must return a scalar. n must be an integer between 0 
and 5 for numerical evaluation or a positive integer for symbolic evaluation.

&RPPHQWV For , this operator gives the same answer as the Derivative operator. For , it si
returns the value of the function itself.

To change the appearance of the nth derivative symbol to an nth partial derivative symbol, choose
Options from the Math menu, click the Display tab and use drop-down options to make th
selection.

$OJRULWKP Modified Ridder’s method (Press et al., 1992; Lorczak)

x3

3x2 3x2 x 2= 3x2

f x( )
xd

d g x( ):=

tn

n

d

d f t( )

n 1= n 0=
Calculus Operators 461



ss a 
/LPLW  

.H\VWURNH [Ctrl]L

'HVFULSWLRQ Returns the two-sided limit of f(t). Must be evaluated symbolically.

$OJRULWKP Series expansion (Geddes and Gonnet, 1989)

5LJKW�+DQG�/LPLW

.H\VWURNH [Ctrl][Shift]A

'HVFULSWLRQ Returns the right-hand limit of f(t). Must be evaluated symbolically.

$OJRULWKP Series expansion (Geddes and Gonnet, 1989)

/HIW�+DQG�/LPLW  

.H\VWURNH [Ctrl][Shift]B

'HVFULSWLRQ Returns the left-hand limit of f(t). Must be evaluated symbolically.

$OJRULWKP Series expansion (Geddes and Gonnet, 1989)

(YDOXDWLRQ�2SHUDWRUV
To access an Evaluation operator:

• type its keystroke, or 

• choose the operator from the Evaluation toolbar:

Refer to “Accessing Operators” on page 447 for more information on how to acce
toolbar. 

f t( )
t a→
lim

f t( )
t a+→

lim

f t( )
t a-→

lim
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(TXDOV c =  

.H\VWURNH =

'HVFULSWLRQ Returns numerical value of c if c is: a variable previously defined in the worksheet; a built-in 
variable; a globally-defined variable; or a function of several such variables. Appears as an 
ordinary = on the screen. Not used for symbolic evaluation.

'HILQLWLRQ z : = c ,   f(x,y,z,...) : = expr  

.H\VWURNH :

'HVFULSWLRQ Gives z the numerical value c from that point onward throughout the worksheet. Gives a function 
f(x,y,z,...) the meaning prescribed by the expression expr  from that point onward throughout the 
worksheet. expr need not involve x, y, z, ... but it usually does; it may involve other built-in or 
user-defined functions. 

([DPSOHV

Figure 18-3: Example 1.

Figure 18-4: Example 2.
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&RPPHQWV You can define arrays in the same way as scalars, with the array name A on the left side of a :=, 
and a corresponding array of values to the right.

You can likewise use arrays to define several variables at once, as the previous example shows. 
The left side of a simultaneous definition is an array whose elements are either names or 
subscripted variable names. The right side must be an array of values having the same number 
of rows and columns as the left side. Mathcad defines each variable on the left side with the value 
of the array in the corresponding position on the right side. Elements on the right side are all 
evaluated before assigning any of them to the left side. Because of this, nothing on the right side 
of an expression can depend on what is on the left side. You also cannot have a variable appear 
more than once on the left side.

When you define a function, Mathcad does not try to evaluate it until you use it later on in the 
worksheet. If there is an error, the use of the function is marked in error, even though the real 
problem may be in the definition of the function itself. For example, if f(x) := 1/x and you attempt 
to evaluate f(0), the error flag occurs not at the definition of f(x) but when Mathcad encounters 
f(0) for the first time. 

*OREDO�'HILQLWLRQ ,  

.H\VWURNH ~

'HVFULSWLRQ Gives z the numerical value c and this holds throughout the worksheet (regardless of where the 
global definition is positioned). Likewise, gives a function f(x,y,z,...) the meaning prescribed by 
the expression expr throughout the worksheet. expr need not involve x, y, z, ... but it usually does; 
it may involve other built-in or user-defined functions. 

&RPPHQWV You can globally define arrays in the same way as scalars, with the array name A on the left side 
of a  ≡, and a corresponding array of values to the right.

This is the algorithm that Mathcad uses to evaluate all definitions, global and otherwise: 

• First, Mathcad takes one pass through the entire worksheet from top to botto
During this first pass, Mathcad evaluates global definitions only.

• Mathcad then makes a second pass through the worksheet from top to bottom
time, Mathcad evaluates all definitions made with := as well as all equations 
containing ≡.

Although global definitions are evaluated before any local definitions, Mathcad e
uates global definitions the same way it evaluates local definitions: top to bottom
left to right. This means that whenever you use a variable to the right of a ≡:

• that variable must also have been defined with a ≡, and

• the variable must have been defined above the place where you are trying to use i

Otherwise, the variable is marked in red to indicate that it is undefined.

It is good practice to allow only one definition for each global variable. Although you can define 
a variable with two different global definitions or with one global and one local definition, this 
is never necessary and usually makes your worksheet difficult to understand.

z c≡ f x y z …, , ,( ) expr≡
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6\PEROLF�(TXDOV

.H\VWURNH [Ctrl].

'HVFULSWLRQ Returns live symbolic “value” of c if c is a variable previously defined in the worksheet, is a 
built-in variable, is a globally-defined variable, or is a function of several such variables. 

&RPPHQWV The live symbolic equals sign is analogous to the numerical equals sign “=”. You can use
symbolically simplify or factor algebraic expressions, or to symbolically evaluate derivativ
integrals and limits. Note that “→” applies only to an entire expression (unlike menu symbolic

3UHIL[ f  x

.H\VWURNH NONE

'HVFULSWLRQ Using the prefix custom operator, f x returns the value f(x), where f is either a built-in or user-
defined function and x is a real or complex number. 

([DPSOHV

Figure 18-5: Example 1: Defining your own operators.

Figure 18-6: Example 2: Displaying an operator as a function and a function 
as an operator.

&RPPHQWV In Figure 18-5, the symbol “ ° ” comes from the Symbol font. First define a function “°(x)” as 
illustrated, then click the Postfix button on the Evaluation toolbar to use postfix notation. F
postfix notation, type the name of the operator in the right placeholder and the operand in t
placeholder.

Many publishers prefer to omit parentheses around the arguments to certain functions (sin x rather 
than ). You can do the same thing by treating the sin function as an operator with one 
operand, as in Figure 18-6. 

c →

x( )sin
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3RVWIL[ x  f
Keystroke

NONE

'HVFULSWLRQ Using the postfix custom operator, x f returns the value f(x), where f is either a built-in or user-
defined function and x is a real or complex number. 

&RPPHQWV In Figure 18-5, on page 465, the symbol “°” comes from the Symbol font. First define a function
“°(x)” as illustrated, then click the postfix button on the Evaluation toolbar to use postfix nota
For postfix notation, type the name of the operator in the right placeholder and the operan
the left placeholder.

,QIL[ x f  y
Keystroke

NONE

'HVFULSWLRQ Using the infix custom operator, x f y returns the value f(x,y), where f is either a built-in or user-
defined function and x, y are real or complex numbers. 

&RPPHQWV In Figure 18-5, on page 465, the symbol “≈” comes from the Symbol font. First define a binary
function “≈(x,y)” as illustrated, then click the infix button on the Evaluation toolbar to use in
notation. For infix notation, type the name of the operator in the middle placeholder and t
operands in the left and right placeholders.

Likewise, in Figure 18-6, on page 465, the binary function “÷(x,y)” is defined and then displayed
in the more conventional manner:  “x÷y”. Functions and operators are fundamentally the sam
Although notation like  “÷(x,y)” is unconventional, use it if you prefer.

7UHHIL[ x  f  y

.H\VWURNH NONE

'HVFULSWLRQ Using the treefix custom operator, x  f y returns the value f(x,y), where f is either a built-in or user-
defined function and x and y are real or complex numbers. 

&RPPHQWV In Figure 18-5, on page 465, the symbol “÷” comes from the Symbol font. First define a binary
function “÷(x,y)” as illustrated, then click the treefix button on the Evaluation toolbar to use
treefix notation. For treefix notation, type the name of the operator in the middle placeholde
the operands in the left and right placeholders.
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%RROHDQ�2SHUDWRUV
To access a Boolean operator:

• type its keystroke, or 

• choose the operator from the Boolean toolbar:

Refer to “Accessing Operators” on page 447 for more information on how to acce
toolbar. 

*UHDWHU�WKDQ ,   

.H\VWURNH > 

'HVFULSWLRQ For real scalars x and y, returns 1 if , 0 otherwise. 
For string expressions S1 and S2, returns 1 if S1 strictly follows S2 in ASCII order, 0 otherwise.

/HVV�WKDQ , 

.H\VWURNH <

'HVFULSWLRQ For real scalars x and y, returns 1 if , 0 otherwise. 
For string expressions S1 and S2, returns 1 if S1 strictly precedes S2 in ASCII order, 0 otherwise.

*UHDWHU�WKDQ�RU�HTXDO�WR  ,  

.H\VWURNH [Ctrl])

'HVFULSWLRQ For real scalars x and y, returns 1 if , 0 otherwise. 
For string expressions S1 and S2, returns 1 if S1 follows S2 in ASCII order, 0 otherwise.

/HVV�WKDQ�RU�HTXDO�WR  ,  

.H\VWURNH [Ctrl](

'HVFULSWLRQ For real scalars x and y, returns 1 if , 0 otherwise. 
For string expressions S1 and S2, returns 1 if S1 precedes S2 in ASCII order, 0 otherwise.

1RW�HTXDO�WR ,  

.H\VWURNH [Ctrl]3

'HVFULSWLRQ For scalars z and w, returns 1 if , 0 otherwise.
For string expressions S1 and S2, returns 1 if S1 is not character by character identical to S2, 0 
otherwise.

x y> S1 S2>

x y>

x y< S1 S2<

x y<

x y≥ S1 S2≥

x y≥

x y≤ S1 S2≤

x y≤

z w≠ S1 S2≠

z w≠
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%ROG�(TXDOV z = w  

.H\VWURNH [Ctrl]=

'HVFULSWLRQ Returns 1 if , 0 otherwise (also known as Boolean equals). Appears as a bold = on the 
screen. Also used when typing constraint equations within solve blocks or when typing equations 
to be solved symbolically.

DQG x ∧ y
.H\VWURNH [Ctrl][Shift]7

'HVFULSWLRQ x ∧ y returns the value 1 if both x and y are nonzero, and 0 if at least one of x or y is zero.

&RPPHQWV The value 0 is regarded as FALSE; any nonzero value (including 1) is regarded as TRUE. The 
Boolean DQG operator evaluates the right argument if and only if the left argument is TRUE. 
x ∧ y is also known as the logical conjunction of x and y.

RU x ∨ y
.H\VWURNH [Ctrl][Shift]6

'HVFULSWLRQ x ∨ y returns the value 1 if at least one of x or y is nonzero, and 0 if both x and y are zero.

&RPPHQWV The value 0 is regarded as FALSE; any nonzero value (including 1) is regarded as TRUE. The 
Boolean RU operator evaluates the right argument if and only if the left argument is FALSE. 
x ∨ y is also known as the logical (inclusive) disjunction of x and y.

[RU x ⊕ y
.H\VWURNH [Ctrl][Shift]1

'HVFULSWLRQ x ⊕ y returns the value 1 if precisely one of x or y is nonzero, and 0 if both x and y are zero or 
both are nonzero.

&RPPHQWV The value 0 is regarded as FALSE; any nonzero value (including 1) is regarded as TRUE. 
x ⊕ y is the same as (x ∨ y) ∧ ¬  (x ∧ y) and is also known as the logical exclusive disjunction 
of x and y.

QRW ¬ x
.H\VWURNH [Ctrl][Shift]5

'HVFULSWLRQ ¬ x returns the value 0 if x is nonzero and 0 if x is zero.

&RPPHQWV The value 0 is regarded as FALSE; any nonzero value (including 1) is regarded as TRUE. 
¬ x is also known as the logical negation of x.

z w=
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3URJUDPPLQJ�2SHUDWRUV�
To access a Programming operator:

• type its keystroke, or 

• choose the operator from the Programming toolbar:

Refer to “Accessing Operators” on page 447 for more information on how to acce
toolbar. 

Special Note: these operators are valid only within a Mathcad programming structu

/RFDO�'HILQLWLRQ  �

.H\VWURNH {

'HVFULSWLRQ Gives w the numerical value of the function f(a,b,c,...) within a program. 
Outside the program, w remains undefined. 

$GG�/LQH �

.H\VWURNH ]

'HVFULSWLRQ Inserts a line in a program. When you insert the $GG�/LQH operator the first time, a program is 
created (a vertical bar with two placeholders). If you select either of these placeholders and insert 
the $GG�/LQH operator again, more placeholders are created. 

&RQGLWLRQDO�6WDWHPHQW  

.H\VWURNH }

'HVFULSWLRQ Within a program, permits evaluation of a statement only when a specified condition is met. You 
must insert this operator using its toolbar button or equivalent keystroke. (Conditional�LI�is not 
the same as the built-in LI�function (do not just type the word “if”).

w f a b c …, , ,( )←
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2WKHUZLVH�6WDWHPHQW � 

.H\VWURNH [Ctrl][Shift]}

'HVFULSWLRQ Within a program, used in conjunction with the LI statement to exhaust possibilities not yet 
covered. You must insert this operator using its toolbar button or equivalent keystroke. (Do not 
just type the word “otherwise”.) 

)RU�/RRS  

.H\VWURNH [Ctrl][Shift]”

'HVFULSWLRQ Within a program, permits evaluation of a sequence of statements a specified number of times. 
The right hand placeholder usually contains a range variable. You must insert this operator using 
its toolbar button or equivalent keystroke. (Do not just type the word “for”.) 

:KLOH�/RRS  

.H\VWURNH [Ctrl]]

'HVFULSWLRQ Within a program, permits evaluation of a sequence of statements until a specified condit
met. The right hand placeholder usually contains a Boolean expression. You must insert 
operator using its toolbar button or equivalent keystroke. (Do not just type the word “while

%UHDN�6WDWHPHQW

.H\VWURNH [Ctrl][Shift]{

'HVFULSWLRQ Within a IRU�or�ZKLOH�loop, halts loop execution. Usually used in conjunction with an LI statement, 
that is, halting occurs if a specified condition occurs. Execution moves to the next statem
outside the loop. You must insert this operator using its toolbar button or equivalent keyst
(Do not just type the word “break”.) 

6HH�DOVR FRQWLQXH and UHWXUQ

&RQWLQXH�6WDWHPHQW

.H\VWURNH [Ctrl][

'HVFULSWLRQ Within a IRU�or ZKLOH�loop, halts loop execution, skips remaining steps, and continues at th
beginning of the next iteration of the next loop. Usually used in conjunction with an LI statement, 
that is, halting occurs if a specified condition occurs. You must insert this operator using i
toolbar button or equivalent keystroke. (Do not just type the word “continue”.) 

6HH�DOVR EUHDN and UHWXUQ
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5HWXUQ�6WDWHPHQW

.H\VWURNH [Ctrl][Shift]|

'HVFULSWLRQ Within a program, halts program execution. Usually used in conjunction with an if statement, 
that is, halting occurs if a specified condition occurs. Also, within a IRU�or�ZKLOH�loop, halts loop 
execution. You must insert this operator using its toolbar button or equivalent keystroke. (Do not 
just type the word "return".) 

6HH�DOVR EUHDN and FRQWLQXH

 

2Q�(UURU�6WDWHPHQW �

.H\VWURNH [Ctrl]’

'HVFULSWLRQ Within a program, permits computation of an alternative expression when an arbitrary numerical 
error flag is raised. You must insert this operator using its toolbar button or equivalent keystroke. 
(Do not just type the phrase "on error".) 

&RPPHQWV RQ�HUURU executes the right-hand argument first. If no error occurs, it returns the result of the 
right argument. If an error occurs, then the error is cleared and the left argument is returned�

RQ�HUURU is a general purpose error trap. It is more powerful than using the�UHWXUQ statement, 
coupled with some specific test, to deal with inputs that give rise to numerical error.
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&KDSWHU���
6\PEROLF�.H\ZRUGV

This chapter lists and describes Mathcad’s symbolic keywords. The keywords are 
alphabetically.

$FFHVVLQJ�6\PEROLF�.H\ZRUGV
You can access symbolic keywords in two ways: 

• Simply type in the keyword as shown for that keyword, or

• Select the keyword from the Symbolic toolbar. 

1. First, click the Symbolic Toobar button on the math menu:

The Symbolic toolbar appears. 

2. Click the button of the keyword that you want to use. 
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The Modifiers keyword button corresponds to symbolic modifiers. 

The modifier assume is discussed on page 475. The other three modifiers, real, RealRange 
and trig, are used in some cases with the simplify keyword; refer to simplify on page 481 
to find out how to use these modifiers.

Most of the keywords have equivalent menu choices on the Symbolics menu.

However, these menu choices are not “live,” which means they do not use any pre
definitions in your worksheet and do not automatically update when you revise y
worksheet. 

)LQGLQJ�0RUH�,QIRUPDWLRQ
Refer to the Resource Center QuickSheets for examples involving keywords. Se
Resource Center from the Help menu. Then click on the QuickSheets icon and sele
a specific topic. 
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.H\ZRUGV

DVVXPH
6\QWD[ DVVXPH, constraint 

'HVFULSWLRQ Imposes constraints on one or more variables according to the expression constraint. A typical 
constraint might be that var < 10. 

DVVXPH can also constrain a variable to be real or to fall within a certain range of real values. 

Use the following modifiers:

var=UHDO�evaluates the expression on the assumption that the variable var is real;

var=5HDO5DQJH�a,b� evaluates on the assumption that var is real and lies between
a and b, where a and b are real numbers or infinity (type [Ctrl][Shift]z to display ∞). 

([DPSOH

FRHIIV
6\QWD[ FRHIIV, var 

'HVFULSWLRQ Finds coefficients of a polynomial when it is written in terms of ascending powers of the variable 
or subexpression var. Mathcad returns a vector containing the coefficients. The first element of 
the vector is the constant term and the last element is the coefficient of the highest order term in 
the polynomial. 

6HH�DOVR FRQYHUW��SDUIUDF�for example

&RPPHQWV Another way to find the coefficients of a polynomial is to enclose the variable or subexpression 
var between the two editing lines and choose Polynomial Coefficients from the Symbolics 
menu.

FROOHFW
6\QWD[ FROOHFW��var1, var2, ... , varn 

'HVFULSWLRQ Collects terms containing like powers of the variables or subexpressions var1 through varn. 

6HH�DOVR H[SDQG�for example

&RPPHQWV Another way to collect terms is to enclose the expression between the editing lines and choose 
Collect from the Symbolics menu
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FRPSOH[
6\QWD[ FRPSOH[

'HVFULSWLRQ Carries out symbolic evaluation in the complex domain. Result is usually of the form . 

6HH�DOVR DVVXPH�for example

&RPPHQWV Another way to evaluate an expression in the complex domain is to enclose the expression 
between the editing lines and choose Evaluate⇒Complex from the Symbolics menu.

FRQYHUW��SDUIUDF
6\QWD[ FRQYHUW, SDUIUDF, var

'HVFULSWLRQ Converts an expression to a partial fraction expansion in the variable var. 

([DPSOH

&RPPHQWV The symbolic processor tries to factor the denominator of the expression into linear or quadratic 
factors having integer coefficients. If it succeeds, it expands the expression into a sum of fractions 
with these factors as denominators. All constants in the selected expression must be integers or 
fractions; Mathcad does not expand an expression that contains decimal points.

Another way to convert an expression to a partial fraction is to click on the variable var anywhere 
in the expression. Then choose Variable⇒Convert to Partial Fraction from the Symbolics 
menu. 

H[SDQG
6\QWD[ H[SDQG, expr

'HVFULSWLRQ Expands all powers and products of sums in an expression except for the subexpression expr. 
The argument expr is optional. The entire expression is expanded if the argument expr is omitted. 

a i b⋅+
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([DPSOH

&RPPHQWV Another way to expand an expression is to enclose the expression between the editing lines and 
choose Expand from the Symbolics menu.

IDFWRU
6\QWD[ IDFWRU, expr

'HVFULSWLRQ Factors an expression into a product, if the entire expression can be written as a product. 
If the expression is a single integer, Mathcad factors it into powers of primes. 
If the expression is a polynomial or rational function, Mathcad factors it into powers of lower-
order polynomials or rational functions. The argument expr is optional. 

6HH�DOVR H[SDQG�for example

&RPPHQWV If you want to factor an expression over certain radicals, follow the�IDFWRU keyword with a comma 
and the radicals. 

You may be able to simplify an expression by factoring subexpressions, even if the expression 
taken as a whole can’t be factored. To do so, enclose a subexpression between the editing lines 
and choose Factor from the Symbolics menu. You can also use the Factor menu command to 
factor an entire expression, but the Symbolics menu commands do not use any previous 
definitions in your worksheet and do not automatically update.

IORDW
6\QWD[ IORDW, m

'HVFULSWLRQ Displays a floating point value with m places of precision whenever possible. If the argument m, 
an integer, is omitted, the default precision is 20. 

6HH�DOVR DVVXPH�for example

&RPPHQWV Another way to perform floating point evaluation on an expression is to enclose the expression 
between the editing lines and choose Evaluate⇒Floating Point from the Symbolics menu. 
In the Floating Point dialog box, specify the number of digits to the right of the decimal point.
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IRXULHU
6\QWD[ IRXULHU, var

'HVFULSWLRQ Evaluates the Fourier transform of an expression with respect to the variable var. 

([DPSOH

&RPPHQWV Mathcad returns a function of ω given by:  where f(t) is the expression to be 
transformed. 

Mathcad returns a function in the variable ω when you perform a Fourier transform because this 
is a commonly used variable name in this context. If the expression you are transforming already 
contains an ω, Mathcad avoids ambiguity by returning a function of the variable ωω instead. 

Another way to evaluate the Fourier transform of an expression is to enter the expression and 
click on the transform variable. Then choose Transform⇒Fourier from the Symbolics menu.

LQYIRXULHU
6\QWD[ LQYIRXULHU, var

'HVFULSWLRQ Evaluates the inverse Fourier transform of an expression with respect to the variable var. 

6HH�DOVR IRXULHU for example

&RPPHQWV Mathcad returns a function of t given by:  where F(ω) is the expression 
to be transformed. 

Mathcad returns a function in the variable t when you perform an inverse Fourier transform 
because this is a commonly used variable name in this context. If the expression you are 
transforming already contains a t, Mathcad avoids ambiguity by returning a function of the 
variable tt instead.

Another way to evaluate the inverse Fourier transform of an expression is to enter the expression 
and click on the transform variable. Then choose Transform⇒Inverse Fourier from the 
Symbolics menu.

f t( )e i– ω t td
∞–

 ∞+

∫

1
2π
------ F ω( )eiω t ωd

∞–

 ∞+

∫
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LQYODSODFH
6\QWD[ LQYODSODFH, var

'HVFULSWLRQ Evaluates the inverse Laplace transform of an expression with respect to the variable var. 

6HH�DOVR fourier for example

&RPPHQWV Mathcad returns a function of t given by:  where F(s) is the expression to 

be transformed and all singularities of F(s) are to the left of the line .

Mathcad returns a function in the variable t when you perform an inverse Laplace transform 
because this is a commonly used variable name in this context. If the expression you are 
transforming already contains a t, Mathcad avoids ambiguity by returning a function of the 
variable tt instead. 

Another way to evaluate the inverse Laplace transform of an expression is to enter the expression 
and click on the transform variable. Then choose Transform⇒Inverse Laplace from the 
Symbolics menu.

LQY]WUDQV
6\QWD[ LQY]WUDQV, var

'HVFULSWLRQ Evaluates the inverse z-transform of an expression with respect to the variable var. 

6HH�DOVR fourier for example

&RPPHQWV Mathcad returns a function of n given by a contour integral around the origin:  

where F(z) is the expression to be transformed and C is a contour enclosing all singularities of 
the integrand. 

Mathcad returns a function in the variable n when you perform an inverse z-transform since this 
is a commonly used variable name in this context. If the expression you are transforming already 
contains an n, Mathcad avoids ambiguity by returning a function of the variable nn instead. 

Another way to evaluate the inverse z-transform of an expression is to enter the expression and 
click on the transform variable. Then choose Transform⇒Inverse Z from the Symbolics menu.

ODSODFH
6\QWD[ ODSODFH, var

'HVFULSWLRQ Evaluates the Laplace transform of an expression with respect to the variable var.

6HH�DOVR fourier for example

&RPPHQWV Mathcad returns a function of s given by: , where f(t) is the expression to be 
transformed. 

Mathcad returns a function in the variable s when you perform a Laplace transform since this is 
a commonly used variable name in this context. If the expression you are transforming already 
contains an s, Mathcad avoids ambiguity by returning a function of the variable ss instead. 

Another way to evaluate the Laplace transform of an expression is to enter the expression and 
click on the transform variable. Then choose Transform⇒Laplace from the Symbolics menu.

1
2πi
-------- F s( )est td

σ i∞–

σ i∞+

∫
Re s( ) σ=

1
2πi
-------- F z( )zn 1– zd

C

 ∫

f t( )e st– td
0

 ∞+

∫
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VHULHV
6\QWD[ VHULHV, var=z, m

'HVFULSWLRQ Expands an expression in one or more variables, var, around the point z. The order of expansion 
is m. Arguments z and m are optional. By default, the expansion is taken around zero and is a 
polynomial of order six. 

([DPSOH

&RPPHQWV Mathcad finds Taylor series (series in nonnegative powers of the variable) for functions that are 
analytic at 0, and Laurent series for functions that have a pole of finite order at 0. To develop a 
series with a center other than 0, the argument to the�VHULHV keyword should be of the form var=z, 
where z is any real or complex number. For example, VHULHV, x=1 expands around the point x=1. 
Press [Ctrl] = for the equal sign.

To expand a series around more than one variable, separate the variables by commas. The last 
line in the example above shows an expression expanded around x and y. 

Another way to generate a series expansion is to enter the expression and click on a variable for 
which you want to find a series expansion. Then choose Variable⇒Expand to Series from the 
Symbolics menu. A dialog box will prompt you for the order of the series. This command is 
limited to a series in a single variable; any other variables in the expression will be treated as 
constants. The results also contain the error term using the O notation. Before you use the series 
for further calculations, you will need to delete this error term. 

When using the approximations you get from the symbolic processor, keep in mind that the Taylor 
series for a function may converge only in some small interval around the center. Furthermore, 
functions like�VLQ or�H[S have series with infinitely many terms, while the polynomials returned 
by Mathcad have only a few terms (how many depends on the order you select). Thus, when you 
approximate a function by the polynomial returned by Mathcad, the approximation will be 
reasonably accurate close to the center, but may be quite inaccurate for values far from the center.
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VLPSOLI\
6\QWD[ VLPSOLI\

'HVFULSWLRQ Simplifies an expression by performing arithmetic, canceling common factors, and using basic 
trigonometric and inverse function identities. 
To control the simplification, use the following modifiers:

DVVXPH=UHDO simplifies on the assumption that all the indeterminates in the expression are real;

DVVXPH=5HDO5DQJH�a,b��simplifies on the assumption that all the indeterminates are real and 
are between a and b, where a and b are real numbers or infinity ([Ctrl]Z);

WULJ, simplifies a trigonometric expression by applying only the following identities:

 ,
but does not simplify the expression by simplifying logarithms, powers, or radicals. 

([DPSOH

&RPPHQWV You can also simplify an expression by placing it between the two editing lines and choosing 
Simplify from the Symbolics menu. This method is useful when you want to simplify parts of 
an expression. Mathcad may sometimes be able to simplify parts of an expression even when it 
cannot simplify the entire expression. If simplifying the entire expression doesn’t give the answer 
you want, try selecting subexpressions and choosing Simplify from the Symbolics menu. If 
Mathcad can’t simplify an expression any further, you’ll just get the original expression back as 
the answer. 

In general, when you simplify an expression, the simplified result will have the same numerical 
behavior as the original expression. However, when the expression includes functions with more 
than one branch, such as square root or the inverse trigonometric functions, the symbolic answer 
may differ from a numerical answer. For example, simplifying  yields θ, but this 
equation holds true numerically in Mathcad only when θ is a number between −π/2 and π/2. 

x( )sin
2

x( )cos
2

+ 1= x( )cosh
2

x( )sinh
2

– 1=

θ( )sin( )asin
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VROYH
6\QWD[ VROYH, var

'HVFULSWLRQ Solves an equation for the variable var or solves a system of equations for the variables in a 
vector var. 

([DPSOHV

Figure 19-1: Solving equations, solving inequalities, and finding roots.

Figure 19-2: Solving a system of equations symbolically.
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&RPPHQWV Solving equations symbolically is far more difficult than solving them numerically. The symbolic 
solver sometimes does not give a solution. Many problems can only be solved via numerical 
approach and many more yield symbolic solutions too lengthy to be useful.

Another way to solve for a variable is to enter the equation, click on the variable you 
want to solve for in an equation, and choose Variable⇒Solve from the Symbolics 
menu.

You can use either the symbolic VROYH�keyword or a solve block, as illustrated above, 
to solve a system of equations symbolically. No initial guess values are necessary for 
symbolic schemes. 

VXEVWLWXWH
6\QWD[ VXEVWLWXWH, var1= var2

'HVFULSWLRQ Replaces all occurrences of a variable var1 with an expression or variable var2.
Press [Ctrl] = for the equal sign. 

([DPSOH

&RPPHQWV Mathcad does not substitute a variable for an entire vector or a matrix. You can, however, 
substitute a scalar expression for a variable that occurs in a matrix. 
To do so, follow these steps:

1. Select the expression that will replace the variable and choose Copy from the Edit menu.

2. Click on an occurrence of the variable you want to replace and choose Variable⇒Substitute 
from the Symbolics menu. You can also use this menu command to perform a substitution 
in any expression.
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]WUDQV
6\QWD[ ]WUDQV, var

'HVFULSWLRQ Evaluates the z-transform of an expression with respect to the variable var. 

6HH�DOVR fourier�for example

&RPPHQWV Mathcad returns a function of z given by: , where f(n) is the expression to be 
transformed. 

Mathcad returns a function in the variable z when you perform a z-transform since this 
is a commonly used variable name in this context. If the expression you are transforming 
already contains a z, Mathcad avoids ambiguity by returning a function of the variable 
zz instead. 

Another way to evaluate the z-transform of an expression is to enter the expression and 
click on the transform variable. Then choose Transform⇒Z from the Symbolics 
menu.

f n( )z n–

n 0=

 ∞+

∑
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$SSHQGLFHV

t 6SHFLDO�)XQFWLRQV

t 6,�8QLWV

t &*6�XQLWV

t 8�6��&XVWRPDU\�8QLWV

t 0.6�8QLWV

t 3UHGHILQHG�9DULDEOHV

t 6XIIL[HV�IRU�1XPEHUV

t *UHHN�/HWWHUV

t $UURZ�DQG�0RYHPHQW�.H\V

t )XQFWLRQ�.H\V

t $6&,,�FRGHV

t 5HIHUHQFHV
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6SHFLDO�)XQFWLRQV

Mathcad sometimes returns a symbolic expression in terms of a function that isn’t one of Mathcad’s built-
in functions. 

You can define many of these functions in Mathcad. See the “Other Special Functions” topic in the
QuickSheets of the Resource Center for examples.

The list below gives definitions for these functions. Except for (L, HUI, and =HWD, all of which involve 
infinite sums, and also :, you can use such definitions to calculate numerical values in Mathcad.

)XQFWLRQ�'HILQLWLRQV
Name Definition

Euler’s constant

Hyperbolic cosine integral

Cosine integral

Dilogarithm function

Dirac delta (unit impulse) function  if x is not zero. 

 

Exponential integral  (x > 0)

Complex error function  (for complex z)

Fresnel cosine integral

Fresnel sine integral

Incomplete elliptic integral of 
the second kind

Complete elliptic integral 
of the second kind

Associated complete elliptic integral
of the second kind

γ 1
k
---

k 1=

n

∑ n( )ln–
 
 
 
 

n ∞→
lim 0.57721566…= =

Chi x( ) γ x( )ln
t( )cosh 1–
t

--------------------------- td
0

x

∫+ +=

Ci x( ) γ x( )ln
t( )cos 1–
t

------------------------ td
0

x

∫+ +=

di x( )log
t( )ln

1 t–
------------ td

1

x

∫=

Dirac x( ) 0=

Dirac x( ) xd
∞–

∞

∫ 1=

Ei x( ) γ x( )ln xn

n n!⋅
------------

n 1=

∞

∑+ +=

erf z( ) 2

π
------- 1–( )nz2n 1+

n! 2n 1+( )
-----------------------------

n 0=

∞

∑=

FresnelC x( ) π
2
---t2

 
 cos td

0

x

∫=

FresnelS x( ) π
2
---t2

 
 sin td

0

x

∫=

LegendreE x k,( ) 1 k2 t2⋅–
1 t2–

----------------------- 
  1 2/

td
0

x

∫=

LegendreEc k( ) LegendreE 1 k,( )=

LegendreEc1 k( ) LegendreEc 1 k2–( )=
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Incomplete elliptic integral of 
the first kind

Complete elliptic integral of 
the first kind

Associated complete elliptic integral 
of the first kind

Incomplete elliptic integral 
of the third kind 

Complete elliptic integral 
of the third kind

Associated complete elliptic
integral of the third kind

Digamma function

Polygamma function

Hyperbolic sine integral

Sine integral

Lambert W function  is the principal branch of a function 
satisfying . 

 is the nth branch of .

Riemann Zeta function    (x > 1)

&RPPHQWV
The Psi function and Γ appear frequently in the results of indefinite sums and products. If you use a single 
variable name rather than a full range in the index placeholder of a summation or product, and you choose 
Evaluate Symbolically or another symbolic evaluation command, Mathcad will attempt to calculate an 
indefinite sum or product of the expression in the main placeholder. The indefinite sum of f(i) is an 
expression S(i) for which .

The indefinite product of f(i) is an expression P(i) for which .

LegendreF x k,( ) 1

1 t2–( ) 1 k2 t2⋅–( )
-------------------------------------------------- td

0

x

∫=

LegendreKc k( ) LegendreF 1 k,( )=

LegendreKc1 k( ) LegendreKc 1 k2–( )=

LegendrePi x n k, ,( ) 1

1 n
2

t
2⋅–( ) 1 t2–( ) 1 k2 t2⋅–( )

----------------------------------------------------------------------------------- td
0

x

∫=

LegendrePic n k,( ) LegendrePi 1 n k, ,( )=

LegendrePic1 k( ) LegendrePic n 1 k2–,( )=

Psi x( )
xd

d Γ x( )( )ln=

Psi n k,( )
xn

n

d

d Psi x( )=

Shi x( ) t( )sinh
t

----------------- td
0

x

∫=

Si x( ) t( )sin
t

-------------- td
0

x

∫=

W x( )
W x( ) W x( )( )exp⋅ x=

W n x,( ) W x( )

Zeta x( ) 1

nx
-----

n 1=

∞

∑=

S i 1+( ) S i( )– f i( )=
P i 1+( )

P i( )
------------------- f i( )=
Special Functions 487



6,�8QLWV

%DVH�8QLWV

$QJXODU�0HDVXUH

/HQJWK

0DVV

7LPH

$UHD��9ROXPH

9HORFLW\��$FFHOHUDWLRQ

)RUFH��(QHUJ\��3RZHU

m (meter), length kg (kilogram), mass s (second), time
A (ampere), current K (kelvin), temperature cd (candela), luminosity
mole or mol, substance

rad 1=
deg

π
180
--------- rad⋅=

sr 1 sr⋅=

cm 0.01
·

m⋅= km 1000 m⋅= mm 0.001 m⋅=

ft 0.3048 m⋅= in 2.54 cm⋅= yd 3 ft⋅=

mi 5280 ft⋅=

gm 10
3–

kg⋅= tonne 1000 kg⋅= lb 453.59237 gm⋅=

mg 10 3– gm⋅= ton 2000 lb⋅= slug 32.174 lb⋅=

oz lb
16
------=

min 60 s⋅= hr 3600 s⋅= day 24 hr ⋅=

yr 365.2422 day ⋅=

hectare 104 m2⋅= acre 4840 yd2⋅= L 0.001 m
3⋅=

mL 10 3– L⋅= fl_oz 29.57353 cm3⋅= gal 128 fl_oz⋅=

mph mi
hr
------= kph km

hr
--------= g 9.80665

m
s2
----⋅=

N kg
m
s2
----⋅= dyne 10 5– N⋅= lbf g lb⋅=

kgf g kg⋅= J N m⋅= erg 10 7– J⋅=

cal 4.1868 J⋅= kcal 1000 cal⋅= BTU 1.05506 103 J⋅ ⋅=

W J
s
--=

kW 1000 W⋅=
hp 550

ft lbf⋅
s

---------------⋅=
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3UHVVXUH��9LVFRVLW\

(OHFWULFDO

)UHTXHQF\��$FWLYLW\

7HPSHUDWXUH

'RVH

/XPLQRXV�)OX[��,OOXPLQDQFH

Pa
N

m2
-------= psi

lbf
in2
-------= atm 1.01325 105 Pa⋅ ⋅=

in_Hg 3.37686 103 Pa⋅ ⋅= torr 1.33322 102 Pa⋅ ⋅=
stokes 10 4– m2

s
-------⋅=

poise 0.1 Pa s⋅ ⋅=

C A s⋅=
V J

C
----= mV 10 3– V⋅=

kV 103 V⋅= Ω V
A
----= kΩ 103 Ω⋅=

MΩ 106 Ω⋅= S
1
Ω
----= mho

1
Ω
----=

H
V
A
---- s⋅= µH 10 6– H⋅= mH 10 3– H⋅=

µA 10 6– A⋅= mA 10 3– A⋅= kA 103 A⋅=

F C
V
----= pF 10 12– F⋅= nF 10 9– F⋅=

µF 10 6– F⋅= Wb V s⋅=

Oe
1000
4 π⋅
------------ A

m
----⋅= T Wb

m2
---------= gauss 10 4– T⋅=

Hz
1
s
---= kHz 103 Hz⋅= MHz 106 Hz⋅=

GHz 109 Hz⋅= Bq 1
s
---=

Hza 2 π Hz⋅ ⋅=

R 0.556 K⋅=

Gy J
kg
------= Sv J

kg
------=

lm cd sr⋅=
lx cd st⋅

m2
--------------=
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&*6�XQLWV�

%DVH�8QLWV

$QJXODU�0HDVXUH

/HQJWK

0DVV

7LPH

$UHD��9ROXPH

9HORFLW\��$FFHOHUDWLRQ

)RUFH��(QHUJ\��3RZHU

cm (centimeter), length gm (gram), mass sec (second), time

coul (coulomb), charge K (kelvin), temperature

rad 1=
deg

π
180
--------- rad⋅=

m 100 cm⋅= km 1000 m⋅= mm 0.1 cm⋅=

ft 30.48 cm⋅= in 2.54 cm⋅= yd 3 ft⋅=

mi 5280 ft⋅=

kg 1000 gm⋅= tonne 1000 kg⋅= lb 453.59237 gm⋅=

mg 10 3– gm⋅= ton 2000 lb⋅= slug 32.174 lb⋅=

oz lb
16
------=

min 60  sec⋅= hr 3600  sec⋅= day 24 hr ⋅=

yr 365.2422 day ⋅=

hectare 108 cm2⋅= acre 4840 yd2⋅= liter 1000 cm3⋅=

mL cm3= fl_oz 29.57353 cm3⋅= gal 128 fl_oz⋅=

mph mi
hr
------= kph km

hr
--------= g 980.665

cm
 2sec

------------⋅=

c 2.997925 1010 cm 
sec
---------⋅ ⋅= c_ c

sec
m

-------⋅=

dyne gm
cm

sec2
----------⋅= newton 105 dyne⋅= lbf g lb⋅=

kgf g kg⋅= erg dyne cm⋅= joule 107 erg⋅=

cal 4.1868 107 erg⋅ ⋅= BTU 1.05506 1010 erg⋅ ⋅= kcal 1000 cal⋅=

watt joule
sec

-------------=
kW 1000 watt⋅=

hp 550
ft lbf⋅

sec
---------------⋅=
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ined in 
3UHVVXUH��9LVFRVLW\

(OHFWULFDO
These are CGS-esu units, based only on mass, length, and time. The “stat” units are def
terms of dyne, cm, and sec.

)UHTXHQF\

7HPSHUDWXUH

&RQYHUVLRQV�WR�6,�8QLWV

8�6��&XVWRPDU\�8QLWV�

%DVH�8QLWV

$QJXODU�0HDVXUH

ft (foot), length lb (pound), mass sec (second), time

coul (coulomb), charge K (kelvin), temperature

Pa 10
dyne
cm2
------------⋅= psi

lbf
in2
-------= atm 1.01325 105 Pa⋅ ⋅=

in_Hg 3.38638 103 Pa⋅ ⋅= torr 1.33322 102 Pa⋅ ⋅=
stokes

cm2

sec
----------=

poise 0.1 Pa sec⋅ ⋅=

statamp dyne0.5 cm sec 1–⋅ ⋅= statcoul dyne0.5 cm⋅= statvolt dyne0.5=

statohm sec cm 1–⋅= statsiemens cm sec 1–⋅= statfarad cm=

statweber dyne0.5 cm⋅= stathenry sec2 cm 1–⋅= stattesla dyne0.5 cm sec 2–⋅ ⋅=

Hz
1

sec
-------= kHz 103 Hz⋅= MHz 106 Hz⋅=

GHz 109 Hz⋅= Hza 2 π Hz⋅ ⋅=

R 0.556 K⋅=

amp
c_
10
------ statamp⋅= volt watt

amp
-----------= ohm volt

amp
-----------=

coul amp sec⋅=
farad coul

volt
-----------= henry volt

sec
amp
-----------⋅=

rad 1=
deg

π
180
--------- rad⋅=
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/HQJWK

0DVV

7LPH

$UHD��9ROXPH

9HORFLW\��$FFHOHUDWLRQ

)RUFH��(QHUJ\��3RZHU

3UHVVXUH��9LVFRVLW\

in ft
12
------= m ft

0.3048
----------------=

yd 3 ft⋅=

cm 0.01 m⋅= mi 5280 ft⋅= km 1000 m⋅=

mm 0.001 m⋅=

slug 32.174 lb⋅=
oz

lb
16
------=

ton 2000 lb⋅=

kg lb
0.45359237
----------------------------=

tonne 1000 kg⋅= gm 10 3– kg⋅=

mg 10 3– gm⋅=

min 60  sec⋅= hr 3600  sec⋅= day 24 hr ⋅=

yr 365.2422 day ⋅=

acre 4840 yd2⋅= hectare 104 m2⋅= fl_oz 29.57353 cm3⋅=

liter 0.035 ft
3⋅= mL 10 3– liter⋅= gal 128 fl_oz⋅=

mph mi
hr
------= kph km

hr
--------= g 32.174

ft
 2sec

------------⋅=

lbf g lb⋅=
newton kg

m
sec2
----------⋅= dyne 10 5– newton⋅=

kgf g kg⋅= joule newton m⋅= erg 10 7– joule⋅=

cal 4.1868 joule⋅= kcal 1000 cal⋅= BTU 1.05506 103 joule⋅ ⋅=

watt joule
sec

-------------= hp 550
ft lbf⋅

sec
---------------⋅=

kW 1000 watt⋅=

psi
lbf
in2
-------= Pa newton

m2
-------------------= atm 1.01325 105 Pa⋅ ⋅=

in_Hg 3.386 103 Pa⋅ ⋅= torr 1.333 102 Pa⋅ ⋅=
stokes

cm2

sec
----------=

poise 0.1 Pa sec⋅ ⋅=
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(OHFWULFDO

)UHTXHQF\

7HPSHUDWXUH

0.6�8QLWV�

%DVH�8QLWV

$QJXODU�0HDVXUH

m (meter), length kg (kilogram), mass sec (second), time

coul (coulomb), charge K (kelvin), temperature

volt watt
amp
-----------= mV 10 3– volt⋅= KV 103 volt⋅=

ohm volt
amp
-----------= mho

1
ohm
-----------= siemens

1
ohm
-----------=

Ω ohm= KΩ 103 ohm⋅= MΩ 106 ohm⋅=

henry weber
amp

----------------= µH 10 6– henry⋅= mH 10 3– henry⋅=

amp coul
sec

-----------= µA 10 6– amp⋅= mA 10 3– amp⋅=

KA 103 amp⋅= farad coul
volt
-----------= pF 10 12– farad⋅=

nF 10 9– farad⋅= µF 10 6– farad⋅= weber volt sec⋅=

oersted
1000
4 π⋅
------------ amp

m
-----------⋅= tesla weber

m2
----------------= gauss 10 4– tesla⋅=

Hz
1

sec
-------= kHz 103 Hz⋅= MHz 106 Hz⋅=

GHz 109 Hz⋅= Hza 2 π Hz⋅ ⋅=

R 0.556 K⋅=

rad 1=
deg

π
180
--------- rad⋅=
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/HQJWK

0DVV

7LPH

$UHD��9ROXPH

9HORFLW\��$FFHOHUDWLRQ

)RUFH��(QHUJ\��3RZHU

cm 0.01 m⋅= km 1000 m⋅= mm 0.001 m⋅=

ft 0.3048 m⋅= in 2.54 cm⋅= yd 3 ft⋅=

mi 5280 ft⋅=

gm 10
3–

kg⋅= tonne 1000 kg⋅= lb 453.59237 gm⋅=

mg 10 3– gm⋅= ton 2000 lb⋅= slug 32.174 lb⋅=

oz lb
16
------=

min 60  sec⋅= hr 3600  sec⋅= day 24 hr ⋅=

yr 365.2422 day ⋅=

hectare 104 m2⋅= acre 4840 yd2⋅= liter 0.1 m⋅( )3=

mL 10 3– liter⋅= fl_oz 29.57353 cm3⋅= gal 128 fl_oz⋅=

mph mi
hr
------= kph km

hr
--------= g 9.80665

m
 2sec

------------⋅=

newton kg
m

sec2
----------⋅= dyne 10 5– newton⋅= lbf g lb⋅=

kgf g kg⋅= joule newton m⋅= erg 10 7– joule⋅=

cal 4.1868 joule⋅= kcal 1000 cal⋅= BTU 1.05506 103 joule⋅ ⋅=

watt joule
sec

-------------=
kW 1000 watt⋅=

hp 550
ft lbf⋅

sec
---------------⋅=
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3UHVVXUH��9LVFRVLW\

(OHFWULFDO

)UHTXHQF\

7HPSHUDWXUH

Pa
newton

m2
-------------------= psi

lbf
in2
-------= atm 1.01325 105 Pa⋅ ⋅=

in_Hg 3.38638 103 Pa⋅ ⋅= torr 1.33322 102 Pa⋅ ⋅=
stokes 10 4– m2

sec
-------⋅=

poise 0.1 Pa sec⋅ ⋅=

volt watt
amp
-----------= mV 10 3– volt⋅= kV 103 volt⋅=

ohm volt
amp
-----------= mho

1
ohm
-----------= siemens

1
ohm
-----------=

Ω ohm= kΩ 103 ohm⋅= MΩ 106 ohm⋅=

henry weber
amp

----------------= µH 10 6– henry⋅= mH 10 3– henry⋅=

amp coul
sec

-----------= µA 10 6– amp⋅= mA 10 3– amp⋅=

kA 103 amp⋅= farad coul
volt
-----------= pF 10 12– farad⋅=

nF 10 9– farad⋅= µF 10 6– farad⋅= weber volt sec⋅=

oersted
1000
4 π⋅
------------ amp

m
-----------⋅= tesla weber

m2
----------------= gauss 10 4– tesla⋅=

Hz
1

sec
-------= kHz 103 Hz⋅= MHz 106 Hz⋅=

GHz 109 Hz⋅= Hza 2 π Hz⋅ ⋅=

R 0.556 K⋅=
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3UHGHILQHG�9DULDEOHV

Mathcad’s predefined variables are listed here with their default starting values.

&RQVWDQW 9DOXH 0HDQLQJ

π = 3.14159... Pi. Mathcad uses the value of π to 15 digits. To type π, press 
[Ctrl][Shift]p.

e = 2.71828... The base of natural logarithms. Mathcad uses the value of e to 15 
digits.

∞ = Infinity. This symbol represents values larger than the largest real 
number representable in Mathcad (about ). To type ∞, press 
[Ctrl][Shift]Z.

% = 0.01 Percent. Use in expressions like 10*% (appears as ) or as a 
scaling unit at the end of an equation with an equal sign.

CTOL = Constraint tolerance used in solving and optimization functions: 
how closely a constraint must be met for a solution to be considered 
acceptable.

CWD = “[system path]” String corresponding to the working folder of the worksheet.

FRAME = 0 Counter for creating animation clips.

inn = 0 Input variables (in0, in1, etc.) in a Mathcad component in a 
MathConnex system. See the MathConnex User’s Guide for details.

ORIGIN = 0 Array origin. Specifies the index of the first element in arrays.

PRNCOLWIDTH = 8 Column width used in writing files with WRITEPRN function.

PRNPRECISION = 4 Number of significant digits used when writing files with the 
WRITEPRN function.

TOL = Tolerance used in numerical approximation algorithms (integrals, 
equation solving, etc.): how close successive approximations must 
be for a solution to be returned. For more information, see the 
sections on the specific operation in question.

10307

10307

10 %⋅

10 3–

10 3–
496  Appendices



6XIIL[HV�IRU�1XPEHUV

The table below shows how Mathcad interprets numbers (sequences of alpha-numerics 
beginning with a number and ending with a letter).

5DGL[

8QLWV�DQG�RWKHU

1RWH Because Mathcad by default treats most expressions involving a number followed immediately 
by a letter to mean implied multiplication of a number by a variable name, you will need to 
backspace over the implied multiplication operator to create expressions like 4.5M. 

6XIIL[ ([DPSOH 0HDQLQJ

b, B 100001b Binary

h, H 8BCh Hexadecimal

o, O 1007o Octal

6XIIL[ ([DPSOH 0HDQLQJ

i or j 4i, 1j, Imaginary

K –273K Standard absolute temperature unit

L –2.54L Standard length unit

M 2.2M Standard mass unit

Q –100Q Standard charge unit

S 6.97S Standard substance unit in SI unit system

T 3600T Standard time unit

C 125C Standard luminosity unit in SI unit system

3 1.5j+
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*UHHN�/HWWHUV

To type a Greek letter into an equation or into text, press the Roman equivalent from 
the table below, followed by [Ctrl]G. Alternatively, use the Greek toolbar.

1RWH The Greek letter π is so commonly used that it has its own keyboard shortcut: [Ctrl][Shift]P.

1DPH 8SSHUFDVH /RZHUFDVH 5RPDQ�HTXLYDOHQW

alpha Α α A

beta Β β B

chi Χ χ C

delta ∆ δ D

epsilon Ε ε E

eta Η η H

gamma Γ γ G

iota Ι ι I

kappa Κ κ K

lambda Λ λ L

mu Μ µ M

nu Ν ν N

omega Ω w W

omicron Ο ο O

phi Φ φ F

phi (alternate) ϕ J

pi Π π P

psi Ψ ψ Y

rho Ρ ρ R

sigma Σ σ S

tau Τ τ T

theta Θ θ Q

theta (alternate) ϑ J

upsilon Υ υ U

xi Ξ ξ X

zeta Ζ ζ Z
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$UURZ�DQG�0RYHPHQW�.H\V

.H\V $FWLRQV

[↑] Move crosshair up. In math: move editing lines up. In text: move 
insertion point up to previous line.

[↓] Move crosshair down. In math: move editing lines down. In text: 
move insertion point down to next line.

[←] Move crosshair left. In math: select left operand. In text: move 
insertion point one character to the left.

[→] Move crosshair right. In math: select right operand. In text: move 
insertion point one character to the right.

[PgUp] Scroll up about one-fourth the height of the window.

[PgDn] Scroll down about one-fourth the height of the window.

[Shift][↑] In math: move crosshair outside and above expression. In text: 
highlight from insertion point up to previous line.

[Shift][↓] In math: move crosshair outside and below expression. In text: 
highlight from insertion point down to next line.

[Shift][←] In math: highlight parts of an expression to the left of the insertion 
point. In text: highlight to left of insertion point, character by 
character.

[Shift][→] In math: highlight parts of an expression to the right. In text: highlight 
to right of insertion point, character by character.

[Ctrl][↑] In text: move insertion point to the beginning of a line.

[Ctrl][↓] In text: move insertion point to the end of a line.

[Ctrl][←] In text: move insertion point left to the beginning of a word.

[Ctrl][→] In text: move insertion point to the beginning of next word.

[Ctrl][↵] Insert a hard page break. In math: insert addition with line break 
operator. In text: set the width of the text region.

[Ctrl][Shift][↑] In text: highlight from insertion point up to the beginning of a line.

[Ctrl][Shift][↓] In text: highlight from insertion point to end of the current line.

[Ctrl][Shift][←] In text: highlight left from insertion point to the beginning of a word.

[Ctrl][Shift][→] In text: highlight from insertion point to beginning of the next word.

[Space] In math: cycles through different states of the editing lines.

[Tab] In text: moves the insertion point to the next tab stop. In math or plot: 
move to next placeholder.

[Shift][Tab] In math or plot: move to previous placeholder.

[Shift][PgUp] Move up to previous pagebreak.

[Shift][PgDn] Move down to next pagebreak.

[Home] Move to beginning of previous region. In text, move to beginning of 
current line.

[End] Move to next region. In text, move to end of current line.
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xt 
)XQFWLRQ�.H\V

1RWH These function keys are provided mainly for compatibility with earlier Mathcad versions. 
Mathcad also supports standard Windows keystrokes for operations such as file opening, 
[Ctrl]O], and saving, [Ctrl]S], copying, [Ctrl]C], and pasting, [Ctrl]V]. Choose 
Preferences from the View menu and check “Use standard Windows shortcut keys” on the
General tab to enable all Windows shortcuts.

[Ctrl][Home] Scroll to beginning of worksheet. In text, move insertion point to 
beginning of text region or paragraph.

[Ctrl][End] Scroll to end of worksheet. In text, move insertion point to end of te
region or paragraph.

[↵] In text: start new line. In equation or plot: move crosshair below 
region, even with left edge of region.

.H\V $FWLRQV

[F1] Help.

[Shift][F1] Context sensitive help.

[F2] Copy selected region to clipboard.

[F3] Cut selected region to clipboard.

[F4] Paste contents of clipboard.

[Ctrl][F4] Close worksheet or template.

[Alt][F4] Close Mathcad.

[F5] Open a worksheet or template.

[Ctrl][F5] Search for text or math characters.

[Shift][F5] Replace text or math characters.

[F6] Save current worksheet.

[Ctrl][F6] Make next window active.

[Ctrl][F7] Inserts the prime symbol (‘).

[F7] Open a new worksheet.

[F9] Recalculate a selected region.

[Ctrl][F9] Inserts blank lines.

[Ctrl][F10] Deletes blank lines.
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$6&,,�FRGHV

Decimal ASCII codes from 32 to 255. Nonprinting characters are indicated by “npc.”

Code Character Code Character Code Character Code Character Code Character
32 [space] 80 P 130 ‚ 182 ¶ 230 æ
33 ! 81 Q 131 ƒ 183 · 231 ç
34 " 82 R 132 „ 184 ¸ 232 è
35 # 83 S 133 ... 185 ¹ 233 é
36 $ 84 T 134 † 186 º 234 ê
37 % 85 U 135 ‡ 187 » 235 ë
38 & 86 V 136 ˆ 188 ¼ 236 ì
39 ' 87 W 137 ‰ 189 ½ 237 í
40 ( 88 X 138 Š 190 ¾ 238 î
41 ) 89 Y 139 ‹ 191 ¿ 239 ï
42 * 90 Z 140 Œ 192 À 240 ð
43 + 91 [ 141–4npc 193 Á 241 ñ
44 , 92 \ 145 ‘ 194 Â 242 ò
45 - 93 ] 146 ’ 195 Ã 243 ó
46 . 94 ^ 147 “ 196 Ä 244 ô
47 / 95 _ 148 ” 197 Å 245 õ
48 0 96 ` 149 • 198 Æ 246 ö
49 1 97 a 150 – 199 Ç 247 ÷
50 2 98 b 151 — 200 È 248 ø
51 3 99 c 152 ˜ 201 É 249 ù
52 4 100 d 153 ™ 202 Ê 250 ú
53 5 101 e 154 š 203 Ë 251 û
54 6 102 f 155 › 204 Ì 252 ü
55 7 103 g 156 œ 205 Í 253 ý
56 8 104 h 157–8npc 206 Î 254 þ
57 9 105 i 159 Ÿ 207 Ï 255 ÿ
58 : 106 j 160 npc 208 Ð
59 ; 107 k 161 ¡ 209 Ñ
60 < 108 l 162 ¢ 210 Ò
61 = 109 m 163 £ 211 Ó
62 > 110 n 164 ¤ 212 Ô
63 ? 111 o 165 ¥ 213 Õ
64 @ 112 p 166 ¦ 214 Ö
65 A 113 q 167 § 215 ×
66 B 114 r 168 ¨ 216 Ø
67 C 115 s 169 © 217 Ù
68 D 116 t 170 ª 218 Ú
69 E 117 u 171 « 219 Û
70 F 118 v 172 ¬ 220 Ü
71 G 119 w 173 - 221 Ý
72 H 120 x 174 ® 222 Þ
73 I 121 y 175 ¯ 223 ß
74 J 122 z 176 ° 224 à
75 K 123 { 177 ± 225 á
76 L 124 | 178 ² 226 â
77 M 125 } 179 ³ 227 ã
78 N 126 ~ 180 ´ 228 ä
79 O 127–9npc 181 µ 229 å
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5HIHUHQFHV

Abramowitz, M., and I. Stegun. Handbook of Mathematical Functions. New York: 
Dover, 1972.

Devroye, L. Non-uniform Random Variate Distribution. New York: Springer-Verlag, 
1986.

Friedman, J. H. “A Variable Span Smoother.” Tech Report No. 5. Laboratory for 
Computational Statistics. Palo Alto: Stanford University. 

Geddes, K. and G. Gonnet. “A New Algorithm for Computing Symbolic Limits Usi
Generalized Hierarchical Series.” Symbolic and Algebraic Computation (Proceedings 
of ISSAC ’88). Edited by P. Gianni. From the series Lecture Notes in Computer Science. 
Berlin: Springer-Verlag, 1989. 

Golub, G. and C. Van Loan. Matrix Computations. Baltimore: John Hopkins 
University Press, 1989.

Knuth, D. The Art of Computer Programming: Seminumerical Algorithms. Reading: 
Addison-Wesley, 1997.

Lorczak, P. The Mathcad Treasury. A MathSoft Electronic Book. Cambridge: 
MathSoft, Inc.

Nash, J.C. Compact Numerical Methods For Computers. Bristol: Adam Hilger 
Ltd., 1979.

Niven, I. and H. Zuckerman. An Introduction to the Theory of Numbers. New York: 
John Wiley & Sons, 1972.

Press, W.H., W.T. Flannery, S.A.Teukolsky, and B.P.Vetterling. Numerical Recipes in 
C. Cambridge University Press, New York, 1992.

Polak, E. Optimization – Algorithms and Consistent Approximations. New York: 
Springer-Verlag, 1997.

Singleton, R. Communications of ACM. Vol. 11, no. 11. November, 1986.

Wilkinson, J.H. and C. Reinsch. Handbook for Automatic Computation. Vol. II, Linear 
Algebra. New York: Springer-Verlag, 1971.

Winston, W. Operations Research: Applications and Algorithms. Belmont: 
Wadsworth, 1994.
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,QGH[
↵ (Enter key) 2
∫ (integral) 142
→ (symbolic equal sign) 260
× (vector cross product) 136
∑ (vector sum) 136
→ (vectorize operator) 136, 213
∑ and ∏ (summation and product) 136
! (factorial) 129
% 496
( ) (parentheses) 51
+, –, ·, and / 131
, 377, 429
:= (definition) 13, 101
<, >, ≤, ≥ (inequalities) 131
= (Boolean equal) 132
= (evaluating expression) 14, 103
| · | (determinant) 136
| · | (magnitude/absolute value) 136
∞ (infinity) 496
≠ (not equal to) 132
√ (square root) 131
3D Plot Format dialog box 246
absolute value 133, 451
accessing Mathcad from other applications 314
accessing other applications from Mathcad 297–298
acos function 319
acosh function 319
acot function 319
acoth function 319
acsc function 319
acsch function 319
ActiveX 308, 314
adaptive smoothing of data 183
add line 469
addition 131, 449

with line break 449
Ai function 320
Airy functions 153, 320, 323
algorithms

See numerical methods
aligning

output tables 211
regions 85
text 62

and 131
and function 468
angle function 320
Animate command 125

animation
compressing AVI files 125
creating 125
playback 126
saving 125
saving with worksheet 126
speed 125–126

antisymmetric tensor function 155, 445
APPEND function 200
APPENDPRN function 200, 320
approximations

root of expression 166
arccosecant 319
arccosine 319
arccotangent 319
arcsecant 321
arcsine 321
arctangent 321
area

collapsing 91
deleting 93
inserting 91
locking and unlocking 91
naming 92
password protecting 91

arg function 321
arguments

of functions 109
arithmetic mean 377
arithmetic operators 131

absolute value 451
addition 449
addition with line break 449
complex conjugate 451
division 450
exponentiation 451–452
factorial 450
multiplication 450
negation 450
nth root 451
parentheses 449
range variable 453
square root 451
subtraction 450

arrays
calculations by element 213
copying and pasting 212
creating 37, 203
defining with range variables 204
displaying in results 210
exporting data from 215
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extracting a row or column 209
functions for 159
graphical display of 215
importing data into 208
nested 117, 217
operators for 133
ORIGIN used with 209
See also matrices and vectors

arrow keys, for editing 9, 499
ASCII codes

entering in strings 38
table 501

asec function 321
asech function 321
asin function 321
asinh function 321
assume keyword 264, 475
assume keyword modifier 266
atan function 321
atan2 function 322
atanh function 322
augment function 162, 322
Author’s Reference 28, 97
Auto (on status bar) 122
automatic calculation mode 122
autoscaling of axis limits 229
AutoSelect

in numerical integration 142
in solving 171
overriding 143, 172

AVI files
compression 125
creating 125
hyperlinking from worksheet 126
playback 126

Axum component 297
Axum graphs in Mathcad 227
Axum LE 227
background color 89
bar plots (3D)

formatting 246
base of results (decimal/octal/binary) 117
base units 119
bei function 153, 322
ber function 323
Bessel functions 153

Ai function 320
bei function 322
ber function 323
Bi function 323
I0 function 354

I1 function 355
In function 357
J0 function 360
J1 function 360
Jn function 361
js function 361
K0 function 361
K1 function 361
Kn function 362
Y0 function 444
Y1 function 444
Yn function 444
ys function 445

Bessel Kelvin functions 153
beta distribution 334, 389, 398, 403
Bi function 153, 323
binary numbers 36, 117
binomial distribution 334, 389, 398, 404
bitmaps

color palettes 73
copying from the Clipboard 72
creating pictures from 71
functions for reading 200

blank lines, inserting or deleting 87
blank pages in printouts 98
blank space between regions 10
BMP files 71, 91, 200
bold equals 468
bookmarks 26
Boolean operators 131, 133, 155, 169

and function 468
bold equals 468
greater than 467
greater than or equal to 467
less than 467
less than or equal to 467
not equal to 467
not function 468
or function 468
xor function 468

border around a region
regions

putting borders around 10
boundary value 325, 384, 411, 427
boundary value problems 195
break statement 289, 470
breaking equations 270
bspline function 323
B-splines 178
built-in functions

listed by type 149
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built-in variables 103
bulleted paragraphs 62
Bulstoer function 324
bulstoer function 324
business functions 183
bvalfit function 196, 325
CAD drawings 306
Calc on message line 123
calculation 14

controlling 122
disabling for individual equation 124
equations 14, 103
locking area 91–92
order in worksheets 103
result format 115
units in 118

calculator, using Mathcad as 12
calculus operators

definite integral 458
derivative 460
indefinite integral 460
left-hand limit 462
limit 462
nth derivative 461
product 457
range product 458
range sum 457
right-hand limit 462
summation 456

calling Mathcad from other applications 314
Cauchy distribution 334, 389, 398, 404
ceil function 326
Celsius 114, 120
CFFT function 327
cfft function 326
CGS units 119, 490
characters, deleting or inserting in math 46
Chebyshev polynomials 439
Chi function 486
chi-squared distribution 335, 390, 398, 404
cholesky function 328
Ci function 486
Clipboard 53, 270
closing a worksheet 20
closing Mathcad

See exiting Mathcad
CMP (colormap) files 202
cnorm function 176
cnper function 328
coeffs keyword 263, 475
Collaboratory 22, 29

collapsing an area 92
collect keyword 263, 475
colon (:) as definition symbol 13, 101
color

Electronic Book annotation 24
equation highlight 89
in equations 55
in text 61
of worksheet background 89

color images
displaying 69
reading 200

color palettes for bitmaps 73
colormap 367, 427
colormap files 202, 249
cols function 328
column vectors

See vectors
combin function 329
combinatorics functions 155

combin function 329
permut function 390

combining matrices
augment function 322
stack function 432

common logarithm 369
complex conjugate 133, 451
complex keyword 262, 476
complex numbers

arg function 321
conjugate 133
csgn function 332
determining angle 133
display of 117
entering 36
Im function 357
imaginary unit symbol 117
magnitude of 133
operators and functions for 133, 156
Re function 404
real and imaginary parts 133
signum function 429
vector field plots 244

complex threshold 117
Component Wizard 298
components

application-based 297
customizing 310
inserting 298
overview of 297
redistributing 310
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scripted 308
computing results 14, 103
concat function 329
cond1 function 329
cond2 function 329
conde function 329
condi function 329
condition number of matrix 329
conditional

functions 155, 199
statement 286

conditional function if 356
conditional statement if 469
confluent hypergeometric function 379, 393
conjugate (complex) 133
conjugate, complex 451
constants

changing the font style of 54
See also numbers and predefined variables

constraint
in solve blocks 169
tolerance 171

constraints in solve blocks 344, 387
context menu

See pop-up menu
continue statement 290, 470
contour integrals 145
contour plots

creating 243
formatting 246
See also plots, 3D

control components 311
convert keyword 263, 269
Convert to Partial Fraction command 269
convert, parfrac keyword 476
converting to partial fractions 263
coordinate system transform functions 162
copy and paste 10, 74, 121
copying

expressions 53
from Electronic Book 25
regions 10
results 121

copying regions 10
corr function 330
correlation coefficient 330
cos function 330
cosh function 330
cosine integral 486
cot function 330
coth function 330

covariance 334
crate function 330
CreateMesh function 331
CreateSpace function 331
creating

2D plots 219
3D plots 235
contour plots 243
Electronic Books 97
hyperlinks 95
pop-up window 95
region tags 96
space curve 239
surface plots 237, 240
text regions 57
vector field plots 244
worksheet templates 79

creating arrays 203
cross product 136, 453
crosshair for insertion 10
csc function 332
csch function 332
csgn function 332
csort function 165, 332
cspline function 332
CTOL variable 171, 344, 387, 496
cube root 117
cubic spline interpolation 177
cumint function 333
cumprn function 333
cumulative distribution functions 174
cumulative probability

See probability distribution
curve fitting

functions for 179
polynomial 180
using cubic splines 177

curves, finding area under 142
custom operators 146
cvar function 334
cyl2xyz function 334
δ function 445
d/dx

See derivatives
dashed selection rectangle 10
data

entering into a table 207
graphing 227

Data Acquisition component (DAC) 313
data files

exporting from an array 217
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functions for reading and writing 200
importing data from 208
reading data from 205
reading into a matrix 205
writing from an array 215

data input 208
databases, exchanging data with 300, 303
date in header or footer 91
dbeta function 334
dbinom function 334
dcauchy function 334
dchisq function 335
debugging a worksheet 127
decimal places

in displayed results 116
internal precision 115

decimal points
numerical calculation 116
symbolic calculation 262

decomposition
matrix 165
partial fraction 263

default formats
2D plots 231
3D plots 246
numerical results 115
template 79
worksheet layout 79

defining
complex numbers 36
functions 109
global variables 104
local variables in program 284
multiple definitions of variable 104
numbers 36
operators 146
programs 283
range variables 106
See also creating
strings 38
units 114, 119
variables 13, 101

definite integral 273, 458
definition 452, 463

global 464
local 469

definition symbol (:=) 13, 101
degrees, converting to radians 121, 152
deleting

blank lines 87
characters in math 46

equations 12
hard page breaks 90
hyperlinks 96
operators 50
parentheses 52
parts of an expression 53
regions 12
text 58

delta function 445, 486
derivative 460
derivatives 139

higher order 141
symbolic 271

determinant 136, 278, 454
Developer’s Reference 28, 309, 311, 314
device-independent bitmap 72
dexp function 335
dF function 175, 335
dgamma function 335
dgeom function 335
dhypergeom function 336
diag function 336
dialects (spell-checker) 68
DIB

See device-independent bitmap
dictionaries (spell-checker) 68
differential equation solvers

Bulstoer function 324
bulstoer function 324
bvalfit function 325
multigrid function 384
Odesolve function 387
relax function 411
Rkadapt function 415
rkadapt function 414
rkfixed function 415
sbval function 427
Stiffb function 433
stiffb function 433
Stiffr function 435
stiffr function 434

differential equations 187
higher order 187, 190
partial 197
second order 187, 190
slowly varying solutions 193
smooth systems 193
stiff systems 193
systems 191

differentiation 460–461
See derivatives
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differentiation variable 139, 141
dilog function 486
dilogarithm function 486
dimensions 113
Dirac function 486
disabling equations 66, 124
display of arrays 210
display of operators 130
displayed precision

See decimal places
distribution functions 174
division 131, 450
dlnorm function 336
dlogis function 336
dnbinom function 336
dnorm function 337
dot product 135, 453
double integrals 145, 458
Down One Level command 217
dpois function 337
drag and drop 10, 25, 53, 74, 76, 254
dragging regions 10
drawings

See pictures
dunif function 337
dweibull function 338
ε function 155, 445
e, base of natural logarithms 102, 367, 496
Edit Go to Page command 9
Edit Links command 77
editing equations

annotated example 45
applying an operator 46
changing a number 46
changing a variable or function name 46
compared to word processors 45
deleting an operator 50
deleting parentheses 52
deleting parts of expression 53
inserting an operator 47
making expression an argument to a function 52
moving parts of an expression 53
moving/rearranging equations 85

editing lines 16, 45
eff function 338
Ei function 486
eigenanalysis 338–339, 351
eigenvals function 338
eigenvalues 164
eigenvec function 338
eigenvecs function 339

eigenvectors 164
Electronic Book

browsing history 24
copying information from 25
creating 97
moving around in 23, 26
searching for information in 24
toolbar 23, 26

Electronic Books 21, 95, 97
elliptic integral 486
Email 99
endpoints for ranges 108
engineering notation 116
Enter key 2
epsilon function 155
equal sign (=)

in numerical calculations 103
in solve blocks 168
symbolic calculations 260, 275–276

equality constraints 169
equals 452, 463

bold 468
equations

as constraints in solve blocks 169
breaking 270
calculating results 14, 103
color 55
disabling calculation for 66, 124
dragging and dropping 53
effect of range variables in 108
errors in 126
font 54
global definitions 104
in text 65
locking in area 91–92
order of evaluation 103, 122
processing and calculating 13, 122
properties 66, 124
solving for root 166
solving symbolically 275–277
solving with solve blocks 167
styles 54
units in 112
variable definition 101

equations, solving 344, 387, 422
erf function 339, 486
erfc function 339
ERR variable 379
ERR variable and Minerr 171
error function 340
error messages
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correcting 128
custom 198
in equations 126
in programs 293
tracing the source of 127
with units 114

error string function 293
Euclidean norm 454
Euler’s constant 486
Euler’s gamma function 445
Evaluate Complex command 269
Evaluate Floating Point command 262, 269
Evaluate in Place option 270
Evaluate Symbolically command 269–270
evaluation operators

definition 463
equals 463
global definition 464
infix 466
postfix 466
prefix 465
symbolic equals 465
treefix 466

Excel
Excel component 300
reading an Excel data file 205
writing data to an Excel file 215

exclusive or 131
exiting Mathcad 20
exp function 340
Expand command 269
expand in series 263
expand keyword 262, 269, 476
expand nested arrays 117
Expand to Series command 262
Expert Solver 168, 172
expfit function 340
exponent 131
exponential

function 153
notation, entering 37
notation, in displayed results 116

exponential distribution 335, 390, 399, 413
exponential function 340
exponential integral 486
exponentiation

matrix case 451–452
scalar case 451–452

exporting
components as MCM 310
worksheets as HTML 80

worksheets as RTF 83
exporting data 215
expression type functions

IsArray function 359
IsScalar function 360
IsString function 360
UnitsOf function 439

expressions
applying a function to 52
converting to partial fractions 269
correcting errors in 128
deleting parts of 53
error messages in 126
evaluating 103
expanding 262, 269
factoring 263
finding the coefficients of 263
moving parts of 53
selecting several 85
simplifying 270
symbolic evaluation of 260–261

Extending Mathcad in the Resource Center 22
Extension Packs 149
extrapolation 395
F (function) keys, table of 500
F distribution 335, 390, 399, 413
Φ function 446
Factor command 269
factor keyword 263, 477
factorial 450
factorial (!) 131
Fahrenheit 114, 120
fast Fourier transform 157, 341, 343
FFT function 343
fft function 340–341
fhyper function 343
file access functions 199–200

APPENDPRN function 320
GETWAVINFO function 352
LoadColormap function 367
READ_BLUE function 405
READ_GREEN function 405
READ_HLS function 405
READ_HLS_HUE function 406
READ_HLS_LIGHT function 406
READ_HLS_SAT function 406
READ_HSV function 406
READ_HSV_HUE function 406
READ_HSV_SAT function 407
READ_HSV_VALUE function 407
READ_IMAGE function 407
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READ_RED function 408
READBMP function 405
READPRN function 407
READRGB function 408
READWAV function 409
SaveColormap function 427
WRITE_HLS function 442
WRITE_HSV function 442
WRITEBMP function 441
WRITEPRN function 442
WRITERGB function 443
WRITEWAV function 443

File Read/Write component 205, 215
File Send command 99
files

opening 80
reading data from 200, 205
saving 20
See also data files
See also worksheets
writing data to 200

filters
for exporting data 215
for importing data 205

finance
cnper function 328
crate function 330
cumint function 333
cumprn function 333
eff function 338
fv function 348
fvadj function 349
fvc function 349
ipmt function 359
irr function 359
mirr function 384
nom function 385
nper function 386
npv function 387
pmt function 391
ppmt function 394
pv function 396
rate function 403

finance functions 183
Find function 168, 277, 344, 387
first order differential equation 189
float keyword 262, 477
floor function 348
font

changing in header or footer 91
changing in math 54

changing in text 60
footers 90
for loop 287
for loop statement 470
Format Header/Footer command 90
Format Properties command 66
Format Style command 63
formatting

2D plots 229
3D plots 246
numbers in matrices 211
operators 130
results 115
symbolic 270
worksheets 89

Formatting toolbar 8
math styles 56
text styles 64

fourier keyword 263, 279, 478
Fourier transform functions

fft function 340
Fourier transforms

alternate form 343
CFFT function 327
cfft function 326
FFT function 343
fft function 341
ICFFT function 355
icfft function 355
IFFT function 357
ifft function 357
numeric functions 157
symbolic 263, 279

fractions
displaying results as 116

FRAME for animation 125
frequency

Fourier analysis 341
statistical counts 352

Fresnel cosine integral 486
FresnelC function 486
FresnelS function 486
FTP 29
functions

applying to an expression 52
built-in 149
business 183
colormap 202, 249
combinatorics 155
complex arithmetic 133
defining 16, 109
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error message 198
file access 199
finance 183
Fourier transform 157
hyperbolic 153
inserting 149
interpolation 177
inverse trigonometric 152
list of categories 317
log and exponential 153
matrix decomposition 165
number theory 155
optimization 166
other special 486
piecewise continuous 155, 199
population statistics 173
prediction 177
probability distribution 174
recursive 111
regression 179
See also built-in functions
smoothing 183
solving 166
special 156
statistical 173
string manipulation 198
tensor 155, 198
that take vector arguments 159
to find roots of expressions 166
to manipulate strings 198
trigonometric 151
uniform polyhedra 202
user-defined 39, 109
vector and matrix 159

future value calculations 185
fv function 348
fvadj function 349
fvc function 349
Γ function 445
gamma (Euler’s constant) 486
gamma distribution 335, 391, 399, 413
gamma function 445
Gauss hypergeometric function 343
Gaussian distribution 176, 337, 392, 401, 422
gcd function 349
generalized

regression 182
genfit function 350
geninv function 350
genvals function 351
genvecs function 351

geometric distribution 335, 391, 399, 414
geometric mean 352
GETWAVINFO function 352
Given function 344, 387
Given, in solve blocks 168, 277
global definition 464
global definitions 104–105
gmean function 352
Gopher 29
graphics, inserting 69
graphing

data 225
expressions 224
functions 224, 236
in 2D 219
in 3D 235
uniform polyhedra 202
vector 225

graphs
creating 18, 202, 235
formatting 19
resizing 19
See also  plots, 2D

greater than 131, 467
greater than or equal to 131, 467
greatest common divisor 349
greatest integer function 348
Greek letters

in equations 40
in text 59
table of 498

Greek toolbar 41, 59, 498
guess

for solve blocks 168
guidelines for aligning regions 86
hard page breaks 90
harmonic mean 354
HBK files 22
headers and footers 90
Heaviside step function 446
Help

Author’s Reference 28
context-sensitive 27
Developer’s Reference 28
on-line 27
See also Resource Center and technical support

Her function 352
Hermite polynomial 352
hexadecimal numbers 37
highlighting equations 88
highpass filter 446
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hist function 352
histogram 352
histogram function 353
history of browsing in Electronic Book 24
hlookup function 354
hmean function 354
HTML 25, 80
HTTP 29
hyperbolic cosine integral 486
hyperbolic functions 153

cosh function 330
coth function 330
csch function 332
sech function 428
sinh function 429
tanh function 438

hyperbolic sine integral 487
hypergeometric 336, 343, 379, 391, 393, 400, 414
hyperlinks

deleting 96
editing 96
to other file types 97
to regions 96
to worksheets 95

Hypertext Markup Language
See HTML

i (imaginary unit) 36
I0 function 354
I1 function 355
ibeta function 355
IBM’s techexplorer™ Hypermedia Browser 81
ICFFT function 355
icfft function 355
identity function 356
if conditional statement 469
if function 155, 199, 356
if statement 286
IFFT function 357
ifft function 357
Im function 357
image file

BMP format 71, 200
in headers and footers 91

imaginary Bessel Kelvin function 322
imaginary numbers

entering 36
symbol for 36, 117

imaginary value 117
implied multiplication 45, 112, 497
importing data 205, 208
impulse function 445, 486

In function 357
incompatible units (error message) 113
incomplete

beta function 355
elliptic integral 486
gamma function 445

increments for ranges 108
indefinite integral 273, 460
indented paragraphs 62
index variables

See range variables
inequalities

as constraints in solve blocks 169
infinity (∞) 40, 496
infix 466
in-line division 135
inner product 453
in-place activation 74, 300
Input Table component 207–208
input to a component 298
Insert Area command 91
Insert Function command 149
Insert Hyperlink command 95
Insert key 47, 58
Insert Link command 95
Insert Math Region command 66
insert matrix 453
Insert Matrix command

to create array 37, 203
to resize array 204

Insert Object command 10, 74, 121
Insert Reference command 94–95
Insert Unit command 113, 118
inserting

blank lines 87
characters 46
equations in text 65
functions 52
graphic objects 74
graphics computationally linked 77
hyperlinks 95
math region 66
minus sign in front of expression 51
parentheses around expression 51
pictures 69
text 58
units 113
worksheet 93

insertion point 12
installation instructions 6
integral transforms
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Fourier 263, 279
Laplace 264, 279
z 264, 279

integrals 142
algorithms 142
AutoSelect 142
contour 145
double 145
indefinite 273
symbolic evaluation of 273
tolerance 144
variable limits 144

integration 458, 460
adaptive 143
infinite limits 143
Romberg 143
singular endpoints 143

IntelliMouse support 9, 257
intercept function 358
interest rate 185
internal rate of return 186
International System of units (SI) 119
Internet

access 28
Collaboratory 29
Web browsing 25

Internet Explorer
See Microsoft Internet Explorer

Internet setup 29
interp function 358
interpolation

cubic spline 177
functions 177
linear 177

interpolation functions
bspline function 323
cspline function 332
interp function 358
linterp function 366
lspline function 371–372
pspline function 395

interrupting calculations in progress 124
inverse

cumulative distributions 174
Fourier transform 263, 279
Laplace transform 264, 279
matrix 136
trigonometric functions 152
z-transform 264, 279

inverse cumulative probability
See inverse probability distribution

inverse hyperbolic functions
acosh function 319
acoth function 319
acsch function 319
asech function 321
asinh function 321
atanh function 322

inverse of matrix 454
inverse probability distribution functions

qbeta function 398
qbinom function 398
qcauchy function 398
qchisq function 398
qexp function 399
qF function 399
qgamma function 399
qgeom function 399
qhypergeom function 400
qlnorm function 400
qlogis function 400
qnbinom function 400
qnorm function 401
qpois function 401
qt function 402
qunif function 402
qweibull function 402

inverse trigonometric functions
acos 319
acot function 319
acsc function 319
angle function 320
asec function 321
asin 321
atan function 321
atan2 function 322

invfourier keyword 263, 279, 478
invlaplace keyword 264, 279, 479
invztrans keyword 264, 279, 479
ipmt function 359
irr function 359
IsArray function 359
IsScalar function 360
IsString function 360
iterated product 136
iterated sum 136
iteration

in programs 287
with range variables 15

iwave function 360
j (imaginary unit) 36
J0 function 360
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J1 function 360
Jac function 360
Jacobi polynomial 360
Jacobian matrix 194, 433
JavaScript 309
Jn function 361
js function 361
JScript 309
K0 function 361
K1 function 361
keywords, symbolic 261–263, 473

assume 475
coeffs 475
collect 475
complex 476
convert, parfrac 476
expand 476
factor 477
float 477
fourier 478
invfourier 478
invlaplace 479
invztrans 479
laplace 479
series 480
simplify 481
solve 482
substitute 483
ztrans 484

Kn function 362
knots 323
Kronecker’s delta function 445
ksmooth function 183, 362
Kummer function 379, 393
kurt function 363
kurtosis 363
Lag function 363
Laguerre polynomial 363
Lambert W function 487
laplace keyword 264, 279, 479
Laplace transforms 264, 279
Laplace’s equation 197, 384, 411
last function 363
Laurent series 263
lcm function 363
least common multiple 363
least integer function 326
least squares

<function>regress 409
genfit function 350
intercept function 358

linfit function 365
loess function 368, 427
slope function 430
stderr function 432

Leg function 364
Legendre function 343
Legendre polynomial 364
LegendreE function 486
LegendreEc function 486
LegendreEc1 function 486
LegendreF function 487
LegendreKc function 487
LegendreKc1 function 487
LegendrePi function 487
LegendrePic function 487
LegendrePic1 function 487
length function 364
less than 131, 467
less than or equal to 131, 467
lgsfit function 364
limit 462

left-hand 462
right-hand 462

limits, evaluating 130, 274
line break

in text 58
line function 364
linear

equations 344, 387
independence 403
interpolation 177, 366
prediction 177, 395
programming 167, 374, 381
regression 179, 409
system solver and optimizer 167
systems of differential equations 191
systems of equations 167

linfit function 365
link

See also hyperlinks
to objects 74
to other worksheets 93, 95

linterp function 177, 366
literal subscripts 41
ln (natural log) function 367
lnfit function 367
LoadColormap function 249, 367
local definition 469
local result format 17
lockable area

See area
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locked calculations 91–93
locking and unlocking an area 91
loess function 368, 427
log and exponential functions

exp function 340
ln function 367
log function 369

log function 153, 369
logarithms and exponential functions 153
logfit function 369
logical operators

See Boolean operators
logistic distribution 391, 400, 420
lognormal distribution 391, 400, 420
long equations 270
lookup function 370
lookup functions 163
looping

for loop 287
while loop 288

lowpass filter 446
lsolve function 370
lspline function

one-dimensional case 371
two-dimensional case 372

LU decomposition 373
lu function 373
magnitude 454

complex numbers 133
vector 136

mailing worksheets 99
mantissa 348
manual mode 122
Mapping functions 162
margins 89
match function 374
Math Optimization command 282
Math Options command 103
math styles

applying 55
Constants 54
editing 54
saving 56
Variables 54

Math toolbar 8, 41
Mathcad

accessing from other applications 314
Mathcad 6, 7, or 8 83
Mathcad OLE automation objects 314
Mathcad Overview 22
Mathcad Web Libary 22

Mathematical Markup Language
See MathML

MathML 81
MathSoft

contacting 6
MathSoft Control Components 311
MathSoft home page 26
MATLAB component 303
matrices

adding/deleting rows or columns 204
as array elements 217
calculations by element 213
creating 37
creating from bitmaps 200
creating with components 298
decomposition functions 165
defining by formula 204
defining with two range variables 204
definition of 37
determinant 136, 278
displayed as pictures 69
displayed as scrolling output tables 210
extracting a column 208
extracting elements 208
functions for 159
inverting 136
limits on size 203, 211
matrix arithmetic 135
numbering elements 209
operators for 133
ORIGIN used with 209
plotting in contour plot 243
plotting in surface plot 240
See also arrays
sorting by row or column 165
start with row and column zero 209
subscripts 208
transpose 136

matrix
changing size 204

Matrix Determinant command 278
Matrix display style 117
matrix function 374
Matrix Invert command 278
matrix operators

combining 322, 432
cross product 453
determinant 454
dot product 453
insert matrix 453
inverse 454
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magnitude 454
picture 455
raising to a power 451–452
subscript 453
sum 454
superscript 454
transpose 454
vectorize 454

Matrix Transpose command 278
max function 374
Maximize function 374
MCD file 79
MCM file 310
MCT file 79
mean function 377
measurement for the ruler 86
medfit function 377
median function 377
medsmooth function 377
metafile 72
mhyper function 379, 393
Microsoft Internet Explorer 22, 25, 309
Microsoft Office 77
min function 379
Minerr function 171, 379
Minimize function 381
minus sign 450

for negation 131
inserting in front of expression 51

MIP
See mixed integer programming

mirr function 384
mixed integer programming 172
mixed number 452
mixed numbers

displaying results as 116
MKS units 119, 493
mod function 384
mode

Seemanual mode
mode function 384
modifiers, symbolic 474
modulus 454
moving

crosshair 10, 499
editing lines 46, 499
insertion point 46, 499
regions 10

moving regions 10
multigrid function 198, 384
multiple integrals 145, 458

multiple roots
finding with polyroots 167
finding with solve blocks 170

multiple summations 137
multiplication 44, 450, 453, 457–458

implied 45, 112, 497
multivalued functions 117
names of variables and functions 39
National Instruments

supported data acquisition devices 313
natural logarithm 367
negating an expression 51
negation 450
negative binomial distribution 336, 392, 400, 420
nested arrays

defining 217
displaying 217
expanding 117, 217

nom function 385
nonlinear

equations 344, 387, 422
regression 350, 365

nonlinear systems of equations 167
nonscalar value (error message) 107
norm

of vector 136
norm1 function 386
norm2 function 386
normal distribution 176, 337, 392, 401, 422
norme function 386
normi function 386
not 131
not converging (error) 144
not equal to 131, 467
not function 468
notations in this User’s Guide 2
nper function 386
npv function 387
nth derivative 461
nth order derivative 141
nth root 451
nth root 131
num2str function 387
number format

See result format
number theory functions 155

gcd function 349
lcm function 363
mod function 384

numbered paragraphs 62
numbers 35
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binary 36, 117
complex 36
decimal 117
displayed as zero 117
exponential notation for 37, 116
format for computed results 115
formatting 17, 115
hexadecimal 37
imaginary 36
octal 36, 117
radix (base) for results 117

numerical methods
differentiation 139, 141
integration 142
root finding 166
solving and optimization 171

object linking and embedding
See OLE

objects
embedding 74
linking 74

octal numbers 36, 117
ODBC component 304
Odesolve function 187, 387
OLE

automation 308, 314
drag and drop 76
editing links 77
in-place activation 74, 77, 300
scripting objects 309
via components 297

on error statement 292, 471
on-line resources 21
OpenGL 235
opening worksheets 80
operator placeholder 50
operators

arithmetic 448
Boolean 131, 467
calculus 456
changing the display of 130
customizing 146
defined 42
deleting 50
derivative 139, 271
evaluation 462
for complex numbers 133
for vectors and matrices 133
indefinite integral 273
inserting 47
integral 142

iterated product 136
iterated sum 136
logical 131, 155
matrix 453
nth order derivative 141
programming 469
replacing 50
symbolic 130
toolbars 8, 129
vector sum 138

operators, accessing 447
optimization

Maximize function 374
Minerr function 379
Minimize function 381

Optimize Palette command 74
optimizers 167
or 131
or function 468
or, exclusive 131
order

of derivative 142
of polynomial regression 180
of worksheet evaluation 105

ORIGIN variable 209
otherwise statement 470
output from a component 298
output table 210

alignment 211
resizing 211
versus matrix display style 117

overlapping regions 88
overtyping text 58
overview of Mathcad features 22
page

breaks, inserting and deleting 90
headers and footers 90
length 90
numbering 91

Page Setup dialog box 89, 98
palettes, color, for bitmaps 73
paragraphs 57

bullets 62
hanging indent 62
indenting 62
numbers 62
properties 61
tab stops 63
text alignment in 62

parametric plot
creating 224
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parametric surface plots
creating 241–242
See also plots, 3D

parentheses 449
deleting from expression 52
inserting into an expression 51

partial differential equations 197, 384, 411
partial fractions 263, 476
password protecting an area 91
Paste command 11, 76
Paste Special command 11, 72, 76
pasting

bitmaps 72
device-independent bitmaps 72
from Clipboard 53, 72
metafiles 72
OLE objects 11, 76

payment calculations 186
pbeta function 389
pbinom function 389
pcauchy function 389
pchisq function 390
Pearson’s correlation coefficient 330
pending computations 122–123
percent 496
permut function 390
permutations 155
personal

dictionary (spell-checker) 68
QuickSheets 147

pexp function 390
pF function 175, 390
pgamma function 390
pgeom function 391
phypergeom function 391
pi (∏, product symbol) 136
pi (3.14159...) 46, 102, 496, 498
picture 455
picture operator 69, 215
pictures

border on 73
creating from bitmap file 71
creating from matrix 70
creating using SmartSketch 306
formatting 73
importing into an array 200
pasted from Clipboard 72
resizing 73

Piecewise 155
piecewise continuous functions 155

δ function 445

ε function 445
Φ function 446
if function 356
sign function 429

placeholder 12, 35
placeholder for an operator 50
Playback command 126
plnorm function 391
plogis function 391
plots 3D

graphing functions 236
plots, 2D

autoscaling of axis limits 229
changing perspective 232
copying format from existing plot 231
creating 220
default formats 231
formatting 229
graphing expressions 221
graphing functions 221
graphing vectors 226
multiple traces on 222
of data 227
QuickPlot 18
read-out of coordinates 233
reference lines in 230
resizing 19
setting axis or data limits 230
setting default formats 231
Show Markers 230
titles and labels 229
traces on 222
tracing coordinates on 233
zooming 232

plots, 3D 235
3D Plot Format dialog box 247
3D Plot Wizard 236
annotations 254
backplanes 247
color 248, 253
colormaps 249–250
contour lines 251
contour plots 243
converting 254
creating 235
examples 236, 240
fill color 248
filling contours 250
fog 246
formatting 246
graphic annotations on 254
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lighting 253
line color 252
lines 250
multiple plots on 245
OpenGL graphics 235
parametric surface plots 241–242
point color 252
point symbols 252
QuickPlot 236
resizing 19
rotating 256
space curves 239
spinning 257
surface plots 237, 240
text on 254
titles 248
uniform polyhedra 202
vector field plots 244
wireframe 250
zooming 256–257

pmt function 391
pnbinom function 392
pnorm function 392
Poisson distribution 337, 394, 401, 425
Poisson’s equation 197, 385, 412
pol2xy function 394
polar plots

creating 220
formatting 229
See also plots, 2D

polygamma function 487
polyhedra 202
Polyhedron 392
Polyhedron function 392
PolyLookup function 393
polynomial

finding roots of 344, 387, 393, 422
finding the roots of 166
regression 180, 350, 365, 368, 409, 427

Polynomial Coefficients command 263
polyroots function 166, 393
population statistics 173
popup hyperlink 95
pop-up menu

3D plots 254
animation playback 126
component 299
Data Acquisition component 313
Excel component 302
Input Table component 208
integration 143

MathSoft Control component 312
MATLAB component 303
OBDC component 304
Scriptable Object Component 310
SmartSketch component 306
solving 172
Web browsing 26

pop-up window, creating 95
postfix 466
power 131
ppmt function 394
ppois function 394
precision, internal 115
predefined variables 102
predict function 395
prediction, linear 177
prefix 465
present value calculations 187
principal branch of function 117
Print Preview command 99
printing 20, 98

and calculation of worksheet 123
and pagination 90
blank pages in 89, 98
color 89
print preview 99
wide worksheets 98

PRNCOLWIDTH variable 496
PRNPRECISION variable 496
probability density functions

dbeta function 334
dbinom function 334
dcauchy function 334
dchisq function 335
dexp function 335
dF function 335
dgamma function 335
dgeom function 335
dhypergeom function 336
dlnorm function 336
dlogis function 336
dnbinom function 336
dnorm function 337
dpois function 337
dunif function 337
dweibull function 338

probability distribution functions
pbeta function 389
pbinom function 389
pcauchy function 389
pchisq function 390
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pexp function 390
pF function 390
pgamma function 390
pgeom function 391
phypergeom function 391
plnorm function 391
plogis function 391
pnbinom function 392
pnorm function 392
ppois function 394
pt function 396
punif function 396
pweibull function 397

probability distributions 174
processing equations 13, 122–123

results of 122
product 136, 450, 453, 457–458

cross product 136
dot product 135
iterated 136

programming operators
add line 469
break 470
continue 470
for 470
if 469
local definition 469
on error 471
otherwise 470
return 471
while 470

programs 283
adding lines 284
break statement 289
continue statement 290
controlling or interrupting 289
defining 283
error handling 291
error messages in 293
for loop 287
generating symbolic results 285
if statement 286
local assignment 283
looping 287
nested 294
on error statement 292
output of 283
recursion 295
return statement 290
statements 284
subroutines 294

symbolic evaluation of 285
while loop 288

properties
of components 299
of controls 304
region 88

proxy server 29
Psi function 487
Psin function 487
pspline function 395
pt function 396
punif function 396
pv function 396
pweibull function 397
pwrfit function 397
qbeta function 398
qbinom function 398
qcauchy function 398
qchisq function 398
qexp function 399
qF function 175, 399
qgamma function 399
qgeom function 399
qhypergeom function 400
qlnorm function 400
qlogis function 400
qnbinom function 400
qnorm function 401
qpois function 401
QR decomposition 401
qr function 401
qt function 402
quadratic equation solving 172
QuickPlot 18, 221, 236
QuickSheets 21

See also Resource Center
storing custom operators 147

qunif function 402
qweibull function 402
radians

converting to degrees 121, 152
trig functions 152

radix of displayed results 117
random number generators

rbeta function 403
rbinom function 404
rcauchy function 404
rchisq function 404
rexp function 413
rF function 413
rgamma function 413
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rgeom function 414
rhypergeom function 414
rlnorm function 420
rlogis function 420
rnbinom function 420
rnd function 421
rnorm function 422
root function 422
rpois function 425
rt function 426
runif function 426
rweibull function 426

range product 458
range sum 457
range variable creation 453
range variables

array calculations with 213
creating arrays with 204
defining 15, 106, 108
fundamental principle for 108
how Mathcad evaluates equations with 108
setting endpoints and increments 108

rank function 403
rate function 403
rbeta function 403
rbinom function 404
rcauchy function 404
rchisq function 404
Re function 404
READ_BLUE function 405
READ_GREEN function 405
READ_HLS function 405
READ_HLS_HUE function 406
READ_HLS_LIGHT function 406
READ_HLS_SAT function 406
READ_HSV function 406
READ_HSV_HUE function 406
READ_HSV_SAT function 407
READ_HSV_VALUE function 407
READ_IMAGE function 407
READ_RED function 408
READBMP function 405
reading a data file 205
READPRN function 407
READRGB function 408
READWAV function 409
real Bessel Kelvin function 323
recursion 111
reference tables in the Resource Center 22
references

and relative paths 94

to other worksheets 93
regions 10

aligning 85
blank space between 10
copying 10
deleting 12
dragging 10
dragging across documents 11
equation 10
hyperlinking to 96
locking 91
moving 10
overlapping 88
separating 88
tags, creating 96
text 57
unlocking 93
viewing 10, 88

region-to-region hyperlinking 96
regress function

one-dimensional case 409
two-dimensional case 411

regression
functions 179
generalized 182
linear 179
localized 180
multivariate 180
polynomial 180
using linear combinations of functions 182

regression functions
expfit function 340
genfit function 350
intercept function 358
lgsfit function 364
line function 364
linfit function 365
lnfit function 367
loess function 368, 427
logfit function 369
medfit function 377
pwrfit function 397
regress function 409
sinfit function 429
slope function 430
stderr function 432

relational operators 155
relative paths

for references 94
relax function 198, 411
Repaginate Now command 90
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replacing characters in math or text 67
replacing operators 50
reports

for a solve block 172
resizing

graphs 19
pictures 73

Resource Center 21
accessing worksheets on Web 25
bookmarks 26
Mathcad Web Library 22
Web browsing in 25

resources, on-line 21
result format 115
results

calculating 14
calculating with equations 103
complex 117
copying 121
formatting 115
units in 118
wrapping 270

return statement 290, 471
reverse function 165, 413
rexp function 413
rF function 175, 413
rgamma function 413
rgeom function 414
rhypergeom function 414
Riccati equation 344, 387
rich text format (RTF) 83
Riemann Zeta function 487
right page margin 89
Rkadapt function 415
rkadapt function 414
rkfixed function 189, 415
rlnorm function 420
rlogis function 420
rnbinom function 420
rnd function 176, 421
rnorm function 422
root function 166, 422
roots

finding 166
finding multiple with solve blocks 170
finding symbolically 275
numerical approximations used 166
of polynomials 166

round function 425
row vectors

See vectors

rows function 425
rpois function 425
rref function 425
rsort function 165, 426
rt function 426
RTF file 79

See also rich text format
ruler

for formatting a worksheet 86
for formatting text 62

runif function 426
rweibull function 426
Save As dialog box 20
SaveColormap function 249, 427
saving

new file 20
templates 84
worksheets 20, 80

sbval function 195, 427
scalar

addition 135
division 135
multiplication 135

scalar product 453
scatter plots (3D)

formatting 246
See also plots, 3D

scientific notation 116
Scriptable Object component 308
scripting languages, supported 309
search

Electronic Book 24
in equations 67
in text 67

Search Book command 24
search function 428
sec function 428
sech function 428
second derivatives, calculating 141
second order differential equations 190
seed for random number generator 421
selecting

graphs 19
math expression 48
page break 90
regions 10
text 59

selection rectangle 10
semicolon, in range variable definitions 106
Separate Regions command 88, 90
separating overlapping regions 88, 90
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series 263
series keyword 263, 480
Shi function 487
Show Border option 73
Si function 487
sigma (summation symbol) 136

for vector 136
sign function 429
signum function 429
Simplify command 270
simplify keyword 262, 270, 481
simultaneous equations, solving 344, 387
simultaneous equations, solving numerically 164, 167
sin function 429
sine integral 487
sinfit function 429
singular matrix 370
singular value decomposition 437–438
sinh function 429
skew function 430
skewness 430
slope function 430
SmartSketch component 77, 306
smooth systems (differential equations) 193
smoothing functions

ksmooth function 362
medsmooth function 377
supsmooth function 437

smoothing of data 183
soft page breaks 90
solve block 344, 387
solve blocks 167, 187

constraints in 169
definition of 168
expressions allowed in 169
finding multiple solutions 170
Given in 168
reports for 172
tolerance 171
using to solve differential equations 187
using to solve numerically 168
using to solve symbolically 277

Solve command 483
solve keyword 263, 275–276, 482
Solving and Optimization Extension Pack 168
solving equations 167

AutoSelect of algorithm 171
linear systems 171
nonlinear systems 171
See also solve blocks
with root function 166

with solve blocks 167, 277
with Solve for Variable 275
with solve keyword 275

solving functions
Find 344
Find function 387
Maximize function 374
Minerr function 379
Minimize function 381
polyroots function 393
root function 422

sorting functions 165
csort function 332
reverse function 413
rsort function 426
sort function 165, 431

sorting vectors and matrices 165
space curves

creating 239
See also plots, 3D

spaces, inserting or deleting 87
special functions 156

eff function 338
erf function 339
erfc function 339
fhyper function 343
Γ function 445
Her function 352
ibeta function 355
Jac function 360
Lag function 363
Leg function 364
mhyper function 379, 393
other

complete elliptic integral
of the first kind 487
of the second kind 486
of the third kind 487

complex error function 486
cosine integral 486
digamma 487
dilogarithm 486
Dirac delta 486
Euler’s constant 486
exponential integral 486
Fresnel cosine integral 486
Fresnel sine integral 486
hyperbolic cosine integral 486
hyperbolic sine integral 487
incomplete elliptic integral

of the first kind 487
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of the second kind 486
of the third kind 487

Lambert W 487
polygamma 487
Riemann Zeta 487
sine integral 487

Tcheb function 439
Ucheb function 439

spell-checking 68
sph2xyz function 431
spherical Bessel functions 361, 445
spline functions 177–178, 371
spreadsheets, exchanging data with 297
square root 451
stack function 162, 432
stack overflow error 112
standard deviation 432
standard error 432
standard normal distribution 176
Standard toolbar 8
statistics

cubic spline interpolation 177
cumulative distribution functions 174
functions 173
generalized linear regression 182
interpolation 177
inverse cumulative distributions 174
linear interpolation 177
linear prediction 177
linear regression 179
multivariate polynomial regression 180
polynomial regression 180
probability density functions 174

statistics functions
corr function 330
cvar function 334
gmean function 352
hist function 352
histogram function 353
hmean function 354
kurt function 363
mean function 377
median function 377
mode function 384
skew function 430
Stdev function 432
stdev function 432
Var function 440
var function 440

stderr function 432
Stdev function 432

stdev function 432
step function 446
step size

for differential equation solving 193
for iteration 108

Stiffb function 433
stiffb function 433
Stiffr function 435
stiffr function 434
str2num function 435
str2vec function 436
string functions

concat function 329
error function 340
num2str function 387
search function 428
str2num function 435
str2vec function 436
strlen function 436
substr function 437
vec2str function 440

strings
arguments to file access functions 199
as elements of vectors 38
comparing 133
converting to numbers and vectors 198
defining 38
editing 49
evaluating 38
manipulating 198
variables 38

strlen function 436
Student’s t distribution 396, 402, 426
styles

math 54
text 63

submatrix function 436
subroutines 294
subscripts

in text 61
literal 41
non-numeric 41
ORIGIN used with 209
start with zero 209

Substitute for Variable command 263
substitute keyword 263, 483
substr function 437
subtraction 131, 450
summation 449, 456

iterated 136
of vector elements 136
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variable upper limit 138
superscript 454

array 136
to get column from matrix 209

supsmooth function 183, 437
surface plots

creating 237, 239–240
formatting 246
parametric 241–242
See also plots, 3D

svd function 437
svds function 438
symbolic

equal sign 260
evaluation 260
evaluation of programs 285
keywords 261

symbolic equals 465
symbolic keywords 473

assume 475
coeffs 475
collect 475
complex 476
convert, parfrac 476
expand 476
factor 477
float 477
fourier 478
invfourier 478
invlaplace 479
invztrans 479
laplace 479
series 480
simplify 481
solve 482
substitute 483
ztrans 484

symbolic modifiers 474
symbolics menu 474
Symbolics menu commands 269
Symbolics menu, using 269
system requirements for Mathcad 5
t distribution 396, 402, 426
tab stops in a worksheet 86
tables of data 207
tabs in a paragraph 63
tag

region, creating 96
tan function 438
tanh function 438
Taylor series 263

Tcheb function 439
techexplorer™

See IBM’s techexplorer™ Hypermedia Browser
technical support 6
temperature conversions 114, 120
templates 79

creating new 84
modifying 85
See also QuickSheets
used to save calculation mode 122
using to create a worksheet 80

tensor 445
text 57

alignment 62
bullets in 62
changing font 60
color 61
editing 60
entering 14
Greek letters in 59
inserting equations in 65
moving 59
moving insertion point in 58
Occupy Page Width option 60
Push Regions Down As You Type option 61
regions 57
selecting 59
spell-checking 68
styles 63
tools 67

text box 14, 57
text regions 57

changing width 60
creating 14, 57
editing 60
how to exit 15, 57

text ruler 62
text styles 63

applying 63
creating 64
modifying 64

text tools 67
tilde (~), used in global definitions 105
time in header or footer 91
Tip of the Day 28
TOL variable 102, 344, 387, 422, 496

and integrals 144
and solve blocks 171

tolerance
constraint (CTOL) 344, 387
convergence (TOL) 422
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See TOL variable and CTOL variable
toolbar

Boolean 467
calculator 448
calculus 456
evaluation 462
Formatting 8
Math 8
matrix and vector 453
programming 469
standard 8
symbolic 473

toolbars 129
customizing 9
Electronic Book 23, 26
operator 129
programming 284
Web 26

Tools
text 67

top-to-bottom evaluation 103
tr function 439
trace 439
traces, on 2D plots 222
tracing the source of an error 127
trailing zeros 116
training 23
transcendental functions 151
transform

inverse
Laplace transform 264

transforms
discrete Fourier 157
Fourier (numerical) 341, 343
Fourier (symbolic) 263, 279, 478
Laplace 264, 279, 479
symbolic 263
wavelet 159, 441
z 264, 279, 484

transpose 454
transpose of matrix 136, 278
treefix 466
trig keyword modifier 266
trigonometric functions 151

cos function 330
cot function 330
csc function 332
inserting without parentheses 148
sec function 428
sin function 429
tan function 438

with degrees and radians 121
trunc function 439
truncation and round-off functions

ceil function 326
floor function 348
round function 425
trunc function 439

two-point boundary value problems 195
typing over text 58
U.S. Customary units 119
Ucheb function 439
undefined variables 104, 106
uniform distribution 337, 396, 402, 426
uniform polyhedra 202
units

alternative definitions 118
base units 119
CGS system 119
common sources of error 114
converting calculated results 120
default 112
defining 114, 119
dimensional consistency 113
errors in dimensions 113
in calculated values 118
in equations 112
metric 119
MKS system 119
placeholder 118
prefixes 119
SI 119
simplifying 117
U.S. customary 119

UnitsOf function 114, 439
Up One Level command 217
update

window manually 123
worksheet 123
worksheet window 123

URL
MathSoft home page 26

Use Default Palette command 74
user-defined functions 109

evaluating variables in 110
valid names 39

Var function 440
var function 440
Variable Differentiate command 271
Variable Integrate command 273
Variable Solve command 275
variables
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changing the font style of 54
defining 13, 101
global definitions of 104
in red 106, 126
matrices 37, 203
names 39
predefined 102
range variables 15, 106
string 38
substituting for 263
undefined 127
vectors 37

variance of a data set 440
VBScript 309
vec2str function 440
vector

changing size 204
definition of 37

vector and matrix functions
augment function 322
cholesky function 328
cols function 328
cond1 function 329
cond2 function 329
conde function 329
condi function 329
CreateMesh function 331
CreateSpace function 331
cyl2xyz function 334
diag function 336
eigenvals function 338
eigenvec function 338
eigenvecs function 339
geninv function 350
genvals function 351
genvecs function 351
hlookup function 354
identity function 356
last function 363
lookup function 370
lookup functions 163
lsolve function 370
lu function 373
match function 374
matrix function 374
max function 374
min function 379
norm1 function 386
norm2 function 386
norme function 386
normi function 386

pol2xy function 394
Polyhedron function 392
PolyLookup function 393
qr function 401
rank function 403
rows function 425
rref function 425
sph2xyz function 431
stack function 432
submatrix function 436
svd function 437
svds function 438
tr function 439
vlookup function 440
xyz2cyl function 443
xyz2pol function 444
xyz2sph function 444

vector and matrix functions functions
length function 364

vector and matrix subscript 453
vector field plots

creating 244
from complex matrices 244
See also plots, 3D

vector norm 454
vector product 453
vector sum 454
vector sum operator 138
vectorize 454
vectorize operator 213–214

effect of 214
how to type 213
properties of 214, 455

vectors
as array elements 217
calculations by element 213
column vectors 136
creating 37
cross product 136
displayed as scrolling output tables 210
dot product 135
functions for 159
graphing 226
magnitude 136
numbering elements 209
operators for 133
ORIGIN used with 209
row 136
See also arrays
sorting elements 165
start with element zero 209
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subscripts 208
sum elements of 136
undefined elements filled with zeros 209
vector arithmetic 135
vectorize operator 213

View Animate command 125
View Zoom command 9
Visual Basic Scripting Edition 309
vlookup function 440
W function 487
wait message 123
WAV files, pulse code modulated (PCM) 201
wave function 441
wavelet transform functions

iwave function 360
wave function 441

wavelet transforms 159
Web

See World Wide Web
Web Store 23
Web toolbar 26
Weibull distribution 338, 397, 402, 426
while loop statement 470
while loops 288
windows

update results manually 123
working with 9
zooming in and out of 9

Windows keystrokes 9, 500
wireframe, in 3D plots 250
Wizards

for inserting 3D plots 236
for inserting a component 299

worksheet ruler 86
worksheets

closing 20
exporting as HTML 80
exporting as RTF 83
formatting 89
gathering in an Electronic Book 97
hyperlinking 95
in pop-up window 95
including by reference 95
opening 80
opening from Internet 26
order of evaluation 103
printing 20, 98
referencing in another worksheet 93

saving 20, 79–80
saving as templates 84
saving in an earlier format 83
sending by Email 99

World Wide Web
accessing 26
bookmarks for browsing 26
browsing 25, 80
Collaboratory 29
HTML browsing 25, 80
MathSoft home page 26
toolbar 26

WRITE function 200
WRITE_HLS function 442
WRITE_HSV function 442
WRITEBMP function 441
WRITEPRN function 200, 442
WRITERGB function 443
WRITEWAV function 443
writing data to a data file 215
WWW

See World Wide Web
Wythoff symbol for a polyhedron 202
xor 131
xor function 468
X-Y plots

creating 220
formatting 229
QuickPlot 18
See also plots, 2D

xyz2cyl function 443
xyz2pol function 444
xyz2sph function 444
Y0 function 444
Y1 function 444
y-intercept 358
Yn function 444
ys function 445
zero threshold 117
zeros of expressions or functions

See roots
Zeta function 487
zooming

2D plots 232
3D plots 257
windows 9

ztrans keyword 264, 279, 484
z-transforms 264, 279
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